### Contents

**VOLUME 1**

**Preface**

- Preface ................................................................. xxix

**Chapter 1**

- **Introduction** .................................................. 1 – 1
- Human Resource Management ................................. 1 – 2
  - Separate v. Integrated HRMS Systems ...................... 1 – 3
  - Human Resources and Payroll Activity Cycles .......... 1 – 4
- Introduction to the HRMS Model ............................. 1 – 6
- Managing Change Over Time .................................... 1 – 9
  - Dated Information and Hierarchy Versions ............... 1 – 10
  - DateTrack .......................................................... 1 – 10
  - Setting Your Effective Date ................................ 1 – 11
    - To set your effective date: ................................. 1 – 11
  - Viewing Datetracked Information and History .......... 1 – 13
    - To view DateTrack History: ................................. 1 – 13
  - Updating and Correcting Datetracked Information .... 1 – 14
  - Deleting Datetracked Information ......................... 1 – 15
    - To remove an end date: .................................... 1 – 16
- Work Structures and Key Flexfields ......................... 1 – 17

**Chapter 2**

- The Employer and Other Organizations ..................... 2 – 1
- Site Locations ..................................................... 2 – 2
Setting Up Site Locations ........................................... 2 – 2
   To enter a work location and its address: .................... 2 – 3
   To remove an address from the Location list: ............... 2 – 3
Representing the Employer: The Business Group .......... 2 – 4
   Key Flexfields for the Business Group ....................... 2 – 4
   Single or Multiple Business Groups ......................... 2 – 7
   Defaults for the Business Group ............................... 2 – 7
Representing the Employer: GREs ............................ 2 – 9
   Enterprises with One GRE ..................................... 2 – 10
   Enterprises with Multiple GREs ............................. 2 – 10
   GREs and Tax Groups ........................................... 2 – 12
Representing Organizations ..................................... 2 – 14
   Levels of Internal Organizations .............................. 2 – 14
   Internal Organizations and Cost Centers ................... 2 – 16
   External Organizations ....................................... 2 – 17
Employer and Organization Setup ............................. 2 – 18
   Accessing Business Groups .................................. 2 – 18
      To define a view–all responsibility: ....................... 2 – 18
Creating an Organization ....................................... 2 – 20
   To create a new organization: ................................. 2 – 22
   To enter additional information: ............................. 2 – 24
Additional Information for Business Groups ................. 2 – 24
   To enter basic, required information for the Business Group: 2 – 24
   To enter defaults for human resource budget values: ........ 2 – 24
   To enter defaults for work day start and end times: ........ 2 – 24
   To register Reporting Categories and Statuses: ............. 2 – 24
   To enter training default values for Oracle Training Administration: 2 – 24
Additional Information for GREs ............................. 2 – 25
   To enter the unique IRS identification number (EIN): .... 2 – 25
   To enter data for EEO, VETS and New Hire reporting: ..... 2 – 25
   To enter tax rules: ............................................. 2 – 25
   To enter data for wage and tax reporting: ................... 2 – 25
   To enter data for NACHA tapes: ............................. 2 – 25
Additional Information for HR Organizations ............... 2 – 25
   To enter cost codes for collection of costing information: ...... 2 – 25
   To place the organization in hierarchies: .................... 2 – 25
   To enter default work day start and end times: .............. 2 – 26
   To enter a default work schedule: ........................... 2 – 26
Additional Information for Reporting Establishments ...... 2 – 26
   To enter filing data for EEO and VETS reports: .............. 2 – 26
   To place Reporting Establishments in hierarchies: ........... 2 – 26
### Contents

- To enter filing data for Multiple Worksite reports: 2 – 26
- Additional Information for AAP Organizations 2 – 26
  - To place AAP Organizations in hierarchies: 2 – 26
- Entering Business Group Information 2 – 26
  - To enter Business Group information: 2 – 26
- Business Groups: Entering Budget Value Defaults 2 – 27
  - To define budget value defaults: 2 – 28
- Business Groups and HR Organizations: Work Day Defaults 2 – 29
  - To define work day defaults: 2 – 29
- GREs: Entering the IRS Identification Number 2 – 30
  - To enter the unique identification number for the GRE: 2 – 30
- HR Organizations: Entering Costing Information 2 – 30
  - To enter costing information: 2 – 30
- HR Organizations: Entering Parent Organizations 2 – 31
  - To enter a parent organization: 2 – 31
- HR Organizations: Entering a Work Schedule 2 – 31
  - To select a work schedule for an HR Organization: 2 – 32
- Deleting an Organization 2 – 33
- Organization Hierarchies 2 – 34
- Multiple Hierarchies 2 – 35
- Organizational Change and Version Control 2 – 36
- Creating Organization Hierarchies 2 – 37
  - To set up a new organization hierarchy: 2 – 37
  - To create a new version of an existing hierarchy: 2 – 37
  - To copy an existing hierarchy: 2 – 38
- Changing Organization Hierarchies 2 – 39
- Deleting Organization Hierarchies 2 – 39
- Organization Hierarchy Report 2 – 39
  - To run the Organization Hierarchy Report: 2 – 39

### Chapter 3

**Jobs and Positions** 3 – 1

- Representing Jobs and Positions 3 – 2
- Position Reporting Structures 3 – 3
- Deciding How to Use Organizations, Jobs, and Positions 3 – 4
- Job and Position Names 3 – 5
- Adding Information About Jobs and Positions 3 – 6
- Defining Jobs 3 – 8
  - To define a job: 3 – 8
- Defining Positions 3 – 11
  - To define a position: 3 – 11
- Evaluating Jobs and Positions 3 – 14
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up an Evaluation System</td>
<td>3 – 14</td>
</tr>
<tr>
<td>Entering Evaluation Information</td>
<td>3 – 15</td>
</tr>
<tr>
<td>Valid Grades</td>
<td>3 – 16</td>
</tr>
<tr>
<td>Entering Job and Position Requirements</td>
<td>3 – 17</td>
</tr>
<tr>
<td>Entering Work Choices for a Job or Position</td>
<td>3 – 18</td>
</tr>
<tr>
<td>Viewing Position Occupancy</td>
<td>3 – 20</td>
</tr>
<tr>
<td>Creating Position Hierarchies</td>
<td>3 – 21</td>
</tr>
<tr>
<td>Changing Position Hierarchies</td>
<td>3 – 23</td>
</tr>
<tr>
<td>Deleting Position Hierarchies</td>
<td>3 – 23</td>
</tr>
<tr>
<td>Position Hierarchy Report</td>
<td>3 – 24</td>
</tr>
<tr>
<td>Making Mass Updates</td>
<td>3 – 25</td>
</tr>
<tr>
<td>Preparing for Your Mass Move</td>
<td>3 – 26</td>
</tr>
<tr>
<td>Performing Mass Move Tasks</td>
<td>3 – 28</td>
</tr>
<tr>
<td>Describing Your Mass Move</td>
<td>3 – 28</td>
</tr>
<tr>
<td>Identifying Your Source Positions</td>
<td>3 – 29</td>
</tr>
<tr>
<td>Identifying Your Target Positions</td>
<td>3 – 30</td>
</tr>
<tr>
<td>Verifying Transferring Assignments for Each Source Position</td>
<td>3 – 31</td>
</tr>
<tr>
<td>Verifying or Adding Valid Grades for Each Target Position</td>
<td>3 – 33</td>
</tr>
<tr>
<td>Executing the Mass Move</td>
<td>3 – 33</td>
</tr>
<tr>
<td>Reviewing the Mass Move</td>
<td>3 – 34</td>
</tr>
<tr>
<td>Resolving Problems and Reexecuting a Mass Move</td>
<td>3 – 34</td>
</tr>
<tr>
<td>Managing Your Mass Move Collection</td>
<td>3 – 35</td>
</tr>
</tbody>
</table>
Chapter 4  Grades and Their Relationship to Pay  4 – 1
Representing Grade Structures  4 – 2
Using Grades  4 – 3
Defining Grades  4 – 4
To define a grade:  4 – 4
Deleting Grades  4 – 5
Grade Relationships to Compensation and Benefits  4 – 6
Relating Pay to Grades Directly: Using Grade Rates  4 – 8
Defining Grade Rates  4 – 9
To define grade rates:  4 – 9
Viewing Grade Comparisons  4 – 10
To view employee grade comparison values:  4 – 10
Relating Pay to Grades Indirectly: Using Pay Scales  4 – 12
To set up a pay scale:  4 – 12
Defining a Pay Scale  4 – 13
To define a pay scale:  4 – 13
Defining Scale Rates  4 – 14
To create a scale rate:  4 – 15
Relating Grades to Progression Points  4 – 15
To create a grade scale:  4 – 16
Placing an Employee on a Grade Step  4 – 16
To place an employee on a grade step:  4 – 17
Incrementing Grade Step Placements  4 – 18
To run the Increment Progression Points process:  4 – 18
Current and Projected Progression Point Values Report  4 – 18
To run the Points Values Report:  4 – 18
Employee Increment Results Report  4 – 19
To run the Employee Increment Results Report:  4 – 19

Chapter 5  Payrolls and Other Employee Groups  5 – 1
Representing Payrolls  5 – 2
Payroll Setup Steps  5 – 3
Defining Payment Methods for the Enterprise  5 – 3
To define a payment method:  5 – 4
Entering NACHA Tape Data for GREs  5 – 5
To enter NACHA rules for a GRE:  5 – 5
Defining a Payroll  5 – 6
To create a new payroll:  5 – 7
Representing Other Employee Groups  5 – 10
Setting Up the People Group Flexfield  5 – 10
To enter information concerning the background check for an employee: 8 – 8
To enter rehire recommendation information for an applicant who was a former employee: 8 – 8
To enter further name information: 8 – 9
To enter medical information for an employee: 8 – 9
To enter other information for a person: 8 – 9

Hiring 8 – 10
To hire an employee: 8 – 10
To hire an applicant: 8 – 10
To rehire an ex–employee: 8 – 10
To cancel a hire: 8 – 10

Entering People’s Addresses at Sites without Oracle Payroll 8 – 11
To enter a generic address: 8 – 11

Entering People’s Addresses at Sites with Oracle Payroll 8 – 12
To enter a US or Canadian address with full validation: 8 – 13

Adding a City for Addresses 8 – 14
Adding Telephone Information 8 – 15
To enter a telephone number: 8 – 15

Entering Pictures 8 – 16
To enter a person’s picture in Oracle HRMS: 8 – 16

Entering Dependents, Beneficiaries and Other Contacts 8 – 16
To enter a contact: 8 – 17

Competence Profiles, Qualifications, School Attendances and Work Choices 8 – 19
Creating a Competence Profile 8 – 20
To create a competence profile: 8 – 20
To copy competencies from requirements: 8 – 21
To update a competence profile: 8 – 21

Entering Work Choices 8 – 21
To enter work choices for a person: 8 – 22

Entering Qualifications 8 – 23
To enter qualifications: 8 – 23
To enter tuition fees for reimbursement: 8 – 23
To enter training details: 8 – 24
To enter license details: 8 – 24
To enter subjects: 8 – 24

Entering Schools and Colleges Attended 8 – 24
To enter schools and colleges attended: 8 – 25

Entering Special Information 8 – 26
To enter special information for a person: 8 – 27

Listing People by Special Information 8 – 28
To list people by special information: 8 – 28
Tracking People’s Roles and Activities 8 – 30
Full Personal Details Report Set 8 – 31
To run the Full Personal Details report set: 8 – 31
New Hire Reporting 8 – 32
Setup Steps for New Hire Reporting 8 – 33
To set up for New Hire reporting: 8 – 33
Entering a New Hire Report Contact for a GRE 8 – 33
To enter a GRE’s contact person for new hire reporting: 8 – 34
Entering New Hire Report Data for Current Employees 8 – 34
To enter New Hire reporting data for current employees: 8 – 34
Obtaining New Hire Reports 8 – 35
To run a New Hire report for a GRE and state: 8 – 35
Deleting a Person from the System 8 – 37
To delete all records of a person: 8 – 37

Chapter 9

Employment Information 9 – 1
Managing Employment Information 9 – 2
The Employee Assignment 9 – 4
Components of the Assignment 9 – 5
Using Multiple Assignments 9 – 6
Identifying Employees and Assignments 9 – 7
Entering a New Assignment 9 – 9
To enter a new assignment: 9 – 9
To enter information in the window GRe and Other Data: 9 – 10
Changing Assignment Information 9 – 14
To change a primary assignment: 9 – 15
Ending an Assignment 9 – 16
To end one of many assignments: 9 – 16
Ending Employment 9 – 17
To terminate an employee: 9 – 17
Cancelling a Termination 9 – 18
To cancel a termination: 9 – 18
To change the termination date: 9 – 18
Terminations Report 9 – 19
To run the Terminations Report: 9 – 19
Additional Employment Information 9 – 20
Entering Payment Methods for an Employee Assignment 9 – 21
To enter a personal payment method for remuneration: 9 – 22
To enter a third party payment method: 9 – 23
Entering Secondary Assignment Statuses 9 – 23
To give a secondary status to an assignment: 9 – 24
Inquiring and Reporting on Employment Information 9 – 25
Listing Assignments 9 – 25
  To produce lists of assignments: 9 – 27
Listing Employees by Organization 9 – 28
  To list employees in several organizations: 9 – 28
  To list employees in one organization only: 9 – 28
Listing Employees by Position 9 – 30
  To view employee names by position: 9 – 30
  To view lists of positions within a position hierarchy: 9 – 31
Assignment Status Report 9 – 32
  To run the Assignment Status Report: 9 – 32
Employee Summary Report 9 – 33
  To run the Employee Summary Report: 9 – 33
Employee Movements Report 9 – 33
  To run the Employee Organization Movements Report: 9 – 33
  To run the Employee Payroll Movements Report: 9 – 34
Assignment History 9 – 35
  To view an employee's assignment history: 9 – 35

Chapter 10

Absence Management and PTO Accruals 10 – 1
Absence Management 10 – 2
Absence Types 10 – 3
  Setup of Absence Types 10 – 4
  Absence Elements 10 – 5
  Absence Recording 10 – 7
Absence Management Setup Steps 10 – 8
  To set up absence recording: 10 – 8
Defining and Linking an Absence Element 10 – 8
  To define an absence element: 10 – 8
  To link the absence element: 10 – 10
Defining an Absence Type 10 – 10
  To define an absence type: 10 – 11
Entering Absences 10 – 13
  To enter absences for an employee: 10 – 13
Viewing and Reporting on Absence Information 10 – 15
  Viewing Absence History 10 – 15
  To view absences for an employee: 10 – 15
Listing Employees by Absence Type 10 – 16
  To list employees by absence type: 10 – 16
Absences Report 10 – 17
To run the Absences Report: 10 – 17
Plans for Accrual of PTO 10 – 18
Accrual Start Rules 10 – 19
Length of Service and Accrual Amount Rules 10 – 20
Accrual Plan Setup Steps 10 – 23
To set up a PTO accrual plans: 10 – 23
Defining a PTO Accrual Plan 10 – 23
To define a PTO accrual plan: 10 – 24
Setting Up Length of Service Bands 10 – 25
To set up length of service bands for a PTO plan: 10 – 25
Reviewing or Changing Net Accrual Calculations 10 – 26
Linking the Accrual Plan Elements 10 – 28
To link the accrual plan elements: 10 – 28
Maintaining PTO Plan Records 10 – 29
Enrolling Employees in PTO Accrual Plans 10 – 29
To enroll participants in a PTO accrual plan: 10 – 29
To override the date for calculating length of service: 10 – 29
Recording Accrued Time Taken 10 – 29
Running the PTO Carry Over Process 10 – 30
To run the PTO Carry Over process: 10 – 30
Reviewing Employees’ PTO Accruals 10 – 32
To view an employee’s net PTO accrual: 10 – 32

Chapter 11

Labor Costs 11 – 1
Labor Costs in Oracle HRMS 11 – 2
The Oracle HRMS Cost Allocation Key Flexfield 11 – 2
Use of the Cost Allocation Key Flexfield 11 – 5
Costing Data at the Payroll Level 11 – 6
Costing Data at the Element Link Level 11 – 7
Costing Data at the Organization and Assignment Levels 11 – 9
Costing Data at the Element Entry Level 11 – 10
Setting Up the Cost Allocation Key Flexfield 11 – 11
Controlling the Display of Flexfield Segments 11 – 11
Costing for Taxes 11 – 14
Costing All Taxes by Tax Type 11 – 15
Costing State and Local Taxes by Jurisdiction 11 – 15
Accumulation and Transfer of Payroll Costs 11 – 17
Example of Labor Cost Allocation 11 – 18
Example of Employer Charge Distribution 11 – 19
Running the Costing Processes 11 – 22
To run the Costing process: 11 – 22
Reviewing Costing Process Results 11 – 22
To run a Cost Breakdown Summary report: 11 – 23
Transferring Costs to Oracle General Ledger 11 – 24
To map Cost Allocation to Accounting flexfield segments: 11 – 24
To run the Transfer to GL process: 11 – 25

Chapter 12
Elements: Foundation of Compensation and Benefits 12 – 1
Overview of Elements 12 – 2
The Structure of Elements 12 – 3
Creation of Elements: Definition or Initiation 12 – 4
Using Elements 12 – 6
Element Classifications and Categories 12 – 8
Survey of the Classifications 12 – 10
Classifications and Payroll Run Processing Priorities 12 – 14
Element Input Values 12 – 16
Validation for Input Value Entries 12 – 16
Default Entries for Input Values 12 – 17
Pay Values and Payroll Run Processing 12 – 19
Elements and Formulas 12 – 21
Oracle FastFormula 12 – 21
Element Processing Types 12 – 23
Element Links and Employee Eligibility Rules 12 – 25
Element Entries for Eligible Employees 12 – 27
Manual Element Entry for Individual Employees 12 – 27
Automatic Entry of Elements and Default Values 12 – 27
Batch Element Entry Using MIX Facilities 12 – 29
Entry as an Indirect Result of Payroll Processing 12 – 29
Element Definition 12 – 31
Defining an Element to Hold Information 12 – 32
To identify and classify the element: 12 – 33
To enter processing information: 12 – 33
To establish currencies and qualifying conditions: 12 – 34
To enter a category and benefits carrier 12 – 34
To set up input values for the element: 12 – 35
To enter an element–level default for an input value: 12 – 35
To establish validation for input value entries: 12 – 35
Deleting an Element Entry 12 – 36
To delete an element entry: 12 – 36
Deleting an Element 12 – 36
To delete an element: 12 – 36
Defining Element Links 12 – 38
To define an element link: 12 – 38
To enter costing information for the link: 12 – 39
To enter qualifying conditions for the link: 12 – 40
Reviewing Element Links 12 – 40
To obtain the Element Link Details Report: 12 – 40
Deleting an Element Link 12 – 41
To delete an element link: 12 – 41
Making Manual Element Entries 12 – 42
To inquire on an element entry: 12 – 43
To enter an element for an employee: 12 – 43
Reviewing Element Entries 12 – 45
Viewing Element Entry History 12 – 45
To view element entry history for an employee: 12 – 45
Listing Employees by Element 12 – 46
To view a list of employees receiving an element: 12 – 46

Chapter 13
Batch Element Entry 13 – 49
MIX Facilities for Batch Element Entry 13 – 50
Making Non–Payroll Batch Entries Using BEE 13 – 51
Creating and Updating Batches of Element Entries 13 – 52
To enter a batch header and control totals: 13 – 53
To enter batch lines for an assignment set: 13 – 55
To enter batch lines manually: 13 – 55
To retrieve existing batch lines: 13 – 56
Validating a BEE Batch 13 – 56
To validate a batch: 13 – 57
Transferring a BEE Batch 13 – 57
To transfer a batch: 13 – 57
Purging a Batch From the BEE Tables 13 – 58
To purge a batch: 13 – 58
Rolling Back a MIX Process 13 – 58
To roll back a MIX process: 13 – 58
PayMIX for Payroll Batch Entry 13 – 60
PayMIX Timecard Entries 13 – 62
Dates of Time Entry Batch Lines 13 – 63
One–Time Batch Entries for Earnings and Deductions 13 – 64
Additional Information for Earnings or Deductions Entries 13 – 65
Dates of Earnings and Deductions Entry Batch Lines 13 – 66
PayMIX Scheduling and Statuses ........................................ 13 – 67
Batch Statuses Error, Warning ........................................... 13 – 67
Batch Statuses Hold, Ready, Validated, Transferred ............ 13 – 67
Completing Batch Element Entries Using PayMIX ............. 13 – 69
Identifying PayMIX Batches and Entering Defaults .......... 13 – 69
To identify a batch and enter user counts and totals: .... 13 – 70
To provide default entries for the batch: ...................... 13 – 71
Entering Batches of Timecard Data .................................. 13 – 72
To make time entries from timecards: ...................... 13 – 72
Making Batch Entries for Earnings Types ....................... 13 – 73
To make one–time entries or changes to an earnings type: . 13 – 73
Making Batch Entries for Deductions ............................... 13 – 74
To make one–time entries or changes to a deduction: .... 13 – 74
Running the PayMIX Batch Process ................................. 13 – 75
Reviewing and Correcting PayMIX Process Results ........... 13 – 77
To review and correct PayMIX entries: ...................... 13 – 77

Index

VOLUME 2

Chapter 14

Earnings and Deductions Overview ................................. 14 –1
Earnings and Deductions in Oracle Payroll ....................... 14 –2
Earnings and Deductions Balances ................................. 14 –3
Reviewing Earnings and Deductions ................................. 14 –6
Reviewing Earnings and Deductions Structures ................. 14 –6
To review processing and amount rules: ...................... 14 –7
To review input values and balance feeds: .................... 14 –7
To review formulas and formula result rules: .............. 14 –7
Reviewing Earnings and Deductions Balances ................. 14 –8
To view balances for earnings types: ...................... 14 –8
To view balances for deductions: ................................. 14 –10
Modifying an Element Generated for Payroll Processing .... 14 –12
Summary of Possible Modifications ................................. 14 –12
Modifying Processing Rules ........................................... 14 –14
To modify processing information: .............................. 14 –14
To specify foreign currencies for element entries: .......... 14 –15
To set qualifying conditions for receiving element entries: .. 14 –15
Adding or Changing Further Information ....................... 14 –16
To enable element entries using PayMIX:  14 –16
To change FLSA indicators:  14 –17
To identify a benefits carrier:  14 –17
To change a deduction’s run type:  14 –18
To change a deduction’s partial amount rule:  14 –18

Adding Input Values  14 –19
To add an input value:  14 –19
To enter a default for an input value:  14 –19
To establish validation for an input value entry:  14 –20

Adding Balance Feeds  14 –20
To enter balance feeds:  14 –20

Defining User Balances  14 –22
To define a user balance:  14 –22
To enter balance feeds (Balance Feeds window):  14 –23
To enter balance feeds (Balance Classifications window):  14 –24
To enter balance dimensions:  14 –24

Defining Formula Processing and Result Rules  14 –25
To enter processing rules for an element:  14 –26
To enter formula result rules for a processing rule:  14 –27

Chapter 15

Earnings Types and Other Payments  15 –1
Regular Salary and Regular Wages  15 –2
Regular Non-Worked Hours  15 –7
Creating Regular Non-Worked Hours  15 –7
To create an earnings category to reduce regular wages:  15 –8
To create a regular non-worked hours earnings type:  15 –8
Disabling a Regular Non-Worked Hours Earnings Type  15 –9
To disable a regular non-worked hours earnings type  15 –9
Ending a Regular Non-Worked Hours Earnings Type  15 –9
Overtime  15 –10
Shift Pay  15 –13
GTL Imputed Income  15 –15
Company Car  15 –17
Structures for Initiated Earnings Types  15 –18
Overrides for Tax Jurisdictions and Dates Earned  15 –19
Supplemental Withholding in Regular Runs  15 –20
Payments by Separate Check  15 –22
Limits on Deductions from a Payment  15 –23
Amount Rules for Earnings and Non–Payroll Payments  15 –24
Initiating Earnings and Non–Payroll Payments  15 –27
To set up an earnings type or non–payroll payment: 15–28

Identifying the Earnings or Payment 15–28

To identify, classify and categorize the earnings or payment: 15–28

Entering Processing Rules for the Earnings or Payment 15–29

To enter processing rules: 15–29

Separate Check Payments and Limiting Deduction Processing 15–30

To set up payment by a physically separate check: 15–30

To limit deduction processing against earnings or payment: 15–30

Chapter 16 Deductions 16–1

Deductions 16–1

Structures for Initiating Deductions 16–2

Initiating Deductions 16–3

To set up a deduction: 16–4

Establishing, Changing, and Ending an Employee’s Deduction 16–4

To establish deductions on an employee’s record: 16–5

To change deductions on an employee’s record: 16–5

To end deductions on an employee’s record: 16–5

Identifying the Deduction 16–5

To identify, classify and categorize the deduction: 16–5

Selecting Processing Rules for the Deduction 16–6

To enter processing rules: 16–6

Selecting Start and Stop Rules for the Deduction 16–8

Selecting Frequency Rules for the Deduction 16–9

To enter frequency rules: 16–10

Series EE Bond Deductions 16–11

Determining the Deduction Amount 16–12

To determine the deduction amount: 16–12

Selecting Arrearage Rules for the Deduction 16–13

To manage insufficient funds: 16–13

Setting Up Payroll Tables 16–14

To set up row types that reference database items: 16–15

To set up row types that do not reference database items: 16–16

Setting Up Benefit Tables 16–17

To set up benefit coverage levels and contribution amounts: 16–18

Chapter 17 Wage Attachments 17–1

Wage Attachments 17–1

Structures for Wage Attachments 17–2

Wage Attachment Formulas 17–5

Garnishment Deductions From External Systems 17–6
Initiating Wage Attachments ............................................. 17 –7
  To identify, classify and categorize the wage attachment: .......................... 17 –8
  To end an wage attachment: ............................................. 17 –9
Attaching Wage Attachments to the Employee ................................. 17 –9
  To establish wage attachment on an employee’s record: ......................... 17 –9
  To change wage attachments on an employee’s record: ......................... 17 –10
  To end wage attachments on an employees record: ............................ 17 –10
Making Payments for Wage Attachments ..................................... 17 –10
  To set up payments of a Wage Attachment: .................................... 17 –11
Producing a Check for a Wage Attachment ....................................... 17 –12
  To produce a check for payment of a Wage Attachment: ......................... 17 –12
Wage Attachment Fee Administration ........................................... 17 –14
  Wage Attachment Fee Rules .............................................. 17 –14
  Creating Wage Attachment Fee Rules .................................... 17 –15
    To create a Wage Attachment fee rule: .................................... 17 –16
  Updating Wage Attachment Fee Rules ..................................... 17 –16
    To update a Wage Attachment fee rule: .................................. 17 –17
  Ending Wage Attachment Fee Rules ..................................... 17 –17
    To end a Wage Attachment fee rule: .................................... 17 –17
Reinstating Wage Attachment Fee Rules ......................................... 17 –17
  To reinstate a Wage Attachment fee rule: ................................... 17 –18
Viewing Rules ........................................................................ 17 –18
  To view Wage Attachment Exemption Rules: .................................... 17 –18
  To view Wage Attachment Limit Rules ..................................... 17 –18
Wage Attachment Earnings Rules .................................................. 17 –19

Chapter 18
  Taxes ................................................................................ 18 –1
  Maintenance of Tax Information .................................................. 18 –2
    Tax Information for GREs .................................................. 18 –2
    W–4 and other Tax Data for Employees ...................................... 18 –2
    Taxability Rules for Earnings and Deductions Categories .............. 18 –2
    Rules for Workers Compensation ........................................ 18 –3
    Tax Withholding Methods ................................................... 18 –4
  The Tax Calculation Process ................................................... 18 –5
    Tax Balances ..................................................................... 18 –5
  Entering Federal, State, and Local Tax Rules for GREs ..................... 18 –9
    Entering Federal Tax Rules ................................................ 18 –9
      To enter federal tax rules for a GRE: .................................... 18 –9
    Entering State Tax Rules ................................................... 18 –10
      To enter state tax rules for a GRE: ..................................... 18 –10
    Entering Local Tax Rules ................................................... 18 –12
To enter local tax rules for a GRE:  

Tax Information for an Employee Assignment  

Assignment Location Rules Overview  

Mechanisms for Updating Tax Records  

Update Assignment Location  

Update With Insert Assignment Location  

Update Override of Assignment Location  

Purging Tax Rules Records  

Entering W–4 and Other Tax Data for Employees  

To enter federal tax rules for an employee:  

To enter a new state tax record for an employee:  

To record a rejection of an employee’s requested allowances:  

To enter county tax rules for an employee:  

To enter city tax rules for an employee:  

To adjust the percentage time:  

Supplemental Tax Override  

FIT Override Region  

SIT Override Region  

LIT Override Region  

State Supplemental Tax Override  

Creating, Reviewing and Maintaining Taxability Rules  

Creating Local Taxability Rules  

To create a local taxability rule for an earnings type, or pre-tax deduction:  

Updating Local Taxability Rules  

To update a local taxability rule for an earnings type or pre-tax deduction:  

Ending Local Taxability Rules  

To end a local taxability rule for an earnings type or pre-tax deduction:  

Changing Taxability Rules for an Earnings Type  

To change taxability rules for an earnings type:  

To change taxability rules for a pre-tax deduction:  

Adjustments to Employee Tax Balances  

Correcting Balance Adjustment Entries  

Entering Adjustments to Employee Tax Balances  

To adjust balances of subject wages and taxes withheld:  

To adjust Employee Withheld balances only:  

Viewing Tax Balances  

To review tax balances:  

Contents  xvii
<table>
<thead>
<tr>
<th>Running the Annual FUTA Tax Return Work Sheet</th>
<th>19 –30</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>To run the Annual FUTA Tax Return Work Sheet:</em></td>
<td>19 –31</td>
</tr>
<tr>
<td>Experience Rates</td>
<td>19 –31</td>
</tr>
<tr>
<td>Entering an Experience Rate</td>
<td>19 –32</td>
</tr>
<tr>
<td><em>To enter an experience rate:</em></td>
<td>19 –32</td>
</tr>
<tr>
<td>Employer’s Quarterly Federal Tax Return (Form W–941)</td>
<td>19 –33</td>
</tr>
<tr>
<td>Reporting Quarterly Federal Tax Returns</td>
<td>19 –33</td>
</tr>
<tr>
<td><em>To run the Quarterly Federal Tax Return Work Sheet:</em></td>
<td>19 –34</td>
</tr>
<tr>
<td>Reports on Magnetic Tape</td>
<td>19 –35</td>
</tr>
<tr>
<td>Federal Form W–2</td>
<td>19 –35</td>
</tr>
<tr>
<td>State Quarterly Wage Listings</td>
<td>19 –36</td>
</tr>
<tr>
<td><em>To run the State Quarterly Wage Listing process:</em></td>
<td>19 –36</td>
</tr>
<tr>
<td>Rollbacks of Processes for Reports on Magnetic Tape</td>
<td>19 –37</td>
</tr>
<tr>
<td>Magnetic Media Wage Reporting Utilities</td>
<td>19 –38</td>
</tr>
<tr>
<td><em>To resubmit magnetic media reports:</em></td>
<td>19 –39</td>
</tr>
<tr>
<td><em>To view archived data:</em></td>
<td>19 –39</td>
</tr>
<tr>
<td><em>To compare archived and current data:</em></td>
<td>19 –40</td>
</tr>
<tr>
<td>Retirement Plan Listings: 1099-R</td>
<td>19 –41</td>
</tr>
<tr>
<td>End of Year Reporting</td>
<td>19 –41</td>
</tr>
<tr>
<td>Defining 1099-R Reporting Rules</td>
<td>19 –41</td>
</tr>
<tr>
<td>Submitting a 1099–R Request</td>
<td>19 –42</td>
</tr>
<tr>
<td>1099–R Output</td>
<td>19 –42</td>
</tr>
</tbody>
</table>

**Chapter 20**

<table>
<thead>
<tr>
<th>Workers Compensation</th>
<th>20 –1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workers Compensation Overview</td>
<td>20 –2</td>
</tr>
<tr>
<td>Data for Calculation of WC Premiums</td>
<td>20 –3</td>
</tr>
<tr>
<td>Jobs and WC State Codes and Rates</td>
<td>20 –4</td>
</tr>
<tr>
<td>Premium Modifiers and Surcharges</td>
<td>20 –5</td>
</tr>
<tr>
<td>Payroll Exposure</td>
<td>20 –6</td>
</tr>
<tr>
<td>WC Code Overrides</td>
<td>20 –7</td>
</tr>
<tr>
<td>WC Elements and Formulas in Oracle Payroll</td>
<td>20 –8</td>
</tr>
<tr>
<td>Calculating Employer and Employee Contributions</td>
<td>20 –9</td>
</tr>
<tr>
<td>Setup Steps for Workers Compensation Calculations</td>
<td>20 –12</td>
</tr>
<tr>
<td><em>To set up WC data for a state in which GREs are located:</em></td>
<td>20 –12</td>
</tr>
<tr>
<td>Exempting Employees from Workers Compensation</td>
<td>20 –13</td>
</tr>
<tr>
<td><em>To exempt employees from workers compensation withholding at the assignment level:</em></td>
<td>20 –13</td>
</tr>
<tr>
<td>Associating WC Codes with Rates</td>
<td>20 –13</td>
</tr>
<tr>
<td><em>To enter WC work classification codes and rates:</em></td>
<td>20 –14</td>
</tr>
<tr>
<td>Entering WC Codes, Payroll Exposure Rules and Surcharges</td>
<td>20 –14</td>
</tr>
<tr>
<td><em>To enter WC codes, payroll exposure rules and surcharges:</em></td>
<td>20 –14</td>
</tr>
</tbody>
</table>
Chapter 21

The Payroll Run and Other Payroll Processes

Pay Processing for Payrolls and Individuals
Regular and Supplemental Runs
Assignment and Element Sets for Payroll Processing
Changes to Earnings or Deductions Before a Run
Post–Run Processes
Run Preparation, Execution, and Review
Requirements for Processing Employee Pay
Running Standard Payroll Processing
Consolidating Payroll Information
Temporarily Changing a Payroll’s Consolidation Set
Entering One–Time Changes Before a Run
Defining Exchange Rates
Running the Pre–Payments Process
Running the Payments Processes
Running QuickPay Processing
Reviewing and Changing QuickPay Results
Running Pre–Payments Processing for QuickPay
To run pre–payments processing from the QuickPay window: 21–22
Making a Manual Payment ................................. 21–24
To make a manual payment to an employee: 21–24
Reviewing Pay Process Results ................. 21–26
Reviewing Messages Issued During Processing ........ 21–26
To see messages issued from a payroll process: ........ 21–26
Reviewing Process–Level Results .............. 21–27
To view the results of pay processes: .......... 21–27
To view further information about a payroll process: .... 21–29
Reviewing Assignment–Level Results .......... 21–30
To view process results for an employee assignment: ...... 21–31
To view further assignment processing information: .... 21–32
Viewing Employee Run Result History .......... 21–34
To view a history of run results for an employee: .... 21–34
Reports on Pay Processing ......................... 21–36
Payments Register, Summary and Detail .......... 21–36
To run the Payment Register reports: .......... 21–36
Voided Payments Report ......................... 21–37
Third Party Payment Register ................... 21–37
To run the Third Party Payment Register report: .... 21–38
Gross to Net Summary ......................... 21–38
To run this report: ....................... 21–38
Earnings Audit ................................. 21–38
To run this report: ....................... 21–39
Employee Deductions Taken and Taken Summary ..... 21–39
To run these reports: ...................... 21–39
Employee Deductions Not Taken and Not Taken Summary .... 21–39
To run the Deductions Not Taken reports: .......... 21–40
NACHA Report .................................. 21–40
To run this report: ....................... 21–40
Costing Breakdown Summary Report .......... 21–40
Tax Reports .................................. 21–40

Chapter 22
Post–Run Corrections, Adjustments and Changes .... 22–1
Correction of Run Results .......................... 22–2
Rollbacks ........................................ 22–3
Rolling Back a Process .......................... 22–3
To roll back a process (Payroll Processes window): .... 22–3
To roll back a process (Submit Request window): .... 22–3
To roll back an assignment process: .............. 22–4
Retries ........................................ 22–5
Retrying a Payroll Process ........................................ 22 –5
   To mark a payroll process for retry: ......................... 22 –6
   To mark an individual employee assignment for retry: .... 22 –6
   To mark a group of employee assignments for retry: ....... 22 –6
   To retry a payroll run or other payroll process: .............. 22 –6
Reversals ...................................................................... 22 –8
Reversing Payroll Processing for Employees ................. 22 –8
   To reverse payroll processing for an employee assignment: 22 –9
Adjustments to Balances ............................................. 22 –10
Making Balance Adjustments ....................................... 22 –10
   To adjust a non–tax balance for an employee: .............. 22 –11
Retroactive Pay Processing ......................................... 22 –12
Setup Steps for Retroactive Pay Processing .................... 22 –12
   To process retroactive pay: ...................................... 22 –13
Creating a RetroPay Set ............................................. 22 –14
   To create the RetroPay Set: ...................................... 22 –14
Running the RetroPay Process ................................... 22 –15
   To run the RetroPay process: .................................... 22 –15

Chapter 23
Reports and Inquiries ............................................... 23 – 1
Overview of Inquiry and Reporting Tools ...................... 23 – 2
Inquiry Windows and Folders .................................... 23 – 3
Predefined and User Defined Reports ......................... 23 – 5
QuickPaint .............................................................. 23 – 8
   Defining QuickPaint Reports .................................. 23 – 9
      To define a QuickPaint Report: ............................. 23 – 9
Running QuickPaint Reports ...................................... 23 – 12
   To run a report for one assignment: ......................... 23 – 12
   To run a report for an assignment set: ...................... 23 – 13
Creating an Assignment Set ..................................... 23 – 14
   To define an assignment set using criteria for a formula: 23 – 14
   To define a set by including or excluding assignments: 23 – 16
Custom Reports ....................................................... 23 – 18
   To submit a Custom Report: .................................. 23 – 18
   To register a new Custom Report with parameters: ...... 23 – 19

Chapter 24
Setup for Personal and Assignment Information ............ 24 – 1
Person Types ......................................................... 24 – 2
Defining Person Types ............................................ 24 – 3
   To change a user name for a person type: .................. 24 – 3
To map other user names to a person-type system name: 24 – 3
Person Types and Information Management 24 – 3
Assignment Statuses 24 – 5
Defining Assignment Statuses 24 – 7
To rename a user status: 24 – 7
To supply additional user statuses for a system status: 24 – 7
To create a secondary status: 24 – 8
Setup To Allow Processing After Termination 24 – 8
Defining Special Information Types 24 – 10
To set up Special Information Types: 24 – 10
Enabling Special Information Types 24 – 11
To enable Special Information Types: 24 – 11

Chapter 25
System Administration 25 – 1
The Role of the System Administrator 25 – 2
Setting User Profile Options 25 – 4
Enabling Currencies 25 – 7
To enable a currency: 25 – 7
To disable a currency: 25 – 7

Chapter 26
Audit Trail 26 – 1
AuditTrail 26 – 2
Setting Up AuditTrail 26 – 2
To set up AuditTrail: 26 – 2
Reporting on Audit Information 26 – 4
To run the predefined audit report: 26 – 5
Designing Your Own Audit Report 26 – 6

Chapter 27
Customizing Windows and Menus 27 – 1
Adding New Fields to Windows 27 – 2
Restricting the Data Displayed in a Window 27 – 3
Types of Data Restrictions 27 – 4
Defining an Element or Distribution Set 27 – 5
To define an element or distribution set: 27 – 6
Defining Customized Forms 27 – 7
To define a customized version of a form: 27 – 7
Linking Windows in Task Flows 27 – 9
Windows You Can Use in Task Flows 27 – 10
Defining Task Flow Nodes 27 – 12
<table>
<thead>
<tr>
<th>Chapter 28</th>
<th>Security and Control .............................................</th>
<th>28 – 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Security in Oracle HRMS ........................................</td>
<td>28 – 2</td>
</tr>
<tr>
<td></td>
<td>Access Control through User Responsibilities ..................</td>
<td>28 – 2</td>
</tr>
<tr>
<td></td>
<td>Security Profiles ................................................</td>
<td>28 – 4</td>
</tr>
<tr>
<td></td>
<td>Database Access Without Online Access ..........................</td>
<td>28 – 8</td>
</tr>
<tr>
<td></td>
<td>Menu Structures ...................................................</td>
<td>28 – 8</td>
</tr>
<tr>
<td></td>
<td>Security Groups ...................................................</td>
<td>28 – 9</td>
</tr>
<tr>
<td></td>
<td>Setting Up Security in Oracle HRMS ................................</td>
<td>28 – 10</td>
</tr>
<tr>
<td></td>
<td>To set up a new responsibility for Oracle HRMS: ..........</td>
<td>28 – 11</td>
</tr>
<tr>
<td></td>
<td>To set up a new reporting user: ................................</td>
<td>28 – 11</td>
</tr>
<tr>
<td></td>
<td>Defining Security Profiles ......................................</td>
<td>28 – 13</td>
</tr>
<tr>
<td></td>
<td>To define a security profile: ...................................</td>
<td>28 – 13</td>
</tr>
<tr>
<td></td>
<td>Running the HRMS Security Processes ............................</td>
<td>28 – 15</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 29</th>
<th>QuickCodes and User Tables ..................................</th>
<th>29 – 1</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QuickCodes ..........................................................</td>
<td>29 – 2</td>
</tr>
<tr>
<td></td>
<td>Adding QuickCode Values ........................................</td>
<td>29 – 3</td>
</tr>
<tr>
<td></td>
<td>To add QuickCodes: .................................................</td>
<td>29 – 3</td>
</tr>
<tr>
<td></td>
<td>Removing QuickCode Values .......................................</td>
<td>29 – 3</td>
</tr>
<tr>
<td></td>
<td>To remove a user defined QuickCode: ..........................</td>
<td>29 – 3</td>
</tr>
<tr>
<td></td>
<td>Defining QuickCode Types ........................................</td>
<td>29 – 5</td>
</tr>
<tr>
<td></td>
<td>To define a new QuickCode Type: ................................</td>
<td>29 – 5</td>
</tr>
<tr>
<td></td>
<td>User and Extensible QuickCodes ..................................</td>
<td>29 – 6</td>
</tr>
<tr>
<td></td>
<td>User–defined Tables ..............................................</td>
<td>29 – 10</td>
</tr>
<tr>
<td></td>
<td>Predefined User Tables ...........................................</td>
<td>29 – 11</td>
</tr>
<tr>
<td></td>
<td>Setting Up User Tables ............................................</td>
<td>29 – 14</td>
</tr>
<tr>
<td></td>
<td>To set up the structure of a table: ................................</td>
<td>29 – 14</td>
</tr>
<tr>
<td></td>
<td>To enter column labels: ...........................................</td>
<td>29 – 15</td>
</tr>
<tr>
<td></td>
<td>To enter row labels: ................................................</td>
<td>29 – 16</td>
</tr>
<tr>
<td></td>
<td>Entering Table Values .............................................</td>
<td>29 – 17</td>
</tr>
</tbody>
</table>
Chapter 30

Integrating With Other Systems .............................. 30 – 1
Using Oracle Human Resources with Oracle Payroll ........ 30 – 2
Using Oracle HRMS with Spreadsheets ..................... 30 – 5
Using Attachments ............................................. 30 – 6
Using Letters to Manage Recruitment and Enrollment .... 30 – 10
Setting Up Standard Letters .................................. 30 – 11
Concurrent Processing ........................................... 30 – 13
Using a Word Processor ........................................ 30 – 14
  Which Word Processor? ....................................... 30 – 15
Flowchart for Setting Up Standard Letters Using MultiMate  or WordPerfect ........................................ 30 – 15
Planning ............................................................ 30 – 16
Writing a SQL*Plus Script for MultiMate or WordPerfect . 30 – 17
  To write a SQL*Plus script for MultiMate or WordPerfect: 30 – 18
Registering the SQL*Plus Script for MultiMate or  
WordPerfect ....................................................... 30 – 18
  To define a standard letter type: .......................... 30 – 19
Writing a Skeleton Letter ....................................... 30 – 19
Requesting Letters for MultiMate or WordPerfect ........... 30 – 20
  To submit an automatic letter request: .................. 30 – 21
  To create a manual letter request: ....................... 30 – 21
Merging the Data File With the Standard Letter MultiMate or  
WordPerfect ....................................................... 30 – 22
Flowchart for Setting Up Standard Letters Using Microsoft 
Word ............................................................... 30 – 23
Writing a SQL*Plus Script for Microsoft Word ............... 30 – 24
  To write a SQL*Plus script for Microsoft Word: ... 30 – 25
Generating a Microsoft Word Letter ........................... 30 – 26
  To generate and merge a Microsoft Word document: ... 30 – 26
Using Oracle Reports ........................................... 30 – 28
Planning the Content and Layout ............................ 30 – 28
Writing the Report ............................................... 30 – 29
Registering the Report .......................................... 30 – 29
  To define a standard letter type: ......................... 30 – 30
Running the Report ............................................. 30 – 30
  To submit an automatic letter request: ................. 30 – 30
  To create a manual letter request: ...................... 30 – 31
### Appendix A

**Default Menus** ........................................... A – 1  
Default Navigation Menus for HR with Payroll Responsibility . A – 2  
Default Navigation Menus for Payroll Responsibility .......... A – 10  
Windows and their Navigation Paths .......................... A – 15

### Appendix B

**Key and Descriptive Flexfields** .......................... B – 1  
User Definable Key Flexfields ................................. B – 2  
User Definable Descriptive Flexfields ....................... B – 5  
List of Descriptive Flexfields ............................... B – 6  
Descriptive Flexfields with Startup Data .................... B – 9  
Changing Address Styles .................................... B – 9  
Protected Flexfields ...................................... B – 10

### Appendix C

**Database Items** ........................................... C – 1  
Static Database Items ........................................ C – 2  
Applicant Information ....................................... C – 2  
Employee Assignment Information ........................ C – 2  
Contact Addresses .......................................... C – 7  
Contact Information ......................................... C – 8  
Employee Hire Information ................................ C – 10  
Location Details ........................................... C – 10  
Payroll Details ............................................. C – 12  
People Addresses ........................................... C – 13  
People Information ......................................... C – 15  
Recruiter Information ...................................... C – 17  
Supervisor Information ................................... C – 18  
Date Information ........................................... C – 18  
Dynamic Database Items .................................... C – 19  
Element Database Items ................................... C – 19  
Grade Rate Database Items ................................ C – 22  
Pay Scale Rate Database Items ............................ C – 22  
Descriptive Flexfield Database Items ....................... C – 23  
Key Flexfield Database Items .............................. C – 25  
Absence Database Items .................................... C – 26

### Appendix D

**Template SQL*Plus Scripts** .............................. D – 1  
Template SQL*Plus PERWPOUK ............................. D – 2  
Template SQL*Plus Script PERWPWUK .................... D – 6  
OTA SQL*Plus Script to Produce Confirmation Letters ... D – 8

xxvi  Oracle Payroll US User’s Guide

This guide includes the information you need to set up Oracle Payroll to meet the requirements of your enterprise. It describes how you can represent your enterprise structures, policies and people on the system and use this information to manage your payroll. It contains detailed information about the following:

- Overview and reference information
- Oracle Payroll implementation suggestions
- Specific tasks you can accomplish using Oracle Payroll
- How to use Oracle Payroll forms and windows
- Oracle Payroll programs, reports, and listings
- Oracle Payroll functions and features

This preface explains how this user’s guide is organized and introduces other sources of information that can help you.
About This User’s Guide

• Chapter 1 describes the requirements of human resource and payroll management, and the processes they involve. This provides the context for the information model you can construct in Oracle HRMS.

• Chapters 2 through 6 explain how to represent your enterprise structures, including organizations, jobs and positions, grades, and payrolls, including retirement structures.

• Chapter 7 describes three models appropriate to three different types of enterprise. It covers the set up of each of these structures, explains how to set up the system to collect costing information during a payroll run.

Once you have set up this key information in the system, you can consider how to use Oracle Payroll to help you with the main payroll management tasks.

• Chapters 8 and 9 explain how you can enter people on the system, assign them to work structures, and hold various kinds of information about them. These chapters also introduce you to the basics of hiring, redeploying, and termination of employment.

• Chapters 10 through 23 cover the key management processes and how you might use Oracle HRMS to support them.
  - Absence and attendance
  - Compensation and Benefits
  - Earnings and Deductions
  - Wage Attachments
  - Taxes
  - Tax and Wage Reporting
  - Worker’s Compensation
  - Payroll Run and Post Run Corrections
  - Reports and Inquiries

The final chapters of the guide focus on tasks for the system administrator and setup team.

• Chapter 24 explains how to set up person types and assignment statuses, and how to define special information types.
• Chapters 25 and 26 explain how you can customize the way information is entered and extracted from the system. This includes:
  – customizing inquiry windows and writing reports
  – customizing the user interface
  – adding your own fields to windows
• Chapter 27 explains how to set up QuickCodes and user tables to add lists and tables of valid values to the system.
• Chapter 28 looks at how you can integrate Oracle Human Resources with Oracle Payroll, and use it with other software such as word processors and spreadsheets. These chapters also consider how you control security of access, set up security, and set up an audit trail.

The Appendixes provide a reference source about the default menus, and about flexfields and database items in Oracle HRMS. Appendix C provides a template SQL*Plus script for use with standard letters.

**Audience for this Guide**

This guide assumes you have a working knowledge of the following:

• the principles and customary practices of your business area
• Oracle Payroll
  If you have not yet used Oracle Payroll we suggest you attend one or more of the training classes for this product available through Oracle Education.
• the Oracle Applications graphical user interface.
  To learn more about this, read the *Oracle Applications User’s Guide.*

See Other Information Sources below for further details of Oracle Applications product information.

**Do Not Use Database Tools to Modify Oracle Applications Data**

Oracle provides powerful tools you can use to create, store, change, retrieve and maintain information in an Oracle database. But if you use
Oracle tools like SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications forms, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

Consequently, we STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our manuals.

Other Information Sources

You can choose from many sources of information, including documentation, training, and support services, to increase your knowledge and understanding of Oracle Payroll.

Online Documentation

All Oracle Applications user’s guides are available online, in both HTML and Adobe Acrobat format. Most other Oracle Applications documentation is available in Adobe Acrobat format.

The paper and online versions of this manual have identical content, and you can use whichever format is more convenient.

The HTML version of this book is optimized for on-screen reading, and lets you follow hypertext links for easy access to books across our entire library. You can also search for words and phrases if your national language is supported by Oracle’s Information Navigator.
The HTML documentation is available from the Oracle Applications toolbar, or from a URL provided by your system administrator. Note that the HTML documentation is translated into over twenty languages.

You can order an Oracle Applications Documentation Library CD containing Adobe Acrobat versions of each manual in the Oracle Applications documentation set. Using this CD, you can search for information, read it on–screen, and print individual pages, sections, or entire books. When you print from Adobe Acrobat, the resulting printouts look just like pages from an Oracle Applications hardcopy manual.

Most Oracle Applications documentation is available in Adobe Acrobat format on the Oracle Applications Documentation Library CD. We supply this CD with every software shipment.

If this guide refers you to other Oracle Applications documentation, use only the Release 11 versions of those books unless we specify otherwise.

Related User’s Guides

Oracle Payroll shares business and setup information with other Oracle Applications products. Even if you have not installed them as separate products, your Oracle Payroll application includes some forms and functionality from other Oracle Applications. Therefore, you may want to refer to other user’s guides when you set up and use Oracle Payroll.

If you do not have the hardcopy versions of these manuals, you can read them by choosing Library from the Help menu, or by reading from the Oracle Applications Document Library CD, or by using a web browser with a URL that your system administrator provides.

Oracle Human Resources User’s Guide

This guide is aimed at HR managers and explains how to set up and use Oracle Human Resources to meet the requirements of your enterprise. It describes how you can represent your enterprise structures, policies, and people on the system and use this information to manage your human resources.
Oracle Training Administration User’s Guide
This guide explains how you can use OTA with Oracle HR to support each part of your enterprise’s training cycle.

Application Data Export User’s Guide
This guide is aimed at end-users, system administrators and consultants. It describes how you can use ADE to export data from Oracle Payroll into either a spreadsheet or mail merge application. It also contains information on how to install ADE.

Oracle HRMS Implementation Guide
This guide includes modular implementation flowcharts and checklists to assist with your project planning. It contains a summary of the sequence of recommended steps for implementing Oracle Payroll and Oracle Payroll. Full instructions for each implementation step are contained in the User’s Guide.

Oracle Applications User’s Guide
This guide explains how to navigate, enter data, query, run reports, and introduces other basic features of the graphical user interface (GUI) available with this release of Oracle Applications. It also includes information on setting user profiles, as well as running and reviewing reports and concurrent requests.

You can access this guide online by choosing “Getting Started with Oracle Applications” from any Oracle Applications help file.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup, and reference information for your implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This guide also provides information on creating custom reports on flexfields data.

Oracle Workflow Guide
This manual explains how to define new workflow business processes as well as customize existing Oracle Applications–embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow–enabled processes.
Oracle Alert User’s Guide
Use this manual to define periodic and event alerts that monitor the status of your Oracle Applications data.

Country–Specific Manuals
Use these manuals to meet statutory requirements and common business practices in your country or region. They also describe additional features added to Oracle Payroll to meet those requirements. Look for a User’s Guide appropriate to your country. For example, Oracle user’s guides for Japanese users exist in the Japanese language.

Oracle Applications Implementation Wizard User’s Guide
If you are implementing more than one Oracle product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. This guide describes how to use the wizard.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the Oracle Applications User Interface Standards. It also provides information to help you build your custom Developer/2000 forms so that they integrate with Oracle Applications.

Oracle Applications User Interface Standards
This manual contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms 4.5.

Installation and System Administration

Oracle Applications Installation Manual
This manual and the accompanying release notes provide information you need to successfully install Oracle Financials, Oracle Government Financials, Oracle Manufacturing, or Oracle Human Resources in your specific hardware and operating system software environment.
Oracle Applications Upgrade Manual

This manual explains how to prepare your Oracle Applications products for an upgrade. It also contains information on finishing the upgrade procedure for each product. Refer to this manual and the Oracle Applications Installation Manual when you plan to upgrade your products.

Oracle Applications System Administrator’s Guide

This manual provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage processing.


This manual contains database diagrams and a description of Oracle HRMS database tables, forms, reports, and programs. This information helps you convert data from your existing applications, integrate Oracle HRMS with other non–Oracle applications, and write custom reports.

You can order a technical reference manual for any product you have licensed. Technical reference manuals are available in paper format only.

Other Information

Training

Oracle Education offers a complete set of training courses to help you and your staff master Oracle Applications. We can help you develop a training plan that provides thorough training for both your project team and your end users. We will work with you to organize courses appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training throughout the implementation process so that the right amount of information is delivered to key people when they need it the most. You can attend courses at any one of our many Educational Centers, or you can arrange for our trainers to teach at your facility. In addition, we can tailor standard courses or develop custom courses to meet your needs.
Support
From on–site support to central support, our team of experienced professionals provides the help and information you need to keep Oracle Payroll working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.

Finding the Latest Information
For information about any new features that were not available when this user’s guide was printed, look at the What’s New? section on the main Help menu. This information is updated for each new release of Oracle Payroll HTML Help.

About Oracle
Oracle develops and markets an integrated line of software products for database management, applications development, decision support, and office automation, as well as a complete family of financial, manufacturing, and human resource applications.

Oracle products are available for mainframes, minicomputers, personal computers, network computers, and personal digital assistants, allowing organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle offers its products, along with related consulting, education, and support services, in over 140 countries around the world. Oracle Corporation is the world’s leading supplier of software for information management, and is the world’s second largest software company.

Thank You
Thank you for using Oracle Payroll and this user’s guide.
We value your comments and feedback. At the end of this manual is a Reader’s Comment Form you can use to explain what you like or dislike about Oracle Payroll or this user’s guide. Mail your comments to the following address or call us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA  94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
Oracle Human Resource Management Systems is the family name for an integrated group of applications that support the management of people. This chapter reviews the business needs of human resource management and how they are met by Oracle HRMS. It provides an introduction to key components and special features of the system.
Human Resource Management

The term Human Resource Management owes much to the view that employees are an asset to be managed in the same way as other, non-human, assets.

When the emphasis is on Resource Management, then in the formal accounts of any enterprise, people appear only as costs. However, they can also be thought of as assets in the sense that they are a productive resource, requiring proper maintenance and renewal.

People Management

The management of people within any enterprise involves a complex and dynamic inter-relationship of management and personal skills. This complexity results in a unique set of structures and policies within each enterprise.

This unique identity is often referred to as the culture of the enterprise, and as the enterprise develops so does its unique culture.

Company Culture

The organizational structures of an enterprise, the ways in which its employees work, and its compensation policies all reflect its unique culture. This culture is also evident in more subtle ways, including enterprise policies on information sharing and decision making.

The cultural diversity of enterprises is reflected in their implementation and use of information systems. It is generally true that all companies need a human resource information system. However, the information they require, its structure, and the means by which they obtain it, produce a different system in every case.

Packaged systems solutions like Oracle HRMS provide a core system, which each enterprise customizes to meet its own needs. Customization involves the definition of special information requirements, structures, and processes. It also involves analysis of the working practices associated with day-to-day maintenance and use of the system.

Changing Role of Human Resource Management

Human resource management was originally an administrative and welfare role within an enterprise. This often included recruitment and record-keeping functions.

This role was primarily reactive in nature. Human Resources responded to the needs of both managers and employees, but did not anticipate them.
In the last few decades, human resource management has evolved and assumed a more *proactive* role. This reflects the recognition of the importance of managing people in the successful achievement of enterprise objectives.

The result now is that this function within many enterprises encompasses responsibilities that include a wide ranging spectrum of activities.

**Payroll Management**

In contrast, payroll management has traditionally been a function of the Finance Group in most enterprises. It has been responsible for the correct payment of employees in line with local and national legislation as well as company policy.

Often this has been a reactive and operational role in which payroll staff responded to the needs of both line managers and employees.

**Separate v. Integrated HRMS Systems**

Traditionally, Human Resources and Payroll groups have both been responsible for holding and managing human resource information – often in separate systems.

There is growing acknowledgement of the importance of complete, accurate, and timely information about the people within an enterprise. This has led to a greater demand for information derived from both Human Resources and Payroll sources.

Historically this was achieved by the development of *Interface* products, which allowed technical specialists to transfer data between the two systems.

Many systems attempt to simplify the transfer of data between two systems. Oracle HRMS is one of the first to provide a truly *integrated* system, which both functions can genuinely share. At the same time, it is flexible enough to be implemented for use in a human resources only or a payroll only environment. In each case you have access to the full range of functionality associated with human resources or payroll.
Human Resources and Payroll Activity Cycles

We can look at the range of human resource activities as an inter-related cycle of functions, as shown in Figure 1 – 1.

The payroll user is concerned with operational and legislative aspects, which introduce a number of external factors that the information system must deal with. These include legislative requirements, auditing requirements and payroll costing. We can look at the operational factors and the effects of the external factors as an interrelated cycle of functions, as shown in Figure 1 – 2.
Figure 1 – 2
The Payroll Cycle

- Define and Administer Payrolls
- Define and Maintain Organization Structures
- Define and Administer Earnings & Deductions
- Maintain Employee Records
- Process Payrolls
- Reconcile Payrolls
- Set Objectives
- Cost Payroll Transactions and Transfer to External Systems

- Legislation: Tax and Insurance
- Statutory Reporting
- Auditing
- Ad hoc Reporting
Introduction to the HRMS Model

With Oracle HRMS you can define your own human resource model to reflect your own enterprise structures and policies. This information model lets you record the personal, work, and pay information for all the people you want to hold and process.

The model is both flexible and adaptable. It is flexible, so that you can reflect the needs of different companies, or different groups within the same company. It is adaptable, so that you can easily change the basic model as your enterprise changes.

See: Managing Change Over Time: page 1 – 9

People

In Oracle HRMS, you can hold information about current and former employees, applicants, external contacts such as contractors, and employee contacts such as relatives and dependents.
In addition to standard information such as addresses, nationality, interview records, qualifications, and absence information, you can define any other special information you need to hold for people. For example, you can define what information to hold on medical history, previous employment, or outside interests.

See:
- Entering Personal Information: page 8 – 4
- Entering Special Information: page 8 – 27

**Work Structures**

Work structures represent the different ways in which employees can work within your enterprise. They provide the framework for defining the work assignments of your employees. They also enable you to manage the information about your enterprise that is independent of your employees.

The work structures include your internal organizations (such as departments or divisions), payrolls, jobs or positions, grading structures, and any special employee groupings that you use in your enterprise.

See:
- Representing the Employer: Business Groups: page 2 – 4
- Representing the Employer: GRES: page 2 – 9
- Representing Organizations: page 2 – 14
- Representing Jobs and Positions: page 3 – 2
- Representing Grade Structures: page 4 – 2
- Representing Payrolls: page 5 – 2
- Representing Other Employee Groups: page 5 – 10

**Compensation and Benefits**

In Oracle HRMS you can define your own types of compensation and benefits, and the business rules you want to apply to them. As you change policies, move people within your enterprise, and adjust their individual remuneration packages, the system maintains their compensation and benefit history.

For example, suppose you want to define a special type of payment and make this available only to employees who work at a particular location. In Oracle HRMS you use a compensation element to represent
Assignments

In Oracle HRMS, the assignment describes employees’ places within the enterprise: the organization for which they work, their role, grade, location, and so on. As you change the assignment information for an employee, you automatically build up his or her work history.

Your compensation eligibility rules link compensation and benefits to work structures, such as jobs or grades. The assignment places employees within the work structures of the enterprise. In this way, an employee’s assignment determines his or her eligibility for compensation and benefits.

You can use assignments to identify major employee groups within the enterprise for management, for reporting and costing, and for compensation and benefit planning and administration.

See: The Employee Assignment: page 9 – 4
Managing Change Over Time

A key requirement for any enterprise is the ability to manage change confidently and effectively. Typical enterprise changes include corporate restructuring, departmental reorganization, mergers and de–mergers of companies, centralization or decentralization of control and decision making, employee development and turnover.

In Oracle HRMS, you can change each of the major parts of your enterprise model without having to redefine the other parts.

Work Structures

You can attach dates to your work structures to manage different versions over time. You retain previous versions for historical information and you can create future–dated versions to prepare for reorganization in advance.

You can also set up in advance the business rules, including compensation and benefits, associated with the new structures. These become effective on the date you specify, avoiding a workload peak.

People, Assignments, and Compensation and Benefits

In contrast to work structures, which are simply dated, other key dynamic information in Oracle HRMS is datetracked. This includes information on employees, assignments, and compensation and benefits. DateTrack allows you to maintain a continuous history of the information over time.

When reviewing, entering, changing or deleting datetracked data, you can set an effective date in the past or future. The system uses only information in effect as of that date for whatever you do. When you make a change, you can choose whether it is a correction to the last update or a new update to be recorded in the history of the record. You can use DateTrack History to view a report of every update ever made to a record.

You can identify windows containing datetracked, rather than dated, information by the presence of a region labelled Effective Dates.
Dated Information and Hierarchy Versions

The information in Oracle HRMS about your locations, organizations, jobs, positions, grades, payrolls and other work structures is dated information. All dated information has From and To dates, that is, dates from and to which it is in effect in your enterprise. For example, when defining a position, you enter a date from which it starts. To close it down, you give it a date to which it remains valid.

Oracle HRMS does not permit you to assign employees to structures on dates earlier than their Date From, or later than their Date To. Similarly, the system protects you from building eligibility rules for compensation and benefits based on work structures that have not yet gone into effect, or are out of date.

Suggestion: Consider using a fixed date, such as 01–JAN–1901 as the start date for all your initial work structures. By choosing a date like this you can immediately identify all of your implementation definitions. You should use accurate dates for all subsequent definitions.

Dated Versions of Hierarchies

You can structure the organizations and positions you enter in Oracle HRMS into organization or position hierarchies that serve various purposes. Reporting hierarchies, for example, reflect reporting lines within your enterprise.

You maintain both dates and version numbers for these hierarchies, to keep a history of your hierarchies as they change over time.

To build a new version of a hierarchy, you can copy an existing one and make the necessary changes to it. When you save the new version the system automatically gives the previous version an end date.

DateTrack

All important dynamic information in Oracle HRMS is datetracked, including information about people, assignments, payrolls, and compensation and benefits.

You can enter datetracked information or make changes to it at any time. When you set an effective date for your work, DateTrack ensures that only information effective on that day is used for any processing, validation, and reporting you carry out. You can view a history of every change made to datetracked information.
Setting Your Effective Date

When you log on to Oracle HRMS, your effective date is always today’s date. To view information current at another date, or to make retrospective or future-dated changes, you need to change your effective date.

There is a DateTrack:Date Security user profile option, which determines whether you can change your effective date. Your system administrator sets this profile option. You can check its value on the Personal Profile Values window. There are four possible values:

- **All**: You can change to any other effective date.
- **Future**: You can change between today’s date and any future dates.
- **Past**: You can change between today’s date and any past dates.
- **Present**: You cannot change to a date other than today.

To set your effective date:

1. Save any outstanding information you have entered or changed, then choose the Alter Effective Date icon from the Toolbar. The Alter Effective Date window opens.
2. Enter a new effective date and choose OK.

If your current window is a “top-level” window (one called directly from the Navigator), your new effective date remains in place until you reset it or exit Oracle HRMS. If your current window is not a top-level window, your new effective date only applies while you are working in the current window and any windows subsidiary to it. When you return to a top-level window, your effective date is reset to its previous value.

**Note**: In certain special cases, when you change your effective date on a subsidiary window, Oracle HRMS returns you to the previous window, and you may have to requery the records.
you want to view or update. This protects the integrity of these records.

So long as your effective date remains different from today’s date, it is displayed in the title bar of every window.

Effective Date Reminder

When you are new to DateTrack, you may find it useful to be reminded of your effective date whenever you open a window that contains datetracked information. The reminder appears in a Decision window and asks whether you want to change your effective date. If you choose Yes, the Alter Effective Date window displays.

There is a user profile option called DateTrack:Reminder that determines when the Decision window appears. There are three possible values for this profile option:

- Always
- Never
- Not Today

The Not Today value causes the reminder to appear when you navigate to a datetracked window and your effective date is not today’s date.

You can set the value of this profile option in the Personal Profile Values window.
Viewing Datetracked Information and History

Oracle HRMS maintains a continuous record of changes made to datetracked information. When you view a record in a datetracked window, it shows you a snapshot of the information on your effective date. The Effective Dates region on the datetracked window shows you the dates between which the snapshot is valid.

Suppose you are viewing an assignment with an effective start date of 01–JAN–1987 and no effective end date. This means that the assignment was created or last changed on 1 January 1987, and the snapshot information you are viewing is still valid. There have been no changes to the assignment since 1 January 1987, and there are no future dated changes.

To find out whether the assignment existed before 1 January 1987, you should use DateTrack History.

If there is an effective end date, you know that the record was either deleted or changed on the next day. To find out whether the record continues to exist, you can set your effective date to the day after this end date, or use DateTrack History.

Viewing the History of Datetracked Information

To see all the changes made to a datetracked record over time, use DateTrack History.

To view DateTrack History:

1. Choose the DateTrack History icon from the Toolbar.
   The DateTrack History Change Field Summary window opens. Each row shows which fields were changed on the From date.

2. Choose the Full History button if you want to open a DateTrack History folder showing the value of each field between the effective
dates. The row for the current snapshot (corresponding to your effective date) is highlighted.

You can use the Folder menu to select the fields to view in the folder.

Note: It is possible to customize the information displayed in the Folder by modifying the DateTrack History view for the underlying table.

See: How To Create and Modify DateTrack History Views, *(Oracle HRMS Implementation Guide)*

### Updating and Correcting Datetracked Information

When you update datetracked information, you are prompted to choose between Update and Correction.

If you choose Update, Oracle HRMS changes the record as from your effective date, but preserves the previous information. If you choose Correction, Oracle HRMS overrides the previous information with your new changes. The start and end dates of the snapshot you have corrected remain the same.

**Example**

Suppose you hire two new employees, Jack Lee and Julie Summers. A few weeks later Julie gets married. At the same time you discover an error in Jack’s record relating to his nationality.

You *update* Julie’s information by setting your effective date to the date of her wedding and entering her new married status, her change of name, and new next of kin information. Her previous personal information, which was valid until her wedding, remains in her record.

You *correct* Jack’s wrong nationality by setting your effective date to his hire date and entering the correct nationality. By choosing Correction, you put the record right, from the beginning. You should check whether there is an end date in the Effective Dates region of Jack’s record. If there is, you have only corrected the first snapshot of the record. Set your effective date to the day after the end date, and make the correction again. Continue in this way until the To field is blank, indicating that you have reached the last snapshot of this record.

### Updating a New Record

You cannot create a record and then update it on the same day. If you try to do this, Oracle HRMS warns you that the old record will be
overridden, and then changes Update to Correction. This is because 
DateTrack maintains records for a minimum of a day at a time.

Future Updates

Using DateTrack, you can make future updates. For example, suppose 
you are relocating an employee, with six months notice. You decide to 
enter the relocation on the system straight away. So you set your 
effective date to the first day when the employee will be at the new 
location, and change the location on the assignment.

Later that month you promote the employee to a new grade. So you 
set your effective date to today’s date and change the grade on the 
assignment. Oracle HRMS checks to see whether the record has a 
future update scheduled. It finds that the location changes in the 
future and prompts you for the type of update you now want to make. 
You have two choices:

- **Insert:** This simply inserts the change before the next scheduled 
  change. This is the correct choice for the example. The 
  employee would be promoted from today. The future–dated 
  relocation still takes place in six months time.

- **Replace:** This change replaces all future–dated changes. In the 
  example, the employee would be promoted from today. 
  However, the record of the relocation would be completely 
  removed from the system.

Deleting Datetracked Information

When you delete datetracked information, Oracle HRMS prompts you 
with the following options:

- **End Date:** This ends the record on your effective date. When 
  you requery the record, this end date displays in the To field.

- **Purge:** This totally removes the record from your database.

If there are any future updates to the record after your effective date, 
Oracle HRMS may prompt you with another two options:

- **All:** This removes all future updates to the record. The current 
  snapshot is valid until you make another change.

- **Next:** This removes the next future update to the record. It then 
  resets the current snapshot’s end date to the end date of the 
  deleted update.
Note: You do not always see all of these options when you choose to delete. Some windows do not allow all four operations.

Removing an End Date

If you have mistakenly set an end date on a datetracked record, you can remove it.

To remove an end date:
1. Set your effective date to the day the record ends.
2. Choose Delete Record from the Edit menu.
3. Choose the DateTrack delete option Next. This removes the next change to the record, which is the end date. Save your work.
Work Structures and Key Flexfields

Before you begin defining your enterprise’s work structures, you set up some key flexfields.

*Key flexfields* are a special feature of Oracle Applications. They help you customize applications, by holding particular information your enterprise needs where you need it. A key flexfield can hold as many as 30 separate segments of information. You can determine exactly what information to hold and how it must be entered.

Oracle HRMS includes six user–definable key flexfields. These are especially useful in helping you build information on work structures that suit the mission and culture of your enterprise.

**Job and Position Name**

Using these key flexfields, you determine the number of segments in your job and position names or codes, and the valid values for each segment.

For example, you may want names that are simple titles using one flexfield segment only, such as Account Manager or Programmer. Or, you may want multiple–segment names that convey more information, such as Senior.Account Manager or Part–time.Trainee.Programmer.

See: Representing Jobs and Positions: page 3 – 2

**Personal Analysis**

The Personal Analysis key flexfield is for holding information about:

- the various requirements for your jobs and positions, such as educational attainment, certification or license types and levels, or language skills
- the educational levels, qualifications, skills and other personal attributes of your employees or applicants, which match your job or position requirements
- a wide range of other types of information you need to keep on record for your workforce, for example, company car usage, workplace accidents, and immunizations for communicable diseases.

You can define up to 30 instances of the Personal Analysis flexfield structure, each holding one special information type.

**Grade Name**

You may want to use simple, single–segment grade names (A, B, C), or more complex grade names (Manual.A.1, Manual.A.2, Clerical.C.1, Clerical.C.2).
People Group

The People Group key flexfield is for setting up special groupings of employees. For example, you can set up a segment of this flexfield to hold all the unions present at your enterprise. When you give an employee an assignment, you can use this segment to record his or her union membership.

As another example, you can set up a segment as Company, holding a list of the companies comprising your enterprise. You can then use this group to assign each employee to a company.

See: Representing Other Employee Groups: page 5 – 10

Cost Allocation

The Cost Allocation key flexfield is for maintaining data needed to transfer information on employee costs from your payrolls to the general ledger, and to labor distribution systems.

For example, you might define one segment of the Cost Allocation flexfield to hold a list of your cost centers, another to hold GL account codes, and a third to hold labor distribution codes.

You would then make choices from these lists to tell the system how to collect payroll costs. For example, when you enter a department into Oracle HRMS, you could select the cost center against which to collect the employee costs of the department.

If you are using Oracle General Ledger, you can map segments of the Cost Allocation flexfield to segments of the GL Accounting flexfield.

See: Costing in Oracle HRMS: page 11 – 2

See Also

*Oracle Applications Flexfields Guide*
Chapter 2

The Employer and Other Organizations

This chapter explains how to represent your enterprise in Oracle HRMS, and how to set up default information applicable across the enterprise.

It further explains how to represent:

• the physical work locations of your employees
• organizations internal to your enterprise, such as companies, departments, divisions, units, and if needed, retirement organizations
• external organizations of importance to human resource management, such as recruitment agencies, insurance providers and tax authorities
• reporting lines and other relationships among these organizations. You represent these relationships by building organization hierarchies.
Site Locations

In Oracle HRMS, you set up each physical site where your employees work as a separate location. Similarly, you enter the addresses of external organizations that you want to maintain in your system, such as employment agencies, tax authorities, and insurance or benefits carriers. When setting up internal or external organizations, you pick from a list of these locations.

This approach has these advantages:

- You enter information about each location only once, thereby saving data entry time.
- Central maintenance of locations ensures consistency of address standards.
- Your work sites exist as separate structures identifiable for reporting purposes, and for use in the rules that determine employee eligibility for various types of compensation and benefits.

Setting Up Site Locations

Enter site addresses in the Location window.

Locations are shared across Business Groups in Oracle HRMS and with two other Oracle applications: Inventory and Purchasing. Oracle HRMS does not use some of the fields in the Location window. These fields are disabled for HRMS users.
To enter a work location and its address:

1. Enter the name of the location, and a description if required.
2. Select a national address style from the list. A window opens with the address format for the country you select.
3. Enter address information in this window and choose the OK button.

Additional Information: Default address styles are predefined for many countries. You can add address styles for other countries, if required.

Removing Site Locations

You cannot delete locations, but you can make them inactive.

To remove an address from the Location list:

- Enter an inactive date from which the location is no longer in use in your enterprise.
Representing the Employer: The Business Group

The largest organizational unit you set up in Oracle HRMS to represent your enterprise as an employer is the Business Group. A Business Group may correspond to a company or corporation, or in large enterprises, to a holding or parent company or corporation.

By default, all employees you enter in Oracle HRMS receive an assignment to their Business Group. When you give them assignments to internal organizations such as divisions or departments, these replace the default assignment, but their records continue to exist within the Business Group.

Within a Business Group, you set up one or more Government Reporting Entities (GREs). A GRE represents an employer the federal government recognizes as being responsible for paying employees and for filing a variety of reports government agencies require, and is distinguished by having a unique IRS (Internal Revenue Service) identification number.

A Business Group with companies or divisions that have their own IRS identification numbers includes a GRE for each one. However all these GREs use the body of information on work structures and employees, and the single set of key flexfields, established for the entire Business Group.

Representing the Employer: Government Reporting Entities (GREs): page 2 – 9

Key Flexfields for the Business Group

Key flexfields are a special feature of Oracle Applications. Unlike regular information fields that hold just one unit of information, key flexfields can hold as many as 30 separate units, or segments, of information. The ability to hold multiple segments of information in a field is one of the features of Oracle Applications that facilitates localization of the software in different countries, and customization of the software at for each enterprise using it. Oracle HRMS includes six key flexfields:

- Job, Position, and Grade
- People Group
- Personal Analysis
- Cost Allocation.

Key Flexfields for Job, Position, and Grade Names

These three key flexfields give you the option of using either simple (single segment) or more complex (multiple segment) names for jobs,
positions, and grades, depending on the particular requirements and policies of your Business Group.

For example, you can decide on names for your jobs or positions such as Programmer and Machinist, or on names incorporating additional information, such as Machinist.Certified.Level3 or Programmer.Trainee. Likewise, you can use grade names such as A, B, and C, or names providing more information, such as Manual.A.1, Manual.A.2, Clerical.C.1, Clerical.C.2.

See:
Job and Position Names: page 3 – 5
Representing Grade Structures: page 4 – 2

The People Group Key Flexfield

This key flexfield provides an easy way to set up whatever special groupings of employees the Business Group requires. For example, a segment of this flexfield can hold all the unions employees belong to. When you give employees assignments, you can select their union from this segment.

Similarly, a segment of this flexfield can hold a list of the companies in a multi-company Business Group. You select from this segment each employee’s company, which can in turn control the employee’s eligibility for elements of compensation and benefits.

See: Setting Up the People Group Flexfield: page 5 – 10

The Personal Analysis Key Flexfield

This key flexfield holds special types of information about:

• the Business Group’s employees or applicants, as for example their educational levels, qualifications, and skills that may match job or position requirements
• requirements for the Business Group’s jobs and positions, for example, educational attainment, certification or license types and levels, and foreign language ability
• a wide range of other matters on record for the Business Group’s workforce, for example, information on company cars, workplace accidents, and employee requests for accommodations for disabilities.

The Personal Analysis flexfield structure can hold as many as 30 different information topics.
The Cost Allocation Key Flexfield

This key flexfield is used to collect information on labor costs within a Business Group. For example, an enterprise can define segments of this flexfield as follows:

- one segment to hold cost center codes, such as Sls (Sales), Eng (Engineering), and Prd (Production).
- another segment to hold GL account codes, for accounts such as Wages, Production Bonus or Union Dues Deduction.
- a third segment to hold codes used in a labor distribution system, such as 31, 32, and 33 (for product lines 31, 32, and 33).

After this flexfield is set up, you can access it at a number of points in the system. For example, when entering a department into Oracle HRMS as an internal organization, you can select from the flexfield the cost center to which the employee costs of the department go. When giving employees their assignments, you have the option of selecting from the flexfield the product lines they work on, and entering the percentage of time on each.

At installations including Oracle Payroll, the payroll run collects labor costs using the codes in the Cost Allocation key flexfield, for transfer to the general ledger and labor distribution or project management systems. Enterprises using both Oracle Payroll and Oracle General Ledger can map segments of the Cost Allocation flexfield to segments of the GL Accounting flexfield.

See: The Oracle HRMS Cost Allocation Key Flexfield: page 11 – 2
See: Costing in Oracle HRMS: page 11 – 2

See Also

User Definable Key Flexfields: page B – 2

Oracle Applications Flexfields Guide
Single or Multiple Business Groups

Each Business Group can have just one particular set of segments defined for its Job, Position, Grade, Employee Group and Cost Allocation key flexfields. You set up the key flexfields for a Business Group before setting up the Business Group itself.

Many enterprises decide to use a single Business Group to hold ‘live’ information, so they can display, report and manage information from all parts of the enterprise at the same time.

**Note:** You cannot view information online for more than one Business Group at a time.

However, there are reasons for setting up multiple Business Groups in the same installation, such as the following:

- You want to have a copy of your live system with example records for training or testing purposes.
- You are a holding company or a corporation with a number of subsidiary companies. Each subsidiary has its own structures, employees, and compensation and benefit policies. If your subsidiaries are in different countries you also have to deal with local legislative requirements.
- You are acquiring a company or merging with another company, and you want to maintain separate structures and compensation and benefits during the transition process.

The Startup Business Group

Oracle HRMS comes with one Business Group supplied as startup data. You can use this Business Group and its default definitions as the starting point for your own Business Group, or you can create a new Business Group.

If you create a new Business Group, you must create a new responsibility (or edit the default responsibility) to allow access to it, before beginning to create other work structures.

**See Also**

Accessing Business Groups: page 2 – 18

Defaults for the Business Group

You can enter certain types of information for the Business Group to appear as defaults throughout your enterprise structures:
• You can select a default currency.
• You can enter a default for the value each assignment contributes towards each staffing budget that you define. For example, by default an assignment may count as one for a headcount budget.
• You can enter default working hours for all the employees in the Business Group. You can override these defaults at organization, position, and assignment levels.
• For certain HR reporting purposes you can register for the Business Group, Reporting Categories and Reporting Statuses. These include employment categories such as Full Time or Part Time that cover employees who are not temporary workers, and assignment statuses such as Active or Paid Leave that cover employees who are not at a terminated status.
• You can register for the Business Group, the names of the segments of its Cost Allocation key flexfield that hold cost center and labor distribution codes. This customizes the names that appear as field prompts in your PayMIX Windows.

Employee and Applicant Identification Numbers

When defining a Business Group, you choose a method of creating identifying numbers for its employees and applicants. The choices are:
• automatic number generation
• manual entry
• for employees only, automatic use of a national identifier, such as the US social security number or the UK National Insurance number.

Note: Once you save an automatic number generation method, you can later change only to manual entry.
Representing the Employer: GREs

After defining one or more Business Groups for your enterprise, you set up one or more Government Reporting Entities (GREs) within each Business Group. The GRE is the organization that federal, state and local governments recognize as the employer who:

- issues pay to employees
- withholds taxes from employees’ pay and is liable for employer taxes and tax reporting
- provides other government-mandated reporting, such as EEO-1, OSHA, and New Hire reports.

Each GRE has a unique 9-digit number (sometimes called the employer identification number or taxpayer identification number) issued by the IRS. Your enterprise may have just one such number, in which case your Business Group and GRE are the same organization.

Large enterprises may include a number of different divisions or companies each with its own identification number from the IRS, in which case you can set up a GRE for each. You can associate several GREs together as a Tax Group, for which one of the GREs can serve as the common paymaster.

See: GREs, Tax Groups, and Common Paymasters: page 2 – 12

Information for Taxes, NACHA, and Reporting

Because a GRE is responsible for paying employees and withholding their taxes, you enter for it basic rules affecting calculation of federal, state and local taxes, and information for tax reporting. Also, each GRE holds information required for labelling NACHA tapes used to pay employees by direct deposit into their bank accounts.

Because a GRE also functions as a reporting unit for government mandated reporting on matters such as employees’ work-related injuries, equal employment opportunities, and obligations to pay child support, you enter for it certain information required for submission of these types of reports.

Attention: The GRE in the Oracle HRMS products is the same organization as the Legal Entity that appears in the Oracle Financials products, holding the taxpayer identification number. For this reason, the GRE may appear as GRE/Legal Entity on pick lists.

Enterprises using Oracle HRMS and Oracle Financials products should define only one GRE/Legal Entity to represent each employer organization with a unique IRS identification number.
Enterprises with One GRE

Enterprises with only one identification number from the IRS need only one GRE in which to place all employees. In Oracle HRMS, the Business Group and the GRE are the same organization. Appearing below is an example organization chart for a Business Group with one GRE.

![Organizational Chart](image)

In a company like this, some employees can have assignments to the Business Group organization itself, if it also has the classification HR Organization. Most have an assignment to one of the various HR Organizations subordinate to the Business Group. All employees belong to the same GRE, which pays them, withholds their taxes, and provides reports on various matters concerning them to government agencies.

Enterprises with Multiple GREs

For large enterprises that include several different employers with their own IRS identification numbers, all the employees in each company may be paid by that company, and hence all require an assignment to a...
GRE that coincides with their company. In this case you set up within the Business Group, a GRE for each separate employer, as seen below in Figure 10–2.

In enterprises like this, all employees assigned to an HR Organization within a company have an assignment to the same GRE, and conversely, all employees in a given GRE belong to the same company.

Alternative Structuring of Companies and GREs

In other large enterprises, the GREs responsible for paying groups of employees are not the same as the companies within the Business Group, which may be organized, for example, according to the particular types of work or projects they undertake. Figure 10–2 still reflects the structure of the companies in this type of enterprise. But the GREs representing the employing organizations that pay employees have a separate structure that is independent of the companies, as in Figure 10–3:

In other large enterprises, the GREs responsible for paying groups of employees are not the same as the companies within the Business Group, which may be organized, for example, according to the particular types of work or projects they undertake. The figure above still reflects the structure of the companies in this type of enterprise. But the GREs representing the employing organizations that pay employees
have a separate structure that is independent of the companies, as in the figure below.

Figure 2 – 3
GREs Independent of Companies

In this type of enterprise, employees assigned to a particular GRE can have a work assignment to any of the different companies constituting the enterprise, and a particular company can include employees assigned to several different GREs.

In enterprises like this, employees are clear about which company they are working in, but may be unaware of their membership in a separate GRE. Because the functions of GREs relate to payroll administration and governmental reporting, they have little direct impact on employees’ daily lives at work.

Business Groups with multiple GREs often associate some GREs together in a Tax Group with a common paymaster

**GREs and Tax Groups**

Enterprises with multiple GREs can place certain GREs together in *Tax Groups*. The Tax Group takes the name you give it.

**Attention:** The Tax Group name must be consistent in spelling and case for all GREs to be included. For example, “My Tax Group” is not the same as “my tax group.”

When multiple GREs are included in a tax group, the taxable limits for FUTA and SS are maintained at a Tax Group Level.

Using tax groups allows employers to give employees moving within GREs credit towards their Social Security, and Federal Unemployment Tax Act (FUTA) taxes.

At the same time that you enter federal tax rules for a GRE, you can place the GRE in a Tax Group.
See Also

Additional Information for GREs: page 2 – 25
Representing Organizations

In Oracle HRMS, the organizations you set up to represent your enterprise as an employer are the Business Group, and one or more GREs within the Business Group.

Below this level, you represent the groupings in which employees work, such as branches, departments or sections, by means of internal organizations. To enable the assignment of employees to an internal organization, you classify it as an HR Organization.

You also maintain information in the system about various types of external organizations relevant to human resources and payroll management and administration. You can never assign employees to external organizations, even those classified as HR Organizations.

Organization Types

When setting up an organization you can give it an organization type. The type may, for example, identify the function an organization performs, such as Administration or Service, or the level of each organization in your enterprise, such as Division, Department or Cost Center.

You create the organization types you require by entering values for the QuickCode Type ORG_TYPE.

Levels of Internal Organizations

You decide for yourself the level of organization detail your enterprise needs in Oracle HRMS.

At one extreme, a Business Group/GRE can be the only organization defined in the system. However this will severely limit your ability to manage and report on employee assignment and payroll information, and to control access to HRMS records. At the other extreme, you can define an organization for every grouping of employees, however small. But the costs of maintaining organizations at this level will probably outweigh the benefits.

When thinking about the internal organizations to set up for your enterprise in Oracle HRMS, consider what your current managerial groupings are. Then you can adjust up or down to determine the best level or organizational detail for your enterprise to maintain.

See Also

Organization Hierarchies: page 2 – 34
Representing Companies in Multi–Company Business Groups

When the configuration of your enterprise warrants, you can use both internal organizations and the People Group key flexfield to represent the entities appearing on your organization chart. For example, suppose your enterprise includes two companies, each with its own internal groupings and compensation and benefits policies:

When you set up both the companies and the subordinate organizations within each company as entities to which you can assign employees, you can create rules governing eligibility for compensation and benefits using both the companies and their subordinate organizations.

To represent the branches, administrative and sales groups, and departments within the companies in Oracle HRMS, you can define internal organizations. To represent the companies, you can use the People Group key flexfield, defining a segment of this flexfield as Company, and listing your companies in it:

**People Group Key Flexfield**

*Segment 1: Company*

- Company 1
- Company 2

This setup permits you to assign each employee both to a company and a subordinate organization within the company, and hence to control his
or her eligibility for elements of compensation and benefits both by company, and by organization within the company.

See Also

Setting Up the People Group Flexfield: page 5 – 10
Using Elements: page 12 – 6

Internal Organizations and Cost Centers

Depending on the structure of your enterprise and your decisions about which organizations to represent in Oracle HRMS, there may not be a one-to-one correspondence between your cost centers and the organizations you enter.

When defining an internal organization, you can identify one cost center against which the payroll costs of the employees assigned to the organization should be collected. You simply select the cost center from a list in a segment of the Cost Allocation key flexfield.

For example, suppose you are defining in Oracle HRMS the organization Product Assembly, whose employee payroll costs go to the cost center Production. When entering the organization Product Assembly, you select Production from the list of cost centers in the Cost Allocation flexfield:

**Cost Allocation Key Flexfield**

*Segment 1: Cost Center*

410–Accounting
425–Production
503–Public Relations

**Note:** If employees’ costs are charged to cost centers other than those of their organizations, or if they work in an organization only part time, you can enter other cost centers, and the percentage of time to be charged to each, on their employee assignments. Costing information entered for employee assignments overrides that entered for organizations.

See Also

Setting Up the Cost Allocation Key Flexfield: page 11 – 11
External Organizations

Oracle HRMS can hold basic information on organizations not part of your own enterprise, such as training vendors, tax offices, benefits carriers or certification bodies.

You define external organizations in the same way as internal organizations. External organizations can appear in your organization hierarchies together with internal organizations.

Attention: The main difference in the system between internal and external organizations is that you cannot assign people to an external organization.
**Employer and Organization Setup**

Use the Organization window to set up:

- Business Groups
- GREs (Government Reporting Entities)
- internal organizations
- external organizations

The nature of each organization is determined by the *classification* you select for it. The setup information you enter for an organization depends in large part on its classification.

You must create a Business Group and a responsibility to allow access to it, before you create other organizations.

**Accessing Business Groups**

You access the startup Business Group using the default ‘Oracle Human Resources’ responsibility. A responsibility is linked to a security profile, which determines which records you can see. The default Oracle HRMS responsibilities allow you to see all the records for the startup Business Group.

You can adapt the startup Business Group or create a new one for your enterprise.

If you are creating a new Business Group, your system administrator must create a new responsibility for it after you save it, but before you use it. This responsibility must give access to all the records in the Business Group. Alternatively, the system administrator can simply update the default Oracle Human Resources responsibility by changing the HR:Security Profile user profile option to the name of the view–all security profile generated for the new Business Group (see steps 8 to 10 below).

**To define a “view–all” responsibility:**

1. Navigate to the Responsibilities window.
2. Enter a Name for the responsibility and select the application for which you are defining it (such as Oracle Human Resources) in the Application field.
3. In the Menu field, select F4 HRMS Top Menu.
4. In the Report Group field, select one of the seeded report groups (such as US HRMS Reports and Processes).
5. Save your work.
6. Navigate to the System Profile Values window.
7. Select your new responsibility and query the HR:Security Profile option.
8. Enter the name of the view–all security profile for your new Business Group. By default this is the name of your Business Group.
9. Save your work.

See Also

Access Control Through User Responsibilities: page 28 – 2
Creating an Organization

- retirement organizations for retiree processing

To determine the purpose and uses in the system of each organization you create, you give it one or more classifications:

- For Business Groups and GREs, you use the classifications **Business Group** and **Government Reporting Entity**.
- For internal organizations such as departments, sections, and project teams to which employees have assignments, you use the classification **HR Organization**.
- To make organizations available for use in certain types of reporting, you use the classifications **Reporting Establishment**, **Corporate Headquarters**, and **AAP Organization**.
- So that you can query or select certain external organizations at appropriate points in the system, you use the classifications **Workers Compensation Carrier**, **Benefits Carrier**, **Beneficiary Organization**, and **Payee Organization**.

To set up an organization, use the Organization window.

**Prerequisites for All Organizations**

- Enter the names and addresses of your work sites in the Location window.
  
  If you are using Oracle Payroll, every organization to which employees can have assignments, including Business Groups, must have on record a location with a complete address. This is because the system uses the location of the organization of the employee’s primary assignment to determine employee work locations for tax purposes.
  
  **Note:** This does not apply to GREs, because the assignment to a GRE exists in addition to the assignment to an organization.

  See: Setting Up Site Locations: page 2 – 2

- Enter organization types you need in the QuickCodes window, for the QuickCode Type ORG_TYPE.
  
  See: Adding QuickCode Values: page 29 – 3

**Prerequisites for Business Groups**

- Enable the currencies you need. Normally your system administrator does this.
  
  See: Enabling Currencies: page 25 – 7
Note: Oracle Payroll is capable of paying employees working in other countries in the currencies of these countries, but does not provide the formulas needed to process taxes for employees paid in foreign currencies under other national legislations. You can write your own formulas in Oracle FastFormula, or contract with local third party vendors for the installation of tax routines.

- Define the structures for the Job, Position and Grade Name key flexfields, and define the structures and at least one segment for the People Group and Cost Allocation key flexfields.
  
  See: Key Flexfields for the Business Group: page 2 – 4

- Make entries for the QuickCode Types FREQUENCY and BUDGET_MEASUREMENT_TYPE in the QuickCodes window.
  
  See: Adding QuickCode Values: page 29 – 3

Prerequisite for GREs

- Enterprises with multiple GREs often associate some together in Tax Groups. Plan in advance which GREs will constitute each Tax Group, and which GRE will be the tax group leader.
  
  See: GREs and Tax Groups: page 2 – 12

Prerequisites for HR Organizations

- To enter cost codes for these organizations, check that the Cost Allocation key flexfield includes a cost code segment, with a qualifier of Organization. This qualifier must be present for the segment to appear in the Organization window.
  
  See: Setting Up the Cost Allocation Key Flexfield: page 11 – 11

- In the Table Structure window, query the table COMPANY WORK SCHEDULES, and check whether the work schedules supplied with the system meet your requirements.
  
  Work schedules show the number of working hours scheduled each day of the week for employees, starting with Monday. For example, 775 means a scheduled work day of 7 hours and 45 minutes. If you need additional work schedules, you can create them in the Table Structures window.
  
  See: Setting Up User Tables: page 29 – 14

Prerequisites for Reporting Establishments, Corporate Headquarters, and AAP Organizations

See:
To create a new organization:

1. Enter a name that is unique within the Business Group, and optionally select an organization type.
   
   **Note:** All Oracle applications you install share the information entered in the Organization window. Therefore organization names must be unique within a Business Group, and Business Group names must be unique across your applications network.

2. Enter a start date early enough for any historical information you must enter.
   
   You cannot assign an employee to an organization before the start date of the organization.

3. Select a location to record the site address, if one exists. You can also enter an internal address to add more details such as a floor or office number.

4. Select Internal or External. You cannot assign people to an external organization.
Examples of external organizations that may require entry are benefits carriers, Workers Compensation insurance carriers, organizations employees name as beneficiaries of certain employee benefits, and organizations that are recipients of third party payments from employees’ pay.

5. Save the organization. Then select at least one classification and enable it.

Note: Your system administrator can limit the classifications you see to those relevant at your installation.

- Select Business Group to define a Business Group.

  Attention: Classifying an organization as a Business Group is not reversible. Employees, organizations, and other data are partitioned by Business Group. Each Business Group must be viewed using a separate responsibility.

- Select Government Reporting Entity to define a GRE.

- Select HR Organization for all organizations (including Business Groups and GREs) to which you intend to assign employees.

- Select Reporting Establishment, Corporate Headquarters or AAP Organization when defining reporting organizations, that is, organizations required for the production of certain reports for government agencies.

  See: Reporting Organizations (Oracle Human Resources North American User’s Guide)

- Select Benefits Carrier, Workers Compensation Carrier, or Beneficiary Organization when defining an external organization belonging in one of these classifications. You can then select the organization when defining a benefit, entering information for Workers Compensation calculations, or recording beneficiaries employees have named for certain benefits.

  See:

  Benefits Administration Overview (Oracle Human Resources North American User’s Guide)

  Setup Steps for Workers Compensation Calculations: page 20–12

  Recording Beneficiaries for Benefits (Oracle Human Resources North American User’s Guide)

- Select Payee Organization when defining an external organization that is the recipient of a third party payment from an employee, for example a court–ordered payment. You can then select this organization on the Personal Payment Method window when entering a third party payment method.
6. Save all enabled classifications for this organization.

**To enter additional information:**

*Note:* There is no additional information to add from the Organization window for the classification Corporate Headquarters, or for external organizations with the classifications Payee Organization, Benefits Carrier, Workers Compensation Carrier, or Beneficiary Organization.

1. In the Organization window, query the organization if it does not already appear there. In the Organization Classifications region, select the classification for which to enter additional information, and choose the Others button to open the Additional Organization Information window.

2. This window displays the entry options available for the selected classification. Choose the option you want. Another Additional Organization Information window opens. Click in a field of this window to open a window for information entry.

3. Enter additional information for the classification.

---

**Additional Information for Business Groups**

- **To enter basic, required information for the Business Group:**
  
  See: Entering Business Group Information: page 2 – 26

- **To enter defaults for human resource budget values:**
  
  See: Business Groups: Entering Budget Value Defaults: page 2 – 27

- **To enter defaults for work day start and end times:**
  
  See: Business Groups and HR Organizations: Work Day Defaults: page 2 – 29

- **To register Reporting Categories and Statuses:**
  

- **To enter training default values for Oracle Training Administration:**
  
Additional Information for GREs

- To enter the unique IRS identification number (EIN):
  See: GRES: Entering the IRS Identification Number: page 2 – 30

- To enter data for EEO, VETS and New Hire reporting:
  See:
  Entering EEO–1 Information for a GRE (Oracle Human Resources North American User’s Guide)
  Entering VETS–100 Information for a GRE (Oracle Human Resources North American User’s Guide)
  Entering a New Hire Report Contact for a GRE: page 8 – 33

- To enter tax rules:
  See: Entering Federal, State, and Local Tax Rules for GREs: page 18 – 9

- To enter data for wage and tax reporting:
  See:
  MWS (Multiple Worksite) Reporting on Magnetic Tape: page 19 – 3
  State Quarterly Wage Listings (SQWL) on Magnetic Tape: page 19 – 18
  W–2 Reporting on Magnetic Tape: page 19 – 8

- To enter data for NACHA tapes:
  See: Entering NACHA Tape Data for GREs: page 5 – 5

Additional Information for HR Organizations

- To enter cost codes for collection of costing information:
  See: HR Organizations: Entering Costing Information: page 2 – 30

- To place the organization in hierarchies:
  See: HR Organizations: Entering Parent Organizations: page 2 – 31
To enter default work day start and end times.  
See: Business Groups and HR Organizations: Work Day Defaults: page 2 – 29

To enter a default work schedule:  
See: HR Organizations: Entering a Work Schedule: page 2 – 31

Additional Information for Reporting Establishments

To enter filing data for EEO and VETS reports:  

To place Reporting Establishments in hierarchies:  
See: Placing Subordinate Reporting Organizations in Hierarchies (Oracle Human Resources North American User’s Guide)

To enter filing data for Multiple Worksite reports:  
See: MWS Reporting on Magnetic Tape: page 19 – 3

Additional Information for AAP Organizations


To place AAP Organizations in hierarchies:  
See: Placing Subordinate Reporting Organizations in Hierarchies (Oracle Human Resources North American User’s Guide)

Entering Business Group Information

To enter Business Group information:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region,
select Business Group, choose the Others button, and select Business Group Information.

2. Click in a field of the Additional Organization Information window to open the Business Group Information window.

3. You can enter a short name for the Business Group. Release 10 does not use this name. It is provided for compatibility with earlier releases, where it appeared in the header line of each form.

4. Select the method of creating identifying numbers for employees and applicants. The choices are:
   - automatic number generation
   - manual entry
   - automatic use of the national identifier (for example, the social security number in the US, and the NI number in the UK). This option is available for employees only.

   **Attention:** Once you save your method, you cannot later change to either of the automatic options. You can only change to manual entry.

5. Select the names of the key flexfield structures you want to use in this Business Group.

6. Select the appropriate Legislation Code and default currency.
   The Legislation Code determines the startup data you can access and the contents of some legislation-specific windows.

   **Attention:** Selecting the correct legislation code is essential for the correct functioning of Oracle HRMS. You cannot change the legislation code after entering employees against the Business Group.

7. To maintain fiscal year balances in Oracle Payroll if your fiscal year is different from the calendar year, enter the fiscal year start date.

8. You can enter a Minimum and Maximum Working Age for the Business Group. When you enter or hire employees, you receive a warning if the person’s age is outside this range.

9. Save your work.

---

**Business Groups: Entering Budget Value Defaults**

You can set up budgets for non-monetary measures such as headcount or full-time equivalent. When you enter employee assignments to
define the work an employee does for your enterprise, you can specify the value of the assignment towards these budgets. For example, all assignments typically count as one for headcount budgets, but may count as less than one for full–time equivalent budgets.

To remove the requirement to enter these values for every assignment, you can enter defaults for the whole Business Group. You can override the defaults for individual assignments.

**Prerequisites**

- Define units of measure (such as Headcount) by adding values to the QuickCode Type BUDGET_MEASUREMENT_TYPE in the QuickCodes window.

---

**To define budget value defaults:**

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Budget Value Defaults.
2. Click in a field of the Additional Organization Information window to open the Budget Value Defaults window.
3. In the Units field, select a measurement type, such as Full Time Equivalent or Headcount.
4. Enter a default value in the Value field.
   - You can enter a default value for as many budgetary units as you plan to use for the Business Group.

**See Also**

Business Groups and HR Organizations: Work Day Defaults

You can set up default working hours for all employees in the Business Group or in an HR Organization, saving data entry at lower levels. When necessary, you can override the defaults at lower levels, for example, for individual positions or employees.

The Salary Administration process uses working hours information to prorate the salary values against which it validates any salary proposals.

To define work day defaults:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Work Day Information.

2. Click in a field of the Additional Organization Information window to open the Work Day Information window.

3. Enter the normal start and end times in 24 hour format. For example, for 5.30 p.m., enter 17:30.

4. Enter a number in the Working Hours field, and select the corresponding period of time in the Frequency field. For example, enter 40 and select Week.

You can add to the list of available frequencies by making entries for the QuickCode Type FREQUENCY, using the QuickCodes window.
GREs: Entering the IRS Identification Number

To enter the unique identification number for the GRE:

1. In the Organization window, query the GRE if it does not already appear there. In the Organization Classifications region, select Government Reporting Entity, choose the Others button, and select Employer Identification.
2. Click in a field of the Additional Organization Information window to open the Employer Identification window.
3. Enter the identification number the IRS has issued for the GRE.

Note: A Retirement Organization may have the same Employer Identification Number as an existing GRE, if required.

HR Organizations: Entering Costing Information

To enter costing information:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organizations, choose Others, and select Costing Information.
2. Click in the Additional Information window to display the segments of the Cost Allocation flexfield set up with the qualifier of Organization.
3. Select the appropriate cost code in each segment.

For individual employees, you can override these organization–level codes by entering costing information on their assignments.
HR Organizations: Entering Parent Organizations

After you set up organization hierarchies, use the Parent Organization window to place a subordinate organization in hierarchies by naming its immediate parent in each hierarchy.

To enter a parent organization:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organization, choose Others, and select Parent Organization to open the Parent Organization window.
2. Select the hierarchy name.
3. Select the name of the parent organization to which the HR Organization is subordinate in this hierarchy.
4. To enter the HR Organization in another hierarchy, repeat steps 2 and 3.

See Also

Organization Hierarchies: page 2 – 34

HR Organizations: Entering a Work Schedule

Work schedules show the number of working hours scheduled each day of the week for employees, starting with Monday. For example, for an
employee who works 7 hours and 45 minutes each day Sunday through Thursday, with Friday and Saturday off, the work schedule is: 775–775–775–0–0–775.

Oracle Payroll uses work schedules to prorate pay for employees who do not submit timecards. The startup data you receive with Oracle Payroll includes several work schedules in common use, entered in the table COMPANY WORK SCHEDULES.

To select a work schedule for an HR Organization:

1. In the Organization window, query the organization if it does not already appear there. In the Organization Classifications region, select HR Organization, choose the Others button, and select Work Schedule.

2. Click in a field in the Additional Organization Information window to open the Work Schedule window.

3. Select the default work schedule for the organization.

   You can override this default for individual employees on their assignments.

If the work schedule you need is not on the list, go to the Table Structure window, query the table COMPANY WORK SCHEDULES, and enter the new work schedule.

See Also

User–defined Tables: page 29 – 10
Deleting an Organization

To remove an organization from the list of organizations available for employee assignments, enter an end date (Date To) on the organization record.

To entirely delete an organization from the system, you must first:

• remove any employee assignments to the organization
• remove the organization from any hierarchies
• disable its organization classifications in the Organization window.
Organization Hierarchies

In Oracle HRMS, organization hierarchies show reporting lines and other hierarchical relationships among the organizations in your enterprise.

You set up a primary reporting hierarchy reflecting the main reporting lines in your enterprise, as established in the organization chart of your enterprise. Below is an example of an organization chart showing the reporting lines of a single-company enterprise.
Multiple Hierarchies

In addition to the primary reporting hierarchy, you can set up in Oracle HRMS as many other organization hierarchies as you need.

Hierarchies for Matrix Management

Your enterprise may have a matrix management structure in which organizations have more than one reporting line. For example, looking at the organization chart in Figure 2–5, the HR organization under Production may have a dotted-line reporting relationship to the organization Company HR. You can set up additional hierarchies to reflect secondary reporting relationships within your enterprise.

Security Hierarchies

As well as constructing hierarchies to reflect reporting lines, in Oracle HRMS you use hierarchies to control access to information. For example, in a decentralized enterprise you might want to give each regional manager access to the records of the employees in the organizations in his or her region.

Looking again at the organization chart in Figure 2–5, you want managers in the Sales East office to have access to the records of all employees in the eastern region sales groups. You can do this by building a geographical hierarchy of your regions and the organizations in each.

See: Security Profiles: page 28–4

Hierarchies for Reporting

When you run some of the Oracle HRMS standard reports, you can specify an organization hierarchy to determine which organizations and employees the report covers. You can also use this approach in your own standard or ad hoc reports. You can create additional organization hierarchies just for analysis and inquiry purposes.

To produce reporting for government authorities, for example EEO-1 and VETS-100 reports, you build special establishment hierarchies to obtain the correct coverage of employees.

See Also

Establishment Hierarchies (Oracle Human Resources North American User’s Guide)
Organizational Change and Version Control

Changing your hierarchies to reflect simple changes in reporting lines is not difficult. You create a new version of your existing hierarchy and modify parts of its structure. The system retains earlier versions of hierarchies for historical information.

However when you experience a major restructuring, it is often best to create new work structures, including new organizations and reporting lines.

**Suggestion:** You can create future–dated versions of your organization structures and use these to prepare for reorganization in advance. You retain previous versions of your hierarchies for historical information.

See Also

Dated Information and Hierarchy Versions: page 1 – 10
Creating Organization Hierarchies

You can create all types of organization hierarchies in two ways:

• using the Organization Hierarchy window
• using the Organization Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your organization hierarchies graphically and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Organization Hierarchy window.
Always define hierarchies from the top organization down.

Prerequisites

☐ Define the top organization in the hierarchy, and at least one organization subordinate to it.

To set up a new organization hierarchy:

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.
2. Enter the version number and start date for the hierarchy.
You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.
4. In the Subordinates block, select the immediate subordinates for the top organization.
5. To add organizations below one of these immediate subordinates, check the Down check box for the organization.

The Organization block now displays the organization you selected. You can add subordinates to *this* organization. To return to the previous level, check the Up check box.

**Attention:** The list of organizations from which you can select in the Subordinates block includes organizations that are already in the hierarchy. If you select such an organization, you will move it and all its subordinates within the hierarchy.

See: Changing Organization Hierarchies: page 2 – 39

---

**To create a new version of an existing hierarchy:**

1. Query the name of the hierarchy.
2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

**Note:** Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.
4. In the Subordinates block, select the immediate subordinates for the top organization.
5. To add organizations below one of these immediate subordinates, select the Down check box for the organization.

The Organization block now displays the organization you selected. You can add subordinates to *this* organization. To return to the previous level, select the Up check box.

---

**To copy an existing hierarchy:**

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.
Changing Organization Hierarchies

To add new organizations to an existing hierarchy, query the hierarchy and version you want to change, query the parent organization for the one you are adding, and select the new organization in the Subordinates block.

To change the top organization of an existing hierarchy, query the hierarchy and version you want to change, query the new top organization, and select the previous top organization in the Subordinates block.

You can move an organization and all of its subordinates within a hierarchy. To move an organization, query the hierarchy and version you want to change, query the new parent organization for the one you want to move, and select the organization to move in the Subordinates block.

Deleting Organization Hierarchies

To delete an organization hierarchy, you must first remove the subordinate organizations from the hierarchy, starting at the lowest level. You cannot delete an organization hierarchy if other versions exist, or a security profile uses it.

Organization Hierarchy Report

Oracle HRMS includes a standard Organization Hierarchy Report to display the relationships between organizations in a hierarchy.

You run reports from the Submit Requests window.

To run the Organization Hierarchy Report:
1. In the Name field, select Organization Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.

4. In the Organization Structure field, select the hierarchy. If there are multiple versions, select a version.

   If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.

5. In the Parent Organization field, select the highest organization in the hierarchy that you want to see on the report.

6. Enter Yes in the Managers Shown field to see managers’ names.

   If there are more than ten managers, you see the number of managers only.

7. Choose the Submit button.
Jobs and Positions

This chapter explains the concepts of jobs and positions in Oracle HRMS and how you can use these work structures to represent the roles of your employees.

It further explains how to:

- use the Job Name and Position Name key flexfields to identify groups of employees in your enterprise
- hold information associated with jobs and positions, such as job descriptions, and standard working hours for positions
- represent the reporting lines and other relationships among positions. You represent these relationships by building position hierarchies
- reorganize jobs, positions and assignments within your Business Group.
Representing Jobs and Positions

In many enterprises the basic management units are roles, not individuals. In theory at least, organizations are able to continue in unchanged existence, in spite of frequent changes in staff. However, the definition of a ‘role’ varies from one enterprise to another. Like organization structures, it reflects the culture of the enterprise.

You define roles to represent the ways that different groups of employees work. In Oracle HRMS you can use jobs or positions, or a combination, to define roles.

Job
A job is a generic role within a Business Group, which is independent of any single organization. For example, the jobs ‘Manager’ and ‘Consultant’ can occur in many organizations.

Position
A position is a specific occurrence of one job, fixed within one organization. For example, the position ‘Finance Manager’ would be an instance of the job of ‘Manager’ in the ‘Finance’ organization. The position belongs to the organization. There may be one, many, or no holders of a position at any time.

Example
In a large structured organization, you may have a permanent establishment of positions for most of your employees.

However, you may also have groups of employees hired to perform specific tasks. This can be on a temporary or a permanent basis. Staff in this category can include agency workers, consultants and contractors. For these staff, you can define the role more flexibly as a job.
Position Reporting Structures

If you use positions to define roles, you can define position hierarchies to show the detailed line management reporting in each organization or throughout the enterprise.

Position hierarchies are very like organization hierarchies. You can set up a primary hierarchy and multiple secondary hierarchies to show reporting lines, including ‘dotted line’ reporting, and to control access to information.

Position hierarchies are dated, so you can create future-dated versions to prepare for reorganization in advance, and can retain previous versions for historical information.

Figure 3 – 1
Position Hierarchies
Deciding How to Use Organizations, Jobs, and Positions

When you plan how to model your organizations and roles, consider the following points:

- Positions are normally used in role–based enterprise structures where clearly defined rules largely determine the ways employees work, and the compensation and benefits they receive.
- To manage fixed establishments of posts that exist independently of the employee assignment, it is best to use positions.

If you decide to use positions to represent your enterprise structures you need to consider carefully how to use organizations.

Positions provide you with a finer degree of structural definition and control than organizations on their own. You can use both organizations and positions to represent your reporting structures. However, if you define both, you must also maintain both over time. This may lead you into duplication of effort and information.

**Suggestion:** If you decide to use positions to represent how people work in your enterprise, it is best to define most of the detail at the level of the position. Do not duplicate this detail in organization structures.

Use organizations to show your highest level of departments or divisions. Use positions and position hierarchies to show the reporting groups existing in your enterprise.

See Also

Creating Position Hierarchies: page 3 – 21
Dated Information and Hierarchy Versions: page 1 – 10
Organization Hierarchies: page 2 – 34

Rule Based Enterprises: page 7 – 6
Job and Position Names

Before you define your jobs and positions, decide whether you want to use simple names and codes, or multi-segment job and position names to hold more information.

The name can be a title only, as for example:

- Director
- Analyst
- Training Manager

You can add another segment to categorize the jobs or positions. In this way, you can use segments to identify subgroups of employees within your enterprise. For example, a job name can comprise a title and a job type, such as:

- Director of Finance.Director
- Assistant Director of Finance.Director
- Finance Officer.Professional

Similarly, a position name can comprise a title, a position number, and an indicator showing whether the position is part-time. For example:

- Training Manager.020001.F/T
- Secretary to the Training Manager.020013.P/T

You define the segments of the job and position names and their valid values by setting up the Job Name key flexfield and the Position Name key flexfield. Normally your system administrator does this.

See Also

User Definable Key Flexfields: page B – 2
Adding Information About Jobs and Positions

As you define roles in your enterprise, you can describe their responsibilities, requirements, and working conditions. There are a number of ways to add information about a role:

- For positions, you can enter in standard fields, the location, probation period, and working hours. Entering location and working hours for an organization provides a default for all positions within that organization.

- You can attach documents (such as word processed documents, spreadsheets, or simple text comments) to each job or position record. For example, you might attach text describing the objectives and tasks of the job or position.
  
  See: Using Attachments: page 30 – 6

- You can add up to twenty additional fields to each window to hold extra information you require. These fields can be global (they always appear), or context-sensitive (they appear only when triggered by another piece of information).

  For example, these fields can record the health and safety requirements of a position, or its suitability for job share. The additional fields appear in a descriptive flexfield.

  See: Adding New Fields to Windows: page 27 – 2

- You may need to add other information, such as required qualifications or valid experience, to help match people to roles. You define the sorts of Special Information Types you want to hold and set them up using a special field called the Personal Analysis key flexfield. For each job or position, you select the requirements from your Special Information Types relevant to that role.

  See Matching People to Vacancies (Oracle Human Resources North American User’s Guide)

Comparing and Relating Roles

You may also want to relate roles to each other and define the relative grading of the roles. You can relate roles in the following ways:

- By forming multiple hierarchies of positions to show reporting relationships or career paths.

- By linking jobs into multiple career paths to show suggested progression paths.
• By recording successor positions and relief positions (to cover in the case of absence) against each position.

• By recording the grades that are valid for each job and position.
  See Valid Grades (Oracle Human Resources North American User’s Guide)

• If you use an evaluation system (such as the Hay Evaluation System) to compare roles, you can set up fields to hold evaluation information and an overall score for each job and position.
Defining Jobs

You use the Job window to define jobs, the skills that jobholders require, and the grades to which they can be assigned. You can also enter job evaluation scores, if you have set up a job evaluation system.

Additionally, you can enter in the Further Information field of the Job window:

- an FLSA (Fair Labor Standards Act) code indicating whether the job is exempt from payment for overtime work
- an EEO job category, needed for production of EEO–1, AAP, and VETS–100 reports, and a job group, line of progression and salary code, needed for AAP reports
- information relating to the use of a job as a survey benchmark.

Prerequisites

- Define all the segments of the Job Name key flexfield that you want to use for the job name.
- If there are one or more valid grades to enter for this job, check that these grades are defined.

To define a job:

1. Enter a start date early enough to handle any historical information you want to enter.

2. Enter a unique name for the job. If there is more than one segment in the Job Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Click in the Further Information field to open the Further Job Information window. Here you can:
   - mark the job for use as a survey benchmark
   - select an FLSA code of Exempt or Nonexempt
     See: The Earnings Type Overtime: page 15–10
   - select an EEO code for the job
     See Associating Jobs with EEO Job Categories (Oracle Human Resources North American User’s Guide)
   - select a job group, line of progression, and salary code for the job
     See Data for AAP Reporting (Oracle Human Resources North American User’s Guide)

4. Save the job.
5. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the job.
6. Choose the Requirements button to enter job requirements, such as required qualifications or valid experience, to help you match people to roles.
   **Note:** Check with your HR manager or system administrator whether this is the right window for entering job requirements. You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.
7. Choose the Valid Grades button to enter the grades to which jobholders can be assigned.
   **Note:** For calculation of the Workers Compensation liability of your enterprise, you must associate this job with the work classification code of one or more states.
   See: Jobs and WC State Codes and Rates: page 20–4
See Also

Entering Work Choices for a Job or Position: page 3 – 18
Defining Positions

You use the Position window to define positions within your organizations and to add them to position hierarchies. You can also enter the skills that position holders require and the grades to which they can be assigned. You can enter position evaluation scores, if you have set up a position evaluation system.

Prerequisites

- Define all the segments of the Position Name key flexfield that you want to use for the position name.
- Define the organizations for the Business Group.
- Define the jobs for the Business Group.
- If you want to hold probation periods for positions, enter the units in which you measure probation periods as values for the QuickCode Type QUALIFYING_UNITS.
- If you want to add the position to a position hierarchy, define the hierarchy in the Position Hierarchy window.

To define a position:

1. Enter a start date early enough to handle any historical information you want to enter.
2. Enter a unique name for the position.
   If there is more than one segment in the Position Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Select the organization and job for this position. They must have a start date on or before the start date of this position.

Attention: You cannot change the organization or job once you have saved the definition.

You can set up several positions that have the same job in the same organization. Each position name must be unique.

4. Optionally, select a status for the position. If the status is Valid or blank, employees can be assigned to the position. If the status is Invalid or any other status defined at your site, employees cannot be assigned to the position.

5. Location and Standard Conditions default from the organization, but you can override the defaults.

6. If there is a probation period for this position, you can enter its length in the Probation Period alternative region.

7. In the Absence alternative region, select Yes in the Replacement Required field if you want users to be warned that they should enter the name of a replacement when they enter an absence for a holder of this position. You might want to do this for positions where it is essential that a person is ‘in charge’ at all times.

You can select the position that should be held by the person to cover as relief in case of absence.

8. In the Planned Successor alternative region, you can select the position from which a successor will to move to fill this position.

9. Save your position.

10. If you want to add the position to one or more position hierarchies, choose the Reporting To button. Select a hierarchy and the name of the position to which this position reports.

11. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the position.

12. Choose the Requirements button to enter position requirements, such as required qualifications or valid experience, to help you match people to roles.

Note: Check with your HR manager or system administrator whether this is the right window for entering position requirements. You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.

13. Choose the Valid Grades button to enter the grades to which position holders can be assigned.
See Also

Entering Work Choices for a Job or Position: page 3 – 18
Evaluating Jobs and Positions

Evaluation systems are common in large enterprises, which compare the responsibilities of roles to help in the definition of grades. Directly or indirectly, the evaluation can also contribute to setting compensation levels. The UK’s Local Government Scheme and the Hay Evaluation System, used internationally, are examples of evaluation systems.

Evaluation systems normally use a set of formal and systematic procedures to perform a comparison of roles. As such, evaluation is primarily concerned with the definition of the relative status of a role, and not with a set of absolutes. The objective of all evaluation systems is to place a role in a grading or salary structure.

There are two main types of evaluation system:

**Factor**
- Key roles are examined factor by factor and a rank comparison order produced for each factor. A complex comparison of weighted factors then follows.

**Points Rating**
- A wider range of factors is used. Each factor is weighted and has a numerical scoring system. The total points scored determines the placement of the role in a grade or salary structure.

These systems might incorporate benchmarking, where a few key roles determine the rank of all the others. Grades and compensation levels are determined after the evaluation and ranking of the jobs.

Setting Up an Evaluation System

**To set up an evaluation system:**

1. Decide whether to hold the evaluation information for jobs or for positions, depending on your own definitions of employees’ roles within the enterprise model.

2. Define values for the QuickCodes Types EVAL_SYSTEM (evaluation system name) and EVAL_SYSTEM_MEAS (the units in which to measure the evaluation). If you use more than one system, you can define multiple values to provide a list of values in the Job Evaluation and Position Evaluation windows.

   See: Adding QuickCode Values: page 29 – 3

3. Define the structure and segments of the Additional Evaluation Details descriptive flexfield, which holds the evaluation
information. This descriptive flexfield displays on the Job Evaluation and Position Evaluation windows.

For example, you could define the following segments:

- Responsibility
- Problem Solving
- Know How
- Related Grade

If you are using more than one evaluation system in your enterprise, you should make the flexfield segments context sensitive to the evaluation system. Context sensitive segments ensure that each system has its own distinct set of evaluation information.

Your system administrator usually carries out this task as it requires access to parts of the system that control how Oracle Human Resources works.

### Entering Evaluation Information

Enter evaluation scores and details in the Job Evaluation or Position Evaluation window.

**Prerequisites**

- An evaluation system must be implemented.

![Job Evaluation Window](image)

**To enter a job or position evaluation:**

1. Select the evaluation system used to evaluate this job or position.
2. Enter the overall score and select the units of measurement.
3. Enter the date of the evaluation.
4. Open the descriptive flexfield window, and enter the information it prompts you for.

Valid Grades

When you have evaluated the relative status of your roles (using an evaluation system or some other approach), you can associate valid grades with each role. You may choose to define valid grades for a few key roles and then use these as benchmarks for all other roles.

When you assign an employee to a grade, the list of grades you select from indicates which grades are valid for the employee’s job or position.

You enter valid grades in the Valid Grades window for a job or position.

To enter valid grades:
- Select as many valid grades as you require.
  The Date From defaults to the date the job or position becomes active, or the date the grade becomes active, if this is later. You can change this date.
Entering Job and Position Requirements

Using the Job Requirements window and Position Requirements window, you can store any personal attributes or experience required by a job or position. You can then use this information to list employees or applicants who might be suitable to hold the job or position.

Note: If you are using Career Management for suitability matching, enter competence requirements for jobs and positions in the Competence Requirements window.

The implementation team at your site must set up one or more special information types to hold the requirements information.

See: Defining Special Information Types: page 24 – 10

To enter job or position requirements:

1. Select the name of a special information type.
2. Enter the Requirements field to open the window corresponding to this special information type.
3. In this window, enter the precise requirement of the job or position and choose OK.
4. If the requirement is essential to the job or position, check the Essential check box. This information is used in the Skills Matching Report.
5. Save the requirements.
See Also


Entering Work Choices for a Job or Position

You can enter work choices that can affect an employee’s, applicant’s, contractor’s, or ex-employee’s capacity to be deployed within your enterprise (or a customer’s). Work Choices include willingness to travel, willingness to relocate, and preferred working hours and work schedule. You can enter work choices for a job or position, and compare these with the personal work choices entered for people.

You enter this information in the Work Choices window, accessed from the Job or Position window.

Prerequisites

You need to enter the following QuickCodes for work factors:

- Define time scales as values for the QuickCode Type PER_TIME_SCALES.
- Define work schedules as values for the QuickCode Type PER_WORK_SCHEDULE.
- Define working hours as values for the QuickCode Type PER_WORK_HOURS.
- Define the full time equivalents as values for the QuickCode Type PER_FTE_CAPACITY.
- Define relocation preferences as values for the QuickCode Type PER_RELOCATION_PREFERENCES.
- Define lengths of service as values for the QuickCode Type PER_LENGTHS_OF_SERVICE.

To enter work choices for a job or position:

1. Check the relevant work requirements boxes if the job or position requires the holder to:
   - work in all locations
   - relocate
• be willing to relocate
• travel
• hold a passport

2. Enter the length of time the jobholder must perform the job or position, for example, indefinite or two years.

3. Enter the normal working hours (for example, 9.00 to 5.30), the work schedule (the working days in the week or pattern of shifts), the proportion of full time hours required, and the minimum length of service required.

4. Check the relevant international deployment boxes if the job or position requires the jobholder to:
   • work in all countries
   • be willing to relocate

5. Select the countries to which the jobholder might be relocated.

6. Select the locations to which the jobholder might be relocated.

7. Enter any further job or position requirements, if required.

See Also

Entering Work Choices (Person): page 8 – 21
Viewing Position Occupancy

The Position Occupancy folder lists all those people who have held a selected position or who are applying for it, and the dates of their occupancy. This information could be relevant for selecting people with the necessary skills for similar positions.

Note: As supplied, this folder displays employees who have held the selected position or who are scheduled to hold it. Your system administrator can create a customized version of the form to display applicants who are currently applying for the position.

The supplied folder also contains a button to open the People window to see further details of an occupant. Your system administrator can change the buttons displayed on this window.

▶ To view occupants of a position:

- In the Position window, query a position and choose the Occupancy button.

  Occupants are listed in reverse date order. Where a person has occupied the same position at different times, a separate record is created for each occupancy.

▶ To see further details of occupants or applicants:

- Select the person’s record in the Position Occupancy folder and choose the Person button.

  Note: There is no restriction on the assignments you can view in the Position Occupancy folder. However, you cannot view further details if you do not have clearance to view that person’s records.
Creating Position Hierarchies

You can create and maintain your reporting structures in two ways:

- using the Position Hierarchy window
- using the Position Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your position hierarchies graphically, and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Position Hierarchy window. Always define hierarchies from the top position down.

Prerequisites

- Define the top position in the hierarchy, and at least one position subordinate to it.

**To create a new position hierarchy:**

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.
2. Enter the version number and start date for the hierarchy.

You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.
3. Query the top position name into the Position block.
   The Holder field displays the name of the employee who holds this position. If there is more than one holder, this field displays the number of holders. You can choose the List icon from the toolbar to display the list of holders.

4. In the Subordinates block, select the immediate subordinates for the top position.

5. To add organizations below one of these immediate subordinates, check the Down check box for the position.
   The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.

   **Attention:** The list of positions from which you can select in the Subordinates block includes positions that are already in the hierarchy. If you select such a position, you will move it and all its subordinates within the hierarchy.

   See: Changing Position Hierarchies: page 3 – 23

**To create a new version of an existing hierarchy:**

1. Query the name of the hierarchy.

2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

   **Note:** Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

   You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top position name into the Position block.

4. In the Subordinates block, select the immediate subordinates for the top position.

5. To add positions below one of these immediate subordinates, check the Down check box for the position.
   The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.
To copy an existing hierarchy:

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.
2. Select the name and version number of the hierarchy you want to copy.

Details of this hierarchy then appear in the Position and Subordinates blocks. You can change these.

See Also

Dated Information and Hierarchy Versions: page 1 – 10

Changing Position Hierarchies

To add new positions to an existing hierarchy, query the hierarchy and version you want to change, query the parent position for the one you want to add, and select the new position in the Subordinates block.

To change the top position in an existing hierarchy, query the hierarchy and version you want to change, query the new top position, and select the previous top position in the Subordinates block.

You can move a position and all of its subordinates within a hierarchy. To move a position, query the hierarchy and version you want to change, query the new parent position for the one you want to move, and select the position to move in the Subordinates block.

Deleting Position Hierarchies

To delete a position hierarchy, you must first remove the subordinate positions from the hierarchy, starting at the lowest level. You cannot delete a position hierarchy if other versions exist, or if a security profile uses it.
Position Hierarchy Report

Oracle HRMS includes a standard Position Hierarchy Report to display the relationship between the positions in a hierarchy. The report also lists the current holders of each position in the hierarchy.

You run reports in the Submit Requests window.

To run the Position Hierarchy Report:

1. In the Name field, select Position Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Position Structure field, select the hierarchy. If there are multiple versions, select a version.
   
   If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.

5. In the Parent Position field, select the highest position in the hierarchy that you want to see on the report.
6. Enter Yes in the Holders Shown field to see holders’ names.
   
   If there are more than ten holders, you see the number of holders only.

7. Choose the Submit button.
Making Mass Updates

You can use the Mass Move feature to reorganize your Business Group, either within an organization or between organizations.

You can move assignments between existing positions, create new positions in which to move assignments, and change the grade, GRE/Legal Entity, or location and standard conditions of an assignment.

Business Group reorganizations often entail changing many employee records in the same way. Because Mass Move allows you to modify multiple employee records at once, you can make such changes conveniently.

These topics are covered:

- Preparing for your mass move: page 3 – 26
- Performing tasks to complete your mass move: page 3 – 28
- Managing your collection of mass moves: page 3 – 35
Preparing for Your Mass Move

To prepare for your mass move, you must make certain decisions and ensure that certain prerequisites are in place.

**Making Decisions for Your Mass Move**

- What is my source organization? (The mass move transfers assignments from the source organization.)
- What is my target organization? (The mass move transfers assignments to the target organization. The target organization can differ from or be the same as the source organization.)
- What is the effective date for the mass move?
- What are the source position(s)? (The mass move transfers assignments from the source position(s) within the source organization).
- Do you want to deactivate the source position?
- What are my target position(s)?
- If my target position(s) are new, will their location and standard conditions be copied from the source position, target organization, or Business Group?
- What grades are valid for the target position(s)?
- Which assignment(s) will transfer from my source position(s) to my target position(s).
- Will the grade of any transferring assignment change during the mass move?
- Will the GRE/Legal Entity of any transferring assignment change during the mass move?
- Will the location and standard conditions of any transferring assignment change during the mass move?

**Prerequisites for Your Mass Move**

To prepare for your mass move:

- Make sure you have access to a responsibility linked to the Business Group within which the mass move will take place.
  
  See: Accessing Business Groups: page 2 – 18

- Check that the source and target organizations for your mass move already exist in the HRMS database.
  
  See: Creating an Organization: page 2 – 20
See Also

Performing Mass Move Tasks: page 3 – 28
Performing Mass Move Tasks

Executing a mass move includes the following tasks:

1. Describe your mass move: page 3 – 28
2. Identify your source position(s): page 3 – 29
3. Identify your target position(s): page 3 – 30
4. For each source position, verify the transferring assignments: page 3 – 31
5. For each target position, verify or add valid grades: page 3 – 33
6. Execute the mass move: page 3 – 33
7. Review the mass move: page 3 – 34
8. If necessary, resolve any problems and then reexecute the mass move: page 3 – 34

Describing Your Mass Move

To define your mass move, the first task involves entering a description, determining the source and target organizations for the mass move, and specifying the date on which the mass move will take effect.

To describe your mass move:

1. Navigate to the Mass Move window.
2. Enter a description of the mass move you want to perform.
   You can change this description at any time before the mass move is processed.
3. Select the source and target organizations for the mass move.
   The source and target organizations can differ or be the same. The lists includes organizations that have been defined for the Business Group.

   Note: You cannot create a target organization “on the fly.”

   You can change the source and target organizations for this mass move at any time until you choose the Find button on the Find Positions window. These definitions then become part of the permanent definition of the mass move and cannot be changed.

   Status is a display field that indicates whether the mass move has not yet been executed (Unprocessed), successfully executed without
3 – 29 Jobs and Positions

errors or warnings (Complete), successfully executed without errors but with warnings (Complete with Warnings), or unsuccessfully executed with no changes made (In Error).

4. If necessary, adjust the effective date of the mass move.
   You can adjust the effective date at any time before the mass move is processed.

5. Save your work.

Identifying Your Source Positions

After describing your mass move, you must identify source position(s) to be moved.

► To identify your source positions:

1. In the Mass Move window, choose the Positions button.

2. In the resulting Find Positions window, select source job(s) and the source position(s) associated with those job(s).
   You can select from a list of existing job(s) and position(s) in the source organization, or you can use generic search criteria (wildcards) to identify a pool of source jobs and source positions from which you will select your source positions in Step 3.

3. Choose the Find button.
   When the Mass Move – Positions window is populated with information, the source and target organizations you defined in the Mass Move window appear in display fields.

4. If you used search criteria to identify a pool of source jobs and positions, make sure that the list includes all of the source jobs and positions you want to include in this mass move.

Attention: If you want to add source jobs or positions to this list, you must delete this mass move and define a new mass move; source job(s) and position(s) cannot be added to this list.

5. In the move check boxes, check each of the source positions you want to move.
   Assignments associated with unchecked source positions will not be affected by the mass move in any way.

6. If you want to deactivate any source position on the effective date for the mass move, check the Deactivate Old Position check box when that position is selected.
Selected: Deactivating a source position does not delete it from the HRMS database, but enters the mass move effective date as the end date for the position.

Unselected: Leaving this check box unchecked allows assignments to be assigned to this source position after the effective date of the mass move, even though the source position may have no assignments immediately following the mass move.

Attention: Unchecking the Move check box for a record restores the original values for that record.

See Also

Defining Positions: page 3 – 11
Managing Your Mass Move Collection: page 3 – 35

Identifying Your Target Positions

Now that you have identified the source position(s) for your mass move, you are ready to identify its target position(s). For each of the target positions you will define, perform the following steps:

To identify your target positions:

1. On the Mass Move – Positions window, select one source position for your mass move.
2. Select a target job to correspond with that source position. The list includes existing jobs within the Business Group.
   Note: You cannot create a target job "on the fly."
3. Choose Edit Field to enter a new target position, or select a target position. The list includes existing positions in the target organization.
   Note: Each source position can only have one target position. However you can use the same target position for multiple source positions.
4. Select the location and standard conditions for this target position. If this target position is a new position, you can enter location and standard conditions as follows:
   Source Position: Indicates that the location and standard conditions of the source position will be applied to the new target position when the mass move takes effect.
Target Organization: Indicates that the location and standard conditions of the target organization will be applied to the new target position when the mass move takes effect.

Business Group: Indicates that the location and standard conditions of the Business Group will be applied to the new target position when the mass move takes effect.

Attention: Unchecking the Move check box for a record restores the original values for that record.

5. When you have identified each of your source and target positions, choose the Assignments button.

See Also

Verifying Transferring Assignments for Each Source Position: page 3 – 31
Defining Positions: page 3 – 11

Verifying Transferring Assignments for Each Source Position

The content of the Mass Move – Assignments window depends on the source position you last selected in the Mass Move – Positions window. The Mass Move – Assignments window displays that selected source position, and its corresponding source organization and source job. It also displays the target position you have entered for this selected source position, and the target organization and job associated with this target position.

All of the (applicant as well as employee) assignments associated with the source position you selected in the Mass Move – Positions window are also displayed.

As the Move check boxes show, by default all assignments associated with this source position are selected to move to the target position. The Mass Move – Assignments window allows you to verify these assignments, indicate which ones, if any, will not be moving to the target position, and change the grade, GRE/Legal Entity, location and standard conditions for any of the assignments to be moved.

To verify transferring assignments for each source position:

1. If you want to prevent any of these assignments from moving to the target position, uncheck the appropriate Move check boxes.
2. If you want to change the grade for any transferring assignment, select the assignment, and then select another grade for that assignment.

3. If you want to change the GRE/Legal Entity for any transferring assignment, select the assignment, and then select another GRE/Legal Entity for that assignment.

4. If you want to copy location and standard conditions for a transferring assignment from an entity other than the current assignment (default), select the assignment, and then select the new location and standard conditions for that assignment. The options follow:

   **Current Assignment**: Indicates that the transferring assignment will maintain its current location and standard conditions when the mass move takes effect.

   **Source Position**: Indicates that the location and standard conditions of the source position will be applied to the transferring assignment when the mass move takes effect.

   **Target Organization**: Indicates that the location and standard conditions of the target organization will be applied to the transferring assignment when the mass move takes effect.

   **Business Group**: Indicates that the location and standard conditions of the Business Group will be applied to the transferring assignment when the mass move takes effect.

   **Attention**: Unchecking the Move check box for a record restores the original values for that record.

5. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Assignment window.

   When the Mass Move – Positions window reappears, you can repeat the above steps for any other source positions whose transferring assignments you choose to verify. Otherwise, you are ready to verify or add valid grades for any target(s) jobs/positions.

**See Also**

- Entering a New Assignment: page 9 – 9
- Representing the Employer: GREs: page 2 – 9
- Site Locations: page 2 – 2
Verifying or Adding Valid Grades for Each Target Position

Because it is possible for the grade of a transferring assignment to be outside the bounds of the valid grades for the target job or target position, you can use Mass Move to add valid grades to the target position.

1. On the Mass Move – Positions window, choose the Valid Grades button.

The resulting Mass Move – Valid Grades window displays information for the source position you last selected in the Mass Moves – Positions window. It displays the valid grades for the target position:

- A newly-created target position has the same valid grades as the source position.
- An existing target position retains its existing valid grades and Mass Move adds any other grades that are valid for the source position.

Thus Mass Move accommodates the grade(s) of the transferring assignment(s). You cannot delete any of the valid grades.

2. Optionally, select additional valid grades for the target position.

3. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Valid Grade window.

When the Mass Move – Positions window reappears, you can select any other records, to verify or add valid grades for that target position.

See Also


Executing the Mass Move


2. Save your work when prompted to do so.

3. On the Mass Move window, choose the Execute button.

If the number of changes being made is large, executing the mass move may take some time.
Reviewing the Mass Move

After you have chosen the Execute button on the Mass Move window, you are ready to review the results.

1. On the Mass Move window, review the contents of the Status field.

   **Unprocessed:** Indicates that you have not yet executed the mass move.

   **Complete:** Indicates that the mass move completed successfully without errors. For historical purposes, completed mass moves are automatically archived and cannot be modified.

   **Complete with Warnings:** Indicates that the mass move completed successfully. Nevertheless, you should still review any warning messages the mass move generates. It is possible for a mass move to execute with Status=Complete with Warnings, yet without all assignments moving as you intended.

   **In Error:** Indicates that the mass move did not complete successfully and that no changes took effect. You must first resolve the offending conditions before you can successfully reexecute the mass move.

   **Attention:** If the Status field shows In Error or Complete with Warnings, the Message button appears next to the Positions button.

2. If the Message button is displayed, review the messages.

   The Message window that appears includes the following fields:

   **Type:** Type of message; Warning or Error.

   **Row Information:** If this field displays a position name, the message applies to a source position. If this field displays the name of a person, this field applies to the assignment associated with that person.

   **Message:** Text of the message.

   **Note:** The Explain button on the Message window is disabled if no additional information is available.

3. If the Status field shows Complete or Complete with Warnings, navigate to the Mass Move – Assignments window and verify that the mass move changes you wanted to make did in fact take effect. Then navigate back to the Mass Move window.

Resolving Problems and Reexecuting a Mass Move

If the Status field on the Mass Move window shows In Error, you need to resolve the problems and reexecute the mass move until the Status
field shows Complete or Complete with Warnings. If the Status field shows Complete with Warnings, you will want to investigate those Warnings, and then determine whether you want to resolve the warning conditions and reexecute the mass move to eliminate the warnings. (However, it is important to remember that a mass move complete with warnings has in fact executed successfully.)

Resolving problems may require that you exit Mass Move. For example, an applicant assignment associated with a vacancy will not move during a mass move. To move that assignment to the target position, you would need to use the Assignment window to disassociate this applicant assignment from the source position, and then assign this applicant to a target position.

▶ To reexecute a mass move:
1. Navigate to the Mass Move window.
2. Query the mass move that you previously saved and want to reexecute.
3. After the Mass Move window is populated with data, make whatever changes you need to make to correct the mass move definition.

Attention: Since assignments are datetracked, you may only update a given assignment once a day. To bypass this rule, you can alter the mass move effective date.

If you query a previously saved mass move and then choose the Positions button, the Find Positions window is not displayed. Instead, the Mass Move – Assignments window immediately appears and is populated with data.

4. Choose the Re–execute button.
5. Review your mass move in the standard manner.

Managing Your Mass Move Collection

As you reorganize your Business Group over time, you will develop an historical archive of mass moves. This archive consists of:

- All executed mass moves for which Status=Complete
- Any executed mass moves for which Status=Complete with Warnings
- Any saved but unexecuted mass moves (Status=Unprocessed or Status=In Error) that you have not deleted
Because it is important to maintain an historical record of Business Group reorganizations, you cannot delete a mass move when its status is Complete or Complete with Warnings. However, you can delete any unexecuted mass moves you chose to save but which have a status of Unprocessed or In Error.

Reexecuting a mass move overwrites its original contents. Thus, only the latest reexecution of that mass move would appear in the historical archive.
This chapter explains how to represent the grade structures used in your enterprise and how to relate compensation to grades. You can relate compensation to grades directly, using grade rates, or indirectly, using grade scales.
Representing Grade Structures

Grades can have different levels of complexity, which need to be represented in the overall structure of the grade.

In its simplest form, a grade can be a single character, or number, in a logical sequence. For example:

- grade A
- grade B
- grade C

By adding a second *segment* to the grade name, you can identify sub–grades, such as:

- grades A.1, A.2, A.3, and A.4
- grades B.1 and B.2
- grades C.1, C.2, and C.3

A more complex structure could be used to distinguish grades for different staff groups, such as:

- Clerical.C.1 and Clerical.C.2

In this example, there are three segments in the grade name. A grade is the *combination* of segments you define. You set up the segments and their valid values using the Grade Name Key Flexfield. Normally this is done by the system administrator.
Using Grades

Grades are normally used to record the relative status of employee assignments and to determine compensation and benefits, such as salary, overtime rates, and company car.

Using Grades to Compare Roles

You can define one or more valid grades for each job or position. You enter this information in the Valid Grades window, which opens from the Job window or the Position window.

When you enter a grade assignment, the list of grades shows which ones are valid for the job or position you select.

See: Valid Grades (Oracle Human Resources North American User’s Guide)

Associating Grades with Compensation and Benefits

You can associate compensation and benefits with your grades. For example, you can record a minimum or maximum salary for a grade. There are two approaches:

- Using grade rates, you can either enter a fixed value for each grade, or you can enter a minimum, maximum, and mid-point values for each grade.
- Using grade scales, you can associate each grade with several points on a pay scale, and enter compensation values for these points.

Attention: The compensation information can change independently of the grade. Therefore, you should not define it as part of the grade name. Instead you should relate it to the grade, either directly or indirectly.
Defining Grades

Prerequisites

- Define all the segments of the Grade Name key flexfield that you want to use for the grade name.

To define a grade:

1. Enter your grades in sequence number order.
   
The sequence number can be any number from 1 upwards. The number indicates the rank order of the grade; 1 indicates the highest grade.
   
   This is the sequence in which the grades appear to users in lists of values.

   Consider sequencing each grade at intervals of 10 or more, to accommodate any future changes to grades.

2. Enter a unique name for the grade. If there is more than one segment in the grade name structure, a window opens when you enter the Name field. You must enter a unique combination of segments.

3. Enter a start date early enough to handle any historical information you want to enter.

4. Save your work.
Deleting Grades

To remove a grade from the list of grades to which employees can be assigned, enter an end date against the grade.

To delete a grade entirely from the system, you must first reassign anyone assigned to the grade. If you have historical records using the grade, you cannot delete it. Instead, enter an end date.
Grade Relationships to Compensation and Benefits

In many enterprises there are rule based reward structures based on grade. These rules can relate grades and pay *directly* or *indirectly*.

**Direct Relationship**

You may have a salary administration system in which the actual level of pay normally falls between a minimum and a maximum value for a grade. Regular performance reviews and ratings can involve comparison with the mid-point value of pay for your grade. In Oracle HRMS, this is a *grade rate*.

**Indirect Relationship**

You may be using a step based system of progression points within grades, in which each point has a fixed value in a pay schedule or table. In Oracle HRMS this is a *pay scale*. 
Relating pay to grades indirectly is common in government, education and health enterprises. It is also common in large commercial enterprises that negotiate pay levels with staff or union representatives.
Relating Pay to Grades Directly: Using Grade Rates

In Oracle HRMS, you can set up a table of values related to each grade. These are called grade rates. You can enter a fixed value or a range of valid values for each grade.

For example, you might define a salary rate and an overtime rate of pay for every grade, with minimum, maximum, and midpoint values. Both rates would be in monetary units. However, you can also define rates with non-monetary units, such as days, hours, or numbers.

Grade rates are datetracked and this means that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

You can use your grade rate values:

- as part of a QuickPaint report or inquiry
- to validate salary proposals
- to validate other compensation entries you make for employees
The salary administration process validates salary proposals automatically against the appropriate grade rate. You can use formula validation to check other compensation entries.

See Also

Salary Administration and Performance Reviews (Oracle Human Resources North American User’s Guide)
Using Oracle FastFormula for Validation, Oracle FastFormula User’s Guide

Defining Grade Rates

You define grade rates in the Grade Rate window.
When you save your definition, an automatic process creates corresponding database items that formulas can access.

To define grade rates:

1. Set your effective date to a date early enough for any historical information you want to enter.
2. Enter a name for the grade rate and select the units for measuring it. Save your new rate.
3. In the Grade Rate Values block, select the grades for which you want to define rates. For each grade, enter a fixed value and/or a minimum, maximum and mid value.
To use this grade rate to validate salary proposals entered in the Salary Administration window, you must enter a minimum and maximum value.

To view comparatio values using this grade rate, you must enter a mid value.

See Also

Setting Up Salary Administration (Oracle Human Resources North American User’s Guide)

Viewing Grade Comparatios

The View Employee Grade Comparatio window compares the compensation values you enter for employees with the minimum, maximum, and mid values you define for their grades.

Prerequisites

- Define a grade rate and enter minimum, maximum, and mid values for each grade.
- Enter salary or other compensation values for your employees.

To view employee grade comparatio values:

1. Select an element, an input value, and a grade.
   The inquiry finds assignments that are on this grade and that have an entry for this input value.
2. Select a grade rate for which you have defined a range of valid values.
   The inquiry compares the minimum, maximum, and mid values for your chosen grade with the element entries of the list of assignments.

3. Choose the Find button to run the inquiry.
   The folder in the lower part of the window lists the assignments that match your selection criteria:
   - The value is the element entry value for each assignment.
   - The comparatio shows the assignment’s element entry as a percentage of the mid–value defined for the grade rate.
   - The percent of range shows the position of the assignment’s element entry between the minimum value for the grade rate (0%) and the maximum value (100%).

**Part Time Employees**

Employee are part time if the hours on their assignment’s standard conditions are less than the work day hours entered for their organization. For part time employees, the system prorates the minimum, maximum, and mid grade rate values before calculating the comparatio and percent of range.
Relating Pay to Grades Indirectly: Using Pay Scales

If you are involved in negotiating pay levels with staff or union groups, you may be using a system of grade steps or points with specific values of pay for each step, or point. For example, you may have negotiated different pay scales with different union groups. Or, you may have negotiated a single set of pay points for all of your employees.

Typically, employees are placed on a step within their grade. They move up the steps for the grade by a periodic incrementing process. This process might run automatically at a fixed time each year or it might be based on a review process specific to the employee.

In Oracle HRMS you set up a *pay scale* to show the separate points and the value negotiated for each point. You can set up any number of pay scales, for example for negotiated pay scales with different unions.

Setting Up Pay Scales

1. **To set up a pay scale:**
   1. Create the pay scale itself, which is a set of progression points.
   2. Define one or more rates associated with the pay scale, entering a value for each progression point.
   3. Define your grade scales, which are the points of the pay scale that are valid for each grade.

You can define the rates before or after you define the grade scales.

Using Pay Scales

You manually place an employee on the appropriate grade step. You can use a process to automate the periodic incrementing of the grade step placements for some or all employees.

See Also

Incrementing Grade Step Placements: page 4 – 18
Placing an Employee on a Grade Step: page 4 – 16
Defining a Pay Scale

You define a pay scale, which is a set of progression points for compensation, in the Pay Scale window.

![Pay Scale Window]

**To define a pay scale:**

1. Enter a unique name for the pay scale.
2. Enter the Increment Frequency for this pay scale. For example, if you want to increment the placement of assignments on the pay scale once each year, enter 1 in the Number field and select Year in the Per Period field.

   **Note:** These values provide information only. You can use the Submit Requests window to set up automatic regular incrementing of grade step placements by the Increment Progression Points process.

   See: Incrementing Grade Step Placements: page 4 – 18

   The Automatic Increment field shows the date of the last automatic increment.

3. Save the pay scale.
4. Enter the names of the points (or steps) of the scale. The Point names can be numeric or alphanumeric. Enter them in ascending order.
5. Enter a sequence number, in ascending order, for each point. The sequence determines the progression order for the incrementing process. Then save the scale again.

**Suggestion:** Enter sequence numbers in multiples of 5 or 10, for example 5, 10, 15, 20. This makes it easier to enter new points between existing points in the sequence if you need to in the future.

---

**Defining Scale Rates**

In the Scale Rate window, you can create a rate and enter a fixed value for each progression point on a pay scale. You can create as many rates as you require, such as one for a shift allowance, and another for overtime. Notice that, unlike grade rates, you can only enter a fixed value for each point; you cannot enter a range of valid values.

The values are datetracked so that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

The rates can be defined in monetary units, or as integers, numbers, days, or hours, in various formats. For example, you could define a rate in hours to specify the maximum number of overtime hours that can be worked per week.

When you define rates, an automatic process creates corresponding database items that formulas can access.

See: Dynamic Database Items: page C – 19
To create a scale rate:

1. Set your effective date early enough to handle any historical information you want to enter.
2. Enter a unique Name for the rate.
3. Select the Units for measuring the rate, such as hours, money, or integer.
4. Select the Pay Scale for which you are defining the rate.
5. Save the rate.
6. In the Progression Point Values block, select the points for which you want to define rates. For each point, enter a fixed value. Save the rate again.

Relating Grades to Progression Points

A pay scale defines a complete set of progression points. You can associate a subset of these points with each grade.

The group of points valid for a grade is called a grade scale. Each point in the grade scale is called a step because it represents the steps for incrementing an employee’s pay. The steps must follow the sequence of points on the pay scale but they can jump several points, if appropriate to the specific grade.

<table>
<thead>
<tr>
<th>Pay Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point</td>
</tr>
<tr>
<td>10</td>
</tr>
<tr>
<td>20</td>
</tr>
<tr>
<td>30</td>
</tr>
<tr>
<td>40</td>
</tr>
<tr>
<td>50</td>
</tr>
<tr>
<td>60</td>
</tr>
<tr>
<td>70</td>
</tr>
<tr>
<td>80</td>
</tr>
</tbody>
</table>
To create a grade scale:

1. Set your effective date early enough to handle any historical information you want to enter.
2. Select a grade, and select the pay scale from which you want to choose progression points.
3. Select the highest point (or ceiling) to which employees on this grade can be automatically incremented by the Increment Progression Points process. Save the grade scale. You can override this ceiling for individual employee assignments.
4. In the Grade Steps block, select the points you want to include on this grade scale.
   When you save, the system sorts the points into ascending order by their sequence numbers (defined in the Pay Scale window).

Placing an Employee on a Grade Step

If you include a grade as part of an employee’s assignment, you can place the employee on a step on the associated grade scale.
You place an employee using the Grade Step Placement window.
When you open this window, information about the grade and scale
appears automatically. By default, the ceiling point is the one you defined for the grade. However, you can enter a special ceiling point for individual employees in the Assignment window.

To place an employee on a grade step:

1. Set your effective date to the date when the placement should come into effect.
2. Select the point or step on which to place the employee assignment.
3. If you want the employee’s placement to increment automatically when you run the Increment Progression Points Process, check Auto-Increment.
4. You can select a reason for manually entering a placement. You can add values to the list of valid reasons by defining values for the QuickCode Type PLACEMENT_REASON.
5. Save your work.

The Progression Point Values block displays the rates you have defined for the pay scale, and the values corresponding to the selected progression point.
Incrementing Grade Step Placements

You can increment grade step placements manually, using the Grade Step Placement window, or automatically, by running the Increment Progression Points process.

To run the Increment Progression Points process:
1. Navigate to the Submit Requests window.
2. In the Name field, select Increment Progression Points.
3. Enter the Parameters field to open the Parameters window.
4. Enter the name of the pay scale.
5. Enter the date on which the increment becomes effective.
6. You can also enter values for some or all of the segments of your People Group Flexfield. This restricts the assignments incremented by the process to those in the group matching the values you enter.

Attention: An assignment’s grade step placement is incremented automatically only if:
   • it is still below the ceiling point, and
   • the automatic increment check box on the Grade Step Placement window is checked for the assignment, and
   • there are no future changes or deletions to the assignment’s grade step placement, or to the assignment itself, or to the grade scale for the assignment’s grade, or to the new grade step for the assignment.

Oracle HRMS supplies two predefined reports to help you predict and check the results of the Increment Progression Points process.

Current and Projected Progression Point Values Report

Run this report before running the Increment Progression Points process, to assess its effects. The report shows what changes would be made by the process and how much it would cost for a particular scale rate, such as salary, or for all rates.

You run reports in the Submit Requests window.

To run the Points Values Report:
1. In the Name field, select Current and Projected Progression Points Values Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and enter the date on which the increment would become effective.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.

**Employee Increment Results Report**

Run this report after running the Increment Progression Points process. This report shows the results of the process.

You run reports in the Submit Requests window.

**To run the Employee Increment Results Report:**

1. In the Name field, select Employee Increment Results Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and the increment process run for which you want to see the results.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.
This chapter explains how to set up payrolls to pay your employees and to define groups of employees who are eligible to receive particular compensation and benefit elements. It also explains how to define payment methods for paying employees and making third party payments.

Using all the work structures you set up, you can identify groups of employees by organization, job, position, grade, employment category, salary basis, or payroll. Additionally, you may need to set up your own groups, for example to identify employees within a trade union, or a pension group. This chapter explains how you can set up your own groups using the People Group Key Flexfield.
Representing Payrolls

In Oracle Payroll you set up payrolls to pay your employees. An employee must have an assignment to a payroll in order to receive pay. Both human resources and payroll users can also use payrolls for other purposes:

- to identify specific groups of employees for inquiry or reporting purposes
- to define eligibility for certain compensation elements
- as part of security definitions, to restrict access to the records of certain groups of employees on the system.

**Note:** You must define payrolls in order to use *nonrecurring elements*. You can use these elements to represent types of compensation and benefits, and to maintain absence balances for your employees.

See: Element Processing Types: page 12 – 23

You can define as many payrolls as you require to represent groups within your workforce. You might need to define multiple payrolls for the following reasons:

- You require different payment frequencies (weekly or monthly) for different groups of employees.
- You need to restrict access to certain payroll information for reasons of confidentiality.

![Figure 5 – 1](image)

**Payroll Groups**

- Monthly Paid
- Semi-monthly Paid
- Weekly Paid

Each payroll has its own processing calendar, key dates, costing information, and valid methods of making payments to its employees.
Payroll Setup Steps

1. Define the various payment methods in use in your GREs.
   See: Defining Payment Methods for the Enterprise: page 5 – 3

2. For GREs using payrolls with payment methods of the type NACHA to pay employees, enter data for the NACHA tape batch headers.
   See: Entering NACHA Tape Data for GREs: page 5 – 5

3. Define the payrolls in use in your GREs.
   See: Defining a Payroll: page 5 – 6

Defining Payment Methods for the Enterprise

Each payment method has a type of either check, NACHA, or cash.

Within these payment method types, you can define as many payment methods as you require for your enterprise. When you create a payroll you can select which of these methods are valid for employees assigned to that payroll. You select one of these methods as the default method for the payroll.

Employees can be paid by one or more of the valid methods for their payroll. You select the appropriate methods and enter bank account information, if required, in the Personal Payment Method window. If you do not enter any personal payment methods, the employee is paid using the default method for his or her payroll.

You can also define payment methods for third party payments, such as court-ordered wage attachments. Third party payments are always made by check, so methods for these payments must have the type Check.
Define payment methods for the enterprise in the Organizational Payment Method window.

To define a payment method:

1. Set your effective date to the date you want to begin using the payment method.
2. Enter a name for the payment method, and select its type.
   - You can create as many payment methods for each type as you require. For example, if you have different source bank accounts for different payrolls, you must create separate payment methods.
   - For a third party payment method, select the type Check.
3. The base currency for the Business Group appears. For some payment methods, you can select another currency.
4. To define a third party payment method, for example for a garnishment or a payments to a benefits carrier, check the Third Party Payment box.
5. Enter the Bank Details field to open the Bank Details window. Enter information about the account from which payments are coming.
   - **Note:** The Further Information field is not activated for US installations, so you cannot make entries in it.
6. Save your work.

**See Also**

Entering Payment Methods for an Employee Assignment: page 9 – 21
For GREs using payrolls with payment methods of the type NACHA, enter information for the NACHA tape batch headers in the NACHA Rules window.

To enter NACHA rules for a GRE:

1. In the Organization window, query the GRE if it does not already appear there. In the Organization Classifications region, place the cursor on Government Reporting Entity, choose the Others button, and select NACHA Rules to open the NACHA Rules window.

2. Enter the Company Name, which is the name of the GRE making this batch of direct deposit payments to employees.

3. Select Mixed Debit and Credit Entries, Debit Entries Only or Credit Entries Only in the Service Class Code field.

4. Select either Cash Concentration and Disbursement or Prearranged Payment and Deposit Entry in the NACHA Standard Entry Class Code field.

5. Enter the Company Identification number of the GRE making this batch of payments.

6. In the Company Discretionary Data field, you can enter codes of significance to you, to enable special handling of all subsequent entries in the batch. This field has no standard interpretation.

7. In the Message Authentication Code, you can enter an 8-character code you derive, whose purpose is to validate the authenticity of Automated Clearing House (ACH) entries. This field has no standard interpretation.
Defining a Payroll

A payroll is a set of employees whose pay you process with a single frequency, for example, weekly or monthly. You can define as many payrolls as you require to meet the pay policies of your enterprise. You put an employee on a payroll by assigning him or her to the payroll.

Use the Payroll window to define a payroll, including its calendar and valid payment methods.

Period Types and Calendars

Since a payroll has only one pay frequency, you must define at least one payroll for each pay frequency you use. Table 5 – 1 shows the valid period types for pay frequency.

<table>
<thead>
<tr>
<th>Payroll Period Types</th>
<th>Periods per Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>1</td>
</tr>
<tr>
<td>Semi-Year</td>
<td>2</td>
</tr>
<tr>
<td>Quarter</td>
<td>4</td>
</tr>
<tr>
<td>Bi-Month</td>
<td>6</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>12</td>
</tr>
<tr>
<td>Lunar Month</td>
<td>13</td>
</tr>
<tr>
<td>Semi-Month</td>
<td>24</td>
</tr>
<tr>
<td>Bi-Week</td>
<td>26</td>
</tr>
<tr>
<td>Week</td>
<td>52</td>
</tr>
</tbody>
</table>

Table 5 – 1 Payroll Period Types

Prerequisites

Define the payment methods available for your employees.

See: Defining Payment Methods for the Enterprise
To create a new payroll:

1. Set your effective date to a date early enough to handle any historical information you want to enter. Your effective date must be on or before the first period start date of the payroll calendar.

2. Enter the payroll’s name and select its period type from the list.

3. Enter the end date of the payroll’s first period, and the number of years for which the system should initially generate the payroll’s calendar. You can increase this number later to generate additional years.

   When you enter the First Period End Date, make sure that the corresponding start date of the first period is after the start date of the payroll.

4. In the Date Offset region, you can change the zero default to a negative or positive number of days before or after the period end date. For example, for a semi–monthly payroll, the Cut Off date can be 3 days before the period end date (−3), while the Scheduled Run and Check dates can be 5 and 7 days after this date, respectively.

   • The Check Date, sometimes called Pay Date, is the date of constructive receipt of pay, on which paychecks become negotiable.

   • The Scheduled Run Date is the date scheduled for the Regular run of this payroll each period.

See: Regular and Supplemental Runs: page 21 – 2

• The Cut Off date, included for your reference, is the final date for entering or changing payroll information before a run.
5. Select a default payment method for employees who have no valid personal payment method. You cannot select a method using magnetic tape because this requires information about employees’ bank accounts.

6. Select a default consolidation set for this payroll. One consolidation set is created automatically when you define your Business Group. Oracle Payroll users can create other consolidation sets for payroll processing.

   See: Consolidating Payroll Information: page 21 –10

7. In the Costing region, you can enter information about the set of books and suspense account holding costing information for this payroll.

   The information you enter here depends on the setup of your Cost Allocation key flexfield.

   See: Setting Up the Cost Allocation Key Flexfield: page 11 – 11

8. Save your work.

9. Choose the Period Dates button to view the calendar generated for your payroll. In the Period Dates window:

   • You can view the default offset dates for every period, and you can manually override any of these dates in any record.

   • You can change the payroll’s default Open status in any period to Closed to prevent further element entries. You can also reopen the period if necessary.

   **Attention:** Use this feature with caution. When you perform certain important tasks in Oracle HRMS, the system may automatically create or delete element entries. These tasks include hiring and terminating people, and updating assignments. You cannot change any element entries that span a closed payroll period, and so you may be prevented from performing these tasks.

10. Choose the Valid Payment Methods button to add valid payment methods for this payroll.

    In the Valid Payment Methods window, the default payment method for the payroll appears automatically. You can add other methods. First set your effective date to the date you want the method to become valid.

    **Note:** An employee assigned to this payroll can have any number of personal payment methods chosen from those you enter here for the payroll.
Deleting Payrolls

You can delete a payroll if there are no active employee assignments or element links to it. However, if you have run processing for a payroll it is not advisable to delete it. If necessary, define a new payroll and simply discontinue use of the old payroll.

See: Entering Payment Methods for an Employee Assignment: page 9 – 21
Representing Other Employee Groups

All the work structures provide ways of defining groups of employees at your enterprise, such as groups working at a particular location, or on a certain grade, or in a department. You create the groups by assigning employees to the work structures in the Assignment window.

You can also assign people to:

- an employment category: full-time – regular, full-time – temporary, part time – regular, or part time – temporary
- a salary basis, such as weekly or annual, which defines the duration for which the employee’s salary is quoted

See: Components of the Assignment: page 9 – 5

Oracle HRMS provides a special structure you can use to define any other special groupings of employees your enterprise requires. This structure is called the People Group. Just as with payrolls and other work structures, you can assign employees to these groups, and use them to define employee eligibility for compensation and benefits elements.

Examples of group definitions might be:

- members of a union
- members of a pension plan.

Setting Up the People Group Flexfield

The People Group is a key flexfield, like Job Name, Position Name, and Grade Name. As with these other key flexfields, you can define up to 30 segments to hold information you use to identify employee groups in your enterprise.

Using the People Group key flexfield to define your groups is a powerful mechanism because you can:

- link elements to Group flexfield segments so that only employees within the group are eligible for the elements
- inquire and report on individual segments in Inquiry windows and in reports
- use DateTrack to build up a history of the group information

If your enterprise uses pay scales to relate compensation levels to grades indirectly, you can use a People Group segment to specify which employees are processed by the Increment Progression Points process.
Once you decide how to define the Group key flexfield structure and segments, it is the responsibility of the System Administrator to set up this and the other key flexfields. At least one segment of this flexfield must be set up before you can begin entering employee assignments.

**Attention:** If you make any of the People Group segments required, they are required in the Element Link window, as well as the Assignment window. This means that you may have to create multiple element links if you want to use a People Group segment in the eligibility criteria for a link.

For example, suppose you have defined two segments: a Yes/No segment called Fast Track, which is required, and a segment called Pension Plan, which is not required. You want to make an element available only to members of a certain pension plan. However, you must create two element links: one for members of the pension plan who are on the Fast Track, and another for members who are not on the Fast Track.

If there are many possible values for the required segment, the maintenance of multiple links can become a burden so be cautious in making segments of this flexfield required.

**See Also**

*Oracle Applications Flexfield Guide*
This chapter explains how to establish and represent the retirement process at your enterprise. It further explains how to represent:

- Retirement structures
- Processing employees for retirement
- Mechanisms for retired employees who continue to earn regular wages
Retirement Overview

Oracle Payroll supports periodic payments from a **defined benefits plan**. A defined benefits plan is generally funded entirely by the employer and the employee receives a pre-determined pension distribution upon retirement.

Pension income is subject to federal, state, and local taxation. However, distributions made to a retiree are taxed differently than regular earnings (e.g., Social Security, Medicare and Disability Taxes are not deducted). Retirement income is also reported separately from an employee’s regular earnings.

VERTEX tax tables do not handle pension-specific tax calculations. Any federal, state, or local tax withholding calculations that do not use the same formulas as active employees will need to be handled by existing tax withholding overrides functionality or user customization.

You need to establish a retirement GRE for pension processing. Within a single GRE, it is difficult to distinguish between regular earnings and retirement distributions. For example, when processing 1099-R reports, only pension distributions should be reported.

Retirement processing in Oracle Payroll resembles processing regular, non-retired employees in every manner. You establish a retirement GRE. You establish a retirement payroll, and any pension elements that may apply. You do not have to manage the process in any different manner than any other employee group.
Establishing Retirement Structures

Establishing a retirement structure is composed of the following tasks:

**To establish a retirement structure:**

1. Create a retirement GRE.
   - The retirement organization can have the same Employer Identification Number (EIN) as an existing GRE if required. If the entity set up as retirement GRE will be used to generate and transmit 1099–R magnetic reports, then a set of 1099–R specific information will need to be defined here.
   - See Employer and Organization Setup: page 2 – 18

2. Define a retiree payroll.
   - Although an Organization might have several different Payrolls defined for their employees, it is likely that all retired employees would be paid at the same frequency.
   - This has the advantage of allowing employers to define new structures for pension processing (e.g. elements, formulas, balances) and link only those structures to the Retiree Payroll.
   - See Defining a Payroll: page 5 – 6

3. Define pension elements.
   - It may be necessary for organizations to define new earnings types for pension payment processing. This can be done by creating earnings, choosing rules that govern their processing and the types of deductions that process against them.
   - According to these rules, Oracle Payroll generates elements with the appropriate input values, balance feeds and formulas with the necessary processing and result rules.

   **Attention:** The VERTEX tables do not calculate tax withholdings that are specific to pension payments. Any such calculations will need to be dealt with through existing tax withholding override functionality or user customization.
   - See Modifying an Element Generated for Payroll Processing: page 14 – 12

4. Define a retirement leaving reason.
   - When an employee retires, you set the Leaving Reason at the person level to something which indicates that the employee has retired.
   - Setting the Leaving Reason to Retired will allow you to see all retirees through the standard Terminations report supplied with Oracle Payroll.
This can be done by adding values to the lookup type LEAV REAS.

See Also
Defining QuickCode Types: page 29 – 5
Defining Assignment Statuses: page 24 – 7

5. Define the retiree salary basis.

A retiree must have a salary basis for earnings relating to the retiree assignment to appear on the statement of earnings form.

Using the Salary Administration window, you can enter a proposed salary change for an employee, associate this change with a performance review, and accept or revise the change later. To administer an employee’s salary in this way, you first assign the employee to a salary basis in the Salary Information region.

See Entering a New Assignment: page 9 – 9

6. Define a retirement status.

A separate assignment status indicating retirement should be used to distinguish those assignments to which pension payments are made.

Set the user–defined assignment status for retirement to a HR system status of Active Assignment and a Payroll system assignment status of Process.

Defining Assignment Statuses: page 24 – 7

7. Define the retirement tax withholding rules.

Oracle HRMS provides flexibility for employers who have retirees who elect to have a specific percentage or flat dollar amount withheld from period distributions.

Retirees may elect one of these options, or they may wish to use the Filing Status and Allowance calculation method.

See Structures for Initiated Deductions: page 16 – 2

8. Date effectively change the GRE, if needed

If an employee is date effectively moved into a new GRE after pension payments have been processed in another GRE, then it is important to note that the balances in both GREs will not reflect the date effective change.

For example, if an employee assigned to GRE A retires and has pension distributions processed in three payroll runs before being date effectively moved (as of retirement date) into
Retirement GRE B, then balances in GRE A will still hold the results of the pension distributions processed.

Balances in GRE B will not contain information relating to the payroll runs made before the employee was date effectively moved.

To maintain balances correctly for both GREs, the distributions made in GRE A for the retiree will need to be reversed and re-applied in GRE B.
Employee Retirement Processing

When employees retire, you move their primary assignment into a Retirement GRE. All earnings and deduction information processed for that person from that point is held in a separate balance (e.g. the level or context of GRE can now be used to extract details of earnings and deductions processed after retirement).

Prerequisites:
The following elements and structures should be determined prior to retiring the employee:
- Retirement GRE
- Retiree payroll.
- Pension elements.
- Retirement leaving reason.

Processing Employees for Retirement

Retiring an employee is similar to the process of terminating an employee. However, there are some post retirement processes that must be performed. The following task list defines the retirement process and post processes.

1. Retire the employee.
   See Retiring an Employee: page 6 –6
2. Update the employee’s assignment details.
   See Updating Assignment Details: page 6 –9
3. Pay earned income, if needed.
   See Earned Income After Retirement: page 6 –10
4. Define any tax withholding rules.
   See Defining Tax Withholding Rules: page 18 –4

Retiring the Employee

To retire an employee:

1. Follow the employee termination procedure when you retire an employee.
See Ending Employment: page 9 – 17

**Attention:** Do not set the Final Process Date. This would cause the Payroll Run to cease processing any elements for the person after the last processed date.

2. Select a Leaving Reason of Retired (user-defined reason) and set the Actual End Date to the date at which the employee will retire. Selecting the Terminate button opens a window with a choice of assignment status.

3. Select a system status with an HR system status of Terminate Assignment and a Payroll system status of Process, or a user defined status of Retired. Selecting OK date effectively changes the employee to a retiree from the Actual End Date you specified.

   **Note:** Setting the Final Process Date will end-date all element entries related to the employee. Any element entries the retiree wishes to continue into retirement (e.g., Health Care 125) must be reentered into the pension assignment.

---

**Final Pay Processing**

Some earnings and deductions undergo special processing for a terminated employee’s final pay:

- Formulas for the predefined earnings for regular pay issue warnings if regular salary or wages process for employees after the actual termination date.
- The formula for the series EE bond deduction produces a refund for accumulated deductions.
- Formulas generated for deductions taken to repay loans cover current outstanding balances.

During final pay processing, any issues relating to the retiree are highlighted. For example, if the employee’s final pay cannot cover a loan payment, this is reported by the payroll run. Any issues raised should be dealt with before the employee is moved into the retirement GRE.

---

**Creating a Retiree Assignment**

After the retiree’s termination procedure, create a new assignment to which the pension payments will be made. A pension assignment is
identical in structure and handling to an Active Assignment for an employee.

**Note:** Prior to moving the retiree into the Retirement GRE, you must assure that any problems that occurred in final pay processing have been resolved.

To create a retiree assignment in the Retirement GRE

1. Set the session date to the day in which the employee’s retirement begins.
2. In the Person screen, update the Person Status of Ex-Employee to Employee.
3. Navigate to the Assignment screen, and insert appropriate retirement specific information for:
   - GRE
   - Organization
   - Payroll
   - Salary Basis
4. Change the assignment status from Active Assignment to a user-defined retiree status.
5. Date effectively add any element entries required for processing the retiree other than the entry associated with the retiree salary basis.

See Final Pay Processing: page 6–7

---

**Defining Retirement Tax Withholding Rules**

Oracle HRMS provides flexibility for employers who have retirees electing to have a specific percentage or flat dollar amount withheld for period distributions. If retirees elect one of these options or if they wish to use the Filing Status and Allowance calculation method, use the Employee Tax Information screen.

When defining tax withholding rules for a retiree, Time in State should be set to 100% in the resident state. All tax exemption boxes should be checked for any defined non-resident states.

**Attention:** Changes to retiree tax rules should not be made until after final pay has processed. This is because any changes made for retiree processing would also affect any regular pay processing.
Retirement Payroll Processing

At the specified retirement date, the employee’s pension elements become active. Any previous element entries attached to the pre-retirement assignment are end-dated by the termination procedure.

Payroll processing for the retiree now produces results which are stored in balances containing retirement data only.

Updating Assignment Details for the Retiree

Once employees have retired, their primary assignment should be moved into the Retirement GRE.

To update assignment details for the retiree:

1. Change the GRE to which the assignment is associated to the retirement GRE.
   See Changing Assignment Information: page 9 – 14
2. Consider changing the Organization that the retiree is associated with to that of the Retirement GRE.
3. Date effectively move the assignment into a Retirement Payroll if required.
   For example, if an employee was paid on a weekly basis but will receive retirement distributions monthly, then his assignment will need to be updated to process on a monthly payroll.
   At the specified retirement date, the employees assignment will automatically switch to the new GRE, any previous element entries will be date effectively ended and the new pension elements will become active.
   Payroll processing will now produce results which are stored in balances containing retirement data only.
4. Any element entries required for processing the retiree should be date effectively added.
Earned Income After Retirement

If non-pension payments need to be made to employees after their retirement date, create a secondary assignment for the employee in the employee’s original GRE.

Making payment of this earned income into the employee’s original GRE allows Oracle Payroll to accurately track pension and earned income distributions separately. This is important when processing end of year reports.

Paying a Retiree Non-Periodic Payments

Some employees continue to receive regular wages after retiring. For example, if an employee was in sales and earns commission after his retirement date, the money is considered to be regular wages and must be taxed as a regular wage.

- **To have regular earnings processed for the retiree:**
  1. Set the session date to the day at which the retiree will begin to receive non-retiree income.
  2. Create a secondary assignment for the retiree in the employee’s original GRE.
     Payment of this earned income into the employee’s original GRE allows Oracle Payroll to accurately track pension and earned income distributions separately. This is important when processing end of year reports, such as W-2 and 1099-R.
     See Entering a New Assignment: page 9 – 9
  3. Create a separate earnings element and salary basis solely for the secondary assignment.
     See Regular Salary and Regular Wages: page 15 – 2
  4. Create a standard link for the earnings to the salary basis and set the “Amount” input value to a value of $0.00. The standard link must be set to satisfy the condition that an assignment must be assigned to a salary basis before results can be viewed through the Statement of Earnings screen.
     See Defining Element Links: page 12 – 38
  5. Earnings such as commission payments can now be processed in exactly the same way as for regular employees and viewed through the Statement of Earnings screen.
Retired employees sometimes desire to continue working, either full or part time. These same employees can rejoin the enterprise either immediately upon retirement, or at some later date.

To process regular earnings for the retiree who continues to work:

1. Set the session date to the day at which the retiree will begin to receive non-retiree income.

2. Create a secondary assignment for the retiree in the employee’s original GRE.

   Payment of this earned income into the employee’s original GRE allows Oracle Payroll to accurately track pension and earned income distributions separately. This is important when processing end of year reports, such as W-2 and 1099-R.

   See Entering a New Assignment: page 9 – 9

3. Create a separate earnings element and salary basis solely for the secondary assignment.

   See Regular Salary and Regular Wages: page 15 –2

4. Set up the secondary assignment salary basis which has been associated with the periodic payment.

5. Add additional earning and deduction information as required.
Each enterprise has its own unique ‘culture’, which is reflected in the organization of work and in the management of people within the enterprise. Culture also affects the reward systems in operation and the control systems that are required. Although each enterprise is unique, it is possible to identify some common types of enterprise.

This chapter describes three typical enterprise models and suggests how you might implement Oracle HRMS for each of these.

These suggestions are not intended to provide a blueprint for your own implementation, but they should help you to see how you can implement and use different combinations of organizations and jobs, or positions in your own situation.
Project Based Enterprises

Project based enterprises are typically service based industries in which flexibility and organizational change is a key feature. Examples of this type of enterprise are consultancy or construction companies, or small manufacturing or software companies.

At its simplest level, an employee is assigned to work on a single project for a given period of time. For example, an engineer working on a large scale construction project might be assigned to the project for a period of six months. All of his or her work, and costs, are associated with this one project. When this is complete the employee moves on to perform a similar role in another project. In this example you would expect the employee to have a single assignment, with 100% of the assignment costs allocated to a single project. The employee assignment might also contain project specific information, such as location or group information.

In a different situation, an employee might be assigned to a number of projects at the same time. For example, consider an Applications Consultant working for Oracle Corporation. This person is employed as a consultant by a specific organization within Oracle but the project work is undertaken outside Oracle. The consultant performs similar tasks in different implementation projects, and costs are allocated on the basis of actual time spent working on each project. In this example you would expect the consultant to have a single assignment in Oracle HRMS and the project allocation and costs to be entered as timecard information.

In both of these examples, employees perform specific roles, but they work on different tasks or projects at different times. Project based enterprises normally have a fluid organization structure with regularly changing reporting and management lines. This fluidity provides the flexibility required to compete in rapidly changing markets.

Organizations can be formed or transformed at short notice as different projects or management groups are formed. Employees can be assigned and reassigned to these organizations, also at short notice, although they normally retain their basic role, or job.

Representing Organizations and Jobs

In both of the examples given, you need the ability to define and change organization structures easily and quickly. You also must be able to move employees between organizations while keeping the same job. For both of these reasons, you would probably use organizations and jobs to show how people are assigned and managed.
Jobs are independent of organizations. In the Assignment window, you can change the assignment organization or job independently.

Figure 7–1
Project based assignments

Typically, you would not define Positions to show this type of working. Positions require additional definition and maintenance, and do not reflect the sort of flexible working environment found in this type of enterprise.

Working with organizations and jobs as the basis of the employee assignment, you can also consider how you would reflect the assignment of the employee to individual projects. There are a number of possible options to consider.

- Use organizations to show actual projects, and assign employees to projects.
  - Useful for single projects. For multiple project assignments you would need to use multiple assignments.

- Use a People Group flexfield segment to hold the project code.
  - An alternative for single projects, where you want to use the organization to show internal management structures. However, for multiple project assignments you would still need to use multiple assignments.

- Use a Cost Allocation Flexfield segment to hold the project code.
  - Useful for both single and multiple project assignments. You can collect project cost information at the work assignment or the timecard entry level.

Organization Structures

You should define organizations down to the level of individual managers, and use the manager flag on the Assignment window to identify the manager of each organization. Also, define your primary organization hierarchy to show the detailed management reporting lines among organizations and managers. In this way you can show that employees assigned to an organization are managed by the organization’s manager.
Attention: It is best not to use the Supervisor field of the assignment window to identify managers for individual employees. This field is used to identify a personal supervisor for an employee and is not updated if the supervisor moves to another job or organization.

Job Structures

In this type of environment, jobs show the specific roles employees perform. Therefore, you are likely to have multi-segment job names to distinguish different types and different levels of jobs in the enterprise. For example, you might define a three segment job name with Job Group, Title, and Job Level. An actual job combination might then be 'Applications.Consultant.Senior'.

Project Allocation and Costing

With this type of implementation, you would probably use the assignment to identify management type reporting. You would identify project-working using a segment of the Cost Allocation flexfield to show Project Code for each assignment.

If you set the qualifier Assignment to Yes for this segment, you could enter percentage costs for the assignment to different project codes. If you set the qualifier Element Entry to Yes for this segment, you could use a timecard element to record and cost the actual hours worked on each project.

See: Costing Information at the Organization and Assignment Levels: page 11 – 9

Other Management Issues

When you consider this environment there are other areas your decisions may affect:

Remuneration Policies

Individual compensation and benefits are often based on personal negotiation, or performance reviews. Therefore you will probably have fewer rules to determine policy and more consideration of the actual values entered for an employee.

Grades and Jobs

Typically grades and jobs are very closely linked. For example, the name Senior Consultant may identify both the role of an employee and his or her relative status and eligibility for compensation and benefits.
You may decide to set up the same structures for both the job and the grade. This will be true if you want to set up rates of pay with minimum and maximum values associated with your grades.

**Budgets**

Headcount budgets are usually allocated at the level of the organization, or to the combination of organization and job.

You can calculate your salary budgets from the definition of organization and job headcount budgets, combined with valid grades and grade rate information.

Actual salary costs in an HR environment can be calculated from the actual salaries of assigned employees.

Actual salary costs in an environment including Oracle Payroll can be calculated directly from payroll results.

*See Oracle Human Resources North American User’s Guide, (Salary Administration and Budgeting)*

**Vacancies and Recruitment**

Vacancies are not created by default whenever an employee leaves. Managers often have the freedom to decide if they want to replace an employee, or to recruit to a different role.

The recruitment process is often informal and allows for recruitment by resume, or cv. Individual managers are usually responsible for interviewing and selecting candidates. This may be on a one-to-one basis.

**Career Planning and Development**

The need for individual career planning and development is matched by the need to identify skilled employees for specific projects.

Using *Special Information Types* you can easily define experience, education, qualifications or skills requirements for different jobs. Using these same information types you can enter information under these headings for individual employees. Oracle HRMS includes a skills matching report.
Rule Based Enterprises

The rule–based enterprise is typically a highly structured environment in which all aspects of work and remuneration are well organized and regulated. Common examples of this type of enterprise are found in government, education, health and other public sector industries. A key feature of this type of enterprise is the concern with managing positions, or posts. Positions exist, and are managed independently of people in post.

You can picture the role type organization as a ‘Greek temple’, which rests its strength in its pillars. These pillars are the specialist functions or departments that exist within the enterprise. They are strong and almost independent organizations. For example, the Finance department would have very little involvement in the working of the HR department.

Coordination between the groups takes place at the top of the structure by a narrow band of senior management – the pediment. In this environment it is assumed that this should be the only personal coordination needed. “If the separate pillars do their job, as laid down by the rules and procedures, the ultimate result will be predictable.”

Roles are usually more important than individuals. People are selected for satisfactory performance of a role, which is described so that a range of individuals could fill it. Reward systems are likely to be role or rule–based.

Often, clearly defined procedures exist for every task and process within the enterprise. For example, job descriptions and job evaluation procedures define individual roles and positions of authority. Also, it is common to find that procedures exist to govern communications, such as colored and numbered forms, committee reports, and so forth.

Representing Positions

‘Positions’ are most appropriate for this type of enterprise and provide the finer detail on work structure and line management that is needed in a fixed establishment. Employees are assigned to a position, and by definition to the organization and job for that position.
Because you are focussing on the use of positions and position hierarchies you define organizations to show only the major divisions in your enterprise. You can model the details of these departments and sections using your position hierarchies. (If you also define detailed organizations and hierarchies, you are defining the same structural information twice.)

In this situation, jobs provide an additional level of information for positions, which is independent of any specific organization. For example, you might want to define job types of 'Managerial', 'Executive' or 'Clerical' so that you can identify skill requirements and levels of benefits for each job.

**Position Name**

In this environment you should consider using the segments of the position name to hold other key information about the position. For example you might want to consider using the following as segment values:

- **Cost Code**
  You might want to show the cost center, or a cost code for each position in your establishment. Using the segment of the key flexfield you could use the same list of cost codes as your general ledger.

- **Funding Organization.**
  You might have funding for a position from an external source. For example, government funding.

- **Multiple assignments allowed – Y/N?**
  In Oracle HRMS a position can have any number of holders. You can set headcount budget values to track any variance on budget, or you could use this type of segment to prompt users.
• Current status.

As part of your position control procedures you may need to mark the status of a position for reporting or management purposes. For example, you can label a position as ‘Frozen’, ‘Vacant’ or ‘Active’.

Note: You can use the Additional Position Details descriptive flexfield to hold this type of information about positions if you do not want the information to be visible to all users.

Management Reporting Lines

You can define a primary position hierarchy to show the management reporting lines for all of your positions. You should find that most of your security and reporting needs are based on this primary hierarchy. Groups are identified by selecting a manager and all the positions that report to it in this hierarchy.

Other Management Issues

When you consider this environment there are other areas your decisions may affect:

| Remuneration Policies | Individual compensation and benefits are often regulated, or based on union negotiated agreements. 
| Reward systems are usually based on the role performed rather than on personal or performance assessment. This may mean that you have to define detailed eligibility rules for compensation and benefits. |
| Comparative Grades and Positions | Valid grades are defined for positions and it is common to use grade steps and progression points. 
| National or union pay scales establish actual rates of pay for a grade and this is independent of performance. An employee is paid the rate for his or her grade and step. Incrementing rules, which determine progression to the next step, are usually part of the plan and are often time-based. 
| Job evaluation methods exist to compare roles across the industry with agreed grading structures and rates of pay. |
| Budgeting | Headcount or full-time equivalent budgets are usually set for each position. |
You can calculate your Salary budgets from the position budgets, combined with valid grades and progression point information.

In an HR environment you would calculate actual salary costs, at any time, from the current salaries of assigned employees.

In an environment including Oracle Payroll, you would calculate actual salary costs directly from payroll run results.

See *Oracle Human Resources North American User’s Guide, (Salary Administration and Budgeting)*

**Vacancies and Recruitment**

There is an automatic vacancy when an employee terminates employment. The position exists even when there are no holders.

The stages of the recruitment process and the procedures surrounding these are probably well defined and regulated.

Standard letters for each stage of the process are also likely to be well established.

In this environment people are recruited for their ability to perform a role. You would hold job descriptions and skill requirements for each position using attachments for text and the Special Information Type for structured data.

**Standard Reports**

Typically there is a well defined set of standard reports needed in this environment. Often these are required by government.
Hybrid Enterprise Structures

Many enterprises combine different types of structure for different groups of employees. Typical of these hybrid types are large manufacturing or corporate enterprises where management and administrative roles are fixed into specific organizations, but other roles are managed in a more flexible manner.

In Oracle HRMS you would set up this type of hybrid enterprise using positions for some groups of employees, and organization and jobs for others. For example, in one factory organization you might define a position for the Production Manager, and one job for all production line workers.

Employee Assignments

In this type of enterprise most of your workers would be assigned to an organization and a job. However you would define management positions because they have the characteristics of fixed roles within specific organizations, including the idea of automatic vacancy on termination of the assignment. In each organization you would have only one position. This would be the manager, and by default, any other employee who works in the organization would report to the manager.

Other Management Issues

Other issues for managing groups of employees by position, or by organization and job are the same as for the previous examples.
Remuneration Policy

Employees working in unionized jobs participate in negotiated rates of pay and conditions. You would define grade rates or progression points to deal with negotiated pay rates for workers in jobs.

Salary Administration

Employees in management positions are more likely to have their salary administered personally and be reviewed on their performance. You define grade rates and salary bases to deal with salary administration for employees in positions.
Contract Staff and Other Non–standard Assignments

It is common to find individuals working within an enterprise who do not fit into the general definition of work structures. For example, you may have agency or contract staff working temporarily to cover a vacancy, or you may have external contract staff working as part of a project team.

The way in which you record information for these individuals depends on how you manage them:

- You can treat the assignment for this type of employee in exactly the same way as any regular employee.
- Alternatively, you could set up a different person type to distinguish this type of employee.
- You could define your own types of employment category to distinguish different ways of working at the assignment level.
- You could define and use your own assignment statuses to identify different ways of working in a particular job or position.

However, you might decide that the person does not work in a predefined role, but is simply working in a particular organization for a set period of time. To do this you would assign the employee to an organization only, and focus on the other assignment information for further information.

**Attention:** A basic rule in Oracle HRMS is that an employee must have an assignment. The minimum work structure required for an assignment is the Business Group.
Entering and Hiring People

This chapter focuses on how to enter people and personal information on the system. You can choose to hold a wide range of personal information, such as medical details, work schedule, and preferred language for correspondence, as well as the basics such as date of birth, employee number, and addresses.

It also explains how to hire people, how to enter personal contacts, including dependents and beneficiaries, and how to inquire and report on the people held in the system.

For people who are your employees, there is assignment information and other information to hold. Chapter 9 Employment Information looks at information to record specifically for employees.
Displaying Personal Information

There are lots of ways to view information about people held in Oracle HRMS. For example, you can:

- use Employee Direct Access to view and update your own personal details using a web browser
- use Line Manager Direct Access to view information about people in your organization
- use the Find Person window or a People folder to display the people who interest you, then ‘drill down’. by clicking on buttons, to the information you need
- use an inquiry window to view specific information about a person, such as employment or absence history
- use QuickPaint to design a report incorporating personal, assignment, application, or compensation information

See Also

Inquiry Windows and Folders: page 23 – 3
QuickPaint: page 23 – 8

Using the Find Person Window

When you navigate to the People window, the Find Person window automatically displays in front of it.

To query a person using the Find Person window:

1. Do one or both of the following:
   - Enter a full or partial query on the person’s name. Where a prefix has been defined for the person, a full name query should be in the format ‘Maddox, Miss Julie’.
   - If relevant, enter a query on employee number, applicant number or social security number.
2. Choose the Find button.

The person or people found by the query are displayed in the People window. If the query found more than one person, you can
People Folders

Using the People Folder window, you can enter inquiries about the people held on Oracle HRMS. You select the fields of personal information you want to see, and position them in the order you prefer. For example, you can produce an alphabetical listing of all applicants and their gender, nationality, and disability registration.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.

**Note:** The system administrator can create customized versions of the People Folder window so that you use each version for one person type only.

![](image.png)
Entering Personal Information

Every enterprise must be able to record personal information for its employees, applicants, and contacts. Some of this information is standard, including basic information such as name, address, birth date, hire date, and nationality.

Oracle HRMS enables you to enter and update this information for all person types on one form – the People window. You can also use this window to update people’s statuses, for example, from applicant to employee.

Note: The system administrator can create customized versions of the People window so that you use each version for certain person types only or for certain functions only (entering employees, entering applicants, or hiring applicants).
Entering New People

Use the People window to enter and maintain basic personal information for all person types, including employees.

The minimum information to enter for all categories of people is name and type. In addition, for employees you must enter gender, employee number and date of birth (for assignment to a payroll). All other personal information is optional.

To enter a new person:

1. If the Find Person window opens, choose New.
2. Set your effective date to the appropriate date for adding the person to the system. If you are entering an employee, this should be his or her hire date.

   **Note:** Before making a change to a hire date already entered for an employee, ensure that the start date of the employee’s primary address is the same as or earlier than the new hire date. This preserves the integrity of the employee’s tax records.

3. Enter the person’s name and other details in the Name region.

   • You can use the Title field to enter a title such as Mrs. or Doctor for the person.

   • You can use the Prefix field to enter the first part of the person’s name, such as Van or De. This field allows you to sort by the main part of the last name, Zee instead of van der Zee, if you choose to do so.

   • You can use the Suffix field to hold part of the last name, such as Junior or II. This enables the suffix to be reported on separately, as required in some government-mandated reports.

4. For an employee, you must select the gender, Male, Female or Unknown Gender, from the list.
5. Select a type. If you select Employee, the Hire Date field displays your effective date. You can change the hire date, and this changes the employee’s effective start date.
6. Enter the person’s identification information in the Identification region.

   If your enterprise uses manual number entry, use the Employee or Applicant fields to enter an employee or applicant number as appropriate. If your enterprise uses automatic number generation,
the employee or applicant number automatically displays when you save your entries in this window.

7. Enter details for the person as required in the Personal Information region:
   • To assign an employee to a payroll, you must enter his or her date of birth.
   • In the Mail To field, select Home or Office to indicate the person’s preferred mail destination.
   • In the Date Last Verified field, you can enter the date the person last checked this personal information for accuracy.
   • In the Status field, select the person’s marital status.
   • In the Email field, enter the person’s email ID.

8. At the request of an applicant or employee, you can register him or her as disabled by checking the Has Disability box. The Americans with Disabilities Act (ADA) Report includes employees registered as disabled in its listing of disabled employees.
   

Optionally, you can enter additional information for people in the alternative regions described in the following steps.

▶ To enter employment information for an employee:

**Prerequisite**

- The system comes with these reasons for excluding a newly hired employee from the New Hire report:
  • Age less than state minimum
  • Wages less than state minimum
  • Hours worked less than state minimum

If you require other reasons, enter them for the QuickCode type US_NEW_HIRE_EXCEPTIONS.

See: Adding QuickCode Values: page 29 – 3

1. Choose the Employment Information alternative region.

2. Select an ethnic origin. For accurate EEO–1 and AAP reporting, it is essential to select an ethnic origin for employees.

See: Data for EEO–1 Reporting (Oracle Human Resources North American User’s Guide)
3. Check the I-9 box when the Employment Eligibility Form I-9 for the employee is completed. Under the US Immigration and Control Act of 1986, this must occur within three days of hire, or within 90 days for employees who have applied for the necessary documentation and are awaiting its receipt.

**Note:** By signing Form I-9, employees attest they are eligible for employment in the US. The employer also must sign the form, listing documents presented to verify the employee’s eligibility as a US citizen, a lawful permanent resident alien, or an alien otherwise authorized to work in the US.

4. Enter an I-9 Expiration Date if the employee’s eligibility to work in the US ends at a certain date, given in his or her documents.

5. For someone not a US citizen, select a visa type.

6. Select the person’s veteran status in the Veteran Status field. To identify employees for inclusion in VETS–100 reporting, it is essential to select Disabled Veteran, Vietnam Veteran or Disabled Vietnam Veteran for each employee qualifying for one of these statuses.


7. To identify an employee as a student, check the Student box.

8. To enter data for the New Hire report:
   - The New Hire Status field defaults to Include in New Hire Report, so that the next run of the New Hire report for the employee’s GRE will include this employee.
   - If the New Hire report should not cover this employee, select Exclude from New Hire Reporting. Optionally, select a reason for this exclusion in the Exception Reason field.
   - If this employee is currently obliged to pay child support, check the Child Support Obligation box.

   **Note:** After a run of the New Hire report that includes the employee, the entry in the New Hire Status field automatically changes to Already Reported.

   See: New Hire Reporting: page 8 – 32

9. After saving your entries in the Employment Information alternative region, enter a primary address for the employee. The window available for entering this address depends on whether or not your installation includes Oracle Payroll.

   **Note:** In Oracle HRMS, every employee must have a primary address on record at all times. At sites using Oracle Payroll, the
The start date of this address cannot be later than the hire date of the employee.

**See Also**

- Entering People’s Addresses at Sites without Oracle Payroll: page 8 – 11
- Entering People’s Addresses at Sites with Oracle Payroll: page 8 – 12

**To enter office location information for a new hire or an existing employee:**

1. Choose the Office Location Information alternative region.
2. Enter the office number for this office.
3. Enter the internal location of this office.
4. Enter the office identifier for internal mail.

**To enter information for an applicant:**

1. Choose the Applicant Information alternative region.
2. If the applicant’s resume is on file, check the Exists check box.
3. If the applicant’s resume is on file, select the date indicating when the resume was last updated.
4. Select the date up to which a file is to be maintained for this applicant.

**To enter information concerning the background check for an employee:**

1. Choose the Background Information alternative region.
2. Check whether the employee’s background check has been performed.
3. Select the date on which the background check was performed.

**To enter rehire recommendation information for an applicant who was a former employee:**

1. Choose the Rehire Information alternative region.
2. Check whether the former manager has recommended the applicant for rehire.
3. Select the reason for this recommendation.

**To enter further name information:**
1. Choose the Further Name Information alternative region.
2. Enter one or more honors/degrees (BA, MBA, or JD, for example) which the employee has earned.
3. Enter the name (perhaps a nickname) by which the employee prefers to be known.
4. If the employee previously was known by a different last name, enter the previous last name.

**To enter medical information for an employee:**
1. Choose the Medical Information alternative region.
2. Select the employee’s blood type.
   You cannot change this value once you enter it.
3. Select the date of this employee’s last medical test.
4. Enter the name of the physician who performed this test.

**To enter other information for a person:**
1. Choose the Other Information alternative region.
2. Select the type of schedule the employee will work.
3. Select the current status of the student.
4. Enter the person’s current full time/part time availability to work with your company.
5. Select the language the person prefers for correspondence.
   This language can differ from the person’s native language, depending on the nature of the correspondence.
6. Check the Military Service check box if the person is employed in a military service in some capacity.
   The value of this field can impact benefits calculations.
7. Check the Second Passport Exists check box if the person possesses multiple passports.

**Note:** The Background Information, Medical Information and Rehire Information alternative regions appear only if your system administrator has enabled them for you.
Hiring

- **To hire an employee:**
  - When you enter a new person as an employee, he or she is automatically hired as of your effective date.

- **To hire an applicant:**
  1. Update the applicant assignment status to Accepted in the Application window.
  2. Set your effective date to the applicant’s hire date and query the applicant in the People window.
  3. In the Type field, select Employee. The Hire Date field displays your effective date.
  4. Save your work.

  **Note:** You cannot update the applicant assignment status to Accepted and change the Person Type to Employee on the same date, since these are both datetracked changes.

- **To rehire an ex–employee:**
  1. Set your effective date to the new hire date and query the ex–employee in the People window.
  2. In the Type field, select Employee. The Hire Date field displays your effective date.
  3. Save your work.

- **To cancel a hire:**
  - Query the employee in the People window and clear the Hire Date field. Then save.

  The system warns you that any changes made to the person’s records after their hire date will be lost. You can choose whether to continue or cancel.

  You cannot cancel a hire if:
  - Oracle Payroll has processed the employee in a payroll run.
  - The person’s type has changed since the hire date.
  - New assignments have been created for the person after the hire date.
• The person was initially entered on the system as an employee and therefore has no previous history as an applicant or contact. In this case you must delete the person’s records from the system using the Delete Person window.

See: Deleting a Person from the System: page 8 – 37

See Also

New Hire Reporting: page 8 – 32

Note: Telephone numbers you enter here are held separately from the numbers you enter in the Phone Numbers window. You have to enter and maintain them separately.

4. Save your work.

Entering People’s Addresses at Sites without Oracle Payroll

All employees must have one (and only one) primary address on record at any point in time, but can have an unlimited number of secondary addresses (such as Summer or Weekend).

To enter all primary and secondary addresses for employees and their contacts at Oracle HR sites that do not include Oracle Payroll, you use the generic Address window. This window permits you to select address styles appropriate both for the US and Canada, and other foreign countries as well.

It does standard validation of field entries (for example, for zip code length), but at sites without Oracle Payroll, no special validation of city or county names, zip codes, or other address elements.

Prerequisite

- Set up the address types you require, such as Summer or Weekend, as QuickCodes for the QuickCode Type ADDRESS_TYPE.

See: Adding QuickCode Values: page 29 – 3

To enter a generic address:

1. Select a national address style.

   A window opens with the address format for the country you select.

   Note: Default address styles are predefined for many countries. You can change these defaults and can create address styles for other countries.
Enter address information in this window and choose the OK button to return to the Assignment window.

The first address entered for someone is by default, the primary address. Employees must have one (and only one) primary address at all times, but can have any number of secondary addresses. However, they cannot have two secondary addresses with the same name at the same time.

3. Select an address type, such as Summer or Weekend.

4. To identify the person’s main address, check Primary. By default, the first address you enter is the Primary address.

At any time, only one address can be a primary address.

Entering People’s Addresses at Sites with Oracle Payroll

Oracle Payroll uses employees’ primary addresses to maintain federal, state and local tax rules for employees subject to US taxes. Therefore, these employees must have on record at all times, one and only one correct, primary US address with an open end date, that includes a valid city, state, zip code and county. This means that sites including Oracle Payroll must enter a new employee’s primary address using a date no later than the employee’s hire date.

The US–specific address window appearing on the menu at sites including Oracle Payroll accepts and fully validates entries of city, state, zip code and county for US addresses, and entries of city, province and post code for Canadian addresses. It is very convenient to use, because entry of only a zip or post code automatically brings up the city, county and state, or city and province, to which the zip or post code applies.

By default, the first address you enter for someone becomes the primary address. Employees must have one (and only one) primary address in effect at all times. There is no limit on the number of secondary addresses, such as weekend or summer addresses, you can enter for a person. However, a person cannot have two secondary addresses with the same name at the same time.

Foreign Secondary Address Entry

If you often enter foreign secondary addresses, ask your system administrator to add the generic address window to your menus. This
window permits you to select the correct address style for any country when making entries.

See: Entering People’s Addresses at Sites without Oracle Payroll: page 8 – 11

**Note:** At sites with Oracle Payroll, the generic address window does only standard validation for all but one national address style. For the US address style, it does the same full validation as entries made in the US-specific address window. However, it is more efficient for users at sites with Oracle Payroll to use the US-specific Address window to enter US and Canadian addresses.

### US and Canadian Address Entry

When entering US or Canadian addresses for employees and their contacts, use the US-specific Address window.

#### Prerequisites

- Set up the secondary address types you require, such as Summer or Weekend, as QuickCodes for the QuickCode Type ADDRESS_TYPE.
  
  See: Adding QuickCode Values: page 29 – 3

- Cities or towns with populations of 200 or less may not be included on the lists for US and Canadian address validation; if not, you must enter them in the database. To check whether a city or town name is in the database, query it in the Cities window.
  
  See: Adding a City for Addresses: page 8 – 14

**To enter a US or Canadian address with full validation:**

1. Set the effective date to the date the address takes effect.

2. In the Address lines, enter the street name and number, and any related information such as building name or apartment number.

3. If you know the US zip code or Canadian post code, enter it in the Zip Code field. For US addresses, this restricts the listing of cities, states, and counties to those valid for the zip code. For Canadian addresses, this restricts the listing of cities and provinces to those valid for the post code. You can then select this additional address information from short lists.

**Note:** For Canadian addresses, CN (for Canada) always appears in the State field, the province name appears in the County field, and the post code appears in the Zip Code field.
4. If you are unsure of the zip or post code, enter the city name. For US addresses, this restricts the lists of states, counties and zip codes to those valid for the city. For Canadian addresses, this restricts the lists of provinces and post codes to those valid for the city. You can then select this additional address information from short lists.

5. If you are unsure of both a zip or post code and the city name, for a US address enter the two-letter state abbreviation. This restricts the city, zip code and county lists to those valid for the state. For a Canadian address, enter CN in the State field. This restricts the city, post code and province lists to Canadian entries. Then select the additional address information.

6. Optionally, enter telephone numbers and select the address type. Check or uncheck the Primary box as required. Notice that a person must have a primary address on record before you can enter any secondary addresses for him or her.

7. If you know the last date this address will be effective for the person, enter it in the Date To field.

8. Save your work.

Adding a City for Addresses

A US or Canadian city or town with a population of less than 250 may not be entered in the HRMS database. Before entering the address of someone living in a city or town not in the database, you must add the city or town to the database using the Cities window.

1. In the State Name field, select the name of the state or territory in which the city is located. For Canadian cities, select Canada in this field.

2. In the County name field, select the county in which the city is located. For Canadian cities, select in this field the province in which the city is located.

3. Enter the city name in the City Name field.

4. If there is a single zip or post code for the city, enter it in the Zip Start field and leave the Zip End field blank.

5. If a range of zip or post codes applies to the city, enter the first code of the range in the Zip Start field, and the last code of the range in the Zip End field.

6. Save your work.
Adding Telephone Information

You can enter multiple telephone numbers for people in the HRMS database. To enter telephone information for a person, use the Phone Numbers window.

To enter a telephone number:
1. In the Type field, select the type of the telephone device.
2. In the Phone Number field, enter the telephone number. Any format is allowed.
3. In the From field, select the start date for the telephone number.
4. In the To field, optionally select the date when the telephone number is no longer valid.
5. In the last field, optionally add the extension number.
6. Save your work.

Note: If you want to maintain a history of telephone numbers for this person, be sure to add a new entry for the new telephone number and enter an end date for the existing existing telephone number. If you do not want to maintain such a history, simply update the record for the existing telephone number.
Entering Pictures

You can store a picture associated with each person on your system, perhaps holding a photograph or digitized image of the person’s signature. These may be useful for approval or identification purposes. You must digitize the image and save it in one of the following file formats:

- BMP
- JFIF
- JPEG
- PCX
- PICT
- TIFF

You enter pictures in Oracle HRMS in the Picture window.

To enter a person’s picture in Oracle HRMS:
1. In the Picture window, choose the Load Picture button.
2. Enter the file path to locate the directory in which you saved the graphic file.
3. Highlight the filename and choose the OK button. The graphic is loaded in the format indicated by the filename. For example, a file called image.bmp would be loaded as a BMP file.

Entering Dependents, Beneficiaries and Other Contacts

Use the Contact window to hold information about an employee’s contacts, for example:

- people to contact in an emergency
- dependents
- beneficiaries of benefits such as insurance policies or stock purchase plans
- individuals receiving payment of a wage attachment deducted from the employee’s salary

A person entered as a contact can be one, some, or all of the above.

Prerequisite

- Set up any relationship types (such as spouse, child, or friend) you want to use as values for the QuickCode Type CONTACT.
To enter a contact:

1. Do one of the following:
   - Enter the name of a new person.
   - Select from a list of people already entered on the system.

2. If this contact is a dependent of the employee, a named beneficiary of the employee, or a recipient of the payment of a wage attachment from the employee, ensure that his or her social security number, gender, and birth date are all on record.

3. Optionally, select a relationship type for the contact.

4. If this contact is receiving a payment from the employee such as a court–ordered wage attachment, check the Payments Recipient box.
   This allows you to select this person on the Personal Payment Method window when entering a third party payment method for the employee.

   See: Making Payments for Wage Attachments: page 17–10

5. If this contact is a dependent of the employee, check the Dependent box. You can then establish dependent coverage for this person under one or more of the employee’s benefits that provide dependent coverage.

6. If this contact is named as a beneficiary for one or more of the employee’s benefits, check the Beneficiary box. You can then record this person as a beneficiary for these benefits.

   See: Recording Beneficiaries for Benefit (*Oracle Human Resources North American User’s Guide*)

7. Save your work.

8. To enter addresses for the contact, choose the Address button.

   Entering People’s Addresses at Sites with Oracle HR Only: page 8 – 11

   Entering People’s Addresses at Sites with Oracle Payroll: page 8 – 12
As you recruit new people and develop existing employees, you need to track their competencies and work preferences. This enables you to match them to projects and vacancies, develop succession plans, and organize further training and certification. In Oracle HRMS, you can record the following information:

- A competence profile – this is a list of the competencies held by a person and their level of proficiency in each competence.
- Qualifications, including details of individual subjects, grades, licenses, status of ongoing training and tuition fees.
- Attendances at educational establishments, such as schools and colleges.
- Work choices, including willingness to travel and relocate; preferred working hours, work schedule, and duration within post and preferred countries for international relocation.

You can enter this information when an employee first joins the enterprise, taking the details from their resume or from tests or interviews. You might update it after the employee successfully completes a training course, and after periodic assessments or appraisals.

You can either enter this information using standard Oracle HRMS windows or using the web–based Line Manager Direct Access.

Copying Core or Primary Assignment Competencies

Some competencies are important for all employees throughout your enterprise; others are required for particular jobs, positions, or organizations. If competencies have been entered as core competencies for your enterprise or as requirements against a person’s job, position, or organization, you can copy them to the person’s competence profile. Copying competencies not only saves you time from having to enter the details yourself, but it also ensures that you do not miss entering relevant competencies.

To assist you in entering applicants and evaluating employees against vacancies, you can also copy competencies from a vacancy. The system checks all the competence requirements of the organization, job and/or position for which the vacancy is defined. It enters these against the person so that you can record the person’s proficiency in each competence and then compare applicants against the vacancy’s requirements.
Managing Competencies Over Time

You can make changes to the competencies and proficiency levels your employees possess over time, enabling you to see both the latest and historical information. When you view a competence profile, you can choose whether to see just the current profile or all historical information, if you want to see changes in proficiency levels over time.

Use Oracle Alert’s automatic mail notification to keep you informed when an employee’s competencies need certification and renewal. This frees your time for more essential tasks. For example, use the competence Renewal Period to drive Oracle Alert—it compares the renewal period date with the date on the person’s Competence Profile, or the last training class delivering the skill.


Creating a Competence Profile

Use the Competence Profile window to create and update a personal competence profile.

When you open this window, you will see all competencies, past and present, held by the person. If you want to see only current competencies and proficiency levels, check the Current Competencies box.

To create a competence profile:

1. Select the first competence this person possesses.
   You can also automatically enter all competencies required for the person’s primary assignment or a vacancy, or the enterprise’s core competencies. See: To copy competencies from requirements: page 8 – 21.

2. Select the proficiency level at which the person performs the competence.

3. Enter the date from which the person possesses the competence at this level. For example, if the person gained the competence through a qualification, enter the date the qualification was gained. You can enter a date when the competence expires, if required.

4. In the Source of Proficiency Rating field, you can select the method by which the person gained the competence, such as training course or previous experience.

5. Select the method of certifying that the person attained the competence at the recorded level, such as by examination.
6. Enter the date when the person’s proficiency in this competence should be reviewed.

7. Continue to enter the competencies the person possesses, then save your changes.

**To copy competencies from requirements:**

1. Choose the Copy Competencies button. A Copy Competencies window appears.

2. Do one of the following:
   - Check the Core Competencies box to copy all the competencies required throughout your enterprise.
   - Check the Primary Assignment Competencies box to copy all the competencies required in the organization, job and position to which the person is assigned.
   - Select a vacancy to copy all the competencies required in the organization, job and position for which the vacancy is defined.

3. Enter the dates between which the competencies are valid (you must have a From date, but you can leave the To date blank).

4. Choose the Copy button.
   You can now enter proficiency levels, certification methods, and so on for each of these competencies held by the person.

**To update a competence profile:**

1. Check the current check box if you want to see only the current competencies the person possesses, otherwise leave this box blank.

2. Enter new competencies for this person, or update proficiency levels and other details for existing competencies.

   **Note:** If you update a proficiency level, enter the date when the new level was attained. Then, when you save your changes, you will see that the system keeps a record of the old proficiency level, ending the day before the start date of the new level.

3. Save your changes.

---

**Entering Work Choices**

You can a person’s work choices, such as their willingness to travel or relocate, their preferred working hours and work schedule, and the
length of time they would like to stay in their next post. You can then compare these choices with the work requirements of jobs or positions when you are planning redeployment.

You enter personal deployment choices in the Work Choices window, accessed from the People window.

► **To enter work choices for a person:**

1. Check the relevant work capabilities boxes if the person is:
   - willing to work in all locations
   - willing to relocate
   - willing to travel
   - prepared to work in their current location only
   - willing to visit internationally

2. Select the length of time the person wants to stay in a role, for example, indefinite or two years.

3. Select the person’s preferred working hours (for example, 9.00 to 5.30), work schedule (the working days in the week or pattern of shifts), the proportion of full time hours available and any relocation preferences (for example, with family).

4. Check the relevant international deployment boxes if the person is willing to:
   - work in all countries
   - relocate

5. Select the countries in which the person prefers to work, and any countries in which they are not prepared to work.

6. Save your work.
Entering Qualifications

You can enter an employee’s qualifications when they first join the enterprise, and then update them after periodic assessments or appraisals or after completion of a training course.

Use the Qualifications window, accessed from the People window, to enter and update qualifications.

To enter qualifications:

1. Select the type of qualification this person possesses and the title of the qualification.
2. Select the status of the qualification, for example, whether training is ongoing or completed.
3. Enter the grade at which the person holds the qualification, if appropriate.
4. Select the establishment at which the person gained the qualification.
5. Enter the awarding body which bestowed the qualification, if you want.
6. Enter the dates between which the qualification is gained You must enter a Start date but you can leave the End date blank (if the qualification is still incomplete).
7. Enter the date the qualification was awarded, if you want.
8. Enter the projected completion date the qualification is awarded, if relevant.
9. Enter the ranked position within the class, if relevant.
10. Enter any comments, for example, what percentage of the award was course work or examination, if you want.
11. Save your work.

To enter tuition fees for reimbursement:

1. In the Tuition Details alternative region, enter the amount and select the currency to reimburse the person
2. Select the method of tuition, for example, day release.
3. Enter the method of reimbursement, for example, bank transfer to be paid when qualification is awarded.
4. Save your changes.
To enter training details:
1. Choose the Training Details alternative region.
2. Enter the amount of training completed. For example, enter 30 days completed of a training program that lasts 60 days.
3. Enter the total amount of training required to deliver the qualification.
4. Enter the units in which the training is measured, for example, days.

To enter license details:
1. Choose the License Details alternative region.
2. Enter the licence number, for example, a driving licence number.
3. Enter any restrictions, for example, licence not valid in certain states.
4. Enter the licence expiry date.

To enter subjects:
1. Enter the first subject the qualification comprises.
2. Select the status at which the subject is awarded, for example, whether training in the subject is ongoing.
3. Enter the dates between which the subject is studied. You must enter a Start date but you can leave the End date blank (if the subject is still incomplete).
4. If the subject forms a major part of the qualification, check the Major box.
5. Enter the grade at which the subject is studied, if you want.
6. Continue to enter further subjects until you have entered them all for the qualification, then save your changes.

See Also

Entering Schools and Colleges Attended
You can enter the school or college at which the person gained a qualification.
Use the School and College Attendances window, accessed from the People window, to enter attendance at an establishment.

To enter schools and colleges attended:

1. Select the name of the school or college that the person attended.
2. Enter the dates of the attendance. You must enter a Start date but you can leave the End date blank (if the attendance is ongoing).
3. If attendance is full time at the school or college, check the Full Time box.
4. Continue to enter schools or colleges, if required, then save your changes.

See Also
Entering Special Information

Basic personnel information is handled in a fairly standard way from enterprise to enterprise. However, other types of information are recorded and used in quite different ways. Examples include training records, disciplinary records, competence, and medical records. Oracle HRMS does not restrict you to any predefined format for holding this information. You can set up your own user-defined fields for recording, analyzing, and reporting on whatever special information you require.

You set up each area of information that you want to handle separately as a Special Information Type. For example, you might define special information types for medical details and disciplinary records. You can enter a person’s information under these sorts of headings in the Special Information window.

For entry of information needed for ADA and OSHA reporting, Oracle HRMS comes with the following three special information types already set up:

- ADA Disabilities
- ADA Disability Accommodations
- OSHA–Reportable Incident.

See:

ADA (Americans with Disabilities Act) Reporting (Oracle Human Resources North American User’s Guide)

OSHA (Occupational Safety and Health Act) Reporting (Oracle Human Resources North American User’s Guide)

Note: Your system administrator can create customized versions of the Special Information window, for entry of information for only one or a selected set of information types.
To enter special information for a person:

1. In the Name field, select the type of information you want to enter for the person.
2. In the Details block, click in the Detail field to open a window for entering information of this type.
3. Choose the OK button when you have completed your entries, then save your work.

See Also

Listing People by Special Information

To view a list of people who match a particular profile for one Special Information Type, use the List People By Special Information window.

**Note:** The system administrator can create customized versions of the List People By Special Information window so that you use each version for one information type only. For example, one version could be called List People By Technical Skills.

To list people by special information:

1. Select a Special Information Type.
2. Click in the Details field. A window opens prompting you for the details you have defined for this information type.
3. Enter values in the fields against which you want to match people, then choose OK. If you leave a field blank, it is not used in the matching process.
4. Choose the Find button.
Employees and applicants who match your selection criteria are listed in the folder in the lower part of the window. You can enter a query here to further restrict the list of people. If you have access to the Folder menu you can remove, rearrange, or resize the fields displayed.
Tracking People’s Roles and Activities

Table 8 – 1 lists the windows you can use to track the roles and activities of employees and applicants. These windows are described in context in other topics, as listed in the table.

You can also use the web–based Line Manager Direct Access to enter some information, such as assessments and appraisals, and to view a wide range of employee data, including employment history, roles (who they manage, supervise etc.) and absence history.


<table>
<thead>
<tr>
<th>Window</th>
<th>Used For</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
<td>describing the work role of an employee</td>
<td>The Employee Assignment: page 9 – 4</td>
</tr>
<tr>
<td>Application</td>
<td>describing the vacancy for which an applicant has applied</td>
<td></td>
</tr>
<tr>
<td>Absence Detail</td>
<td>recording an employee’s absence from work</td>
<td>Entering Absences (Oracle Human Resources North American User’s Guide)</td>
</tr>
<tr>
<td>Book Events</td>
<td>recording that an employee or applicant will attend an event. The event must be already defined in the Event Bookings window.</td>
<td>Managing Bookings and Attendance (Oracle Human Resources North American User’s Guide)</td>
</tr>
<tr>
<td>Employee Review</td>
<td>scheduling and recording details of an employee’s review or other interview type</td>
<td>Employee Reviews (Oracle Human Resources North American User’s Guide)</td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>scheduling and recording details of an applicant’s interviews</td>
<td>Interviewing Applicants (Oracle Human Resources North American User’s Guide)</td>
</tr>
</tbody>
</table>

Table 8 – 1 Other Windows for Personal Information

You can enter other work–related information for employees, such as salary and payment methods, after entering the employee’s assignment.

See Also

Managing Employment Information: page 9 – 2
Full Personal Details Report Set

To create printed reports of the personal information held for one person, you can run the Full Personal Details report set. It comprises four reports that meet employees’ rights to view their own personal details under data protection legislation:

- Full Person Details 1 reports on addresses and information entered in the People window, such as name, date of birth, nationality, and work telephone number.
- Full Person Details 2 reports on applications and applicant interviews.
- Full Person Details 3 reports on assignment information including periods of service, payment methods, and element entries.
- Full Person Details 4 reports on miscellaneous work information, including special information, absences, recruitment activities, and contacts.

If you do not need to see all this information for the employee, you can run individual reports rather than the report set. The Full Person Details report, Full Assignment Details report, and Full Work Details report are equivalent to reports 1, 3, and 4 in the report set, respectively. The Full Applicant Details report is equivalent to report 2 in the report set, but you can only run this as a separate report for an applicant, not an employee.

You run report sets from the Submit Request Set window.

To run the Full Personal Details report set:

1. In the Request Set field, select Full Personal Details.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the reports.
4. Enter the name of the person for whom you want to print the reports.
5. Choose the Submit Request button.

See Also

Employee Summary Report: page 9 – 33
New Hire Reporting

At present, many states require some or all employers to submit New Hire reports covering newly hired or rehired employees. Other states and Canadian provinces have already announced plans to implement new hire reporting programs, or are considering such plans.

A primary purpose of New Hire reports is to ensure that individuals legally responsible for making child support payments are in fact making these payments by means of pay garnishments. Some states also use new hire reporting to help in detecting abuse of assistance programs such as Workers Compensation and unemployment insurance.

Because garnishment administration is a responsibility of the payroll department, and because submission of copies of form W-4, Employee’s Withholding Allowance Certificate is often a part of new hire reporting, payroll departments usually are responsible for submitting the New Hire reports for the GREs in their enterprise. In most states, they must submit these reports within a certain number of days (ranging from 5 to 35) after a new employee’s start date. Employers failing to do so may be liable for penalties.

Report Coverage

States have different rules regarding the employees that new hire reporting must cover. Some states do not require coverage of employees who are below a minimum age, or whose pay or normal working hours in a specified time period fall below a stated minimum.

Data for New Hire Reports

In all states, these reports must display for each newly hired or rehired employee, the full name, social security number, and hire date. Some states require additional information, such as:

- employee addresses and dates of birth
- their jobs, salaries, hours normally worked per week, and full or part-time employment category
- the availability to the employees, and their dependents, of employer-provided health care insurance plans
- whether employees currently have child support obligations.

To identify each GRE submitting New Hire reports, states require (in addition to the GRE’s name and address) its federal identification number (issued by the IRS), or its SUI identification number, or both
numbers. Entry of one or both of these numbers often occurs when the
GRE is set up.

New Hire reports must also include the name, job and telephone
number of the employee serving as the GRE’s contact for new hire
reporting.

Setup Steps for New Hire Reporting

To set up for New Hire reporting:

1. Ensure that a federal identification number and a SUI identification
   number, if appropriate, is on record for each GRE that submits
   New Hire reports.
   See:
   GRES: Entering the IRS Identification Number: page 2 – 30
   Entering Federal, State, and Local Tax Rules for GRES: page 18 – 9

2. Enter the name of each GRE’s contact person for new hire
   reporting.
   See: Entering a New Hire Report Contact for a GRE: page 8 – 33

3. When hiring or rehiring employees, indicate whether they
   • are to be included in or excluded from new hire reporting
   • have a legal obligation to pay child support.
   See: Entering New Hire Report Information for Employees: page
   8 – 34

   See: Obtaining New Hire Reports: page 8 – 35

Entering a New Hire Report Contact for a GRE

For each GRE, you can maintain information about the contact person
for New Hire reporting. Start this information entry from the
Organization window.

Prerequisite

☐ Set up the GRE in your system.
To enter a GRE’s contact person for new hire reporting:

1. In the Organization window, query the GRE if it does not already appear there. With the cursor in Government Reporting Entity in the Organization Classifications region, choose the Others button and select New Hire Reporting.

2. Click in the field that appears in the Additional Organization Information window to open the New Hire Reporting window.

3. Select the name of the employee serving as the GRE’s contact for new hire reporting. The New Hire Report process finds this employee’s job title and work telephone number in the database and prints the contact name, title and phone number on the report.

Entering New Hire Report Data for Current Employees

Use the People window to start this information entry.

Prerequisite

- The system comes with these reasons for excluding a newly hired employee from the New Hire report:
  - Age less than state minimum
  - Wages less than state minimum
  - Hours worked less than state minimum

If you require other reasons, enter them for the QuickCode type US_NEW_HIRE_EXCEPTIONS.

See: Adding QuickCode Values: page 29 – 3

To enter New Hire reporting data for current employees:

1. Query the employee in the People window if he or she does not already appear there. Select the Employment Information alternative region.

2. The New Hire Status field defaults to null (no entry). If new hire reporting should cover the employee, select Include in New Hire Report, so that the next run of the New Hire report for the employee’s GRE will include this employee. If the report should not cover this employee, select Exclude from New Hire Reporting, and optionally select the reason for this exception.
After a run of the New Hire report includes the employee, the entry in the New Hire Status field automatically changes to Already Reported.

**Note:** When you implement Oracle HRMS and load your current employees into the database, the New Hire Status field defaults to null for them. The first run of the New Hire report for the state and GRE of current employees will include these employees unless you enter a value of Already Reported or Exclude from New Hire Reporting in the New Hire Status field for them.

These entries can be accomplished either manually or by means of a script your MIS staff or Oracle consultant can write in accordance with your specifications.

3. If this employee is currently obliged to pay child support, check the Child Support Obligation box.
4. Save your work.

---

### Obtaining New Hire Reports

For these reports, states have varying data requirements and formatting requirements. The New Hire reports in Oracle HRMS are set up to meet each state’s data and formatting specifications.

**Attention:** All states except Tennessee permit submission of these reports as computer printouts. For Tennessee, you must copy the report information onto the state’s Form DES 230.11C.

Run New Hire reports from the Submit Requests window.

**Prerequisite**

- Complete the setup steps for new hire reporting.
  
  See: Setup Steps for New Hire Reporting: page 8 – 33

**To run a New Hire report for a GRE and state:**

1. In the Name field of the Submit Requests window, select New Hire Report. If the Parameters window does not open automatically, click in the Parameters field.
2. The As Of date that appears on the report defaults to the effective date. Change this default if necessary.
3. Select the GRE and state for which to produce the report.
   
   If the state is Iowa or Texas, also make entries in the fields Dependent Health Insurance and Waiting Period (Days).
4. For Iowa and Texas, enter Yes in the Dependent Health Insurance field if the employer offers health care insurance coverage to employees’ dependents, or No if coverage is not available to dependents.

5. For Iowa and Texas, if health care insurance is available to dependents, enter in the Waiting Period field the number of days after the employee’s hire date that dependents must wait before obtaining coverage. This field defaults to zero.

6. Choose Submit.

See Also

New Hire Reporting: page 8 – 32
Deleting a Person from the System

If you mistakenly save information in the People window, you can remove the person by selecting Delete Record from the Edit menu. Notice that you are prevented from performing this action if you have entered information about that person in other windows.

If you want to remove all records of a person, use the Delete Person window. Notice, however, that you cannot use this window to remove the records of an employee or ex-employee whom Oracle Payroll processed in any payroll runs.

To delete all records of a person:

- Query the person in the Delete Person window and choose the Delete Person button.

  If there is a contact for the person you are deleting, there are two possibilities:

  - If the only information held about the contact is the basic person details entered in the Contacts window, then the record of the contact is deleted.
  - If there is other information held about the contact (for example, assignment or applicant information), the contact is not deleted. However, the record of their relationship to the person you are removing from the system is deleted.
The previous chapter focussed on the personal information you hold for all types of people. Employees require additional information on where they fit into your enterprise, and on their compensation and benefits.

This chapter describes the key types of employment information, how you hold them in Oracle HRMS, how you track changes in employment for employees, and how you can report and inquire about employment information.
Managing Employment Information

Table 9 – 1 below summarizes the information typically held for an employee, and how you can hold this information in Oracle HRMS.

<table>
<thead>
<tr>
<th>Information</th>
<th>How to set it up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Title or Position</td>
<td>Assign the employee to work structures in the Assignment window.</td>
</tr>
<tr>
<td>Department</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Grade</td>
<td></td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter in the Grade Step Placement window; enter any special ceiling in the Assignment window.</td>
</tr>
<tr>
<td>Name of manager or position to report to</td>
<td>Use a position hierarchy or enter supervisor name in the Assignment window.</td>
</tr>
<tr>
<td>Salary</td>
<td>Assign to a salary basis in the Assignment window; enter amount in the Salary Administration window.</td>
</tr>
<tr>
<td>Medical, Dental and Vision Benefit Plans (without Oracle Payroll)</td>
<td>Define elements or initiate; enter coverage levels plus default employer and employee contributions for each level into Benefits Table; link elements; enroll employees by selecting their coverage levels in the Element Entries window.</td>
</tr>
<tr>
<td>Medical, Dental and Vision Benefit Plans (with Oracle Payroll)</td>
<td>Initiate plan deductions using amount rule Benefits Table; enter coverage levels plus default employer and employee contributions for each level into Benefits Table; link elements; enroll employees as above.</td>
</tr>
<tr>
<td>Other Benefits (without Oracle Payroll)</td>
<td>Define and link elements; make input value entries using the Element Entries window or MIX batch entry.</td>
</tr>
<tr>
<td>Other Benefits (with Oracle Payroll)</td>
<td>Initiate deductions to pay for benefits; link elements; make input value entries using the Element Entries window or PayMIX batch entry.</td>
</tr>
<tr>
<td>Pay Frequency</td>
<td>Assign to a payroll in the Assignment window.</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Accept the default from the Payroll to which the employee is assigned or select a method in the Personal Payment Method window.</td>
</tr>
<tr>
<td>Full time/part time status</td>
<td>Assign to an employment category.</td>
</tr>
<tr>
<td>Standard Work Day</td>
<td>Enter in the Assignment window or accept the default from the organization or position to which the employee is assigned.</td>
</tr>
</tbody>
</table>

Table 9 – 1 Employment Information
Table 9 – 1 Employment Information

Every enterprise needs to track the changes in employment information for each employee over the lifetime of their employment:

- Where a change affects a group, the human resource system must be able to effect that change for every individual in the group according to a set of rules.
- Where a change affects only a few individuals, the system must allow entry of changes for those individuals.

In Oracle HRMS, you manage these changes through the employee assignment:

- The assignment connects employees to your enterprise’s work structures and policies, so that changes to the structures and policies are reflected in the employee’s records.
- You can query groups of employees with similar assignments (such as all assignments on grade C2) and make changes for each employee in these groups.
- The assignment is datetracked to maintain a work history as the employee moves through your enterprise.
The Employee Assignment

The assignment is the central concept that relates employees to the structures in which they work, and the compensation and benefits for which they are eligible.

In Oracle HRMS, many of the activities you undertake in human resource management, such as vacancy management and budget planning, are based around assignments and not people. In particular, you enter all earnings, deductions, and other pay–related elements for the employee assignment, rather than the employee. This makes it possible to give an employee two or more assignments when this is necessary.

Figure 9 – 1
Employee Assignment

An employee must have a current assignment at all times. You record relocations, promotions, transfers and so on as changes to the existing assignment. These changes are datetracked so that you can view the history of changes to an assignment, and can make future–dated changes in advance.
Components of the Assignment

You can use the assignment to define more precisely the place of the employee in the enterprise, including his or her job, position, organization, location, grade, and supervisor. You can also assign the employee to any of the employee groups you set up using the People Group key flexfield, such as pension groups or unions.

You can assign employees to an employment category, such as Part Time – Regular or Full Time – Temporary. Your startup data includes four categories, and you can add others for the QuickCode Type EMP_CAT.

You can assign employees to a salary basis and maintain their salaries or wages using the Salary Administration procedure.

Requirements for Payroll Processing

At installations using Oracle Payroll to pay employees, each employee’s assignment must include these components:

- a GRE
- an organization with a physical location that is entered in the HRMS database
  
  See: Setting Up Site Locations: page 2 – 2
- a payroll
- an employment category

Additionally, there must be on record for each assignment:

- W–4 and other tax information
- a salary basis and an approved salary entry

Notice that a prerequisite for the establishment of employee tax information is entry of a primary US or Canadian residence address for the employee, and assignment of the employee to an organization having a location with a complete address.

See:

Entering US and Canadian Addresses: page 8 – 13
Setting Up Site Locations: page 2 – 2

See Also

W–4 and Other Tax Data for Employees: page 18 – 2
Using Multiple Assignments

Relocations, transfers, promotions and so on go on record as datetracked changes to employees’ existing assignments; you do not enter new assignments for changes like these.

However, if your enterprise permits employees to work in two or more different capacities at once and thereby become eligible for different benefits, you can enter additional assignments for them.

For example, if a university professor of history also coaches the baseball team, receiving additional pay but retaining the same benefits, there is no reason to give him a second assignment. But if he becomes eligible for different benefits as a coach, it is best to give him a separate assignment for this work.

You can maintain multiple assignments for any employee. Oracle HRMS separately manages each assignment, together with its associated compensation and benefits. When an employee has more than one assignment, one must be designated as the primary assignment. By default, this is the first assignment the employee receives. You can change this default using the Miscellaneous alternative region of the Assignment window.

You can end all assignments except the primary assignment by entering a status change in the Assignment window. However, to end an employee’s primary assignment you must terminate the employee, using the Terminate window.

To show that an assignment is part time, you use the employment categories Part Time – Regular or Part Time – Temporary. You could also set up a Full Time Equivalent budget, and weight each assignment as a fraction of a full time equivalent for the calculation of actual values.

Notice that when employees split their time between two departments performing the same job, or fulfill two different roles in one organization, you do not need to define two separate assignments to maintain accurate costing records. You can set up cost allocation to distribute proportions of one assignment’s payroll costs to different cost centers.
Identifying Employees and Assignments

Oracle HRMS uses two unique identifiers for employees:

- Employee Number
- Employee Assignment Number

Employee Number

The Employee Number uniquely identifies every employee in your Business Group.

An employee can have only one Employee Number. You decide how this number is to be generated when you define your Business Group:

- Automatic
- Manual
- National Identifier (for example, the US Social Security Number or the UK National Insurance Number)

If you choose automatic or national identifier number generation, the employee number, by default, remains the same for an employee who has multiple periods of service. If you choose manual number entry, you can update the number at any time.

The employee name and number appear together in people information windows, such as the People window and View Absence History window. In these windows you can select an employee by name or by employee number.

Employee Assignment Number

The employee assignment number uniquely identifies every assignment that exists within your Business Group. An employee can have one or more than one assignment, and therefore more than one assignment number.

The system automatically generates the assignment number, which is the same as the employee number by default. You can manually override the default assignment numbers the system generates. For example, you might want to use this number to store a payroll code.
If an employee has a second current assignment, the system also generates the second Assignment Number by default from the Employee Number, as in the following example:

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Samantha Green</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Number</td>
<td>1012</td>
</tr>
<tr>
<td>1st Assignment Number</td>
<td>1012</td>
</tr>
<tr>
<td>2nd Assignment Number</td>
<td>1012–02</td>
</tr>
</tbody>
</table>
Entering a New Assignment

Enter new assignments in the Assignment window. You must hire applicants before you can create an employee assignment for them. The details of the employee assignment default from their accepted application.

To enter a new assignment:

1. Set your effective date to the start date of the new assignment.
2. Select the organization to which you want to assign the employee. By default, the employee has an assignment either to the Business Group organization, or to the organization to which he or she was an applicant. If a location is defined for the Business Group or other organization, it also appears as a default.

   Note: If you are using Oracle Payroll, the organizations to which employees have assignments must have on record, a location with a complete address including a city and state. The system uses this address to determine employees’ work locations for tax purposes.

   See: Setting Up Site Locations: page 2 – 2

   Attention: If you overwrite a new employee’s default assignment to an organization, a window appears asking if the change is an update or a correction. Select Correction. If you are using Oracle Payroll, it is especially important to select Correction, so that the work location for the employee’s tax records is correctly recorded.

3. Select a payroll if you are paying the employee using Oracle Payroll, or if you intend to record for the employee certain types of
compensation and benefits (represented on the system by nonrecurring elements).

**Note:** If Oracle Payroll is installed and you are an HR User, you cannot assign employees to payrolls. Ask your system administrator to change your HR:User Type profile option if you need to assign employees to payrolls.

4. Select a grade if you use grade rates or grade scales to determine the appropriate compensation levels for employees.

5. Select any other components included in this employee’s assignment (job, position, groups, employment category). If you are using Oracle Payroll to pay the employee, the assignment must include an employment category.

6. Select a Status for the assignment. By default a new assignment has the status Active Assignment (or an equivalent user status defined on your system).

   See: Assignment Statuses: page 24 – 5

7. Enter an Assignment Number to uniquely identify the assignment. By default, this number is the same as the Employee Number, for the employee’s first assignment.

8. Enter the information you want to hold in the alternative regions.

By default, the first assignment entered for an employee is the primary assignment. To change this default for an employee with more than one assignment, select the Primary check box in the Miscellaneous alternative region.

**Note:** You must associate all employee assignments (except any unpaid voluntary assignments) with a GRE, using the alternative region GREs and Other Data.

**GREs & Other Data Region**

Use the GREs and Other Data alternative region to place the employee assignment in a GRE, and enter other information.

**To enter information in the window GREs and Other Data:**

1. Select the GRE (Government Reporting Entity) for the assignment.

   The GRE is the organization holding a federal Employer Identification Number (EIN) that is responsible for paying employees, withholding their taxes, and issuing the Form W–2, Wage and Tax Statement. Additionally, the GRE is responsible for providing certain government–mandated reporting, such as EEO–1 and VETS–100 reports.
2. If the employee must submit a timecard, select Yes in the Timecard Required field and select the name of the employee approving the timecard.

Oracle Payroll does not process pay for employees required to submit timecards who fail to do so.

3. You can select a work schedule for the assignment. This field may display a default work schedule for the employee’s organization.

Oracle Payroll uses the work schedule to prorate pay for the employee. By scanning the work schedule, the payroll run detects mid-period assignment start or end dates, and mid-period pay increases or decreases.

4. If this employee assignment is for shift work, select the shift regularly worked.

5. You can enter the spouse’s salary, which can be a state requirement for married couples to qualify for reduced rates if they are filing jointly.

6. Select Yes in the Legal Representative field if you send the W–2, Wage and Tax Statement form for this employee to his or her legal representative. A legal representative can be, for example, the employee’s custodian, parent, or attorney.

7. To override the usual Workers Compensation job code for the assignment, select the override code in the WC Override Code field.

See: Entering a WC Override Code: page 20–15

8. Entries in the remaining fields in this window (except Reporting Establishment) are required at sites with Oracle Payroll that are using Oracle Payroll to produce state quarterly wage listings.

See: Entering S Record Data for Employees: page 19–26

**Supervisor Region**

Enter the name and employee number of the employee’s personal supervisor.

**Note:** This information shows the personal supervisor for an employee and is not updated by the system. Use organization and position hierarchies to show management reporting lines.

**Note:** The Auto WGI uses this information.
Probation Period and Standard Conditions Regions

The probation period and standard work day information default from the employee’s position. If standard conditions are not defined for the position, they may default from the employee’s organization or Business Group.

Miscellaneous Region

The Internal Address adds address details (such as the floor or office number) to the location address.

You can select a reason for adding or changing the assignment. You define valid reasons as values for the QuickCode Type EMP_ASSIGN_REASON.

Check the Manager check box if the assignment is at the level of manager.

Check the Primary check box if it is the employee’s only assignment or main assignment.

Special Ceiling Region

A special ceiling progression point is the highest point to which the Increment Progression Points process can automatically progress the employee.

You can enter a special ceiling if the employee is assigned to a grade, and a grade scale is defined for this grade. This special ceiling overrides the ceiling defined for the grade scale.

Salary Information Region

Using the Salary Administration window, you can enter a proposed salary change for an employee, associate this change with a performance review, and accept or revise the change later. To administer an employee’s salary in this way, you first assign the employee to a salary basis in the Salary Information region.

You can also enter the frequency of salary and performance reviews.

Attention: If you change an employee’s salary basis to a basis that uses a different salary element, the employee’s existing salary element entry will be ended. Using the Salary Administration window, you should make a new salary entry for the employee, effective from the date of the salary basis change.
See Also

Salary Administration and Performance Reviews (*Oracle Human Resources North American User’s Guide*)

Additional Employment Information: page 9 – 20
**Changing Assignment Information**

When an employee experiences changes such as a promotion, transfer, or move from full time to part time, you change a component of the assignment. A change to any of the assignment components produces the DateTrack prompt.

- If you choose *Correction*, Oracle HRMS overwrites the existing assignment information.
- If you choose *Update*, Oracle HRMS records the date and change, and retains the original information.

By changing your effective date on the system, you can see the employee’s assignment at any point in time. You can also view the changes made to the assignment over time using DateTrack History. DateTrack History shows the changes made to one assignment. Use the Assignment History window to view the history of all the employee’s assignments, both currently and in any previous periods of service.

**Effects of Changing an Assignment**

Changing any assignment component can have the following effects:

- The employee may lose eligibility for some compensation types, benefits or deductions, and gain eligibility for others. You receive a warning that the system automatically ends any unprocessed element entries for which the employee is no longer eligible.

- The employee may have a different level of access to Oracle HRMS, since the system’s security is based on assignment to work structures.

- If you change the employee’s grade when a grade step placement exists for the assignment, you receive a warning message that the placement will be date effectively ended and any future placements will be deleted. Also, the special ceiling point field is cleared.

  **Note:** If an assignment change causes the system to change element entries, you may not be able to save the change if a current or future pay period is closed. You must reopen the period or change your effective date to make the change.

**Changing Primary Assignments**

Over time, a secondary assignment may need to be elevated to a primary assignment. Most companies have requirements to show the history of changes in an employee’s record.
This process will create two historical records: one showing a secondary assignment that lasted from x day to y date, and the other showing that the primary assignment started as one set of components and then changed to another set of components (which are the same as the secondary assignment) as of a particular date.

To change a primary assignment:

1. Create a new assignment “B” as a secondary assignment.
   See Entering a New Assignment: page 9 – 9
2. Set an effective date for the assignment to become the employee’s primary assignment.
3. Change Assignment “B” to be the primary assignment by selecting the Primary checkbox in the Miscellaneous alternative region.

See Also

Assignment History: page 9 – 35
Viewing Datetracked Information and History: page 1 – 13
Updating and Correcting Datetracked Information: page 1 – 14
Ending an Assignment

Oracle HRMS does not permit an employee to exist in the system without an active assignment. That is, an employee must always have at least one active assignment at any point in time. This means that for an employee with just one active assignment, the only way to end the assignment is to terminate the employee, using the Terminate window.

See: Ending Employment: page 9 – 17

For employees with more than one active assignment, you can end all but one of their assignments by selecting an assignment status of End or Terminate in the Assignment window. Sites not using Oracle Payroll can use these two statuses to provide information. For example, End may mean that further pay processing cannot occur for the assignment, while Terminate may mean that further processing can occur. Alternatively, these sites can simply use the status End.

At sites using Oracle Payroll, the choice of End or Terminate controls the ability to include the assignment in a payroll run after the date the assignment ends, as explained in the procedure below.

► To end one of many assignments:

1. Set your effective date to the actual termination date for the assignment.

2. Update the assignment status to End or Terminate Process Assignment (or the equivalent user status on your system):
   - Use Terminate Process Assignment (with a Payroll system status of Process) if further pay processing of the assignment is required after the date the assignment ends. This leaves the assignment’s final processing date open so that further processing can occur. It is often best to use this status, so that you can process any necessary adjustments to the final pay for the assignment.
   - Use End (with a Payroll system status of Do Not Process) if all pay processing for the assignment is finished. This makes your effective date the assignment’s final processing date, after which no further processing for the assignment can occur.

   **Note:** The End status is not recorded on the assignment; it causes the assignment to end as of the effective date of entry of this status.

   - To temporarily prevent pay processing for this assignment, use the status Terminate Assignment (with a Payroll system status of Do Not Process). When no further processing is required and you are ready to set a final processing date, update the status to End.
Ending Employment

If an employee is leaving your enterprise, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

If an employee is leaving your agency, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

The ex-employee's records remain in the database. You can reinstate, or rehire, the person to create a new period of service.

Since terminating ends all assignments, the system does not permit you to terminate an employee who has future-dated assignments.

**Note:** If you have mistakenly added someone to the database or you want to remove all records for an ex-employee, you can delete the person in the Delete Person window. You cannot delete an employee whom Oracle Payroll has processed in a payroll run.

See: Deleting a Person from the System: page 8 – 37

If you mistakenly hired an applicant, you can cancel the hire in the Person window.

See: Hiring: page 8 – 10

Terminating an Employee

You end employment in the Terminate window.

► **To terminate an employee:**

1. Optionally, enter the reason for the termination. You can define valid reasons as values for the QuickCode Type LEAV_REAS.
If you use Oracle Payroll and the employee is deceased, you must select the reason Deceased, for recording on the W–2 Wage and Tax Statement.

2. Enter the termination dates. Only the Actual date is required. This is the date when the employee’s person type changes to Ex–employee. The Notified and Projected dates are for information only. The Final Process date is a date after which no further pay processing for the employee can occur, if you are using Oracle Payroll.

At sites including Oracle Payroll, it is best to leave the Final Process date blank, so that you can make corrections to the final payment or make other payments to the employee in the future if this is necessary.

3. When the information is complete, choose the Terminate button to complete the termination.

Setup To Allow Processing After Termination

** Cancelling a Termination

If the employee decides not to leave, or the date of leaving changes, you can cancel a termination. You can cancel a termination at any time provided that you have not rehired the employee. (You rehire an employee by changing his or her person type to Employee in the Person window.)

Oracle HRMS reopens the assignments previously closed down and gives each assignment the status it had before termination. It also restores other information to its state before termination. For example, it removes the end date put on recurring element entries for the assignment.

Notice, however, that any nonrecurring element entries that were deleted for processing periods after the termination date cannot be automatically restored. You must act to reenter these entries.

** To cancel a termination:

- Choose the Reverse Termination button in the Terminate window.

** To change the termination date:

1. Cancel the termination by choosing the Reverse Termination button.
2. Enter a new Actual date and choose the Terminate button.
Terminations Report

Oracle HRMS includes a standard report showing the reasons why employees left your organization within a specified period.

You run reports from the Submit Requests window.

To run the Terminations Report:

1. In the Name field, select Terminations.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Organization Structure field, select an organization hierarchy name, if you want to see terminations in a number of subordinate organizations. If there are multiple versions, select a version.
5. In the Parent Organization field, select the parent organization within the hierarchy whose subordinate organizations you want to see in the report.
   If you have not selected an organization hierarchy, use the Parent Organization field to enter the name of the organization for which you want to view terminations.
6. Enter the start and end dates defining the period in which you are interested.
7. Select at least one termination reason to include in the report.
8. Choose the Submit button.

See Also

Employee Movements Report: page 9 – 33
Additional Employment Information

Just as you can record additional information about people, such as their addresses, contacts, and skills, you can also record additional information associated with each employee assignment. The main items of information are as follows:

- If you are using Oracle Payroll, use the Tax Rules window to maintain W-4 and other required tax information.
  See: Tax Information for an Employee Assignment: page 18 – 13

- You can propose or approve a salary change in the Salary Administration window.
  
  **Note:** To pay employees using Oracle Payroll, they must have an approved salary on record.

- You can make entries to the earnings, deductions, benefits and other elements the employee is eligible for, using the Element Entries window.
  See: Making Manual Element Entries: page 12 – 42

- If you use a pay scale and progression point system, you can place the assignment on a pay scale using the Grade Step Placement window.
  See: Placing an Employee on a Grade Step: page 4 – 16

- You can select the cost centers or accounts to which the costs of the assignment should be allocated, using the Costing window.

- You can use the Assignment Budget Values window to specify the value of the assignment in terms of headcount, full time equivalent (FTE), or any other budgets you have defined.

- For employees who have assignments to payrolls, you can select the methods by which the employee wants to receive pay for this assignment in the Personal Payment Method window.
  See: Entering Payment Methods for an Employee Assignment: page 9 – 21

- You can enter secondary assignment statuses for analysis and reporting, if these have been defined on your system.
  See: Entering Secondary Assignment Statuses: page 9 – 23
Entering Payment Methods for an Employee Assignment

Your enterprise may pay employees by check, by direct deposit of funds into their bank accounts through the National Automated Clearing House Association (NACHA), or by a combination of these payment types.

Depending on the policies of your enterprise, you may enter several payment methods for an employee assignment, so long as these are valid methods for the assignment’s payroll. For example an employee may request that you use direct deposit to send 80% of her pay to a checking account, 10% to a savings account, and 10% to a credit union.

Employees with no personal payment method on record receive pay by the default payment method of their payrolls.

You enter payment methods for employee assignments in the Personal Payment Method window. You can also use this window to enter the payee for third party payments.

Note: As the GRE (Government Reporting Entity) is the organization that pays employees and withholds their taxes, you must associate every employee assignment with a GRE.

See: GREs and Other Data Region: page 9 – 10

Prerequisites

- Define all the payment methods available in your Business Group using the Organizational Payment Method window.
  See: Defining Payment Methods for the Enterprise: page 5 – 3

- Select at least one valid payment method for each payroll you define in the Payroll window.
  See: Defining a Payroll: page 5 – 6

- Assign the employee to a payroll.

- For third party payment methods, define the payee in the Organization window (using the classification Payee Organization) or the Contact window (using the relationship Payments Recipient).
To enter a personal payment method for remuneration:

1. Set your effective date to the date on which to begin paying the employee by this method.
2. In the Name field, select a payment method.
3. Enter a number in the Priority field to determine the order for Oracle Payroll to use each payment method. It uses the method with the lowest number first.
   - If an employee with two assignments requests the same payment method for both, give them different priority numbers to determine their order of use.
4. Enter either the amount or percentage of the assignment’s pay to be paid by this method.
   - If the total of the amounts you allocate to payment methods is less than the amount to be paid, Oracle Payroll uses the payment method with the highest priority number to pay the excess.
5. The Type field displays Cash, Check or NACHA. If the type is NACHA, open the Bank Details window for entry of information about the employee’s bank account.

**NACHA Prenote Information for Oracle Payroll**

For someone currently employed in your enterprise whose bank information NACHA has already verified, enter the verification date in the Prenote Information region. Oracle Payroll automatically checks the Issued box, and immediately uses this payment method to route payments through NACHA.

For a new employee with unverified bank information, leave the Issued and Date fields blank. Oracle Payroll pays the employee by check...
when it next processes pay for the employee, and sends a zero payment through NACHA. It enters this payment date in the Date field and checks the Issued box.

For a 10–day waiting period, it makes all further payments to this employee by check. If during this time the bank informs you of erroneous information, you correct the information and clear the Issued box. Then when next processing the employee, Oracle Payroll sends another zero payment through NACHA to restart the verification process.

When the 10–day waiting period passes with no notification of errors and no manual clearing of the Issued box, Oracle Payroll automatically starts making regular payments to the employee through NACHA.

To enter a third party payment method:

1. Set your effective date to the date on which to begin making payments using this method.
2. In the Name field, select a third party payment method. Third party payment methods automatically receive priority 1 (the highest priority) and you cannot change this. You cannot split a third party payment between different payment methods; the Percentage field always displays 100%.
3. In the Payee region, select an organization or a person.
4. Save your work.

You can select this third party payment method in the Payee Details entry value when you enter a deduction to be paid as a third party payment.

Entering Secondary Assignment Statuses

Your implementation team may have created secondary assignment statuses for analysis and reporting of employee or applicant assignments.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.
To give a secondary status to an assignment:
1. Select the status and enter a start date.
2. You can also select a reason for giving the new status.
   When a status no longer applies, simply enter an end date.

See Also

Assignment Statuses: page 24 – 5
Inquiring and Reporting on Employment Information

Oracle HRMS provides a number of predefined inquiry windows and reports for employment information. You can also create your own inquiries and reports using QuickPaint or other reporting tools.

Listing Assignments

There are three predefined inquiry windows for producing lists of assignments that match criteria you enter:

- Assignments Folder
- List Assignments
- List People by Assignment

Assignments Folder

Using the Assignments Folder window, you can query lists of current assignments, past assignments, or both. You select the fields of assignment information you want to see, and position them in the order you prefer. For example, you can produce a listing of all current employees ordered by organization, and by grade within organization.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.
Note: The system administrator can create customized versions of the Assignments Folder window so that you use each version for one person type only.

The system administrator can also link this window in a task flow so that you use it to access other windows of employment information. Notice that if you select a past assignment in the folder, you cannot open other windows of employment information.

List Assignments Window

In this window, you can view current employees and applicants. If you enter the Job, Position, Grade, or Group fields, a window opens prompting you for individual segments of the flexfield. You can enter selection criteria in one or more segments. This means that you can search on parts of the job name, for example.
List People by Assignment Window

In this window you can choose whether to view current or former employees/applicants, or both. However, you must search on a whole Job, Position, or Grade name, not on segments of these flexfields.

To produce lists of assignments:

1. Select values in one or more fields in the top part of the window, and choose the Find button.
   
The folder in the lower part of the window lists the assignments that match the selection criteria you entered.

2. You can enter a query in the folder to reduce further the list of assignments displayed. For example, you could run the query "C%" in the Full Name field to view the assignments of people whose names begin with C.

3. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Listing Employees by Organization

In the List Employees by Organization window, you can view lists of employees within one organization or within all organizations below a specified level in a hierarchy you select.

To list employees in several organizations:
- Select an organization hierarchy and select the highest organization in this hierarchy for which you want to list employees. Choose the Find button.

To list employees in one organization only:
- Leave the Organization Hierarchy field blank and select an organization. Choose the Find button.
  
  You can enter a query in the Employees block to further restrict the list of employees to be displayed.

Manager Field
The Manager field identifies any employee for whom the Manager check box is checked in the Miscellaneous region of the Assignment window.

If there is more than one manager in the organization you select, the Manager field displays the number of managers. You can view the names of these managers by choosing the List icon from the Toolbar.
Organization Field

If an employee belongs to more than one organization within the hierarchy you selected, the number of organizations appears in the Organization field. You can view the names of these organizations by choosing the List icon from the Toolbar.
Listing Employees by Position

There are two windows for viewing lists of employees by position:

- List Employees by Position
- List Employees by Position Hierarchy

List Employees by Position Window

To view employees in a single position, or in all positions corresponding to a job or organization, use the List Employees by Position window.

To view employee names by position:

1. Select any combination of an organization, job, or position.
2. Choose the Find button.

   The folder displays the positions that match your selection criteria, together with the holder’s name and employee number.

   If there is more than one holder for a position, the number of holders is displayed in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

   **Note:** You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
List Employees by Position Hierarchy Window

To view lists of employees in a number of positions within a hierarchy, use the List Employees by Position Hierarchy window.

1. Select a position hierarchy and the highest position in the hierarchy for which you want to list employees.
2. Choose the Find button.

The folder displays all positions below the one you selected in the hierarchy. It also lists the employees who hold these positions.

If there is more than one holder for a position, the number of holders appears in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

Note: You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Assignment Status Report

Use this report to see a list of people assigned to particular organizations, jobs, positions and grades, with specific assignment statuses. If you select both applicants and employees as person types, the report prints out in two sections. Otherwise it prints for the type you select.

Run reports from the Submit Requests window.

To run the Assignment Status Report:

1. In the Name field, select Assignment Status Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Leave the Organization Structure field blank to see information about all organizations. Select an organization hierarchy name to see assignment statuses in a number of subordinate organizations.
5. If there are multiple versions, select a version.
   If the effective date lies between the version’s start and end dates, the report is effective as of this date. If it lies outside these dates, the report is effective as of the start date of the version you select.
6. Leave the Parent Organization field blank to see information about all organizations. Select a name in this field to see information on all subordinate organizations in the hierarchy.
   Note: You must enter a value in this field if you have entered a value in the Organization Structure field, and you must leave this field blank if you left that field blank.
7. Make entries in the Group, Job, Position, Grade and Payroll fields as required.
   If you leave all segments of the Group flexfield blank, you see information about employees in any groups. If you leave one segment blank you see employees with any value for that segment.
8. Enter Yes in the Primary field if you want to report on primary assignments only. Leave blank to include all assignments.
9. Select Employee, Applicant or Both in the Person Type field. This determines which sections of the report are printed.
10. Select up to four assignment statuses, or leave blank to list employees and/or applicants with any assignment status.
11. Choose the Submit button.
Employee Summary Report

This report is a current summary of information for an employee, covering addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries.

Run reports from the Submit Requests window.

► To run the Employee Summary Report:
1. In the Name field, select Employee Summary.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Enter the name of the employee whose summary you want to see.
5. Choose the Submit button.

See Also

Full Personal Details Report Set: page 8 – 31

Employee Movements Report

There are two versions of the Employee Movements Report:

- Employee Organization Movements Report shows employee movements into and out of a particular organization or hierarchy.
- Employee Payroll Movements Report shows employee assignment changes to and from a particular payroll.

Both versions list the following movements: New Hires, Terminations, Transfers In, and Transfers Out. You can use this information to monitor employee assignment changes for turnover analysis.

Run reports from the Submit Requests window.

► To run the Employee Organization Movements Report:
1. In the Name field, select Employee Organization Movements Report.
2. Enter the Parameters field to open the Parameters window.
3. Do one of the following:
• If you want to see information for a whole organization hierarchy, select the Organization Hierarchy name and version number, and leave Parent Organization blank.

• If you want to see information for one organization, select the organization name in the Parent Organization field, and leave Organization Hierarchy name and version number blank.

• If you want to see information for an organization and its subordinates in a particular hierarchy, select the name of the organization and the name and version of the organization hierarchy to which it belongs.

4. Select the period for which you want to see the information.

5. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

6. Choose the Submit button.

To run the Employee Payroll Movements Report:

1. In the Name field, select Employee Payroll Movements Report.

2. Enter the Parameters field to open the Parameters window.

3. Select the payroll and payroll period for which you want to see the information.

4. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

5. Choose the Submit button.
Assignment History

Use the Assignment History window to view the history of all an employee’s assignments, both current and in previous periods of service.

To view an employee’s assignment history:

1. In the Current field, select Yes, No or All.
   - Yes selects the list of current employees. No selects the list of ex–employees. All selects the list of both current and ex–employees.

2. In the Name or Number field, select an employee or ex–employee and choose the Find button.
   - The Service History region displays the employee’s final period of service. It shows three periods of time:
     - **This Period** shows the number of complete years and months worked in this period of service to date.
     - **All Periods** shows the number of complete years and months worked in all periods of service to date.
     - **Including Breaks** shows the total elapsed time (in complete years and months) from the employee’s initial hire date to date.

You can view previous periods of service by choosing Next Record from the Go menu.
To manage your employees’ absences from work, you must be able to:

- identify the types of absence your enterprise recognizes
- record the reasons, dates and times for projected and actual absences, and maintain records of time taken for each absence type
- group related absence types together for reporting and analysis
- set up and administer PTO accrual plans, whereby employees can accrue time off for vacation or sick leave as they put in time at work.

This chapter explains how to set up an effective absence recording system in Oracle HRMS, how to enter and obtain information about employee absences, and how to set up, maintain and report on plans for accrual of paid time off.
Absence Management

Employees take paid or unpaid time off from work for a variety of purposes, such as illness or injury, vacation, medical appointments, childbirth, death of a close relative, jury duty, labor representation, and professional activities. Maintaining information on employee absences for reporting and analysis is an important aspect of human resource management.

Many enterprises permit employees to accrue hours or days of PTO (paid time off) as they work, to use for sick or vacation leave. In such enterprises, setting up and maintaining PTO plans is another part of absence management.

See Also

Absence Types: page 10 – 3
Absence Management Setup Steps: page 10 – 8
Entering Absences: page 10 – 13
Viewing and Reporting on Absence Information: page 10 – 15
Absence Types

Oracle HRMS provides a convenient way to maintain information about the various absence types your enterprise recognizes. To facilitate reporting and analysis of employee absences, you can distinguish between absence types and absence categories. An absence category is a group of related absence types, as for example:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Leave</td>
<td>Illness or Injury</td>
</tr>
<tr>
<td></td>
<td>Work-related Injury</td>
</tr>
<tr>
<td></td>
<td>Work-related Illness</td>
</tr>
<tr>
<td></td>
<td>Medical Appointment</td>
</tr>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Unpaid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Dependent Care</td>
</tr>
<tr>
<td>Personal Leave</td>
<td>Compassionate Leave</td>
</tr>
<tr>
<td></td>
<td>Personal Business</td>
</tr>
<tr>
<td>Professional Leave</td>
<td>Certification Classes</td>
</tr>
<tr>
<td></td>
<td>Meeting Attendance</td>
</tr>
</tbody>
</table>

Table 10 – 1 Example Absence Categories and Types

Also to assist with absence reporting and analysis, you can provide reasons to select from when recording employees’ time taken for an absence type. For example, if you need information to analyze the particular family–related responsibilities that cause employees to miss work, you can define reasons for absence types as follows:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
<th>Absence Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
<td>Birth of a child</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adoption of a child</td>
</tr>
<tr>
<td></td>
<td>Dependent Care</td>
<td>Child Care</td>
</tr>
</tbody>
</table>

Table 10 – 2 Example Absence Category, Types and Reasons
<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
<th>Absence Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Elder Care</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disabled Care</td>
<td></td>
</tr>
</tbody>
</table>

Table 10-2 Example Absence Category, Types and Reasons

Absence Elements: page 10–5

Setup of Absence Types

Setting up each absence type is essentially a two-step process. One step involves defining the type, that is, entering its name, and optionally selecting a category and reasons for it. The other step involves defining an element to associate with the type. This element serves two important purposes:

- It provides a way to maintain a running total of time taken for the absence type. When you record an absence for an employee, the amount of time taken goes as an entry to the input value of the element associated with the absence type.

  For example, if you record 8 hours of Compassionate Leave for an employee, the input value of the element for this absence type receives an entry of 8. If a second 4 hour absence of this type occurs the input value gets an entry of 4, which adds in for a total of 12 hours Compassionate Leave taken to date.

- It provides a way to restrict employee eligibility for the absence type. The links you build for the element establish which employees are eligible to use the type.

  For example, if the absence type Compassionate Leave is available only to full time employees, you link its element to the employment category Full Time.

See:

Overview of Elements: page 12–2
The Structure of Elements: page 12–3
Using Elements: page 12–6

To hold a single running total of time taken for two or more absence types, you associate all the types with the same absence element. For example, your absence category Personal Leave may include two absence types you need for certain reporting purposes, Compassionate
Leave and Personal Business. However, you require just one running total to be kept of employees’ time taken for both types of personal leave. In this case you simply associate both absence types with the same absence element.

**Note:** If you have a use for absence types for which you do not maintain running totals of time taken or time remaining, and which do not require any eligibility rules, you can define the type with no associated element.

Absence Recording: page 10 – 7

### Absence Elements

Each element you define and associate with an absence type has an input value with either hours or days as its unit of measure. To maintain a running total of the hours or days a employee has taken for an absence type, this input value is said to hold an *increasing balance*.

### Increasing Balances of Time Taken

As you would expect, an increasing balance for an absence type starts with no time entered, and increases as you enter employees’ hours or days absent. For example, if the absence type Compassionate Leave has an increasing balance, the balance starts from zero for each employee and increases by the number of hours entered for each absence of this type.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>Hours in decimal format</td>
<td>(none)</td>
</tr>
</tbody>
</table>

**Table 10 – 3  Example Element for the Absence Type Compassionate Leave**

Increasing balances are appropriate for most or all absence types. For absence types for which your enterprise sets a maximum time allowed, the system issues a message when an entry of time absent exceeds this maximum, or Oracle Alert can notify you when an employee reaches the maximum time or takes excess time.

**See: Oracle Alert User’s Guide**

When defining an absence type for a PTO accrual plan, you give it an increasing balance that will show accrued time the employee has used. To see the amount of accrued time a plan participant has available for use as vacation or sick leave, you use the Accruals window.
Decreasing Balances of Time Remaining

If your enterprise sets a maximum time allowed for an absence type that is not connected to a PTO accrual plan, you have the option of setting up a decreasing balance for this type, instead of an increasing balance.

For example, suppose your enterprise allows certain employees 32 hours leave per year for professional development. The Professional Leave absence element can have a decreasing balance, and an initial entry of 32 hours.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Hours in decimal format</td>
<td>32</td>
</tr>
</tbody>
</table>

Table 10 – 4 Example Element for the Absence Type Professional Leave

If you record an employee absence of 4 hours for this absence type, the decreasing balance shows 28 hours still available to be taken.

Decreasing absence balances require more maintenance than increasing balances. They need a prorated initial balance entry for all eligible new hires throughout the year, and require resetting each year for all eligible employees.

Notice that an absence element cannot have both a decreasing and an increasing balance; it has one or the other.

Initializing an Absence Balance

Oracle HRMS provides two ways to initialize both increasing and decreasing absence balances at the year’s start, and to enter initial amounts of any decreasing balances:

- the Element Entries window, for individual employees
- the MIX batch entry facility, for batches of employees.

Alternatively, users can develop their own processes for resetting absence balances in a new year, and entering initial values for decreasing balances.

See:

Making Manual Element Entries: page 12–42
Making Non–Payroll Batch Entries Using MIX: page 13–51

Referencing Absent Time in Payroll Runs

You can reference absence time taken (amount of an increasing balance) or absence time remaining (amount of a decreasing balance) for absence
types in formulas for earnings, deductions, or other items Oracle Payroll processes in payroll runs. When defining the input value to hold the absence balance for an absence type’s element, you can check the Database Item box. Entries to this input value then become database items that formulas for payroll calculations can access.

See: Elements and Formulas: page 12 – 21

Absence Recording

When you record an absence for an employee using the Absence Detail window, you must always select an absence type. This ensures that you always have on record, information about the nature of and reasons for the absence.

Dates and Times

In the Absence Detail window you can conveniently record for an employee either a projected or an actual start and end dates and times of a particular type of absence, as well as the date you receive notification of the absence. When an actual absence occurs in accordance with projected absence information already entered, you record this by simply clicking a button.

The system records an employee’s absences using the same calendar upon which the employee’s payroll is based. This means that all employees for whom you record absence information must have a payroll component in their assignments.

See: Components of the Assignment: page 9 – 5

Authorization and Replacement

When recording a projected or actual absence in the Absence Detail window, you can select both the name of an employee authorizing the absence, and of an employee replacing the absent worker.

Batch Entry of Accrued Time Taken

When employees report accrued sick or vacation time taken on their timecards, you can use PayMIX, instead of the Absence Detail window, to enter sick or vacation time taken together with other timecard data.

See: Recording Accrued Time Taken: page 10 – 29
Absence Management Setup Steps

1. Define a nonrecurring absence element, with the Termination Rule *Actual Termination* and with at least one input value, for each absence type. Link this element.

   See: Defining and Linking an Absence Element: page 10 – 8

   **Note:** To set up an absence type for which you do not need to maintain a running total of time taken or remaining, and do not need eligibility rules, omit this step.

   To keep a single record of employees’ time taken for two or more different absence types, you can define one element only to associate with all the types.

   See: Setup of Absence Types: page 10 – 4

2. Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and your absence reasons as values for the QuickCode Type ABSENCE_REASON.

   You can select the same reason for different absence types.

   See: Adding QuickCode Values: page 29 – 3

3. Define each absence type, associating with the type its absence element.

   See: Defining an Absence Type: page 10 – 10

4. For an absence type with a decreasing balance, use the Element Entries window or the MIX batch facility to make initial element entries for employees eligible for the type.

   See:

   Making Manual Element Entries: page 12 – 42
   Making Non–Payroll Batch Entries Using BEE: page 13 – 51

Defining and Linking an Absence Element

Define an absence element in the Element window.

**To define an absence element:**

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.
2. Enter a name for the element, and select the classification Information.
   
   **Suggestion:** Give the absence element and its absence type the same name, or coordinate the element name with the type name. For example, for the absence type Compassionate Leave, name the element Compassionate Leave or Compassionate Leave Absence.

3. Select the processing type Nonrecurring, and the termination rule Actual Termination.

4. Check the Multiple Entries Allowed box to enable employees to have several instances of this type of absence in a pay period.

5. If this is an absence element for a PTO accruals plan, do not select Process in Run. Uncheck this box if necessary.

6. If employees must be a certain age or have served for a certain number of years to be allowed this absence, enter this information in the Qualifying Conditions region.

   **Note:** If this is an absence element for a PTO accrual plan, the plan setup relates length of service to accrued time off. Do not make an entry here for length of service.

7. If this is an absence element for a PTO accrual plan for which you may make batch entries using PayMIX, you must mark it so that it can accept these entries. To do this, click in the Further Information field and select a PayMIX category of Time for the element.

   This does not affect your ability to make manual entries to the element.

8. Save the element, then choose the Input Values button.

9. In the Input Values window, create an input value to hold the amount of time taken. Select units of Day, Hours in "HH" format, or Hours in Decimal Format (to one, two, or three decimal places).

   **Attention:** If this is an absence element for a PTO accrual plan, give the input value the name Hours or Days, to accord with the unit of measure of the plan. When you define the plan using the Accrual Plan window, this input value name appears in the Units field of the Absence Information region.

   For a PTO accrual plan whose units are Hours, the units you select for the input value Hours must be:

   - Hours in "HH" format, or
   - Hours in Decimal format (1, 2 or 3 places).
For an accrual plan whose units are Days, the units you select for the input value Days must be: Day.

Additionally, if you may make batch entries to this element using PayMIX, you must create an input value named Date Earned for the element, with units in the format DD–MON–YYYY. When you make entries to this element using PayMIX, the system supplies a date in this field.

The existence of this input value does not affect your ability to make manual entries to the element. When making manual entries, you leave this field blank.

See: PayMIX Timecard Entries: page 13 – 62

10. You can define minimum and maximum days or hours that can be entered in an absence record. If you do this, select what happens if these limits are breached:
   - Select Warning for the system to warn users but allow them to breach the limits.
   - Select Error for the system to issue an error message and prevent users from saving an entry that breaches the limits.

11. Save your work.

   ► To link the absence element:
   1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.
   2. In the Element Link window, select the absence element.

      See: Defining Element Links: page 12 – 38

   3. Select eligibility criteria for this absence element. If you want to make the element available to all employees, do not select any criteria.
   4. Save the link. Then define the absence type associated with this absence element.

See Also

Defining an Absence Type

Use the Absence Attendance Type window to define an absence type for association with the nonrecurring element representing an absence.

Prerequisites

- Define and link the element for the absence type.
Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and define your absence reasons as values for the QuickCode Type ABSENCE_REASON. You can select the same reason for different absence types.

See:  Adding QuickCode Values: page 29 – 3

To define an absence type:

1. Enter a name and category for the absence type.

   Suggestion: Give the absence type and its associated element the same name, or coordinate the type name with its element name. For example, name the absence type for a PTO accrual plan Salaried Sick PTO Plan, and its associated element, Salaried Sick PTO Absence.

2. In the Associated Element region, select the element defined for this absence type. The name of the element’s input value that holds the time taken or time remaining for this absence type appears in the Input Value field, and the unit of measure for the input value appears in the Units region.

3. In the Balance region, select Increasing for each entry to the absence element’s input value to add to a running total of time taken to
date for this absence type. Select increasing balances for absence types for PTO accrual plans, and for most other absence types.

For absence types that have a set maximum amount of hours or days allowed, you may select *Decreasing*. In this case, each absence recorded reduces an initial balance entered for the absence type, to show time remaining to be taken for the type.

Decreasing balances require more maintenance. You must enter an initial balance amount for each new hire eligible for the absence type, and must initialize the balance for all eligible employees at the start of each year.

4. Optionally, select reasons that are valid for entries of this type of absence.

5. Save the absence type.

**Absences Taken and Time Remaining for Accrued PTO**

An employee’s net accrual of accrued time as of a given date, together with a record of accrued time used this year and unused time carried over from the previous year, is always available for review in the Accruals window.

See: Reviewing Employees’ PTO Accruals: page 10 – 32
Entering Absences

To enter projected or actual absences for an employee, use the Absence Detail window.

See: Absence Recording: page 10 – 7

Prerequisites

- Because the calendar holding absence records for an employee is the same as that of the employee’s payroll, the assignments of employees for whom you enter absence information must include an assignment to a payroll. The effective date of this assignment must be no later than the start of the current payroll period.

  See: Entering a New Assignment: page 9 – 9

- Similarly, the definition and linking of the element associated with the absence type must have occurred on or before the start of the current payroll period.

  See: Defining and Linking an Absence Element: page 10 – 10

To enter absences for an employee:

1. Select the absence type. The following information appears:
   - The category of the type.
• The occurrence of the new absence record you are entering. For example, if the employee has already incurred two absences of this type, the occurrence of the new record is 3.

• The running total of hours or days absent for the absence type. For absence types with increasing balances, this is the number of days or hours absent already recorded (in the past or future). For any types with decreasing balances, this is or the number of hours or days remaining to be taken.

• The number of days absence recorded for the absence type in the current calendar year.

• The name of the element that maintains each employee’s time taken or time remaining for this absence type.

2. Do one of the following:

• Enter projected dates for the absence. You can later copy them to the Actual Date fields by choosing the Confirm Projected Dates button.

• Enter actual dates and duration as days or hours, according to the units of the balance. For a duration in hours, you must enter start and end times, as well as start and end dates.

3. You can also select:

• reasons for the absence

• the employee authorizing the absence

• the employee who replaces the absent employee for the duration of the absence

4. Save your work.
Viewing and Reporting on Absence Information

For monitoring and analyzing recorded employee absences unconnected with a PTO accrual plan, use:

- the View Absence History window: page 10 – 15
- the List Employees by Absence Type window: page 10 – 16
- the Absences Report: page 10 – 17

For reviewing PTO plan participants’ accrued time earned and taken, use the Accruals window.

Viewing Absence History

Use the View Absence History window to view all absences for an employee.

To view absences for an employee:
- Select an employee then choose the Find button.
The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.

Listing Employees by Absence Type

Use the List Employees by Absence Type window to see all the absence records for a particular absence type, or category of types.

To list employees by absence type:

- Enter any combination of absence type, category, and start and end dates to define the absences to view. Choose the Find button.

The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.
Absences Report

The Absences Report shows information about employee absences during a specified period. It can show absences:

- for an individual employee, or for all the employees in an organization
- for all types of absence, or as many as 10 selected types.

The report summarizes the information as totals for each absence type since the employee was first hired.

Run reports in the Submit Requests window.

**To run the Absences Report:**

1. In the Name field, select Absences Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select either an organization or an employee.
5. Enter the start and end dates of the period for which you want to report absences.
6. You can choose up to 10 absence types for the report. To report on all types, leave the absence type fields blank. Choose OK.
7. Choose the Submit button.
Plans for Accrual of PTO

Accrual plans permit eligible employees to accrue PTO (paid time off) each year as they work, to use for vacation or sick leave. Oracle HRMS has no restrictions on the number of plans you can set up, each with its own units of accrued time (hours or days) and its own rules.

The system calculates accruals for all plans on a calendar year basis. That is, on 1 January of each year, accruals for that year begin. Accruals for new hires can begin on their hire date, six months after their hire date, or at the beginning of the next calendar year.

For all plans, participants’ payroll periods determine the frequency with which they accrue PTO. Employees on a monthly payroll accrue time each month, employees on semi-monthly payrolls accrue time twice each month, and so on. PTO accrual occurs automatically for each eligible plan participant on the last day of his or her pay period, independently of any payroll run.

For example, if employees on a semi-monthly payroll participate in a vacation PTO plan permitting the accrual of 84 hours per year, they accrue 3.5 hours on the last day of the year’s first pay period, say 15 January. They then accrue another 3.5 hours on 31 January, another 3.5 hours on 14 February and so forth.

Because accrual plans use employees’ payroll calendars to schedule accruals, the assignment of every employee participating in an accrual plan must include an assignment to a payroll.

Accrual Plan Structure

Just as elements constitute the underlying structure of absence types, so they provide the structure of accrual plans. To set up an accrual plan, you first set up absence recording for the plan, including an element to hold information about absences taken under the plan.

With absence recording in place, you can then enter information for setup of the accrual plan itself. This information includes:

- a start rule, to determine when employees can begin to accrue PTO under the plan
- length of service bands, which establish how PTO accrued under the plan increases with employees’ length of service.

In response to the information entered for plan setup, the system generates three elements for the plan:

- an element representing the plan (classification: PTO Accruals). You use this element to enroll participants in the plan.
• an element (classification: Information) to hold participants’ unused PTO that is available for carryover to the next year
• an element (classification: Information) to hold residual PTO, that is, unused PTO not available for carryover under plan rules.

Accrual Start Rules

Accrual plans differ with respect to the date from which they permit plan participants to start accruing PTO. In Oracle HRMS, the accrual start rule determines this date for a plan. The system includes these accrual start rules:

• Hire Date
• Beginning of Calendar Year
• Six Months after Hire Date

Enterprises have many different rules governing their accrual starts, so you may need start rules other than the three provided. You can either modify the existing rules, or add new ones.

Start Rule: Hire Date

For plans with this rule, participants’ accruals begin from the first full period following their hire date. For example, if the hire date of a participant on a semi-monthly payroll falls on the first day of either the first or second period in the month, PTO accrual starts as of that date. If the hire date falls sometime after the first of the month but before the end of the first period, accruals start in the second period of the month. If the hire date falls after the first day of the second period but before its end, accruals start with the first period in the next month.

Start Rule: Beginning of Calendar Year

With this start rule, participants’ accruals begin from the start of the year following the year in which they are hired. This means that a participant with a hire date of 2 January 1996 and another with a hire date of 31 December 1996 both start to accrue time as of 1 January 1997. Notice that the amount of PTO each accrues may not be the same, as accrual amounts often depend on employees’ length of service.

Period of Ineligibility

Plans with the start rule Hire Date or Beginning of Year can require participants to work for a period of time, perhaps three or six months,
before they are eligible to accrue PTO. If plan participants in fact take
vacation or sick leave during this period, the system does not accept
entry of this time against the accrual plan. Many enterprises set up an
absence type for “approved but unpaid leave” to use for absences taken
during periods of ineligibility.

The period of ineligibility is not applicable to plans with the start rule
Six Months After Hire.

**Start Rule: Six Months After Hire**

For plans with this start rule, participants’ accruals do not begin until
the first full pay period after the six-month anniversary of their hire
date. For example, someone on a semi-monthly payroll who is hired
on 5 February 1996, completes six months of service on 5 August 1996,
and starts to accrue PTO in the second period in August.

Notice that if people are hired on the first day of a period, their
accruals begin with the pay period of the six-month anniversary of
their hire date. For example, someone on a semi-monthly payroll who
is hired on 1 February 1996 completes six months of service on 1
August 1996, and hence starts to accrue PTO in the first period in
August.

**Length of Service and Accrual Amount Rules**

In Oracle HRMS, the *first day of the month of an employee’s hire date*
is the default date from which his or her length of service is calculated
for accrual purposes. For example, someone hired on 18 January 1997
completes one year of service on 1 January 1997, and someone hired on
31 December 1996 completes one year of service on 1 December 1997.

**Length of Service Override**

For individual accrual plan participants, you can override the default
date from which a plan starts its length of service calculations. This is
useful for managing exceptional cases that arise when, for example,
employees who already have accumulated periods of service in your
enterprise transfer from one place to another. You enter the date
override when enrolling a participant in a plan.

See: Enrolling Employees in PTO Accrual Plans: page 10 – 29

**Length of Service Bands**

For many accrual plans, the time off that plan participants can accrue
increases with their length of service. That is, *length of service bands*
determine accrual amounts. In addition, these bands can determine ceiling and maximum carryover amounts for plans that have these rules.

For each accrual plan in Oracle HRMS, you set up one or more length of service bands, supplying for each the hours or days of PTO that participants can accrue each year, together with any ceiling and maximum carryover of accrued time.

**Ceiling Rules**

The ceiling rule, found in some vacation accrual plans, sets a maximum amount of PTO an employee can hold at any time. When a participant’s accrued PTO reaches the ceiling, no additional time accrues. Accruals begin again only after the participant uses some accrued time.

**Maximum Carryover Rules**

Maximum carryover rules, found in both vacation and sick leave plans, set the maximum amount of unused PTO a participant can carry over from one year to the next.

**Carried Over and Residual PTO**

To manage the carryover to a new calendar year of employees’ unused PTO, you run the PTO Carry Over process at year end. This process first calculates participants’ net PTO as of the last day of the year’s last pay period. This calculation insures that this period’s accruals do not exceed any plan ceilings that may exist. The process then checks the maximum carryover permitted, to determine for each participant both the amount to carry over, and the amount of any residual PTO that cannot be carried over.

For employees with unused, accrued time to carry over, it enters this time on the element generated to hold carried over time for the plan. Similarly, for employees with unused, accrued time they cannot carry over, it enters this time on the element generated for the plan to hold residual time.
PTO Sale or Purchase

Your enterprise may have policies permitting accrual plan participants, under certain circumstances, to sell back PTO they have accrued but not used. You may also permit them to purchase additional PTO. Because such policies and rules are not standard across enterprises, Oracle HRMS has no method in place for managing PTO sale or purchase. However, you can design a method and define elements for doing this, customized to your own requirements.

See: Reviewing or Changing Net Accrual Calculations: page 10 – 26
Accrual Plan Setup Steps

To set up a PTO accrual plans:

1. Define and link an element for the plan’s absence type.
   See: Defining and Linking an Absence Element: page 10 – 8
2. If you expect to record accrued time taken under the plan using the Absence Detail window, define an absence type for the plan, associating its absence element with this type.
   If you expect to record accrued time taken using only PayMIX or the Element Entries window, it is not essential that you define an absence type for the plan.
   See: Defining an Absence Type: page 10 – 10
3. Define the accrual plan.
   See: Defining a PTO Accrual Plan: page 10 – 23
4. Set up length of service bands for the plan.
   See: Setting Up Length of Service Bands: page 10 – 25

Defining a PTO Accrual Plan

Use the Accrual Plan window to define an accrual plan.

Prerequisite

Before setting up the plan, set up a way to track absences taken under the plan. To do this you define and link an element for recording accrued time taken under this plan, and optionally, associate this element with absence type information.

See: Absence Management Setup Steps: page 10 – 8
To define a PTO accrual plan:

1. Enter the plan name, and select an accrual category of either Sick or Vacation for it.

   **Suggestion:** Coordinate the names of the accrual plan, the plan’s absence type if any, and the element used to record absences taken under the plan. For example, for the Hrly Vacation PTO Plan for your hourly workers, you could name the absence type and its element Hrly Vacation PTO Absence.

2. Select the start rule for the plan in the Accrual Start field. This rule determines the date on which a plan participant begins to accrue PTO.

   See: Accrual Start Rules: page 10 – 19

3. Select Days or Hours in the Accrual Units field. This selection must accord with the input value units selected for the element that records accrued time taken under this plan.

   See: Defining an Absence Type: page 10 – 10

4. In the Name field of the Absence Information region, select the element associated with the plan’s absence type. The name of the element’s input value that holds the entries or hours or days absent appears in the Units field.
5. If the start rule for this plan is Hire Date or Beginning of Year you can enter a period of ineligibility, during which a plan participant can accrue PTO but cannot use accrued PTO. For example, enter 3 in the Length field and select Calendar Month in the next field. 

See: Period of Ineligibility: page 10 – 19

6. Save your work, and then set up length of service bands for the plan. Choose the Accrual Bands button to go to the Accrual Bands window.

Choose the Net Calculation Rules button to view or change the rules for calculating employees’ net PTO.

---

**Setting Up Length of Service Bands**

Use the Accrual Bands window to define length of service bands for an accrual plan.

**Prerequisite**

- Define the accrual plan for which you are entering length of service bands.

---

![Accrual Bands Window](image)

**To set up length of service bands for a PTO plan:**

1. For each length of service band applicable to this plan, establish the band’s duration by making an entry in the To field. The first band
starts from zero years of service. If it extends for five years, enter 5 in the To field. The system then sets the From field for the second band at 5, as the second band starts after five years of service.

For the last band you enter, in order to cover all participants with any length of service beyond the band’s From entry, enter 99 in the To field. For example, if your bands cover service of 0–5 years, 5–10 years and 10+ years, the third band’s From and To entries should be 10 and 99.

If length of service is not relevant for this plan, define one band only for it, with a From entry of 0 and a To entry of 99.

2. For each band, enter in the Yearly Accrual field the number of hours or days that participants whose length of service falls into this band can accrue each year. For example, if plan participants accrue 80 hours of vacation per year during their first five years of service (band 0 – 5), enter 80 in the Yearly Accrual field.

3. If a band does not permit participants to carry unused accrued time over to the next year, leave the Accrual Carryover field blank. Otherwise, enter in this field the maximum number of accrued, unused hours or days that participants at this band may carry forward.

See: Length of Service and Accrual Amount Rules: page 10 – 20

4. If a band has no ceiling that limits the total number of hours or days participants at this band can accrue at any one time, leave the Ceiling field blank. Otherwise, enter the ceiling number for the band.

5. Save your work.

When you do this, the system generates three new elements for the plan, one to represent the plan and one each to hold carried over and residual amounts of accrued, unused PTO. Define for these elements, the same links as those of the plan’s absence element.

---

### Reviewing or Changing Net Accrual Calculations

The rules for automatic calculation of employees’ net PTO appear in the Net Calculation Rules window. Here the system displays the rules that carried over time adds to net PTO, and hours or days absent subtract from the net. You enter this window by choosing the Net Calculation Rules button in the Accrual Plan window.
The Net Accrual Calculation for Net Entitlement of PTO

The calculation dynamically adds up a plan participant’s regular accruals to date. Then it adds in any carried over PTO from the previous year, obtained from the plan’s Carried Over element, to produce the gross accrual to date.

The calculation next adds up all PTO taken to date, obtained from the entries in each period to the element of the plan’s absence type. It then subtracts the amount of time taken to date from the gross accrual to date, to obtain the net accrual to date.

Gross PTO accrual = Accrued PTO + PTO carried over
Net PTO accrual = Gross PTO accrual - PTO taken this year

If your enterprise allows employees to purchase additional PTO or sell unused PTO, you can define elements to record information about purchased or sold amounts, query them in the Net Calculation Rules window, and select for the elements’ input values, rules governing their addition or subtraction in the net accruals calculation.

Residual PTO

Notice that the system does no automatic processing of the entries of employees’ residual PTO. Your enterprise may want to use these entries to inform employees of accrued but unused time they may forfeit, or to make payments for part or all of this time.
Linking the Accrual Plan Elements

When you save your entries in the Accrual Bands window, the system creates three elements:

- An element (classification: PTO Accruals) representing the plan that has the plan name, for example, Hrly Vacation PTO Plan. Use this element to enroll employees in the plan.
- An element (classification: Information) to hold for each plan participant, any accrued, unused hours or days that can be carried over to the next year.
- An element (classification: Information) to hold each participant’s residual time, that is, any accrued, unused hours or days that cannot be carried over.

The Carried Over and Residual elements each have an input value Hours or Days (depending on the plan’s units), which automatically receive entries when you run the PTO Carryover process at year end.

For the three elements generated for each PTO accrual plan, you must build links that are the same as those of the plan’s absence element, whose name appears in the Absence Information region of the Accrual Plan window.

**To link the accrual plan elements:**

1. Set your effective date to the date the accrual plan goes into effect.
2. In the Element Link window, select one of the following:
   - the element representing the plan (for example, Hrly Vacation PTO Plan)
   - the plan’s Carried Over element (for example, Carried Over Hrly Vacation PTO Plan)
   - the plan’s Residual element (for example, Residual Hrly Vacation PTO Plan)
3. Select the same eligibility criteria for the element as those selected for the plan’s absence element. If you save a link without selecting any criteria, the element is available to all employees.
4. Save the link.

You are now ready to enroll employees in the plan, and record absences for plan participants when they use time they have accrued.
Maintaining PTO Plan Records

When a PTO accrual plan setup is complete, you enroll employees in their plans, and record their accrued time taken. At year end, you run the PTO Carry Over process to clear down each employee’s balance of unused accrued time, recording both unused time available for carryover, and residual time unavailable for carryover.

The net accrual calculation produces for an employee, his or her amount of accrued PTO at a given point in time. The results of this calculation are always available for review.

Enrolling Employees in PTO Accrual Plans

Enroll individual participants in an accrual plan by entering for them the element generated to represent the plan.

- To enroll participants in a PTO accrual plan:
  - Do one of the following:
    - For enrollment of an individual employee, perhaps as a part of the hiring process, enter the element representing the plan for him or her using the Element Entries window.
      See: Making Manual Element Entries: page 12 – 42
    - For enrollment of a batch of employees in a plan, perhaps a newly-developed plan, use the MIX batch entry facility.
      See: Making Non-Payroll Batch Entries Using MIX: page 13 – 51

If an accrual plan should calculate a participant’s length of service from a date other than the default date deriving from the plan’s start rule, give the plan a date to use for this participant when enrolling him or her.

See: Length of Service Override: page 10 – 20

- To override the date for calculating length of service:
  - When enrolling the participant, enter the override date in the input value Continuous Service Date of the element representing the plan. This entry overrides the default date derived from the plan’s accrual start rule.

Recording Accrued Time Taken

For PTO accrual plans associated with an absence type, you can use the Absence Detail window to record a plan participant’s accrued time taken.
See: Entering Absences: page 10 – 13

For plans not associated with an absence type, you can make entries for individual participants directly to the plan’s absence element, using the Element Entries window.

See: Making Manual Element Entries: page 12 – 42

If you are using Oracle Payroll you can make batch entries of hours of accrued sick or vacation time that employees have taken and noted on their timecards.

See: PayMIX Timecard Entries: page 13 – 62

Note: If you are using PayMIX to make entries from timecards of accrued time taken, ensure that standard links to all payrolls are in place for the elements Vacation Pay and Sick Pay. These elements are included in the system, and should receive standard links during the implementation of Oracle Payroll at your site.

Recording PTO Sold or Purchased

If your enterprise pays employees for time they have accrued but not used, or if you permit employees to buy additional time, you may decide to define your own PTO–related elements to record information about these transactions. In this case, you can enter these elements and select the rules governing the subtraction or addition of sold or purchased PTO in the Net Calculation Rules window.

Running the PTO Carry Over Process

Run this process at year end for each PTO accrual plan, to clear down participants’ balances of unused, accrued time. For each participant, the process stores time available for carryover to the new year on the plan’s Carried Over <plan name> element, and stores time they cannot carry over on the plan’s Residual <plan name> element.

Run the PTO Carry Over process from the Submit Requests window.

To run the PTO Carry Over process:

1. Select PTO Carry Over in the Name field. If the Parameters window does not open automatically, click in the Parameters field.

2. The date in the PTO Year Earned field defaults to the year before the current year. You can enter a different year.
3. Select the name and category of the accrual plan for which you are running the process.

4. The Reprocess All Participants field defaults to No, so that the process affects only those plan participants not previously processed for this year. To process all participants regardless of any previous processing, select Yes in this field.

5. When the entry of parameters is complete, choose OK. Choose Submit to submit the request.

The net accrual calculation for PTO includes carried over PTO in determining an employee’s accrued PTO to date. To set the net calculation rules, use the Net Calculation Rules window. To review an employee’s carryover of accrued time, use the Accruals window.

**See Also**

Reviewing or Changing Net Accrual Calculations: page 10 – 26
Reviewing Employees’ PTO Accruals

To view information on employees’ accrued PTO, use the Accruals window.

▶ To view an employee’s net PTO accrual:

1. In the Assignments Folder, query the employee’s name. Choose the Accruals button to go to the Accruals window.

2. Query the accrual plan in the Name window. The field Net Entitlement displays the net accrued days or hours as of the effective dates that appear. If you allow maintenance of negative balances of accrued time at your installation and an employee’s time absent exceeds time accrued, the net entitlement appears as a negative number.

   The Entitlement Details region shows the amounts of current accrued time, the accrued time carried over and accrued time taken used in the calculation of the net PTO accrual.

   **Attention:** When reviewing employee accruals at year end, remember that:
   - the last day of the final period of the current calendar year may fall between a date in late December and one in early January
– accruals for the new calendar year do not go on record until the last day of the first period of the new year
– carried over and residual PTO appear only after the PTO Carry Over process is run.
You must be able to enter and maintain information relating to the labor costs associated with your employees. In Oracle HRMS, you set up segments of the Cost Allocation key flexfield to identify the work structures that constitute your cost centers and the GL account codes to use for entry of labor costs.

Installations including Oracle Payroll use post-payroll run processes to accumulate information on payroll costs by cost center, GL account code, and labor distribution codes, and to transfer information to Oracle General Ledger.

This chapter explains the setup for collection of labor costs in Oracle HRMS, and the Oracle Payroll processes for accumulating and transferring these costs.
Labor Costs in Oracle HRMS

At all installations of Oracle HR, you can allocate employee costs to cost centers, GL codes and labor distribution codes. If your installation does not include Oracle Payroll or Oracle General Ledger, you must consider how to relate information on labor costs entered in Oracle Human Resources to your payroll and financial systems.

If your installation includes Oracle Payroll, you use a post-payroll run process to accumulate payroll costs by cost center, GL account code, and the labor distribution codes in use at your enterprise. For installations that also include Oracle General Ledger, another post-payroll run process is available to facilitate the transfer of information on payroll transactions to Oracle General Ledger.

For the allocation of labor costs, all installations of Oracle HRMS, use the Cost Allocation key flexfield.

The Oracle HRMS Cost Allocation Key Flexfield

In this flexfield you set up as many segments as you need to identify:

- the companies or sets of books for which your enterprise collects labor costs
- the work structures, such as departments, sections, or projects that constitute the cost centers of your enterprise
- the GL codes and labor distribution codes against which you collect labor costs.

Example Cost Allocation Flexfields

To construct a simple example of a Cost Allocation flexfield, suppose that the departments of a hypothetical enterprise each constitutes a cost center, and the general ledger accounts receiving labor costs are Salaries, Wages, Overtime, Bonuses, Union Dues Liability and Clearing.

Note: The Clearing account in this example represents a single account set up for entry of:

- credits, in order to balance debits to accounts for earnings types, for example Salaries, Wages, Overtime and Bonuses
- debits, in order to balance credits to accounts for deductions, for example Union Dues Liability.

After running payroll and the Costing process, you can make journal entries to credit or debit each individual balancing
account, making corresponding debits or credits to the Clearing account.

This example enterprise must transfer to the general ledger, information such as the following:

- the totals of salaries and wages paid in its departments/cost centers, to go as debits to the Salaries and Wages accounts, and as balancing credits to the Clearing account
- the total of bonuses paid to employees, to go as a debit to the account Bonuses, and as a balancing credit to the Clearing account
- the total deducted from employees in Production and Quality Control to pay their union dues, to go as a credit to the Dues Liability account, and as a balancing debit to the Clearing account.

To collect information for transfer to the general ledger, this enterprise can construct a Cost Allocation flexfield with two segments, one for identifying cost centers and one for GL costing and balancing codes, as follows:

<table>
<thead>
<tr>
<th>Seg. 1 Cost Center</th>
<th>Seg. 2 GL Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting</td>
<td>Salaries</td>
</tr>
<tr>
<td>Production</td>
<td>Wages</td>
</tr>
<tr>
<td>Public Relations</td>
<td>Overtime</td>
</tr>
<tr>
<td>Quality Control</td>
<td>Bonuses</td>
</tr>
<tr>
<td>Sales</td>
<td>Dues Liability</td>
</tr>
<tr>
<td></td>
<td>Clearing</td>
</tr>
</tbody>
</table>

Table 11 – 1 Example Cost Allocation Flexfield

Now suppose that for labor distribution purposes, this enterprise accumulates labor costs not just by cost center and GL account, but also by its product lines, represented by the labor distribution codes H201, H202, H305, H307 and H310. The enterprise requires product line costing information such as the following:

- total wages paid to produce product line H201, and to check its quality
- total paid for overtime to produce product line H201
- total paid for salaries and bonuses to sell product line H201

Since this enterprise uses its GL codes for labor distribution, it does not need another segment to hold a separate list of codes. However, it must add another segment to hold product line codes, as follows:
Similarly, if this enterprise needed to identify for each of its payrolls a particular company or set of books to which all the information on labor costs should go, it could define another segment of the Cost Allocation flexfield such as Company or Set of Books, to contain a list of the appropriate codes.

**Note:** Installations including both Oracle HRMS and Oracle General Ledger should take the GL codes for the Oracle HRMS Cost Allocation flexfield and for the Oracle General Ledger Accounting flexfield from the same table. Installations without Oracle GL can set up their own tables of GL codes, possibly populating these tables from their existing financial systems.

See: User–defined Tables: page 29 – 10
Use of the Cost Allocation Key Flexfield

When implementing and using Oracle HRMS, you make selections from the lists in the Cost Allocation flexfield segments as follows:

- **When defining a payroll**, you can select a code for the company or set of books holding the labor costs from the payroll.

- **When linking an element** representing an earnings type such as Regular Salary, a deduction such as Union Dues, or an employer charge such as a benefit plan contribution, you select a GL code that the element’s results should debit or credit, and a code for the balancing GL account to credit or debit.

  **Note:** As well as making entries to the Cost Allocation flexfield at the element link level, you also enter on each link, essential information about the type of costing the system should do for the link. Available types include Costed, Fixed Costed, and Distributed.

  See: Costing Information at the Element Link Level: page 11 – 7

- **When defining an internal organization or entering an employee assignment**, you can select codes for the cost centers, product lines or other structures for which to collect the labor costs of the organization or assignment.

- **When entering timecard data** in Oracle Payroll, you can select codes for accounts, cost centers, product lines and other items listed in the flexfield segments to show how to collect labor costs for particular hours worked.

The different points at which you can make entries to segments of the Cost Allocation flexfield exist as related entry levels. Ranging from top to bottom, the five entry levels are these:

<table>
<thead>
<tr>
<th>Entry Level</th>
<th>Windows</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll</td>
<td>Payroll</td>
<td>Identifies company or set of books to which all costs from this payroll should go.</td>
</tr>
<tr>
<td>Link</td>
<td>Element Link</td>
<td>Identifies a GL account to debit and a balancing account to credit, or for deductions, an account to credit and a balancing account to debit. Other entries can identify any other accounts into which run results of the element should go.</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization</td>
<td>Identifies structures such as cost centers against which to charge the payroll costs of employees in the organization.</td>
</tr>
</tbody>
</table>

Table 11 – 3 Cost Allocation Flexfield Entry Levels
Purpose of Entry

Windows

Assignment

Costing

Identifies structures such as cost centers and product lines against which to regularly charge payroll costs of this assignment.

Element Entry

PayMIX Time Entry, Element Entries

Identifies structures such as cost centers and product lines against which to charge payroll costs of an employee assignment for a period. Entries often taken from timecards.

<table>
<thead>
<tr>
<th>Entry Level</th>
<th>Windows</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
<td>Assignment Costing</td>
<td>Identifies structures such as cost centers and product lines against which to regularly charge payroll costs of this assignment.</td>
</tr>
<tr>
<td>Element Entry</td>
<td>PayMIX Time Entry, Element Entries</td>
<td>Identifies structures such as cost centers and product lines against which to charge payroll costs of an employee assignment for a period. Entries often taken from timecards.</td>
</tr>
</tbody>
</table>

Table 11 – 3 Cost Allocation Flexfield Entry Levels

Note: You enable a qualifier for each segment of your Cost Allocation flexfield to control whether it appears at a given entry level. For example for the Cost Center segment of your flexfield, which receives entries only at the organization, assignment and element entry levels, you enable only the Organization, Assignment and Element Entry qualifiers. This segment then appears only at these levels.

See: Setting Up the Cost Allocation Key Flexfield: page 11 – 11

Cost Allocation Flexfield Entry Overrides

A key feature of the Cost Allocation flexfield is that entries made to its segments at lower levels, override any entries at higher levels. Thus, entries from timecards made in a particular segment at the Element Entry level override any entries to this segment made at the employee assignment, organization, link and payroll levels.

This helps to keep your costing information accurate. For example, if employees temporarily work at cost centers or on product lines different from those entered for their organizations or assignments, they can enter the cost center or product line codes together with their time worked on their timecards. On receipt of this costing information at the element entry level, the system correctly charges their time for the period, using this information rather than any entered at the organization or assignment levels.

Costing Data at the Payroll Level

Sometimes the labor costs from a payroll should all be charged to a particular company within your enterprise, or all be entered in a particular set of books. In this case, you select the code for the company or set of books from the appropriate segment of the Cost Allocation flexfield when defining the payroll.
Also at the payroll level, you can select codes for *suspense accounts*. A suspense account is one that collects costs from the payroll if segment entries at lower levels are missing. For example, if an employee receives a Special Production Bonus but no GL code for this earnings type to debit in the Cost Allocation flexfield, the cost of the bonus goes into the suspense account.

Entries of sums in a suspense account alert you to missing codes, and provide a way to hold unallocated costs until you can make manual journal entries to the correct accounts. Since codes entered in the Cost Allocation flexfield at levels below the payroll level override any entered at the payroll level, costs go to a suspense account only when the correct account codes are not entered at the element link level.

**See Also**

Defining a Payroll: page 5 – 6

**Costing Data at the Element Link Level**

You enter the important costing information for an element on its links. This means that **all elements for which you must maintain costing information must have at least one link**, even those that receive entries during the payroll run as indirect results of the processing of other elements.

See: Entry as an Indirect Result of Formula Processing: page 12 – 29

When defining a link for an element, you select a *costable type* that determines whether the payroll run should collect the results of this link for costing purposes. By default, a link’s costable type is *Not Costed*. For the results of elements that process in payroll runs to be collected for accumulation and transfer, you must change this default to a costable type of either *Costed, Fixed Costed* or *Distributed*.

**Costable Type: Costed and Fixed Costed**

When processing an element for an employee with a link marked Costed, the payroll run checks for Cost Allocation flexfield entries affecting the employee at every level—payroll, organization, assignment, and element entry. Since earnings types may well receive override entries of information for labor distribution purposes at the lower levels of Assignment or Element Entry, the costable type Costed is likely to be best for the links of elements representing earnings.
however, deduction amounts are usually irrelevant to labor distribution analyses, so elements representing deductions seldom receive lower level entries of costing information. Accordingly, the costable type Fixed Costing may be best for these elements’ links. When processing elements marked for Fixed Costing, the system looks for costing information at the payroll, element link and organization levels only, not the assignment or element entry levels.

**Costable Type: Distributed**

For labor distribution analysis, you can distribute employer charges, such as employer payments for FUTA, Social Security, or employee benefits, as overhead costs to be added to employees’ earnings. The links of elements representing employer charges you want to distribute in this way require the costing type Distributed.

For each employee, Oracle Payroll distributes the run results of elements with this costable type proportionally over a set of earnings types you specify. This *distribution set* of earnings types could include, for example, Wages, Overtime and Shift Pay. When you select Distributed as the costable type of a link, you must also enter the name of the distribution set of earnings over which the run results of the link are to be distributed.

See: Defining an Element or Distribution Set: page 27 – 5

**Costing and Balancing GL Accounts**

For element links whose run results should go to the general ledger, you enter in the Costing field of the link, the GL account to debit or credit, and in the Balancing field, the account to correspondingly credit or debit.

For earnings types and non–payroll payments, the GL account to debit (for example, Salaries) goes in the Costing field, and the account to credit (for example, Clearing) goes in the Balancing field. For deductions, the account to credit (for example, Clearing) goes in the Costing field, and the account to debit (for example, Union Dues Liabilities) goes in the Balancing field.

**See Also**

Defining Element Links: page 12 – 38

Example of Employer Charge Distribution: page 11 – 19
Costing Data at the Organization and Assignment Levels

When setting up an internal organization for which most or all labor costs go to the same cost center, select that cost center from the appropriate segment of the Cost Allocation flexfield when defining the organization.

For example, if the labor costs of most of the employees in the Commercial Sales Group go against the cost center Sales, select Sales from the list of cost centers when defining the organization Commercial Sales Group. This means that by default, the system accumulates labor costs for each employee assigned to the Commercial Sales Group for the cost center Sales.

Perhaps the costs of some employees assigned to this group should exceptionally be charged to a different cost center. For these employees, you can enter the correct costing information on their assignments. Entries at the assignment level override entries at the organization level.

There may also be employees regularly assigned to work in this group only part time, who work elsewhere the rest of the time. In cases like these, it is not necessary to give employees two assignments. You can enter a number of cost centers for one assignment, specifying the percentage of labor costs to charge to each:

<table>
<thead>
<tr>
<th>Proportion</th>
<th>Seg. 1 Cost Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>50%</td>
<td>Sales</td>
</tr>
<tr>
<td>50%</td>
<td>Public Relations</td>
</tr>
</tbody>
</table>

Table 11–4 Example Cost Center Information at the Assignment Level

You can also enter other types of costing information at the assignment level. For example, if a Production Department employee regularly works 80% of the time on one product line and 20% on another, you can enter this on her assignment.

<table>
<thead>
<tr>
<th>Proportion</th>
<th>Seg. 3 Labor Dist. Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>80%</td>
<td>H201</td>
</tr>
<tr>
<td>20%</td>
<td>H202</td>
</tr>
</tbody>
</table>

Table 11–5 Example Labor Distribution Information at the Assignment Level

Notice that assignment level entries are datetracked, so you can enter changes ahead of time.
Costing Data at the Element Entry Level

When you make entries to elements with links marked as Costed for individual employees using the Element Entries window, or for many employees at once using the PayMIX windows, you can at the same time supply costing information.

Information entered at this level overrides any information entered at other levels. For example, if an employee has costing information on record in a Cost Allocation flexfield segment at the organization or assignment level, an entry of timecard information in this segment at the element entry level overrides the organization or assignment-level information.

See Also

HR Organizations: Entering Costing Information: page 2 – 30

Making Manual Element Entries: page 12 – 42
PayMIX Timecard Entries: page 13 – 62
Setting Up the Cost Allocation Key Flexfield

You must define at least one segment of the Cost Allocation key flexfield; you may define as many as 30 segments. To set up this flexfield, consult the explanations and procedures given in the Oracle Applications Flexfields Manual.

You can control which segments of the Cost Allocation flexfield appear in each of the windows from which users can make entries to this flexfield.

Controlling the Display of Flexfield Segments

Oracle HRMS implementors and users make selections from the lists in the Cost Allocation flexfield’s segments at different levels, that is, in several different Oracle HRMS windows. However in a particular window, they usually need to access only certain segments of the flexfield.

For example, when defining a payroll you need only the segment containing the companies or sets of books to which a payroll’s labor costs should go. When defining a link for an earnings or deduction element, you may need only the segment containing the list of the costing and balancing GL codes. You likely need the segment containing the list of cost centers only when defining an organization or employee assignment, or making an element entry.

You control the appearance of a Cost Allocation flexfield segment in a particular window by enabling qualifiers for the segment. When you enable a particular qualifier for a segment, this causes the segment to appear and be available for entry in a particular window, as follows:

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Enables Segment’s Appearance in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element</td>
<td>Element Link window</td>
</tr>
<tr>
<td>Balancing</td>
<td>Element Link window</td>
</tr>
<tr>
<td>Payroll</td>
<td>Payroll window</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization window</td>
</tr>
<tr>
<td>Assignment</td>
<td>Assignment Costing window</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Element Entries window</td>
</tr>
</tbody>
</table>

Table 11-6 Qualifiers for Cost Allocation Flexfield Segments

You can enable as many qualifiers as necessary for a particular segment. Consider this example:
Table 11–7 Example Cost Allocation Flexfield

For the segments of this flexfield, qualifiers would likely be enabled as follows:

Table 11–8 Qualifiers for Example Cost Allocation Flexfield

Enabling the qualifiers Organization, Assignment and Element Entry for the Cost Center segment and the Labor Distribution Code segment causes these segments to appear in the Organization, Assignment Costing and Element Entries windows, but not in the Payroll or Element Link windows.

Enabling the qualifiers Element and Balancing for the GL Code segment causes this segment to appear in the Costing and Balancing fields of the Element Link window, but not in the Payroll, Organization, Assignment Costing or Element Entry windows.

Note: Since this example Cost Allocation flexfield has no segments set up to hold payroll-level information such as sets.
of books, there is no need to enable the qualifier Payroll for a segment of this flexfield.
Costing for Taxes

The setup for maintaining costing information on employer and employee federal tax liabilities is straightforward. However, the setup for costing state and local taxes depends on the way your general ledger holds this information.

On the one hand, just as you enter a total into a GL account for a federal tax type, your enterprise may enter a total into a GL account for one or more state or local tax types, regardless of the states or localities levying the taxes. For example, you enter a single total for amounts withheld for employees’ federal income tax (FIT), and may similarly enter a single total for amounts withheld for employees’ state income tax (SIT), regardless of the states in which these taxes are owed.

Alternatively, you may make entries for state and local taxes for each state, or state and locality, in which these taxes are owed. In this case, your setup for costing these taxes will differ from that used for federal taxes.

Elements for Taxes

Oracle Payroll comes with the elements for the following taxes already defined (EE = employee tax, ER = employer tax):

**Federal taxes**
- Federal Income Tax (FIT) – EE
- Federal Unemployment Tax Act (FUTA) – ER
- Social Security (SS) – EE and ER
- Medicare – EE and ER
- Earned Income Credit (EIC) – EE

**State taxes**
- State Income Tax (SIT) – EE
- State Unemployment Insurance (SUI) – ER, EE in some states
- State Disability Insurance (SDI) – EE, ER in some states

**Local taxes**
- City Tax – EE. Includes coverage of Head Tax – ER.
- County Tax – EE. Includes coverage of School District Tax – EE

Links to all payrolls for the elements for each of these taxes are usually created during the implementation of Oracle HRMS for your enterprise.
See Also

Tax Balances: page 18–5

Costing All Taxes by Tax Type

You maintain costing for federal taxes by the tax type, and can similarly hold costing information for state and local taxes by type only (not by the state or locality to which they are payable). To do this you enter on the link for the tax type’s element the code for the general ledger account to which amounts of the tax should go.

For example, suppose that:

- the segment of the Cost Allocation key flexfield that holds GL codes has the name GL Code
- all amounts withheld for FIT should go to the GL account code 123fit, and all amounts for SIT, should go to 123sit.

To collect costing information for both these taxes, you do the following:

- ensure that links to all payrolls exist for the elements FIT and SIT. These are usually created during implementation of Oracle Payroll.
- if the possible entries to the GL Code segment exist in value sets validated by entries existing in a table or on a predefined list, ensure that the codes 123sit and 123fit appear in the table or list.

See: Values and Value Sets (Oracle Applications Flexfields Guide)

- Query the FIT or SIT element in the Element Link window. In the Costing region, choose the tax type Fixed Costed. The Transfer to GL box is automatically checked.
- For the FIT element, select in the Costing field, the account code 123fit. For the SIT element, select the code 123sit.

With this setup, when the Costing process runs, it will collect all amounts withheld for FIT and SIT under the GL codes 123fit and 123sit.

Costing State and Local Taxes by Jurisdiction

If your general ledger maintains tax totals by state, or by state and locality, you follow a different setup procedure for costing these taxes. You still must ensure that links to all payrolls exist for the tax elements.
Additionally, you must set up one or more special segments of the Cost Allocation key flexfield to collect the required jurisdiction information. These special segments must be named as follows:

- **State Code.** If your requirement is to collect state and local tax costs by state but not locality, set up only this segment.

- **County Code, City Code, School District Code.** Set up these three segments if you must collect tax amounts not only by state, but also by locality.

**Attention:** In setting up these segments, **do not** mark them as required. Also, **do not** enable any qualifiers for them, as they should not appear in any Oracle HRMS windows.

See: Controlling the Display of Flexfield Segments: page 11 – 11

These segments are special in that you never make any entries in them at any of the entry levels (Payroll, Element Link, Organization, Assignment, or Element Entry). Instead, these segments receive entries directly from the payroll run.

Payroll runs enter the appropriate **jurisdiction code** for each of the state and local taxes it processes:

- into the State Code segment, if the other segments are not defined, or
- into the State Code, County Code, City Code, and School District Code, if these are all defined.

When the Costing process runs, it collects the amounts for each state and local tax under the jurisdiction code of the state or locality. For example, the jurisdiction code of the state of Illinois is 14, for Kane County in this state the code is 089, and for the town of Geneva in this county the code is 1110.

It is your responsibility to set up matches between your GL account codes and the jurisdiction codes the Costing process uses, and to develop a process for transferring Costing process results to the appropriate accounts in your general ledger. A complete listing of US jurisdiction codes used in Oracle HRMS is available in the *GeoCoder Master List* from Vertex Inc.
Accumulation and Transfer of Payroll Costs

At installations including Oracle Payroll, you initiate the post–run process *Costing* following payroll runs to accumulate costing results for transfer to the GL and other systems. This process sorts the run results by company or set of books, cost center, and GL and labor distribution accounts, in accordance with the information you have selected from the Cost Allocation flexfield at all levels.

The sections that follow contain examples of the cost allocation of payroll results, and of the distribution of employer charges over selected employee earnings.

If your installation also includes Oracle General Ledger, following the Costing process you can run the process Transfer to GL, to facilitate the transfer of the results from the Costing process to Oracle General Ledger.
Example of Labor Cost Allocation

The Sample Payroll Results table below displays payroll run results for four employees, using accounts and work structures identified using the Cost Allocation key flexfield. The Example Costing Process Results table shows how the Costing process allocates these payroll results:

- to accounts and cost centers, for the general ledger
- to accounts for cost centers and product lines within cost centers, for labor distribution purposes.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Work Structure</th>
<th>Earnings &amp; Deductions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cost Center</td>
<td>Product Line</td>
<td>Salary</td>
</tr>
<tr>
<td>Employee 1</td>
<td>Production</td>
<td>H201 100%</td>
<td>1,000</td>
</tr>
<tr>
<td>Employee 2</td>
<td>Sales</td>
<td>H305 100%</td>
<td>1,500</td>
</tr>
<tr>
<td>Employee 3</td>
<td>Production</td>
<td>H201 50% H202 50%</td>
<td>2,000</td>
</tr>
<tr>
<td>Employee 4</td>
<td>Sales</td>
<td>H305 20% H310 40%</td>
<td>1,000</td>
</tr>
</tbody>
</table>

Table 11 – 9
The table below shows the allocation of costs from the sample run results displayed above.

<table>
<thead>
<tr>
<th>Account Code</th>
<th>Cost Center</th>
<th>Product Line</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Production</td>
<td>H201</td>
</tr>
<tr>
<td>Salaries</td>
<td>2,500</td>
<td></td>
</tr>
<tr>
<td>Wages</td>
<td>3,000</td>
<td>2,000</td>
</tr>
<tr>
<td>Overtime</td>
<td>1,000</td>
<td>700</td>
</tr>
<tr>
<td>Union Dues Liability</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Clearing</td>
<td>(Account contains balancing credits for earnings Salary, Wages and Overtime, and balancing debit for deduction Union Dues.)</td>
<td></td>
</tr>
</tbody>
</table>

Table 11 – 10

Example of Employer Charge Distribution

When you give links for elements representing employer charges the costable type Distributed, the Costing process distributes the employer charges as overhead for each employee, over a set of employees’ earnings.

See: Costing Information at the Element Link Level: page 11 – 7

This example shows how employer payments totalling $100 are distributed over a set of earnings including wages and overtime, for the cost center Production and the product lines H201 and H202.

**Overhead Distribution for the Production Cost Center**

Total paid to Production Cost Center as Wages run result: $3,000.00

Total paid to Production Cost Center as Overtime run result: $1,000.00

Total for Earnings types specified for distribution: $4,000.00

Ratio for Wages distribution, Production Cost Center = 3000/4000 = .75

Wages overhead = Pension Charge $100 x .75 = $75.00
Ratio for Overtime distribution, Production Cost Center = 1000/4000 = .25
Overtime overhead = Pension Charge $100 x .25 = $25.00

**Overhead Distribution for Product Lines H210 and H202**

Total paid for Product Line H201 as Wages run result: $2,000.00
Total paid for Product Line H202 as Wages run result: $1,000.00
Total paid for Product Lines 201 and 202 for Wages: $3,000.00

Ratio for Wages distribution, Product Line H201 = 2000/3000 = 0.6667
Product Line H201 overhead = Total Wages overhead $75 x .6667 = $50.00
Ratio for Wages distribution, Product Line H202 = 1000/3000 = .3334
Product Line H202 overhead = Total Wages overhead $75 x .3334 = $25.00

Total paid for Product Line H201 as Overtime run result: $700.00
Total paid for Product Line H202 as Overtime run result: $300.00
Total paid for Product Lines H201 and H202 as Overtime: $1,000.00

Ratio for Overhead distribution, Product Line H201 = 700/1000 = .7
Product Line H201 overhead = Total Overtime overhead $25 x .7 = $17.50
Ratio for Overhead distribution, Product Line H202 = 300/1000 = .3
Product Line H202 overhead = Total Overtime overhead $25 x .3 = $7.50
### Distribution of Overhead over Cost Center and Product Line Totals

<table>
<thead>
<tr>
<th>Account Code</th>
<th>Cost Center</th>
<th>Product Line</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Production</td>
<td>H201</td>
</tr>
<tr>
<td>Wages</td>
<td>3,000</td>
<td>2,000</td>
</tr>
<tr>
<td>Employer Liability Distribution</td>
<td>75</td>
<td>50</td>
</tr>
<tr>
<td>Overtime</td>
<td>1,000</td>
<td>700</td>
</tr>
<tr>
<td>Employer Liability Distribution</td>
<td>25</td>
<td>17.50</td>
</tr>
</tbody>
</table>

Table 11 – 11
Running the Costing Processes

Run the Costing process from the Submit Requests window.

To run the Costing process:
1. Select Costing in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. In the Parameters window, select the payroll or consolidation set for which you are running the Costing process. If you select a payroll, the name of its consolidation set appears in the Consolidation Set field.
3. In the Start and End Date fields, enter the start and end dates of the period of time for which you want to see costing results. Choose Submit.

Reviewing Costing Process Results

To review these results online, use the Costing Breakdown window and the Costing window. Standard reports on these results include Costing Breakdown Summary, Costing Breakdown for Costing Run, and Costing Breakdown for Date Range.

Online Results

The Costing Breakdown window summarizes the results of a run of the Costing process.

See: Reviewing Process–Level Results: page 21–27

The Costing window displays complete results of the Costing process for an individual employee assignment.

See: Reviewing Assignment–Level Results: page 21–30
The Cost Breakdown Summary Reports

The Cost Breakdown Summary reports are Cost Breakdown Report for Costing Run and Cost Breakdown Report for Date Range. They show for a payroll, a consolidation set, a GRE, or all GREs, summarized totals either from one run of the Costing process, or from all the Costing processes run during a specified date range. For GL accounts, debits and credits appear separately.

Run this report from the Submit Requests window.

▶ To run a Cost Breakdown Summary report:

1. In the Name field, select either Cost Breakdown Report for Costing Run or Cost Breakdown Report for Date Range. Click in the Parameters field if a window containing the parameters for this report does not appear.

2. For the Cost Breakdown for Costing Run report, select the Costing Process. To see results from this process for a single GRE only, select this GRE in the GRE field. Choose OK, then Submit.

3. For the Cost Breakdown for Date Range report, enter the start and end dates of the date range. To see results from processes run in this range for a single consolidation set, payroll, or GRE, select the GRE, consolidation set or payroll. Otherwise, the report covers all GREs’ results for the date range. Choose OK, then Submit.
Transferring Costs to Oracle General Ledger

If your installation includes Oracle General Ledger, you can run the Transfer to GL process to facilitate transfer of the results of the Costing process for a payroll to the Accounting flexfield of Oracle General Ledger.

Mapping Flexfield Segments

Before running this process, for each payroll you must map segments of the Cost Allocation flexfield to the corresponding segments of the GL Accounting flexfield. To accomplish this mapping, use the GL Map window.

Prerequisites

- Complete the setup of the Cost Allocation key flexfield in Oracle Payroll.
- Complete the setup of your sets of books and Accounting key flexfield in Oracle General Ledger.
- Check that the Oracle Payroll currency codes match those of Oracle General Ledger. Using the international set of currency codes for both ensures that they match.

To map Cost Allocation to Accounting flexfield segments:

1. Set your effective date to the date from which this mapping should take effect.
2. Query the payroll for which you are performing the mapping. Its period type appears in the Period field.

3. Select the set of books for whose Accounting flexfield you are performing the mapping. Costing information from a payroll can go to only one set of books. The payroll and set of books must have the same currency code.

4. Select the name of a Cost Allocation flexfield segment in the Payroll Costing Segment field for which a corresponding segment exists in the Accounting flexfield. Select the name of the corresponding segment in the GL Chart of Accounts Segment field. Repeat this process for all the Cost Allocation flexfield segments for which there is a corresponding segment in the Accounting flexfield.

5. Save your entries.

Running the Transfer to GL Process

Run this process from the Submit Requests window.

To run the Transfer to GL process:

1. Select Transfer to GL in the Name field. If the Parameters window does not open automatically, click in the Parameters field.

2. In the Parameters window, select the payroll or consolidation set for which you are running the Transfer to GL process. If you select a payroll, the name of its consolidation set appears in the Consolidation Set field.

3. In the Start and End Date fields, enter the start and end dates of the period of time for which you want to see costing results. Choose Submit.
Elements are special information structures that Oracle HRMS uses to:

- represent the various types of compensation and benefits that make up your employees’ remuneration packages
- represent tangible items distributed to employees, such as uniforms or company cars
- maintain information on employee absences, and represent plans for accrual of paid time off
- build the earnings types, deductions, non-payroll payments and other items that the payroll run processes

This chapter discusses the creation and use of elements in Oracle HRMS.
Overview of Elements

Oracle HRMS products use specially designed data structures called *elements* to hold information about the items included in the remuneration packages available to your employees, and indeed about all the items your enterprise distributes to employees.

In **Oracle HR**, elements provide a versatile and efficient way to represent the following:

- compensation types, including earnings such as salary, wages and bonuses
- benefits such as employee stock purchase and pension plans, and benefit plans for health care coverage, such as medical or dental plans
- employee absences from work
- non-payroll payments such as expense reimbursements
- tangible items you provide to employees, such as tools, uniforms or computers.

In **Oracle Payroll**, elements constitute the underlying structures of all the items the payroll run processes, including the following:

- earnings, supplemental earnings and imputed earnings
• tax credits and non-payroll payments
• voluntary and involuntary deductions, as well as pre-tax and tax deductions
• employer taxes and other employer liabilities.

Features of Elements

Each element has a classification such as Earnings, Voluntary Deduction or Information that determines its particular use. It has input values into which you enter values that can feed into formulas which can, for example, prescribe payroll run calculations for the element. It has a processing type that controls whether it needs new entries in a payroll period to process in that period. Additionally, you supply other rules that determine whether, when and how the element can process, and to whom it can apply.

The remainder of this chapter provides all the basic information you need to understand the use of elements in Oracle HRMS.

The Structure of Elements

To meet the needs of all Oracle HRMS users, elements include the following structural features:

• **Classification and category.** Every element has a primary classification that determines whether it represents some type of earnings, deduction, payment, benefit or accrual plan, or holds information about tangible items such as company-provided uniforms or tools.

Elements representing benefits additionally have a benefits classification, to indicate the type of benefit they stand for.

Within many primary classifications there are subgroups called categories. Categories further define an element’s purpose, and can help to determine applicable processing or tax rules.

See: Element Classifications and Categories: page 12 – 8

• **Input values.** An element’s input values exist to receive entries of relevant data for the employees eligible for the element.

For example, the element Annual Salary would likely have an input value Amount, for entries of employees’ yearly salary amounts, while the element Wages would have the input value Hours Worked, for entry of employees’ hours worked each
period. The element Company Car could have the input values Make, Model, Year and Registration Number.

See: Element Input Values: page 12 – 16

• **Formulas.** In Oracle Payroll, entries to an element’s input values can feed into one or more *formulas* attached to the element, which prescribe calculations for the payroll run to perform. For example, entries of hours worked can feed into a formula that multiplies them by a wage rate, so the payroll run can produce employees’ wages.

See: Elements and Formulas: page 12 – 21

• **Processing types.** Every element has a *processing type*, to indicate the duration of its entries. An element’s entries for employees may last for one pay period only, such as entries from timecards of hours worked in a week, or entries of the amounts of a one-time bonus. In this case, the processing type is *nonrecurring*. Alternatively, an element’s entries may last through many pay periods until they are changed or ended. Examples are entries of annual salary, or of company car make and model. Elements with entries like this have the processing type *recurring*.

See: Element Processing Types: page 12 – 23

• **Other rules.** In addition to the above, elements can have a number of *rules* that determine a range of matters, such as:
  - whether the element can process in the payroll run
  - whether it can accept multiple entries in a pay period
  - whether employees must complete a specified length of service before receiving entries of the element.

---

**Creation of Elements: Definition or Initiation**

- when Oracle HRMS users manually *define* them
- when Oracle Payroll *generates* them in response to users’ *initiation* of earnings types, deductions, non-payroll payments made through payroll, or other items that process in payroll runs.

**Element Definition**

At Oracle HRMS installations either **with or without Oracle Payroll**, users define elements that do not process in the payroll run, but do
hold information on things like compensation and benefits, employees’ hours or days absent, and tangible items distributed to employees.

To define an element, use the Element window to perform these basic steps:

• selecting the element classification, and category, if any
• selecting the processing type, and the particular rules applicable to the element.
• setting up each input value the element requires.

See:
Defining an Element to Hold Information: page 12 – 32
Defining Benefit Plan Elements at Sites with HR Only (Oracle Human Resources North American User’s Guide)
Defining and Linking an Absence Element (Oracle Human Resources North American User’s Guide)

System Generation

In some circumstances the system generates elements, so that users do not need to define them. To set up a plan for employee accrual of PTO (paid time off), the system generates elements needed for plan administration, in response to entry of certain information about the plan.

At installations including Oracle Payroll, the system generates all the elements that process in the payroll run, in response to users’ initiation of the earnings, non-payroll payments and non-tax deductions their enterprise requires. On the basis of information entered in the Earnings or Deduction window, the system generates both the element and other essential components of an earnings, payment or deduction. Altogether, the generated components include:

• the element for the earnings, payment or deduction, with its necessary input values, processing type and rules, and balance feeds already in place
• a basic formula for the element, together with the formula processing rules.

If necessary, a generated element or formula can be modified to exactly meet user requirements.

Elements Included in Oracle HRMS

Users at Oracle HRMS installations without Oracle Payroll have two elements already generated for them, Regular Salary and Regular
Wages. These elements are available to use with the salary administration features of Oracle HRMS.

See: Setting Up Salary Administration (Oracle Human Resources North American Users’ Guide)

Installations with Oracle Payroll include not only Regular Salary and Regular Wages, but also Overtime, Shift Pay, GTL Imputed Income, and Company Car, as well as some basic deductions for garnishments, already generated and available for use.

Using Elements

Once an element exists, whether by definition or by generation, you prepare it for use by setting up links for it, to specify the eligibility rules that determine which employees in your database can receive entries of it. After its links are in place, you can make entries to the element’s input values for eligible employees.

Links for Eligibility Rules

While an element may occasionally represent a compensation type, benefit, piece of equipment or deduction available to every one of the employees in your enterprise, many of your elements are likely available only to certain groupings of employees. For example, a holiday bonus may be payable just to those employees who work full time. Or, your enterprise may provide company cars only to employees in the Sales Department.
To determine which employee groupings are eligible for an element, you build *links* to the assignment components employees must have to receive entries for the element. For example, the Holiday Bonus element can have a link to the employment category Full Time, or a Radiation Badge element, to the organization Operations Group. Links rule out the possibility of employees getting element entries by mistake.

See: Element Links and Employee Eligibility Rules: page 12 – 25

**Element Entries**

After an element is created and linked, its input values can receive entries for the employees eligible for it. Various ways to make these entries are available. You can manually enter input values for individual employees, or in certain cases set up automatic element entry for all eligible employees. Additionally, the payroll run can itself enter an indirect result of one element’s formula to an input value of another element.

For batch element entry, Oracle HRMS MIX (Mass Information Exchange) provides two facilities:

- the BEE facility, for elements that do not process in the payroll run
- the PayMIX facility, for elements the payroll run processes.

See: Element Entries for Eligible Employees: page 12 – 27
Element Classifications and Categories

Every element has a primary *classification*, to establish what it represents. Your Oracle HRMS installation includes a set of classifications developed in accordance with US legislative requirements. You cannot add or make changes to this classification set. The table below lists the US element classifications. There is no limit to the number of different elements you can have in any given classification, and no limit on the total number of elements you can use at an installation.

You see that most US classifications are subdivided into several *categories*. Categories go further than the classifications in determining a particular element’s function. They are also useful for determining how certain rules, such as tax rules, apply to elements within a classification.

See: Maintaining Taxability Rules: page 18–33

You can make your own additions to the list of available categories as you require.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earnings</td>
<td>Regular</td>
</tr>
<tr>
<td></td>
<td>Overtime</td>
</tr>
<tr>
<td></td>
<td>Shift Pay</td>
</tr>
<tr>
<td>Supplemental Earnings</td>
<td>Dismissal Payments</td>
</tr>
<tr>
<td></td>
<td>Educational Assistance</td>
</tr>
<tr>
<td></td>
<td>Deferred Compensation Plans</td>
</tr>
<tr>
<td></td>
<td>Jury Duty Pay</td>
</tr>
<tr>
<td></td>
<td>Moving Expense Reimbursement</td>
</tr>
<tr>
<td></td>
<td>Pensions/Annuities</td>
</tr>
<tr>
<td></td>
<td>Awards and Prizes</td>
</tr>
<tr>
<td></td>
<td>Bonuses</td>
</tr>
<tr>
<td></td>
<td>Commissions</td>
</tr>
<tr>
<td></td>
<td>Cafeteria Plans</td>
</tr>
<tr>
<td></td>
<td>Deceased Employee Wages</td>
</tr>
<tr>
<td>Classification</td>
<td>Categories</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Sick Pay</td>
<td></td>
</tr>
<tr>
<td>Travel Expense Reimbursement</td>
<td></td>
</tr>
<tr>
<td>Vacation Pay</td>
<td></td>
</tr>
<tr>
<td>Imputed Earnings</td>
<td>Group Term Life Insurance</td>
</tr>
<tr>
<td></td>
<td>Personal Use of Company Car</td>
</tr>
<tr>
<td></td>
<td>Non–cash Awards</td>
</tr>
<tr>
<td>PTO Accruals</td>
<td>Vacation</td>
</tr>
<tr>
<td></td>
<td>Sick</td>
</tr>
<tr>
<td>Voluntary Deductions</td>
<td></td>
</tr>
<tr>
<td>Involuntary Deductions</td>
<td>Garnishments</td>
</tr>
<tr>
<td></td>
<td>Bankruptcy Order</td>
</tr>
<tr>
<td></td>
<td>Federal Tax Levy</td>
</tr>
<tr>
<td></td>
<td>State Tax Levy</td>
</tr>
<tr>
<td></td>
<td>Local Tax Levy</td>
</tr>
<tr>
<td></td>
<td>Child Support Order</td>
</tr>
<tr>
<td></td>
<td>Spousal Support Order</td>
</tr>
<tr>
<td></td>
<td>Alimony</td>
</tr>
<tr>
<td></td>
<td>School Loan</td>
</tr>
<tr>
<td></td>
<td>Credit Debt</td>
</tr>
<tr>
<td></td>
<td>Employee–Requested Payment</td>
</tr>
<tr>
<td>Pre–Tax Deductions</td>
<td>Deferred Comp 401k</td>
</tr>
<tr>
<td></td>
<td>Health Care 125</td>
</tr>
<tr>
<td></td>
<td>Dependent Care 125</td>
</tr>
</tbody>
</table>
Table 12 – 1

Table of Element Classification and Categories

Survey of the Classifications

Each classification, and category within the classification, holds elements with a distinct function.

Earnings, Supplemental Earnings, Imputed Earnings

There are three classifications of earnings types: Earnings, Supplemental Earnings and Imputed Earnings.

Earnings classification elements represent earnings for time worked, as for example salary and hourly wages. The Supplemental Earnings classification includes a variety of special earnings paid in addition to earnings for time worked, as for example bonuses or sick pay.
Elements in the classification Imputed Earnings are for non-cash remuneration such as personal use of a company–provided car, or company–paid premiums for group term life insurance.

Paid Time Off (PTO) Accruals

Elements the system generates to represent plans for accrual of PTO for vacation or sick leave have the classification PTO Accruals, and the category of either Vacation or Sick. You use these elements to enroll employees in the accrual plans. The system also generates elements (with the classification Information) to hold accrued time that employees can carry over to the new year, and accrued time they cannot carry over.

See: Defining a PTO Accrual Plan (Oracle Human Resources North American User’s Guide)

For entry of amounts of accrued time employees take for vacation or sick leave, you define for each accrual plan an absence element with the classification Information.


Pre–Tax and After Tax Deductions

Elements for deductions taken before taxes, as for example deductions for 401(k) plans or for health care or dependent care reimbursement, fall into the classification Pre–Tax Deductions.

Other non–tax deduction elements fall into one of two classifications, either Voluntary Deductions or Involuntary Deductions. Loan repayments, credit union deductions, insurance premiums and charitable contributions are examples of voluntary deductions. Deductions for court–ordered wage attachments, as for example for tax levies, child or spousal support, or bankruptcy orders, fall into the classification Involuntary Deductions.

Non–Payroll Payments

Elements in this classification produce payments made to employees through the payroll system that are not true earnings. For example, the Expense Reimbursement category of this classification covers non–taxable expense reimbursements.

Because payments in this classification are not earnings, they are never subject to taxes and never feed balances of taxable pay. Payments
resulting from the processing of Non–Payroll Payments elements always appear separately from earnings in reports and balance totals.

Tax Deductions, Tax Credits, Employer Taxes

Deductions for employee tax withholding fall into the classification Tax Deductions. Oracle Payroll includes elements representing deductions for the following federal taxes:

- Federal Income Tax (FIT)
- Federal Unemployment Tax Act taxes (FUTA)
- Social Security (FICA–OASDI)
- Medicare (FICA–HI)

At the state level, Oracle Payroll includes elements representing deductions for:

- State Income Tax (SIT)
- State Unemployment Insurance (SUI)
- State Disability Insurance (SDI)
- Workers Compensation (WC).

At the local level, Oracle Payroll includes elements for:

- city tax
- county tax
- school district tax
- head tax.

Tax credits you pay to employees belong in the Tax Credits classification. These are, for example, payments of credits due in accordance with the Earned Income Credit (EIC) plan.

For employer payments for Social Security and Medicare, and for Workers Compensation, SUI and SDI, Oracle Payroll uses elements in the classification Employer Taxes.

Oracle Payroll comes with all the necessary elements and calculations for tax deductions, tax credits and employer taxes already in place. As tax information changes, you receive the necessary updates. Oracle has concluded an agreement with Vertex Inc. making Vertex the supplier of all tax calculations and updates for Oracle Payroll.

See: Tax Balances: page 18–5

Employer–paid Benefits and Employer Overhead

Elements producing non–tax payments employers make on behalf of their employees belong in the classification Employer Liabilities. The
category Benefits within this classification covers employer payments toward employee benefits such as health insurance or pension plans.

The category Overhead covers charges employers incur for employees apart from benefits payments. For example, an element in this classification can represent the cost of required employee safety equipment.

Information Elements

Many elements may not belong in any of the classifications described above, but nonetheless hold many different types of information you need. These elements belong in the classification Information.

This classification is especially useful for elements that do not process in Oracle Payroll. Such elements might, for example, hold information about tangible items issued to employees, such as cellular phones, identification badges or company cars. Sites that do not include Oracle Payroll use elements in this classification to hold information about employee compensation and benefits.

See: Defining an Element to Hold Information: page 12 – 32

Absence Category

Elements in the Absence Hours category of the Information classification hold hours of time that employees are absent from work.

Straight–time Overtime Hours Category

Elements in the Straight Time Portion of Overtime Pay category hold amounts of straight time pay needed in some states for the calculation of Workers Compensation premiums.

See: Data for Calculation of WC Premiums: page 20 –3

Tax Balance Figures

Elements in this category hold figures resulting from tax calculations. Oracle Payroll uses these figures to feed various tax balances that appear in inquiry windows and on reports.

See: Viewing Tax Balances: page 18 –44

Labor Hours and Regular Hours Categories

The category Labor Hours exists for the predefined element Labor Recording, used to receive entries of salaried employees’ hours worked on a project, when you require this information for transfer to a project accounting or labor distribution system.
The category Regular Hours exists for the predefined element Regular Hours Worked, which receives information on employees’ hours worked during the payroll run, for use in reports.

See: The Earnings Types Regular Salary and Regular Wages: page 15 –2

Classifications and Payroll Run Processing Priorities

An element’s primary classification provides a default processing priority for the element in payroll runs. The default priorities for the element classifications appear in the table below. Lower priority numbers process first.

You can overwrite an element’s default processing priority with another number, when you need to establish the order in which the element processes with respect to other elements. However, because of their special processing requirements, elements in the classifications Tax Deductions, Employer Taxes, and Tax Credits all have the same priority number, which you cannot change.

Sometimes you must prioritize the processing of certain elements for an individual employee. For example, you may need to determine the precise order in which deductions taken for wage attachments process for an employee. You can change the priority numbers of elements entered for an employee using the Entry Values window (accessible from the Element Entries window).

Table of Classification Priorities

<table>
<thead>
<tr>
<th>Classification</th>
<th>Priority</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>0 – 500</td>
<td>250</td>
</tr>
<tr>
<td>Non–payroll</td>
<td>501 – 1000</td>
<td>750</td>
</tr>
<tr>
<td>PTO Accruals</td>
<td>1001 – 1500</td>
<td>1250</td>
</tr>
<tr>
<td>Earnings</td>
<td>1501 – 2000</td>
<td>1750</td>
</tr>
<tr>
<td>Supplemental Earnings</td>
<td>2001 – 3000</td>
<td>2500</td>
</tr>
<tr>
<td>Imputed Earnings</td>
<td>3001 – 3500</td>
<td>3250</td>
</tr>
<tr>
<td>Pre–Tax Deductions</td>
<td>3501 – 4000</td>
<td>3750</td>
</tr>
<tr>
<td>Tax Deductions</td>
<td>(no range)</td>
<td>4250</td>
</tr>
<tr>
<td>Employer Taxes</td>
<td>(no range)</td>
<td>4250</td>
</tr>
<tr>
<td>Classification</td>
<td>Priority</td>
<td>Default</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------</td>
<td>---------</td>
</tr>
<tr>
<td>Tax Credits</td>
<td>(no range)</td>
<td>4250</td>
</tr>
<tr>
<td>Involuntary Deductions</td>
<td>5001 – 5500</td>
<td>5250</td>
</tr>
<tr>
<td>Voluntary Deductions</td>
<td>5501 – 6000</td>
<td>5750</td>
</tr>
<tr>
<td>Employer Liabilities</td>
<td>6001 – 7000</td>
<td>6500</td>
</tr>
</tbody>
</table>
Element Input Values

To hold information, elements can have as many as 15 different input values. The particular type of information an input value can accept is determined when it is set up. An input value can accept information with any one of these units of measure:

- alphabetic characters or words
- integers or numbers
- money
- hours and minutes
- date, day or time.

For example, an element to maintain information about company cars can have input values for entries of the car make, model and year, its registration state, the date of its issue to the employee, and its mileage when issued to an employee:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM–DD–YY</td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
</tr>
</tbody>
</table>

Example Car Element

Validation for Input Value Entries

To ensure that an input value does not receive incorrect entries, its setup can include one of these ways of validating its entries:

- entry of *minimum* and *maximum* values within which entries must fall
- provision of a *lookup*, that is, a list of values from which an entry must come
- provision of a *validation formula* that validates entries, written using Oracle FastFormula. For example, for entries of the
amount of a bonus, the formula could check amounts entered against each employee’s length of service and current salary.

For the Company Car element, you can establish validation for input values as in this example:

For the Government Car element, you can establish validation for input values as in this example:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM–DD–YY</td>
<td></td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
<td>Minimum/Maximum</td>
</tr>
</tbody>
</table>

Example Input Values Validation for Government Car Element

Example Input Values Validation for Company Car Element

Example Input Values Validation for Government Car Elements

Default Entries for Input Values

The setup of an input value can include entry of a default for the input value. For example, suppose that for most of the employees eligible for company cars, the make is Ford and the Registration State is Massachusetts.

On the Company Car element’s setup, you can enter defaults for its input values as follows:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
<td>Ford</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
<td>MA</td>
</tr>
</tbody>
</table>

Example Default Entries for Input Values
Elements come into being in one of two ways:
For individual employees, you can manually enter overrides to default input value entries.

Default Entries on Element Links

You can supply default entries for input values not only as a part of the basic element setup, but also as a part of setting up the element links that determine an element’s eligibility rules. This means you can enter different defaults for different employee groups.

For example, suppose two groups of employees are eligible for company cars, those on the Monthly payroll and those on the Executive payroll. While most Monthly payroll employees receive a Ford Escort, most executives receive a Ford Mustang. The element for Company Car with a link to the Monthly Payroll looks like this:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
<td>Ford</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
<td>Escort</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
<td>MA</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM-DD-YY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
<td>Minimum/Maximum</td>
<td></td>
</tr>
</tbody>
</table>

Whereas the link to the Monthly payroll includes the default entries shown above, the Company Car element with a link to the Executive Payroll includes these defaults:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
<td>Ford</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
<td>Mustang</td>
</tr>
<tr>
<td>Input Value</td>
<td>Unit of Measure</td>
<td>Validation</td>
<td>Default Entry</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------</td>
<td>------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
<td>MA</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM-DD-YY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
<td>Minimum/Maximum</td>
<td></td>
</tr>
</tbody>
</table>

Example Default Entries on Executive Payroll Link

You also enter costing information on a link. For example, if the company car costs for executives are chargeable to a different cost center than the car costs for the Monthly Payroll employees, you can enter the correct cost center on each link.

See Also

Making Changes to Links: page 12 – 40

Pay Values and Payroll Run Processing

When you have occasion to look at the structure of an element online, you may see an input value named Pay Value at the top of its input value listing. Although the Pay Value appears as an input value, it is different from other input values.

The essential purpose of the Pay Value is to store an element’s run result. For example, suppose the formula for the Wages element is:

\[
\text{Wages} = \text{Hours Worked} \times \text{Wage Rate}
\]

If an employee whose wage rate is $10/hour works 40 hours in a week, the payroll run produces a run result of $400 for him or her. It stores this result in the element’s Pay Value. After the run, you see 400.00 as the Pay Value for Wages.

However, if you give an entry to a Pay Value before a run, during the run this entry becomes the element’s run result. For example, suppose you enter 40 in the Time Worked input value of the Wages element for an employee who earns $10/hour, but also enter $100 in the element’s Pay Value. The run ignores the entry of hours worked and the Wages formula, and simply produces a run result of $100 for this employee.

Enterable and Non–Enterable Pay Values

Pay Values sometimes appear as the first input value for elements having the rule Process in Run, providing a place to store run results.
For some elements with the Process in Run rule the Pay Value may be enterable, so you can put in it a run result amount when the element has no formula, or when you do not want its formula to process.

However for generated elements, the Pay Value is usually not enterable. This is because Oracle Payroll provides other ways for you to supply run result amounts for these elements when formulas are unnecessary, or when you need to add to, subtract from or replace calculated run results.

See: Changes to Earnings or Deductions Before a Run: page 21 –4
Elements and Formulas

In Oracle Payroll, you can associate elements with formulas that specify how the payroll run should perform calculations for the element. For example, this is a basic formula for the calculation for the element Wages:

\[ \text{Wages} = \text{Hours Worked in Week} \times \text{Wage Rate} \]

To do their work, formulas must have data inputs. The simple wages formula above needs two inputs for each employee, the employee’s hours worked in the week, and his or her wage rate.

Formula Inputs from Input Values or Database Items

Formulas obtain some of the data they need from entries to their element’s input values. The Wages formula, for example, could locate each employee’s hours worked as an entry to the input value Hours of the Wages element.

As well as getting inputs from input values, formulas can obtain information from database items. These are information items held in the Oracle HRMS database in such a way that formulas can locate and use them. Much database information, including extensive information on employees and their assignments, is available in this form. For example, the Wages formula can locate each employee’s wage rate as a database item.

Oracle FastFormula

The tool for developing Oracle HRMS formulas is Oracle FastFormula. This is a sophisticated product capable of producing all the calculations payrolls require, as for example the calculation of shift differentials or complex overtime payments.

Conditional Logic

Formulas written using Oracle FastFormula can employ conditional logic, so they can produce different run results for different employees or employee groups depending on characteristics of the employees or groups. For example, a formula could determine employees’ pay rates by accessing the database items for their job class and length of service.

See: Oracle FastFormula User’s Guide
Formulas for Different Employee Statuses

An element can have several associated formulas, whose applicability depends on the particular status of an employee. For example, the earnings Salary can have a formula that processes for employees whose status is Active, and a different formula for employees with a status of On Leave who are not receiving their full pay. A formula’s processing rules determine the employee statuses for which the formula can process.

See: Defining Formula Processing and Result Rules: page 14–25

Types of Formula Results

Formulas can produce different types of run results. The direct result is the amount of an earnings or deduction, for example, the dollar amount of wages an employee has earned this week. As well as direct results, a formula can also produce indirect results, updates, and stops. The payroll run sends indirect results or updates as entries to the input values of other elements for their formulas to use. It sends stops to other elements to prevent their processing in the run.

Another type of formula result is a message. For example, you can write a formula that checks the length of a text string, and have it issue a message for payroll users if the string is too short or too long. You set up formula result rules to determine the type of each result, and the names and input values of any other elements the result may affect.

See: Defining Formula Processing and Result Rules: page 14–25

Formulas Included in Oracle Payroll Startup Data

Oracle Payroll comes with formulas already written for most types of earnings and deductions; you select the appropriate one when initiating a particular earnings or deduction.

The system also comes with the calculations for employee tax withholding and employer taxes already in place. When there are changes to taxes, you receive updates. You never need to write or modify tax formulas.

See: Earnings and Deductions Overview: page 14–2
Element Processing Types

Entries for some elements remain valid until you change them or they reach their end date. For example, if your employees usually get salary increases once a year, entries to the input value Amount of the element Annual Salary are usually good for a year. Entries to the input values Make and Model of the element Company Car remain valid as long as an employee has the same car.

Elements with entries that can remain valid over a number of pay periods, whether the periods are weekly, monthly, or some other length of time, have the processing type recurring.

For other elements, entries are good for one pay period only. These could be, for example, entries of regular hours worked in a period to the Hours Worked input value of the Wages element, or entries of overtime hours worked to the Hours Worked input value of the Overtime element. Entries to these elements should process once only, to produce employees’ wages or overtime pay for a period.

Elements with entries that are valid in one period only have the processing type nonrecurring.

All elements require a processing type of either recurring or nonrecurring.

Figure 12 – 3
Element Entry Validity Across Pay Periods

Frequency Rules for Recurring Deductions

In addition to a processing type, certain elements that process in payroll runs may require frequency rules. These rules are needed for
recurring deductions that should process at regular intervals, but not in every pay period.

For example, you may need to take a recurring deduction for medical insurance just once each month for employees on the Weekly payroll. In this case you give the deduction a frequency rule specifying for this payroll, which period in a month the recurring deduction element should process.

See: Deduction Frequency Rules: page 16–9
Element Links and Employee Eligibility Rules

Some elements representing earnings, deductions or benefits may be applicable to all your employees, but it is likely that many are available only to certain groupings of employees. To set eligibility rules for elements, you build element **links**. A link lists one or more assignment components that must be included in an employee’s assignment for him or her to be eligible for the element.

You can build several links for an element, but Oracle HRMS enforces the rule that you cannot build links making employees eligible for an element more than once. For example, if you link the Wages element to the Weekly payroll, the system stops you from building a second link for Wages to the Production Department, because this link would allow Production Department employees on the Weekly payroll to be eligible for Wages twice.

**Note:** During the installation of Oracle Payroll at your enterprise, creation of links to the Vertex tax elements and to the Workers Compensation elements occurs.

Eligibility Criteria

The assignment components to which you can link elements are:

- the employee’s **payroll**. If employees on all your payrolls are eligible for an element, you can link it to **all payrolls**.
- the employee’s **salary basis**, which establishes the period of time, often hours or months, for which you quote the employee’s salary or wages.
- the **employment category**, for example, Full Time–Regular or Part Time–Temporary.
- the **organization**, for example department or section, in which employees work.
- employees’ work **location**.
- the employee’s **job**, for example, Associate Professor or Secretary.
- his or her **grade**.
- one or more **groups** to which the employee belongs. You set up all the groups that are appropriate for your enterprise. For example, you could decide to group employees by company within a multi–company enterprise, and by union membership.
- employees’ **positions**. A position is a class of job performed in a particular organization, for example, Associate Professor of Chemistry, or Finance Department Secretary.
Default Input Value Entries and Costing Information on Links

When you build a link for an element, you can make entries of default values to the element’s input values, and you also enter costing information on the link. When necessary you can make changes to the input values or costing information of existing links.

See Also

Default Entries on Element Links: page 12 – 18
Making Changes to Links: page 12 – 40
Element Entries for Eligible Employees

An element’s links establish which employees it can apply to, but do not necessarily determine the employees it actually does apply to. For elements to actually apply to employees, they must receive entries to the element’s input values. Oracle HRMS includes several different ways to make element entries.

Manual Element Entry for Individual Employees

Oracle HR and Oracle Payroll users with access to an employee’s record can use the Element Entries window at any time to make entries to the input values of the elements for which this employee is eligible.

Entries made for elements with the processing type Nonrecurring are valid only for the pay period in which you enter them. Entries for elements with the processing type Recurring remain in effect until you change them, or until they reach their effective end date. To supply an end date for an entry, you delete the entry as of the end date.

See: Deleting Datetracked Information: page 1 – 15

For entry and maintenance of employees’ regular salaries or wage rates, you use the Oracle HRMS feature salary administration. You can enter both starting salaries or wages, and proposals for pay increases (or decreases) using the Salary Administration window. This window gives you the option of coordinating proposed pay changes with the results of performance reviews.

See:

Making Manual Element Entries: page 12 – 42
Salary Administration and Performance Reviews (Oracle Human Resources North American User’s Guide)

Automatic Entry of Elements and Default Values

For elements with the processing type of recurring, a special type of element link is available to both Oracle HR and Oracle Payroll users, the standard link. The standard link makes element entry automatic for all eligible employees. With this link, the element and all its default input value entries automatically go on record for all eligible employees now and in the future.

For recurring elements that should process for all eligible employees, and that have default input value entries applicable to all or almost all of these employees, standard links save time and help avoid errors.
Example Standard Link for HR Use

Suppose your enterprise has a policy of providing every salesperson with a company car, a Honda Accord. To maintain car information, your HR Department uses the element Company Car with a number of input values, among which are Make, Model, Year and Registration Number.

Suppose your enterprise has a policy of providing every eligible employee with a Ford Escort. To maintain car information, your HR Department uses the element Government Car with a number of input values, such as Make, Model, Year, and Registration Number.

You can make a link for Company Car to the job Salesperson, enter Honda and Accord as defaults for the input values Make and Model, and mark the link as Standard. With this link, the Company Car element and its default input value entries automatically go on record both for every employee currently assigned to the job Salesperson, and for every employee assigned this job in the future.

The Company Car element with a standard link to the job Salesperson looks like this:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Honda</td>
</tr>
<tr>
<td>Model</td>
<td>Accord</td>
</tr>
<tr>
<td>Year</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td></td>
</tr>
</tbody>
</table>

Example Standard HR Link

Example Standard Link for Payroll Use

Suppose your enterprise has an employee Sports Club, whose members all agree to pay $5 club dues each month by payroll deduction. You record participation in the Sports Club by setting it up as a kind of employee group, and including membership in this group in employees’ assignments.

After initiating a recurring voluntary deduction called Sports Club Dues, you can link the deduction element to the employee group Sports Club, mark this link as Standard, and make a default entry of $5.00 to the input value Amount. Because the link is Standard, the deduction with its default amount of $5 goes automatically on the records of all current and future club members.
The Sports Club Dues element with a standard link to the group Sports Club looks like this:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>$5.00</td>
</tr>
</tbody>
</table>

Example Standard Payroll Link

**Batch Element Entry Using MIX Facilities**

For a number of different purposes, you need a way to rapidly make entries to elements for many employees at once. Oracle HRMS MIX includes the **BEE** (Batch Element Entry) and **PayMIX** facilities for batch element entry. BEE is used for non-payroll element entries, for example, entries that serve to enroll employees in benefits or accrual plans. PayMIX is available for Oracle Payroll users for batch entry of:

- timecard data
- amounts for a nonrecurring earnings or deduction
- changes to existing entries of a recurring earnings or deduction.

PayMIX entries can include entry of information needed for the transfer of payroll costing information to the general ledger and to labor distribution systems.

Data typed into a BEE or PayMIX entry window goes to a special table. There you can validate it, make corrections, and validate again, before transferring the data to the HRMS database. After the transfer, you can see the entries in the HRMS database using Element Entries window.

**See Also**

MIX Facilities for Batch Element Entries: page 13 – 50

**Entry as an Indirect Result of Payroll Processing**

For nonrecurring elements that process in the payroll run, input value entry can occur during processing. When payroll runs, these elements can receive entries to their input values as *indirect results* of the processing of other elements.

For example, when the payroll run processes the formula for the earnings types Regular Salary, it sends entries of an employee’s hours.
worked in a period to the element Regular Hours Worked as an indirect result.

Then when the report processes for the statement of earnings and the Earnings Audit run, they can go to the Regular Hours Worked element to find employees’ regular hours worked each period.

You mark formula results as indirect, and specify the element input value to which an indirect result should go, using the Formula Result Rules window.

See Also

Formula Results: page 12 – 22
Regular Salary and Regular Wages: page 15 – 2
Element Definition

The types of element definition you do depends to some extent on the nature of your Oracle HRMS installation.

Installations without Oracle Payroll

Users at these installations use the Element window to define all the elements they need to hold information on the following:

- employee compensation and benefits
- medical, dental and vision benefit plans
- employee absences
- tangible items distributed to employees, such as tools or uniforms.

At these installations, users obviously have no need for elements for Oracle Payroll to process in payroll runs.

Installations including Oracle Payroll

Users at these sites similarly define elements to hold information on employee absences and on tangible items distributed to employees. However these sites also use elements that process in the payroll run to represent:

- compensation types
- non–payroll payments such as reimbursements
- benefits toward whose cost employees and employers may contribute
- other employee deductions and employer liabilities.

The system generates these elements, together with the necessary balances, formulas, and formula result rules, when users initiate earnings, other payments and deductions using the Earnings or Deduction window.

See Also

Definition of Benefit Elements at Sites with HR Only *(Oracle Human Resources North American User’s Guide)*

Defining an Element to Hold Information

Use the procedure below to define most elements that hold information but do not process in payroll runs.

**Note:** To define information elements for health care benefit plans (elements with the benefit classification Medical, Dental or Vision), or elements for absence types, use different procedures.

See:

Definition of Benefit Elements at Sites with HR Only (*Oracle Human Resources North American User’s Guide*)


To define an element, use the Element window.

**Attention:** The version of the Element window you see depends on your HR User Type profile option. With the profile option HR User, you see and access only those fields needed to define elements that hold information or represent benefit plans or absence types. With the profile options Payroll User and HR with Payroll User, you see and access all available fields.

**Prerequisites**

- Decide what validation you need for entries to the element’s input values.
  - To restrict entries to a list of valid values, use the QuickCode Types window to define a new lookup. Then enter the valid values for this lookup in the QuickCodes window.
  - To validate values using formulas, write the validation formulas using the Formulas window.
    
    See: *Oracle FastFormula User’s Guide*

- If you need a new category within the Information classification for this element, add it in the QuickCodes window for the QuickCode type US_INFORMATION.
  
  See: Information Elements: page 12 – 13

- If this element represents a benefit for which you want to enter a carrier, set up the carrier as an external organization with the classification Benefits Carrier.
  
  See: Creating an Organization: page 2 – 20
Identifying the Information Element and its Processing Rules

To identify and classify the element:

1. Set the effective date early enough for any historical element entries.

2. Enter a unique name starting with a letter of the alphabet (not a number or symbol). You can optionally enter a reporting name and description. The reporting name is a short name that appears on reports.

3. Select Information as the primary classification for the element. Also select a benefits classification if this element represents a benefit other than a medical, dental or vision benefit plan.


To enter processing information:

   Note: The rule Additional Entry Allowed has no applicability for US installations. It is available for use at non-US sites.

1. Select Recurring as the processing type, so that entries to this element’s input values will remain in effect until you end them. If you select Nonrecurring, entries to the element are effective only for the pay period in which you make them.
2. Select Actual Termination as the termination rule.
3. For the element to receive more than one entry at the same time, check the Multiple Entries Allowed box.
4. If at some time you need to prevent the element from accepting any new entries, either temporarily or permanently, check the Closed for Entry box. This does not affect any existing element entries.

**To establish currencies and qualifying conditions:**
1. The Input and Output Currencies appear as USD (US dollars) and you cannot change these defaults.
2. If there is a minimum age for employees to receive the element, enter it in the Age field.
3. If employees must complete a minimum length of service before receiving the element, enter a number in the Length of Service field and select a unit of measure (such as months or years) in the Units field.
4. For the system to automatically enter the element and its default values for all eligible employees, check the Standard box.
   
   See: Automatic Entry of Default Values: page 12 – 27
5. Save the element definition.

**To enter a category and benefits carrier**
1. Click in the Further Information field to open the Further Element Information window. In the Category field, select a category.
2. For an element representing a benefit that does not have the benefit classification Medical, Dental or Vision, you can select a benefits carrier in the Benefits Carrier field.
3. Complete the definition of the element by setting up its input values.
Establishing the Information Element’s Input Values

To set up input values for the element:
1. Enter a name for the input value and select a unit of measure for it (money, hours, character, date, number or time).
2. You can enter number in the Sequence field to designate the order in which the Element Entries window displays the input values.
3. If the input value must have an entry, check the Required box.

To enter an element–level default for an input value:
1. Make the entry in the Default field.
2. For automatic update of existing entries of a default whenever you change the default, check the Hot Default box. Hot defaults appear in the Element Entries window in quotation marks.

Warning: If you override a hot default appearing as an entry for an employee, any further changes to the element’s default value do not affect this entry. For this reason, it is best to make changes to a default value for large groups of employees using a MIX batch entry facility rather than the hot default feature.

To establish validation for input value entries:
1. Choose one of these approaches:
   • Enter maximum and minimum values for the entry
   • Select a QuickCode Type to act as a lookup for an input value whose type is Character
   • Select a formula to validate entries. Formulas can return messages about the success or failure of the validation.
2. Choose Warning for the system to warn of an invalid entry, or Error if it should not save a valid entry. You cannot select Warning or Error when using a lookup for validation, because in this case an invalid entry is impossible.

3. Choose Done when you are finished. Your definition of an element to hold information is complete.

Deleting an Element Entry

Perform this task from the Element Entries window.

To delete an element entry:
1. Query the element entry in the Element Entries window.
2. Select Delete Record.
3. Select the Save icon to save this change.

Deleting an Element

Before you delete an element, you must ensure that no employees have the element in their record and that no links to the element exist in the Link window. If either of these conditions exist, you must first delete the element entry and the element link before you can delete the element itself.

See Also:
Deleting an Element Link: page 12 – 41
Deleting an Element Entry: page 12 – 36

Once there are no links or element entries you can delete an element. Use the following process to delete an element that was defined in any of the following windows:

- Element Description window,
- Earnings window
- Deduction window

To delete an element:
1. Query the element in the appropriate window.
2. Select Delete Record.

   The system prompts you to either End Date the element or Purge it.

   **Note:** Select End Date if you want the element to remain in the system but be effective through a certain date. Select Purge if you made a mistake defining the element and you want to delete it from the system altogether.

3. Select Save to save this change.
Defining Element Links

To determine the groups of employees eligible for an element, you define links for the element in the Element Link window.

Prerequisite

- If the link should have Distributed as its costable type, define the set of earnings types (the distribution set) over which the system should distribute the element’s payroll costs.

  See: Costing Information at the Element Link Level: page 11 – 7

To define an element link:

1. In the Element Name field, select the element for which you are defining a link.

2. Check the Standard box only if you want automatic entry of the element and its default entries for all eligible employees. Standard links are possible for recurring elements that do not have the rule Multiple Entries Allowed.

3. In the Eligibility Criteria region, select the assignment components that constitute this eligibility rule.

   You can link to all payrolls or to a specific payroll:

   - Leave the Payroll field blank and check the Link to all Payrolls box if you want employees assigned to any payroll to be eligible. This rule excludes employees with no payroll assignment.
• Select the name of a specific payroll to make employees assigned to that payroll eligible for the element.

Costing Information

▲ To enter costing information for the link:

1. Select the Costable Type. The default is Not Costed, meaning that the system maintains no costing information for the element.
   • To allow entry of costing information for this element at all levels, including the assignment and element entry levels, select Costed. This is the appropriate selection for most elements representing earnings types.
   • To allow entry of costing information for this element at the payroll, element link and organization levels only, select Fixed Costed. This is the appropriate selection for most elements representing deductions.
   • Select Distributed to have the element’s costs distributed proportionally over a specified set of earnings types. This Payroll User and HR with Payroll Use selection is appropriate for elements representing various types of employer charges and liabilities. For a link with the costable type Distributed, select the distribution set in the Distribution Set field.

See: Costing Information at the Element Link Level: page 11 – 7

2. If the payroll run results from this link should be transferred to the general ledger, check the Transfer to GL box.

3. In the Costing field, select a GL account code and if present, account codes of labor distribution or other systems in which to collect the run results of this element.

   Use the Balancing field to select the code for the GL account that balances the GL account selected in the Costing field.

   To select costing and balancing GL accounts for an element in the classification Pre–Tax Deduction, Voluntary Deduction or Involuntary Deduction:
   • Select the code for the GL account to credit in the Costing field, and the code for the account to debit in the Balancing field.

   To select costing and balancing GL accounts for elements in all other classifications:
   • Select the code for the GL account code to debit in the Costing field, and the code for the account to credit in the Balancing field.
Qualifying Conditions

To enter qualifying conditions for the link:
- Go to the Qualifying Conditions alternative region. Here you can add or change age or length of service requirements for this particular eligibility rule.

Link Level Changes to Input Values

Use the Link Input Values window.
You can:
- enter a new default or change one entered at the element level
- check the Costed box to maintain costing information for an input value
- change the maximum, minimum or both for an input value.
   Logically, the new values should be within the range you defined for the element as a whole. However the system does not enforce this.

Reviewing Element Links

The Element Link Details Report is available for reviewing element links. To obtain the report you select an element classification, and can further select only recurring or nonrecurring elements in the classification, or just a single element. You can choose whether to see only standard or non–standard links, and only active or inactive links. Further, you can choose whether to see links for payrolls or a job or organization.
Run reports from the Run Requests window.

To obtain the Element Link Details Report:
1. In the Name field, select Element Link Details Report. The parameters window opens.
2. Enter the effective date for the report.
3. Select the element classification to report on. Optionally, select an element processing type (recurring or nonrecurring) or an individual element to report on.
4. To report only on standard links, select Yes in the Standard Link field. Select No to report only on non–standard links. Leave blank to report on all links.
5. Select a link status to report only on links that are either active or inactive as of the report’s effective date.

6. To report on links to payrolls:
   - For links to one payroll only, select No in the All Payrolls field and select the payroll in the Payroll field.
   - For links to all payrolls, select Yes in the All Payrolls field and leave the Payroll field blank.
   - To see links irrespective of their payroll criteria, select No in the All Payrolls field and leave the Payroll field blank.

7. To report on links to a particular job or organization, select the job or organization.

8. Choose the Submit button.

Deleting an Element Link

Perform this task from the Element Link window.

► To delete an element link:
   1. Query the element link in the Element Link window.
   2. Select Delete Record.
   3. Select the Save icon to save this change.
Making Manual Element Entries

You use the Element Entries window to make and review manual entries to element input values for individual employees.

Customizing the Element Entries Window

Your system administrator can create customized versions of the Element Entries window to restrict the elements that particular users can enter. Reducing the elements available for entry in this window enhances speed, usability, and security for specific data entry scenarios.

You can restrict element entry by:

- element set (a group of elements that you define)
- element type (recurring or nonrecurring)
- element classification.

Your system administrator can include several versions of the Element Entries window in your menus.

See: Restricting the Data Displayed in a Window: page 27 – 3
Completing or Inquiring on Entries

To manually enter elements for an employee, and to inquire on existing entries, use the Element Entries window.

▶ To inquire on an element entry:
- You can use the Period field, Classification field, and Processing Types option buttons to view the entries for the employee in any one pay period.

▶ To enter an element for an employee:
1. If necessary, change your effective date to the correct date for making the element entry.
   If the pay period is closed at your effective date, you cannot make any nonrecurring entries of elements that process in payroll runs.
2. To reduce the list of element to choose from, select a classification, a processing type, or both in the first region.
3. In the Element Name field, select an element.
   Note: Elements this employee is eligible for by means of a standard link appear automatically.
   The system displays a warning message if the employee fails to meet any qualifying conditions for the element of age or length of service.
4. If the Costing field is enterable, you can enter cost codes, for example to indicate the cost center the employee's time should be charged to.
   See: Costing Information at the Element Entry Level: page 11 – 10
5. You can select a reason for an element entry you make or update. As part of your system setup, you can enter valid reasons for the QuickCode Type ELE_ENTRY_REASON.
   Note: There is no use for the Override, Additional, or Show Adjustment check boxes at US installations.
6. Choose the Entry Values button to open the Entry Values window.
7. Make entries in the Entry Value fields. Notice that:
   • some fields may not be enterable.
   • Some fields may be required.
   • Some fields may have a list of values; others may be validated as you leave the field. You receive a message if your entry is not valid.
• Some fields may contain default values. If the default value is in quotation marks, it is a "hot default".

**Attention:** You should consider carefully before overriding a hot default. If you override it, then any subsequent changes to the default value on the element or element link definition will **not** affect this element entry.

8. To establish an earned date for an earnings element that is outside of the current payroll period, make a selection in the Date Earned field.

9. To enter information about a third party recipient of a payment resulting from a deduction element, select in the Payee Details field, the name of the third party payment method set up for this payment.

   See: Defining Payment Methods for the Enterprise: page 5 – 3

10. To change the default processing priority of this element in the payroll run, enter a new priority number in the Processing Priority field. Lower priority numbers process first.

**See Also**

Reviewing Element Entries: page 12 – 45
Reviewing Element Entries

In the View Element Entry History window, you can see a history of entries for an employee, and in the List Employees by Element window, you can see a list of employees receiving entries to an element in a time period you set.

You can use the Element Entries window to review existing entries for an employee in a specified pay period.

Viewing Element Entry History

In the View Element Entry History window you can see a history of entries for an employee for:

- one element
- all recurring elements, all nonrecurring elements, or both
- elements from a selected classification

▶ To view element entry history for an employee:

1. Enter your selection criteria. You can:
   - Select a classification.
• Select a processing type.
• Enter a date range. The end date defaults to your effective date.

2. Run the query.

The window displays all entries of the types of element you selected within the time period, including datetracked updates to entries. New entries are shown in bold to contrast with datetracked updates, which are listed under the initial entry.

3. Select an entry and choose the Entry Values button to view the entry values.

Listing Employees by Element

In the List Employees by Element window, you can view a list of the employees with entries to an element in any period of time you choose. You can also see the last entry value for each assignment.

To view a list of employees receiving an element:

1. Select an element.
2. Select Current Employees, Ex-employees, or both.
3. You can also enter a date range. Both date fields default to your effective date.
4. You can enter additional query criteria in the Element Entries region.

5. Run the query.

The Element Entries region displays all entries of the element for employees of the type you selected in the chosen time period.

**Note:** This window does not display datetracked updates to recurring element entries. You only see the *latest* value (within your chosen time period) of each element entry. The date of the last datetracked update may vary from employee to employee.
For batch entry of information held in element input values or elsewhere on elements, Oracle HRMS MIX (Mass Information Exchange) provides special facilities. Using BEE (Batch Element Entry) for elements that do not process in payroll runs, or PayMIX for elements that do process in runs, users can:

- rapidly enter batches of information for entry to elements into a temporary table
- validate, correct, and update the information in this table
- transfer validated information from this table to elements in the HRMS database.

This chapter explains how to use BEE and PayMIX for batch element entry.
MIX Facilities for Batch Element Entry

At many enterprises, Oracle Payroll users must make batch element entries in each payroll period, in order to:

- **record timecard data** needed for regular pay processing, such as hours worked, location or shift worked, and costing or labor distribution data
- **enter special nonrecurring earnings or deductions** to be processed in the period
- **enter one–time changes** to recurring earnings or deductions.

For batch element entry in Oracle Payroll, Oracle HRMS MIX includes the **PayMIX** facility.

Non–payroll users of Oracle HRMS may also require the ability to make element entries in batch mode, as for example:

- **staff responsible for absence management**, who must make entries to elements representing absence types to record employees’ hours or days absent
- **benefits administrators**, who must make entries to elements representing benefits, such as stock purchase plans, 401(k) plans and health care plans, in order to enroll employees in these benefits
- **salary administrators** at installations without Oracle Payroll, who must make entries to elements representing salary, bonuses, commissions, and other types of earnings to maintain information about employee compensation.

For non–payroll users, MIX includes the **BEE** (Batch Element Entry) facility.

See Also

Making Non–Payroll Batch Entries Using BEE: page 13 – 51
PayMIX for Payroll Batch Entry: page 13 – 60
Making Non–Payroll Batch Entries Using BEE

For element entries that record absence information, enroll employees in benefits, maintain compensation information, or perform other non–payroll functions, you use the Batch Header and Batch Lines windows of BEE.

Information batches entered using BEE can include as many elements and assignments as necessary. To speed entry, you can supply defaults for any value, changing defaults as necessary when working through a batch. Use the Batch Lines window to choose the input values to display.

Validation of Batch Entries

To validate a batch after saving it, you run the BEE validation process from the Batch Header window. This process checks the header and each line of the batch. For example, it checks that each assignment number exists in the database, and that you have specified values for all required input values.

You can add your own validation procedures to the standard process. For example, you can set up control types, such as record counts, and write a validation procedure to check that the batch matches the control totals you enter for each type. You can also add any business validation you require, for example to check that amounts entered for a bonus do not exceed a maximum, or that an assignment’s paid time off entitlement is sufficient to cover time taken.

When the batch is ready for transfer to the database, you run the BEE transfer process from the Batch Header window. This process first performs the same checks as the validation process. If it finds no errors, it transfers the element entries from the temporary tables to the Entries table in Oracle HRMS.

You can choose whether the transfer process automatically purges the entries from the temporary tables after transfer. You can also run a separate purge process.

Batch Statuses

The Batch Status depends on the status of the batch header, all the batch lines, and any control totals specified for the batch. On the Batch Header window, you can see the following status values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid</td>
<td>All of the lines, control totals, and header are valid.</td>
</tr>
</tbody>
</table>
Creating and Updating Batches of Element Entries

You can enter batches of element entries in the Batch Header and Batch Lines windows.

**Prerequisites**

- You can create additional validation procedures for checking the batch header and lines, and for validating the batch against control totals.
- If you want to use control totals to validate the batch, enter values for the QuickCode Type CONTROL_TYPE.

**Entering a Batch Header**

The header identifies the batch and determines what happens if any of the batch lines duplicate existing element entries.

---

**Transferred**

All of the lines, control totals, and header have been transferred.

**Unprocessed**

At least one line, control total, or the header is unprocessed.

**Error**

At least one line, control total, or the header is in error.

**Status Mismatch**

The combination of statuses in the header, lines, and batch is not consistent. For example, it is inconsistent for some, but not all, of the lines to have the status Transferred.

**Note:** A status mismatch is not possible if you always use the Batch Header and Batch Lines windows to enter and maintain a batch.
To enter a batch header and control totals:

1. Set your effective date to the date when you want the entries to take effect.

2. Enter a name for the batch, and enter a reference number and the source of the batch, if you require these for your own reference.

3. Select what action the process should take if one of the batch lines matches an existing element entry for an assignment at the effective date.
   - Create New Entry – The process creates a new entry if multiple entries of the element are allowed by the element definition. If multiple entries are not allowed, the process sets the status of the batch line to Error.
   - Reject Entry – The process sets the status of the batch line to Error.
   - Change Existing Entry – The process corrects or updates the existing entry. If there is more than one existing entry, the process sets the status of the batch line to Error.

   The Undefined option is display-only (for batches created using SQL*Plus or a similar tool).

4. If you selected Change Existing Entry, select the type of date effective change to be made to recurring entries:
   - Update – The process changes the existing entry from the effective date, but preserves the previous information. If there are future-dated changes to the existing entry, the process inserts the change before the next scheduled change.
• Correct – The process corrects the existing entry from its start date through to its end date. Any future-dated changes are unaffected.

• Override – The process changes the existing entry from the effective date, but preserves the previous information. If there are future-dated changes to the existing entry, the process replaces all future-dated changes with the batch line.

Notice that if you select this option, you cannot check the Reject if Future Changes check box.

The Undefined option is display-only (for batches created using SQL*Plus or a similar tool).

5. If you want to reject batch lines that match entries that start in the future or for which future changes are scheduled, check the Reject if Future Changes check box.

Notice that if you check this box, you cannot select the Override option.

6. If you want the batch to be purged from the temporary tables after successful transfer to Oracle HRMS, check the Purge After Transfer check box.

7. If you have set up control types to validate the batch before transfer, choose the Totals button. Select a batch control type and enter the total for the batch. You can enter as many types and totals as you require.

**Entering Batch Lines**

A batch line is one element entry for an assignment.

Use the Create Batch Lines window to create identical lines for all assignments identified by an assignment set. This is a quick way to create many lines for an element. If the input values need to vary between assignments, you can leave these blank and add them later using the Batch Lines window.

In the Batch Lines window, you can enter new lines for individual assignments, and you can view and edit lines created automatically for an assignment set. You can speed up entry of new lines by entering default input values.

**Note:** A batch can contain lines for as many elements as you require. Lines within a batch can have different effective dates.

To navigate to these windows, first create and save a batch header in the Batch Header window. Then choose the Create Lines button (for
the Create Batch Lines window) or the Lines button (for the Batch Lines window).

**To enter batch lines for an assignment set:**

1. Select the assignment set and payroll which identify the employees you want to create lines for.
2. Select the element for the batch lines and enter input values as appropriate.
3. Change the effective date if required.
4. Choose the Process button to submit a concurrent process called Create Batches. Confirm that you want the system to create the lines.

   The Batch Lines window now closes, taking you back to the Batch Header window.
5. Choose the Create Lines button again if you want to add lines for another element. Requery your batch and choose the Lines button if you want to view and edit the lines created by the process.

**To enter batch lines manually:**

1. Choose the Lines button.
2. Select the element for which you want to make entries.
3. To enter default values to speed up the data entry, choose the Defaults button. The Defaults window displays the input values for the selected element.

4. Enter default values in any of the fields in the Defaults window. These defaults apply to all new entries in the batch, but not to any entries you have already made. You can change the defaults at any time during your data entry.

5. Uncheck the Display check box for any field that you do not want to display in the Lines window. You might want to hide any fields for which the default is correct for every entry.

6. In the Lines window, enter the data required for the batch. Lists of values are available on some fields, but no validation is enforced during data entry.

   You can override the Effective Date for any line. This is the effective start date for a new entry or the effective date of an update.

7. Save your entries. If you want to make entries for another element, select the element, enter new defaults, enter the lines, then save again.

Retrieving Existing Batch Lines

Use the Batch Lines window to view existing batch lines.

► To retrieve existing batch lines:

1. Do one of the following:
   • Select the element in the Element field.
   • Check the Unknown Elements check box if you are querying batch lines entered for an invalid element (or no element) by SQL*Plus or another tool.

2. Choose the Find button.

Updating a Batch

You can update a batch at any time before you transfer it. If you make any changes to a batch with the status Validated or Error, the batch status changes to Unprocessed.

Validating a BEE Batch

You can validate a batch with the status Unprocessed, Error, or Valid. The validation process tests each batch line against certain predefined...
rules about element entries, and also against your own rules if you have created additional validation procedures.

▶ To validate a batch:

1. Query the batch in the Batch Header window, and choose the Process button.
2. Select Validate, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.
3. When the concurrent request is completed, query the batch in the Batch Header window.
   If the Batch Status is Valid, the validation was successful. If the Batch Status is Error, at least one line, control total, or the header is in error.
4. To view the status of individual lines in the batch, choose the Lines button. In the Batch Lines window, select an element and choose Find.
5. If you entered control totals for the batch, choose the Totals button on the Batch Header window to view the status for each control type.
6. To view messages for the whole batch, or all lines, or control totals, choose the Messages button. Use the option group at the top of the Messages window to control which messages are displayed.

Transferring a BEE Batch

A batch exists in the temporary BEE tables only until you run the transfer process to create element entries in the Oracle HRMS Entries table.

▶ To transfer a batch:

1. Query the batch in the Batch Header window, and choose the Process button.
2. Select Transfer, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.
3. When the concurrent request is completed, query the batch in the Batch Header window.
If the Batch Status is Transferred, there were no errors in the batch and the process has created the element entries. The process may have issued messages associated with the batch header, lines, or control totals.

If the Batch Status is Error, the process has set the status of at least one line, or control total to Error. Check the status fields in the Batch Lines window and the Control Totals window, and review the messages issued by the process.

---

**Purging a Batch From the BEE Tables**

If the Purge After Transfer check box on the Batch Header window is checked when you run the transfer process, the batch is deleted from the MIX tables automatically after the transfer. If the box is not checked, you can purge the batch by running a separate process.

You can purge a batch with any status.

► **To purge a batch:**

1. Query the batch in the Batch Header window, and choose the Process button.
2. Select Purge, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window. When the concurrent request is completed, the batch is purged.

---

**Rolling Back a MIX Process**

You can roll back a MIX process if you want to completely remove it after it successfully completes. You have a choice of deleting the batch header as well or of keeping the header after the rollback.

The process interlock rule (which prevents you rolling back a payroll process if any further processing has taken place) does not apply to MIX Rollback. You can still perform the rollback even if run results from payroll processing exist for any of the lines.

You run the MIX Rollback process from the Submit Requests window.

► **To roll back a MIX process:**

1. Select the batch header name of the process you want to roll back.
2. Enter Yes to cancel the rollback process if the system detects run results for any of the batch lines. Enter No if you want the system to complete the rollback even though run results exist.

3. Enter Yes to keep the batch after the rollback. Enter No to delete the batch after the rollback.
PayMIX for Payroll Batch Entry

Oracle Payroll’s PayMIX facility provides for rapid entry of these types of data batches:

- timecard data showing hours worked, and possibly other information, for a period
- data for a one–time earnings or deduction entry or change

A unique number identifies each separate batch of data you enter. This number increments automatically.

Heads Down Data Entry

To facilitate rapid data entry, PayMIX lets you provide as many defaults as possible each information batch. Defaults appear as entries for every line in the batch entry window. You can overwrite them when necessary. For example, if the hours worked entered on most of the timecards in a batch is 40, you can enter a default of 40 for Hours.

Another way that PayMIX supports rapid data entry is by deferring all validation until entry is complete. After saving a batch you can both check it against batch totals, and run a validation process for it.

Balancing to Batch Totals

Your enterprise may check data totals and line counts for a batch against externally determined totals and counts. For example, you may know that the total of hours entered on a batch of timecards is 500, or that the total of amounts entered for a bonus is $35,000. You can supply user totals and line counts for a batch when you identify it.

The system displays batch totals and counts when you save a batch, together with any discrepancies to the user totals and counts. You can then make and save changes to line information. PayMIX automatically adjusts its system–generated totals and counts.

Validating Batch Entries

After saving an information batch in PayMIX, you launch a validation process to check whether the entries are correct, and mark any that are in error. For each batch line, this process verifies that:

- there are no outstanding discrepancies between external and system–generated totals
- the employee’s assignment number exists in the database
• an element exists to receive the data entered through PayMIX
• the employee has not already received for this period, an earnings being entered through PayMIX
• for values entered as overrides, that other values exist to be overridden.

Note: It is not difficult add steps to, or remove steps from, this basic validation process. Its program consists of a series of statements written in PL/SQL that follow clear coding standards. Your MIS staff can insert new statements or remove statements as necessary.

See Also

Completing Batch Element Entries Using PayMIX: page 13 – 69
PayMIX Timecard Entries

Each batch line entered from timecards has an entry of:

- an employee’s assignment number
- the number of hours
- the type of hours being entered. This entry determines the element to which the line’s entries go. The element must be nonrecurring, have an input value Hours, and be marked to accept PayMIX entries.

For example, to process the predefined earnings Regular Wages for employees, you can make entries through PayMIX to the Time Entry Wages element. To track accounting and labor distribution information for employees receiving Regular Salary, you make entries to the element Labor Recording. You can also use PayMIX to enter absence elements set up to record the use of sick or vacation time accrued under a PTO accrual plan.

See:
The Earnings Types Regular Salary and Regular Wages: page 15 –2

Additional Timecard Information

PayMIX can also accept entry of extra timecard data employees supply to ensure correct calculation of pay and taxes, or accurate recording of labor distribution and cost center information.

<table>
<thead>
<tr>
<th>Field in Time Entry Windows</th>
<th>Entry Goes To</th>
</tr>
</thead>
</table>
| Labor Distribution Code     | Cost Allocation key flexfield, segment for labor distribution codes.  
                                  See: Use of the Cost Allocation Key Flexfield: page 11 – 5 |
| Rate Code                   | Input value Rate Code (as on the earnings Time Entry Wages, Overtime, Shift Pay). A rate code entry gives the element’s formula a code by which to locate a rate in the Wage Rates table.  
| Hourly Rate                 | Input value Rate (as on Time Entry Wages, Overtime, Shift Pay). Entry of a rate overrides an existing rate code entry. |
| Shift                       | Input value Shift (as on Time Entry Wages, Labor Recording, Shift Pay) for locating shift differential in the Shift Differentials table, if no entry exists for Rate or Rate Code. |

Table 13 – 1 Additional Information for PayMIX Time Entry
### Table 13 – 1 Additional Information for PayMIX Time Entry

<table>
<thead>
<tr>
<th>Field in Time Entry Windows</th>
<th>Entry Goes To</th>
</tr>
</thead>
</table>
| **Amount**                  | Pay Value of Time Entry Wages element, which feeds it directly into the Regular Pay balance for the employee. Useful for paying someone a fixed dollar amount regardless of time worked.  
  See: Pay Values and Payroll Run Processing: page 12 – 19 |
| **Multiple**                | Input value Multiple (as on Overtime). An entry here gives the element’s formula a rate or other multiple. |
| **Separate Check**          | Input value Separate Check (on all earnings). Check this box for payment of this earnings type by separate check.  
  See: Input Value for Payments by Separate Check: page 15 – 22 |
| **Tax Rule**                | Input value Deduction Processing (on all earnings). Possible entries are *Tax and Pretax Only* or *Tax Only*.  
  See: Input Values to Control Deduction Processing: page 15 – 23 |
| **Location**                | The table of jurisdiction codes, and sends the correct code for the location to the input value Jurisdiction (as on Time Entry Wages, Overtime, Shift Pay). An entry here overrides the jurisdiction code of the employee’s regular work location. |
| **Cost Center Code**        | Cost Allocation key flexfield, segment for cost center codes.  
  See: Use of the Cost Allocation Key Flexfield: page 11 – 5 |
| **From**                    | The beginning date of the pay period for the time card entry. |
| **To**                      | Input value Date Earned (as on Time Entry Wages, Overtime, Shift Pay). This should be in the same pay period as indicated in the From field. |

### Dates of Time Entry Batch Lines

Timecard entries of a *To* date (or *From* and *To* dates) signal that the card’s information is for a period other than the current one. When you enter a To date in a PayMIX Time Entry batch line, the system gives this line the end date of the period in which the Date Earned falls. For lines with no Date Earned entry, the system supplies one when you run the Validation or Transfer process. The date supplied is the end date of the period in which the effective date of the Validation or Transfer process falls.
One–Time Batch Entries for Earnings and Deductions

Using the PayMIX Earnings Entry and Deductions Entry windows, you can make new entries for nonrecurring earnings and deductions, or entries to change the run results of recurring earnings and deductions.

New Entries for Nonrecurring Earnings or Deductions

When entering an amount for a nonrecurring earnings or deduction through PayMIX, the calculation or amount rule of the earnings or deduction determines the input value this amount should go to. Possible input values for receiving the amount are Amount, Percentage, or Pay Value. PayMIX routes the amount entry as follows:

- If the earnings or deduction has the input value Amount, the amount entered goes here. All earnings and deductions with the calculation or amount rule Flat Amount have an input value Amount.
- If the earnings or deduction does not have the input value Amount but does have the input value Percentage, the amount entered goes here. All earnings and deductions with the rule Percentage have an input value Percentage.
- If the earnings or deduction does not have the input values Amount or Percentage, the amount entered goes to the Pay Value.

See:

Earnings with the Calculation Rule Percentage of Earnings: page 15 –26

When you make a new entry to an input value of a nonrecurring earnings or deduction through PayMIX, the system considers that you are replacing a null entry, and calls the action a replacement. You can select Replace in the Action field of the PayMIX entry window, but it is not necessary to do so because the default action is Replacement.

Changes to Recurring Earnings or Deduction Results

Suppose that for this quarter only, some employees will receive additions to their regular, recurring quarterly bonuses, while others will receive lump sum payments instead of a percentage of their regular pay. A few employees will suffer a reduction of the bonus amount. You can rapidly enter all these changes to a recurring element using the PayMIX Earnings Entry window.

Amounts you enter via PayMIX to add to, subtract from or replace the calculated result of a recurring earnings or deduction go either to the
Additional Amount or Replacement Amount input value of the earnings or deduction’s special inputs element. The batch line’s Action field determines the line’s routing:

- To **add or subtract the amount to the run result** of the earnings or deduction, you type `inc` (Increase) or `dec` (Decrease) in the Action field. The amount goes to the Additional Amount input value of the special inputs element.
- To have the amount **replace the run result** of the earnings or deduction, you leave the Action field blank, or type in `rep`. In either case, the line’s amount goes to the Replacement Amount input value of the special inputs element.

### Additional Information for Earnings or Deductions Entries

When using PayMIX to make entries to earnings and deductions, you must enter employees’ assignment numbers, the earnings or deduction element name and the amount. You may need to enter other information as well. For an earnings type, this additional information entry is possible:

<table>
<thead>
<tr>
<th>Field in Earnings Entry Window</th>
<th>Entry Goes To</th>
</tr>
</thead>
</table>
| Cost Center                   | Cost Allocation key flexfield, segment for cost center codes.  
See: Use of the Cost Allocation Key Flexfield: page 11 – 5 |
| Action                        | System, causing it to route amount either to the input value Replacement Amount or Additional Amount of the special inputs element.  
See: Changes to Earnings or Deductions Before a Run: page 21 –4 |
| Tax Rule                      | Input value Deduction Processing (on all earnings).  
Possible entries are `Tax and Pretax Only` or `Tax Only`.  
See: Input Values to Control Deduction Processing: page 15 –23 |
| Location                      | The table of jurisdiction codes, and sends the correct code for the location to the input value Jurisdiction (as on Time Entry Wages, Overtime, Shift Pay). An entry here overrides the code of the employee’s regular work location.  
See: The Earnings Types Regular Salary and Regular Wages: page 15 –2  
The Earnings Type Overtime: page 15 –10,  
The Earnings Type Shift Pay: page 15 –13 |

Table 13 – 2 Additional Information for PayMIX Earnings Entry
For a deduction, there is a limited amount of additional information that you can enter:

<table>
<thead>
<tr>
<th>Field in Deduction Entry Window</th>
<th>Entry Goes To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Center</td>
<td>Costing flexfield, Account Code segment.</td>
</tr>
<tr>
<td></td>
<td>See: Use of the Cost Allocation Key Flexfield: page 11 – 5</td>
</tr>
<tr>
<td>Accrued Balance Override</td>
<td>System, to prevent increment of the balance for deductions with the stop rule Total Reached that normally accumulates deduction amounts.</td>
</tr>
<tr>
<td></td>
<td>See: Input Values to Control Deduction Processing: page 15 – 23</td>
</tr>
</tbody>
</table>

Table 13 – 3 Additional Information for PayMIX Deductions Entry

**Dates of Earnings and Deductions Entry Batch Lines**

When you supply an earned date for a batch line in the PayMIX Earnings Entry window, the entry goes to the input value Earned Date, and PayMIX gives this line the end date of the period in which the Earned Date falls. For lines in the Earnings Entry window with no Earned Date entry, and for all lines in the Deductions Entry window, the system supplies a date when you run the validation or transfer process. This date is the end date of the period in which the effective date of the process falls.
PayMIX Scheduling and Statuses

You can use PayMIX to enter, validate and correct information batches in a payroll period until you reach the payroll cutoff date, which can be just one or two days before the payroll run date.

Between the cutoff date and the run date, you can transfer all validated information batches into the HRMS database. Since the data is already validated, you can anticipate few if any transfer process failures.

The ability to validate, correct and again validate batches before the payroll run date can help even out the payroll department’s workload.

Batch Statuses Error, Warning

When the validation process finds problems in batch lines, it gives the lines a status of either Error or Warning. When any line’s status is Error, the status for the whole batch goes to Error. An Error status signals the presence of one or more major errors you must correct before you can transfer the batch. You cannot override the Error status and transfer the batch with lines marked Error still uncorrected.

When the validation process gives some lines a status of Warning, but none a status of Error, the batch status goes to Warning. If necessary, you can change a Warning status to Ready and transfer the batch to the database before correcting the conditions causing the warnings. In this case, the transferred batch has the status Transferred with Warnings.

It is of course always preferable to correct all problems before transferring data and initiating a payroll run. If you transfer batches with warnings uncorrected, you risk getting errors on the payroll run. After a transfer, it is no longer possible to make any corrections to batch data using PayMIX windows.

You decide which types of problems warrant an Error or Warning status at your installation.

Batch Statuses Hold, Ready, Validated, Transferred

At entry, a batch’s status is Hold, meaning it is not yet ready for further processing. When a batch is either completely entered and ready for validation, or validated and ready for transfer, you change its status to Ready. You can initiate the PayMIX Batch Process in either the Validate mode or the Transfer mode for batches at Ready status.
When you run the process in Validate mode for a batch and it finds no problems, the batch status goes to Validated. Batches at this status are ready for transfer. If your calendar permits, you can hold these batches in the PayMIX table and continue to enter any changes that come in until the payroll cutoff date.

Before the payroll run, you transfer all relevant batches from the PayMIX table to the HRMS database. To do this you initiate the PayMIX Batch Process in Transfer mode. In this mode, the process firstinvokes the validation process. If the validation process finds no problems, the transfer process moves the batch to the HRMS database.

When transfer is complete, the batch status goes to Transferred. You can still see the batch in PayMIX windows, but you can no longer add to, change or delete data in these windows. At this point you must use the windows to which the information in the batch has been transferred.
Completing Batch Element Entries Using PayMIX

To make batch element entries for Oracle Payroll, this is the overall procedure:

1. Identify each batch, supply any external totals against which to balance it, and enter any defaults for it.
   See: Identifying PayMIX Batches and Entering Defaults: page 13 – 69

2. Enter the batch.
   See:
   Entering Batches of Timecard Data: page 13 – 72
   Making Batch Entries for Earnings Types: page 13 – 73
   Making Batch Entries for Deductions: page 13 – 74

3. Run the PayMIX Batch Process in Validate mode to validate the batch.
   See: Running the PayMIX Batch Process: page 13 – 75

4. Review the results of this process and correct any lines with a status of Error. If time permits, also correct lines with a status of Warning.

5. Run the PayMIX Batch Process in Transfer mode to validate and transfer the batch.

Identifying PayMIX Batches and Entering Defaults

To enter a batch of information for payroll processing, start with the PayMIX Batch Information window to do the following:

- identify the batch you are entering
- supply any external totals you are using to validate these entries
- provide default values for the batch.
To identify a batch and enter user counts and totals:

1. Select the payroll for which you are entering this batch.
2. Select the batch type:
   - *Time* to make entries from timecards of time worked
   - *Earnings* or *Deductions* to make one-time entries or changes to an earnings type or deduction.

   The batch number, used to identify the batch, automatically increments.

   **Note:** For convenience, your system administrator can change your menus so that you select the batch type you are entering directly from the menu.

   See: *Oracle HRMS Technical Reference Manual*

3. In the Reference field, optionally enter an identifying code or any other data relevant to this batch. For example, for batches coming from your manufacturing facility in Detroit, you could enter the reference Detroit Plant.

4. At entry, the batch status defaults to Hold, meaning the batch is not ready for further processing. Change the status to Ready when the batch is:
   - completely entered and ready for validation, or
   - validated and ready for transfer.

5. In the Batch Totals region, you can enter externally determined counts of hours and batch lines and batch amount totals for Time type batches, or line counts and amount totals for Earnings or Deductions type batches.
When you complete entry of the batch and save it, this region displays the corresponding system totals and any differences between the user and system totals.

**Entering Default Values for a Batch**

Choose the Defaults button to open the Batch Entry Default Values window, in which you can enter defaults for the batch. If there are no defaults to enter for this batch, choose the Detail button to open the Time Entry, Earnings Entry or Deductions Entry window.

To provide default entries for the batch:

1. In the Batch Entry Default Values window, select the payroll for the batch, and the batch type of Time, Earnings or Deductions for the large alternative region in this window.
2. In the alternative region, enter any default values appropriate for all or most of the lines in this batch.

For example, to make Time entries for a batch of timecards most of which have 40 as the entry for Hours, enter 40 as a default in the Hours field. You can overwrite the default on any batch line.
3. Return to the PayMIX Batch Information window and choose the Detail button to open the Time Entry, Earnings Entry or Deduction Entry window.

**Entering Batches of Timecard Data**

To enter timecard data via PayMIX for payroll processing, use the Time Entry window.

![Time Entry Window](image)

**To make time entries from timecards:**

1. Make these entries on each line:
   - the employee assignment number, in the Assignment field
   - the name of the element to which the line’s entries are going, in the Hours Type field. For example, to enter hours taken as sick or vacation time, the element might be Sick Hours Taken or Vacation Hours Taken.

   **Note:** If you are making an entry of hours worked for an employee to receive the predefined earnings types Regular Wages or Regular Salary, you make the entry to the element Time Entry Wages.

   See: The Earnings Types Regular Salary and Regular Wages: page 15–2

   - the number of hours in the Hours field.
2. If a timecard contains additional information about these hours, as for example a rate code or rate for these hours or a location where they were worked, enter this information in the Additional Information region.

3. To remove all unsaved entries and return to the PayMIX Batch Information window, choose Cancel.

4. When entry is complete, save the batch, and change its status to Ready in the PayMIX Batch Information window. To stop entering a batch partway through, save the existing entries but keep the status at Hold. You can then query this batch and make further entries later.

Making Batch Entries for Earnings Types

To enter batch data via PayMIX for one–time processing of an earnings type, use the Earnings Entry window.

To make one–time entries or changes to an earnings type:

1. Make these entries on each line:
   • the employee assignment number, in the Assignment field
   • the name of the element to which the line’s entries are going, in the Earnings Name field

2. To enter a replacement for an existing entry, a null entry, or a calculated amount, enter the replacement amount in the Amount field.
field. By default, this amount replaces an existing or null entry, or a calculated amount.

OR

To enter an addition to or subtraction from an existing or calculated amount, enter the amount to add or subtract in the Amount field, and enter inc (Increase) or dec (Decrease) in the Action field of the Additional Information region.

3. Enter any further information required for this earnings type, as for example an indication to pay the earnings by a separate check, in the Additional Information region.

Note: To remove any unsaved entries and return to the PayMIX Batch Information window, choose Cancel.

4. When entry is complete, choose OK. Save the batch, and change its status to Ready in the PayMIX Batch Information window. To stop entering a batch partway through, choose OK and save the existing entries but keep the status at Hold. You can then query this batch and make further entries later.

Making Batch Entries for Deductions

To enter batch data via PayMIX for one–time processing of a deduction, use the Deductions Entry window.

To make one–time entries or changes to a deduction:

1. Make these entries on each line:
• the employee assignment number, in the Assignment field
• the name of the element to which the line’s entries are going, in the Deduction Name field

2. To enter a replacement for an existing entry, a null entry, or a calculated amount, enter the replacement amount in the Amount field. By default, this amount replaces an existing or null entry, or a calculated amount.

OR

To enter an addition to or subtraction from an existing or calculated amount, enter the amount to add or subtract in the Amount field, and enter inc (Increase) or dec (Decrease) in the Action field of the Additional Information region.

3. If further information is required for this deduction, as for example a cost center override, enter this information.

Note: To remove all unsaved entries and return to the PayMIX Batch Information window, choose Cancel.

4. When entry is complete, choose OK. Save the batch, and change its status to Ready in the PayMIX Batch Information window. To stop entering a batch partway through, choose OK and save the existing entries but keep the status at Hold. You can then query this batch and make further entries later.

Running the PayMIX Batch Process

Prerequisites

☐ Save the batches for which you are running the process, and if necessary, reconcile the user and system totals appearing in the Batch Totals region.

☐ Change the status of the batches to Ready, and save this change.

Run this process from the Submit Requests window.

1. In the Name field, select PayMIX Batch Process. If the Parameters box does not appear automatically, click in the Parameters field.

2. Select the payroll for which you are validating or transferring batches.

3. Enter the starting and ending numbers of the range of batches to process. To process just one batch, enter its number in the Starting Batch Number field.
4. Select the status, either Ready or Validated, of the batches to process.

5. Optionally enter a reference to further identify the batches to process.

For example, to validate all the batches from numbers 50 through 70 coming from your Detroit facility, enter 50 and 70 as the starting and ending batch numbers, and Detroit Plant as the batch reference.

6. Choose the process mode of either Validate or Transfer. Choose Validate for the process to validate but not transfer the batches identified. Choose Transfer for the process to validate the batches and then immediately transfer all those passing validation.

7. Choose Submit.
Reviewing and Correcting PayMIX Process Results

To review the results of the PayMIX Batch Process run, use the PayMIX Batch Summary window. To view batch line error messages, use the PayMIX Batch Line Errors window.

To review and correct PayMIX entries:

1. In the PayMIX Batch Summary window, query a processed batch using its batch number, and check its status. To review a batch with a status of Error or Warning, choose the View Batch button to open the PayMIX Batch Information window.

2. Information for the batch displays in the PayMIX Batch Information window. To see errors for this batch, choose the Batch Errors button. If there is an error affecting the entire batch, the PayMIX Batch Header Errors window opens and displays the error message.

   For batch line errors, the batch entry window opens. For each line with a problem, the line status is marked E (Error) or W (Warning), and the line displays in a contrasting color.

3. If the problem with a line is obvious, correct it and save the correction. If it is not obvious, choose Show Error. This opens the PayMIX Batch Line Errors window and displays the appropriate error messages. Make the necessary corrections and save them.

4. Run the PayMIX Batch Process again as needed.
Oracle Payroll includes several standard earnings and deductions in its startup data. You initiate the additional earnings types, non-payroll payments and non-tax deductions you require for processing in the payroll run, in accordance with your own policies relating to compensation and benefits.

This chapter presents the basic features of earnings and deductions in Oracle Payroll.
Earnings and Deductions in Oracle Payroll

Oracle Payroll comes with certain earnings types and deductions ready for you to use. You initiate the other earnings and deductions you need, as well as non-payroll payments such as expense reimbursements.

When you install Oracle Payroll, earnings types and deductions already present in the system are:

- the earnings types Regular Salary, Regular Wages, Overtime, and Shift Pay
- earnings types for the imputed earnings GTL Imputed Income and Company Car
- deductions for federal, state, and local tax levies, child support, and creditor garnishments.

These earnings and deductions come with their elements, input values, balance feeds, formulas, processing rules and result rules already in place, and available for review.

See: Reviewing Earnings and Deductions: page 14 –6

Tax Deductions

In addition to the earnings and deductions mentioned above, Oracle Payroll comes with all current federal, state and local–level tax deductions already in place. Oracle Corporation has made an agreement with Vertex Inc. to provide this data.

You do not need to set up or make entries to the tax deductions. They do require element links, which should be put in place during the implementation of the system at your site. Your system administrator receives tax updates from Vertex Inc., and applies them as necessary.

User–Initiated, System–Generated Earnings and Deductions

To supplement the earnings types and deductions included in your startup data, you initiate earnings types, payments and deductions that accord with your own compensation policies and practices. After you choose the appropriate processing and amount rules in the Earnings or Deduction window, the system generates:

- an element for the earnings, payment or deduction, with all necessary input values, balances and balance feeds
- a formula that utilizes the input values, together with a processing rule for the formula.
Once you create links for the earnings, payments and deductions you initiate and make entries to their input values, they are ready for use in payroll runs.

If the generated components of an earnings or deduction do not precisely meet your needs, you can:

• make certain changes to the structure of the generated element, using the Element window. For example, you can give the generated element additional input values.  
  See: Modifying an Element Generated for Payroll Processing: page 14–12
• make modifications to the generated formula, using the Formula window
• modify a generated processing rule or supply additional processing rules, using the Formula Result Rules window.  

See Also

Initiating Earnings and Non–payroll Payments: page 15–27
Initiating Deductions: page 16–3

Earnings and Deductions Balances

When the payroll run processes employees’ earnings and deductions, there are two ways that the earnings and deductions elements feed payroll–related balances:

• an element’s the run result, or Pay Value, can feed balances. For example, the Pay Value of the element for the garnishment deduction Child Support feeds the balance Child Support.

• the input values of an element can feed balances. For example, the element Time Entry Wages has an input value Hours, to receive entries from timecards of employees’ hours worked. This input value feeds the balance Regular Hours Worked.

The Pay Values of one or more individual elements can feed a balance, or alternatively, the Pay Values of entire element classifications can feed a balance. For example, the element classifications Earnings, Imputed Earnings and Supplemental Earnings all appear as feeds for the balance Gross Earnings. This is because the Pay Values of all elements belonging to these classifications feed this balance.
The setup of all balances in Oracle Payroll involves specifying:
- the elements or element classifications feeding the balances
- whether a feed adds to or subtracts from the balance total
- for individual elements that feed a balance, whether the feed comes from the element’s Pay Value or from one of its input values
- for feeds coming from an input value, the name of the input value.

Balance Dimensions and Levels

Balances exist for different time dimensions. For example, an employee can have a balance of Regular Salary for a particular payroll run, for the payroll period to date, for the month, the quarter to date, the year to date and the fiscal year to date.

Note: To hold balances for a fiscal year that is different from the calendar year, you must supply the fiscal year start date for your Business Group.

See: Entering Business Group Information: page 2 – 26

Balances also can exist at different levels. For individual employee assignments they exist at the assignment level, and for employees who hold more than one assignment at the same time, they also exist at the person level. For example, a person–level Gross Earnings balance represent the sum of an employee’s assignment–level Gross Earnings balances.

The process of setting up a balance includes selecting its applicable dimensions and levels.

Creation of Balances

The balances and balance feeds for the earnings, deductions and tax deductions supplied with Oracle Payroll are present in the system when you receive it. When you initiate earnings types, deductions and other items that process in the payroll run, the system generates the appropriate balances and balance feeds together with the necessary elements.

You can define whatever additional balances your enterprise requires. For example, you may require a Pensionable Earnings balance for a defined benefit pension plan your enterprise offers employees.

See Also

Reviewing Earnings and Deductions Balances: page 14 –8
Viewing Tax Balances: page 18–44
Defining User Balances: page 14–22
Reviewing Earnings and Deductions

You can review at any time the earnings types, non-payroll payments and deductions you initiate in Oracle Payroll, as well as the earnings and deductions included with the system. After running payroll processing, you can review the earnings and deductions balances, as well as tax balances, existing for individual employees.

The earnings types included in Oracle Payroll are:

- Regular Salary and Regular Wages: page 15–2
- Overtime: page 15–10
- Shift Pay: page 15–13
- GTL (Group Term Life) Imputed Income: page 15–15
- Company Car: page 15–17

The included non-tax deductions are:

- Wage Attachments: page 17–2
  - Child Support
  - Federal, State and Local Tax Levies
  - Creditor Garnishment

Note: When reviewing earnings or deductions you may find two with the same name, the second however including the words “Special Inputs” (for example, Regular Salary and Regular Salary Special Inputs). The special inputs element exists to provide a convenient way to enter a change to an earnings or deduction before a payroll run.

See: Changes to Earnings or Deductions Before a Run: page 21–4

Reviewing Earnings and Deductions Structures

To review the structures of earnings and deductions, you use these windows:

- Earnings
- Deduction
- Element
- Formula
- Formula Result Rules
To review processing and amount rules:

1. For an earnings or payment, use the Earnings window and query the earnings or payment.
   
   See: Initiating Earnings and Non–Payroll Payments: page 15 –27

2. For a deduction, use the Deduction window and query the deduction.
   
   See: Initiating Deductions: page 16 –3

To review input values and balance feeds:

- Using the Element window, query the earnings, payment or deduction in question. Choose the Input Values button to review the input values. Choose the Balance Feeds button to review the balance feeds.

  See: Modifying an Element Generated for Payroll Processing: page 14 –12

To review formulas and formula result rules:

- For the formula, use the Formula window. For the formula result rules, use the Formula Result Rules window. Query the earnings, payment or deduction in the appropriate window.

  See:

  Using the Formula Window, Oracle FastFormula User’s Guide
  Defining Formula Processing and Result Rules: page 14 –25
Reviewing Earnings and Deductions Balances

To review earnings and deductions balances that accumulate for individuals after payroll runs, use the View Earnings and Deductions Balances window.

To view balances for earnings types:

1. Set the effective date at which you want to see these balances, and if necessary query the employee assignment for which you are reviewing balances.
2. Select the classification of the earnings types you are reviewing.
3. Choose whether to see balances at the assignment level or the person level. For employees with more than one current assignment, the person level balances show totals of the balances accumulated for each assignment.
4. The earnings types for the selected classification appear in the Balances region.

The dimensions for which you see assignment-level balances are period to date, month to date, quarter to date and year to date. You also see person-level balances for these dimensions, except for
period to date. No person-level balances exist for the dimension period to date.
To view balances for deductions:

1. From the Assignments Folder, enter or query the employee assignment for which you are reviewing balances.
2. If necessary, use the Alter Effective Date icon in the tool bar to set the effective date to an appropriate date for viewing the balance.
3. Select the classification of the deductions you are reviewing.
4. Choose whether to see balances at the assignment level or the person level. For employees with more than one current assignment, the person level balances show totals of the balances accumulated for each assignment.

The deductions for the selected classification appear in the Balances region.

The dimensions for which you see assignment-level balances are period to date, month to date, quarter to date and year to date. You also see person-level balances for these dimensions, except for period to date. No person-level balances exist for the dimension period to date.

**The Accrued Balance**

This balance exists only for deductions with a stop rule of Total Reached. It holds the amount accumulated to date toward the total.
The Arrears Balance
This balance exists only for deductions for which the system holds arrearage when employee earnings are insufficient to cover the deduction’s full amount. The arrears balance holds any amounts not taken but held in arrears.

The Toward Bond Balance
This balance exists only for deductions taken for the purchase of Series EE bonds. It holds the amount accumulated to date toward purchase of a bond.

The Able Balance
This balance exists only for pretax deductions you initiate that do not fit in the categories Deferred Comp 401k, Health Care 125 or Dependent Care 125. For a pretax deduction such as this, you may require a balance fed by earnings types subject to the deduction. This is the Able balance that you can review here.

When you initiate a pretax deduction requiring this balance, the system generates the balance, but you must manually enter the earnings types that feed it. You may also need to modify the generated formula for the deduction so that it references this balance.

See: Defining User Balances: page 14–22

Note: To view tax balances for individuals, use the View Tax Balances window.

See: Viewing Tax Balances: page 18–44

See Also

Earnings and Deductions Balances: page 14–3

See: Deduction Start and Stop Rules: page 16–8

See Also

Earnings and Deductions Overview 14–11
Modifying an Element Generated for Payroll Processing

Oracle Payroll generates elements that process in the payroll run when you initiate the earnings, non-payroll payments and non-tax deductions your enterprise requires. You can make certain modifications to the structure of these generated elements, to enhance their suitability or efficiency for use at your installation. Some modifications can be made even after processing has occurred, but most should be made before processing the element in payroll run.

Attention: If a generated element requires changes because of mistaken entries made when initiating the earnings or deduction, it is best to delete the results and re-initiate.

For example, if you select the wrong processing rule or amount rule when initiating an earnings or deduction, simply delete the generated components and begin again.

When you modify an element generated for an earnings or deduction, you may also need to make modifications or additions to:

- **balances** that the element’s run results or input values feed
  
  See: Defining User Balances: page 14–22

- **formulas** for calculation of the element’s run results
  

- **formula processing** and **result rules**, required for every formula for an element.
  
  See: Defining Formula Processing and Result Rules: page 14–25

See Also

*Oracle HRMS Technical Reference Manual*

Summary of Possible Modifications

The modifications you can make to an element generated for payroll processing include the following:

- **Changes to processing rules**. This can include modification of processing information, entry of foreign currencies for element input or output, and entry of any factors or conditions that employees should meet in order to receive entries of the element.
See: Modifying Processing Rules: page 14–14

- **Changes to further information.** This includes enabling elements for PayMIX entry; changing FLSA indicators; identifying benefits carriers and the periodicity of benefit deductions; and making changes to the run type and partial amount rule of any type of deduction.

  See: Adding or Changing Further Information: page 14–16

- **Addition of input values and default entries.**

  See: Adding Input Values: page 14–19

- **Addition of balances and balance feeds.**

  See:
  
  Defining User Balances: page 14–22
  
  Adding Balance Feeds: page 14–20

To make modifications to an element generated for payroll processing, start from the Element window.

![Element window screenshot](image)

**Attention:** When making modifications to generated elements, save them as *corrections* (not updates).
Modifying Processing Rules

Modifying Processing Information

Prerequisite

- If the element requires any additions to a generated skip rule, develop the additions. Notice that a skip rule cannot contravene any other processing rules in place for the element.

See: Writing Formulas for Element Skip Rules, Oracle FastFormula User’s Guide

To modify processing information:

1. In the Element window, query the generated element you are modifying.
2. You cannot change the processing type (Recurring or Nonrecurring) of a generated element.
3. To control the processing of entries to the element after employee termination, you can select an alternative termination rule.
   - If the termination rule is Final Close, entries to the element stay open beyond the actual termination date. This makes it possible to produce the final pay for the terminated employee, and other payments if necessary, after his or her actual termination date. This is the appropriate selection for most elements.
   - If the termination rule is Actual Termination and the element’s processing type is Recurring, entries to the element close down on the employee’s termination date. If the element’s processing type is nonrecurring, entries close down on the last date of the pay period in which the employee leaves.
4. You cannot change the Multiple Entries Allowed rule for a generated element.
   
   Note: The rules Additional Entry Allowed has no applicability for US installations. It is available for use at non-US sites.
5. You can prevent the element from accepting any new entries, either temporarily or permanently, as of a certain date. Set the effective date to the date from which you want to close down the element, and check Closed for Entry. This does not affect any existing entries.
6. You can control an element’s availability for processing in runs by checking or unchecking the Process in Run box.
7. You cannot specify Indirect Results or Adjustment Only as a modification to a generated element.

8. To make third party payments from an earnings or deduction element, check the Third Party Payment box.

9. You can change the default priority number appearing in the Priority field. The payroll run processes elements with lower priority numbers first.

10. You can select a skip rule or change an existing skip rule for the element in the Skip Rule field.

Entering Foreign Currencies

**Note:** If you set up earnings types to produce payments in local currencies instead of the base currency of the Business Group, you must also define the balances required to hold amounts of the local currencies. The system does not generate these balances.

See: Defining User Balances: page 14 –22

**To specify foreign currencies for element entries:**

1. To make entries for the element in a currency other than the Business Group’s base currency, select the currency in the Currency Input field.

   For example, if the element represents a housing allowance of 500 pounds sterling paid monthly to a US employee working in the UK, you can select United Kingdom pounds as the input currency.

2. You can select in the Currency Output field, a currency different from the base currency for the element’s run results.

   See: Defining Exchange Rates: page 21 –13

Entering Qualifying Conditions

**To set qualifying conditions for receiving element entries:**

1. If there is a minimum age for employees to receive the element, enter it in the Age field.

2. If employees must complete a minimum length of service before receiving the element, enter a number in the Length of Service field and select a unit of measure (such as months or years) in the Units field.
3. To automatically enter the element and its default input values for all eligible employees, check the Standard box.

You cannot check this box for nonrecurring elements, or for those with the rule Multiple Entries Allowed.

Note: The qualifying conditions and Standard check box provide defaults for the element. You can override them for particular groupings of employees when you build links for the element.

See: Defining Element Links: page 12 – 38

Adding or Changing Further Information

To open the Further Element Information window for an element, click in the Further Information in the lower right-hand corner of the Element window. The fields that appear in this window depend on the primary classification of the element that appears in the element window. Use these fields to make the entries described below.

Note: The names of certain balances that the system can accumulate for an earnings type or deduction appear in fields of the Further Element Information window. Whether a balance actually does accumulate depends on the selections made in the Earnings or Deduction window.

For example, the Toward Bond Purchase balance accumulates only for deductions for which you have checked the Series EE Bond box in the Processing alternative region of the Deduction window.

Enabling PayMIX Entries

To enable element entries using PayMIX:

1. In the Element window, query the element you are modifying.
   Click in the Further Information field to open the Further Element Information window.

2. To enable users to make entries to this element using a PayMIX window, select the PayMIX window in the PayMIX Category field. The choices are:
   • Deductions (Deductions Entry window)
   • Earnings (Earnings Entry window)
   • Time (Time Entry window for entry of timecard data)
Changing FLSA Indicators for Earnings or Supplemental Earnings

To change FLSA indicators:

1. In the Element window, query the element you are modifying. Click in the Further Information field to open the Further Element Information window.

2. To include the amount of the earnings in the calculation of the FLSA overtime base rate, select Yes in the field Include in OT Base. To exclude the amount of this earnings type, select No.

3. To include the hours worked for this earnings type in the calculation of the FLSA overtime base rate, select Yes in the field FLSA Hours. To exclude the hours worked for this earnings, select No.

See: Identifying the Earnings or Payment: page 15 –28

Entering Benefits Carriers for Imputed Earnings or Pre-Tax or Voluntary Deductions

Prerequisite

- Define an external organization with the classification Benefits Carrier to represent the carrier.

See: Creating an Organization: page 2 – 20

To identify a benefits carrier:

1. In the Element window, query the element you are modifying. Click in the Further Information field to open the Further Element Information window.

2. Select the carrier name in the field Benefits Carrier.

Setting Processing Frequencies for Benefit Deductions

1. In the Element window, query the element you are modifying. Click in the Further Information field to open the Further Element Information window.

2. Identify the processing frequency of a deduction taken to pay for a benefit by selecting a processing period in the field Period Type. For example, for a benefit deduction that should be taken once each month, select the period type Calendar Month.
Note: When a benefit deduction does not have the same processing frequency as a payroll, give the deduction a frequency rule for the payroll using the Frequency Rules window.

For example, if a benefit deduction taken monthly should process in the second period of the month for the semi-monthly payroll, check 2 as this deduction’s regular processing period for this payroll. You can enter or change deduction frequency rules for payrolls at any time.

See: Setting Frequency Rules for the Deduction: page 16–10

Changing Run Types for Pre-Tax, Voluntary or Involuntary Deductions

To change a deduction’s run type:

1. In the Element window, query the element you are modifying. Click in the Further Information field to open the Further Element Information window.

2. Change the selection in the Processing Run Type field. The choices are:
   - Regular (process only in Regular runs)
   - All (process in both Regular and Supplemental runs).

See: Regular and Supplemental Runs: page 21–2

Changing Partial Amount Rules for Pre-Tax, Voluntary or Involuntary Deductions

To change a deduction’s partial amount rule:

1. In the Element window, query the element you are modifying. Click in the Further Information field to open the Further Element Information window.

2. Change the selection in the Partial EE Contributions field. The choices are:
   - Yes (The payroll run should take partial amounts for the deduction if employee funds are insufficient to take the full amount.)
   - No (The run should never take partial amounts for the deduction.)

Adding Input Values

Prerequisite

- Decide whether and how to validate entries to any new input values.
  - To restrict entries to a list of valid values, use the QuickCode Types window to define a new lookup. Then enter the valid values for this lookup in the QuickCodes window.
    See: Defining QuickCode Types: page 29
  - To validate values using formulas, write the validation formulas using the Formulas window.
    See: Using Oracle FastFormula for Validation, Oracle FastFormula User’s Guide

To add an input value:

1. In the Element window, query the element you are modifying and choose the Input Values button.
   **Note:** An element can have as many as 15 input values.
2. Enter the name of the new input value.
3. Select the unit of measure for the input value (money, hours, character, date, number or time).
   **Note:** The unit of measure for the Pay Value is always money.
4. You can enter numbers in the Sequence field to designate the order in which the Element Entries window displays the input values.
5. If the input value must have an entry, check the Required box.
6. To enable user entries to this input value, check the User Enterable box.
7. If entries to this input value should exist as database items, that is, items that formulas and QuickPaint inquiries can access, check the Database Item box.

Entering Element–level Defaults

To enter a default for an input value:

1. In the Element window, query the element you are modifying and choose the Input Values button.
2. Make the entry of the default value in the Default field.

3. For automatic update of existing entries of a default whenever you change the default, check the Hot Default box. Hot defaults appear in the Element Entries window in quotation marks.

⚠️ **Warning:** If you override a hot default appearing as an entry for an employee, any further changes to the element’s default value do not affect this entry. For this reason, it is best to make changes to a default value for large groups of employees using PayMIX, rather than the hot default feature.

### Supplying Entry Validation

**To establish validation for an input value entry:**

1. In the Element window, query the element you are modifying and choose the Input Values button.

2. Choose one of these approaches:
   - Enter maximum and minimum values for the entry.
   - Select a QuickCode Type to act as a lookup for an input value.
   - Select a formula to validate entries. Formulas can return messages about the success or failure of the validation.
     
     See: Validation of Input Value Entries: page 12 – 16

3. Choose Warning for the system to warn of an invalid entry, or Error if it should not save a valid entry. You cannot select Warning or Error when using a lookup for validation, because in this case an invalid entry is impossible.

### Adding Balance Feeds

**Prerequisite**

- If the element’s run results or input values must feed new balances not already in the system, create these balances.

  See: Defining User Balances: page 14 – 22

**To enter balance feeds:**

1. In the Element window, query the element you are modifying. Choose the Balance Feeds button to go to the Balance Feeds window.
2. For each additional balance this element feeds, select in the Value Name field either Pay Value, or the name of the input value that should feed the balance.

3. Select the balance to be fed in the Balance Name field.

4. Choose Add to add the input value amount to the balance, or Subtract to subtract it.

5. Choose Done when you are finished.

   Note: Secondary classifications and balance feed controls currently do not apply to the US version of Oracle Payroll.
Defining User Balances

Balances for the earnings, deductions and tax deductions provided with Oracle Payroll are already in your system, and when you initiate earnings, deductions and other items for payroll processing, the system generates the standard balances and balance feeds required. You must define for your installation any balances that are specific to your enterprise.

For example, if your enterprise require a balance holding pensionable earnings for a company–provided Defined Benefit pension plan, define this balance yourself. Or, if you set up earnings types to make payments in local currencies rather than the base currency of the Business Group, you must define balances for these currencies.

To define a balance, use the Balance window.

Prerequisite

- If the earnings, payment or deduction whose run results or input values feed the balance you are defining do not already exist in your system, initiate the earnings or payment using the Earnings window, or the deduction using the Deduction window.

To define a user balance:

1. Do one of the following:
   - Enter a unique name and a reporting name for a new balance you are defining. If you do not provide a reporting name the first seven characters of the balance name appear on reports and statements of earnings.
   - Query any user balances you want to change.

   Note: Do not select the Use for Remuneration check box. It is not relevant for user–defined balances.
2. Select the unit of measure for the balance. The choices are days, hours (listed in different formats), integer, money and number. If you select money as the unit you must also select a currency. The default is USD (US dollars).

3. Go to the Balance Feeds window or to the Balance Classifications window.

![Balance Feeds window]

**To enter balance feeds (Balance Feeds window):**

- Use DateTrack if necessary to set the effective starting dates for each feed.

- Select one or more individual elements to feed the balance. Only those elements whose input values have the same unit of measure as the balance appear on the list.

  When you select an element its classification displays. You can select elements with different classifications.

- Select the input value name for the element.

  If the element’s run result should feed this balance, select Pay Value. Otherwise, select the name of the input value feeding this balance.

- Select Add or Subtract for the balance feed.
To enter balance feeds (Balance Classifications window):
- Select one or more element classifications all of whose elements' Pay Values should feed this balance.

To enter balance dimensions:
- In the Balance Dimensions window, select the dimensions you require. The description of each dimension displays.
  You can remove any dimension selected for a user–defined balance.
  You can also add and remove further dimensions to non–tax balances included with the system, but you cannot remove dimensions provided with balances included in the system.
Defining Formula Processing and Result Rules

When the system generates a formula prescribing the payroll run calculations for an earnings or deduction element, it also generates processing and result rules that control the formula’s use with the element. If you substitute a modified formula for the one generated for an element, or write additional formulas to use for employees at certain specific employment statuses, you may need to modify or write new processing and result rules for the element.

Formula processing rules serve two purposes:

- they connect elements to their formulas
- if there are elements with more than one formula, they establish which formula to use to process employees at a specified employment status.

Formula result rules serve to identify the various possible results of a formula.

Formula Processing Rules

An element’s standard formula processing rule designates the formula usually used to process the element for employees. If an element has additional formulas to use for processing employees at certain specified assignment statuses, it requires additional processing rules.

For example, suppose employees who are union members and receive the earnings type Union Wages, receive wages computed differently from their usual wages when they are on paid training leave. In this case the Union Wages element can have two formulas, and two formula processing rules:

- The STANDARD_UNION_WAGES formula, to process pay for all union members with an assignment status of Active. This formula has the processing rule Standard Union Wages.
- the TRAINING_UNION_WAGES formula, to process pay only for union members with an assignment status of Paid Training Leave. It has the processing rule Paid Training Leave.

Formula Result Rules

Formula result rules identify the types of results coming from a particular formula. Possible results of a formula are:

- the run result (Pay Value) of the element
- an indirect result or an update for the payroll run to send as an entry or update to the input value of another element, to be processed later in the run
• **messages** to be issued to the user
• a **stop** that puts an end date on a recurring entry for the formula’s element or another element, to stop processing of the entry after the end date.

To enter, edit, or review formula processing and result rules, use the Formula Result Rules window.

**Prerequisite**

- In the Formula window, write, edit, or review the formula for the element for which you are entering or reviewing processing and result rules.


> **To enter processing rules for an element:**

1. Set your effective date to the start date for the rule.
2. Select the element for which you are entering processing rules. The element’s description and classification automatically display.
3. In the Processing Rules region, select an assignment status and the formula to use when processing the element for employees at this status. Select the status “Standard” for the rule with the formula usually used to process this element.
Create a processing rule for each formula available to use for processing this element. For example, the earnings type Sabbatical Pay can have these processing rules:

- the Standard processing rule, with STD_SABBATICAL_PAY as its formula, applicable to employees with the relatively common status Sabbatical Leave.
- the Research Leave processing rule, with RESEARCH_SABBATICAL_PAY as its formula, applicable to employees with the less commonly occurring status Research Leave.

4. Save your work.

**To enter formula result rules for a processing rule:**

1. Each separate formula with a processing rule in the Processing Rules region requires its own result rules. Click on a processing rule to enter its result rules in the Formula Results region.

2. Set your effective date to the start date for the formula result rules you are entering.

   **Note:** Formula result rules take on the effective end date of their processing rule. Any date effective changes you make to an existing processing rule can affect its result rules as follows:

   - If you update a processing rule or give it an effective end date, all the rule’s currently effective and future–dated formula result rules automatically get identical end dates.
   - If you correct a processing rule, all its currently effective and future–dated formula result rules remain unchanged.

3. In the Name field of the Formula Results region, select a result of the formula for which you are entering result rules. All the possible results of this formula appear in the list of values.

4. In the Type field, select the appropriate result type. These are the possible types:

   - **Direct result:** This is the element’s run result (Pay Value). There can be only one direct result per formula.
   - **Indirect result:** This is a result from an element’s processing that the payroll run passes as an element entry to another nonrecurring element not yet processed. A formula can produce any number of indirect results.

   **Note:** To maintain costing information for elements that receive indirect results as entries, you must construct links for them with a costable type of Costed, Fixed, or Distributed.
• See: Costing Information at the Element Link Level: page 11 – 7

**Update recurring entry:** This result updates a recurring entry for another element not yet processed (the element receiving the update must be one for which multiple entries are not allowed).

**Message:** These are messages the formula issues under certain conditions. For example, a formula can check a loan repayment balance and, if the balance is zero, issue the message “Loan is repaid.”

See: Reviewing Messages Issued During Processing: page 21 – 26

**Stop:** This formula result uses the effective date of the payroll run to put an end date on a recurring entry to this or another element. After the end date, the entry can no longer process.

5. For a formula result of the type Indirect Result, Stop or Update Recurring Entry, select in the Element field, the name of the element receiving this result.

**Note:** An element receiving one of these results from the processing of another element must process after the element sending the result. Accordingly, the element receiving the result must have a higher priority number than the element sending the result.

See: Classifications and Payroll Run Processing Priorities: page 12 – 14

6. If the formula result type is Indirect Result or Update Recurring Entry, select the name of the input value to receive this result. The units of this input value display.

7. If the formula result type is Message, select a message severity level. There are three choices:

**Fatal:** When a message with this severity results from your formula, the run rolls back all processing for the employee assignment.

**Warning.** A message with this level of severity does not affect payroll processing but warns the user of a possible problem.

**Information:** A message with this level of severity simply gives information.
Oracle Payroll includes the earnings types Regular Salary and Regular Wages, Overtime, Shift Pay, Group Term Life Imputed Income and Company Car.

You initiate the other earnings types and non-payroll payments you need in accordance with your own compensation policies, by entering information about them in the Earnings window.

This chapter first presents an outline of the earnings types included in Oracle Payroll, and the way they process. It next discusses structural features of the elements Oracle Payroll generates for the earnings and non-payroll payments you initiate.

The chapter concludes with a presentation of the procedures for initiating earnings types and non-payroll payments in Oracle Payroll.
Regular Salary and Regular Wages

*Classification:* Earnings  
*Category:* Regular  
*Processing Type:* Recurring

The earnings type Regular Salary and Regular Wages can process in the Regular run each period to produce regular pay for salaried and waged employees, respectively.

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly Salary</td>
<td>Gives amount of employee’s monthly salary to formula.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Location entered here prompts system to find the location’s tax code in the table of jurisdiction codes, and use this code to override the code of the employee’s regular work location.</td>
</tr>
</tbody>
</table>

Table 15 – 1 Input Values for Regular Salary

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>Gives formula the rates to use. Entries here override Rate Code entries.</td>
</tr>
<tr>
<td>Rate Code</td>
<td>Gives formula the codes by which to locate rates in the Wage Rates table.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Location entered here prompts system to find the location’s tax code in the table of jurisdiction codes, and use this code to override the code of the employee’s regular work location.</td>
</tr>
</tbody>
</table>

Table 15 – 2 Input Values for Regular Wages

For information about the Wage Rates table, see: Predefined User Tables: page 29 – 11

**Associated Elements**

Working together with the Regular Salary and Regular Wages earnings are three additional elements, Time Entry Wages, Labor Recording and Regular Hours Worked.

**Time Entry Wages Element**

*Classification:* Earnings  
*Category:* Regular  
*Processing Type:* Nonrecurring
<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>Gives hours worked to Regular Wages formula.</td>
</tr>
<tr>
<td>Rate</td>
<td>Overrides rate appearing on Regular Wages.</td>
</tr>
<tr>
<td>Rate Code</td>
<td>Overrides rate code appearing on Regular Wages.</td>
</tr>
<tr>
<td>Shift</td>
<td>Gives formula shift designator, for locating shift differential in the Shift Differentials table if no entry exists for Rate or Rate Code.</td>
</tr>
<tr>
<td>Date Earned</td>
<td>Signals that this set of entries is for a prior period, not the current period.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Location entered here prompts system to find the location’s tax code in the table of jurisdiction codes, and use this code to override the code of the employee’s regular work location.</td>
</tr>
<tr>
<td>Separate Check</td>
<td>Yes signals that this earnings should be paid by separate check. Default is No.</td>
</tr>
<tr>
<td>Deduction Processing</td>
<td><strong>Tax Only</strong> means, process tax deductions only for this earnings. <strong>Tax and Pre–tax Only</strong> means, process only these deductions for this earnings. Default is All.</td>
</tr>
</tbody>
</table>

Table 15 – 3 Input Values for Time Entry Wages

For information about the Shift Differentials table, see: Predefined User Tables: page 29 – 11

Time Entry Wages functions to receive timecard data through the PayMIX batch entry facility. As well as hours worked, it can receive overrides to existing Regular Wages entries, and other information affecting employees’ pay. For example, if day shift workers temporarily work the evening shift at a plant in another state at a special wage rate, they enter on their timecards for the week not only hours worked, but also the location and rate code or shift designator.

These entries go via PayMIX to the Time Entry Wages input values Hours, Jurisdiction, Shift and Rate Code. The Regular Wages formula then uses these entries, rather than entries on Regular Wages and the work location information on the employees’ records, to produce correct pay for the week.

See: PayMIX Timecard Entries: page 13 – 62

Entries to Time Entry Wages also signal to the Regular Salary and Regular Wages formulas that waged employees required to submit timecards with hours worked each period have in fact done so.
Labor Recording Element

*Classification:* Information
*Category:* Labor Hours
*Processing Type:* Nonrecurring

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>Holds entries of hours worked at a particular labor distribution or project accounting code.</td>
</tr>
<tr>
<td>Rate</td>
<td>Holds rate paid for the hours entered.</td>
</tr>
<tr>
<td>Rate Code</td>
<td>Holds rate code for the hours entered.</td>
</tr>
<tr>
<td>Shift</td>
<td>Gives formula shift designator, for locating shift differential in the Shift Differentials table if no entry exists for Rate or Rate Code.</td>
</tr>
<tr>
<td>Date Earned</td>
<td>Signals that this set of entries is for a prior period, not the current period.</td>
</tr>
</tbody>
</table>

Table 15 – 4 Input Values for Labor Recording

Labor Recording functions to receive entries of time worked, and optionally other information, for salaried employees who submit timecards only for project accounting or labor distribution purposes. These entries usually go in through PayMIX, but you can make them manually as well.

See: Entering Batches of Timecard Data: page 13 – 72

Regular Hours Worked Element

*Classification:* Information
*Category:* Regular Hours
*Processing Type:* Nonrecurring

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Receives entries of hours worked for use in reports.</td>
</tr>
</tbody>
</table>

Table 15 – 5 Input Values for Regular Hours Worked

Regular Hours Worked functions to receive entries of each employee’s hours worked as indirect results of the Regular Salary and Regular Wages formulas. Oracle Payroll can then access these entries for use in reports such as the Statement of Earnings and Earnings Audit.
Vacation Pay and Sick Pay

These elements should receive links to all payrolls during implementation. If you make batch entries of accrued vacation or sick time taken using PayMIX, these elements automatically receive entries of the time taken, which Oracle Payroll uses in reports such as the Statement of Earnings.

Processing for Regular Salary and Regular Wages

(except for final pay to terminating employees)

The formula for these earnings types does the following:

Checks employee’s assignment to see if timecard is required.
IF timecard is not required
    Calculates salary or wages due. Feeds results into Regular Pay balance for the employee.
    Checks employee’s work schedule or standard working hours to locate hours worked in period.
IF timecard is required because employee is salaried but must submit timecard with hours worked for project accounting/labor distribution recording
    Checks whether Labor Recording element has received entries of hours worked.
    IF no entries exist, issues message to this effect and does not calculate pay.
    IF entries exist, enters hours and project accounting/labor distribution codes on employee’s record.
    Sends hours worked to Regular Hours Worked information element, for reports such as Statement of Earnings and Earnings Audit.
ELSE IF timecard is required because employee must submit hours worked on timecard to receive pay
    Checks whether Time Entry Wages element has received current entries of hours worked from timecard.
    IF no entries exist, issues message No timecard entries exist and does not calculate pay.
    IF entries exist, locates correct pay rate and calculates earnings due. Feeds results into Regular Pay balance for the employee. Enters hours and any other period-specific information on employee’s record. Sends hours worked to Regular Hours Worked element for reports such as Statement of Earnings and Earnings Audit.
See Also

Structures for Initiated Earnings Types: page 15–18
Regular Non-Worked Hours

The regular non-worked hours functionality allows you to date effectively reduce Regular Wages for earnings types you specify according to your business rules, such as jury duty, paid holidays etc.

The effects of reducing earnings using regular non-worked hours are seen on the employees Statement of Earnings. When earnings are reduced for an earnings category such as jury duty, the SOE shows an amount and hours for the employee’s regular work actually performed and an amount and hours for the regular non-worked hours.

For example, a salaried employee, paid bi-weekly, reports 16 hours of jury duty time off this pay period, the employee’s SOE might look like this:

<table>
<thead>
<tr>
<th>Earnings Type</th>
<th>Hours</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular Salary</td>
<td>64</td>
<td>$6400</td>
</tr>
<tr>
<td>Jury Duty Pay</td>
<td>16</td>
<td>$1600</td>
</tr>
</tbody>
</table>

Note that the sum of the hours worked (“Regular Salary”) and non-worked hours (“Jury Duty Pay”) equals the regular hours (80 hours, in this example).

Without noting the regular non-worked hours difference, the same employee’s SOE might look like this:

<table>
<thead>
<tr>
<th>Earnings Type</th>
<th>Hours</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular Salary</td>
<td>80</td>
<td>$8000</td>
</tr>
</tbody>
</table>

Attention: Regular non-worked hours are distinct from the predefined earnings types that are used on accruals, such as Paid Time Off. Regular non-worked hours do not require any kind of accrual plan.

Creating Regular Non-Worked Hours

Regular non-worked hours adds functionality to earnings types you specify to reduce earnings according to your business rules. The sum of the worked hours and regular non–worked hours is equal to the regular hours.

Attention: The earnings category “Regular” cannot be used with this functionality. You must use a special earnings category.

To create regular non-worked hours, you must perform the following tasks:

- Create an earnings category for reducing regular wages
You create earnings categories from the QuickCode Values screen from the Other Definitions in the Navigator.

- **Set up an earnings type to reduce regular wages**
  You create regular non-worked hours through the Earnings screen.

  **Attention:** Set an appropriate effective date before creating a regular non-worked hours earnings type.

**To create an earnings category to reduce regular wages:**

1. Query US_EARNINGS in the Type field.
2. Enter a unique code for the earnings category in the Code field.
3. Enter a name for the earnings category, such as “Regular Non-Worked” in the Meanings field.
   This name will display in the list of values for the earnings category.
4. Select an appropriate access level.
5. Save the earnings category.

**To create a regular non-worked hours earnings type:**

Set an appropriate effective date before creating a regular non-worked hours earnings type.

1. Identify the earnings.

  **Attention:** The earnings classification must be either Earnings or Supplemental Earnings. The earnings classification cannot be Imputed Earnings or Non-Payroll Payments.
2. Enter calculation rules for the earnings type.

Attention: You must select either Hours_X_Rate or Hours_X_Rate_Multiple. You cannot choose a flat amount or a percentage of regular earnings.

3. Check the Reduce Regular check box.

4. If necessary, enter rules to control payments by separate check, and to limit the deductions processed against the earnings or payment.

5. Review and if necessary, make changes to the components generated for the earnings.

Attention: If you make mistakes when initiating an earnings or payment so that the components generated for it need correction, delete all the generated components and re-initiate the earnings.

Disabling a Regular Non-Worked Hours Earnings Type

Disabling regular non-worked hours earnings type is handled from the Further Element Information descriptive flexfield in the Element Description screen.

To disable a regular non-worked hours earnings type

1. Query the name of the earnings category you wish to disable.
2. Click in the Further Information descriptive flexfield.
3. Change the value of the Reduce Regular field from Yes to No.

Ending a Regular Non-Worked Hours Earnings Type

The best and approved way to end a regular non-worked hours earnings type is to set an effective end date. This way you will be able to keep history on this activity.
Overtime

**Classification:** Earnings  
**Category:** Overtime  
**Processing Type:** Nonrecurring

The earnings type Overtime produces pay for overtime worked both at straight time rates and premium rates. You may provide the rate of pay for overtime work either as an entry to the input value Rate, or as an entry in the Wage Rates table, to be located by an entry to the input value Rate Code. Otherwise, the Overtime formula itself calculates the FLSA (Fair Labor Standards Act) overtime base rate.

See: Predefined User Tables: page 29 – 11

For correct calculation of the FLSA overtime base rate, when you initiate an earnings type you must identify whether to include the pay resulting from the type in the overtime base rate calculation, and whether to count hours worked for the type as FLSA hours.

**Attention:** Oracle Payroll supports FLSA overtime and bonus calculation when the weekly payroll period and the overtime/bonus occur in the same work week. Payroll periods greater than a single work week are not supported at this time and manual calculations of the overtime amounts are required.

See: Identifying the Earnings or Payment: page 15–28

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Short-circuits formula and provides Overtime earnings run result.</td>
</tr>
<tr>
<td>Hours</td>
<td>Gives overtime hours worked to formula.</td>
</tr>
<tr>
<td>Rate</td>
<td>Gives formula the rates to use. Entries here override Rate Code entries.</td>
</tr>
<tr>
<td>Rate Code</td>
<td>Gives formula the codes by which to locate rates in the Wage Rates table.</td>
</tr>
<tr>
<td>Multiple</td>
<td>Gives rate multiple for overtime hours to formula.</td>
</tr>
<tr>
<td>Date Earned</td>
<td>Signals that this set of entries is for a prior period, not the current period.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Location entered here prompts system to find the location’s tax code in the table of jurisdiction codes, and use this code to override the code of the employee’s regular work location.</td>
</tr>
</tbody>
</table>

Table 15–6 Overtime Input Values
### Processing for Overtime

The Overtime formula does the following:

Checks employee’s job to see if it is exempt from overtime payments under Fair Labor Standards Act (FLSA) rules.

- **IF** job is exempt
  - Issues message *Job is exempt* and stops payroll processing for the employee.
- **IF** job is not exempt
  - Finds overtime rate using entry to Rate or Rate Code.
  - **IF** no entries exist
    - Calls function to calculate the overtime base rate. This function:
      1. Determines pay this period for each earnings type entered for employee and identified as contributing to the overtime base rate.
      
      For example:


<table>
<thead>
<tr>
<th>Earnings Contributing to Overtime Base Rate</th>
<th>Pay Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular Hours</td>
<td>$600.00</td>
</tr>
<tr>
<td>Production Bonus</td>
<td>$200.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$800.00</strong></td>
</tr>
</tbody>
</table>

2) Determines hours worked this period for each earnings type entered for employee and identified as contributing to FLSA hours.

For example:
Earnings Contributing to FLSA Hours | Hours Worked
---|---
Regular Hours | 40
| TOTAL | 40

Table 15 – 8

Formula then produces direct result Overtime Pay:

\[ \text{Overtime hours worked} \times \text{overtime base rate} \]

or

\[ \text{Overtime hours worked} \times \text{overtime base rate} \times \text{Multiple.} \]

Produces indirect result Straight Time Overtime Pay:

\[ \text{Overtime hours worked} \times \text{regular rate.} \]

**See Also**

Structures for Initiated Earnings Types: page 15–18
Shift Pay

Classification: Earnings
Category: Shift Pay
Processing Type: Nonrecurring

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Short-circuits formula and provides Shift Pay run result.</td>
</tr>
<tr>
<td>Hours</td>
<td>Gives shift hours worked to formula.</td>
</tr>
<tr>
<td>Rate</td>
<td>Gives formula the rates to use. Entries here override Rate Code entries.</td>
</tr>
<tr>
<td>Rate Code</td>
<td>Gives formula the codes by which to locate rates in the Wage Rates table.</td>
</tr>
<tr>
<td>Shift</td>
<td>Gives formula shift designator, for locating shift differential in the Shift Differentials table if no entry exists for Rate or Rate Code.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Location entered here prompts system to find the location’s tax code in the table of jurisdiction codes, and use this code to override the code of the employee’s regular work location.</td>
</tr>
<tr>
<td>Date Earned</td>
<td>Signals that this set of entries is for a prior period, not the current period.</td>
</tr>
</tbody>
</table>

Table 15 – 9 Shift Pay Input Values

Employees receive earnings type Shift Pay instead of Regular Wages only when they work a shift other than their usual one. They record work on such a shift by entering a designator, such as E (Evening) or N (Night), on their timecards. Employees working their usual shift need not enter shift designators. They receive Regular Wages with wage rates that already include any applicable shift differential or multiplier.

The Oracle HRMS Shift Differentials Table

Oracle Payroll includes this table for entry of shift differentials. For example, suppose day shift employees earn twice the day rate for the night shift, while evening shift workers earn 1.5 times their rate for night work. Workers from both shifts get three times their regular rate for the split shift. You make these entries in the Shift Differentials table:
Example Shift Differential Table Entries

<table>
<thead>
<tr>
<th></th>
<th>D</th>
<th>E</th>
<th>N</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td>10</td>
<td></td>
<td>20</td>
<td>30</td>
</tr>
<tr>
<td>Evening</td>
<td></td>
<td>10</td>
<td>15</td>
<td>30</td>
</tr>
</tbody>
</table>

Table 15 – 10 Example Shift Differential Table Entries

When a formula for an earnings locates a pay rate or a rate code for pay, it looks also for a shift designator. It uses the designator to find the correct differential for the employee in the Shift Differentials table.

See: Predefined User Tables: page 29 –11

Processing for Shift Pay

The formula for Shift Pay does the following:

Looks for rate to use to determine pay.
If entry exists for the input Value Rate, multiplies shift hours worked by this rate to produce run result.
If there is no entry for Rate but entry for the input value Rate Code exists, uses code to find rate in Wage Rates table. Multiplies shift hours worked by this rate to produce run result.
If there is no entry for Rate Code, takes employee’s regular rate from Regular Wages earnings. Uses shift designator to locate correct differential for regular rate in Shift Differentials table. Multiplies regular rate by differential to obtain shift rate. Multiplies shift hours worked by shift rate to produce run result.

See Also

Structures for Initiated Earnings Types: page 15–18
GTL Imputed Income

*Classification:* Imputed Earnings  
*Category:* GTL Insurance  
*Processing Type:* Recurring

Currently, employer-paid Group Term Life insurance premiums for insurance coverage up to $50,000 are tax-exempt. However, premiums for coverage over $50,000 are taxable as imputed earnings.

The premiums for GTL coverage vary depending on the age of the insured person. They are maintained in the IRS Uniform Premiums table. Oracle maintains this table in Oracle HRMS with the name GTL PREMIUMS.

See: Predefined User Tables: page 29 – 11

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Short-circuits formula and provides GTL Imputed Income run result.</td>
</tr>
<tr>
<td>Coverage Multiple</td>
<td>Gives formula the number by which to multiply employee’s annualized salary to determine GTL coverage.</td>
</tr>
<tr>
<td>Coverage Amount</td>
<td>Gives amount of employee’s GTL coverage to formula. Overrides any entry for Coverage Multiple.</td>
</tr>
<tr>
<td>EE Contribution</td>
<td>Gives formula amount of employee’s contribution, if any, to payments of GTL Insurance premiums.</td>
</tr>
</tbody>
</table>

Table 15 – 11 GTL Imputed Income Input Values

Processing for GTL Imputed Income

(Except for final pay to terminating employees)

The formula for the GTL Imputed Income earnings type does the following:

Determines employee’s GTL insurance coverage amount, if necessary calculating annualized salary from pay information entered in Salary Administration window. Checks if amount exceeds $50,000.

IF no Employee has no imputed income. No further calculations occur.

IF yes
Calculates coverage whose premiums are net taxable imputed income to the employee (Coverage amount – $50,000.00)
Checks employee’s age. Locates monthly premiums by age group per $1,000 of coverage in the table GTL PREMIUMS.
Uses premiums to calculate employee’s imputed earnings. If employee contributed to premium payments, reduces GTL imputed earnings appropriately.

See Also

Structures for Initiated Earnings Types: page 15–18
Company Car

Classification: Imputed Earnings
Category: Personal Use of Company Car
Processing Type: Recurring

The imputed earnings Company Car represents the monetary value to an employee of his or her personal use of a company car. The calculation of this value occurs outside Oracle Payroll. The calculated amount is entered for the input value Imputed Amount.

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Short-circuits formula and provides Company Car Imputed Earnings run result.</td>
</tr>
<tr>
<td>Imputed Amount</td>
<td>Provides the externally-calculated amount of imputed earnings for personal use of a company car.</td>
</tr>
</tbody>
</table>

Table 15 – 12 Company Car Input Values

Processing for Company Car

The Company Car formula does the following:

Checks whether current processing is producing final pay for a terminating employee. If so, deletes entry of Company Car for the employee as of the run date of the current processing.

See Also

Structures for Initiated Earnings Types: page 15 –18
Structures for Initiated Earnings Types

In response to the information you enter for an earnings type or non-payroll payment in the Earnings window, the system generates the essential components of the earnings or payment. These include:

- an element whose structure includes the necessary input values and balance feeds
- a formula prescribing the correct processing for the earnings or payment, together with the formula processing and result rules.

The following sections discuss the particular input values and rules available for a generated earnings type or non-payroll payment, and the circumstances under which they are used. These input values and rules control the following:

- overrides to the tax jurisdiction or date earned of an earnings type
  See: Overrides for Tax Jurisdictions and Dates Earned: page 15–19

- the applicability of supplemental tax withholding to supplemental earnings types processed in Regular runs
  See: Supplemental Withholding in Regular Runs: page 15–20

- payment of an earnings type or non-payroll payment by a separate check, issued in addition to the usual paycheck or direct deposit payment
  See: Payments by Separate Check: page 15–22

- the applicability of deductions to an earnings or payment: all deductions, or only tax deductions, or only tax and pre-tax deductions
  See: Limits on Deductions from a Payment: page 15–23

- the calculation rule used to determine the amount of an earnings or non-payroll payment.
  See: Amount Rules for Earnings and Non-Payroll Payments: page 15–24
Overrides for Tax Jurisdictions and Dates Earned

You must sometimes pay employees earnings for work performed in a tax jurisdiction other than their primary work location, or for work performed in prior periods. To permit you to correctly process such earnings, the structure of all the elements Oracle Payroll generates for earnings in the classification Earnings includes these input values:

- **Jurisdiction**
- **Date Earned**

The input value Jurisdiction takes entries of locations different from employees’ primary work location, when the other entries for the earnings type refers to work done at a location other than the primary location. The payroll run then finds the jurisdiction code (tax code) of the location where this work was performed in the system’s table of jurisdiction codes, so it can process the earnings for this work using the correct tax information.

The input value Date Earned takes entries of the end date of a prior period, when a set of input value entries for the earnings type is for work performed in this earlier period. If the payroll run finds an entry for the Date Earned input value, it processes the earnings using the employee information, including W–4 information, in effect as of the earned date.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jurisdiction</td>
<td>Provides the location for work done somewhere other than the primary work location. Entry of a location here prompts system to find the location’s tax code in the table of jurisdiction codes, and use it to override the code of the employee’s regular work location when calculating taxes.</td>
</tr>
<tr>
<td>Date Earned</td>
<td>Signals that this set of entries is for a prior period, not the current period.</td>
</tr>
</tbody>
</table>

Table 15 – 13 Input Values for Work Location and Period Worked
Supplemental Withholding in Regular Runs

Oracle Payroll includes two types of payroll runs, Regular and Supplemental. A payroll normally has just one Regular run each period, to produce employees’ regular earnings. But it can have many Supplemental runs each period, to process supplemental earnings and final pay for terminating employees, as needed.

The default tax withholding method for Supplemental runs is supplemental withholding. However when these runs process final pay, they always use regular withholding for any regular earnings included in the final pay.

The default withholding method for Regular runs is regular withholding (Percentage or Annualized Wages withholding), but these runs can use supplemental withholding for any included supplemental earnings.

<table>
<thead>
<tr>
<th>Run Type</th>
<th>Withholding Method</th>
<th>Frequency and Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>Default is regular. Can use supplemental for supplemental earnings.</td>
<td>Regular runs are scheduled in advance to process employees’ regular and imputed earnings once each period.</td>
</tr>
<tr>
<td>Supplemental</td>
<td>Default is supplemental. Uses regular to process regular and imputed earnings in final pay.</td>
<td>Supplemental runs occur whenever necessary to process supplemental earnings, and final pay for terminating employees.</td>
</tr>
</tbody>
</table>

Table 15 – 14 Oracle Payroll Run Types

To identify supplemental earnings that Regular runs should process using supplemental withholding, Oracle Payroll generates all earnings types in the Supplemental Earnings classification with an input value Tax Separately. This input value has a default entry of No. If you change this entry to Yes for a supplemental earnings type, Regular runs use supplemental withholding when processing the earnings.

<table>
<thead>
<tr>
<th>Input Values Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Separately</td>
<td>Default No means, apply run’s default withholding method. Yes means, always apply supplemental withholding.</td>
</tr>
</tbody>
</table>

Table 15 – 15 Input Value for Supplemental Withholding

See Also

Tax Withholding Methods: page 18 –4
Payments by Separate Check

You sometimes pay certain earnings or non-payroll payments by separate check, that is, by physically separate checks that employees receive in addition to their regular paychecks or direct deposit payments. For example, you may pay a special bonus or award, or a reimbursement for moving expenses, using a separate check.

For control of separate check payments, the elements generated for all earnings in the Earnings and Supplemental Earnings classifications, and for all payments in the classification Non-payroll Payments, include the input value **Separate Check**.

The Separate Check input value has a default entry of No, matching the default entry of Never in the Separate Check region of the Earnings window.

You can change the Separate Check input value entry back and forth between No and Yes for an earnings type or payment, using the Element Link window. For an individual employee, you can make an entry of No or Yes for this input value using Element Entries window, to stop or enable a payment by separate check.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separate Check</td>
<td>Yes signals that this earnings should be paid by separate check. Default is No.</td>
</tr>
</tbody>
</table>

Table 15 – 16 Input Value for Payment by Separate Check
Limits on Deductions from a Payment

The payroll run usually take all deductions against an earnings type or non-payroll payment, but there can be certain circumstances under which it should take only tax deductions or only tax and pre-tax deductions. So that you can exercise control over deductions processed for a payment, Oracle Payroll generates all earnings in the Earnings and Supplemental Earnings classifications, and all payments in the classification Non-payroll Payments, with the input value Deduction Processing.

The entry in this input value defaults to All (process all deductions), as does the entry in the Deduction Processing region of the Earnings window. You can change this default for an earnings or payment element on its links using the Element Link window, or for individual employees using the Element Entries window.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deduction Processing</td>
<td><em>Tax Only</em> means, process tax deductions only for this separate check payment. <em>PreTax and Tax Only</em> means, process only tax and pretax deductions. Default is All.</td>
</tr>
</tbody>
</table>

Table 15 – 17 Input Value for Tax or Tax and Pre-Tax Deductions Only
Amount Rules for Earnings and Non–Payroll Payments

Oracle Payroll generates each earnings or payment element with the particular input values it needs for the rule that determines the calculation of its amount. The available calculation rules are:

- Flat Amount
- Hours x Rate, or Hours x Rate x Multiple
- Percentage of Regular Earnings

Earnings or Payments with the Rule Flat Amount

The structure of elements generated for earnings or non–payroll payments with this rule includes an input value Amount, for entry of an amount. No calculations are necessary to determine the amount of this earnings or payment.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Gives formula the earnings or payment amount.</td>
</tr>
</tbody>
</table>

Table 15 – 18 Input Value for Amount Rule Flat Amount

Earnings with the Rule Hours x Rate

The elements generated for earnings with this rule include the input values Hours Worked, Rate Code and Rate. Hours Worked holds the number of hours worked at a particular rate or rate code. An entry in the input value Rate Code signals that the rates for this earnings come from the Wage Rates table. An entry of a rate to the input value Rate overrides entry of a rate code.

The Oracle HRMS Wage Rates Table

Oracle HRMS comes with the table WAGE RATES ready to receive entries. This table has one column, named Rate. You can enter as many rows as you need to accommodate your rates. For example, you can enter rates for operating different types of equipment:

As employees operate different equipment, they record on their timecards the codes and hours worked for each. The codes and hours worked go to the input values Rate Code and Hours Worked by means of the PayMIX batch entry facility. The earnings formula uses the codes to locate the correct rates to use for each employee’s pay calculation.
Example Wage Rate Table Entries

<table>
<thead>
<tr>
<th>Code</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL (forklift)</td>
<td>6.80</td>
</tr>
<tr>
<td>A3 (crane A3)</td>
<td>8.20</td>
</tr>
<tr>
<td>A7 (crane A7)</td>
<td>9.00</td>
</tr>
</tbody>
</table>

Table 15–19 Wage Rates Table

Instead of using the Oracle HRMS table for wage rates, you may set up your own rates tables. Notice that if you do this, you must modify the formula generated for earnings with the Hours x Rate or Hours x Rate x Multiple rule, so that it references columns in your table.

See:
Predefined User Tables: page 29–11
Setting Up User Tables: page 29–14
Entering Table Values: page 29–17

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours Worked</td>
<td>Gives formula the hours worked at each rate.</td>
</tr>
<tr>
<td>Rate Code</td>
<td>Gives formula the codes by which to locate rates in the Wage Rates table.</td>
</tr>
<tr>
<td>Rate</td>
<td>Gives formula the rates to use. Entries here override Rate Code entries.</td>
</tr>
</tbody>
</table>

Table 15–20 Input Value for Amount Rule Hours X Rate

Earnings with the Rule Hours x Rate x Multiple

You use this rule to apply an uplift, or increase, to earnings calculated by the Hours × Rate rule. These two rules are very similar, except that earnings generated with the Hours x Rate x Multiple rule include an additional input value, Multiple.

Here you enter a multiple for the calculation. For example, for a pay uplift of 5% above the standard, make an entry of .05 in this input value.
### Earnings with the Rule *Percentage of Regular Earnings*

Oracle Payroll generates elements for earnings with this rule with the input value Percentage, for entry of the percentage to use in the calculation.

For a **salaried employee**, the formula for this rule locates the employee’s regular monthly earnings as an entry in the Monthly Salary input value of the earnings Regular Salary.

For a **waged employee**, it calculates the regular earnings in a pay period by finding the employee’s wage rate and multiplying it by the hours normally worked in a pay period. It locates the employee’s usual hours worked by referencing the work schedule, or if there is none the standard working hours, for his or her assignment. It finds the wage rate by referencing, in this order:

- the employee’s salary basis
- the rate code entered for the employee for the earnings Regular Wages
- the rate entered for the employee for Regular Wages.

See:

- [HR Organizations: Entering a Work Schedule](#)
- [Business Groups and HR Organizations: Work Day Defaults](#)

### Table 15 – 22 Input Value for Amount Rule *Percentage*

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage</td>
<td>Gives formula the percentage to use.</td>
</tr>
</tbody>
</table>

---

15–26 Oracle Payroll US User’s Guide
Initiating Earnings and Non–Payroll Payments

You initiate an earnings type or non–payroll payment by entering information about it in the Earnings window. Oracle Payroll then generates the earnings or payment element with the necessary input values and balance feeds, and its formula with the necessary processing and result rules.

**Note:** You must define, not initiate, certain elements that do not process in the payroll run. This includes elements used for recording employees’ time absent, and for holding information about tangible items provided to employees, such as tools or cellular phones.

See:

- Defining an Element to Hold Information: page 12 – 32

To initiate an earnings type or non–payroll payment, use the Earnings window.

**Prerequisites**

- If you must add a category for the earnings or payment type you are initiating, use the QuickCodes window to enter additional categories for these QuickCode types:
  - US_EARNINGS
  - US_SUPPLEMENTAL_EARNINGS
  - US_IMPUTED_EARNINGS
  - US_PAYMENT.

See: Adding QuickCode Values: page 29 – 3
To set up an earnings type or non-payroll payment:

1. Identify the earnings or payment: page 15–28
2. Enter processing rules for it: page 15–29
3. If necessary, enter rules to control payments by separate check, and to limit the deductions processed against the earnings or payment: page 15–30
4. Review the components generated for the earnings or payment: page 14–6
5. If necessary, make modifications to the generated components: page 14–12

Attention: If you make mistaken entries when initiating an earnings or payment so that the components generated for it need correction, delete all the generated components and re-initiate the earnings or payment.

Identifying the Earnings or Payment

To identify, classify and categorize the earnings or payment:

1. Set the effective date early enough to handle any historical entries. You cannot enter an earnings or payment for employees before its effective start date.
2. Enter a unique name for the earnings or payment, to apply both to the earnings or payment element and formula. It must start with a
letter of the alphabet, not a number or symbol. You can also supply a reporting name, a short name that appears on reports and the statement of earnings.

3. Select the correct classification and category. The classification and category of an earnings or payment help to determine the tax rules and other rules and procedures that apply to it.

4. To enable the earnings or payment to receive entries through PayMIX, check the PayMIX Entry Allowed box.

5. If pay rates for this earnings type should be used in determining overtime base rates for the predefined earnings Overtime under Fair Labor Standards Act (FLSA) rules, check the Overtime Base box. Further, if this earnings type represents pay for hours worked that should be used in determining overtime base rates for the predefined earnings Overtime under FLSA rules, check the FLSA Hours box.

Attention: Oracle Payroll supports FLSA overtime and bonus calculation when the weekly payroll period and the overtime/bonus occur in the same work week. Payroll periods greater than a single work week are not supported at this time and manual calculations of the overtime amounts are required.

See: The Earnings Type Overtime: page 15–10

---

**Entering Processing Rules for the Earnings or Payment**

1. To enter processing rules:

   1. Select Recurring or Nonrecurring as the processing type.

      Select Recurring if entries to the input values of this earnings type or payment, once entered for an employee, should process each period until you change them or they reach their end date. Select Nonrecurring if this earnings type or payment should process only when it receives one or more new entries in a period.

   2. Accept or change the default priority. Its classification gives the earning or payment a default processing priority in the payroll run.

   3. Check the Standard Link box only if Oracle Payroll should automatically enter the earnings or payment, with its default input value entries, for all eligible employees.

See: Automatic Entry of Elements and Default Values: page 12–27
4. Choose the appropriate calculation rule. The exact formula names appearing in the list of values depend on the processing type of the earnings or payment. The basic calculation rules listed are:

- **Flat Amount**, if you enter the earnings or payment amount and no calculation is necessary
- **Hours \times Rate**, if the amount is calculated by multiplying hours worked by a wage rate
- **Hours \times Rate \times Multiple**, if the amount is calculated by multiplying hours worked by a wage rate and a multiplier
- **Percentage of Regular Earnings**, if the amount is calculated by multiplying the regular salary or the wages by a percentage

See: Input Values for Calculation Rules: page 15–24

---

### Separate Check Payments and Limiting Deduction Processing

**To set up payment by a physically separate check:**

1. Choose Yes in the Separate Check region. The default is No.
   
   See: Input Value for Payment by Separate Check: page 15–22

2. Save your work.

**To limit deduction processing against earnings or payment:**

1. Make a selection in the Deduction Processing region. The default is All (all deductions process against the earnings type or payment). For only tax deductions to process, choose Tax Only. For only tax and pretax deductions to process, choose PreTax and Tax Only.
   
   See: Input Value to Control Deduction Processing: page 15–23

2. Save your work.
You initiate the non-tax deductions you need (pretax, benefit, voluntary, and involuntary deductions) in accordance with your own compensation policies, by entering information about them in the Deductions window. The system then generates the components of the deductions.

This chapter explains the structural features of the deductions Oracle Payroll generates for non-tax deductions, and presents the procedures you use to initiate these deductions.
Structures for Initiating Deductions

In response to the information you enter for a deduction in the Deduction window, Oracle Payroll generates the essential components of the deduction. These include:

- one or more deduction elements with the necessary input values and balance feeds
- formulas prescribing the correct processing for the deduction elements, together with the formula processing and result rules.

After initiation of a deduction, you can make certain modifications to the generated components so that they better meet your requirements. It is always best to make such modifications before using the deduction.

See: Modifying an Element Generated for Payroll Processing: page 14 –12

To use the deduction in payroll runs, you must build links, and make entries to its input values.

See: Using Elements: page 12 – 6

All generated deductions include the input values Additional Amount and Replacement Amount, for efficient management of one–time changes to the deduction amount.

See: Changes to Earnings or Deductions before a Run: page 21 –4

Deduction Input Values and Other Special Structures

Oracle Payroll generates a number of specialized input values and other structures for deductions. These structures are used for:

- controlling deduction starts and stops
  See: Deduction Start and Stop Rules: page 16 –8

- providing frequency rules for deductions processing
  Deductions do not have to be withheld in all payroll periods, but are allowed to be withheld on specific payroll periods you determine.
  See: Deduction Frequency Rules: page 16 –10

- storing essential processing information for deductions for Series EE Bond purchase or wage attachment payments.
  See:
  Series EE Bond Deductions: page 16 –11
• managing arrearage
  See: Arrears Management: page 16–13

Initiating Deductions

You initiate a non-tax deduction by entering information in the Deduction window. The system generates the deduction element with the necessary input values and balance feeds, and the deduction formula with the necessary processing and result rules.

Prerequisites

- If the deduction amounts come from a payroll table you must enter the database, set up this table and enter values in it before defining the deduction.

See:
Setting Up User Tables: page 29–14
Entering Table Values: page 29–17

Note: If the rows of a payroll table reference something other than employee pay, age or job class (that is, if the table row type is not Age Range, Salary Range or Job Class), both the table row type and the table must be set up before you define the deduction.

See: Setting Up Row Types for Payroll Tables: page 16–15

To initiate a deduction, use the Deduction window.
To set up a deduction:

1. Identify the deduction: page 16–5
2. Select processing rules: page 16–7
3. If necessary, set frequency rules: page 16–11
4. Determine the deduction amount: page 16–12
5. If necessary, select arrearage rules: page 16–13
6. Review it: page 14–6
7. If necessary, modify the generated components of the deduction: page 14–12

Attention: If you make mistaken entries when initiating a deduction so that components generated for it need correction, delete all the generated components and re-initiate the deduction.

Establishing, Changing, and Ending an Employee’s Deduction

To establish an individual employee’s deduction, use the Element Entries window.
To establish deductions on an employee’s record:

1. Query the deduction and open the Entry Values window.
2. Select the correct deduction amount for the employee.
   
   Note: For a benefit plan, after you enroll an employee by entering a coverage level, the plan deduction’s input values Employer and Employee Contributions automatically receive entries of the default contribution amounts entered for the level in the Benefits Table. Optionally, you can overwrite these defaults for individual employees.

   Note: To enroll many employees in a benefit plan, use the BEE batch entry facility.

   See: Making Non–Payroll Batch Entries Using BEE: page 13 – 51
3. Select a processing priority, if desired.

To change deductions on an employee’s record:

1. Open the Entry Values window for the employee’s deduction.
2. Update the deduction amount, or other details for the employee.
3. Save the updated deduction information.

To end deductions on an employees record:

1. Query the deduction and open the Entry Values window.
2. Select delete record.
3. Respond appropriately to the prompt to Purge or effectively End Date the deduction.
   
   Note: If the deduction contains a year-to-date balance, you cannot purge the record.
4. Save your changes.

Identifying the Deduction

To identify, classify and categorize the deduction:

1. Set the effective date early enough to handle any historical entries. You cannot enter a deduction for employees before its effective start date.
2. Enter a unique name for the deduction. This name applies both to the deduction element and its formula. It must start with a letter of the alphabet, not a number or symbol. You can also supply a reporting name, a short name that appears on reports and the statement of earnings.

3. Select the correct classification for the deduction, and a category if applicable.

Pretax deductions (classification Pre–Tax Deductions) and deductions taken for wage attachments (classification Wage Attachments) require selection of a category.

4. If this deduction pays for a benefit or benefit plan, select the appropriate benefit classification for it.

See: Benefits Administration Overview (Oracle Human Resources North American User’s Guide)

5. To enable the deduction to receive entries through the PayMIX batch entry windows, check the PayMIX Entry Allowed box.

Note: If you do not initially check this box but decide later to allow PayMIX entries for this deduction, do this using the Element window.
Selecting Processing Rules for the Deduction

To enter processing rules:

2. Select Recurring or Nonrecurring as the processing type.
   Select Recurring if entries to this deduction should process until you change or end them. Select Nonrecurring if the deduction should process only when it receives one or more new entries in a period.
   All deductions for Series EE Bond purchase require the processing type Recurring.
3. If this is a deduction for the purchase of Series EE Bonds, check the Series EE Bond box.
4. Accept or change the default priority. The deduction’s classification gives it a default processing priority in the payroll run.
5. Check the Standard Link box only if you want automatic entry of the deduction and its default input value entries for all eligible employees.
   See: Automatic Entry of Elements and Default Values: page 12 – 27
6. Select a run type of Regular or All.
Select Regular for the deduction to process only in Regular runs, that is, the runs that produce employees’ regular pay in each period. Select All to process the deduction in both Regular and Supplemental runs.
See: Regular and Supplemental Runs: page 21–2

7. Select On Entry, Chained, or Earnings Threshold as the rule determining when this deduction starts for an employee:
   • On Entry if the deduction should start as of the effective date you enter it for an employee
   • Chained if this deduction should start up for an employee at the point when another deduction stops. Enter the name of the prior deduction in the input value Chained To.
   • Earnings Threshold if this deduction should start when the employee’s Gross Earnings balance reaches or surpasses a threshold amount. Enter this amount in the input value Threshold Amount.
You can modify the deduction formula to reference a different earnings balance.
See: Deduction Start and Stop Rules: page 16–8

8. Select On Entry or Total Reached as the rule determining when this deduction stops for an employee:
   • On Entry if the deduction should stop as of the effective date you delete it for an employee
   • Total Reached if the deduction should stop when the sum of amounts taken from an employee reaches a specified total. You enter this total in the input value Total Owed.
See: Deduction Start and Stop Rules: page 16–8

Selecting Start and Stop Rules for the Deduction

The elements Oracle Payroll generates for initiated deductions include input values needed for particular start and stop rules. Available start and stop rules are:

<table>
<thead>
<tr>
<th>Start or Stop Rule</th>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Entry start and stop rule</td>
<td>On Entry</td>
<td>N/A</td>
</tr>
<tr>
<td>Chained start rule</td>
<td>Chained to</td>
<td>Gives formula the deduction whose stop triggers this deduction’s start</td>
</tr>
</tbody>
</table>
**See Also**

**Start and Stop Rule: On Entry**

Deduction elements with the On Entry start rule begin for an employee as of the effective date they are entered for him or her. Similarly, they end on the effective date they are deleted for the employee. No input values are required for the On Entry start and stop rules.

**Start Rule: Chained**

Deductions with this rule start for an employee on the date when another deduction stops for the employee. Elements for deductions with the Chained start rule include the input value **Chained To**, for entry of the name of the prior deduction whose stop triggers the chained deduction’s start.

The formula for a deduction with this rule checks to see whether the prior deduction has stopped for employees with entries of this deduction. When it finds that the prior deduction has stopped, it starts the chained deduction.

**Start Rule: Earnings Threshold**

Deductions with this rule start for an employee when a balance of earnings for the employee reaches a specified amount. Elements for deductions with this rule include the input value **Threshold Amount**, for entry of the balance amount that will trigger the deduction’s start.

The formula for deductions with this rule checks whether the payroll run has caused the employee’s year-to-date value of the Gross Earnings balance to reach or surpass the threshold amount. You can modify the generated formula to reference a different balance.
Stop Rule: *Total Reached*

Deductions with this rule stop for an employee when a balance of the amount taken for the deduction reaches a specified amount. Elements for deductions with this rule include the input value *Total Owed*, for entry of the total to be reached that will cause the deduction to stop for an employee.

The formula for deductions with this rule checks whether the payroll run has caused this total to be reached or surpassed.

---

Selecting Frequency Rules for the Deduction

Recurring deductions that process only in Regular runs may require one or more frequency rules. A frequency rule determines the period the deduction processes in, when its processing frequency differs from the pay frequency of employees subject to it.

For example, suppose a deduction should process just once a month for employees on weekly, bi-weekly and semi-monthly payrolls. The deduction should process in the third period of the month for the Weekly-paid employees, and the second period each month for those employees paid bi-weekly and semi-monthly.

You need a frequency rule for each payroll, to specify which period in a month the deduction processes for that payroll.

You can change a deduction’s frequency rules at any time.

---

Annual and Semiannual Frequencies

It is possible set frequency rules to process a once- or twice-yearly deduction on monthly, quarterly or semiannual payrolls. These rules’ periods then refer to periods within a year (months, quarters or half-years) instead of periods within a month.

However, to have better control over an infrequent deduction you can make it nonrecurring, and use the PayMIX batch entry facility to give it entries when it should process.
Setting Frequency Rules for the Deduction

To enter frequency rules:

1. Choose the Frequency Rules button.
2. Select the names of the payrolls for which you are setting frequency rules.
3. Check the boxes for the processing period or periods in which the deduction should process for each payroll.
   
   For example, if you want a monthly deduction to process in the second week of the month for a weekly payroll, check the box under 2 for that payroll.
   
   See: Deduction Frequency Rules: page 16–10

Valid Processing Periods

Notice that some of the periods appearing in the window are not available for some payrolls. For example, periods 4 and 5 are not applicable to payrolls with bi-weekly or semi-monthly periods, because these payrolls can have at most only three periods a month.

Series EE Bond Deductions

For deductions taken to purchase Series EE bonds, the system-generated element includes the input value *Purchase Price*, for entering of the purchase price of the bonds.

The Series EE Bond deduction formula sends the amount deducted for a bond purchase to a special balance, whose name is the deduction name with the words Towards Bond Purchase appended (for example, Series EE Bond 50 Towards Bond Purchase).

When an amount sufficient to cover one or more bond purchases accumulates in this balance, the formula issues a message to this effect
and subtracts the bond purchase price from the Toward Bond Purchase balance amount. The bond purchasing process is external to Oracle Payroll.

When employees terminate, calculation of their final payments includes a refund of any amounts accumulated toward bond purchase.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Price</td>
<td>Gives formula the amount needed for a bond purchase.</td>
</tr>
</tbody>
</table>

Table 16–2 Input Value for Series EE Bond Deductions

See Also

Selecting Processing Rules for the Deduction: page 16–7

**Determining the Deduction Amount**

To determine the deduction amount:

1. Choose the Amount Details alternative region.
2. Select Flat Amount, % Earnings, Payroll Table or Benefits Table as the amount rule:
   - Flat Amount, if you enter an amount at the employee level from the Element Entry window for the deduction.
   - % Earnings, if you enter a percentage at the employee level from the Element Entry window for the deduction formula.
   - Payroll Table, if the amount comes from a previously created table you enter
   - Benefits Table, if the amount comes from the Oracle HRMS Benefits Table. For example, medical, dental and vision benefit plans, the Benefits Table holds the available coverage levels and contribution amounts for each level.

3. If the amount rule is Payroll Table, select in the Payroll Table region the name and row type of the table. Also, select the name of the table column in which the deduction formula should look for the deduction amounts.

   **Note:** The payroll table rows may have a row type other than Age Range, Salary Range or Job Class. In this case, after setting up this deduction you must modify its generated formula to reference the row type and the appropriate database item. The formula has the name of the deduction with the words PAYROLL_TABLE added.

   See:
   - Setting Up Row Types for Payroll Tables: page 16–15
   - Setting Up User Tables: page 29–14

4. If the amount rule is Benefits Table, complete the deduction setup by setting up the appropriate benefit plan in the Benefits Table, using the Benefit Contributions window. First save your deduction in this window.


---

**Selecting Arrearage Rules for the Deduction**

When employee earnings are insufficient to permit the payroll run to take the full amount of a deduction, the system can hold amounts not taken in an arrears balance. Elements generated for deductions you mark to hold arrearage include special input values for management of arrears balances.
These input values are special in that they function without you ever seeing them or making entries to them. They receive their entries automatically during the payroll run.

The special input value *Not Taken* holds any amount not taken for the deduction in the most recent payroll run. The special input value *Arrears Contribution* feeds the arrears balance.

**To manage insufficient funds:**

1. Check the Arrearage box to hold an arrears balance for the deduction. The arrears balance takes the deduction’s name. If you do not check this box, no arrears balance is held for this deduction.

2. Check the Partial Deduction box to take a partial amount when earnings are insufficient to take the full deduction amount.

   If you check this box but do not check the Arrearage box, the system does not hold an amount not taken in an arrears balance.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Taken</td>
<td>Receives any amount not taken in the most recent payroll run.</td>
</tr>
<tr>
<td>Arrears Contribution</td>
<td>Receives results of the calculation of Scheduled Amount minus Pay Value for most recent run. Feeds this result to the arrears balance.</td>
</tr>
</tbody>
</table>

**Table 16 – 3 Special Input Values Generated for Arrears Management**

The table below presents an example of how the entries automatically made to these input values work to maintain the arrears balance.

*Scheduled deduction amount per run: $50

Pay Value = Amount actually deducted in each run*

<table>
<thead>
<tr>
<th>Run</th>
<th>Pay Value</th>
<th>Not Taken</th>
<th>Arrears Contribution</th>
<th>Arrears Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>50</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>30</td>
<td>20</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>3</td>
<td>10</td>
<td>40</td>
<td>40</td>
<td>60</td>
</tr>
</tbody>
</table>

**Table 16 – 4 Arrears Management Example**
The system also makes use of the special input value *Adjust Arrears* in managing arrearage. For more information about this input value, see: Changes to Earnings or Deductions Before a Run: page 21–4

To review an employee’s arrears balance for a deduction, use the View Earnings and Deductions Balances window.

Reviewing Earnings and Deductions Balances: page 14–8

### Setting Up Payroll Tables

When a deduction’s formula finds the deduction amounts in a payroll table, these amounts most commonly vary with employees’ ages, pay or job class. This example payroll table holds union dues amounts that vary with employee pay:

<table>
<thead>
<tr>
<th>Salary Range</th>
<th>Union A</th>
<th>Union B</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.00 – 7.50</td>
<td>10.00</td>
<td>12.00</td>
</tr>
<tr>
<td>7.51 – 10.00</td>
<td>15.00</td>
<td>18.00</td>
</tr>
<tr>
<td>10.01 – 15.00</td>
<td>20.00</td>
<td>23.00</td>
</tr>
</tbody>
</table>

Table 16–5 Example Payroll table where Rows Represent Pay

Oracle HRMS includes the *row types* Age Range, Salary Range and Job Class, already set up and ready for use for payroll tables holding deduction amounts.

For payroll tables whose rows do not reference employee age, pay or job class, you set up the additional row types you require. The new row type may reference information already in the HRMS database as a database item. For example, a new row type can reference employees’ positions.

Alternatively, the new type may reference information not previously existing in the database. For example, instead of referring to pay...
ranges, the rows of a table holding amounts of union dues deductions can refer to union–defined skill levels not found elsewhere in your HRMS database:

<table>
<thead>
<tr>
<th>Skill Level</th>
<th>Union A</th>
<th>Union B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apprentice</td>
<td>10.00</td>
<td>12.00</td>
</tr>
<tr>
<td>Journeyman</td>
<td>15.00</td>
<td>18.00</td>
</tr>
<tr>
<td>Craftsman</td>
<td>20.00</td>
<td>23.00</td>
</tr>
</tbody>
</table>

Table 16 – 6 Example Payroll Table where Rows do not Represent Pay, Age or Job

The procedure for setting up a new row type varies depending on whether the row references a database item or not. If the row references a database item, you use the QuickCodes window. If it does not reference a database item, you first use the QuickCode Types window and then the QuickCodes window.

**To set up row types that reference database items:**

1. In the QuickCodes window, and query the QuickCode type US_TABLE_ROW_TYPES in the Type field.
2. Enter a suitable short code for the new row type, and the meaning of the code. For example, if the new row type references employees’ positions, you could enter the code POS and the meaning Position.
3. Optionally, enter a description for the new row type. The start date defaults to the effective date. You can change this default. Save your work.

**To set up row types that do not reference database items:**

1. In the QuickCode Types window, enter an appropriate QuickCode type for the new row type. For example, to set up a row type for the table holding union dues deduction amounts that vary by employees’ union–defined skill levels, set up a QuickCode type SKILL_LEVEL.
2. Save your work.
3. Navigate to the QuickCodes window, query the new QuickCode type in the Type field, and enter a short code and meaning for each code belonging to the type.

These are example QuickCode entries for the QuickCode type SKILL_LEVEL:
Table 16 – 7

<table>
<thead>
<tr>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>APP</td>
<td>Apprentice</td>
</tr>
<tr>
<td>JRN</td>
<td>Journeyman</td>
</tr>
<tr>
<td>CRFT</td>
<td>Craftsman</td>
</tr>
</tbody>
</table>

4. Optionally, enter a description for the new row type. The start date defaults to the effective date. You can change this default.

5. Save your work.

6. Clear the entries in the QuickCodes window, and query the QuickCode type US_TABLE_ROW_TYPES in the Type field. Then add the new QuickCode type to the list of codes and meanings available as QuickCodes for the type US_TABLE_ROW_TYPE.

Note: After setting up a deduction whose amount comes from the table using the new row type, you must use the Formulas window to modify the formula generated for the deduction so that it references the new row type. The formula has the name of the deduction with the words PAYROLL_TABLE added.

**Setting Up Benefit Tables**

Deductions taken to pay for medical, dental or other benefit plans have the amount rule Benefits Table, so that the payroll run goes to the Oracle HRMS Benefits Table for the amounts of these deductions. After initiating a deduction with the Benefits Table amount rule, set up the benefit plan in Benefits Table by entering in this table:

- the plan’s available coverage levels
- the default employee and employer contributions at each level.

To make these entries, use the Benefit Contributions window.

**Prerequisites**

Before setting up a benefit plan with coverage levels in the Benefit Contributions window, you must first define a deduction with the amount rule Benefits Table, for contributions taken to pay for the plan. These may be employee contributions, employer contributions, or both.

Notice that the deduction for a benefit plan with coverage levels requires both a primary classification and a benefits classification.
Oracle HRMS includes these coverage levels for a benefit plan:

- Employee Only
- Employee and Spouse
- Employee and Children
- Employee and Family

If you need additional coverage levels, use the QuickCodes window to add them for the QuickCode Type US_BENEFIT_COVERAGE.

Information entered in the Benefit Contributions window goes into the Oracle HRMS Benefits table, for the system to access when you enroll an employee in the plan.

To set up benefit coverage levels and contribution amounts:
1. Query the benefit plan in the Benefit Contributions window
2. Select the coverage levels available for the benefit plan.
3. For each level, enter an employee and an employer contribution amount.
   
   **Note**: Enter a contribution amount of zero when a plan has no contribution from the employer and/or from the employee.
4. Save your work.
5. Query the benefit plan from the Element window,
6. Click in the Further Information field to open the Further Element Information window.

7. Select a period in the Period Type field to identify the frequency with which the contributions entered in the Benefit Contributions window are paid.

   **Note:** Many contributions for health care plans are paid monthly. In this case, select Calendar Month as the period type.
CHAPTER 17

Wage Attachments

You initiate wage attachments by entering information about them in the Deductions window. The system then generates the components of the wage attachments. If your company policies indicate fees for processing the wage attachment, as allowed in some states, the software allows you to date effectively maintain fees and fee limits for administering wage attachments.

This chapter explains the structural features of the deductions Oracle Payroll generates for wage attachments, and presents the procedures you use to initiate these deductions.
Structures for Wage Attachments

In response to the information you enter for a wage attachment in the Deduction window, Oracle Payroll generates the essential components of the deduction. These include:

- one or more deduction elements with the necessary input values and balance feeds
- formulas prescribing the correct processing for the deduction elements, together with the formula processing and result rules.

After initiation of a wage attachment, you can make certain modifications to the generated components so that they better meet your requirements. It is always best to make such modifications before using the deduction.

See: Modifying an Element Generated for Payroll Processing: page 0–12

To use the wage attachment in payroll runs, you must build links, and make entries to its input values.

See: Using Elements: page 12–6

All generated deductions include the input values Additional Amount and Replacement Amount, for efficient management of one-time changes to the deduction amount.

Involuntary deductions, or wage attachments, belong to one of these categories:

- Credit Debt/Garnishments
- Bankruptcy Order
- Federal, State or Local Tax Levy
- Spousal Support Order, Child Support Order, and Alimony
- Educational Loan
- Employee-Requested Payment

**Note:** If you prefer to manage wage attachments using an external system, Oracle Payroll comes with some simple garnishment deductions already set up, to which you can make entries for payroll processing. These deductions all belong to the classification Wage Attachment and to the category Garnishments.

Payment of Wage Attachments or Garnishments

Oracle Payroll’s Check Writer process can produce checks for payment of Wage Attachments or garnishments either to organizations, or to individuals.
Input Values for Wage Attachments

When you initiate Wage Attachments, the elements the system generates have the following input values:

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Gives amount to deduct each pay period if the deduction amount rule is <em>Flat Amount</em>.</td>
</tr>
<tr>
<td>Pay Value</td>
<td>N/A for wage attachments.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Overrides employee’s work state as source of the legislation used to administer the attachment. This is on a state–by–state basis as not all states honor court orders issued by other jurisdictions or will honor the order but follow the legislative requirements of the employee work state.</td>
</tr>
<tr>
<td>Attachment Number</td>
<td>Records court-issued identification number, the case number, sometimes the Social Security Number of the employee.</td>
</tr>
<tr>
<td>Total Owed</td>
<td>Gives formula the total amount owed, if applicable for the deduction category.</td>
</tr>
<tr>
<td>Date Served</td>
<td>Holds the attachment’s date of issue. This can help to set priorities if multiple wage attachments exist.</td>
</tr>
<tr>
<td>Arrears Dedn Amount</td>
<td>Gives formula a court-specified amount to be withheld each period to cover any existing arrearage.</td>
</tr>
<tr>
<td>Date in Arrears</td>
<td>If arrearage exists, gives formula the date from which it started. This information is supplied by the court order.</td>
</tr>
<tr>
<td>Number of Dependents</td>
<td>Gives formula the number of dependents that can affect calculation of the employee’s exempt earnings. Generally, this field is not applicable except for employees residing in Delaware. If the employee has multiple children on different orders, this field should hold the sum total of all the dependent children.</td>
</tr>
<tr>
<td>Filing Status</td>
<td>Holds filing information from federal form 668W, part 3. This information does not have to match federal W–4.</td>
</tr>
<tr>
<td></td>
<td>Note: Must be entered for federal tax levies; will not default to W–4 information.</td>
</tr>
<tr>
<td>Allowances</td>
<td>Holds withholding allowance information from federal form 668W, part 3.</td>
</tr>
<tr>
<td></td>
<td>Note: Must be entered for federal tax levies; will not default to W–4 information.</td>
</tr>
<tr>
<td>Dedns at Time of Writ</td>
<td>Gives formula the total dollar amount of employee’s non-tax deductions as of the date served, which can affect calculation of employee’s exempt earnings for tax levies. The deduction amounts may vary periodically. Examples include medical premiums and union dues.</td>
</tr>
</tbody>
</table>

Table 17 – 1 Input Values for Deductions for Wage Attachments
### Purpose of Entry

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percentage</td>
<td>Gives percentage to use if the deduction amount rule is % Earnings. Calculated by the system, when applicable.</td>
</tr>
<tr>
<td>Arrears Bal Amount</td>
<td>Holds arrearage information supplied on the court order.</td>
</tr>
<tr>
<td>Support Other Family</td>
<td>This field holds a value of Yes or No, and affects the employees exempt wages for support orders.</td>
</tr>
<tr>
<td>Date Earned</td>
<td>N/A for wage attachments.</td>
</tr>
<tr>
<td>Payee Details</td>
<td>Holds the information about the recipient of the wage attachment, such as the estranged spouse or a creditor. This is established as a personal payment method, and there can be multiple values for an employee record, such as for a support order payment AND a creditor debt, or multiple support orders.</td>
</tr>
<tr>
<td>Processing Priority</td>
<td>The first field gives the system assigned processing priority. The second field lets you determine the processing sequence or priority of multiple wage attachments.</td>
</tr>
</tbody>
</table>

| Table 17 – 1 Input Values for Deductions for Wage Attachments |

**Attention:** If you have no value to supply, leave the field blank. It is not required to enter data in any field that is not appropriate to your particular deduction or state.

The following matrix identifies the status (optional, suggested, mandatory) of the entry value category for each type of wage attachment.

<table>
<thead>
<tr>
<th>Entry Value Category</th>
<th>Creditor Debt</th>
<th>Federal Tax Levy</th>
<th>Support Orders</th>
<th>Educational Loans</th>
<th>Employee Requested</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Optional</td>
<td>N/A</td>
<td>Required</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Attachment Number 1</td>
<td>Suggested</td>
<td>Suggested</td>
<td>Suggested</td>
<td>Suggested</td>
<td>Suggested</td>
</tr>
<tr>
<td>Total Owed</td>
<td>Required</td>
<td>Required</td>
<td>N/A</td>
<td>Required</td>
<td>Optional</td>
</tr>
<tr>
<td>Date served</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
<td>Optional</td>
</tr>
<tr>
<td>Arrears Deduction Amount</td>
<td>N/A</td>
<td>N/A</td>
<td>Optional</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Date In Arrears</td>
<td>N/A</td>
<td>N/A</td>
<td>Optional</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Number of Dependents</td>
<td>N/A</td>
<td>N/A</td>
<td>Optional 2</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Wage Attachment Formulas

The system generates one of three basic formulas for a Wage Attachment, depending on whether it is a tax levy, a support order, or credit debt. Separate formulas exist for tax levies and child support orders because there are special rules to determine exempt earnings for these categories of attachment.

Whichever formula is used, formula processing of Wage Attachments occurs in three steps:

- **Determination of employee disposable wages** or **take home pay** (earnings minus tax and any other allowable deductions),
and of his or her **exempt earnings** or **exemption allowance** (percentage of disposable wages not subject to attachment).

- **Calculation of the amount to withhold.** The Wage Attachment court order will provide the amount to be withheld per pay period and/or a total amount due. If no pay period amount is entered, Oracle Payroll will default to the maximum amount allowed by law. Added to the base amount may be an **arrearage amount** specified in the court order, and any **fees** that state law permits employers to withhold to cover their setup and administration costs.

- **Verification of amounts withheld.** After the calculation of all Wage Attachments for an employee, a formula checks to ensure that all rules and limits applicable to these attachments have been taken into account. If it finds any violations, the formula makes adjustments to the previously calculated amounts, prorating them and creating arrearages if necessary.

  **Note:** The system holds calculation and verification results on two elements specially generated for this purpose, not on the base element for the Wage Attachment. These two elements have the base element name with “Calculator” or “Verifier” added.

  For example, if an wage attachment for a child support order has the name Child Supp1, the elements generated for the deduction have the names Child Supp1, Child Supp1 Calculator, and Child Supp1 Verifier.

**See Also**

Producing a Check for Wage Attachments: page 17–12

**Garnishment Deductions From External Systems**

You can use an external system to manage wage attachments. If you want to make entries from that system into Oracle Payroll for payroll processing, you can use five predefined deductions that come with Oracle Payroll:

- Child Support
- Federal, State and Local Tax Levies
- Creditor Garnishment

These deductions all belong to the classification Wage Attachment and the category Garnishments, and all have the processing type Recurring. To use them you need only make links for them and provide balances.
Input Values for Wage Attachments

These deductions for garnishments all have the same input values:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Gives deduction amount to formula.</td>
</tr>
<tr>
<td>Total Owed</td>
<td>Gives formula the total amount owed for this levy or garnishment. This triggers the deduction's stop.</td>
</tr>
<tr>
<td>Guaranteed Net</td>
<td>Gives formula employee's guaranteed amount of take-home pay.</td>
</tr>
</tbody>
</table>

Table 17 – 3 Garnishment Deductions Input Values

Formula Processing for Wage Attachments

The formulas for these garnishment deductions do the following:

- Calculate deduction amount. Check whether employee’s net pay will be greater than Guaranteed Net amount after taking deduction.
- IF net pay not greater than Guaranteed Net amount, hold amount not taken and feed garnishment arrears balance.
- IF total owed is reached, stop processing garnishment for this employee.
- IF processing is producing final pay for a terminating employee, attempt to collect total amount owed.
- IF collection of total amount owed would reduce net pay below guaranteed net, issue message reporting how much has been taken and how much remains to be taken.

See Also

Producing a Check for Wage Attachments: page 17–12

Initiating Wage Attachments

You initiate an wage attachment by entering information about it in the Deduction window. The system generates the deduction element with the necessary input values and balance feeds, and the deduction formula with the necessary processing and result rules.
Prerequisites

- If you must add a category for the deduction you are initiating, use the QuickCodes window to enter additional categories for this QuickCode value:
  - US_INVolUNTARY_DEDUCTIONS
  See: Element Classifications and Categories: page 12 – 8

- If the wage attachment amounts come from a payroll table you must enter the database, set up this table and enter values in it before defining the deduction.
  See:
  Setting Up User Tables: page 29 – 14
  Entering Table Values: page 29 – 17
  Note: If the rows of a payroll table reference something other than employee pay, age or job class (that is, if the table row type is not Age Range, Salary Range or Job Class), both the table row type and the table must be set up before you define the deduction.
  See: Setting Up Row Types for Payroll Tables: page 0 – 14

To initiate a wage attachment, use the Deduction window.

Identifying the Wage Attachment

- To identify, classify and categorize the wage attachment:
  1. Set the effective date early enough to handle any historical entries.
  
  ![Attention:](image) You cannot enter a deduction for employees before its effective start date.

  2. Enter a unique name for the wage attachment.

  This name applies both to the deduction element and its formula. It must start with a letter of the alphabet, not a number or symbol. You can also supply a reporting name, a short name that appears on reports and the statement of earnings.

  ![Attention:](image) You cannot reuse the name of an wage attachment if this employee should have another similar wage attachment. Each instance of an wage attachment must have a unique name.

  4. Select a category.
Wage Attachments require selection of a category, such as alimony, or credit debt.

The system automatically sets up the processing rules and arrearage rules for the wage attachment.

Ending a Wage Attachment

Wage attachments are ended when the court issues a release notice, or in the case of the federal tax levies Form 668-D is received.

Note: Oracle Payroll automatically stops issuing wage attachments from wages when the total owed is reached, regardless of whether a court-issued notice or form 668-D is received.

If you need to manually end an wage attachment (such as when an employee makes a lump sum payment to the Payee and the court issues a release notice, or when a dependent child reaches legal maturity), you can manually stop the wage attachment.

To end an wage attachment:

1. Select Delete Record from the Edit menu.

   The system displays a dialog box asking if you want to purge the record from the database or if you want to set an effective end date.

   Attention: If there is any history associated with this wage attachment, the software will not allow you to purge this record. In this situation, you must set an effective end date.

2. Select the option that is best for your situation.

Attaching Wage Attachments to the Employee

To establish wage attachment on an employee’s record:

1. Query the wage attachment and open the Entry Values window.

2. Enter the appropriate required, suggested, and optional values for the wage attachment entry values.

   Note: Much of this information can be found on the court order for the wage attachment.

   Attention: Federal Tax Levies continue to accrue interest until fully paid; the face amount of the levy is seldom the amount actually due.
3. Select a processing priority, if desired.

To set processing priorities among deductions for wage attachments for an employee with more than one such deduction, enter secondary priorities for the deduction elements using the Entry Values window (accessed from the Element Entries window). Elements with lower priority numbers process first.

The standard priority order for processing the various categories of attachment is this:

- Bankruptcy orders
- Support orders effective before federal tax levies
- Federal tax levies
- Support orders effective after federal tax levies
- State tax levies
- Creditor garnishments
- All other attachments.

To change wage attachments on an employee’s record:

1. Open the Entry Values window for the employee’s wage attachment.
2. Update the deduction amount, or other details for the employee.
3. Save the updated deduction amount.

To end wage attachments on an employees record:

1. Query the wage attachment and open the Entry Values window.
2. Select delete record from the Edit menu.
   
   The system displays a dialog box asking if you want to purge the record from the database or if you want to set an effective end date.

   **Attention:** If there is any history associated with this wage attachment, the software will not allow you to purge this record. In this situation, you must set an effective end date.
3. Select the option that is best for your situation.
4. Save your changes.

Making Payments for Wage Attachments

To produce checks for payment of Wage Attachments to individuals or organizations named in attachment orders, you make use of third party payment methods.
Setup Steps for Wage Attachment Payments

To set up payments of a Wage Attachment:

1. Enter the recipient of the payments, either an individual or an organization, into the database. The name and address of the recipient appears on the payment checks.

   For an attachment payable to an individual, use the Contact window to enter the individual as a contact of the employee, with the relationship Payments Recipient.

   See: Entering Dependents, Beneficiaries, and Other Employee Contacts: page 0 – 16

   For an attachment payable to an organization, use the Organization window to enter the organization’s location and then the organization, giving it the classification Payee Organization.

   See:
   Setting Up Site Locations: page 2 – 2
   Creating an Organization: page 2 – 20

2. Define a third party payment method for use in your enterprise, using the Organizational Payment Method window. In the Valid Payment Methods window, select this method as a valid payment method for the payroll to which the employee with the Wage Attachments is assigned.

   See:
   Defining Payment Methods for the Enterprise: page 0 – 3
   Defining a Payroll: page 0 – 6.

3. Using the Personal Payment Method window, select the third party payment method (Step 2 above) as a personal payment method for the employee subject to the Wage Attachment. Enter on this personal payment method the type (individual or organization) and name of the payee.

   See: Entering Payment Methods for an Employee Assignment: page 9 – 21

4. For the employee subject to the Wage Attachment, use the Element Entries window to make entries to the input values of the Wage Attachment. In the Payee Details field, select the name of the personal payment method set up to make the payments for this attachment.

   See: Manual Element Entry for Individual Employees: page 12 – 27
Entries to the deduction’s input values provide essential information about the Wage Attachment, such as its unique identification number, its amount, the date it was served, and arrearage to be recovered.

See: Structures for Wage Attachments: page 17–2

5. After processing the Wage Attachment in a payroll run and running the Pre–Payments process for the run results, you are ready to produce a check for payment of the Wage Attachment.

**Producing a Check for a Wage Attachment**

To produce a check for payment of a Wage Attachment, run the Check Writer process from the Submit Request window.

**To produce a check for payment of a Wage Attachment:**

1. In the Name field of the Submit Request window, select Check Writer. If the Parameters window does not open automatically, click in the Parameters field.

2. For the Payroll parameter, select the payroll to which the employee subject to the Wage Attachment has an assignment. The default consolidation set of this payroll appears in the Consolidation Set field. You can select a different consolidation set.

3. In the date fields, enter the date of the Pre–Payments process on whose results this Check Writer process depends. To produce a number of checks for Wage Attachments for which Pre–Payments processes were run over a period of time, enter the start and end dates of this time period.

4. For Payment Method, select the name of the third party payment method to be used for making this payment. For Check Style, select Third Party Check.

5. The Sort Sequence defaults to Organization, Person. If other sequences are defined for your installation, you can select one of them.

6. For Start Check Number, enter the number of the first check to produce in this check run.

7. Choose OK, then Submit.

**Note:** Consult with your supplier of business forms to determine the formatting and numbering system to use on your checks.
Oracle Corporation has worked with Evergreen Business Forms Inc. (telephone 1-800-248-2898) to produce check formats for use with Oracle Payroll.

See Also

Producing a Check for Wage Attachments: page 17–12
**Wage Attachment Fee Administration**

Many states allow employers to recoup costs for administering Wage Attachments, such as court-ordered support and creditor garnishment.

Oracle Payroll allows you to date effectively maintain fees and fee limits for administering Wage Attachments in a given state according to your company policy. You are responsible for setting up and maintaining fee amounts for each state in which you have employees.

Using the Wage Attachment Fee Rules window you can create a new Wage Attachment fee rule, update an existing Wage Attachment fee rule, conclude an obsolete Wage Attachment fee rule, and reinstate a Wage Attachment fee rule that concluded.

**Wage Attachment Fee Categories**

You can recoup costs for administering Wage Attachments for the following categories:

- Alimony
- Bankruptcy Order
- Child Support Order
- Credit Debt
- Educational Loan
- Employee Requested
- Tax Levy
- Garnishment
- Spousal Support Order

**Wage Attachment Fee Rules**

Wage Attachment Fee Rules Administration allows you to date effectively create, maintain, conclude, and reinstate fees and fee limits for administering Wage Attachments in a given state according to your company policy.

*Note:* For each state there can exist only one Wage Attachment fee rule per Wage Attachment category. You cannot have multiple Wage Attachment fee rules per Wage Attachment category for the same state.

The following rules help you define, maintain, and limit Wage Attachment fee administration:

**Amount.** You recoup a flat dollar amount fee for administering a specified Wage Attachment category using this rule.

**Amount or percent.** You recoup a flat dollar amount or a fixed percentage amount fee (whichever is the greater) for administering a specified Wage Attachment category using this rule.
Amount to maximum per month. You recoup a flat dollar amount fee for administering a specified Wage Attachment category using this rule. This Wage Attachment fee rule is capped and cannot exceed the cap in any given month.

Amount to maximum per period. You recoup a flat dollar amount fee for administering a specified Wage Attachment category using this rule. This Wage Attachment fee rule is capped and cannot exceed the cap in a specified period.

Amount to maximum per run. You recoup a flat dollar amount fee for administering a specified Wage Attachment category using this rule. This Wage Attachment fee rule is capped and cannot exceed the cap in any payroll run.

Initial and subsequent amounts. You recoup initial startup costs for administering a specified Wage Attachment using this rule. This rule establishes a subsequent fee for ongoing administration of this Wage Attachment category.

Initial and subsequent amounts to maximum per month. You recoup initial startup costs for administering a specified Wage Attachment using this rule. This rule establishes a subsequent fee (with a monthly cap) for ongoing administration of this Wage Attachment category.

Initial and subsequent amounts to maximum per period. You recoup initial startup costs for administering a specified Wage Attachment using this rule. This rule establishes a subsequent fee (with a cap for the specified time period) for ongoing administration of this Wage Attachment category.

Initial and subsequent amounts to maximum per run. You recoup initial startup costs for administering a specified Wage Attachment using this rule. This rule establishes a subsequent fee (with a specified cap for any payroll run) for ongoing administration of this Wage Attachment category.

Creating Wage Attachment Fee Rules

Creating Wage Attachment fee rules consists of creating the Wage Attachment fee rule (frequency and amount, initial startup fee, etc.) and associating it with a Wage Attachment fee category for the specific states in which you have employees residing.

Note: For each state there can exist only one rule per Wage Attachment category. You cannot have multiple Wage Attachment fee rules per Wage Attachment category in the same state.
Attention: Before creating a Wage Attachment fee rule, be sure to set your effective date appropriately.

See Setting Your Effective Date: page 1 - 11.

You access the Wage Attachment Fee Administration window from the Compensation and Benefits section of the Navigator.

To create a Wage Attachment fee rule:

1. Select information for State, Category, and Rule from the list of values for each field.
2. Fill in appropriate amounts in the amount fields according to your company policies including correspondence fees.
3. Save your Wage Attachment fee rule.

Updating Wage Attachment Fee Rules

You can update your Wage Attachment fee rules to change fee amounts, to adjust the cap, or the frequencies of attachments. You cannot update the state or category as that would in effect be creating a new Wage Attachment fee rule.

Note: For each state there can exist only one rule per Wage Attachment category. You cannot have multiple Wage Attachment fee rules per Wage Attachment category in the same state. You cannot change the state or the category when updating the Wage Attachment fee rules.

Attention: Before updating a Wage Attachment fee rule, be sure to set your effective date appropriately.
To update a Wage Attachment fee rule:
1. Query the Wage Attachment rule you wish to update.
2. Change the values that need updating, such as the Wage Attachment fee rule, or the amount of the Wage Attachment fee.
3. Save your Wage Attachment fee rule.
4. Select Update from the dialog box, or if the nature of your update is to correct a Wage Attachment fee rule that has incorrect information, select Correct.

Ending Wage Attachment Fee Rules
If there are no records associated with a Wage Attachment rule, you may want to delete the rule. However, once a Wage Attachment fee rule is in use, you do not want to delete it.

If you decide to date effectively end the Wage Attachment rule, you will not be able to reinstate it in the future, you must recreate it.

The best way to conclude a Wage Attachment fee rule is to set the value of the fee to zero dollars.

Attention: Before Ending a Wage Attachment fee rule, be sure to set your effective date appropriately.

To end a Wage Attachment fee rule:
1. Query the Wage Attachment fee rule you want to conclude.
2. Change the amount fields’ values to zero dollars.
3. Save your Wage Attachment fee rule.
4. Select Update from the dialog box.

Reinstating Wage Attachment Fee Rules
If a Wage Attachment fee rule concluded by setting the values of the amount categories to zero, you can reinstate the rule by updating the amount value.
Attention: Before reinstating a Wage Attachment fee rule, be sure to set your effective date appropriately.

To reinstate a Wage Attachment fee rule:
1. Query the Wage Attachment fee rule you want to reinstate.
2. Change the amount fields' values from zero to the correct amount.
3. Save your reinstated Wage Attachment fee rule.
4. Select Update from the dialog box.

Viewing Rules

The Wage Attachment Exemption Rules window allows users to view legislative data for informational purposes only. This window displays all legislative rules supported by Oracle Payroll concerning wage attachment disposable income exemption calculations.

The Wage Attachment Limit Rules window allows users to view the currently identified limit rules: minimum and maximum withholding amounts per periodmaximum withholding duration. These rules can be affected by different state and wage attachment categories.

To view Wage Attachment Exemption Rules:
- Navigate to the Exemption Rules in the View section of the Navigator

To view Wage Attachment Limit Rules
- Navigate to the Limit Rules in the View section of the Navigator.
Wage Attachment Earnings Rules

Wage Attachment Disposable Income Administration allows users to date effectively define and maintain which Supplemental and Imputed earnings should be included as part of disposable income for support orders or other garnishments.

Oracle Payroll provides initial setup data, which you are able to add and modify to suit your business practices.
Taxes

Essential to payroll processing is the calculation of tax liability. The payroll run must determine:

• employees’ liability for federal, state and local taxes
• employer liability for federal level taxes:
  – Social Security (FICA–OASDI)
  – Medicare (FICA–HI)
  – Federal Unemployment Tax Act (FUTA)
• employer liability for state level taxes:
  – State Unemployment Insurance (SUI)
  – State Disability Insurance (SDI)

So that Oracle Payroll can calculate these liabilities correctly and issue reports on them, you must maintain a substantial body of tax–related information. This chapter presents a review of this information, and an outline of the tax calculations that occur when payroll runs.

For a discussion of Workers Compensation, see the chapter Workers Compensation.
Maintenance of Tax Information

For the correct calculation and reporting of employee and employer tax liabilities at the federal, state and local levels, including Workers Compensation liabilities, you must maintain tax–related information for:

- each GRE (GRE/Legal Entity) included in your Business Group
- your employees
- certain categories of earnings types and deductions.

Tax Information for GREs

Each GRE represents an employer for which the US Internal Revenue Services provides an identifying number for tax purposes (sometimes called the employer identification number). When creating an organization classified as a GRE, you must enter federal, state and local tax rules for it. These rules include information such as the following:

- the GRE’s federal–level supplemental withholding calculation method, and any common paymaster for the GRE’s employees
- self–adjust methods in use at the federal and state levels
- at the state level, rates needed for calculation of SUI
- identifiers used at the state and local levels.

See: Entering Federal, State, and Local Tax Rules for GREs: page 18 –9

W–4 and other Tax Data for Employees

For each employee assignment, you maintain information taken from the W–4 Employee’s Withholding Allowance Certificate that employees must complete, as well as certain additional tax–related information.

See: Tax Information for an Employee Assignment: page 18 –13

Taxability Rules for Earnings and Deductions Categories

Regular and overtime earnings are always subject to federal and state taxes. However at any point in time, other categories of earnings, and certain categories of pre–tax deductions, may be subject to different types of taxes and tax withholding at the federal and state levels.
Oracle Payroll comes with the current rules for the federal and state-level taxability already in place for a number of categories of supplemental and imputed earnings types, and for three categories of pre-tax deductions. These rules are updated as necessary in subsequent releases of Oracle Payroll.

See: Reviewing and Maintaining Taxability Rules: page 18–33

Rules for Workers Compensation

States have different rules regarding the earnings categories to include in the payroll exposure used to calculate Workers Compensation liability. The system does not come with rules in place regarding the inclusion of supplemental and imputed earnings categories in states’ payroll exposure for Workers Compensation, but does provide a convenient way for you to maintain this information yourself.

**Note:** Each installation of Oracle Payroll is responsible for entering and maintaining the rules regarding the inclusion of its earnings types in the payroll exposure for Workers Compensation.

Workers Compensation liability calculations also require that your jobs be assigned the Workers Compensation codes of one or more states. Associated with each state’s codes are the rates of the WC insurance carrier or carriers in the state.

See:

Reviewing and Maintaining Taxability Rules: page 18–33

Workers Compensation Overview: page 20–2
Tax Withholding Methods

To calculate the Employee Withheld balance, payroll runs use the regular or supplemental method. At the federal level, the cumulative withholding method is also available.

- **Regular withholding** (also called Percentage or Annualized Wages withholding) is the default withholding method of Regular runs. These runs process employees once each period to produce their regular earnings for time worked, and may also process supplemental earnings and final pay for terminating employees.

  Regular runs apply supplemental withholding to any supplemental earnings whose input value Tax separately has the entry Yes.

  See: Supplemental Withholding in Regular Runs: page 15–20

- **Supplemental withholding** is the default withholding method for federal and state income taxes in Supplemental runs. You initiate these runs whenever necessary to process supplemental earnings, and final pay for terminating employees. You enter in the Federal Tax Rules window, the supplemental withholding calculation method a GRE uses.

  See: Entering Federal, State, and Local Tax Rules for GRES: page 18–9

  Supplemental runs act like regular runs when processing final pay, using regular withholding except for any supplemental earnings with an entry of Yes in its Tax Separately input value.

- **Cumulative withholding** can apply only to employees whose earnings occur unevenly over the year; it can be beneficial for such employees. Regular and supplemental runs both use cumulative withholding in calculating federal taxes for the regular earnings and commissions of those employees who qualify for and have requested this method.

  You mark employee assignments for cumulative withholding when entering tax information for individual employees.

See Also

Regular and Supplemental Runs: page 21–2
The Tax Calculation Process

When all the necessary tax information is in place, the payroll run calculates the tax withholding of your employees and the tax liabilities of their GREs.

For each employee, it first creates gross earnings balances. Then it calculates his or her withholding, applying the appropriate withholding method, and the GRE’s tax liability for the employee.

Note: For the state-level calculations of employer liability for Workers Compensation payments, the run does special calculations.

See: WC Elements and Formulas in Oracle Payroll: page 20 –8

Calculation Provision and Maintenance

The tax rules used to produce the tax balances can be complex. Moreover, they are subject to frequent changes. Developing and maintaining current US tax calculations at the federal, state and local levels requires many researchers with specialized skills and experience.

For this reason, an independent, well-established US payroll tax vendor is the best source for tax calculation routines and updates. Oracle Corporation has concluded an agreement with Vertex Inc. to supply these tax calculation programs.

Each Oracle Payroll installation incorporates into the payroll run, tax calculations that Vertex provides and maintains. The payroll run calls these calculations at the appropriate times, so that they automatically go into effect.

You receive Vertex documentation together with Oracle Payroll. There is no online access to Vertex formulas and tables; however you can obtain a variety of reports on the tax calculations, described in the documentation. For tax calculation maintenance, Vertex provides you with data on diskettes or tapes. When you apply this data to your system it overlays all existing data in the Vertex tables, so that all data in these tables is current.

Tax Balances

In accordance with the tax-related information entered in the Oracle HRMS database, the payroll run can build tax balances for each of the following tax types (EE = employee tax, ER = employer tax):
Federal taxes
- Federal Income Tax (FIT) – EE
- Federal Unemployment Tax Act (FUTA) – ER
- Social Security (SS) – EE and ER
- Medicare – EE and ER
- Earned Income Credit (EIC) – EE

State taxes
- State Income Tax (SIT) – EE
- State Unemployment Insurance (SUI) – ER, EE in some states
- State Disability Insurance (SDI) – EE, ER in some states

Local taxes
- City Tax – EE
- County Tax – EE
- Head Tax – ER
- School District Tax – EE

For these taxes, the following balances can be created for each employee assignment processed in the payroll run.

<table>
<thead>
<tr>
<th>Balance</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gross Earnings</td>
<td>All earnings (relevant for the particular jurisdiction, or for EIC)</td>
</tr>
<tr>
<td>Exempt Earnings</td>
<td>Gross earnings – Gross earnings subject to tax</td>
</tr>
<tr>
<td>Gross Earnings Subject to Tax</td>
<td>All earnings subject to this tax</td>
</tr>
<tr>
<td>Gross Earnings Subject to Tax and not Withholdable</td>
<td>All earnings subject to tax not requiring withholding</td>
</tr>
<tr>
<td>Gross Earnings Subject to Tax and Withholdable</td>
<td>Gross earnings subject to tax – Gross earnings subject to tax and not withholdable</td>
</tr>
<tr>
<td>401(k), 125 and Dependent Care Reductions</td>
<td>Any amounts applicable as pre-tax reductions to the Gross earnings subject to tax and withholdable</td>
</tr>
<tr>
<td>Reduced Subject to Tax and Withholdable Earnings</td>
<td>Gross earnings subject to tax and withholdable – 401(k), 125 and Dependent Care reductions</td>
</tr>
<tr>
<td>Balance</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Employee Withheld</td>
<td>Amount withheld for the employee</td>
</tr>
<tr>
<td>Reduced Subject EIC</td>
<td>Gross earnings (under EIC tax-ability rules) subject to tax and withholdable – 401(k), 125 and Dependent Care reductions</td>
</tr>
<tr>
<td>EIC Advance</td>
<td>EIC credit for the employee</td>
</tr>
<tr>
<td>Employer Liability</td>
<td>Liability of the GRE for Social Security, Medicare, FUTA, SUI, SDI and Head Tax for this employee</td>
</tr>
</tbody>
</table>

**Note:** When no rules exist for a particular tax type, as for example when a state has no income tax or no employee liability for SUI or SDI, or when no city or county tax exists, the system builds no balances for the tax.

### Taxes with Upper Earnings Limits

As well as the above balances, the system creates two additional balances for those taxes with *upper earnings limits*, that is, a maximum amount of earnings above which the tax is not levied. Currently, upper earnings limits exist for the federal taxes Social Security and FUTA, and the state taxes SUI and SDI.

<table>
<thead>
<tr>
<th>Balance</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taxable earnings</td>
<td>Reduced Subject to Tax and Withholdable Earnings, adjusted to take upper limit into account</td>
</tr>
<tr>
<td>Excess earnings</td>
<td>Reduced Subject to Tax and Withholdable Earnings that exceed the upper limit</td>
</tr>
</tbody>
</table>

The Taxable Earnings balance accumulates the Reduced Subject to Tax and Withholdable earnings balances for an employee each payroll run, until it reaches the upper limit. After this, the Taxable Earnings balance for a run is zero (and its year-to-date balance remains fixed at the upper limit), since the employee’s earnings are no longer taxable for this tax.

### Balance Calculations and Adjustments

The calculation routines provided by Vertex, Inc. use balances that Oracle Payroll produces to calculate the following balances:
• Employee Withheld
• EIC Advance
• Employer Liability
• Taxable Earnings and Excess Earnings

On occasion, you must make manual adjustments for employees to Employee Withheld balances, to Gross Earnings Subject to Tax balances, or to both balances. To do this you use the Adjust Tax Balances window.

See: Adjustments to Employee Tax Balances: page 18–39
Entering Federal, State, and Local Tax Rules for GREs

For each GRE, you hold basic federal–level tax information, and state and local level tax information for each state and locality in which the GRE has employees.

Additionally, for GREs that serve as transmitters of Federal Form W–2, Wage and Tax Statements or of State Quarterly Wage Listings on magnetic tape, you hold tape–related information.

To enter tax information for a GRE, use the Organization window.

Prerequisite

- Enter the GRE into the database as an organization with the classification Government Reporting Entity.

See: Creating an Organization: page 2 – 20

Entering Federal Tax Rules

To enter federal tax rules for a GRE:

1. Enter or query the GRE in the Organization window. In the Organization Classifications region, place the cursor on the classification Government Reporting Entity, choose the Others button, and select Federal Tax Rules. Click in the Additional Organization Information field to open the Federal Tax Rules window.


The methods you select determine the calculation of withholding for taxes taken as a percentage of earnings, until an employee’s
earnings reach an upper earnings limit. The method *Self Adjust* ensures greater accuracy by basing withholding calculations on year-to-date earnings, instead of earnings this period.

3. Select the type of employment to enter for the GRE on Form 941, the Employee Quarterly Federal Tax Return.

4. If this GRE belongs to a Tax Group, enter its name. The Tax Group associates several GREs so that employees who transfer from one GRE to another within the group receive credit in the new GRE for amounts withheld in the former GRE toward Social Security, and FUTA.

5. Select the GRE’s method for calculating tax liabilities on employees’ supplemental earnings. The choices are, Concurrent Aggregation, Cumulative Aggregation, Flat Percentage or Previous Aggregation. If you select Flat Percentage, you can enter a percentage figure that will override the percentage mandated by the IRS.

Consult the Vertex handbook for detailed explanations of the different calculation methods.

---

### Entering State Tax Rules

To enter state tax rules for a GRE:

1. Enter or query the GRE in the Organization window. In the Organization Classifications region, place the cursor on the classification Government Reporting Entity, choose the Others button, and select State Tax Rules. Click in the Additional Organization Information field to open the State Tax Rules window.

2. Select the state code.
3. Enter the GRE’s ID numbers in the state for SUI (State Unemployment Insurance) and SIT (State Income Tax).

4. Select self adjust methods for unemployment and disability insurance (SUI and SDI) withholding.

   The methods you select determine the calculation of withholding for taxes taken as a percentage of earnings, until an employee’s earnings reach an upper earnings limit. The method *Self Adjust* ensures greater accuracy by basing withholding calculations on year-to-date earnings, instead of earnings this period.

5. Enter any SUI employer experience rates for the GRE.

6. In the Filing Status/Allowance Rule field, select the rule this state uses to determine the defaults for employee filing status and allowances.

   Select Federal Default if this state uses an employee’s federal filing status and allowances as the defaults for the state-level filing status and allowances. Select Single Status/Zero Allowances if this state requires single status and zero allowances as the state-level defaults.

7. Select the Workers Compensation insurance carrier for this GRE. Use the Organization window to set up WC carriers as external organizations with the classification Workers Compensation Carrier.

8. Enter this state’s Experience Modification rate for the Workers Compensation premium calculation. If the state also uses the Employer’s Liability Rate or the Premium Discount Rate to modify the WC premium, enter these rates at well.

   Enter all rates as positive numbers. For example, enter an Employer’s Liability surcharge of 20% as 120 (120% of the base premium). Enter a 10% Premium Discount as 90 (90% of the premium total). The Employer’s Liability always increases the premium amount, while the Premium Discount always decreases it.

   The Experience Modification can either increase or decrease the premium. To enter it correctly, you must understand which is does for this GRE.

See: Setup Steps for Workers Compensation Calculations: page 20 –12
Entering Local Tax Rules

To enter local tax rules for a GRE:

1. Enter or query the GRE in the Organization window. In the Organization Classifications region, place the cursor on the classification Government Reporting Entity, choose the Others button, and select Local Tax Rules. Click in the Additional Organization Information field to open the Local Tax Rules window.

2. Select the name of the locality. Because this is a long list, it is best to enter part or all of the locality name. Using its table of jurisdiction codes, the system establishes the correct code for the locality, for tax calculation purposes.

3. If the GRE has an ID number for local tax withholding, enter it in the Company Locality ID field.
Tax Information for an Employee Assignment

Oracle Payroll users must maintain the tax–related information each employee provides on form W–4 Employee’s Withholding Allowance Certificate, as well as certain additional tax information for employees. The payroll run uses this information to determine employee tax withholding at the federal, state, and local levels.

To review and maintain employee tax information, you use the Federal, State, County, City, and sometimes Percent Tax Rules windows. Entries to these windows are date effective.

Tax Records for New Hires

When you hire a new employee, you must enter a primary residence address for him or her. Each new employee must also have a work location with an address that includes a city or town, and a state. The work location is the location of the organization included in the employee assignment.

Note: This assignment may be the default assignment of the employee either to the Business Group or to the organization to which he or she was an applicant, or may be another assignment entered as a correction to the default assignment.

The system date–effectively creates default federal, state and local tax records for each new hire, using:

- the employee’s primary residence address to determine his or her state, county, and city or town of residence
- the location of the organization included in the employee’s assignment to determine his or her work state, county, and city or town.

The filing status of these default tax records is Single, and the default for the number of allowances is Zero. If a new employee’s W–4 form contains different information from that of the default records, you enter this information using the Federal Tax Rules window.

Tax Record Changes for Current Employees

Whenever changes occur to the city, county, or state of a current employee’s primary residence address or work location address, the system checks the employee’s tax records and date effectively makes changes to the local or state and local tax records, as required.

For example, when the work location changes to a new state, county, and city, the system:
• creates default tax records for the new state and locality, with 100% as the time worked in the new state and locality.

**Note:** Depending on the rule entered for the state in the State Tax Rules window, the default filing status and number of allowances for the new state and local records are either defaulted from those on the employee’s federal tax record, or go in as Single and Zero.

See: Entering Federal, State, and Local Tax Rules for GREs: page 18–9

• reduces to zero, the time worked in all other states and localities on record for the employee.

• updates the employee’s SUI state to the new work state.

If the employee is not working 100% of the time in the new state and/ or locality, but is working elsewhere for some percentage of time, you must create additional tax records for these other work localities or states and localities. Enter these and any other changes to the employee’s default tax records using the appropriate tax rules window.

### Assignment Location Rules Overview

Tax records are created by the defaulting tax rules process whenever the following assignment location rules are met:

- Assignment has a payroll
- Assignment has a salary basis
- Assignment has a primary residence address
- Assignment is for a US employee
- Assignment is associated with a GRE

Example: An employee moves to three different states, A, B, and C in a year. In state A, the employee works in two different counties, D and E. In State B, the employee works in city G (which is located in county F). In State C, the employee works in an unspecified area. The employee’s percentage in each of these areas can be expressed as follows:

<table>
<thead>
<tr>
<th></th>
<th>State A</th>
<th>State B</th>
<th>State C</th>
</tr>
</thead>
<tbody>
<tr>
<td>County D</td>
<td>30%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>County E</td>
<td>20%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>County F</td>
<td>0%</td>
<td>0%</td>
<td>0%</td>
</tr>
<tr>
<td>City G</td>
<td>0%</td>
<td>30%</td>
<td>0%</td>
</tr>
<tr>
<td>-------</td>
<td>----</td>
<td>-----</td>
<td>----</td>
</tr>
<tr>
<td>Unspecified</td>
<td>0%</td>
<td>0%</td>
<td>20%</td>
</tr>
<tr>
<td>Total in State this year</td>
<td>50%</td>
<td>30%</td>
<td>20%</td>
</tr>
</tbody>
</table>

**Note:** The state totals add up to 100% for the year.

Date 1 is the date on which all of the defaulting tax rules criteria are met.

The following tax rules records are created with the effective start date as the date on which the defaulting tax rules criteria was met for the first time and the effective end date as the end of time:

- Federal tax rules record for the assignment
- State tax rules record for the assignment location
- State tax rules record for state of primary address
- County tax rules record for the assignment location
- County tax rules record for county of primary address
- City tax rules record for the assignment location
- City tax rules record for city of primary address

For every change in the assignment location, percentage records are created:

- Percentage state record for the assignment location
- Percentage county record for the assignment location
• Percentage city record for the assignment location

If the primary residence address is not the same as the work address, percentage records are created:

• Percentage state record for the primary residence address
• Percentage county record for the primary residence address
• Percentage city record for the primary residence location

Updating Assignment Location Processes

When updating an assignment location, the following processes occur:

Note: The percentage records are affected and created with a change in the assignment’s location and not by any other change in the assignment details. The percentage records will always be created for the date range within two locations of the assignment.

• New state, county, and city records are created from the date the defaulting tax rules criteria is met if state, county, city tax records do not already exist for the location.
• The federal tax record is changed to reflect the state of the new location as the SUI state.
• The percentage tax records for state, county and city are created from the date on which the defaulting tax rules criteria is first met. A percentage tax record cannot exist without a corresponding tax rules record.
• The tax rules records and the tax percentage records are changed when an assignment start date is changed, if all of the defaulting tax rules criteria is met as of that new date.
• New state, county, and city records are created from the date the primary residence address changes if state, county, city tax records do not already exist for the location.
• New state, county, and city percentage tax records are created from the date the primary residence address changes.

Mechanisms for Updating Tax Records

There are three update mechanisms.

• Update
  Update is changing of a tax record from a certain date until the end of time
See Updating an Assignment Location: page 18 –17

• Update with Insert
Update with insert is inserting a new tax record between two existing tax records.
See Updating and Inserting Assignment Location: page 18 –19

• Update Override
Update override is inserting a new tax record between an existing tax record and a future dated tax record, but having the inserted tax record supercede the future dated tax record; the tax record that supercedes is valid until the end of time.
See Update Override Assignment Location: page 18 –21

Update Assignment Location

Assuming that tax records do not already exist for the second assignment location, the following events occur when you update an assignment location:

• The existing federal tax record for Location 1 is end dated to (Date 2–1) and a new federal record is created with effective start date of (Date 2), and the effective end date (End of Time).
  
  **Note:** The SUI state is now the state of Location 2.

• The existing state tax percentage record for Location 1 is end dated to (Date 2–1).
  
  **Note:** Note that for the time period of Date 1 through Date 2, the state percentage of Location 1 is 100%.

• A new state tax percentage record is created with effective start date of (Date 2), and the effective end date (End of Time). This new record now has a State percentage record of 100% for Location 2.

• The existing county tax percentage record for Location 1 is end dated to (Date 2–1).
  
  **Note:** Note that for the time period of Date 1 through Date 2, the county percentage of Location 1 is 100%.

• A new county tax percentage record is created with effective start date of (Date 2), and the effective end date (End of Time). This new record now has a County percentage record of 100% for Location 2.
• The existing city tax percentage record for Location 1 is end dated to (Date 2–1). Note that for the time period of Date 1 through Date 2, the city percentage of Location 1 is 100%.

• A new city tax percentage record is created with effective start date of (Date 2), and the effective end date (End of Time). This new record now has a City percentage record of 100% for Location 2.
Update With Insert Assignment Location

Update with Insert allows you to create a new tax record and insert it between two existing records.

For instance, an employee transfers from current Location 1 to future Location 2. Before the employee actually transfers to Location 2, the plans change, and the employee transfers to Location 3.

Note: The transfer to Location 2 is not altered by this action, and the change will take effect as planned.

In update and insert, the following processes occur:

- The first percentage tax record is from (Date 1) to (Date 3–1).
  
  Note: Note that for the time period of Date 1 through Date 3, the state percentage tax record of Location 1 is 100%.

- The existing state percentage tax record for Location 1 is end dated to (Date 3–1).

- The second percentage tax record is from (Date 3) to (Date 2–1). This new record now has a State percentage record of 100%.
  
  Note: Note that for the time period of Date 1 through Date 3, the state percentage of Location 1 is 100%.

- The third percentage tax record remains from (Date 2) to the end of time
<table>
<thead>
<tr>
<th>Employee</th>
<th>Date 1</th>
<th>Date 3</th>
<th>Date 2</th>
<th>End of Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal Tax Record</td>
<td>SUI = A1</td>
<td>SUI = A2</td>
<td>SUI = A3</td>
<td>SUI = A2</td>
</tr>
<tr>
<td>State of Location 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>County of Location 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City of Location 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Percentage of Location 1</td>
<td>100%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>County Percentage of Location 1</td>
<td>100%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>City Percentage of Location 1</td>
<td>100%</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>State of Location 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>County of Location 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City of Location 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Percentage of Location 3</td>
<td>0%</td>
<td>100%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>County Percentage of Location 3</td>
<td>0%</td>
<td>100%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>City Percentage of Location 3</td>
<td>0%</td>
<td>100%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>State of Location 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>County of Location 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City of Location 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Percentage of Location 2</td>
<td>0%</td>
<td>0%</td>
<td>100%</td>
<td></td>
</tr>
<tr>
<td>County Percentage of Location 2</td>
<td>0%</td>
<td>0%</td>
<td>100%</td>
<td></td>
</tr>
<tr>
<td>City Percentage of Location 2</td>
<td>0%</td>
<td>0%</td>
<td>100%</td>
<td></td>
</tr>
</tbody>
</table>
Update Override of Assignment Location

Update override allows you to insert a future dated assignment location and override any existing future dated assignment locations.

For instance, an employee in Location 1 transfers to Location 2 in a few months’ time. But before the transfer happens, plans change, and the employee is now transferring to Location 3.

The records for Location 2 are created, but the percentage records for State, County, and City for Location 2 are set to zero. However, the records for Location 3 are created and as of the default date, until the end of time, the employee percentage records for State, County, and City are set to 100% for Location 3 as of the transfer date until the end of time. Note also that the Federal tax record is set for Location 3 as well.

In update Override, the following process occur:

- The first percentage tax record is from (Date 1) to (Date 3–1).
  
  Note: Note that for the time period of Date 1 through Date 3, the state percentage of Location 1 is 100%.

- The existing state percentage tax record for Location 1 is end dated to (Date 3–1).

- The second percentage tax record is from (Date 3) to End of Time. This new record now has a State percentage record of 100%.
  
  Note: Note that for the time period of Date 3 through end of time, the state percentage of Location 1 is 100%.

- The third percentage tax record is removed.
<table>
<thead>
<tr>
<th>Employee</th>
<th>Date 1</th>
<th>Date 2</th>
<th>End of Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal Tax Record</td>
<td>SUI = A1</td>
<td>SUI = A3</td>
<td></td>
</tr>
<tr>
<td>State of Location 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>County of Location 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City of Location 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Percentage of Location 1</td>
<td>100%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>County Percentage of Location 1</td>
<td>100%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>City Percentage of Location 1</td>
<td>100%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>State of Location 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>County of Location 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City of Location 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Percentage of Location 2</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>County Percentage of Location 2</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>City Percentage of Location 2</td>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>State of Location 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>County of Location 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>City of Location 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>State Percentage of Location 3</td>
<td>0%</td>
<td>100%</td>
<td></td>
</tr>
<tr>
<td>County Percentage of Location 3</td>
<td>0%</td>
<td>100%</td>
<td></td>
</tr>
<tr>
<td>City Percentage of Location 3</td>
<td>0%</td>
<td>100%</td>
<td></td>
</tr>
</tbody>
</table>
Purging Tax Rules Records

Purging tax rules records is allowed, however, no other kind of deletion is allowed. The purging descends down the the tax percentage records, thus whenever a tax rules record is purged, the corresponding tax percentage record is also automatically purged.

**Note:** Percentage tax records cannot be created nor deleted through the percentage screen. They are created only when their tax rules records are created. They are deleted only when their corresponding tax rules are purged.

State tax rules records can be purged only if:
- That state has never been assigned as the state of a work location, or as the state of the residential address.
- No payroll has ever been run for that state.
- Purging a state tax rule also purges tax rules for all of the counties and cities within that state. Similarly all the tax percentage rules for that state, counties and cities will also be purged.

County tax rules can be purged only if:
- That county has never been assigned as the county of a work location or as the county of the residential address.
- No payroll have ever been run for that county.
- Purging a county tax rule also purges tax rules for all the cities within that county. Similarly, all the tax percentage rules for that county and all of its cities will also be purged.

City tax rules can be purged only if:
- That city has never been assigned as the city of a work location, or as the city of the residential address.
• No payroll has ever been run for that city.
• Purging a city tax rule also purges the percentage tax rule for that city.

**Entering W–4 and Other Tax Data for Employees**

To review and change default tax information for an employee, use the appropriate Tax Rules window. Information in these windows are maintained date effectively.

**Note:** All changes effect the tax calculation as of the date paid, not the date calculated.

**Prerequisites**

- The employee must have a primary home address entered in the US–specific Address window that includes a city, county, state, and zip code. This determines the Resident State and Resident Locality displayed in the Tax Rules window.
  
  See: Entering People’s Addresses at Sites with Oracle Payroll: page 8 – 12

- There must be a location associated with the organization included in the employee’s primary assignment, and the location address must include a city and state. This determines the work state and locality displayed.
  
  See: Setting Up Site Locations: page 2 – 2

- The employee’s assignment must also include an assignment to a payroll and an employment category.
  
  See: Entering a New Assignment: page 9 – 9

- Links for the tax and Workers Compensation elements must be in place for you to use this window. These links should be set up during the installation of Oracle HRMS at your enterprise.
Attention: Ensure that you have set the correct effective date before entering any tax information.

To enter federal tax rules for an employee:

1. Default information appears for the employee in the W–4 Information region. You can change the filing status and other defaults as necessary.
   - In the Allowances field, enter the number of allowances the employee claims.
   - In the Additional Tax field, enter the amount of any additional Federal tax withholding the employee requests.

2. The resident and work states are displayed from the employee’s primary residence address and work location address, respectively. You cannot change them here.

3. The SUI state defaults from the work state, but under the general rules for place of employment, can be different from the work state. In this case you can select another state as the SUI state. If a tax record is not already present for this state, select the state in the State Tax Rules window and save the default record. You can then select this state in the SUI State field.

4. In the Tax Exemption region, check the boxes corresponding to taxes for which the employee claims exemption on the W–4. You must renew tax exemptions each year.
5. In the FIT Override region, enter a percentage in the Rate field to override the regular rate used in withholding calculations. To withhold a fixed amount each period with no tax calculations occurring, enter the amount.

6. Check the Statutory Employee box if the employee governs his or her own conditions of work, and is not considered an employee under common law rules. For example, this might apply to an insurance agent affiliated with, but not working for, an insurance company.

Statutory employees are exempt from FIT withholding, but you may need to withhold Medicare, Social Security, or FUTA for them.

7. Check the Cumulative Taxation box if the employee qualifies for cumulative withholding, and requests its application to his or her regular earnings and commissions.

8. In the EIC Filing Status field, select Single or Married if the employee files the W5 Earned Income Credit Advance Payment form. Single means the filing is for 100% EIC. Married means it is for 50% EIC.

One or two default state tax records appear in the W–4 Information region for a new employee’s resident state and work state. You can change the defaults as necessary.

For an employee who may work in several different states in addition to the state of their work location, enter a State Tax Rules record for each one. This makes it possible for you to use the PayMIX Time Entry window to enter the employee’s actual work locations each pay period from his or her timecard.

See: Entering Batches of Timecard Data: page 13 – 72

State Tax Rules

State Tax Rules are entered from the State Tax Rules window. Navigate to the Federal Tax Rules window, and select the State Tax button.

Attention: Ensure that you have set the correct effective date before entering any tax information.

To enter a new state tax record for an employee:

1. Choose New Record from the Edit menu and select a state.

   There can be only one record for each state, so states for which records already exist do not appear on the list.

2. Select a filing status and enter other information relevant to this state.
3. In the Tax Exemption region, check the boxes corresponding to taxes for which the employee is claiming exemption on the W4. You must renew exemptions each year.

4. In the SIT Override region, enter a percentage in the Rate field to override the regular rate used in withholding calculations. To withhold a fixed amount each period without performing any state tax calculations, enter the amount.

5. Check the Non resident Certificate check box if the employee has certificates of nonresidence on file for the state.

6. To enter another work state for the employee, choose New Record from the Edit menu and select another state. Enter information for all the states in which the employee may work before you save the state tax records. Make sure that the total of all the Time in State entries for the employee equals 100%.

Claims For More Than 10 Allowances

If the employee claims more than 10 allowances, you must send a copy of the W-4 to the IRS and to the appropriate state tax authorities. The IRS and state authorities may independently issue notices rejecting the claim, and reducing the number of allowances.

**Attention:** Ensure that you have set the correct effective date before entering any tax information.

▶ **To record a rejection of an employee’s requested allowances:**

1. Enter the notice date in the Allowances Reject Date fields in the Federal Tax Rules or appropriate State Tax Rules region.

2. Reduce the employee’s allowances as of this date.
You can enter information for local tax withholding in any locality within the states for which you entered state tax rules.

County Tax Rules

County tax rules are entered from the County Tax Rules window. With the appropriate state displayed in the State Tax Rules window, choose the County Tax button.

Attention: Ensure that you have set the correct effective date before entering any tax information.

To enter county tax rules for an employee:

1. Select a county.
2. Select a filing status and enter other information from the W-4 that is applicable to this locality.
3. In the LIT Override region, to override the regular rate used in withholding calculations, enter a percentage in the Rate field. Enter an amount for Oracle Payroll to withhold a fixed amount each period, without performing any local tax calculations.
4. Check appropriate boxes in the Tax Exemptions block to exempt the employee from these taxes.
5. Enter the School District code to calculate school district tax for the employee. Currently, this is applicable only to employees resident in Kentucky, Ohio or Pennsylvania. Consult your Vertex, Inc. handbook for further information on school districts and codes.
City Tax Rules

City tax rules are entered from the City Tax Rules window. With the appropriate county displayed in the County Tax Rules window, choose the City Tax button.

**Attention:** Ensure that you have set the correct effective date before entering any tax information.

**To enter city tax rules for an employee:**

1. Select a city.
2. Select a filing status and enter other information from the W–4. that is applicable to this locality.
3. In the LIT Override region, to override the regular rate used in withholding calculations, enter a percentage in the Rate field. Enter an amount for Oracle Payroll to withhold a fixed amount each period, without performing any local tax calculations.
4. Check appropriate boxes in the Tax Exemptions block to exempt the employee from these taxes.
5. Enter the School District code to calculate school district tax for the employee. Currently, this is applicable only to employees resident in Kentucky, Ohio or Pennsylvania. Consult your Vertex, Inc. handbook for further information on school districts and codes.

Percentage Tax Rules

Percentage time in state is accessed from the State Tax Rules window. Navigate to the Percentage window by selecting the Percentage button on the State Tax Rules window.

Percentage time in county is accessed from the County Tax Rules window. Navigate to the Percentage window by selecting the Percentage button on the County Tax Rules window.

Percentage time in city is accessed from the City Tax Rules window. Navigate to the Percentage window by selecting the Percentage button on the City Tax Rules window.

**Attention:** Ensure that you have set the correct effective date before entering any tax information.

**To adjust the percentage time:**

- Enter the percentage of the employee’s total work time spent in this locality. Make sure that the total of all the Time in Locality entries for localities within a state do not exceed the Time in State entry.
Supplemental Tax Override

Highly compensated employees, amongst others, sometime request to withhold supplemental taxes at a rate higher than legislatively required.

Oracle Payroll supports supplemental tax override rates at the assignment level for federal, state, county, and city taxes.

Separate rates can be specified for each locality and the federal level on the employee’s tax information.

**Attention:** To use a supplemental tax override rate, the GRE must have flat percentage override selected as a calculation method, a non-zero override rate must be specified, and it must be a supplemental payroll run. All three of these conditions must be met, or the default withholding method will be used.

FIT Override Region

In the FIT Override region on the Federal Tax Rules window, you can specify FIT and/or federal supplemental tax overrides.

If you want to specify an FIT override, enter a percentage in the Regular Rate field to override the regular rate used in FIT withholding calculations.
To withhold a fixed FIT override amount each period with no tax calculations occurring, enter the amount in the Regular Amount field.

If you want to withhold a supplemental tax, enter a percentage in the Supplemental Rate field to override the regular rate used in federal supplemental withholding calculations.

**SIT Override Region**

In the SIT Override region on the State Tax Rules window, you can specify SIT and/or state supplemental tax overrides.

If you want to specify an SIT override, enter a percentage in the Regular Rate field to override the regular rate used in SIT withholding calculations.

To withhold a fixed SIT override amount each period with no tax calculations occurring, enter the amount in the Regular Amount field.

If you want to withhold a supplemental tax, enter a percentage in the Supplemental Rate field to override the regular rate used in state supplemental withholding calculations.

**LIT Override Region**

In the LIT Override region on the County and City Tax Rules windows, you can specify LIT tax overrides.

If you want to specify an LIT override, enter a percentage in the Rate field to override the regular rate used in LIT withholding calculations.

To withhold a fixed LIT override amount each period with no tax calculations occurring, enter the amount in the Amount field.

If you want to withhold a supplemental tax, enter a percentage in the Supplemental Rate field to override the regular rate used in state supplemental withholding calculations.

**State Supplemental Tax Override**

To specify a state supplemental tax override for an employee, you must first specify a flat rate calculation method for the employee’s GRE.

Select the supplemental state withholding tax calculation method to be used for employees of this GRE. The options follow:

00: Specifies that the state’s default method always be used to calculate supplemental state withholding taxes for employees of this GRE. 00 is the default value for the Supplemental Tax Calculation Method field.
02: Specifies that in addition to the state’s default method, a flat percentage rate also can be used to calculate supplemental state withholding taxes for employees of this GRE.

**Note:** If you plan to apply a supplemental tax override rate to override the regular rate used in state supplemental withholding calculations for any employees of this GRE, you must specify a value of 02 in the Supplemental Tax Calculation Method field.
Creating, Reviewing and Maintaining Taxability Rules

Use the Taxability Rules window for the following:

- to identify rules for earnings types and pre-tax deductions for county and city for any given state.
  
  See Creating Local Taxability Rules: page 18–34
  
  See Updating Local Taxability Rules: page 18–36
  
  See Ending Local Taxability Rules: page 18–36
  
  See Changing Taxability Rules for an Earnings Type: page 18–36
- to review the taxability of categories of supplemental and imputed earnings, and of pre-tax deductions, at the federal and state levels
- to enter and maintain rules regarding the inclusion of categories of supplemental and imputed earnings in a state’s payroll exposure for Workers Compensation.

  See: Workers Compensation Overview: page 20–2

Prerequisite

- To enter tax rules for earnings categories not presently listed in this window, add the categories to the list using the QuickCode type US_SUPPLEMENTAL_EARNINGS or US_IMPUTED_EARNINGS.

  See: Adding QuickCode Values: page 29–3

  You cannot make additions to the list of categories of pre-tax deductions.
Creating Local Taxability Rules

**Attention:** When creating or updating a local taxability rule for county, or city, all default state taxability rules are superceded for that locality. You must re-enter all state taxability rules for that particular locality when you create a local taxability rule.

**Attention:** Local taxability rules are not validated by Oracle Payroll, nor are they date effective. Local tax rules do not include regular earnings. You can only enter local tax rules for one level (county or city) at a time.

**Attention:** Selecting Not Withheld for a pre-tax deduction will introduce errors in your payroll. Do not select Not Withheld for a pre-tax deduction.

**Prerequisite**

- To enter tax rules for earnings categories not presently listed in this window, add the categories to the list using the QuickCode type US_SUPPLEMENTAL_EARNINGS or US_IMPUTED_EARNINGS. See: Adding QuickCode Values: page 29 – 3

You cannot make additions to the list of categories of pre-tax deductions.
You access Taxability Rules from the Tax Withholding Rules under the Compensation and Benefits area of the Navigator.

To create a local taxability rule for an earnings type, or pre-tax deduction:

1. Select a primary classification for the earnings type, or pre-tax deduction.
2. Select the tax level such as county or city.
3. Select the appropriate state from the list of values.
4. Select the locality from the list of values for the county or city.
   Note that the applicable tax categories are displayed.
5. For each tax category, select the appropriate rule: withheld or not withheld.
   Oracle Payroll interprets the tax category as not subject to tax if a tax category is left unchecked.
6. Save your changes.

Attention: When you refresh this screen, the Default Rules Edited check box will be checked. This indicates that there is a local tax rule in effect and that you need to re-establish state tax rules for this locality.
Updating Local Taxability Rules

Attention: Selecting Not Withheld for a pre-tax deduction will introduce errors in your payroll. Do not select Not Withheld for a pre-tax deduction.

To update a local taxability rule for an earnings type or pre-tax deduction:
1. Query the taxability rule for the locality you want to update.
2. Make changes to the local tax rule as appropriate.
3. Save your changes.

Ending Local Taxability Rules

To end a local taxability rule for an earnings type or pre-tax deduction:
1. Query the taxability rule you want to end.
2. For each tax category, uncheck the appropriate rule: withheld or not withheld.
3. Save your changes.

Attention: If there are no tax rules for this locality, when you refresh your screen the Default Rules Edited check box will revert to being unchecked. This indicates that the default tax rules for the state are in effect.

Changing Taxability Rules for an Earnings Type

To change taxability rules for an earnings type:
1. In the Primary Classification region, choose Supplemental Earnings or Imputed Earnings.
2. In the Level region, choose Federal to change a federal-level rule, or State to change a state-level rule. If you choose State, select the particular state in the State region.
3. The Tax Category field displays the categories of earnings types in the Supplemental or Imputed Earnings classification. For a category, check the box under a tax heading in the Subject To region.
if the earnings types in the category are subject to the tax, or uncheck the box if they are not subject to the tax.

At the federal level, the tax headings appearing in the Subject To region are:
- FIT – Federal Income Tax
- EIC – Earned Income Credit
- FUTA – Federal Unemployment Tax Act
- Medicare – (FICA–HI)
- SS – Social Security (FICA–OASDI)

At the state level, the tax headings appearing in the Subject To region are:
- SIT – State Income Tax
- SDI – State Disability Insurance
- SUI – State Unemployment Insurance
- WC – Workers Compensation payroll exposure

To change taxability rules for a pre–tax deduction:
1. In the Primary Classification region, choose Pre–Tax Deduction.
2. In the Level region, choose Federal to maintain federal–level rules, or State to maintain state–level rules. If you choose State, select the particular state in the State region.

3. The Tax Category field displays the categories Dependent Care 125, Deferred Comp 401k, and Health Care 125. For a category, check the box under a tax heading in the Subject To region if deductions in the category are subject to the tax, or uncheck the box if they are not subject to the tax.

At the federal level, the tax headings appearing in the Subject To region are:

- FIT – Federal Income Tax
- EIC – Earned Income Credit
- FUTA – Federal Unemployment Tax Act
- Medicare – (FICA–HI)
- SS – Social Security (FICA–OASDI)

At the state level, the tax headings appearing in the Subject To region are:

- SIT – State Income Tax
- SDI – State Disability Insurance
- SUI – State Unemployment Insurance
Adjustments to Employee Tax Balances

The need to adjust the Employee Withheld tax balance for an employee arises when, for example, employees incur income outside of a regular payroll (imputed income from a fringe benefit, or exercises a stock option) and need to have their income and taxes adjusted upwards. The other tax balance that requires manual adjustment on occasion is the Gross Earnings Subject To Tax balance.

You need the ability to make adjustments to both of these balances when employees receive a hand pay (a payment resulting from manual calculation of earnings and tax deductions), or an earnings type processed by an outside source instead of Oracle Payroll. This source may be a separate department in your enterprise, or an external third party. Examples of earnings that outside sources may process are those resulting from purchase of stock options for employees, or from payment of relocation expense reimbursements or sick pay.

To permit you to adjust either Employee Withheld balances, Gross Earnings Subject to Tax balances, or both at once, Oracle Payroll provides the Adjust Tax Balances window.

Adjustments to Balances of Subject Wages

To make adjustments to an employee’s Gross Earnings Subject To Tax balances for various taxes, you select the name of the earnings type causing the change, and then enter the gross amount of the change. For example, in the case of a hand pay or sick pay received from an insurance company, you select the earnings type name (such as Regular Salary or Desai Co. Sick Pay), and then enter the gross amount of the payment.

After you save this information, the system locates the classification and category of the earnings type. It then uses this information, together with the relevant work location information, to locate the taxability rules applicable to this earnings type for this employee assignment. These are the rules you see in the Taxability Rules window.

See: Reviewing and Maintaining Taxability Rules: page 18–33

In accordance with these rules, the system adds the gross amount of the earnings type to the employee’s Gross Earnings Subject to Tax balance of every tax applicable to the earnings type. For taxes with upper earnings limits, if this addition causes the upper limit to be exceeded, the next payroll run makes the necessary adjustments to the Taxable Earnings and Excess Earnings balances.
Adjustments to Balances of Taxes Withheld

To adjust amounts actually withheld for an employee for various taxes, you enter in the Adjust Tax Balances window, an amount for each affected tax. For example, if an employee has received a hand pay, or sick pay from an insurance company, you enter the amounts that your payroll staff or the insurance company report that they deducted for various federal, state and local taxes when making this payment. When you save these entries, the system updates the Employee Withheld balance of each of these taxes for the employee.

If you are using the Self Adjust method for the calculation of employee withholding for Social Security, Medicare, SUI and SDI, the next payroll run automatically makes corrections for any under withholding or over withholding for these taxes. This run also adjusts as necessary, Employer Liability balances for Social Security, Medicare, SUI, SDI, and FUTA.

Correcting Balance Adjustment Entries

It can happen that you save entries in this window that you must later correct. An outside source that has processed an earnings for employees and issued a report on the gross and net amount of the earnings and the deductions taken, may later issue a correction to this report. Or, you may simply need to correct mistyped figures.

When you must make such corrections, first enter and save the incorrect numbers as negatives, to cancel the original entries. (If the original numbers entered were negative numbers, enter positive numbers to cancel them out.) Then make new entries of the correct numbers.

Entering Adjustments to Employee Tax Balances

To make these entries for an employee assignment, use the Adjust Tax Balances window.

⚠️ Warning: To make corrections to numbers saved in the Adjust Tax Balances window, see the section:
Correcting Balance Adjustment Entries: page 18–40

Using a correction method other than that described in this section can endanger the integrity of your tax balances.
Prerequisite

For each Business Group, there are certain elements needed to hold some of the information entered in this window. These elements are included in your Oracle Payroll startup data. Before your first use of the Adjust Tax Balances window, you must create links for these elements that include the costing information appropriate to your enterprise.

To ensure that these links are always in effect for the Business Group, set your effective date to 01–JAN–0001 when creating them.

See: Defining Element Links: page 12 – 38

The elements requiring links are:

<table>
<thead>
<tr>
<th>Federal</th>
<th>State</th>
<th>Local</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIT</td>
<td>SIT_WK</td>
<td>County_WK</td>
</tr>
<tr>
<td>SS_EE</td>
<td>SUI_EE</td>
<td>City_WK</td>
</tr>
<tr>
<td>Medicare_EE</td>
<td>SDI_EE</td>
<td>County_SUBJECT_WK</td>
</tr>
<tr>
<td></td>
<td>SIT_SUBJECT_WK</td>
<td>City_SUBJECT_WK</td>
</tr>
<tr>
<td></td>
<td>SUI_SUBJECT_EE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SUI_SUBJECT_ER</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SDI_SUBJECT_EE</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SDI SUBJECT_ER</td>
<td></td>
</tr>
</tbody>
</table>

FIT = Federal Income Tax, SS = Social Security
SIT = State Income Tax, SUI = State Unemployment Insurance, SDI = State Disability Insurance
WK = Work Location

Note: It may be convenient to link these elements to all payrolls, so that all employees in the Business Group are eligible for them.

To adjust balances of subject wages and taxes withheld:

1. In the Assignment window, query the employee assignment for which you are entering adjustments to tax balances, and open the Adjust Tax Balances window.

   The window displays the city, state, zip code and county of the employee’s default work location, and the default consolidation set for the payroll of the employee’s assignment. You can change these defaults if necessary.

2. To enter adjustments to the Gross Earnings Subject to Tax balances for the employee, select the name of the earnings type causing the adjustment in the Earnings Name field.
The list displays all the earnings types initiated in your system (classifications Earnings, Supplemental Earnings, and Imputed Earnings).

3. Enter the gross amount by which you are adjusting the Gross Earnings Subject to Tax balances. The amount can be positive or negative.

   If you are not also entering adjustments to balances of taxes actually withheld, go to step 4. If you are also entering adjustments to Employee Withheld tax balances, go to step 5.

4. If you are adjusting Gross Earnings Subject to Tax Balances only, save your work and exit this window. The system updates Gross Earnings Subject to Tax balances in accordance with the taxability rules for the earnings type (these appear in the Taxability Rules window).

5. To also enter adjustments to the Employee Withheld tax balances for this earnings type, in order to record in Oracle Payroll information about a payment made and tax deductions taken for the employee outside Oracle Payroll, enter the net amount of the payment.

6. Enter for each tax appearing in the Taxes Withheld region, any amount actually deducted for the tax from the gross amount of the earnings type. When you complete these entries, save your work.

7. To check the correctness of your entries of amounts withheld, the system adds each amount entered for a tax in the Taxes Withheld region to the net amount entered for the earnings type. If the total does not equal the gross amount entered, you receive an error message and must correct any typing errors.

8. When you save the entries in the Taxes Withheld region and receive no error messages, the system:
   - updates Gross Earnings Subject to Tax balances in accordance with the taxability rules for the earnings type that appear in the Taxability Rules window
   - updates Employee Withheld balances for the taxes with the amounts entered amounts in the Taxes Withheld region.

To adjust Employee Withheld balances only:

1. In the Assignment window, query the employee assignment for which you are entering adjustments to Employee Withheld balances. Open the Adjust Tax Balances window.

The window displays the city, state, zip code and county of the employee’s default work location, and the default consolidation set
for the payroll of the employee’s assignment. You can change these defaults if necessary.

2. For each tax appearing in the Taxes Withheld region, enter the amount of the adjustment. When you complete these entries, save your work.

The system then updates Employee Withheld balances for the taxes with the amounts entered in the Taxes Withheld region.
Viewing Tax Balances

After running payrolls, you can review online the applicable balances for federal, state and local taxes at the level of an individual employee assignment, and at the person level for employees with two or more separate assignments. Balances at the person level represent the totals of the balances of each assignment the person has.

You can also review employer tax liabilities.

To view tax balances, use the View Tax Balances window.

To review tax balances:

1. Set your session date to the date at which you want to review tax balances. This window displays the current year’s tax balances for the dimensions period to date, month to date, quarter to date and year to date.

2. Select the GRE responsible for withholding or paying the tax whose balances you are reviewing.

3. Select the tax whose balances you are reviewing. The buttons ER and EE show whether this is tax on employers or employees. If this is a tax for which both employees and employers are liable,
choose ER to review balances for the employer liability, or EE to review balances for employee withholding.

At the federal level, both employers and employees make payments for Social Security and Medicare. In some states, both employers and employees are liable for SUI or SDI.

4. Choose Assignment to see assignment–level balances, or Person to see person–level balances for employees with more than one assignment.

5. If the tax selected is at the state level, select the state. The list of states includes all those for which tax records exist for the employee.

   See: Tax Information for an Employee Assignment: page 18 –13

6. If the tax selected is at the local level, select the state and locality. Depending on the tax selected, the list of localities includes all counties, cities or cities and counties within the state for which tax records exist for the employee.

   If the tax selected is a school district tax, the school district designation automatically appears.

7. To obtain the tax balances, choose Get Balances. Balances listed in the Tax Balances region that are not applicable for the selected tax are greyed out. For employee taxes this region displays balances withheld; for employer taxes it displays the employer liability.
A number of reports on taxes must be submitted to federal or state agencies at regular intervals, and submission is often done using magnetic media. For internal use, a summary of taxes processed in one or a set of payroll runs is essential.

This chapter covers:

- the data requirements for wage and tax–related reporting on magnetic media
- the procedures to follow for obtaining reports on taxes and wages.
Tax and Wage Reporting

After payroll runs, Tax Summary Listings show for internal use, the balances of federal, state, and local taxes processed for a GRE, a consolidation set of payrolls, or a single payroll. Other tax and wage reporting meets federal or state reporting requirements.

The federal–level reports on taxes and wages that each GRE must produce include:

- **Form W–2, Wage and Tax Statement.** At year end, an individual report is distributed on paper to each employee, and a report for each GRE goes on magnetic tape to the IRS.

- **Form W–941, Employer’s Quarterly Federal Tax Return.** Each quarter you view online for each GRE, the information to enter on the form for submission to the IRS.

- **Form BLS 3020, Multiple Work Site Report.** This quarterly report covers monthly wages paid, number of employees paid per month, and wages paid for the quarter, by work site within GRE within state. It goes on magnetic tape to the Bureau of Labor Statistics.

- **Form 1099-R, Retirement Plan Distribution.** At year end, a report is generated on paper to each (retired) employee receiving a distribution from all types of retirement plans, and a report for each GRE goes on magnetic tape to the IRS.

  See: Retirement Plan Listings: 1099-R: page 19 –41

At the state level, GREs must issue each quarter on magnetic tape to the states in which they have employees, reports of employee wages subject to SUI. Oracle Payroll calls these reports State Quarterly Wage Listings (SQWL).

Data for Reporting on Magnetic Tape

For GREs and other organizational units using magnetic tape to submit federal and state tax and wage reporting, you must maintain some special data. This serves to identify things like the GREs that are serving as transmitters of the media, the GREs whose employer and employee data appears on a particular tape or diskette, and the equipment used to generate the files submitted.

See Also

Obtaining Tax and Wage Reports: page 19 –28
MWS Reporting on Magnetic Tape

Employers with multiple worksites must file quarterly employment and wage reports. This information is used by the Bureau of Labor Statistics (BLS) to provide analyses of U.S. employment. This Multiple Worksite Report (MWS) is submitted on magnetic media.

Certain industries such as gas and oil exploration, construction, and contract logging are exempted from reporting. Employers with less than 10 employees total in their multiple worksite locations are also exempted from filing this report.


Certain states have mandatory reporting requirements:

- California
- Colorado
- Florida
- Georgia
- Iowa
- Kansas
- Louisiana
- Maine
- Minnesota
- Montana
- Nevada
- New Hampshire
- New Jersey
- New York
- North Carolina
- North Dakota
- Ohio
- Oregon
- Puerto Rico
- Vermont
- Virginia
- West Virginia

Defining Structures for Multiple Worksite Reporting

Only one GRE in your business group submits the MWS report to the Bureau, and this GRE reports on the wages and locations of employees in all the multiple locations across all SUIs and other GREs. This is the MWS GRE.

Each state assigns a Reporting Unit Number (RUN) for each worksite that your organization has in that state. Worksites are identified by the RUN/SUI combination. Employees are assigned to the worksites based on the SUI for their GRE and the RUN.

Oracle Payroll uses the following rules when reporting multiple worksites and employee numbers and wages:
• Only one GRE is the MWS transmitter for the entire business group, regardless of how many locations the business has in multiple states.

• Every GRE must have at least one SUI account code associated with it (but can have many); however every SUI account code has only one GRE associated with it.

• Employees are reported based on their location for the payroll run that includes the twelfth day of the month. Employees that change locations will be recorded in the same manner.

• Employees must be assigned to a GRE whose SUI matches the SUI identified for the organization on the Worksite Filing form. You must ensure that these SUIs match.

• Employees must be assigned to an organization that is in turn associated with a worksite.

• Employees must have non-zero quarterly wages and have an active primary assignment as of the twelfth of each month.

• Retired employees assigned to a retirement GRE are not to be reported. While assigning the SUI account code to an organization for a worksite, do not complete the Worksite Filing form for a retirement GRE; if you do, you will include your retired employees wages and locations in this report.

To complete the MWS report, Oracle Payroll requires some additional information. You will be asked for some or all of the following information:

- **MWS Transmitter GRE**: Takes a value of Yes or No. Yes indicates that this GRE is the transmitter for MWS reporting.
- **Contact Title**: Title of the person who can be contacted for information regarding creation of the tape. This is mandatory information.
- **Contact Telephone**: The telephone number of the contact person. Every tape should have the telephone number of the contact person.
- **Company Trade Name**: The name of the company.
- **Tape Medium**: The medium of the tape indicating whether the data is on reel, tape, tape cartridge, or PC diskette.
- **Tape Density**: The density for the tape medium.
- **Header/Label**: The header/label for the tape.
### Reporting Establishment Classification
- **Select Worksite Filing**

### Primary Reporting Worksite Organization
- When set to Yes, the address of this organization is taken as the address for the worksite. Every worksite needs an address.

### SUI Account No.
- The Unemployment Insurance Account given to the GRE of the worksite to which the organization is associated. This is mandatory information for the tape.

### Reporting Unit Number
- The Reporting Unit Number is given to the worksite by the state. This is the number to which the organization is associated, and is required on the tape for each worksite that is being reported. This field accepts alpha/numeric values.

### Trade Name
- The name of the worksite that is being reported. This is required information for the tape.

### Worksite Description
- Enter a meaningful and unique description of the worksite that is being reported. This is optional information.

### Comment Code1
- A code defining the reason the employment data differs substantially from previous reports. The list of comment codes is provided by the BLS.

### Comment Code2
- Additional information describing the reason for the employment data differing substantially from previous reports.

### Comment
- Large changes in employment or wage data can be explained here.

### Prerequisites
- Your business is already defined so that your company and its physical locations are maintained by the software.
- Organizations for your company have already been defined, including classifications (i.e., Business Group, GRE, Reporting Establishment, HR Organization, etc.).

### To define the Multiple Worksite Reporting Structure:
1. Define the MWS Transmitter GRE.
2. Define the organizations for a worksite.

See Defining the Organizations for a Worksite: page 19–6

3. Submit the Multiple Worksite Report

See Submitting the Multiple Worksite Report: page 19–6

Defining the Multiple Worksite Reporting Transmitter GRE

You define the MWS transmitter GRE from the Organization window.

To define the Multiple Worksite Reporting Transmitter GRE:
1. Query the GRE to be the MWS transmitter for the MWS report.
2. Select the Others button.
3. From the list select Multiple Worksite Reporting.
4. In the additional information flexfield, complete the required information.

Defining the Organizations for a Worksite

Define organizations for a worksite from the Organizations window.

To define the worksite organizations:
1. Query the organization.
2. Select the Reporting Establishment organization classification.
3. From the list, select Worksite Filing.
4. In the additional information field, complete the required information.

Submitting the Multiple Worksite Report

The multiple Worksite Report is submitted from the Submit Request window.

To submit the Multiple Worksite Report
1. Select Multiple Worksite Report from the list in the Submit Request window.
2. Select appropriate information about the quarter from the list of values.
3. Enter information about the year.
4. Enter information about the MWS transmitter. This is the name of the GRE that acts as transmitter.
W–2 Reporting on Magnetic Tape

For each GRE serving as a transmitter of federal W–2 reporting on magnetic tape, you must enter information identifying the GRE and the equipment being used. Start from the Organization window to make entries in the W2 Reporting Rules window.

To identify a GRE as a transmitter of W–2 reporting:

1. Enter or query the GRE in the Organization window. In the Organization Classifications region, select Government Reporting Entity. Choose the Others button, and select W2 Reporting Rules.
2. Click in the Additional Organization Information field to open the W2 Reporting Rules window.
3. Enter Yes in the W–2 Transmitter field for this GRE to function as a transmitter of W–2 information.
4. Optionally, enter the manufacturer’s name of the computer used to transmit W–2 information.
5. Select a tape labelling method: Standard Label, Non-standard Label or No Label.
6. Select a density: 800 CPI (Characters per Inch), 1600 CPI, 6250 CPI or 38,000 CPI.
7. Select a Recording Code: EBCDIC or ASCII.
Wage and Tax Reporting (Paper, Magnetic, Federal and State W-2)

Employers must report to their employees the amounts paid and withheld so the employees can complete their own income tax returns and pay any amount owed to the Internal Revenue Service.

Employers accomplish these reporting goals with the Wage and Tax Statement, or form W-2.

Information from this form is used to enforce the appropriate tax laws as legislated by federal and state governments.

In addition to reporting taxable income, some nontaxable amounts must also be reported to ensure that employees correctly complete their individual income tax return. The same is true for state reporting, except that the amounts reported are generally limited to taxable income and taxes withheld.

The following table depicts the various boxes and fields on form W-2, and indicates where Oracle Payroll draws the appropriate balances to complete the form.

<table>
<thead>
<tr>
<th>Box</th>
<th>Title</th>
<th>Information Contained</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>Control Number</td>
<td>Not required</td>
</tr>
<tr>
<td>b</td>
<td>Employer’s Identification Number</td>
<td>Employer ID (Federal EIN)</td>
</tr>
<tr>
<td>c</td>
<td>Employer’s Name, address, and Zip Code</td>
<td>Tax Unit Name (GRE Name) Tax Unit Address (GRE Location)</td>
</tr>
<tr>
<td>d</td>
<td>Employee’s SSN</td>
<td>National Identifier</td>
</tr>
<tr>
<td>e</td>
<td>Employee’s Name, address, and Zip Code, and telephone number</td>
<td>First, Middle Initial, Last Primary Address Telephone Number</td>
</tr>
<tr>
<td>1</td>
<td>Wages, Tips, and other Compensation</td>
<td>FIT_REDUCED_SUBJ_WHABLE + SUBJ_NWHABLE (PER_GRE_YTD)</td>
</tr>
<tr>
<td>2</td>
<td>Federal Income Tax Withheld</td>
<td>FIT_WITHHELD (PER_GRE_YTD)</td>
</tr>
<tr>
<td>3</td>
<td>Social Security Wages</td>
<td>SS EE TAXABLE (PER_GRE_YTD)</td>
</tr>
<tr>
<td>4</td>
<td>Social Security Tax Withheld</td>
<td>SS WITHHELD (PER_GRE_YTD)</td>
</tr>
<tr>
<td>5</td>
<td>Medicare Wages and Tips</td>
<td>MEDICARE EE TAXABLE (PER_GRE_YTD)</td>
</tr>
<tr>
<td>Box</td>
<td>Title</td>
<td>Information Contained</td>
</tr>
<tr>
<td>-----</td>
<td>-------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>6</td>
<td>Medicare Tax Withheld</td>
<td>MEDICARE EE TAXABLE (PER_GRE_YTD)</td>
</tr>
<tr>
<td>7</td>
<td>Social Security Tips</td>
<td>Not supported</td>
</tr>
<tr>
<td>8</td>
<td>Allocated Tips</td>
<td>Not supported</td>
</tr>
<tr>
<td>9</td>
<td>Advanced EIC Payment</td>
<td>EIC ADVANCED (PER_GRE_YTD)</td>
</tr>
<tr>
<td>10</td>
<td>Dependent Care Benefits</td>
<td>DEPENDENT CARE (PER_GRE_YTD)</td>
</tr>
<tr>
<td>11</td>
<td>Nonqualified Plans</td>
<td>Not supported</td>
</tr>
<tr>
<td>12</td>
<td>Benefits included in box 1</td>
<td>W2 FRINGE BENEFIT (PER_GRE_YTD)</td>
</tr>
<tr>
<td>13</td>
<td>See Instructions. for box 13</td>
<td>Creating Balances for Box 13 and 14: page 19 –14</td>
</tr>
<tr>
<td>14</td>
<td>Other (such as union dues, health insurance premiums deducted, nontaxable income, voluntary after-tax contributions, or educational assistance payments)</td>
<td>Creating Balances for Box 13 and 14: page 19 –14</td>
</tr>
<tr>
<td>15</td>
<td>Statutory employee (whose earnings are subject to social security and Medicare taxes but NOT subject to federal income tax withholding)</td>
<td>Federal Employee (if aei_information_10. Information_type is 'Federal')</td>
</tr>
<tr>
<td>15</td>
<td>Deceased (Checked when the reason of leaving is Deceased)</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Pension Plan</td>
<td>W2 PENSION PLAN (PER_GRE_YTD)</td>
</tr>
<tr>
<td>15</td>
<td>Legal representative</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Household Employee</td>
<td>not supported</td>
</tr>
<tr>
<td>15</td>
<td>Subtotal</td>
<td>not supported</td>
</tr>
<tr>
<td>15</td>
<td>Deferred Compensation</td>
<td>Def Comp 401(k) (PER_GRE_YTD)</td>
</tr>
<tr>
<td>16</td>
<td>State</td>
<td>State Code (The state information on the W-2 is provided only if that state or locality information is entered in the tax information form for the assignment.)</td>
</tr>
<tr>
<td>Box</td>
<td>Title</td>
<td>Information Contained</td>
</tr>
<tr>
<td>-----</td>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>16</td>
<td>Employer’s State ID Number</td>
<td>State_id from ORG_INFORMATION of hr_organization_information</td>
</tr>
<tr>
<td>17</td>
<td>State Wages, Tips, etc.</td>
<td>SIT REDUCED_SUBJ_WHABLE + SUBJ_NWHABLE (PER_GRE_YTD)</td>
</tr>
<tr>
<td>18</td>
<td>State income tax</td>
<td>SIT WITHHELD</td>
</tr>
<tr>
<td>19</td>
<td>Locality name</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Local wages, tips, etc</td>
<td>REDUCED_SUBJ_WHABLE + SUBJ_NWHABLE (PER_GRE_YTD)</td>
</tr>
<tr>
<td>21</td>
<td>Local Income Tax</td>
<td>Tax type (SDI, city, county, school) WITHHELD</td>
</tr>
</tbody>
</table>

**Balances for W-2 Box 13**

Box 13 holds a variety of information, much of which needs to be fed by a balance that you create according to your business rules. You can create individual balances to feed box 13 as appropriate.

For each Box 13 code, a definition is provided below.

**Code A – Uncollected social security tax on tips.**

A balance for Code A includes the amount of social security tax on an employee’s tips that could not be collected because of insufficient funds.

**Code B – Uncollected Medicare tax on tips**

A balance for Code B includes the amount of Medicare tax on an employee’s tips that could not be collected because of insufficient employee funds.

**Code C – Value of group-term life insurance coverage over $50,000**

A balance for Code C includes the value of employer-provided group-term life insurance coverage over $50,000 minus the employee’s after-ax contributions.
Code D – Section 401(k) contributions

A balance for Code D includes the employee’s total elective deferrals to a 401(k) cash or deferred arrangement, even if the employee exceeds the annual elective deferral limit.

Code E – Section 403(b) contributions

A balance for Code E includes the employee’s total elective deferrals to a 403(b) salary reduction agreement to purchase an annuity contract, even if the employee exceeds the annual elective deferral limit.

Code F – Section 408(k)(6) contributions

A balance for Code F includes the employee’s total elective deferrals to a 408(k)(6) salary reduction Simplified Employee Pension plan, even if the employee exceeds the annual elective deferral limit.

Code G – Section 457(b) contributions

A balance for Code G includes the total elective and nonelective contributions made to a 457(b) deferred compensation plan for government employees or tax exempt organizations, even if the employee exceeds the annual elective deferral limit.

Code H – Section 501(c)(18)(D) contributions

A balance for Code H includes the total elective deferrals to a 501(c)(18)(D) tax-exempt organization plan (not employer nonelective contributions or employee after-tax contributions).

Code J – Sick pay not includable as income

A balance for Code J includes the amount of third-party sick pay that is not subject to federal income tax because of the employee’s after-tax contributions to the sick pay plan.

Code K – Tax on excess golden parachute payments

A balance for Code K includes a 20% excise tax on excess golden parachute payments made to key corporate employees after a merger or acquisition.

Code L – Nontaxable part of employee business expense reimbursements

A balance for Code L includes the amount of employee business expense treated as substantiated (nontaxable) only if the
employer reimburses its employees for expenses under a per diem or mileage allowance that exceeds the government-approved rates.

**Code M – Uncollected social security tax on value of group-term life coverage over $50,000**

A balance for Code M includes the amount of uncollected social security tax on the value of excess group-term life insurance coverage for former employees.

**Code N – Uncollected Medicare tax on value of group-term life insurance coverage over $50,000**

A balance for Code N includes the amount of uncollected Medicare tax on the value of excess group-term life insurance coverage for former employees.

**Code P – Excludable reimbursed moving expenses**

A balance for Code P includes the amount of moving expense reimbursements paid to employees (or third parties on behalf of employees) that were not included in the employees’ income because they were paid for qualified moving expenses.

**Code Q – Military employee basic quarters, subsistence and combat pay**

A balance for Code Q includes the value of employee basic quarters, subsistence, and combat pay.

---

**Balances for W-2 Box 14**

Form W-2 Box 14 is designated as “Other,” and can hold information such as:

- Union Dues
- Health insurance premiums
- Nontaxable income
- Voluntary after-tax contributions
- Educational Assistance payments

Form W-2 Box 14 also allows you to place other information that you may be tracking throughout the year as a user-defined balance.
If you have been tracking user-defined information and need to report it in box 14 of form W-2, you need to feed the balance.

### Feeding Balances for W-2 Box 13 and Box 14

Balance feeds are established from the Balances window in the Compensation and Benefits area of the Navigator.

**Attention:** Balances are date effective. Ensure that you have set your effective date.

1. Query the code for W-2 box 13 and/or query for a balance for box 14 for which you want to establish a balance feed.
   
   **Note:** Codes for Box 13 take the form of “W2 Box 13A”, where the 13A is the code corresponding to the information required on form W-2 box 13, code A.

2. Press the Feeds button.
   
   The Balance Feeds window displays.

3. Select the appropriate Element name from the list on the Balance Feeds window.

4. Select the appropriate Input Value Name for what you want to add or feed.

5. Select Add for the Add/Subtract field to feed a balance.

6. Save your changes.
Withholding FIT From Third Party Payments

When employees return to work from long term disability, if they have received payments from a third party (such as a workers compensation carrier or an insurance company), these payments must be reported as income for FIT purposes.

Withholding FIT from third party payers is performed on the Adjust Tax Balances window.

- To withhold FIT from third party payments:
  1. Fill in the amount to be withheld in the FIT field.
  2. Check the FIT withheld by third party check box.
  3. Save your changes.

Wage and Tax Reporting

Reporting W-2 information is performed from the Submit Request window.

- To run Wage and Tax reporting on magnetic media for Federal W-2, select Wage and Tax Statement in the Name field.
- To run Wage and Tax reporting on magnetic media for State W-2, select State W2 in the Name field.
- To run Wage and Tax reporting for employees, select Employee W2 Report in the Name field.

**Attention:** Running this report to generate magnetic media produces a .mf file and a .aol file (transmittal report) to send. All Wage and Tax reporting requires that you have prepared tax feeds and balances for your system. See Creating Balances for W-2 Box 13 and 14: page 19–14.
To report state wage and taxes on magnetic media:
1. Query State W-2 Magnetic Media report in the Name field.
   The Parameters dialog box displays.
2. Enter or select the appropriate state in the State field.
3. Enter the appropriate year in the Year field.
4. Enter or select the appropriate transmitter GRE in the Transmitter GRE field.
5. Select OK.
   The dialog box is no longer displayed, however, information from it has populated many of the fields on the Submit Request window.
6. Select appropriate print options in the Print Options region.
7. Select appropriate run options in the run Options region.
8. Submit the report.

To report federal wage and taxes on magnetic media:
1. Query Wage and Tax Statement in the Name field.
   The Parameters dialog box displays.
2. Enter the appropriate year in the Year field.
3. Enter or select the appropriate transmitter GRE in the Transmitter GRE field.
4. Select OK.
   The dialog box is no longer displayed, however, information from it has populated many of the fields on the Submit Request window.
5. Select appropriate print options in the Print Options region.
6. Select appropriate run options in the run Options region.
7. Submit the report.

To report wage and taxes on paper for employees:
1. Query Employee W-2 Report in the Name field.
   The Parameters dialog box displays.
2. Enter the appropriate year in the Year field.
3. Enter or select the appropriate transmitter GRE in the GRE field.
4. Enter or select the appropriate organization name in the Organization field.
5. Enter or select the appropriate location in the Location Name field.
6. Enter or select the employee name in the Person Name field.
7. Enter or select the social security number in the Social Security Number field.
8. Select OK.
   The dialog box is no longer displayed, however, information from it has populated many of the fields on the Submit Request window.
9. Select appropriate print options in the Print Options region.
10. Select appropriate run options in the run Options region.
11. Submit the report.
State Quarterly Wage Listings on Magnetic Tape

For the quarterly wage listings distributed to states in which you have employees, there is a requirement to maintain data for several different kinds of records. The Interstate Conference of Employment Security Agencies, Inc. (ICESA) has developed a format for magnetic reporting of state wage listings that more than 20 states have adopted. The ICESA format designates the records required for state wage listings by code letters, as follows:

<table>
<thead>
<tr>
<th>Code</th>
<th>Record Name</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Transmitter Record</td>
<td>Identifies a GRE serving as a transmitter of wage listing files to a state.</td>
</tr>
<tr>
<td>B</td>
<td>Authorization Record</td>
<td>Identifies equipment used to create the file.</td>
</tr>
<tr>
<td>E</td>
<td>Employer Record</td>
<td>Identifies GREs whose employee data (S and T records) are included in a file.</td>
</tr>
<tr>
<td>S</td>
<td>Employee Wage Record</td>
<td>Gives wage and tax information for individual employees.</td>
</tr>
<tr>
<td>T</td>
<td>Total Record</td>
<td>Gives totals of S records for an employer.</td>
</tr>
<tr>
<td>F</td>
<td>Final Record</td>
<td>Indicates the end of a file.</td>
</tr>
</tbody>
</table>

States that have not adopted the ICESA format for wage listings use the federal Social Security Administration (SSA) format, or a variant of this format. Some of these states do not explicitly require the Transmitter (A) and Authorization (B) Records, but do require some of the information appearing on these records. For this reason, for each state to which you submit quarterly wage listings using Oracle Payroll, you must identify a GRE with employees in that state as a transmitter of the wage listing file, and enter A and B record information for this GRE.

See:
- Entering Generic A and B Record Data for GRE Transmitters: page 19–18
- Entering State A and B Record Data for GRE Transmitters: page 19–20
- Entering a Blocking Factor for E Records: page 19–22
- Entering State Data for E and T Records: page 19–23
- Entering S Record Data for Employees: page 19–26
- Magnetic Media Wage Reporting Utilities: page 19–38

Entering Generic A and B Record Data for GRE Transmitters

For each state to which you submit quarterly wage listings, you must identify a GRE with employees in that state as a transmitter of these
listings. You do this by entering for the GRE, data for the Transmitter (A) Record and the Authorization (B) Record. Depending on the states to which a GRE is transmitting wage listings, you may need to enter state–specific data in addition to generic data for these records.

Start entry from the Organization window to make entries for a GRE in the SQWL Generic Transmitter Rules window.

**Attention:** SQWL reports contain specific information tailored for specific states. Consider a strategy of grouping states with similar transmitter requirements, and then prepare and run the reports sequentially. This will minimize the amount of effort in preparing SQWL reports for multiple states.

**Note:** SQWL requires two processes to generate each report. Depending upon how your concurrent manager is configured, you may have to stagger submitting your SQWL reports until previously submitted reports have finished processing.

To enter generic transmitter data for A and B records:

1. In the Organization window, enter or query a GRE serving as a transmitter of state quarterly wage listings. In the Organization Classifications region, place the cursor on Government Reporting Entity, choose the Others button, and select SQWL Generic Transmitter Rules.
2. Click in the Additional Organization Information field to open the SQWL Generic Transmitter Rules window.
3. Select Yes in the Transmitter GRE field to identify this GRE as a transmitter of state wage listings.
4. Optionally, enter the manufacturer’s name of the computer used to transmit the state wage listings.
5. Select the tape labelling method being used: ANSI standard, IBM standard, No label, or Non–standard.
6. Select the tape density: 1600 BPI (blocks per inch), 6250 BPI, or 38000 BPI.
7. Select the recording code: EBCDIC or ASCII.

8. Select the number of tracks: IBM 3480 cartridge or Reel tapes.

9. Enter the blocking factor of the file (not to exceed 85).

   **Note:** You may also need to enter blocking factors for individual Employer (E) Records included on a file.

   See: Entering a Blocking Factor for E Records: page 19–22

10. In the Transmitter Contact field, enter the title of the person responsible for state wage listing transmission. Also enter the phone number and extension of the person with this title.

11. In the Media Transmitter/Authorization Number field, enter any authorizing code or number provided by the state to which this GRE is transmitting quarterly wage listings.

12. Save your work and choose OK to return to the Organization window.

This completes the entry of information for A and B records except for GREs with employees in any of the following states: Illinois, Missouri, New Jersey, Pennsylvania, Texas. For these states, you must enter rules unique to particular states in the SQWL State Transmitter Rules window.

See: Entering State A and B Record Data for GRE Transmitters: page 19–20

---

**Entering State A and B Record Data for GRE Transmitters**

Start this entry of data specific to particular states from the Organization window, to make entries in the SQWL State Transmitter Rules window.

**Attention:** SQWL reports contain specific information tailored for specific states. Consider a strategy of grouping states with similar transmitter requirements, and then prepare and run the reports sequentially. This will minimize the amount of effort in preparing SQWL reports for multiple states.

**Note:** SQWL requires two processes to generate each report. Depending upon how your concurrent manager is configured, you may have to stagger submitting your SQWL reports until previously submitted reports have finished processing.
To enter A and B record data for IL, MO, NJ, PA, TX:

1. In the Organization window, query the GRE serving as a SQWL transmitter, if it does not already appear there. With Government Reporting Entity selected in the Organization Classifications region of the Organization window, choose Others and select SQWL State Transmitter Rules.

2. Click in the Additional Organization Information field to open the SQWL State Transmitter Rules window. Make entries only for the state or states to which this GRE is transmitting quarterly wage listings.

**Illinois**
- In the Filing Type field, select either Magnetic Tape or Magnetic Cartridge.

**Missouri**
- Enter the total dollar amount of wages reported in this file.

**New Jersey**
- Enter the tape authorization number appearing on Form WR-43, Wage Reporting Magnetic Tape Transmittal, in the Tape Authorization Number field.

**Pennsylvania**
- Enter the name of the person responsible for state wage listing submission in the Transmitter Contact Person field.

**Texas**
1. If an allocation list is reported on this tape (listing different GREs whose S and T records are included on the tape), select Yes in the Allocation List field. For tapes reporting an allocation list:
• enter a 9–digit ID number in the Service Agent ID field
• enter a dollar amount in the Total Remittance Amount field.

2. If tax (C–3) data is reported for each GRE’s account in this file, select Yes in the C3 Data field.

3. In the Suffix Code field, enter the suffix code assigned by the Texas Employment Commission.

Entering a Blocking Factor for E Records

You must enter a blocking factor for a GRE’s E records when a state requires it.

To enter a blocking factor for a GRE’s E record, start from the Organization window to make an entry in the SQWL Employer Rules (1) window.

To enter a blocking factor for a GRE’s E records:

1. In the Organization window, query the GRE for which to enter a blocking factor, if it does not already appear there. With Government Reporting Entity selected in the Organization Classifications region of the Organization window, choose Others and select SQWL Employer Rules (1).

2. Click in the Additional Organization Information field to open the SQWL Employer Rules (1) window.

3. In the Blocking Factor field, enter the blocking factor (not to exceed 85) for this GRE’s Employer (E) Record.
Entering State Data for E and T Records

There are certain state–specific requirements for entries to a GRE’s Employer (E) Records, or Total (T) Records, or both. The states with unique requirements for these records are the following: Illinois, Kentucky, Missouri, Montana, North Carolina, New Hampshire, New York, Ohio, Pennsylvania, and Texas.

E and T Record Data for IL, KY, MO, and MT

To make entries for the E or T records of a GRE with employees in these states, start from the Organization window to make entries in the SQWL Employer Rules (1) window.

**Note:** For information about making entries to the Blocking Factor field in this window see: Entering a Blocking Factor for E Records: page 19–22

To enter E and T record data for IL, KY, MO, and MT:

1. In the Organization window, query the GRE for which to enter SQWL record data if it does not already appear there. With Government Reporting Entity selected in the Organization Classifications region of the Organization window, choose Others and select SQWL Employer Rules (1).
2. Click in the Additional Organization Information field to open the SQWL Employer Rules (1) window. Make entries only for the state, or states, in which the GRE has employees.

**Illinois (for the GRE’s E and T records)**

1. If a previous overpayment is being applied to the balance due, enter the overpayment amount in the Credit/Overpayment field.
2. Enter the Document Control Number from the Quarterly Filing Notice. If unknown, enter the number 1.

3. Enter any interest and penalty due in the Interest and Penalty fields.

4. Enter any previous quarter (s) underpayment (including previously due penalty and interest) in the Previous Quarter (s) Underpayment field.

5. Enter the appropriate tax type code (Taxable employer or Reimbursable employer) in the Tax Type Code field.

**Kentucky (for the GRE’s E records)**
- Enter the industry code from form UI-3.

**Missouri (for the GRE’s T records)**
1. Enter the total payment submitted for the GRE in the Amount Remitted field.

2. Enter the amount of all outstanding credits in the Credit/Overpayment field.

3. If the Contribution and Wage Report shows an amount due for interest assessment, enter this amount in the Employer Assessment Amount field.

4. When interest is due for quarterly reports not filed by the due date, multiply the contributions due by the monthly interest rate (from the Contribution and Wage Report). Enter the interest due in the Interest field.

5. Enter the amount of all outstanding amounts due in the Previous Quarter(s) Underpayment field.

**Montana (for the GRE’s T records)**
1. Enter any overpayment existing on the file generation date in the Credit/Overpayment field.

2. Compute interest by multiplying the Qtr. UI Taxes Due amount by the rate of .05% per day. Enter the results in the Interest field.

3. For payments 30 or fewer days late, the penalty is $10.00 or 10% of the Qtr. UI Taxes Due, whichever is greater. For payments more than 30 days late, the penalty is $15.00 or 15% of the taxes due, whichever is greater. Enter a penalty amount in the Penalty field.

4. Enter the amount of all adjustments or amendments to previous quarter reports in the Previous Quarter(s) Adjustments field.
E and T Record Data for NC, NH, NY, OH, PA, and TX

To make entries for the E or T records of a GRE with employees in these states, start from the Organization window to make entries in the SQWL Employer Rules (2) window.

To enter E and T record data for NC, NH, NY, OH, PA, and TX:

1. In the Organization window, query the GRE for which to enter SQWL record data if it does not already appear there. With Government Reporting Entity selected in the Organization Classifications region of the Organization window, choose Others and select SQWL Employer Rules (2).

2. Click in the Additional Organization Information field to open the SQWL Employer Rules (2) window. Make entries only for the state, or states, in which the GRE has employees.

North Carolina (for the GRE’s E records)

- Enter the 6-digit Remitter Number assigned by the state Employment Security Commission in the State Control Number field. A GRE with no number must contact the ESC to obtain one.

New Hampshire (for the GRE’s E records)

- Enter the name and title of the contact person for the GRE.

New York (for the GRE’s E records)

- If the GRE hires seasonal labor, select Yes in the Seasonal Employer Indicator field.

Ohio (for the GRE’s E records)

- If the Bureau of Employment Services has assigned a 3-digit number to the GRE for multiple plant charging, enter the number in the State Employer Plant Code Field.
Pennsylvania (for the GRE’s E records)

If the GRE is approved for plant reporting, enter its plant number.

Texas (for the GRE’s T records)

1. If the record for this GRE is one of several employee records on the tape (so that the A record for the tape includes an Allocation List), enter in the Allocation Amount field the dollar amount for this GRE’s account.

2. Select a county in which the GRE has the greatest number of employees.

3. In the Multi State Employment Indicator field, select Yes for a GRE which, during the year, reports wages to another state for employees whose wage information is included on this tape.

Entering S Record Data for Employees

Most states require entry of some basic data on the Employee Wage (S) records of the state wage listings. Additionally, Alaska, California, and Missouri have state-specific requirements.

To enter data for an employee for entry on the S records of state quarterly wage listings, query the employee in the Person window, go to the Assignment window for him or her, and access the alternative window GREs and Other Data.

To enter data for a GRE’s S records:

1. In the Assignment window, open the alternative region GREs and Other Data. Scroll down this window to the field Reporting.
Establishment. Select the Reporting Establishment for this employee.

Attention: Ensure that Reporting Unit Numbers have been entered for your Reporting Establishments in the Work site Filing window. The State Quarterly Wage Listing process requires this number for the S records of some states.

See: Defining the Multiple Worksite Reporting Transmitter GRE: page 19–6

2. If this employee is a seasonal worker, select Yes in the Seasonal Worker field. The default is No.

3. If this employee is an officer of your corporation, enter 1 in this field.

This completes entry of information required for the S record except for employees who work in Alaska, California, or Missouri. For these employees, continue data entry.

Alaska
- To find the Area Code and Occupational Code for this employee, consult the Occupational Coding Manual for Employers published by the Alaska Department of Labor.

California
- Select the correct wage plan for the employee.

  Note: UI = Unemployment Insurance; SUI = State Unemployment Insurance. DI = Disability Insurance; SDI = State Disability Insurance.

Missouri
- Select the appropriate probationary status for the employee.
Obtaining Tax and Wage Reports

These reports include the following:

- Tax Summary Listing: page 19–28
- Federal Form W–2, Wage and Tax Statement (for employees): page 19–29
- Federal Form W–941, Employer’s Quarterly Federal Tax Return: page 19–33
- Reporting distributed on magnetic tape:
  - Federal Form W–2, Wage and Tax Statement (for the IRS): page 19–35
  - Federal Form BLS 3020, Multiple Work Site Report: page 19–36
  - State Quarterly Wage Listings: page 19–36

See Also

Reports on Pay Processing: page 21–36

Tax Summary Listing

This report shows the federal, state and local tax balances summarized for a particular payroll, a consolidation set, or a GRE, as of a payroll period end date and Check Date.

Run the Tax Summary report from the Submit Request window.

To run the Tax Summary report:

1. In the Name field, select one of the following:
   - Tax Summary Listing for a Check Date
   - Tax Summary Listing for a Payroll Run or QuickPay
   Click in the Parameters field if the Parameters box does not automatically open.
2. Select the particular listing you want to run.
3. For the Listing for a Check Date report, select the Check Date of the period to report on. This required field is the date of constructive receipt of pay. Optionally, select a consolidation set and payroll. If
you do not select a consolidation set or payroll, the report covers all sets and payrolls.

For the Listing for a Payroll Run report, select the payroll run to cover. The list shows the payroll name, the check date and the consolidation set.

4. Select a GRE. If you make no selections, the report covers all the GREs in the Business Group.

5. Select Federal, State or Local as the domain of taxes to include. If you make no selection the report covers taxes for all domains.

6. Select a state or county to report on taxes for this state or county only.

**Federal Form W–2 for Employees**

Federal Form W–2, Wage and Tax Statement is the annual statement of earnings that employers must distribute to each employee, and submit to the IRS. It lists all compensation paid in the calendar year and the taxes withheld. You produce this report on paper to send to each employee.

Run this report from the Submit Request window.

**To run Form W–2 for distribution to employees:**

1. In the Name field, select Employee W2 Report. Click in the Parameters field if the Parameters box does not open automatically.

2. Enter the tax year for this report.

3. Select a GRE, organization or location to obtain a W–2 for every employee in that GRE, organization or location.

4. To obtain the report for one employee, select his or her name. The list displays employees’ names, Social Security Numbers and employee numbers.

5. Choose Submit.
Annual FUTA Tax Return Work Sheet (Form 940)

Employers use form 940 to determine your FUTA taxable wages for the calendar year and the FUTA tax liability on those wages after accounting for applicable state unemployment tax credits and FUTA tax deposits made during the year.

If you are covered by FUTA, you must report your liability annually on Form 940, Employer’s Annual Federal Unemployment (FUTA) Tax Return. See IRC 3306(a) and IRS Regulation 31.3306(a)–1(b) for eligibility requirements.

Using Form 940, you can also pay your fourth quarter liability if the liability is less than $100.

Reporting Federal Unemployment Tax

Generally all employee compensation is subject to FUTA tax unless exempted under IRC 3306(b) and IRS Reg. 31.3306(b)(2)–1 – (b)(10)–1.

Oracle Payroll provides certain information in the form of a work sheet that you then transcribe to the official form 940; however, some information must be provided by you:

- Part II, section 3, column i, Contributions actually paid to state.
- Part II, section 3a, total for column i, Contributions actually paid to state.
- Part II, section 3b, Total tentative credit.
- Part II, section 6, Credit.
- Part II, section 7, Total FUTA tax.
- Part II, section 8, Total FUTA tax deposited for the year.
- Part II, section 9, Balance due.
- Part II, section 10, Overpayment.
- Part III, record of Quarterly Federal Unemployment Tax Liability.

Running the Annual FUTA Tax Return Work Sheet

Prerequisite

- You must know which of your employees are exempt from FUTA and have marked them appropriately on the Tax Rules window.
See IRC 3306(c), (s) and IRS Reg. 31.3306(c)(1)–1 – (c)(18)–1 for types of employment that are exempt from FUTA.

You run the Annual FUTA Tax Return Work Sheet from the Submit Request window.

To run the Annual FUTA Tax Return Work Sheet:

1. Enter or query Annual FUTA Tax Return Work Sheet (Form 940) in the Name field. The Parameters dialog box displays.
2. Enter the appropriate GRE in the Government Reporting Entity field.
3. Enter the appropriate tax year in the Tax Year field.
4. Enter the appropriate state code in the State Code field (optional).
5. Select OK. The dialog box disappears, and the Submit Request window is filled in.
6. Submit the request.
7. To check on the progress of the processing, use the Concurrent Requests window, or from the Help menu, select View My Requests.

Experience Rates

The Experience Rate is the rate an employer uses to determine the amount of unemployment taxes it must pay. The experience rate is determined by the employers “Experience Rating,” which in turn is
The unemployment insurance experience rate is determined by the employers unemployment benefit charges and average annual taxable payroll. The state provides the employer with its experience rate.

Employers with a high turnover generally have a higher experience rate. Employers with little turnover have a lower experience rate.

**Entering an Experience Rate**

- **To enter an experience rate:**
  1. Navigate to the State Tax Rules window.
  2. Enter the experience rate in the SUI ER Experience Rate 1 field.

  **Attention:** Oracle Payroll supports only one yearly experience rate. If your experience rate changes during the year, you must track it separately. SUI ER Experience Rate 2 field is reserved for future development.

  3. Save the entry.
Employer’s Quarterly Federal Tax Return (Form W–941)

This quarterly report must be filed by all employers that withhold federal income tax from employee compensation and are subject to withholding and payment of social security and/or Medicare taxes.

Form 941, Employer’s Quarterly Federal Tax Return, provides the IRS with a report of each employer’s total taxable wages paid and payroll tax liability, which is then reconciled with the employer’s record of tax deposits and wage and tax information provided to employees on their W-2 forms.

Reporting Quarterly Federal Tax Returns

Oracle Payroll provides certain information in the form of a work sheet that you then transcribe to the official form 941; however, some information must be provided by you:

- Item 4, Adjustment of withheld income tax for preceding quarters of calendar year.
- Item 5, Adjusted total of income tax withheld.
- Item 9, Adjustment of social security and Medicare taxes.
- Item 10, Adjusted total of social security and Medicare taxes.
- Item 11, Total taxes.
- Item 13, Net taxes.
- Item 14, Total deposits for quarter, including overpayment applied from a prior quarter.
- Item 15, Balance due.
- Item 16, Overpayment.
- Item 17, Monthly summary of Federal Tax Liability.

You run the Quarterly Federal Tax Return Work Sheet from the Submit Request window.
To run the Quarterly Federal Tax Return Work Sheet:

1. Enter or query Quarterly Federal Tax Return Work Sheet (Form 941) in the Name field.
   The Parameters dialog box displays.
2. Enter the appropriate GRE in the Government Reporting Entity field.
3. Enter the appropriate tax year in the Tax Year field.
4. Select the appropriate quarter ending date from the list provided in the Quarter Date field.
5. Select OK.
   The dialog box disappears, and the Submit Request window is filled in.
6. Submit the request.
7. To check on the progress of the processing, use the Concurrent Requests window, or from the Help menu, select View My Requests.
Reports on Magnetic Tape

Tax and wage reporting distributed on magnetic tape includes:

- Federal Form W–2 (for the IRS): page 19–35
- Federal Form BLS 3020, Multiple Work Site Report (Form BLS 3020): page 19–3
- State Quarterly Wage Listings: page 19–36

If necessary, you can roll back processes that produce files for loading on magnetic tape, make updates or corrections to data, and rerun the processes.

See Also

Rollbacks of Processes for Reports on Magnetic Tape: page 19–37
Magnetic Media Wage Reporting Utilities: page 19–38

Federal Form W–2

The Federal W2 process:

- creates a file containing your enterprise’s annual Wage and Tax Statement of employee earnings and tax withholding, to load on tape for submission to the IRS
- creates a second file containing report totals and other information needed for entry on tape transmittal forms.

Run the Federal W2 process from the Submit Request window.

To run the Federal W2 process:

1. In the Name field, select Federal W2. Click in the Parameters field if the Parameters box does not open automatically.
2. Enter the tax year for this report.
3. Select the name of the GRE that functions as the transmitter of this W–2 report.
   See: W–2 Reporting on Magnetic Tape: page 19–8
4. Choose OK, then Submit.

The Federal W2 process selects all employees with earnings to report. It then automatically initiates the Magnetic Report process, which produces two files:
5. Use the FEDW2_yy.mf file to produce the magnetic tape. Consult your system administrator for the procedure to use for tape production.

6. The other file, 6559_yy.a01, contains report totals and other information for entry on the transmittal forms that must accompany your tape when you submit it to the IRS.

View this file online to obtain data for entry on Form 6559, Transmitter Report and Summary of Magnetic Media, and Form 6559–A, Continuation Sheet for Form 6559 (for tapes containing reports from more than two employers).

---

**State Quarterly Wage Listings**

The State Quarterly Wage Listing process:

- creates a file containing quarterly state wage listings, to load on tape for submission to the appropriate state authority.
- creates a second file containing report totals and other information needed for entry on tape transmittal forms.
- marks this information as archived for later recall if needed.

Run this process from the Submit Request window.

See: Magnetic Media Wage Reporting Utilities: page 19 –38

**To run the State Quarterly Wage Listing process:**

1. In the Name field, select State Quarterly Wage Listing. Click in the Parameters field if the Parameters window does not open automatically.

2. Select the state, quarter, and year for which to run the process.

3. Select the name of the GRE serving as transmitter of the tape of quarterly wage listings to the state for which you are running this process.

   See: State Quarterly Wage Listings on Magnetic Tape: page 19 –18

4. Choose OK, then Submit.
The State Quarterly Wage Listing process selects all employees with earnings to report in the state selected as a report parameter, sorted by the GRE to which they belong. It then automatically initiates the Magnetic Report process, which produces two files:

**Note:** The qqyy format indicating quarter and year is determined by the final month of the quarter of the year in question. Hence, the first quarter of 1999 is represented by ST_0399.mf (the 03 indicates March, the last month of the first quarter; the 99 indicates the year 1999).

- ST_qqyy.mf (for example, for a report for Pennsylvania for the third quarter of 1997, the name would be PA_0997.mf)
- ST_qqyy.a01 (for example, for Michigan for the second quarter of 1998, the name would be MI_0698.a01)

5. Use the ST_qqyy.mf file to produce the magnetic tape. Consult your system administrator for the procedure to use for tape production.

6. The other file, ST_qqyy.a01, contains report totals and other information that may be needed for entry on the transmittal form accompanying the tape you submit to the state authority. View this file online to obtain data for entry on the transmittal form.

---

**Rollbacks of Processes for Reports on Magnetic Tape**

If you have already run a process for a magnetic tape report for a state and then must make changes to the data that was processed, do the following:

- roll back the process
- make all necessary changes to employee data
- rerun the process.

Roll back a process from the Submit Request window.

**To roll back a process for a magnetic tape report:**

1. In the Name field, select Rollback Magnetic Report. Click in the Parameters field if the Parameters box does not open automatically.

2. In the Magnetic Report field, select the name of the process (state, period, and effective date) to roll back.

3. Choose OK, then Submit.
Attention: The rollback process does not have any effect on the two files produced by the Magnetic Report process. However, when you rerun the process following a rollback, this new process produces two files that overwrite the existing files.

Magnetic Media Wage Reporting Utilities

Oracle Payroll provides a number of utilities to help manage magnetic media wage reporting:

- Resubmit Magnetic Report utility
  The Resubmit Magnetic Report utility recreates a previously created magnetic report, which you can then resubmit if the original is ever damaged or lost.

- Archive Report utility
  The Archive Report utility lets you view archived information. Oracle Payroll marks information as archived when a magnetic wage report (such as SQWL) is generated.
  You can view information from a specific SQWL report. Alternately, you can view information about a specific employee in a specific SQWL report.

- Archive Differences Report utility
  The Archive Differences Report utility compares archived data and current data. Oracle Payroll marks information as archived when a magnetic wage report (such as SQWL) is generated.
  The output is information that has changed since the archive. If the Archive Differences Report generates no output, then no data has changed since the original report was generated and archived.

See: State Quarterly Wage Listings: page 19–36

Resubmit Magnetic Report

Magnetic media can be damaged or lost when shipped. The Resubmit Magnetic Report utility recreates the magnetic report that is lost or damaged and prepares it for submittal.

If minor employer information has changed since the original report submittal (such as an incorrect address), it is included in the report. However, employee information that has changed is not reflected as this would change the integrity of the report (the exception being an
incorrect employee address is allowed to be updated). These changes are typically handled with paper corrections as required by the appropriate reporting authority.

▶ **To resubmit magnetic media reports:**

2. Select the report you want to resubmit from the list of values in the Magnetic Report field of the Parameters window.
3. Select the Submit button.

**Archive Magnetic Report**

The Archive Magnetic Report utility scans for data marked as archived and generates a report listing archived data. This utility allows you to view archived magnetic report data for state-specific SQWL, or for a specific employee’s data included in a SQWL report or a Federal W-2 report.

▶ **To view archived data:**

2. Select the report you want to examine from the list of values in the Magnetic Report field on the Parameters window.
3. If desired, enter the name of an employee in the Assignment field on the Parameters window to examine information about that employee as submitted in the magnetic report selected in step 2, above.
4. Select the Submit button.

**Note:** The output of this report includes database items that are preceded with an “A_”. This indicates that the database item is archived, and is not current information.

**Archive Differences Report**

The Archive Differences Report utility scans the database for data that is marked as archived and compares it with current data. This utility gives you a method to ensure that information has been updated since the selected report was generated.

The Archive Differences Report utility only lists information that has changed from the material marked as archived, and that which is
current. If the Archive Differences Report utility does not generate a report, this means that the current data and the data that is archived are the same.

To compare archived and current data:

1. Select Archive Differences Report from the Submit Request window.
2. Select the report you want to compare from the list of values in the Magnetic Report field on the Parameters window.
3. Select the Submit button.
Retirement Plan Listings: 1099-R

At year’s end, employers who make distributions of retirement income are required to report those distributions and any amount withheld for FIT on form 1099-R. Employers with more than 249 employees are required to file Forms 1099-R on magnetic media, unless a waiver has been granted.

Employers must report any distributions from all types of retirement plans; both periodic and lump-sum payments must be reported as well.

Form 1099-R requires distributions from any of the following be reported:

- Pensions
- Annuities
- Retirement or Profit sharing plans
- IRAs
- Insurance Contracts

End of Year Reporting

Oracle Payroll supports legislative requirements for the reporting of pension distributions on either paper or magnetic media.

The standard reports base their calculations on balances held for the dimensions year to date, person, and GRE.

You can modify the reports to reflect the manner in which your enterprise makes pension distributions.

Defining 1099-R Reporting Rules

US 1099-R Magnetic Reporting Rules are under Additional Organization Information for the Organization Classification of Government Reporting Entity, and must be defined for each retirement GRE.

The reporting rules take the following parameters:

- 1099R Transmitter
- Transmitter Control Code
- Bureau
• Combined Filing
• Recording Mode
• Parity
• Label
• Density

Note that for a retirement GRE which is not a 1099–R transmitter, the last six parameters are not used and may be left blank. However, the Transmitter Control Code should be the same as the 1099–R transmitter for that GRE.

**Attention:** Since State 1099–R Magnetic Report for New York and Michigan uses State Quarterly Wage Listings and TIB4 format respectively, W2 Reporting Rules must be defined for the pertinent retirement GRE in order for the NY and MI 1099–R reports to be generated.

---

### Submitting a 1099–R Request

1099-R can be requested through the Submit Request window under the name Federal 1099–R Magnetic Report or State 1099–R Magnetic Report.

Federal 1099–R Request parameters are:

• Year
• Transmitter
• All Payers
• Test Tape

The All Payers field indicates whether or not all retirement GREs defined with the same TCC as the chosen transmitter should be included in the magnetic report.

**Attention:** State 1099–R Request parameters are identical to the Federal parameters with one extra field: State

---

### 1099–R Output

1099–R generates two output files:

• Magnetic report with naming convention [STATE]99R_[YEAR].mf
e.g. FE99R_96.mf, NY99R_98.mf

- Transmitter report with naming convention 1099_[YEAR].a01
  e.g. 1099_96.a01
Workers Compensation

Every state has a Workers Compensation program to provide employees with insurance coverage for work-related injuries. Oracle HRMS allows you to maintain Workers Compensation information for each of your GREs, and for the jobs within them.

At installations including Oracle Payroll, the payroll run calculates the employer/employee liability for Workers Compensation.

This chapter explains:

- how to maintain information for Workers Compensation calculations
- how to manage the calculation of Workers Compensation using Oracle Payroll.
Workers Compensation Overview

All states legislate WC (Workers Compensation) programs to provide employees with insurance coverage for work–related injuries. In every state, employers are liable for the premiums for this insurance, and in some states the employee pays a portion as well.

Determination of the WC liability of your enterprise requires maintenance of some specialized information. You must associate your jobs with state WC work classification codes, and further, associate these codes with state WC premium rates. You also must maintain WC–related data for each GRE.

For Oracle Payroll users, the payroll run calculates employer WC liability for each employee. At Oracle HRMS installations that do not include Oracle Payroll, it may still be necessary to maintain WC–related information in the HRMS database, for transfer to other systems.

WC Insurance Carriers and Monopolistic or Competitive States

Some states are monopolistic with respect to the WC insurance carrier, which means that employers in these states can use only the state fund as their carrier.

Other states are competitive, which means they permit employers to use either private insurers or the state agency to fund WC programs. If your enterprise has GREs in different states, you likely have a different carrier in each state. If your enterprise has more than one GRE in a competitive state, it is possible for each to have a different WC carrier. However, each GRE can have only one WC carrier per state, whose name you enter in the system.

See Also

Setup Steps for Workers Compensation Calculations: page 20–12
Data for Calculation of WC Premiums

Premiums paid for worker’s compensation insurance, whether it is a monopolistic or competitive state, are generally based on the type of business the employer does and the size of the payroll.

Employers are assigned classification codes based on the nature of the business. A dollar value is then assigned to the code and using one of the calculation methods noted below, it is used to determine the employer’s and employee’s worker’s compensation premium.

Calculation Methods

Oracle Payroll provides several calculation methods to support both employee and employer contributions to Workers Compensation Insurance. These methods apply to the employer and employee numbered portions (if required) independently.

- Percent of Subject Earnings:
  The employer and employee rates are expressed as a percentage.

- Hourly Rate:
  The employer and employee rates are expressed in dollars per hour, where the hours used to calculate the amount deducted are the regular hours worked.

- Flat Amount Per Period:
  The employer and employee rates are expressed in dollars per specified period of time, such as a year, a month, or a quarter.

Some businesses are deemed to be more dangerous than others and have a higher dollar amount assigned to the business. However, some employees may be assigned to a different and less expensive code because they are not involved in the more dangerous aspects of the business. For example, the job Phone Line Maintenance Worker has a different code, and higher rate, than the job Long Distance Operator. These employees may be assigned to an exception classification.

You must maintain information on:

- state WC classification codes for jobs, and their associated rates: page 20 –4
- state-level modifiers, surcharges and discounts applicable to the base premium calculation: page 20 –5
- state rules governing the determination of the payroll exposure: page 20 –6
Jobs and WC State Codes and Rates

Each state uses a set of work classification codes to represent its WC rates. The codes and their associated rates are intended to reflect the risk of injury or work-related illness in different types of work.

For each state in which you have a GRE, your jobs require WC classification codes. A given job does not necessarily have the same classification and code from state to state. Within a state, the same code normally covers a number of different jobs judged to have a similar risk level, so in each state all your jobs may fall into a fairly small number of codes.

<table>
<thead>
<tr>
<th>Job</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookkeeper</td>
<td>8810</td>
</tr>
<tr>
<td>Clerk/Typist</td>
<td>8810</td>
</tr>
<tr>
<td>Installer</td>
<td>5538</td>
</tr>
<tr>
<td>Repair people</td>
<td>5538</td>
</tr>
<tr>
<td>Senior Installer</td>
<td>5542</td>
</tr>
<tr>
<td>Outside Sales</td>
<td>8742</td>
</tr>
</tbody>
</table>

Table 20–1 Example Jobs and WC Codes for a State

In a competitive state that permits employers to use private WC insurance carriers, all the carriers use the same set of codes, but need not use the same rates for each code. Also, the rate a private carrier charges for a code can vary according to the locations within a state. That is, particular geographical areas or job sites in a state can have special rates for the same code.

In addition to each carrier’s default rates, you must maintain any special rates the carrier uses for particular locations.

<table>
<thead>
<tr>
<th>Code</th>
<th>Carrier A, Default Rates</th>
<th>Carrier A, Rates for Site H</th>
</tr>
</thead>
<tbody>
<tr>
<td>8810</td>
<td>.97</td>
<td>.94</td>
</tr>
<tr>
<td>8742</td>
<td>1.36</td>
<td>1.34</td>
</tr>
</tbody>
</table>

Table 20–2 Example WC Codes and Rates for WC Carrier A, by Location
See Also

Entering WC Job Codes, Payroll Exposure Rules and Surcharges: page 20–14
Associating WC Codes with Rates: page 20–13

Premium Modifiers and Surcharges

Reflecting your history as an employer with respect to WC claims, all states apply an Experience Modification Rate to the base premium, which can either reduce or increase your WC liability. Also, many states use:

- an Employer’s Liability Rate, applied before the Experience Modification Rate, which adds a percentage to the premium total. The system multiplies the premium total by the percentage to obtain the new total. For example, for an Employer’s Liability Rate of 4%, the system multiplies the total by 1.04.

- a Premium Discount Rate, applied after the Experience Modification Rate and certain surcharges that may be present. This modifier always reduces the premium total. The system multiplies the premium total by the Premium Discount Rate to determine the discount amount, and then subtracts this amount from the premium total.

Surcharges

In addition to the modifiers mentioned above, some states apply surcharges, which can be either additional charges or rebates, to the WC premium calculation. One or two surcharges may be applied after the Experience Modification Rate but before the Premium Discount Rate. Another surcharge may be applied after the Premium Discount Rate. Some surcharges are added into the running total of the premium, while others are held separately and applied to the premium calculation at the end.
Unique State Provisions

In addition to the commonly occurring modifiers and surcharges, a state may use special modifiers, surcharges or rules not found elsewhere. You can modify the standard functionality of Oracle HRMS to accommodate special state provisions. Your WC insurance carriers can inform you about the rules currently in effect in particular states, and about changes to these rules as they occur.

See Also

Entering WC Job Codes, Payroll Exposure Rules and Surcharges: page 20–14

Payroll Exposure

Overtime Pay and Executive Weekly Maximum

States have different rules regarding the inclusion of overtime pay in employees’ WC payroll exposure, depending on whether these earnings are paid at straight time or premium rates. Further, some states impose an Executive Weekly Maximum, which sets an upper limit on the amount of an employee’s earnings available for inclusion in his or her payroll exposure. Overtime hours can also be included, independent from subject wages.

You set a state’s rules concerning the inclusion of overtime in payroll exposure, and any limit on the inclusion of earnings in payroll exposure, using the Workers Compensation window.

Note: This category of payroll exposure only applies when at least one of the calculation methods is Percentage of Subject Earnings.

See: Entering WC Job Codes, Payroll Exposure Rules and Surcharges: page 20–14

Supplemental and Imputed Earnings Types

The inclusion in the payroll exposure of supplemental and imputed earnings also varies from state to state. You maintain information on commonly–occurring state rules regarding the inclusion of various earnings types in the Workers Compensation payroll exposure.

See: Reviewing and Maintaining Taxability Rules: page 18–33
Unique State Rules

Individual states can, and do, have additional rules they apply to the determination of WC payroll exposure. If you have GREs in these states, you can make modifications to Oracle HRMS to account for such rules. Your WC insurance carrier in a state can supply information about that state’s particular rules and regulations.

WC Code Overrides

Sometimes you must override the regular WC job classification codes for certain employees. For example, when employees in a high risk job classification are working at a construction site, you may be required to give everyone at the site, including clerical personnel and similar lower risk workers, the higher risk code.

After your setup of WC–related information is complete, you can select and remove WC override codes for individual employee assignments.

See Also

Entering a WC Override Code: page 20–15
WC Elements and Formulas in Oracle Payroll

Oracle Payroll includes several WC elements:

- **Workers Compensation element** (classification: Employer Taxes).
  The Workers Compensation element stores the amount of each employer’s liability WC premium, calculated using the WC formula.

- **Workers Compensation ER2** (classification: Employer Taxes).
  The Workers Compensation element stores the amount of each employer’s secondary liability WC premium, calculated using the WC formula.

- **Workers Compensation ER3** (classification: Employer Taxes).
  The Workers Compensation element stores the amount of each employer’s tertiary liability WC premium, calculated using the WC formula.

- **Workers Compensation EE** (classification: Employee Taxes).
  The Workers Compensation EE element maintains the employee withheld balance.

- **Workers Compensation EE2** (classification: Employee Taxes).
  The Workers Compensation EE element maintains the secondary employee withheld balance.

- **The Workers Compensation Information element** (classification: Information).
  The Workers Compensation Information element’s input values Mod 1 Surcharge, Post Exp Mod 2 Surcharge and Post Prem Disc 1 Surcharge, hold the results of the three surcharges that may apply to an employee’s WC premium calculation. Its input value WCable Hours Pay holds the employee’s payroll exposure.

- **The Workers Compensation (WC) formula.**

You can review these elements and formula at any time using the Element window and the Formula window.

The Workers Compensation elements receive links to all payrolls during the installation of Oracle Payroll. For WC reporting, you can retrieve information from the WC elements and report on it in the ways that best suit your enterprise.

**Attention:** You must create links to all payrolls or the payrolls cannot be run.
User Additions and Modifications

Oracle Payroll’s various WC elements and WC formula may be sufficient for your enterprise. However, you may require additional elements, and new formulas or formula modifications, if your enterprise has:

- multiple GREs in different states, with different carriers
- employees working in a state with unique rules governing the makeup of employees’ payroll exposure, or with its own non–standard modifiers for the WC premium calculation.

To develop additional WC elements and formulas, you can borrow features of those already in the system.

The WC Premium Calculation

The WC calculation included in Oracle Payroll does the following:

- Determines the employee’s SUI state and his or her assignment location.
- Locates the WC code. (Uses the code for the employee’s job, unless it finds an entry of an override code.)
- Finds the employee’s payroll exposure and applies the executive maximum if one is entered and applied.
- Determines the WC rate, using the employee’s GRE, SUI state, work location if relevant, and the WC code.
- Calculates the employee and employer liabilities based on the calculation method(s) specified.
- Applies the Experience Modification.
- Applies the first surcharge if one exists; adds it to running total if surcharge entry is marked for accumulation.
- Applies the second surcharge if one exists; adds it to running total if surcharge entry is marked for accumulation.
- Applies the Premium Discount if one exists.
- Applies the third surcharge if one exists; adds it to running total if surcharge entry is marked for accumulation.
- Calculates total WC payable for this employee. Total WC payable = running total + any surcharges not accumulated.

Calculating Employer and Employee Contributions

Oracle Payroll supports both employee and employer contributions to Worker’s Compensation Insurance.
Calculation Methods control the navigation and titles on the lower portion of the screen. Percent of Subject Earnings is the default calculation method if none is chosen. Order of precedence for calculation methods is:

1. If none is specified, the percent of Subject Earnings is default.
2. Employee and Employer portion one: Use calculation method one. If none is specified the method is defaulted to percent of subject earnings.
3. Employee and Employer portion two: Use calculation method two. If none is specified, use the same as calculation method one.
4. Employee and Employer tertiary portion: Use calculation method three. If none is specified, use the same as calculation method two.

The details of each calculation method are:

- **Percent of Subject Earnings**:
  The employer and employee rates are in percent, where 10.0000 is calculated as 10%. If the Employer/Employee Rate fields are left blank they are assumed to be zero. The Period field is not applicable.

- **Hourly Rate**:
  The employer and employee rates are in units of dollars per hour, where 10.0000 = $10/Hour. The hours used to calculate the amount deducted are the regular hours worked. Overtime can be included in the calculation. The Period field is not applicable.

- **Flat Amount Per Period**:
  The titles on the Employer/Employee rate fields switch to amount, and the amounts are in units of dollars per specified period, where 10.0000 = $10/Period.

  For this calculation method a period must be specified. The valid choices for Period are Year, Month, and Quarter. The amount specified will be deducted at the beginning of the period.

  **Example**: If $10 per year is specified, then $10 will be deducted from the next pay period and then again in the first pay period of the following year.

**Employer Rates/Employee Rates** are fields where you can associate the state’s WC codes with a carrier’s default rates or amounts for a given state. If the carrier applies special rates to one or more work locations within the state, enter these rates by carrier and location.

**Period** is the period of time used in the Flat Amount Per Period calculation method.
Surcharges, experience and liability modifications, and premium discounts are supported for all methods. Surcharges only apply to the employer portion, and not the employee’s portion.
Setup Steps for Workers Compensation Calculations

To set up WC data for a state in which GREs are located:

1. Set up each of your WC insurance carriers in the state as an external organization with the classification Workers Compensation Carrier. For a monopolistic state, there is only one carrier.
   See: Creating an Organization: page 2 – 20

2. For each carrier in the state, associate the state work classification codes with the carrier’s default rates, and any special rates applicable at particular locations.
   See: Associating WC Codes with Rates: page 20 –13

3. For each GRE in the state, identify the WC carrier and enter the Experience Modification rate. If applicable, also enter the Employer’s Liability and Premium Discount rates.
   Enter all rates as positive numbers, never as negative numbers. For example, enter an Employer’s Liability surcharge of 20% as 120 (120% of the base premium). Enter a 10% Premium Discount as 90 (90% of the premium total).

   Note: The Employer’s Liability rate always increases the premium amount; the Premium Discount rate always decreases it. The Experience Modification rate can either increase or decrease the premium. To enter it correctly, check what it is intended to do for this GRE.

   See: Entering Federal, State, and Local Tax Rules for GREs: page 18 –9

4. Define calculation methods, rates for each job code, and period if applicable.
   See Calculating Employer and Employee Contributions: page 20 –9

5. Ensure that you have set up each work location in the state for which a WC carrier uses rates other than its default rates.
   See: Setting Up Site Locations: page 2 –2

6. Associate your jobs with the state work classification codes. At this time, also enter:
   • the Executive Weekly Maximum if one exists for this state
   • the state’s rules regarding inclusion of overtime earnings and overtime hours in the payroll exposure
   • any standard surcharges in use in this state.
If you are using Oracle Payroll to calculate WC liability, for each state in which you are liable for WC payments, check the categories in the classifications Supplemental Earnings and Imputed Earnings that represent earnings included in employees’ payroll exposure.

Exempting Employees from Workers Compensation

To exempt employees from workers compensation withholding at the assignment level:

1. Enter the employee tax information form.
2. Check the WC Exempt check box in the state area.
   This exempts the assignment in the state currently displayed in the state area.

   Note: The workers compensation state is the same as the SUI state; changing the workers compensation state changes the SUI state.

Associating WC Codes with Rates

For a given state and each Workers Compensation insurance carrier you use in the state, associate the state’s WC codes with a carrier’s default rates. The default rates are those that apply when no location is specified. If the carrier applies special rates to one or more work locations within the state, enter these rates by carrier and location.

To associate codes with rates, use the WC Codes and Rates window.

Prerequisites

- All your WC carriers in this state must be set up as external organizations with the classification Workers Compensation Carrier.
  See: Creating an Organization: page 2 – 20
- If there are carriers whose rates differ for particular work locations, those locations must be entered in the system.
  See: Setting Up Site Locations: page 2 – 2
To enter WC work classification codes and rates:

1. Query the state and carrier for which you are entering codes and rates. To enter rates for a particular location, also query the location. If you leave the Location field blank, the rates you enter are the default rates for this carrier and state.

2. Enter each code and its associated rate in the Code and Rate fields. When finished, save your work.

Entering WC Codes, Payroll Exposure Rules and Surcharges

Make these entries for a state using the Workers Compensation window.

Prerequisite

- Complete the entry of WC codes and rates for the carrier or carriers in the state.

See: Entering WC Codes and Rates: page 20–13

To enter WC codes, payroll exposure rules and surcharges:

1. Query the state in the Name window.
2. If an Executive Weekly Maximum exists for this state, enter it.
3. In the Codes for Jobs region, select your jobs and their codes.
4. In the Calculation Region, select this state’s rules for the inclusion of overtime earnings in employees’ payroll exposure. To include earnings for overtime paid at premium rates check the Premium Time box, and to include overtime paid at straight time rates, check the Straight Time box.

If your enterprise uses terms other than Premium Time and Straight Time to designate types of overtime pay, you can change to your terms using the QuickCode window. The QuickCode type is US_WC_OVERTIME_CATEGORY.

5. In the Surcharges region, enter any standard surcharges this state applies to the WC calculation. For each surcharge:
   • enter its name, which must be unique for the state
   • select its formula position, that is, the point at which it applies to the WC premium calculation. Three possible selections exist:
     - After Experience Modification – Charge 1 (applied immediately after the Experience Modification Rate)
     - After Experience Modification – Charge 2 (applied immediately after Charge 1. This selection is available only after entry of a surcharge with the formula position After Experience Modification – Charge 1).
     - After Premium Discount – Charge 1 (applied immediately after the Premium Discount Rate).
   • enter the rate for the surcharge as a positive number for a rebate, or a negative number for an additional charge. For example, enter –10 to apply a rebate of 10% to the premium, or 10 to apply an additional charge of 10%.
   • In the Accumulate field, select Yes or No. Select Yes for the rebate or additional charge to be calculated and immediately applied to the running total of the premium. Select No for the rebate or additional charge to be calculated, held separately and only added to the premium calculation when it is complete.

6. Save your work.

Entering a WC Override Code

You may be required to enter a WC code for an employee that overrides the default code associated with his or her job. This situation
can arise when, for example, workers in a relatively high-risk job classification begin work at a job site, and the risk of injury for any worker at the site is judged to increase.

Enter WC code overrides in the window GREs and Other Data.

**Prerequisites**

- The employee’s assignment must include a work location and a job with a WC code.
  
  See:
  
  Entering a New Assignment: page 9 – 9
  
  Entering WC Job Codes, Payroll Exposure Rules and Surcharges: page 20 –14

- The employee’s assignment must have a SUI state and a GRE on record. There must be a WC insurance carrier entered for the GRE. An association of the WC codes for the SUI state with the default rates of the GRE’s WC carrier must be in place.

  See:
  
  Tax Information for an Employee Assignment: page 18 –13
  
  GREs and Other Data Region: page 9 – 10
  
  Entering Federal, State, and Local Tax Rules for GREs: page 18 –9
  
  Associating WC Codes with Rates: page 20 –13

---

**To enter a WC override code:**

- In the WC Override Code field, select the override code.
**Note:** If no list of codes is available, check that all the prerequisites for override code selection are in place.
Default Workers Compensation Code Mapping

Many states have only one Workers Compensation rate, and for employers in those states with a large amount of job codes, this leads to excessive manual data entry in the Workers Compensation Codes screen. Oracle Payroll allows you to run a process to map all of the available jobs to a single Workers Compensation code.

Use the Default Workers Compensation Code Mapping when you have employees in a state with only one workers compensation code, or very few workers compensation codes. You can manually change those employees who are not part of the default.

Creating Default Workers Compensation Code Mapping

Oracle Payroll assumes that no jobs are currently mapped to any codes for the state of interest; this prevents the accidental overriding of previously entered job codes.

Attention: This is an implementation-level task. If you have already implemented your system for all the states in which you have employees, do not run this process. If you do decide to run this process, you will need to remove this information from the system first, then run the process.

The system also requires you to enter a code with its corresponding rate into the Workers Compensation Rates screen prior to running the process; this maintains the same validation as the corresponding form.

You request a default workers compensation code mapping from the Submit Requests screen.

To create a default worker's compensation code mapping:

1. Select Set default workers compensation job code from the list in the Name field.
2. Select the appropriate state in the State field.
3. Select the appropriate code number in the Workers Compensation Job Code field.
4. Select OK, then select Submit.
You must be able to quickly and accurately process pay for an entire payroll, or for individual employees.

When a payroll run finishes, you:

- review the results
- initiate post-run processing
- obtain reports on pay processes.

This chapter explains how you manage the payroll run and post–run processes in Oracle Payroll. The following chapter discusses the methods for making corrections, adjustments, and retroactive changes to run results.
Pay Processing for Payrolls and Individuals

As well as the standard processing of entire payrolls that typically occurs overnight, Oracle Payroll allows you to initiate at any time, a QuickPay run for one employee only. QuickPay runs process pay for individual employees within a few minutes. They are especially convenient for processing corrections, or final pay for a terminating employee. They are also useful for payroll testing.

Overnight payroll runs and QuickPay runs both do the following processing:

- build gross earnings balances
- calculate pretax deductions.
- calculate deductions for tax withholding
- calculate amounts of involuntary and voluntary deductions
- calculate net pay by subtracting pretax, tax, involuntary and voluntary deductions from gross earnings.

Negative and Zero Net Pay

Both standard and QuickPay processing give the processing of an employee assignment a status of Error if it would produce negative pay for the employee.

Production of zero net pay can occur in both types of run. In this case, the processes for payment by paycheck or direct deposit produce a statement of earnings for the employee showing zero net pay, but do not produce paychecks or NACHA tape entries for the employee.

Standard and QuickPay runs all are either Regular or Supplemental runs.

Regular and Supplemental Runs

Regular payroll runs process employees’ regular earnings together with their usual deductions. Regular earnings are earnings for time worked, such as salary, wages and overtime. In each payroll period, you normally do a Regular run once only for each employee.

By contrast, you initiate Supplemental payroll runs as often as needed in a pay period to process final pay for terminating employees, and supplemental earnings such as bonuses, sales commissions, awards, sick pay, educational assistance and the like.
Regular Run Processing and Tax Withholding

The Regular run of a payroll is structured to process for each employee:

- all recurring earnings and deductions not yet processed in the period
- all nonrecurring earnings and deductions with unprocessed entries for the period

The default income tax withholding method for Regular runs is regular withholding (Percentage or Annualized Wages withholding). When Regular runs process supplemental earnings, by default they use regular withholding. However for supplemental earnings marked as Tax Separately, they use supplemental withholding.

See: Supplemental Withholding in Regular Runs: page 15–20

Supplemental Run Processing and Tax Withholding

Supplemental runs of a payroll are structured to process:

- all nonrecurring earnings and deductions with unprocessed entries for the period
- unprocessed recurring earnings and deductions for employees at a status of Terminated, for whom final pay has not yet been processed.

The default withholding method for Supplemental runs is supplemental withholding. However these runs apply regular withholding to any regular earnings types included in final payments.

Regular and Supplemental runs both use cumulative withholding for federal tax calculations when processing regular earnings and commissions for any employees who qualify for and request this withholding method.

Assignment and Element Sets for Payroll Processing

Payroll processing usually includes all employees with an assignment to the payroll whose status allows processing. However, if for any reason you want to process only certain subsets of these employees, you can put them in assignment sets and specify processing for a particular set only.

You either explicitly select or deselect the assignments included in an assignment set, or specify criteria for set membership for which the
system generates a formula to determine the makeup of the set. Assignment sets can be saved for reuse.

As well as assignment sets, if circumstances warrant you can define particular sets of elements, called run sets, that include only certain earnings or deductions elements for processing. You can use element sets in both standard and QuickPay runs.

See Also

Creating an Assignment Set: page 23 – 14
Defining an Element or Distribution Set: page 27 – 5

Changes to Earnings or Deductions Before a Run

Sometimes you must make a one–time change to a recurring earnings or deduction before a run: to:

- to replace its normally calculated amount with another number, or
- to provide a number to add to or subtract from the calculated amount.

Similarly, for a deduction you may need to change an arrears balance amount.

To make these changes possible, Oracle Payroll includes a second, special inputs element for all predefined and user–initiated earnings, payments and deductions elements. This nonrecurring element is specially designed to receive entries from the PayMIX batch entry facility, but can also receive manual entries.

Special inputs elements take the name of their original, with the words Special Inputs added (for example, Quarterly Bonus Special Inputs). They function as extensions to the original element. You may sometimes see special inputs elements when performing queries, but often are unaware of their presence.

The Special Inputs Replacement Amount and Additional Amount

Special inputs elements all have the input values Replacement Amount and Additional Amount. An amount entered in the Replacement Amount input value becomes the run result the next time the payroll run processes the element.
When an amount is entered in the input value Additional Amount, the next run to process the element calculates a result according to its amount rule. It then adds in the Additional Amount entry, to produce the element’s result for this run only. A positive entry increases the element’s result, while a negative entry decreases it.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement Amount</td>
<td>Provides earnings, payment, or deduction amount for the run. Overrides calculated result.</td>
</tr>
<tr>
<td>Additional Amount</td>
<td>For the run, adds to the amount calculated by the earnings, payment or deduction formula. Can be positive or negative.</td>
</tr>
</tbody>
</table>

Table 21–1 Special Inputs Elements for Earnings, Payments or Deductions

The Special Input Adjust Arrears

Special inputs elements for deductions with arrearage include not only the input values Replacement Amount and Additional Amount, but also the input value Adjust Arrears. When you enter an amount in this input value, the amount becomes the arrears balance for the deduction when the payroll run next starts to process the deduction.

<table>
<thead>
<tr>
<th>Input Value Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Arrears</td>
<td>Becomes the arrears balance for the deduction when it is next processed.</td>
</tr>
</tbody>
</table>

Table 21–2 Special Inputs Elements for Deductions with Arrears

See Also

Entering One-Time Changes Before a Run: page 21–12

Post–Run Processes

When pay processing finishes, additional processes produce payroll payments and costing information. These post–run processes are:

- **Pre-Payments.** Distributes employees’ net pay in accordance with their choice of available payment methods, using banking information they provide.
• **NACHA.** Produces the file to load to tape for direct deposit payments.

• **Deposit Advice.** Prints deposit advices and statements of earnings for employees receiving payments through NACHA.

• **Check Writer.** Prints paychecks and statements of earnings. Permits you to determine check numbers and test printer alignment.

When implementing Oracle Payroll you can set up as many check formats as you need. You can also establish the ordering of check output (for example, by last name within department within location), if the default ordering is not suitable.

• **Costing and Transfer to GL.** The Costing process accumulates the results of payroll processing by cost center, GL account code, and labor distribution account codes, utilizing information entered in the Cost Allocation key flexfield. The Transfer to GL process facilitates the transfer of Costing process results to Oracle General Ledger.

**See Also**

Running the Pre–Payments Process: page 21–15  
Running Pre–Payments Processing for QuickPay: page 21–22  
Running the Payments Processes: page 21–16  
Accumulation and Transfer of Payroll Costs: page 11–17  
Running the Costing Processes: page 11–22
Run Preparation, Execution, and Review

You can initiate standard payroll processing for a *consolidation set* including several payrolls or just one, or start QuickPay processing for one employee to finish while you wait.

Before a run, you may need to enter one-time changes to affect this run only. If you are using currencies other than your Business Group base currency, you must enter current exchange rates.

When payroll runs finish, you review the results online, and make changes and corrections as necessary. You then start up post-run processes, and obtain payroll reports.

See Also

Consolidating Payroll Information: page 21–10
Entering One-Time Changes Before a Run: page 21–12
Defining Exchange Rates: page 21–13
Running Standard Payroll Processing: page 21–9
Reviewing Pay Process Results: page 21–26
Running QuickPay Processing: page 21–19
Reviewing and Changing QuickPay Results: page 21–21
Running the Pre-Payments Process: page 21–15
Running the Payments Processes: page 21–16
Reports on Pay Processing: page 21–36

Requirements for Processing Employee Pay

To successfully process an employee in either a standard or a QuickPay run, **the employee assignment must include the following:**

- a GRE
- an organization with a location that has an address including a city and state
- a payroll
- an employment category

See: Components of the Assignment: page 9–5
Additionally, there must be on record for each assignment:

- a salary basis and an approved salary entry
  See: Setting Up Salary Administration (Oracle Human Resources User’s Guide)

- W–4 and other tax information
  See: W–4 and Other Tax Data for Employees: page 18–2

  **Note:** A prerequisite for entry of employee tax information is entry of a valid primary US or Canadian address for the employee.

  See: Entering People’s Addresses at Sites with Oracle Payroll: page 8–12
Running Standard Payroll Processing

Prerequisites

☐ Ensure that the employee assignments on the payrolls you are running include all necessary information.
  See: Requirements for Processing Employee Pay: page 21–7

☐ To process only a subset of the available employee assignments or elements, ensure that the appropriate assignment set or element set is defined.
  See: Assignment and Element Sets for Payroll Processing: page 21–3

☐ To make a one-time change to a recurring earnings or deduction before payroll processing, or to change a deduction’s arrears balance, make an entry to a special inputs input value of the earnings or deduction.
  See: Entering One-Time Changes Before a Run: page 21–12

☐ If the pay processing involves the use of currencies other than the base currency of your Business Group, enter the necessary exchange rates.
  See: Defining Exchange Rates: page 21–13

Use the Submit Request window to initiate processing for a consolidation set of payrolls.

► To initiate processing for one or more payrolls:

1. In the Name field, select Payroll Process. Click in the Parameters field if the Parameters window does not automatically appear.
2. Select the payroll or consolidation set to process. If you select a payroll, the name of its consolidation set displays.
3. Select the Date Earned and Date Paid for this run. The Date Paid is the Check Date, that is, the date of constructive receipt of pay.
4. To process a subset of the employee assignments available for processing, select the name of the assignment set including this subset of assignments. Similarly, to process a subset of the earnings, payments and deductions available for processing, select the name of the element set including this subset of elements.

See: Assignment and Element Sets for Payroll Processing: page 21–3
5. Select R for a Regular run, or S for a Supplemental run.
   See: Regular and Supplemental Runs: page 21–2

6. You can optionally enter a message to appear on the statements of earnings for this run, if your SOE is designed to include such a message.

7. Choose OK, and Submit.

8. To check on the progress of the processing, use the Concurrent Requests window. To see the results of payroll runs as well as other payroll processes, use the Payroll Processes and Assignment Processes windows.
   See: Reviewing Pay Process Results: page 21–26

See Also

Running QuickPay Processing: page 21–19

Consolidating Payroll Information

For convenience in post–run processes such as NACHA and Costing, and reporting, you group payrolls into consolidation sets. All scheduling of post–run processes involves selection of a consolidation set. Oracle Payroll produces a single NACHA tape, set of costing results, and set of reports for all the payrolls in a consolidation set.

To initiate post–run processing for only some or just one of the payrolls in a consolidation set, simply transfer these payrolls to another consolidation set (a set can include one payroll only). When you no longer have use for a consolidation set, delete it.

To initiate post–run processing for a payroll separately from that of the other payrolls in its consolidation set, you can transfer the payroll to a different consolidation set in such a way that the transfer lasts only until the next run of the payroll.

See: Temporarily Changing a Payroll’s Consolidation Set: page 21–11

Defining or Deleting a Consolidation Set

Use the Consolidation Sets window.

To define a consolidation set:

- Enter the name of the consolidation set.
To delete a consolidation set:

- Query the name of the set you are deleting. Select the record and then choose Edit, Delete Record.

Temporarily Changing a Payroll’s Consolidation Set

To temporarily transfer a payroll to another consolidation set after a run, use the Update Payroll Run window.

To temporarily change a consolidation set after a run:

1. Query the payroll whose consolidation set you want to change.
   Run information for the payroll displays in reverse order from the last completed run. The Set region displays whether the run was for a particular element set and/or assignment set. You can update consolidation set and the pay advice date and message in this window regardless of the status displayed for the payroll run.

2. Select the new consolidation set in the Consolidation field.
   **Note:** The payroll’s usual consolidation set takes effect with the next payroll run.

3. Optionally, update the pay advice (statement of earnings) date and message.
Entering One-Time Changes Before a Run

Before a run you can enter an amount to replace the run result of a recurring earnings or deduction, or a positive or negative amount to add to or subtract from the run result. For a deduction, you can change the arrears balance. These types of changes go to the special inputs element of an earnings or deduction.

See: Changes to Earnings or Deductions Before a Run: page 21–4

One-Time Changes Using PayMIX

To make batch entries to a special inputs input value:

For an earnings or non-payroll payment, use the PayMIX Earnings Entry window. For a deduction, use the PayMIX Deductions Entry window.

- In the field Earnings Name or Deduction Name, query the name of the base element, not the special inputs element (for example, query Quarterly Bonus, not Quarterly Bonus Special Inputs).

The PayMIX facility automatically routes entries for a special inputs input value to the special inputs element.

See:
Making Batch Entries for Earnings Types: page 13–73
Making Batch Entries for Deductions: page 13–74

Manual Entry of One-Time Changes

To make a default entry to a special inputs input value:

Use the Element Link window.

1. Query the Special Inputs element to make the entry. For example, query Regular Salary Special Inputs, not Regular Salary. Choose Input Values to go to the Input Values window.
2. In the Default field, make an entry to the Replacement Amount, Additional Amount, or Adjust Arrears input value of the special inputs element.
3. Save your work.

To make a manual entry to a special inputs input value:

Start from the Assignment window to go to the Element Entries window.
1. In the Assignment window, query the employee assignment for which you are making the manual entry. Choose Entries to go to the Element Entries window.

2. In the Element Name field, select the appropriate Special Inputs element (for example, select Regular Wages Special Inputs, not Regular Wages). Choose Entry Values.

3. Make an entry to the Replacement Amount, Additional Amount, or Adjust Arrears input value of the special inputs element.

4. Save your work.

---

**Defining Exchange Rates**

For payroll processing that involves the use of currencies different from the Business Group base currency, define exchange rates before payroll or QuickPay runs. Enter exchange rates that are current on the day of the run whenever possible, as rates can fluctuate daily.

**Attention:** If you set up earnings types to produce payments in local currencies instead of the base currency of the Business Group, you must also define the balances required to hold amounts of the local currencies, and any formulas needed to process payments in these currencies. The system does not generate these balances and formulas.

Define and update exchange rates in the Exchange Rates window.

---

**To enter exchange rates:**

1. Set the effective date to the day for which you are defining exchange rates.
2. Query the name of the payroll for which you are defining exchange rates.

   The payroll’s processing period type displays in the next field.

3. Select the input and output currencies for which you are defining exchange rates.

4. Enter the exchange rate expressed as a decimal. This is always the value of the output currency divided by the input currency. For example, if the input value is 2.50 and the output value is 1.00, the rate is 0.4.

   **Note:** The entry block for exchange rates is multi-row. You can define as many exchange rates for each payroll as your balances and processes require.
Running the Pre–Payments Process

After the successful completion of standard payroll runs, run the Pre–Payments process to distribute employees’ pay among all the payment methods they have requested.

Successful completion of pre–payments processing is a prerequisite for running the payments processes.

Note: There is a special Pre–Payments process to use following QuickPay runs.

See: Running Pre–Payments Processing for QuickPay: page 21 –22

Run the Pre–Payments process from the Submit Request window.

To run the Pre–Payments process:

1. In the Name field, select Pre–Payments. Click in the Parameters field if the Parameters window does not open automatically.

2. Select the name of the payroll or consolidation set to run the process for. When you select a payroll name, its default consolidation set displays.

3. Enter the start and end dates of the time span for the pre–payments processing to cover.

4. Optionally, enter an override payment method to apply to this processing. For example, to make all the payments resulting from this processing by check, select in the Payment Method Override field the name of a payment method of the type Check.

5. Choose OK, and Submit.

See Also

- Defining Payment Methods for the Enterprise: page 5 – 3
- Entering Payment Methods for an Employee Assignment: page 9 – 21
Running the Payments Processes

The payments processes are:

- the Check Writer process, which produces paychecks with attached statements of earnings (SOEs)
- the NACHA process, which produces files that you load on magnetic tape and dispatch to banks for direct deposit payments
- the Deposit Advice process, which produces deposit advices with attached statements of earnings.

Note: You can review statements of earnings for employees before running the Check Writer or Deposit Advice processes. After a payroll run, you can view online the statement of earnings for each individual employee processed in the run.

See:
- Reviewing Assignment–Level Results: page 21–30
- Reviewing and Changing QuickPay Results: page 21–21

Run the Payments processes from the Submit Request window.

Note: After QuickPay runs, it may be most convenient to make manual payments, rather than running payments processes.

See: Making a Manual Payment: page 21–24

To run the Check Writer process:

1. Select Check Writer in the Name field.
2. Select the payroll or consolidation set of the pay processing for which to produce checks and SOEs. If you select a payroll, its default consolidation set displays.
3. Enter the start and end dates of the time period for which to print the checks and statements of earnings.
4. Optionally, select a payment method with the type Check to use for all the payments resulting from this process run.
5. Select the check style Payroll Check, or, to make payments to third parties, the style Third Party Check.

See: Producing a Check for a Wage Attachment: page 17–12
6. A default sort sequence displays. To add more sort sequences, your MIS staff can modify the Check Writer process.
7. Enter the check number with which to start this check run.
8. Choose OK, and submit.
To run the NACHA process:

1. In the Name field, select NACHA. Click in the Parameters field if the Parameters window does not open automatically.
2. Select the name of the payroll or consolidation set to run the process for. When you select a payroll name, its default consolidation set displays.
3. Enter the start and end dates of the time span for the processing to cover.
4. Optionally, select the name of a payment method of type NACHA to use for all the payments resulting from this process run.
5. Optionally, enter an override deposit date to use for all the payments resulting from this process run.
6. Choose OK, and Submit.

The process creates a flat file in the PAY_TOP/out directory. The file’s name starts with the letter p, followed by a 5-digit number that identifies the concurrent request number of the NACHA process, with the extension .mf. For numbers with fewer than 5 digits, the system supplies leading zeros. For example, for a concurrent request number 134, the file name becomes p00134.mf.

7. Loading this file onto a magnetic tape is a responsibility of your system administrator.

To run the Deposit Advice process:

1. Select Deposit Advice in the Name field.
2. Select the name of the payroll or consolidation set to run the process for. When you select a payroll name, its default consolidation set displays.
3. Enter the start and end dates of the time span for the deposit advice to cover.
4. Choose OK, and submit.

Void Payments Process

Void Payments enables you to void checks that have been printed out but need to be cancelled.

You may want to do this if there is a printing error or if the checks you print are lost or defaced. The process cancels the issue, records that there was an issue, and enables you to enter a reason for cancelling.
You run the Void Payments process from the Submit Request window.

To run the Void Payments process:

1. In the Name field, select Void Payments.
2. In the Parameters window, select the payment run for Check Writer that you want to void.
3. Enter the date on which you want to void the check or checks. The default is your system date.
4. Enter, optionally, a reason for voiding the check issue.
5. Enter the start and end numbers of the checks you are voiding. You can void single checks by entering the check number in both fields.
Running QuickPay Processing

You can conveniently run full payroll processing and certain post-run processes for an individual employee in just a few minutes, using the QuickPay processing facility.

Following a QuickPay process you review the results, and if necessary roll back or retry the processing, from the QuickPay window. You can also run the Pre-Payments process from this window, and record information about an immediate manual payment made to the employee.

Prerequisites

- If the pay processing involves the use of currencies other than the base currency of your Business Group, enter the necessary exchange rates.
  
  See: Defining Exchange Rates: page 21–13

- To make a change to a recurring earnings or deduction or to a deduction’s arrears balance before payroll processing, make an entry to a special inputs input value of the earnings or deduction.

  See: Entering One-Time Changes before a Run: page 21–12

To initiate payroll processing for one employee assignment, use the QuickPay window.

1. Set your effective date to the correct date for the QuickPay run. This date appears in the Date Paid and Date Earned fields. The Period field displays the period in which this date falls.

To define and initiate a QuickPay run for an employee:

1. Set your effective date to the correct date for the QuickPay run. This date appears in the Date Paid and Date Earned fields. The Period field displays the period in which this date falls.
You can update the Date Paid, which is the Check Date, or date of constructive receipt of pay, to another date in this period.

**Note:** If you select an effective date for which there is no valid payroll period, all three fields remain blank. You cannot select an effective date earlier than the start date of the employee assignment.

2. If this QuickPay run is the Regular run for this employee assignment in this period, check the Regular box. Leave this box unchecked for a Supplemental run.

See: Regular and Supplemental Runs: page 21 –2

3. Enter a date for the statement of earnings, date and optionally a message, if your SOE is designed to include a message. These fields are for information only.

**Note:** The Number field remains blank and the status field remains set to Unprocessed until QuickPay processing is complete.

4. Save your work.

**Note:** You cannot process a QuickPay for someone who has an existing run process at a status of Incomplete or Error. If you receive an assignment interlock failure message when attempting to save, check and if necessary, correct the status of other payroll processing for this employee.

5. Choose the Element Selection button to check or verify element entries for the QuickPay run. All the elements for the assignment that exist as of Date Earned appear in the Element Entries window. Check or clear the Include in Run box to include an element in or exclude it from the run.

Choose the Entry Values button to view existing entries for each element. You cannot change or delete these entries, or add new ones. Close the Element Entries window.

6. In the QuickPay window, choose the Start Run button to run the QuickPay process. Use the View Requests window to check the status of the run.

When processing finishes, the Status and Number fields in the QuickPay Run block display values for the run as follows:

- **Number:** For each payroll, numbering is consecutive, starting from 1, for each QuickPay run in a payroll period. The numbering restarts from 1 for each successive period.
Troubleshooting: Concurrent Manager

Once you initiate the QuickPay process, your screen freezes until the process completes. If there is a processing problem you receive one of two error messages informing you that:

- the process has not started, or
- the process has started but has not finished

These messages appear either because the concurrent manager has not been started, or because there are other requests of a high priority. Consult your system administrator to start your request or change its priority, or to provide assistance if you receive no error message but your screen remains frozen for several minutes.

Note: Oracle Payroll does not permit deletion or update of the QuickPay definition between request initiation and completion.

Reviewing and Changing QuickPay Results

To view the results of the QuickPay run:

- Choose the View Results button.

  - Message. Opens the View Run Messages window, which displays any system messages issued during the process run for this assignment.

    See: Reviewing Messages Issued During Processing: page 21–26

  - Run Results. Opens the Run Results window, which shows the Pay Value of each element processed for the employee, together with basic information about the element. To review the entries for an element, choose the Run Result Values button to open the Result Values window.

    See: Steps 9 and 10, Viewing Assignment-Level Results: page 21–30

  - SOE Report. Opens the Employee Statement of Earnings window, which displays online, a Statement of Earnings for this employee resulting from a payroll run with a status of Complete.

    Notice that you can scroll down the lists of earnings and deductions to see all those included in this run.

  - Tax Balances. Opens the View Tax Balances window, which displays federal, state and local tax balances for this employee assignment.
See: Viewing Tax Balances: page 18–44

- **Earnings and Deductions Balances.** Opens the View Earnings and Deductions Balances window, which displays earnings and deductions balances for this individual.

  See: Reviewing Earnings and Deductions Balances: page 14–8

  **Note:** You may also have access to the Balances window. This window has no use at Oracle HRMS installations in the US.

▲ **To roll back a QuickPay run:**

- In the QuickPay Run region, query the run to roll back. Select Edit – Delete Record, and save your work.

  See: Rollbacks: page 22–3

▲ **To retry a QuickPay run:**

1. As necessary, change and save data entered for the run.
2. Choose the Retry Run button.

  See: Retries: page 22–5

---

**Running Pre–Payments Processing for QuickPay**

When QuickPay run has a status of Complete, if time permits you can include it in the next batch pre–payments processing for the assignment payroll. Otherwise, you can start pre–payments processing from the QuickPay form, if necessary overriding the default payment method.

▲ **To run pre–payments processing from the QuickPay window:**

1. Choose the Start Pre–payments button. If required, you can override the default payment method for the assignment. You have a choice Check or NACHA for pre–payments run from the QuickPay window.

   The status for the completed process displays in the Status field in the QuickPay Pre–payment block.

2. When a status of Complete displays, do one of the following:

   - Choose the External Payment button to make payment by check from the External/Manual Payments window.
   - Leave the payment to be made by a batch CheckWriter process for the consolidation set.
Note: If you have already included the QuickPay run in the default consolidation set for the assignment payroll, it can take part in the batch pre-payment process for the payroll without further action on your part.
Making a Manual Payment

You can make a manual payment to an employee, recording the amount, date and check number of the payment in Oracle Payroll. Such payments usually follow QuickPay runs.

To record information about a manual payment, use the External/Manual Payments window.

Prerequisite

- Run the pre-payments process either from the QuickPay or the Submit Request window.

See:

- Running the Pre-Payments Process: page 21–15
- Running Pre-Payments Processing for QuickPay: page 21–22

To make a manual payment to an employee:

1. Run a query in the Payment Method field to see a list of unpaid payments for this employee assignment.

   The window displays the type (Pre-payments or QuickPay) and date of the pre-payment processing for each payment.

   **Note:** If you enter the External/Manual Payments window from the QuickPay window, the query shown unpaid payments for the current QuickPay pre-payments processing only. The Date and Type fields do not display, because the type is always QuickPay and the date is the same as that of the QuickPay run.

2. Check the Pay box for the payments you are making manually.

   Enter the check number, and the payment amount in the Value field.
3. Save your work.
Reviewing Pay Process Results

Following process runs, you can:

- see all messages issued during the processing, relating either to the process as a whole or to the processing of a particular assignment
- review online, results of pay processes at both the process level and individual employee assignment level.

See Also

Correction of Process Results: page 22-2

Reviewing Messages Issued During Processing

To see these messages, use the View Run Messages window.

To see messages issued from a payroll process:

1. In the Payroll Processes window, select the payroll and period for which you are reviewing process messages.
2. Move the cursor to the record of the process whose messages you want to see. When system messages exist for a process, the status bar at the bottom of the window informs you of this.
3. Choose the Message button to open the View Run Messages window.
4. To see messages for the processing of employee assignments, select the payroll process and choose the Assignment Process button.

5. In the Assignment Processes window, place the cursor on each record in turn, or on a particular record for which you want to see messages. If messages exist for an assignment, the status bar informs you of this.

6. Choose the Message button to open the View Run Messages window.

**Reviewing Process–Level Results**

To review process results at the process level, use the Payroll Processes window.

► **To view the results of pay processes:**

1. Select the name of the payroll whose processing you are reviewing, and the range of periods over which this processing occurred.

   If you leave the Period To field blank, you see processing that occurred in the period selected in the Period From field. If you run the query without selecting any payrolls or periods, the window displays all payroll process results for all payrolls in the Business Group.

2. Choose Find.

   The window displays information about all processes occurring for the payroll selected, in the period or range of periods selected.
• **Type.** This field displays the process type, as for example Run or Costing.

• **Status.** There are four process status categories: Incomplete, Complete, Error, Processing.
  
  – Incomplete: not all of the assignment actions for the payroll action are complete. (E.g., at least one assignment action is in error, marked for retry, or unprocessed.)
  
  – Complete: all assignment actions for this payroll action are successfully processed (i.e., they all have an assignment action status of “complete.”)
  
  – Error: the payroll action itself has erred, since it has encountered a number of consecutive errors in processing assignment actions which most likely are caused by a system wide problem (e.g., the database is being shut down, a table/index is full, or some incorrect or concurrent manager has a problem).
  
  – Processing: the payroll action is currently processing.

• **Name.** The name appearing in this field depends on the process type, as this table shows:

<table>
<thead>
<tr>
<th>Process Type</th>
<th>Name Appearing for Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Run Number, Employee Set, Element Set</td>
</tr>
<tr>
<td>Costing</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>Pre–payments</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>Magnetic Transfer</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>Transfer to General Ledger</td>
<td>Consolidation Set</td>
</tr>
<tr>
<td>QuickPay Pre–payments</td>
<td>Run Number, Employee Name</td>
</tr>
<tr>
<td>Purge</td>
<td>None</td>
</tr>
<tr>
<td>Non–Tracked Process</td>
<td>None</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Run Number, Employee Name</td>
</tr>
<tr>
<td>External Manual Payment</td>
<td>Employee Name</td>
</tr>
<tr>
<td>Reversal</td>
<td>Employee Name</td>
</tr>
<tr>
<td>Balance Adjustment</td>
<td>Employee Name, Element Type</td>
</tr>
</tbody>
</table>

Table 21 – 3

To see further information about a payroll process, select its record and choose from the action buttons at the bottom of the window. Buttons
that are not valid for the process type of the selected record are greyed out to show they are unavailable.

To view further information about a payroll process:

1. To view results for the individual assignments included in the particular payroll process selected in the Payroll Processes window, choose the Assignment Process button. This opens the Assignment Processes window.

   This window displays for assignments included in the selected payroll process, the same assignment processing information available in the Employee Assignment Processes window.

   See: Reviewing Assignment–Level Results: page 21–30

2. To view system messages issued during the payroll process, choose the Message button to open the View Run Messages window.

   See: Reviewing Messages Issued During Processing: page 21–26

3. To review a summary of processing status information for the assignments included in the payroll process, choose the Process Information button to open the Assignment Process Information window.

   This window displays for the payroll process, the number of assignments that are complete, that are in error, that are unprocessed, and that are marked for retry.

4. To review summary results from a run of the Costing process, choose the Costing Breakdown button to open the Costing Breakdown window.
5. To review the status, request diagnostics and other information for the payroll process, choose the **Concurrent Manager** button to open the Requests window.

### Reviewing Assignment–Level Results

To review process results for an employee assignment, use the **Employee Assignment Processes** window accessed from the Navigator.
To view process results for an employee assignment:

1. Select the name or assignment number of the employee. The employee’s payroll displays automatically. If the employee has an assignment to more than one payroll, select one from the list.

2. Select the range of periods for which to review process results. If you leave the Period To field blank, you see processing that occurred only in the period selected in the Period From field.

3. Choose Find. The window displays all the employee’s assignment processes for the payroll and periods selected.
   - **Type.** Names the type of the process selected.
   - **Number.** The assignment process ID.
   - **Applied To.** For reversals, external/manual payments and pre-payments, this field displays the payroll process ID of the parent process.
   - **Status.** There are four process statuses: Incomplete, Complete, Error, Processing.

To see further information about an assignment process, select the record and choose from the buttons at the bottom of the window. Buttons that are not valid for process type of the selected record are greyed out to show they are unavailable.
To view further assignment processing information:

1. To view any system messages issued during the process run for this assignment, choose the **Message** button to open the View Run Messages window.
   
   See: Reviewing Messages Issued During Processing: page 21 –26

2. To view online the Statement of Earnings resulting from a completed payroll run for this employee, choose the **SOE Report** button.

   Notice that you can scroll down the lists of earnings and deductions to see all those included in this run.

3. To see balances for the employee resulting from the selected process, choose the **Balances** button.
   
   - Select Tax Balances to open the View Tax Balances window, which displays federal, state and local tax balances for this employee assignment.
     
     See: Viewing Tax Balances: page 18 –44
   
   - Select Employee Balances to open the Earnings and Deductions Balances window, which displays earnings and deductions balances for this individual.
     
     See: Reviewing Earnings and Deductions Balances: page 14 –8

4. To view the results of a balance adjustment process, choose the **Balance Adjustment** button to open the Balances window.

   See: Adjustments to Balances: page 22 –10
5. To view information about payments made by check or direct deposit (using the Check Writer or NACHA magnetic tape process), choose the **Payment** button to open the Payments window.

See: Running the Payments Processes: page 21–16

6. To view complete results of the Costing process for this employee assignment, choose the **Costing** button.

See: Reviewing Costing Process Results: page 11–22

7. To view the Pay Value for each element that the payroll run has produces for this employee, together with basic information about the element, choose the **Run Results** button to open the Run Results window.
8. To review the entries made for an element for this employee, select the element in the Run Results window and choose the Run Result Values button to open the Result Values window.

9. To view the breakdown of pay resulting from the Pre–Payments process, choose the Payment Methods button to open the Payment Methods window. This window shows for the employee assignment, the payment amount and status for each payment method on record for the assignment, together with other payment information.

   See: Entering Payment Methods for an Employee Assignment: page 9 – 21

See Also

Correction of Run Results: page 22 –2

Viewing Employee Run Result History

In this window you can view, for a single employee, a history of run results by element.

   ► To view a history of run results for an employee:

      1. Select the name or the assignment number of the employee and the name of the element for which you want to review run results.
2. Select the range of payroll periods over which to display the information.

3. Choose Find.

   The window displays information on each completed run for the criteria you have selected.
   
   - Run – This is the run type (Payroll or QuickPay).
   - Number – This is the assignment action id corresponding to the run.

4. Select an entry and choose the Entry Values button to view entry value details.
Reports on Pay Processing

Reports on aspects of pay processing include the following:

- Payments Register: page 21–36
- Voided Payments Report: page 21–37
- Third Party Payments Register: page 21–37
- Gross to Net Summary: page 21–38
- Earnings Audit: page 21–38
- Employee Deductions Taken: page 21–39
- Employee Deductions Not Taken: page 21–39
- NACHA Report: page 21–40
- Costing Breakdown Summary reports: page 11–22
- Tax reports: page 19–2

Note: To obtain paychecks, deposit advices, and statements of earnings, you run the payments processes Check Writer or Deposit Advice.

See: Running the Payments Processes: page 21–16

Payments Register, Summary and Detail

The Payments Register Detail report shows for each employee, the assignment number, payment type, deposit advice or check number, payment amount, and bank name, account number and account type. The Payments Register Summary report shows total amounts paid for a payment type by GRE.

Note: These reports do not include payments made to third parties. These payments are listed on another register.

See: Third Party Payments Register: page 21–37

Run these reports from the Submit Request window.

To run the Payment Register reports:

1. Select Payments Register Report or Payments Register Summary Report in the Name field. If the parameters window does not open automatically, click in the Parameters field to open it.

2. Select a consolidation set whose run results the report should cover, or a payroll run for the report to cover. If you select a payroll run, its consolidation set may display.
3. Optionally, select a GRE. If you make no selection, the report covers all GREs.
4. Optionally, select a payment type. If you make no selection, the report covers all payment types.

**Voided Payments Report**

This report shows details of voided payments. Currently, the report shows details of cancelled check payments only.

You run this report in the Submit Request window.

To run the Void Payments report:
1. In the Name field, select Void Payments Report
2. In the Parameters window, enter a start date and an end date for the report.
3. Select a payroll and/or consolidation set and/or GRE if you want to restrict your information by these parameters. If you leave these fields blank the report will return information on all payrolls for the period chosen.
4. Choose the Submit button.

**Third Party Payment Register**

The Third Party Payment Register report shows for each third party payment processed in a run, the payment amount and the name of the employee making the payment. Additionally it shows the payee name, payment reference number and type (check or direct deposit), and
check or deposit advice number. For direct deposit payments, it also lists the bank name and account number and type.

**Note:** Third party payments by direct deposit will be implemented in a later version of Oracle Payroll.

Run this report from the Submit Request window.

**To run the Third Party Payment Register report:**

1. Select Third Party Payment Register Report in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. Select a consolidation set whose run results the report should cover, or a payroll run for the report to cover. If you select a payroll run, its consolidation set may display.
3. Optionally, select a GRE. If you make no selection, the report covers all GREs.
4. Optionally, select a payment type. If you make no selection, the report covers all payment types.

---

**Gross to Net Summary**

For a payroll run or a consolidation set, this report shows totals for the calculation results of each earnings, deduction, and other elements of pay. It groups totals by element classification, thereby showing a gross to net view of the runs covered. It can display subtotals for GREs.

Run this report from the Submit Request window.

**To run this report:**

1. Select Gross to Net Summary (US) in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. Select the payroll or consolidation set for the report to cover.
3. Select the period for the report to cover.
4. Optionally, select a GRE. If you make no selection, the report covers all GREs.

---

**Earnings Audit**

This report is used for verification of individual earnings calculations. For a payroll run or run set, it lists all employees processed. For each employee, it lists:
The Payroll Run and Other Payroll Processes

• all earnings processed, and the results for each
• the check or direct deposit number of each payment.

Run this report from the Submit Request window.

To run this report:
1. Select Earnings Audit Report in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. Select one of the following to determine the coverage of the report:
   • consolidation set
   • payroll and time period
   • payroll run.
3. Optionally, select a GRE. If you make no selection, the report covers all GREs.
4. Select the earnings type to report on.

Employee Deductions Taken and Taken Summary

For each employee, this report lists deductions taken in a period together with a year to date balance for each deduction. The summary version of the report presents totals only.

Run these reports from the Submit Request window.

To run these reports:
1. Select either Deductions Taken Report or Deductions Taken Summary Report in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. Select one of the following to determine the coverage of the report:
   • consolidation set
   • payroll and time period
3. Optionally, select a GRE. If you make no selection, the report covers all GREs.
4. Select the deduction to report on.

Employee Deductions Not Taken and Not Taken Summary

This report lists by deduction element for each employee, any deduction scheduled for processing in a period not taken in full. For
each deduction, it also lists any amount placed in arrearage in the period, and the total arrearage to date. The summary version of the report presents totals of amounts not taken.

Run these reports from the Submit Request window.

▶ **To run the Deductions Not Taken reports:**

1. Select either Deductions Not Taken Report or Deductions Not Taken Summary in the Name field. If the Parameters window does not open automatically, click in the Parameters field.

2. Select one of the following to determine the coverage of the report:
   - consolidation set
   - payroll and time period

3. Optionally, select a GRE. If you make no selection, the report covers all GREs.

4. Select the deduction to report on.

---

**NACHA Report**

For each government reporting entity, this report prints employee name, number and payment amount for employees receiving pay by direct deposit. It includes record counts and subtotals for each GRE.

Run this report from the Submit Request window.

▶ **To run this report:**

1. Select NACHA Report in the Name field. If the Parameters window does not open automatically, click in the Parameters field.

2. Select the payroll action for the report to cover.

---

**Costing Breakdown Summary Report**

See: Reviewing Costing Process Results: page 11 – 22

---

**Tax Reports**

See: Tax Reporting: page 19 – 2
After running payrolls and post-run processes and reviewing the results, you must be able to make corrections, adjustments, and changes. This chapter discusses the management of these activities in Oracle Payroll.
Correction of Run Results

When the payroll run or other payroll processes require corrections or adjustments, you can:

- roll back, retry, or reverse the run for individual employee assignments
- roll back or retry the processing for particular groups of employees, or for everyone processed
- make direct adjustments to individual employees’ earnings or deductions balances.

Retroactive Pay

A special type of correction to payroll run results occurs when you must process earnings types or deductions retroactively for employees, not to correct errors in the original input or processing, but because of changes made retroactively to the original inputs.

In these circumstances you make use of Oracle Payroll’s special functionality for retroactive pay processing.

See: Retroactive Pay Processing: page 22–12
Rollbacks

Rollbacks are useful for eliminating all records of processing that should never have occurred, or that occurred only for testing purposes. A rollback completely removes an employee from a run, or completely obliterates an entire run, leaving no record that the processing ever happened.

To preserve data integrity, Oracle Payroll does not permit you to roll back payroll processing for individuals or payrolls for which post-run processing has occurred.

Uses of Rollbacks

Suppose that just after a payroll run, you receive notification that three employees have been transferred to a different payroll. This means the run just completed should not have processed them. In this case you can roll back the processing for the three individuals. If the entire set of employees a run processes is the wrong set, you can roll back the entire run.

Rollbacks are also useful when you are doing runs for testing purposes. You can examine run results and then remove all traces of them.

Rolling Back a Process

Payroll Process Rollback

Use the Payroll Processes window to roll back a process for a few individuals. Roll back processes for many employees from the Submit Request window. To roll back a subset of employee assignments included in a process, place them in an assignment set.

See: Assignment and Element Sets for Payroll Processing: page 21–3

- **To roll back a process (Payroll Processes window):**
  - In this window, select the process record. Select Edit – Delete Record, and save your work.

- **To roll back a process (Submit Request window):**
  1. In the Name field, select Rollback to roll back all processes except a payroll run, or Rollback Run to roll back a payroll run. If the Parameters box does not appear, click in the Parameters field.
2. Select the process to roll back. The list for Rollback displays processing dates with the corresponding process types, payrolls, and consolidation sets. The list for Rollback Run displays process run dates with the corresponding period dates and payrolls.

3. To roll back processing for an assignment set, select the set name.

4. Choose Submit.

**Individual Employee Assignment Process Rollback**

Use the Employee Assignment Processes window.

- **To roll back an assignment process:**
  - Select the record for the assignment process. Select Edit – Delete Record, and save your work.
Retries

Retries are useful for correcting mistaken input to payroll runs or other processing shortly after processing finishes. As long as there is no further processing on record, you can mark individual assignments, groups of employees, or entire processes for retry, and then reprocess them.

If you mark only some employee assignments included in a process for retry, you can start other processing for everyone else, enter the necessary corrections for those requiring them, and then retry the original process. It reprocesses only those assignments marked for retry.

For example, if you receive a few late timecards after payroll processing for a consolidation set has finished, you can mark the affected employee for retry and then initiate the Pre-Payments, Check Writer and NACHA processes for the consolidation set. These processes go ahead for everyone not marked for retry.

You then use the Element Entries window to update employees’ time entries as necessary, and retry the payroll process. It reprocesses only the employees marked for retry, utilizing the updated numbers.

Retrying Runs

You may realize after a run that results for many employees are incorrect. This could happen, for example, if you neglected to modify a formula for an earnings or deduction before starting the run.

In this case, if no post-run processing has occurred, you can make the necessary changes and retry the entire run. The new run ignores employees whose processing is unaffected by the corrections entered, reprocessing only those whose original results are mistaken in view of the corrections.

A payroll run’s status remains at Incomplete as long as any employees are marked for retry. The system keeps a record of retries for audit purposes.

Retrying a Payroll Process

If you must correct or update data input for a payroll process that has already run, you can mark either the entire process, individual employee assignments, or sets of assignments for Retry, and then retry the process. The status of a process remains at Incomplete if it has any employee assignments marked for retry.
To mark a payroll process for retry:
- In the Payroll Processes window, select the process to retry and check the Retry box. This effectively marks every employee assignment included in the process for reprocessing when you retry it.

To mark an individual employee assignment for retry:
- In the Assignment Processes window, select the assignment to retry and check the Retry box. Then when you retry the process, only these assignments are reprocessed. This is a convenient approach when only a few assignments require reprocessing.

To mark a group of employee assignments for retry:
1. Place the group of employee assignments in an assignment set. See: Assignment and Element Sets for Payroll Processing: page 21-3
2. In the Submit Request window, select Mark Payroll Run for Retry in the Name field if you are retrying a payroll run. Otherwise select Mark Process for Retry. These processes have the same parameters, Payroll Process and Assignment Set.
   - If the Parameters box does not automatically appear, click in the Parameters field.
3. Select the process you are marking for retry.
4. To reprocess an assignment set, select the set’s name.
5. Choose Submit.

To retry a payroll run or other payroll process:
1. Mark the entire process, individual employee assignments, or a group (assignment set) of assignments for retry, using one of the procedures given above.
2. In the Submit Request window, select Retry Payroll Run in the Name field to retry a run. Otherwise select Retry Payroll Process to retry another process.
   - If the Parameters box does not automatically appear, click in the Parameters field.
3. In the Payroll Process field of the Parameters box, select the process to retry.
4. Choose Submit.
Reversals

You use a reversal to correct run results after post-run processing has occurred for an employee. Reversals are usually the way to correct run results for individuals some time after the run has occurred.

When you reverse a run for someone, the system creates negative figures to cancel all the positive figures the run produced, and likewise, positive figures to cancel all the negative run results. The reversal applies to information on payroll costs as well as all other information. The original run results and the results of the reversal all remain on the database for you to review whenever necessary.

You can reverse processing for individual employee assignments only.

When you reverse run results, correct input and reprocess, all affected balances receive updates. Oracle Payroll preserves a complete audit trail of reversals.

Restarting Earnings or Deductions after Reversals

You may reverse a run for a past period during or after which a stop date exists for an earnings or deduction of the employee. When this happens, Oracle Payroll issues a warning, advising you to check whether you should restart any stopped earnings or deductions for the employee.

Reversing Payroll Processing for Employees

You can reverse standard and QuickPay runs for individual employee assignments to correct run mistakes after post-run processing has occurred. A reversal creates negative figures to cancel all positive run results, and positive figures to cancel all negative run results. Both the original results and the reversal remain in the database.

Use the Reverse Payroll Run window to reverse a run.
To reverse payroll processing for an employee assignment:

The Reverse Payroll Run window displays, listing the consolidation set, effective date and type of all the completed runs for the assignment.

1. The Reverse Payroll Run window shows the consolidation set, date, and type (Run or QuickPay Run) of the runs completed for this assignment. Check the Reverse box for the run to reverse.

   The consolidation set for the run automatically displays as the consolidation set for the reversal.

2. Select a different consolidation set to process the reversal in a set different from the original run set. Save your entry.

See: Temporarily Changing a Payroll’s Consolidation Set: page 21 –11
Adjustments to Balances

You seldom need to make direct adjustments to an employee’s earnings and deductions balances in Oracle Payroll, because you can usually correct mistaken inputs to the payroll process by rolling back or reversing the process, and retrying it or reprocessing the employee using QuickPay.

When you do need to directly adjust a balance for an employee, the system processes the adjustment as it processes a payroll run, and produces the adjustment as a run result. You place the adjustment in a consolidation set and schedule post-run processing for it just as for other payroll runs.

To preserve balance integrity, when you make an adjustment to a lower-level balance, the system automatically adjusts all related higher-level balances for the employee.

To make adjustments to tax balances, special procedures are available.

See Also

Adjustments to Employee Tax Balances: page 18–39

Making Balance Adjustments

To adjust a non-tax balance for an employee assignment, use the Adjust Balance window.

Note: To make adjustments to tax balances, use the Adjust Tax Balances window.

See: Adjustments to Employee Tax Balances: page 18–39
To adjust a non-tax balance for an employee:

1. Set the effective date to the date for the adjustment. The window displays this date and the corresponding payroll period for the employee.

2. Select the element to which you are making the adjustment. The names of its input values appear in the Entry Values window. Make entries to these input values as necessary.

3. The default consolidation set for the payroll of this employee assignment displays. You can enter a new consolidation set for the post-run processing of the balance adjustment.

4. Save your work. The system processes the new element entries and creates a run result for the element. The Status region displays the progress of this processing.

   If the process ends with a status of Error, check that the units of measure for the entry values are correct. If they are, consult your system administrator.
Retroactive Pay Processing

Sometimes you must recalculate past payroll processing for individuals or groups, and adjust for any differences between original and recalculated pay. This situation can occur when inputs to pay that were correct at the time change retroactively. For example, a new union contract with a retroactive pay raise can mean you must recalculate wages already paid, using a higher wage rate.

In other cases, inputs actually changed in the past, but notification of the change was late in reaching the payroll department. For example, if notice of changes to contribution tables arrives late, you must recalculate voluntary deductions already taken, and adjust for the changed premium amounts.

To produce retroactive pay in Oracle Payroll, you:

• identify the set of employees affected, and date effectively update the appropriate element entries for them
• define elements for processing in payroll runs to hold the retroactive adjustment for each employee, which is the difference between newly calculated and original values for balances you identify (for example, Gross Pay to Date, or Benefit A Payments to Date)
• run the RetroPay process
• process the elements holding the retroactive adjustments in current period payroll runs.

The RetroPay Process

The RetroPay process rolls back and reprocesses all the payrolls for the affected employees, from a date you supply. The system compares the original values of the balances identified for processing with the new ones, and creates entries for the RetroPay elements in the amounts of the difference. Employees receive the retroactive adjustments to their pay when you include the Retroactive Pay earnings for processing in a payroll run in the current period.

When you roll back an entire process or individual assignment processing, the records will show no record that the processing ever occurred. With the Oracle Payroll audit trail you can preserve a complete record of processing. You cannot roll back a process for which further processing has occurred.

Setup Steps for Retroactive Pay Processing

The procedure for making retroactive pay adjustments for employees involves a number of steps, as follows:
To process retroactive pay:

1. Define the set of employees who are to receive the retroactive adjustments.
   
   **Note:** Ensure that only those employees getting retro pay are in your assignment set.
   
   See: Creating an Assignment Set: page 23 – 14

2. For the employees in the assignment set, date–effectively make new entries for the earnings or deduction you are reprocessing. You can make these entries using the Element Entries window for individual employees, or PayMIX for batch element entry.
   
   See:
   
   Making Manual Element Entries: page 12 – 42
   Completing Batch Element Entries Using PayMIX: page 13 – 69

3. Define the RetroPay elements you require to receive entries of the retroactive adjustments. Give them:
   
   - the appropriate element classification, for example, Earnings or Voluntary Deduction (not Information)
   - the processing type Nonrecurring
   - the rule Multiple Entries Allowed
   - input values with these names
     - Pay Value
     - Start Date
     - End Date
   
   **Note:** The end date must be at least 1 day into the next pay period in order to make the pay element retroactive.

4. Link the RetroPay elements to the employees who are due retroactive adjustments.
   
   See: Defining Element Links: page 12 – 38

5. Create a RetroPay set.
   
   See: Creating a RetroPay Set: page 22 – 14

6. Run the RetroPay process.
   

   
   - identify a balance for which RetroPay is to produce an adjustment. This could be, for example, Gross Wages to Date or Insurance Coverage Payments to Date.
Creating a RetroPay Set

To create the RetroPay set you use the RetroPay Set window.

To create the RetroPay Set:

1. Enter a name and a description for the RetroPay set you are creating, and save this information.

2. Select a balance for which the RetroPay process will create new element entries.
   
   **Note:** If you plan to run the RetroPay process over several past payroll periods, check that you are not going to go through an end of year or similar period where balance totals are reset to zero. If necessary, adjust the balance dimension span to Inception to Date.

3. Select the RetroPay element you have defined to receive entries to update the balance.
   
   **Note:** If the list of values does not include your retropay element, check its definition to ensure the element has the input values Start Date and End Date.

4. Select the input value of the element that is to receive the entries.
   
   **Note:** To make the full payment or deduction in the next run select the Pay Value. To spread the payment or deductions over several runs select another input value to feed a formula you write.

5. Repeat steps 2 through 4 for each balance requiring retroactive update. Save your work.

6. In the Run Requests window, initiate the RetroPay process.
Running the RetroPay Process

Run this process from the Submit Request window.

To run the RetroPay process:
1. Select RetroPay in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. Select the Assignment Set defined for this process.
3. Select the RetroPay set created for this process.
4. Enter the start and end dates of the process.
5. Choose Submit.
This chapter introduces the inquiry and reporting tools you can use with Oracle HRMS. It summarizes the reports and inquiry windows that are supplied with Oracle Human Resources and Oracle Payroll. It also explains how you can create and run your own QuickPaint reports for fast online reporting on people and assignments.
Overview of Inquiry and Reporting Tools

Oracle HRMS provides a range of inquiry and reporting mechanisms to meet the needs of different users:

- inquiry windows (including folders)
- predefined reports that can be scheduled and grouped for periodic processing
- DateTrack History, to view the changes to datetracked information over time
- QuickPaint, to create your own online inquiries and reports about people and assignments

In addition, you can use Oracle Reports or other tools to write your own reports. You can register these with the system so that they can be run in the same way as the predefined reports.

You can extract mail merge information from the human resource database to send to your word processing system. For example, you might want to produce standard letters for applicants as part of your recruitment process.

It is also possible to download information from the human resource database to other tools for reporting or editing. For example, you can use Oracle Application Data Export (ADE) to download information to a spreadsheet.

See Also

Viewing DateTracked Information and History: page 1 – 13
Inquiry Windows and Folders

Oracle HRMS includes some inquiry windows to meet the most common online reporting requirements. In these windows, you typically enter selection criteria in the first block then choose the Find button to view a list of people, assignments, or other entities that match your criteria. Some of these windows use folders to display the information retrieved by your criteria.

Folders are online views that you can customize. By default, the folder block in an inquiry window displays all records matching your inquiry and all fields available within the folder. However, you can create your own folders to display a subset of these records and fields. You can also choose the field labels, their size and order, and the sort sequence of the retrieved records.

For example, in the Assignment Folder window, you could create a folder called Sales Employees by Grade. This folder has the query criteria Organization = 'Sales', and it is sorted by grade.

You can define public folders, which all users can view, as well as private folders for your own use.

<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignments Folder</td>
<td>Lists of assignments in a folder</td>
</tr>
<tr>
<td>Employee Assignment Processes (Oracle Payroll)</td>
<td>All the assignment processes for one employee assignment, which you can view, retry or roll back, with further information on run messages, run results, balances, payment details and costing</td>
</tr>
<tr>
<td>Payroll Processes (Oracle Payroll)</td>
<td>All the payroll processes for one payroll for a specified period, which you can view, retry or roll back, with further details on assignment processes, run messages and costing</td>
</tr>
<tr>
<td>People Folder</td>
<td>Lists of people in a folder</td>
</tr>
<tr>
<td>Salary Management Folder</td>
<td>List of assignments with their current approved salary and proposed new salary</td>
</tr>
<tr>
<td>Position Occupancy Folder</td>
<td>Lists of people who have held a selected position, or are applying for it, and the dates of their occupancy</td>
</tr>
<tr>
<td>List Assignments</td>
<td>Assignments that match the assignment components you specify for current applicants, employees, or both</td>
</tr>
<tr>
<td>List People by Assignment</td>
<td>People whose assignments match the assignment components you specify for current or former applicants, employees, or both</td>
</tr>
</tbody>
</table>

Table 23 – 1 Inquiry Windows in Oracle HRMS
<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Employees by Organization</td>
<td>All employees assigned to one organization and, optionally, to all organizations below it in a specified hierarchy</td>
</tr>
<tr>
<td>Assignment History</td>
<td>The dates of assignments and periods of service for an employee who has had more than one assignment. <strong>NOTE:</strong> Use DateTrack History on the Assignment window to see historical changes to one assignment.</td>
</tr>
<tr>
<td>List Employees by Position</td>
<td>All employees assigned to a specified position or organization and job</td>
</tr>
<tr>
<td>List Employees by Position Hierarchy</td>
<td>Current holders of positions at and below a specified position in a position hierarchy</td>
</tr>
<tr>
<td>View Employee Grade Comparison</td>
<td>The amount employees receive for a specified element as a percentage of the mid-value of their grade rate range</td>
</tr>
<tr>
<td>List Employees by Absence Type</td>
<td>All absences of a particular absence type or category within, optionally, a specified time period</td>
</tr>
<tr>
<td>View Employee Absence History</td>
<td>Periods of absence for a specified employee</td>
</tr>
<tr>
<td>List People by Special Information</td>
<td>All people for whom you have entered details about a specified special information type</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>All employee assignments receiving a specified compensation element within a given time period</td>
</tr>
<tr>
<td>View Element Entry History for Employee</td>
<td>The history of entries of one or more elements for an employee assignment</td>
</tr>
<tr>
<td>List Position Budget Variance</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for positions below a chosen position in a hierarchy</td>
</tr>
<tr>
<td>List Budget Variance by Organization</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for all positions in organizations at and below a chosen organization in a hierarchy</td>
</tr>
<tr>
<td>View Employee Benefits</td>
<td>View benefit plans on which an employee is enrolled and the coverage level and contributions for each plan</td>
</tr>
<tr>
<td>View Vacancies</td>
<td>Vacancies matching assignment components and other criteria you select</td>
</tr>
</tbody>
</table>

Table 23 – 1 Inquiry Windows in Oracle HRMS
Predefined and User Defined Reports

There are a number of predefined reports that you can use immediately without any further set up (see Table 23 – 2). They have a predefined format but you can choose which records to view by entering a set of parameters when you submit the report.

These reports run in batch mode: you submit them for processing in the Submit Requests window and can view their progress using the View Requests window. The requests are handled by a concurrent manager so you can continue working online while your request is processed.

You can schedule the reports to run regularly and you can group them with other reports and processes to run as a set. You can also control access to the reports and control their printing. For example, the system administrator might want to ensure that users in one location always print their reports on a local printer.

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absences</td>
<td>Absence details for an employee or organization, for some or all absence types</td>
</tr>
<tr>
<td>Assignment Status</td>
<td>All employees, applicants, or both assigned to selected work structures</td>
</tr>
<tr>
<td>Current and Projected Progression Point Values</td>
<td>The expected results of running the Increment Progression Points process, that is, the projected point and value changes for a group of employees</td>
</tr>
<tr>
<td>Element Link Details</td>
<td>The eligibility criteria for an element or a group of elements</td>
</tr>
<tr>
<td>Element Result Listing (Oracle Payroll)</td>
<td>Run results processed for a particular element over a defined period, and run results for selected input values of each employee’s last assignment process</td>
</tr>
<tr>
<td>Employee Increment Results</td>
<td>The actual results of running the Increment Progression Points process, that is, progression point and value changes for a group of employees</td>
</tr>
<tr>
<td>Employee Organization Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected organization, or organization hierarchy</td>
</tr>
<tr>
<td>Employee Payroll Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected payroll</td>
</tr>
<tr>
<td>Employee Summary</td>
<td>Addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries for a selected employee</td>
</tr>
<tr>
<td>Full Applicant Details</td>
<td>Applications and applicant interviews for one applicant</td>
</tr>
</tbody>
</table>

Table 23 – 2 Standard Reports in Oracle HRMS
Information Provided

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Assignment Details</td>
<td>Assignment information including periods of service, payment methods, and element entries for one employee</td>
</tr>
<tr>
<td>Full Personal Details Report Set</td>
<td>Person details, applicant details, assignment details, and work details for one employee</td>
</tr>
<tr>
<td>Full Person Details</td>
<td>Addresses and information entered in the Person window, such as name, date of birth, nationality, and work telephone number for one employee</td>
</tr>
<tr>
<td>Full Work Details</td>
<td>Miscellaneous work information, including special information, absences, recruitment activities, and contacts for one employee</td>
</tr>
<tr>
<td>Job and Position Skills Matching</td>
<td>Lists of employees, applicants, or both that meet some or all skill requirements of a job or position</td>
</tr>
<tr>
<td>Organization Hierarchy</td>
<td>The organizations (and optionally their managers) below a selected organization in a particular hierarchy</td>
</tr>
<tr>
<td>Position Hierarchy</td>
<td>The positions (and optionally their holders) below a selected position in a particular hierarchy</td>
</tr>
<tr>
<td>Requisition Summary</td>
<td>Applicants and their interview schedules for a selection of vacancies</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Current, past, and proposed salaries for a selected list of employees</td>
</tr>
<tr>
<td>Staffing Budget Details</td>
<td>Actual staffing level with budgeted levels over a specified period</td>
</tr>
<tr>
<td>Terminations</td>
<td>The number of employees from selected organizations leaving your enterprise within a particular period, and the reasons for leaving</td>
</tr>
</tbody>
</table>

Table 23 – 2 Standard Reports in Oracle HRMS

You can create your own reports using Oracle Reports or SQL*Plus or another tool of your choice. You can register them with Application Object Library. This means you can run them from the standard Submit Requests window, and you can schedule them in report sets with other reports and processes.

See Also

Assignment Status Report: page 9 – 32
Employee Summary Report: page 9 – 33
Employee Movements Report: page 9 – 33
Terminations Report: page 9 – 19
Employee Increment Results Report: page 4 – 19
Current and Projected Progression Point Values Report: page 4 – 18
Organization Hierarchy Report: page 2 – 39
Position Hierarchy Report: page 3 – 24
Absences Report (Oracle Human Resources North American Users’ Guide)
Reviewing Element Links: page 12 – 40
Submitting a Request
(Oracle Applications User’s Guide)
Oracle Application Object Library Reference Manual
QuickPaint

QuickPaint is a powerful and flexible tool to design reports about assignments in the format you require. You can include the following sorts of information in a QuickPaint report:

- Personal information
- Contact information
- Assignment information
- Application information
- Compensation and benefit information
- Descriptive Flexfield information

Once you have designed a QuickPaint report, you and other users can run the report online for any assignment or set of assignments. You can view the results online or print them.
Defining QuickPaint Reports

You can design QuickPaint reports in the Define QuickPaint Report window.

In the Report Definition area, you can enter free text to introduce the report and to label the information that the report extracts from the database. You can also select database items, which are tags representing the information to be extracted from the database. When you run the report, the database item names are replaced by the appropriate data for the assignment or set of assignments for which the report is run.

You must be careful how you position the database items so that QuickPaint interprets them correctly and formats the report in the layout you require.

To define a QuickPaint Report:

1. Enter a name, and optionally a description, of the report.

   The Protected field is display only; some reports provided by localization teams are protected against edits.
2. In the Report Definition area, enter free text exactly as you want it to appear on the report.

3. To select database items, choose the Show Items button and run a query to display a list of database items, then select and copy items to the Report Definition area.

   Notice that the database item name must begin with an ampersand (&). Names without an ampersand are treated as free text.

4. Save the report definition.

Positioning Items

If you want to add free text immediately after a database item, you must separate it from the database item with at least one space. Otherwise QuickPaint reads the database item as free text.

Both free text and database items appear in the report results on the line on which you painted them in the Report Definition area. They also generally appear in the column in which you painted them. However, it might be that the data replacing a database item name is long enough to push later items on the same line to the right.

For example, if you paint database items and free text like this:

   &ASG_JOB       in &ASG_ORG

the report results print like this:

   Technician in Biochemistry
   Scientific Officer in Biochemistry

Notice that, in the second result, the free text 'in' is pushed to the right and one space is entered before it.

If you know the number of the column in which you want text or a database item to appear, you can enter it like this:

   &ASG_JOB       &32in &ASG_ORG

However, the text 'in' will still be pushed to the right if the preceding database item (&ASG_JOB) extends beyond column 32. If you would prefer the preceding database item to be truncated, paint the line as follows:

   &ASG_JOB       &32in &ASG_ORG

The report results will look like this:

   Technician in Biochemistry
   Scientific Off in Biochemistry
If you want one space between two database items or between a
database item and text, then paint them separated by a single space.
The single space is always preserved. For example, this definition:

\&EMP_FIRST_NAME &EMP_LAST_NAME

gives the following report results:

Alice Hollister
Ray Garcia

Adding Conditions or Calculations to QuickPaint Reports

When you save a report definition, QuickPaint generates a formula to
extract the information required by the report. You can view this
formula in the Formulas window. To query the formula, enter the
name of your QuickPaint report preceded by the prefix QP_.

Formulas generated from QuickPaint definitions do not contain
conditional logic or mathematical computations. If you need these
features, query the formula in the Formulas window and copy it. Edit
the copy to add the logic you require.

Attention: You should not edit the original QuickPaint
formula. Always edit a copy. Any edits of the original formula
are overwritten if you change the report definition in the
QuickPaint Report window.

See Also

Static Database Items: page C – 2
Dynamic Database Items: page C – 19
Using Oracle FastFormula to Define QuickPaint Reports, Oracle
FastFormula User’s Guide
Running QuickPaint Reports

You run QuickPaint reports from the Run QuickPaint Report window. You can run a report for one assignment or for a group of assignments.

Prerequisites

- To run a QuickPaint report for a group of assignments, you must first define an assignment set.

To run a report for one assignment:

1. Select the type Assignment.
2. In the Assignment region, select the assignment for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

When you run a QuickPaint report, the system runs the formula associated with the report. The first time you run a report, the
system may take several seconds to identify all of the related data and bring it back to the screen. All subsequent inquiries for other employees or applicants will run very quickly.

To run a report for an assignment set:
1. Select the type Assignment Set.
2. In the Assignment Set region, select the assignment set for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

Customizing the Run QuickPaint Reports Window

Using the standard QuickPaint Report window, you can run the report for an assignment or an assignment set. The assignments can be held by current employees or applicants.

Your system administrator can create customized versions of this window to restrict the reports you can run and the people you can report on. A customized version might be subject to one or more of the following restrictions:

- report on one person type only (employees OR applicants)
- run one report only
- report on single assignments only, or report on assignment sets only

If the window is subject to the third type of restriction, it will look different to the standard version since it will contain either the assignment region or the assignment set region, but not both.

See Also

Restricting the Data Displayed in a Window: page 27 – 3
Creating an Assignment Set

There are two uses of assignment sets in Oracle HRMS:

- You can run a QuickPaint report for a set of assignments, rather than individual assignments.
- In Oracle Payroll, you can process subsets of the employees assigned to a payroll. Normally you initiate payroll runs and other post–run processes for one or more payrolls at a time. However, if you need to process smaller groups within a single payroll, you define an assignment set.

There are three ways to define the set:

- You can enter selection criteria, which the system generates into a formula. When you use the assignment set, Oracle FastFormula runs the formula to find the assignments that match the criteria. It checks all the assignments in the Business Group or, if you select a payroll when you define the set, all the assignments to that payroll. When you define the set you can also include or exclude individual assignments to modify the set created by the formula.
- You can select individually all the assignments you want to include in the set.
- You can start from a full set of all the employees in the Business Group or all the employees assigned to a selected payroll. Then you can exclude individual assignments from the set.

Use the Assignment Set window to define your set.

To define an assignment set using criteria for a formula:

1. Enter a unique name for the set.
2. Do one of the following:
   - If you are defining an assignment set for payroll processing, you must select a payroll. You cannot process an assignment set drawn from more than one payroll.
• If you are defining an assignment set for other purposes, selecting a payroll is optional. If you select a payroll, the formula generated from your selection criteria will select assignments from this payroll only. If you do not select a payroll, the formula will select assignments from the whole Business Group.

3. Save the new set and choose the Criteria button.

4. In the Assignment Criteria window, enter one criterion in each row, and join the criteria with AND or OR in the Condition field. Field details are as follows:

   **No.**: The sequence number of each condition in your rule. If you use sequence numbers that are multiples of 10, it will be easier to insert new conditions later.

   **Condition**: Leave the first row blank. Enter AND or OR for second and subsequent rows.

   **Database Item**: Select database items as variables for your definition. All database items are prefixed by an ampersand [&].

   **Operator**: Select operators to determine relationships between database items or values. The list of operators is shown in Table 23 – 4.

   **Value/Database Item**: Select database items for the second variable. Alternatively, you can enter a fixed value of the same type as the database item. Enter text values in single quotes.

   As an example, here is a definition for an assignment set of employees with salaries between 16,000 and 24,000:

<table>
<thead>
<tr>
<th>No.</th>
<th>Condition</th>
<th>Database Item</th>
<th>Operator</th>
<th>Value/Database Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>&amp;SALARY_PAY_VALUE_ENTRY_VALUE</td>
<td>&gt;=</td>
<td>16000</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>AND &amp;SALARY_PAY_VALUE_ENTRY_VALUE</td>
<td>&lt;=</td>
<td>24000</td>
<td></td>
</tr>
</tbody>
</table>

   Table 23 – 3 Assignment Set Criteria

5. Save your criteria and choose the Generate button to generate the formula.

   You can view and edit the formula in the Formula window. Its name is the same as the assignment set name.


6. If you want to include or exclude individual assignments from the set defined by your criteria, choose the Amendment button. Select the assignments you want to include or exclude from the set.
Note: The list of assignments you see in this window is either all the assignments in the Business Group or, if you selected a payroll, all the assignments to that payroll. It does not show the assignments matching your criteria since these are identified dynamically each time the formula runs.

7. Save the set.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Symbols</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equals</td>
<td>=</td>
<td>The condition is true if both expressions have exactly the same value. For text, the case of the expression must be the same. So, for example, ‘Smith’ is not equal to ‘SMITH’.</td>
</tr>
<tr>
<td>Not Equal</td>
<td>!=</td>
<td>The condition is true if the result of the first expression does NOT have the same value as the result of the second expression.</td>
</tr>
<tr>
<td>Greater than</td>
<td>&gt;</td>
<td>The condition is true if the first expression is alphabetically after, or has a numerically greater value, or a later date than the second expression.</td>
</tr>
<tr>
<td>Less than</td>
<td>&lt;</td>
<td>The condition is true if the first expression is alphabetically before, or has a numerically smaller value, or an earlier date than the second expression.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>&gt;=</td>
<td>The condition is true if either the greater than OR the equal to operator returns a true result.</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>&lt;=</td>
<td>The condition is true if either the less than OR the equal to operator returns a true result.</td>
</tr>
</tbody>
</table>

Table 23 – 4 Values in Operator Field

► To define a set by including or excluding assignments:

1. Enter a unique name for the set.
2. If you are defining a set for payroll processing, select a Payroll.
3. Save the new set.
4. Choose the Amendment button.
5. Do one of the following:
   - If you want to create a small set of assignments, select Include in the Inc/Exc field and select all the assignments for the set.
   - If you want to start from the full set of assignments for the payroll or Business Group, select Exclude in the Inc/Exc field and select assignments to remove from the set.
Attention: Do not create a mixture of Include and Exclude rows if you have not entered criteria and generated a formula.

6. Save your set.
Custom Reports

The Custom Reports function provides a generic reporting capability that makes use of a single report to print out a custom definition. This report is called PERGENRP.

The report is registered as a concurrent process and prints, in landscape format, the contents of the temporary table PER_GENERIC_OUTPUT_REPORT.

This table contains the individual components of a custom report and is populated by the PL/SQL package PERGENRP.pkb, stored in $PER_TOP/admin/sql. This package is executed when you select the Generate Report button on the Custom Reports window.

To submit a Custom Report:

1. Navigate to the Custom Reports window.
2. Select the report by name.
3. Enter any parameters for this report.

Attention: Parameter values are not validated until you choose the Generate Report button.

4. Choose the Generate Report button
   
The default for the report is to print the output automatically. It is a System Administrator task to set default printers for all users, or to reset this option on the Concurrent Program window.

Creating New Report Formats

A special feature of Custom Reports is that you do not need to create multiple reports. You modify the generic package (PERGENRP.pkb) and report to provide additional formats and parameters.

Three sample report formats are provided, each with a different set of parameters:

- PERCS001 – Custom Report 1
  
  There is one parameter: Vacancy. The format in PERGENRP is Full Name of Applicant and Gender.

- PERCS002 – Custom Report 2
  
  Parameters are Vacancy and Gender. The format in PERGENRP is Full Name of Applicant in uppercase.

- PERCS003 – Custom Report 3
Parameters are Vacancy, Gender and Marital Status. The format in PERGENRP is *Full Name of Applicant, Gender* and then *Full Name* in uppercase.

You can edit the generic package to change:

- Report Title Page
- Header
- Footer
- Body Text

After you have modified the package, you need to register a new custom report, with the parameter set for that report. This is a task for the System Administrator.

**To register a new Custom Report with parameters:**

1. Navigate to the Concurrent Programs window.
2. Enter the name of the Custom Report as the Program.
3. Enter a short name for the Custom Report.

  **Attention:** You must start the short name with PERCS. This will limit the list of values available to users in the Custom Report window.
This chapter focuses on three aspects of setup that affect how you record and track people in your system:

- Person Types – choosing the types of people you need to identify and the sorts of information you want to hold about each type
- Assignment Statuses – choosing statuses to track temporary or permanent departures of employees from your enterprise
- Special Information Types – designing fields to hold any special information, not provided by the main system, you want to hold about people, jobs and positions, and training activities
Person Types

In any enterprise there is a need to identify different groups of people. For each group that exists in your enterprise there may be different types of information you need to keep. You may also want to control access to the records of different groups of people.

There are three basic types of people for whom you maintain information in your human resource system. These are:

- Employees, both current and ex-employees
- Applicants, both current and ex-applicants
- External people

A special category of the External type is contact. A contact is someone associated with an employee or an applicant.

For example, people who are dependents of employees, people whom employees name as beneficiaries of certain benefits, and people whom employees list as their contacts in case of emergency are all entered as contacts.

Using Person Types

Oracle HRMS comes with a set of Person Types. You can change the names of these types when you install the system, and you can add your own subgroups of Person Types. For example, you might have two types of employee in your enterprise:

- Regular Employee
- Contractor

You can define these as subgroups of the Employee person type to:

- enable fast identification of these groups
- manage different kinds of personal information for each group
- change employees from Contractor to Regular Employee, without changing current work information

Note: Each employee’s assignment can be described by an employment category such as Full Time – Regular or Part Time – Temporary. So you do not use Person Types to distinguish the category of assignment.

In another example, you might want to distinguish between internal and external applicants for vacancies. You may also be involved in a redundancy program or a program of staff layoffs, and need to identify employees as preferred candidates for any vacancies. You can do this with the following subgroups of applicant:
Defining Person Types

There are eight Person Types recognized by the system, and identified by a system name. For each, there is a predefined user name. You can change the predefined name and you can enter other user names.

One user name must be the default. This is the name the system enters in certain circumstances if you do not select a Person Type manually. For example, when you hire an applicant, the system automatically updates the Person Type to the default user name for the system name ‘Employee’.

You enter user names for person types in the Person Types window.

First consider whether the existing user names are meaningful in your enterprise.

► To change a user name for a person type:
  - Delete the contents of the User Name field and type in your preferred name.

► To map other user names to a person-type system name:
  1. Select New Record from the Edit menu.
  2. Enter a unique User Name and select the System Name you want to map on to.

Deactivating User Names

You cannot delete user names in use in the system, but you can deactivate them by unchecking the Active check box. Notice that you cannot deactivate a default User Name. You must first select another user name as the default.

Person Types and Information Management

The system uses its Person Types to control the type of information you can enter. For example, you cannot enter earnings or deductions for an applicant. You can use Person Types in the following ways:

• Internal Candidate
• External Candidate
• Preferred
• To control access to people’s records on the system, according to their Person Type. For example, you might give all managers in a department access to employee records, but only give recruitment officers access to records of applicants and ex-employees.

Your system administrator can achieve this by creating customized versions of the People window.

See: Restricting the Data Displayed in a Window: page 27 – 3

• When you set up your own fields to hold additional information, you can tie them to particular Person Types. For example, you might want a user-defined field holding visa information for foreign workers to appear for employees and applicants, but not for other people.

You can do this by setting up the descriptive flexfield on the People window.

See: Adding New Fields to Windows: page 27 – 2

**Suggestion:** If you want to define rules of eligibility for a compensation or benefits element based on the type of employee, you cannot use the Person Type directly. However, you can use Person Type in a formula to validate the values entered for an employee.

Also, consider whether you can meet your needs using the assignment status and employment category to control eligibility for compensation and benefits.

See: Components of the Assignment: page 9 – 5
Assignment Statuses

You use assignment statuses to track temporary or permanent departures of employees from your enterprise. Temporary departures include paid or unpaid leaves of absence that you may allow employees to take for a number of reasons.

Primary Statuses

There are four system statuses for employee assignments:

- **Active Assignment**, used to show that the employee is working in accordance with his or her usual conditions of employment.
- **Suspend Assignment**, used to show that the employee is on leave of absence, but remains an employee of your enterprise.
- **Terminate Assignment**, used to show that your enterprise no longer employs the person in that assignment. It can still be possible to make payments through Oracle Payroll for assignments at this status.
- **End**, used to end any assignment except the primary assignment for an employee with multiple assignments. This status causes a secondary assignment to end but is not recorded on the assignment.

On your system, you may give these statuses different *user statuses* appropriate to your enterprise. Each system status can have several user statuses related to it. For example, for the system status Suspend Assignment, you can have the user statuses Maternity Leave, Paternity Leave, and Military Leave.

These statuses are *primary* because they determine how the system processes and manages the assignment. An assignment must have one, and only one, primary status at a given time. You enter this status in the Assignment window.

See: Entering a New Assignment: page 9 – 9

Using Assignment Statuses to Control Compensation

When you define user statuses, consider how you will use them in reports, inquiries, and processing.

When you use a validation formula to validate entries to element input values, you can make the valid values for an entry dependent on the assignment status.

To use the statuses to control whether the payroll run processes an employee assignment, you choose a payroll status of Process or Do not
Process for each user status. Additionally, in Oracle Payroll you can set up your pay calculation formulas so that a status change also changes the formula used to calculate the employee’s pay. For example, an employee might receive half pay while on Military Leave.

See: Using Oracle FastFormula for Validation, Oracle FastFormula User’s Guide

**Additional Information:** Refer to your Oracle Payroll manual for information on the use of assignment statuses in the Formula Result Rules window to control the payroll formula that processes for an employee.

### Secondary Assignment Statuses

For analysis and reporting purposes, you can set up and use *secondary* assignment statuses, for both employee and applicant assignments. These statuses have no effect on assignment processing.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.

To enter reasons for giving secondary statuses to assignments, define valid reasons as values for the QuickCode Type EMP_SEC_ASSIGN_REASON (for employee assignments) and APL_SEC_ASSIGN_REASON (for applicant assignments).
Defining Assignment Statuses

You define both primary and secondary user statuses your enterprise uses for employee and applicant assignments in the Assignment Statuses window.

Defining Primary User Statuses

You can give your own user status names to the predefined system statuses. For example, for applicants you could use the user status “Rejected” for the system status “Terminate Application”. Oracle HRMS users see user statuses only.

You can also supply more than one user status for each system status. For example, for employees you can define several different user statuses for the system status Suspend Assignment, such as Maternity Leave, Paternity Leave, Disability Leave, Military Leave or Education Leave.

For applicants, you can track the stages of your selection process by means of user statuses. You can define user statuses such as Application Received, Application Acknowledged, First Interview, and Second Interview for the system status Active Application. These statuses can trigger production of standard letters.

See: Tracking Applicant Progress (Oracle Human Resources North American User's Guide)

► To rename a user status:

- Delete the contents of the User Status field and type in your preferred name.

► To supply additional user statuses for a system status:

1. Select New Record from the Edit menu.
2. Type in your user status, and select an HR System Status.
3. For an employee assignment status, also select a Payroll System Status. The payroll system status controls whether Oracle Payroll processes the assignment in a payroll run.
4. Save the new status.

Note: For each HR System Status, you must have one default user status. The system automatically uses the default in certain situations. For example, when you create a new employee assignment, it automatically has the default user status corresponding to the system status ‘Active Assignment’. You can override this default.

You cannot delete a user status, but you can prevent its use by deactivating it. To deactivate a user status, uncheck the Active check box.

Defining Secondary Statuses

A user status associated with a system status is called a primary status because it determines how the system processes the assignment. You can also define secondary statuses not associated with a system status. You use secondary statuses for analysis and reporting, but not to control pay processing for assignments.

To create a secondary status:

1. Select New Record from the Edit menu in the Assignment Statuses window.
2. Type in a user status and do not select a system status.
   The Type field displays Secondary.

Setup To Allow Processing After Termination

To enable payroll processing for employees after they leave your enterprise, in your system setup you must do the following:

- Use the Assignment Statuses window to make sure your system has a user status that corresponds to:
  - the HR system status of Terminate Assignment
  - the Payroll system status of Process

Your startup data includes the user status Terminate Process Assignment, which matches this definition. Use this status (or
your own equivalent status) when you terminate employment or end an assignment.
Defining Special Information Types

In Oracle HRMS, you use the Personal Analysis key flexfield to define any special information not provided by the main system that you want to hold about people, jobs and positions, and training activities.

You can define any number of instances of the Personal Analysis key flexfield. Each instance is called a Special Information Type. For example, you might set up types to hold performance reviews or medical details.

Each Special Information Type can have up to thirty fields (where each field is a segment of the flexfield). You can set up cross-validation to ensure that users enter correct combinations of segments. You can also speed up data entry and minimize errors by defining an ‘Alias’ for common combinations of segment values.

When you enable Special Information Types for your Business Group, you select how you plan to use each type.

In Oracle Human Resources, you can use Special Information Types for:
- job requirements
- position requirements
- personal information
- OSHA and ADA reporting

In Oracle Training Administration, you can use Special Information Types for:
- skills provided by training activities

Each Special Information Type can be used for one or more of these purposes. The options you select control the windows in which each Special Information Type appears.

Special Information Setup Steps

To set up Special Information Types:

1. Define each Special Information Type as an instance of the Personal Analysis key flexfield.
   
   See: Oracle Applications Flexfields Guide

2. Enable the Special Information Types you want to use in your Business Group and select how you want to use them.

See Also

The Special Information Approach to Skills Matching, Oracle Human Resources North American User’s Guide
Enabling Special Information Types

Use the Special Information Types window to enable Special Information Types for the Business Group, and to select how you want to use them.

To enable Special Information Types:

1. Select the Special Information Types you want to use in your Business Group.
2. Enable each Type by checking the Enabled check box.
3. Check the other boxes to specify how you plan to use the Special Information Type. This makes it available in the list of values in other windows as follows:
   - **Job:** in the Job Requirements window
   - **Position:** in the Position Requirements window
   - **Other:** in the Special Information window
   - **Skill:** in the Skill Provisions and Search for Event windows in Oracle Training Administration

The information types ADA Disabilities, ADA Disability Accommodations, and OSHA–Reportable Incident are already enabled when you receive Oracle Human Resources, and ready to use for ADA and OSHA reporting.


CHAPTER 25

System Administration

The HRMS system administrator looks after the day to day administration of the system. This chapter summarises the tasks performed by the system administrator and explains how to:

- set user profiles to predefine aspects of your users’ work environment
- enable the currencies used in your Business Group
The Role of the System Administrator

The system administrator takes responsibility for the day to day administration of one or more Oracle Applications.

Many jobs are more efficiently performed by one designated person. For example, the system administrator defines printers, and balances the system’s processing workload between online data entry and background processing, such as report generation.

A database management system can be conceptually divided into two parts: user applications and their underlying data structures. This division lends itself to two job categories: database administrator (DBA), and system administrator.

- An Oracle Applications System Administrator administers the user interface or applications side of the database management system.
- An Oracle Database Administrator or DBA administers the data the various applications enter, update, delete, and use for company business.

Ideally the system administrator should be someone from within the user group who knows how the system has been defined and can act as the first level of support for the application users. The system administrator role is clearly defined with a specific set of practical tasks to be carried out.

The HRMS System Administrator

For Oracle HRMS these practical tasks normally include:

- customizing the application, including setting up Key and Descriptive Flexfields. See:
  User Definable Key Flexfields: page B – 2
  User Definable Descriptive Flexfields: page B – 5
- imposing limits on what users can access through menus, security profiles, and responsibilities
  See: Setting up Security in Oracle HRMS: page 28 – 10
- defining audit requirements
  See: Setting Up AuditTrail: page 26 – 2
- setting up user profiles
  See: Setting User Profile Options: page 25 – 4
• defining the formats for displaying currency amounts
  See: Enabling Currencies: page 25 – 7
• setting up and maintaining QuickCode types and values
  See: Defining QuickCode Types: page 29 – 5 and: Adding
  QuickCode Values: page 29 – 3
• installing printers and managing concurrent processing
  See: *Oracle Applications System Administrator’s Guide*
Setting User Profile Options

A user profile is a set of changeable options that affect the way your application runs. The system administrator can set user profiles at different levels:

- **Site level**: These settings apply to all users at an installation site.
- **Application level**: These settings apply to all users of any responsibility associated with the application.
- **Responsibility level**: These settings apply to all users currently signed on under the responsibility.
- **User level**: These settings apply to an individual user, identified by their application username.

Values set at a higher level cascade as defaults to the lower levels. Values set at a lower level override any default from a higher level.

**Suggestion**: Set site–level options first to ensure that all options have a default. If a profile option does not have a default value, it might cause errors when you use windows, run reports, or run concurrent requests.

You use the System Profile Values window to set profile options at each level for your user community. If you change a user profile option value, your change takes effect as soon as your users log on again or change responsibilities.
Application users can the Personal Profile Values window to set their own profile options at the user level. Not all profile options are visible to users, and some profile options, while visible, cannot be updated by end users. Any changes a user makes to his or her personal profile options take effect immediately.

**List of User Profile Options**

There are a number of User Profile Options that are of specific importance to HRMS system administrators. These are listed in Table 25–1 and Table 25–2. The only one of these options that a user can change is DateTrack:Reminder.

<table>
<thead>
<tr>
<th>HR Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR:Business Group</td>
<td>Business Group that is linked to the security profile for a responsibility. This option is used online to control access to records that are not related to organization, position, or payroll.</td>
</tr>
<tr>
<td></td>
<td>This option is seeded at Site level with the start-up Business Group. It is view only. Values are derived from the HR:Security Profile user profile option.</td>
</tr>
<tr>
<td>HR:Security Profile</td>
<td>Restricts access to the organizations, positions, and payrolls defined in the security profile. This option is seeded at Site level with the view–all security profile created for the Startup Business Group.</td>
</tr>
<tr>
<td>HR:User Type</td>
<td>Limits field access on windows shared between Oracle Human Resources and Oracle Payroll. If you do not use Oracle Payroll, it must be set to HR User for all responsibilities.</td>
</tr>
<tr>
<td></td>
<td>If you do use Oracle Payroll, you can give each Responsibility one of the following user types, depending on the work role of the holders of the responsibility: HR User, HR with Payroll User, Payroll User</td>
</tr>
<tr>
<td>HR:Query Only Mode</td>
<td>Restricts access to view–only for all HR and Payroll forms on a menu.</td>
</tr>
<tr>
<td>HR:Use Standard Attachments</td>
<td>Disables the facility to attach short text comments to records. Enables the attachment of multiple items of various types including OLE objects, Web pages, images, and word processed documents.</td>
</tr>
</tbody>
</table>

Table 25–1 HR User Profile Options
DateTrack Option | Purpose
---|---
DateTrack:Date Security | Controls the way users can change their effective date:
- All (users can change to any date),
- Past (users can change to dates in the past only),
- Present (users cannot change their effective date),
- Future (users can change to dates in the future only)

DateTrack:Reminder | Determines whether the Decision window appears when a datetracked window opens:
- Always (the window always appears),
- Never (the window never appears),
- Not Today (the window appears only if the effective date is not the system date)

Table 25 – 2 DateTrack User Profile Options

See Also

Oracle Applications System Administrator’s Guide
Enabling Currencies

Oracle HRMS allows you to use multiple currencies for entering information about employee compensation and benefits. You can also record your payment methods to employees in different currencies.

For example, if you have employees living and working temporarily in other countries, you might want to record specific earnings or deductions for these employees in local currencies. You might also want to pay these employees a fixed amount into a bank account in their home currency. The remainder you would pay in a local currency.

Your startup data includes the definitions of all world currencies. These definitions are shared by all Oracle Applications and are controlled by the system administrator responsibility. You enable those currencies you want to use in the Currencies window.

Note: You must enable at least one currency as the default currency for all information related to money in your system. This default is known as the Base Currency for your Business Group.

To enable a currency:

- Query the currency you want to enable and check the Enabled check box. Save your choice to enable the currency.

You can never delete a currency, but you can disable it.

To disable a currency:

- Uncheck Enabled, or enter an End Date for the currency.
Audit Trail provides a flexible approach to tracking the changes to your data. You can choose which data to audit and how long to keep the audit data. You can use the supplied audit report or design your own.

This chapter explains how to set up AuditTrail and how to report on audit data.
AuditTrail

AuditTrail lets you keep a history of changes to your important data: what changed, who changed it, and when. With AuditTrail, you can easily determine how any data row or element obtained its current value. You can track information on most types of fields, including character, number and date fields.

You enable auditing for audit groups. These are groups of tables and columns you want to audit, where you do not necessarily need to include all the columns in a given table. You typically group together those tables that belong to the same business process, such as employee compensation tables.

During implementation you need to decide:

- which tables and columns you want to audit
- how you plan to report on the audit data
- how long you want to keep the audit data active

Setting Up AuditTrail

Setting up AuditTrail is normally a task for the system administrator.

The first four steps must be done to enable auditing of any Oracle Applications table. They are explained in more detail in the Oracle Applications System Administrator’s Guide. The fifth step is required only for tables in the HR account.

To set up AuditTrail:

1. Have your database administrator grant SELECT privileges on SYS.DBA_TABLES to the APPLSYS account. Normally this step would already have been done as part of your installation or upgrade.

2. Select the tables you want to audit in the Audit Groups window, and select which columns in these tables you want to audit in the Audit Tables window.

   Note: You cannot audit LONG, RAW, or LONG RAW columns.

3. Select the registered ORACLE IDs you want to audit in the Audit Installations window.

4. Run the Audit Trail Update Tables process. You do this in the Submit Requests window for a System Administrator responsibility. This process:
• creates database triggers on your audited tables
• creates one shadow table for each audited table, to contain the audit information
• builds special views on non-datetracked tables, which you can use to retrieve your audit data for reporting

5. Run the Audit Trail Update Datetracked Tables process. You do this in the Submit Requests window for an HRMS responsibility. For each datetracked table, this process:
• creates an index on the shadow table
• creates the function <tablespace>_<TT and the procedure <tablename>_<VP, which extracts information from the shadow table when you run the predefined audit report

**Attention:** You must rerun these processes any time you update any of your audit definitions.

### Disabling AuditTrail

You can disable the auditing of an audit group at any time by selecting a Disable state in the Audit Groups window.

**Suggestion:** If you are planning high volume transactions on an audited table, such as loading a batch of information from another system, consider disabling auditing for the table’s audit group. This will enable the batch loading to complete more quickly.

Before you restart auditing, you should archive your audit data, according to your business needs, and purge the shadow tables. You purge the tables by setting the audit group to Disable – Purge Table and running the Audit Trail Update Tables report. To restart auditing, you set the audit group to Enable Requested and rerun the Audit Trail Update Tables process and the Audit Trail Update Datetracked Tables process.

### See Also

- Setting Up Release 10 AuditTrail
  *Oracle Applications System Administrator’s Guide*
- Disabling AuditTrail and Archiving Audit Data
  *Oracle Applications System Administrator’s Guide*
Reporting on Audit Information

For any non-datetracked tables, you can write a report that uses the views on the shadow tables to access the audit data. However, for datetracked tables, the information from the shadow tables must be extracted and written to the HR_AUDITS table and the HR_AUDIT_COLUMNS table before you can report on it.

The Oracle HRMS audit report performs this additional processing. You can use it as supplied or as an example of how to report on audit information. It can report on both datetracked and non-datetracked tables that have a numeric primary key.

Note: It can report on up to approximately 90 columns in datetracked tables and 80 columns in non-datetracked tables.

The report lists every change made to the table you select in the time period you specify when you run the report. You can restrict the reported changes to those made by a specified username. The changes are listed by date and time of the change. For each change, the report shows:

- the date and time of the change
- the user id who made the change
- the type of change
- the fields that changed and either their old values, or their new values, or both, depending on the type of change

Table 26–1 lists the 12 types of change and what information is shown in the audit report for each type.

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Insert (creates a non-datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>Normal Update (updates a non-datetracked record)</td>
<td>The old and new values for all fields that changed.</td>
</tr>
<tr>
<td>Normal Delete (deletes a non-datetracked record)</td>
<td>The non-null values in the record that was deleted.</td>
</tr>
<tr>
<td>DT First Insert (creates a datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>DT Update (date-effectively ends the last row on a datetracked record and creates a new row)</td>
<td>The old and new values of all fields that changed, and the new effective end date on the old row.</td>
</tr>
</tbody>
</table>

Table 26–1 Transaction Types in the Audit Report
Table 26 – 1 Transaction Types in the Audit Report

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>DT Correction</td>
<td>The old and new values of all fields that changed, and the effective dates of the corrected row.</td>
</tr>
<tr>
<td>DT Replace</td>
<td>The non–null values in the rows that were deleted, the new effective end date on the row preceding the new row, and the old and new values of all fields that changed.</td>
</tr>
<tr>
<td>DT Insert</td>
<td>The old and new values of all fields that changed, and the new effective end date on the row preceding the new row.</td>
</tr>
<tr>
<td>DT Purge</td>
<td>The non–null values in all rows of the record that was deleted.</td>
</tr>
<tr>
<td>DT End Date</td>
<td>The new effective end date of the row.</td>
</tr>
<tr>
<td>DT All</td>
<td>The non–null values in the rows that were deleted, and the new effective end date on the last row.</td>
</tr>
<tr>
<td>DT Next</td>
<td>The non–null values in the row that was deleted, and the old and new effective end dates on the preceding row.</td>
</tr>
</tbody>
</table>

To run the predefined audit report:

1. In the Submit Requests window, select Audit Report in the Name field.
2. Enter the Parameters field to open the Parameters window.
3. Select an audited table (that is, one in an audit group).
4. Select a value for the Initialization parameter:
   - **Yes** means that the report removes obsolete data related to your selected table from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.
   - **No** means that the report runs on the existing data in the HR_AUDITS table and the HR_AUDIT_COLUMNS table.
• **Refresh** means that the report removes *all* obsolete data from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.

5. If you only want to report on the changes made by one user, enter the username.

6. Enter start and end dates to limit the time period for reporting audit information.

7. Choose the Submit button.

You can use the View Requests window to check the progress of the report.

---

**Designing Your Own Audit Report**

If you want to design your own audit report, you can copy the supplied report and use it as the basis of your own version. The supplied report uses a dynamic SQL structure to retrieve information for the report, and an Oracle Report to format it.

**Dynamic SQL Structure**

For a non–datetracked table, the dynamic SQL structure retrieves information and uses a private procedure to retrieve the new values for an update.

For a datetracked table, the dynamic SQL structure retrieves information from the function and procedure created for each datetracked table by the Audit Trail Update Datetracked Tables process:

- The `<tablename>_TT` function identifies the type of datetracked transaction represented by each row of the shadow table.
- The `<tablename>_VP` procedure gets new values from the shadow table for update and insert transactions. It writes these to the HR_AUDITS and HR_AUDIT_COLUMNS tables.

The dynamic SQL structure comprises several character strings, which are concatenated into one long string, then parsed and executed using the dynamic SQL generator. If you change a string, you must ensure that you do not exceed the text space allocated to it, as listed in the package header.

The structure is built up by identifying the audited table column information, which is retrieved from the FND_AUDIT_COLUMNS table. The logic varies depending on the data type being audited.
The package for the dynamic SQL is called py_audit_report_pkg. It is found in the script pyadyn.pkh/pyadyn.pkb.

**HR Audit Tables**

The HR_AUDITS table holds audit information about the transaction. The HR_AUDIT_COLUMNS table holds the changed column information for that transaction. The structure of these tables is as follows:

**HR_AUDITS Table**

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>commit_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>current_session_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key_value</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>sequence_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>session_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>table_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>timestamp</td>
<td>date</td>
<td>not null</td>
</tr>
<tr>
<td>transaction</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>transaction_type</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>user_name</td>
<td>varchar2(100)</td>
<td>not null</td>
</tr>
<tr>
<td>effective_end_date</td>
<td>date</td>
<td>null</td>
</tr>
<tr>
<td>effective_start_date</td>
<td>date</td>
<td>null</td>
</tr>
</tbody>
</table>

**HR_AUDIT_COLUMNS Table**

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>column_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>column_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>new_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
<tr>
<td>old_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
</tbody>
</table>
Customizing Windows and Menus

As part of your implementation plan, you identify who will use Oracle HRMS, what information they require, and how they will use it. You can group together users with similar requirements and give them the same view of the system. For each group, you can:

- set up menus using structures and names that make sense to the users
- link windows into flows that the users follow to complete a task
- restrict the data they can view and edit in certain windows, so they only see what they need to see

These customizations provide security for your data and an efficient interface designed for your users’ needs.

In addition to these customizations for groups of users, you can customize windows for all users by adding data fields to hold additional information required by your enterprise.
Adding New Fields to Windows

The predefined fields in Oracle HRMS windows are designed to meet your core information requirements. However, like all enterprises, you may have special requirements that are best met by fields that you design yourself. Oracle HRMS provides a flexible mechanism called descriptive flexfields to enable you to add fields to windows.

Figure 27 – 1 illustrates the distinctive appearance of descriptive flexfields. When users click in a flexfield that you have set up, a window opens, displaying up to 20 segments that you have defined.

![Figure 27 – 1](image)

Defining Segments

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the flexfield window
- Context sensitive segments, which appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same zone.

For example, a segment to hold details of an employee’s disability might display only when the Disabled field contains the value Yes.

Attention: Some descriptive flexfields appear in more than one window. For example, the Additional Evaluation Details flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

See Also

List of Descriptive Flexfields: page B – 6

Oracle Applications Flexfields Guide
Restricting the Data Displayed in a Window

Many of the standard Oracle HRMS forms are multipurpose. For example, in the Person form, you can enter or view details of employees, applicants, contacts, or other person types that you have defined. In the Element Entries form, you can make entries for all the elements you have defined.

You may prefer to have multiple versions of these forms, each version being used for just one purpose. This approach restricts the list of values on certain fields and therefore provides for faster data entry. It also allows you to limit access to certain types of information.

For example, you might create a customized version of the View Element Entry History for Employee form that does not display the earnings elements representing salary, bonus, and commission. Most users’ menus would only give them access to this customized version of the form. For the small group of people authorized to view salary, bonus, and commission figures, your system administrator can define a menu function to allow access to the uncustomized form.

Table 27 – 1 lists the forms you can customize and the criteria you can use to restrict access to information.

<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Balance (Oracle Payroll form)</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Define User Values</td>
<td>Table Name</td>
<td>User defined</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td></td>
<td>Entry Type</td>
<td>Override</td>
</tr>
<tr>
<td>Event Bookings</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

Table 27 – 1 List of Customizable Forms
<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>List People by Special Information</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>Special Information Type</td>
<td>User defined</td>
<td></td>
</tr>
<tr>
<td>Person Type</td>
<td>User defined</td>
<td></td>
</tr>
<tr>
<td>Organization</td>
<td>Organization Classification</td>
<td>List of Organization Classifications</td>
</tr>
<tr>
<td>Payroll and Assignment Processes (Oracle Payroll form)</td>
<td>Action Type</td>
<td>List of Action Types (e.g. Run, Pre-payments, Reversal)</td>
</tr>
<tr>
<td>People Folder</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>People (PERWSEP), People and Assignment (PERWSHRG)</td>
<td>Person Function</td>
<td>Enter Employee, Enter Applicant, Hire people already on system</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Position Occupancy Folder</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>Run QuickPaint Report</td>
<td>QuickPaint Inquiry</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Assignments</td>
<td>Assignment Sets, Assignments</td>
</tr>
<tr>
<td>Special Information</td>
<td>Special Information Type</td>
<td>User defined</td>
</tr>
<tr>
<td>View Element Entry History for Employee</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

Table 27 – 1 List of Customizable Forms

Types of Data Restrictions

You can restrict the information that appears in a customized form by the following sorts of criteria:

- element type (recurring or nonrecurring)
- element set (user defined)
• person function (enter employee, enter applicant, hire someone on system)
• person type (user defined)
• special information type (user defined)
• organization classification
• employee or applicant
• QuickPaint Report (user defined)

If you want to restrict the data by a user defined information type, you must create it first:

• To restrict by element set, create the set in the Element and Distribution Set window.

• To restrict by QuickPaint Report, create the report in the Define QuickPaint Report window.

See: Defining QuickPaint Reports: page 23 – 9

• To restrict by Special Information Type, define your information type as an instance of the Personal Analysis key flexfield.

See: Defining Special Information Types, Oracle Human Resources North American User’s Guide

• To restrict by person types, define your user person types in the Person Types window.

See: Defining Person Types: page 24 – 3

---

**Defining an Element or Distribution Set**

In the Element and Distribution Set window, you can select element classifications or individual elements to define a set. There are three types of set:

• Customization set: You can use a Customization set to restrict the elements that can be entered or viewed on a customized version of the Element Entries window.

• Run set: Oracle Payroll users can use a Run set to specify the elements to be processed in a payroll run.

• Distribution set: Oracle Payroll users can use a Distribution set to define the elements over which the costs of other elements are to be distributed.
To define an element or distribution set:

1. Enter a unique name for the set and select the Type: Distribution, Run, or Customization. Save your new set.

2. If you want to include all elements in a classification, choose the Classification Rules button.
   - In the Classification Rules window, select one or more classifications to include. Save the set and close this window. The elements in the classifications you choose are now listed in the Elements region.
   - If you want to exclude individual elements, place your cursor in the element’s row and choose the Exclude Element button.

3. If you want to include particular elements from other classifications, choose the Include Element button.
   - In the Elements window, select the element you want to include and choose the OK button.

   **Note:** After you include a particular element, you cannot go to the Classification Rules window and include the classification to which this element belongs.

4. Save your set.

5. If you want to see a list of the individual elements you have included or excluded from the set, choose the Element Rules button. The Element Rules window is view-only.
Defining Customized Forms

You can define customized versions of certain forms in the Form Customization window.

See: Table 27 – 1 List of Customizable Forms: page 27 – 4

**Note:** If you want to restrict access to query–only for a form, you do not need to create a customized version. Instead you create a new form function, setting the QUERY_ONLY parameter to YES.

See: Setting Up Query–only Access to Forms: page 27 – 19

To define a customized version of a form:

1. Select the name of the standard form in the Form to be customized field. All GUI Smart Client form names are prefixed by F4.
2. Enter the name of your new version in the Name field. This name is used when defining menus but it is not seen by users.
3. Select Enabled if you want the restrictions to come into effect. If you do not select this option, the customized version of the form behaves the same way as the standard version.
4. Enter the titles to appear in the new version of the form:
   - In the Standard Title field, enter the window title to be seen by users who can use the form for data entry and editing.
• In the Query Title field, enter the window title to be seen by
  users who have view-only access to the form.

5. Save your new version.

6. In the Restrictions block, select the Type and Value of the restriction
  you want to define. The types and values available depend on the
  form you are customizing.

Adding the Customized Form to a Menu or Task Flow

If you want to add the customized form to a task flow, you must create
a Task Flow Node for it.

If the customized form is called directly from the Navigator window,
your System Administrator must define a menu function to call the
form with the customization. The System Administrator can add this
function to any menu.

  Note: If you want to use a customized version of the People
  form, People Folder, or Assignment Folder to start a task flow,
you should define a new customized task flow node and then
define a menu function to call the task flow.

See Also

Calling Customized Forms and Task Flows from Menus: page 27 – 20
Linking Windows in Task Flows

To complete many tasks, users need to use more than one window. For example, to hire a new employee, users typically go from the Person window, to the Address window, to the Special Information window, to the Assignment window, and so on.

You can link these windows together in a task flow so that the user can choose a button to bring up each window in turn without returning to the menu. The first window in the task flow defines the context of the subsequent windows. For example, if the task flow begins with the People window, all subsequent information is entered for the person you enter or query in the People window.

You can include customized forms in task flows. For example, you might create a customized version of the People window that handles applicants only. Then you could use this customization in a recruitment task flow.

Oracle HRMS supplies a predefined task flow that includes all the windows that you can use in task flows. It is designed as a simple structure to use during implementation, not as a recommended structure for users.

Figure 27 – 2
Sequential Task Flow
Windows You Can Use in Task Flows

You can create your own task flows using the windows listed in Table 27–2, or customized versions of them. Some of these windows require the context of an assignment. This means that either the Assignment window or the Assignments Folder window or the Application window (for applicant assignments) must appear above them in the task flow.

All task flows must begin with one of the following forms:

- People and Assignment (PERWSHRG)
- People (PERWSEPI)
- People Folder (PERWSFPE)
- Assignments Folder (PERWSFAS)
- Job (PERWSDJT)
- Position (PERWSDPO)

**Attention:** Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), the Assignment window opens more quickly from the People window. We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

<table>
<thead>
<tr>
<th>Window</th>
<th>Context Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absence Detail</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Address</td>
<td>Person</td>
</tr>
<tr>
<td>Window</td>
<td>Context Required</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>Adjust Balances (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>Assignment (applicant)</td>
</tr>
<tr>
<td>Application</td>
<td>Person (applicant)</td>
</tr>
<tr>
<td>Assignment</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Assignment</td>
</tr>
<tr>
<td>Assignments Folder</td>
<td>None</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Element entry</td>
</tr>
<tr>
<td>Book Events</td>
<td>Person (employee or applicant)</td>
</tr>
<tr>
<td>Competence Profile</td>
<td>Person</td>
</tr>
<tr>
<td>Contact</td>
<td>Person</td>
</tr>
<tr>
<td>Costing</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Covered Dependents</td>
<td>Element entry</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Employee Tax Rules (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>External/Manual Payments (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>People Folder</td>
<td>None</td>
</tr>
<tr>
<td>People</td>
<td>None</td>
</tr>
<tr>
<td>Personal Payment Method</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Person</td>
</tr>
<tr>
<td>Picture</td>
<td>Person</td>
</tr>
<tr>
<td>Position</td>
<td>None</td>
</tr>
<tr>
<td>Position Occupancy</td>
<td>Position</td>
</tr>
<tr>
<td>Qualifications</td>
<td>Person</td>
</tr>
<tr>
<td>QuickPay (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Reverse Payroll Run (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
</tbody>
</table>

Table 27 – 2 Windows You Can Use in Task Flows
### Defining Task Flow Nodes

Each form in a task flow is a node. There are predefined nodes for every form that you can include in a task flow. However, if you create a customization of one of these forms, you must create a node for the customization before you can include it in a task flow.

You create nodes in the Define Task Flow Nodes window.
To create a task flow node:

1. Enter a name for the node. You select this name when you create a task flow containing the node. It is not visible to users.
2. Select the form that you customized. Leave the Block field blank.
3. Select the customization that you created.
4. Save the new node.
Defining Task Flows

You define task flows in the Define Task Flow window. If there is a similar existing task flow, you can copy it to form the basis of your new flow.

Including the Assignment Window in Taskflows

Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), means the Assignment window opens more quickly from the People window.

Attention: We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

When users move down a task flow from the combined form, the Assignment window remains visible in the background. They can return to the Assignment window by closing their current window. Therefore you should not define a button to call the Assignment window.

However, if you are defining a task flow to the Assignment window from any window except the People window, you should use the Assignment form (PERWSEMA). In this case you may wish to add an Assignment button to any forms below the Assignment window in the taskflow. This allows users to return to the Assignment window without going back to the top window.

Prerequisites

- First create nodes for any form customizations you want to include in the task flow.
To define a task flow:

1. Enter a name for the task flow and save it.
2. In the Node block, select the name of the node that you want to be the first form in the task flow.
3. For this node, select the Top Node check box.
4. Create a new record in the Node block and select another node. You must create all the nodes for the task flow before you can begin entering the navigation paths between them.
5. In the Navigation Options region, for each node, select the other nodes to which you can navigate.
6. Enter a sequence number to determine the order in which the navigation options appear as buttons (from left to right) along the base of the window or as options in a navigation list.
7. Select the Button check box for the navigation options that should appear as buttons. There is a limit on the number of buttons that can appear on each form. This number varies from form to form. The other options are displayed in a navigation list when the user chooses a button labelled Others. Or, if there is only one other option, this form displays when the user chooses a button labelled Next.
8. There is a default label that appears on buttons or in the navigation list for every form. You can override this with your own label.
If the label in the Define Taskflow window appears blue, this is the default value. It is a dynamic default: if the seeded value changes (for example, as the result of an upgrade), the label will be updated automatically in all task flows where it has not been overridden.

If the label appears black, the default value has been overridden. To re-inherit the default label, clear the field.

9. To define an access key (or keyboard shortcut) for a navigation option, precede the appropriate letter in the label with an ampersand (&). For example, to use ALT+P (in the Microsoft Windows environment) as the access key for the Picture window, enter the label &Picture.

**Note:** Do not use the following letters since they are used on the Oracle Applications menu: A, E, F, G, H, Q, S, W.

There is no validation to prevent the same letter being used more than once for a group of buttons.

10. Save the task flow.

**To copy an existing task flow:**

1. Query the existing flow and choose the Copy To button.
2. Enter the name of the new task flow and choose OK.
3. Query your new task flow and edit it as required.

**See Also**

Calling Customized Forms and Task Flows from Menus: page 27 – 20
Setting Up Navigation Menus

Users access standard windows, customized windows, and the first window in a task flow through the menu structure displayed in the Navigator window. Each responsibility is associated with a single menu structure. Using Function Security System Administrators can further restrict access to individual menu options.

By defining menus with function security for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices
- restrict users to query-only access to some or all windows

Each responsibility you define must be linked to one root menu, which is the list of menu options displayed when the Navigator window first opens.
The Default Menu Structure

The AutoInstall program creates a default menu structure for your HRMS product. This menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menu structure.

Using function security you can use this default menu for any number of responsibilities and restrict access to the default menu options. You can also define any number of new functions and menus to restrict the access of other users. To view the hierarchy of menus you have defined, you can run the Menu Structures Report.

The supplied menus give you access to all of the available submenus. However, a number of seeded functions are not enabled on these menus. You need to add them for the responsibilities that should have access to these functions:

- **HR View Medical**
  This function causes the Medical Information alternative region to display in the People window.

- **HR View Background**
  This function causes the Background Information alternative region to display in the People window.

- **HR View Rehire**
  This function causes the Rehire Information alternative region to display in the People window.

- **Salary Administration: Approve**
  This function enables the user to approve salary proposals in the Salary Administration window and the Salary Management folder.

Suggestions for Structuring Menus

Menus can be structured in different ways:

- following a sequence of tasks, such as:
  1. Define a Requisition and Vacancy
  2. Define a Recruitment Activity
  3. Enter Applicant Information

- by type, such as inquiry windows, in which case the grouping is important but the sequence is not
When you define a new menu you should start by drawing it out on paper. This will help you to decide the best structure and the best prompts and descriptions. Work from the lowest level of sub-menu to the highest and define the root menu as the last step in the sequence.

You can define as many submenus as you require under each menu option. We recommend that you restrict the number of menu levels to three because a menu structure with more levels is cumbersome to use.

Opening Multiple Forms

In most Oracle Applications, you can open multiple forms from the Navigator window without closing the form you already have open.

Attention: You must disable this feature on a menu structure that accesses Oracle HRMS task flows. To prevent the confusion of working with multiple effective dates, you should also disable this feature if your menu structure accesses Oracle HRMS datetracked forms.

To disable the Multiple Open Form feature:

1. Add a Function type menu entry to the top-level menu referenced by your new responsibility.
2. Select the function whose User Function Name and Function Name are:
   - Disable Multiform, Multisession
   - FND_FNDSCSGN_DISABLE_MULTIFORM
3. Save your changes.

See Also

Default Navigation Menus for HR with Payroll Responsibility: page A – 10
Menus
Oracle Applications System Administrator’s Guide
Menu Report
Oracle Applications System Administrator’s Guide

Setting Up Query–only Access to Forms

You can restrict access to query–only for all HR and Payroll forms on a menu by setting the user profile option HR:Query Only Mode to Yes.
You can set this profile for individual responsibilities or users, or at the site or application level.

If you want to give query–only access to some forms and full access to other forms, set the HR:Query Only Mode profile to No and use the parameter QUERY_ONLY=YES at form function level to restrict access to individual forms.

**Note:** You can set the parameter QUERY_ONLY=YES for a form function that also launches a task flow. In this case, specify two parameters in the Form Function window:

- QUERY_ONLY=YES
- WORKFLOW_NAME="taskflow name"

The entire task flow will be query–only, not just the first form.

To restrict access to query–only mode for an individual form:

1. In the Form Functions window, select the form and specify the parameter QUERY_ONLY=YES. If you want to specify other parameters for this form function, separate them with a space.
2. Enter a user function name to identify your new function, and save it.
3. In the Menus window, select your new function instead of the supplied form function.

### Calling Customized Forms and Task Flows from Menus

For certain options you must define menu functions that include a parameter in the Parameters field of the Form Functions window, as follows:

- If the menu entry calls a customized form, use the following parameter:
  - HR_CUSTOMIZATION = "customization name"
- If the menu entry calls the first form in a task flow, use the following parameter:
  - WORKFLOW_NAME = "task flow name"
- If the menu entry calls a form in query–only mode, use the following parameter:
  - QUERY_ONLY=YES
- If the menu entry calls the Define Rate form (PAYWSGEV), use the following parameter:
FORM_MODE = "grade" (for the Grade Rate window)
FORM_MODE = "spine" (for the Scale Rate window)

• If the menu entry calls the Payroll and Assignment Processes form (PAYWSACT – used in Oracle Payroll), use the following parameter:
  FORM_MODE = "assignment" (for the Assignment Processes window)
  FORM_MODE = "payroll" (for the Payroll Processes window)

If you need to specify more than one parameter for a form function, separate the parameters with a space.
Employees’ personal and pay–related information is highly sensitive. You must be able to reliably secure this information from unauthorized access by users of your Oracle Applications.

Oracle HRMS gives you a flexible approach to controlling access to records, windows, and functions. This means you can suit each employee’s level of access to his or her work responsibilities. You can partition data by organization, position, or payroll.

Management of security is normally part of the system administrator’s role. This chapter explains how to secure information in Oracle HRMS.
Security in Oracle HRMS

You can control users’ access to human resources information by record, window, and function.

You can restrict access to records of applicants and employees assigned to certain work structures. For example, you can give department managers access only to the records of the employees in their own department.

Further, within a given department, you can control access to records of employees at or above a certain level. For example, you can give a department’s administrator access to all department employee records except those of the manager and assistant manager. You do this by defining security profiles.

You can use the same security profiles to restrict the records accessed by a reporting user, who runs reports against the system but does not have online access through the Oracle HRMS forms.

You can also restrict access to certain information types. For example, you can create customized versions of some windows to restrict access to certain elements and person types.

Another important area of security is control over information change. For each group of employees sharing a responsibility, you can set up a menu controlling the windows to which they have access. If it is important to know who makes changes to information in certain windows, you can enable full data auditing for these windows.

You can specify which processes and reports a user can use by setting up security groups.

Access Control through User Responsibilities

You control access to Oracle HRMS through responsibilities that you create and assign to users of the system. Users can sign on to Oracle HRMS only through the responsibilities you give them. So their responsibilities control what they can see and do in the system.

A responsibility always includes a security profile and a menu structure. It may also include a security group. Optionally, you can restrict access to specific sub–menus or functions in your chosen menu.

- Security profiles determine the organizations, positions and payrolls whose applicant and employee records responsibility holders can access.
- Menu structures and functions control:
the particular windows a responsibility holder can access

whether he or she can perform data entry, change or deletion on these windows

You can produce customized versions of some Oracle HRMS windows. Each customized version allows access to a subset of certain types of information, such as person types, special information types, or elements. You define additional menu functions to call customized windows or task flows, and then you add these functions to a menu structure, which is linked to a responsibility.

- Security groups determine the group of processes and reports a responsibility holder can initiate. A security group is an optional component of a responsibility. If holders of a responsibility should not initiate any reports or processes, you do not include a security group in the responsibility.

For each responsibility, you must also define two user profile options:

- HR:Security Profile
- HR:User Type
Single and Multiple Responsibilities

You can develop as many different responsibilities as your enterprise requires. Typically, most employees need one responsibility only. However you can assign multiple responsibilities to users who need to:

- access applicant and employee records from two or more security profiles.
- use more than one menu structure to view or make changes to the records they can access.
- use more than one Oracle Application. For example, some people may use windows in both Oracle HRMS and Oracle General Ledger.
- access records for more than one Business Group. For example, an enterprise with international operations may have a US-based Business Group and a UK-based Business Group. A few of your employees might need access to both.

See Also

Setting User Profile Options: page 25 – 4

Security Profiles

The security profile attached to a responsibility determines which applicant and employee records are available to holders of that responsibility. You associate a security profile with work structures. The records of employees and applicants assigned to these work structures are then accessible to holders of the responsibility.

The work structures you can name in security profiles are:

- internal organizations and organization hierarchies. Organizations include structures like departments, sections, groups and teams. Each security profile allows access to one Business Group only.
- positions and position hierarchies. Positions are jobs performed within specified organizations, such as:
  - Clerk, Accounting Section (organization is Accounting Section and job is clerk)
  - Quality Control Technician (organization is Quality Control Group and job is technician)
- payrolls, such as Weekly Payroll, Monthly Payroll, or Sales Payroll.
Organizations and Organization Hierarchy

To set up a security profile that permits access to employee records of certain organizations only, you make use of organization hierarchies. You can build any number of additional hierarchies to meet your security requirements.

For example, suppose you build this Sales Organization hierarchy:

You can create a security profile that permits access to employee records throughout the sales organization. This profile references the Sales Organization hierarchy. It names the Sales Department as the highest organization in the hierarchy through which profile holders have access to employee records.

Next, you want the directors of the two sales regions to have access to all employee records in their region only. You create Eastern and Western Sales Director security profiles. These profiles also reference the Sales hierarchy. But, they name the Eastern and Western Regions, respectively, as the top organizations for these profiles’ access to employee records.

When you name an organization as the top organization, you specify whether it is inclusive or not. You must include the top organization if
you want holders of the profile to access records of people assigned to
the top organization.

Positions and Position Hierarchies

After establishing limits on record access using organization
hierarchies, you can further restrict access by means of position
hierarchies.

Suppose, for example, within the Sales Department, you want to give
the Sales Research Director access to her subordinates’ records only.
You can start by building the following Sales Positions Hierarchy:

Figure 28 – 3
Sales Positions Hierarchy

Now you create the Sales Research Director security profile. This
profile references the Sales Positions hierarchy and names the Sales
Research Director as the top position for access to employee records.
Security Profile: SALES RESEARCH DIRECTOR

Organization Hierarchy: Sales Organization
Top Organization: Sales Department
Position Hierarchy: Sales Positions
Top Position: Sales Research Director
Include Top Position: Yes

When you give the Sales Research Director a responsibility including this security profile, she can access the records of her subordinates. But, she cannot access records of:

- the VP or Associate VP of Sales
- the Regional Sales Director
- the Regional Sales Director’s subordinates.

As with organization hierarchies, you can specify that profiles do not include access to the top position.

Payrolls

The third way to restrict access to employee records is by payroll. For example, you can give payroll staff who work on the Sales payroll access to records of employees on this payroll only.

Controlling security by payroll assignment limits the employee records users can see and update on employee-related windows, such as those for employee information, and element entry.

Of course, if an employee assignment does not include a payroll, payroll security cannot apply to this assignment. Payroll security never applies to applicant records since applicants are not assigned to payrolls.

The windows for compensation definition are unrelated to any particular employee records or payroll assignments. Therefore limiting access by payroll does not affect users’ access to these windows.

See Also

Database Access Without Online Access

You may need to set up access restrictions for employees who never use Oracle HRMS windows and do not change database information, but do access the database. These individuals are reporting users. A reporting user can use Oracle reporting tools to access database information for reports. A reporting user can report on, or query, the information in the HRMS database, but cannot insert, update, or delete that information.

You can make any of your security profiles available not only for regular Oracle HRMS users, but also for reporting users. The security profile restricts a reporting user’s access to employee records in exactly the same way as it limits regular users’ access.

Menu Structures

Each responsibility includes a security profile to restrict users’ access to employee records. It also includes a menu structure to restrict the windows users can access, and what they can do on these windows.

By using different menu structures and functions for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices

Menu functions can include:

- standard windows, displayed in edit or view-only mode
- customized windows, on which you have restricted the range of data that can be displayed
- the first window in task flows that link a number of windows that are used in sequence to complete a task

The AutoInstall program creates the default menu structure for your Oracle HRMS product. You can run a report to produce a listing of this structure.

The default menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menus. You can define any number of new functions and menus to restrict the access of other users.
See Also

Setting Up Navigation Menus: page 27 – 17

Security Groups

When you build a responsibility for employees who must initiate reports or processes, you can attach a security group to the responsibility. The security group lists a group of processes and reports its holders can run. Holders of responsibilities with no security groups cannot run any processes or reports.

The seeded groups US/UK HRMS Reports and Processes give access to all predefined reports and processes.
Setting Up Security in Oracle HRMS

Figure 28 – 4 depicts the relationship between the security items you define when you set up security for Oracle HRMS.

The key definition is the responsibility, which allows access to the records specified by the security profile, using the windows specified by the menu structure, and the reports and processes specified by the report security group.

At most, one responsibility can see all records for one Business Group. When you create a new Business Group, a view–all security profile is automatically created. It provides access to all employee records, and all applicant records in the Business Group. The system administrator creates a responsibility that includes this view–all security profile, then assigns this responsibility to the users who are setting up the system. They in turn can set up security profiles for other users.
To set up a new responsibility for Oracle HRMS:

2. Set up any new functions or menus required for the responsibility. For menu functions calling customized forms or task flows, you must enter a parameter in the Parameter field of the Form Functions window.

3. Define the new responsibility.
4. Create usernames and passwords related to the new responsibility. A username can be related to more than one responsibility.
5. Set the HR User Profile Options for the new responsibility. The options you must set are:
   - HR:Security Profile
   - HR:User Type
   You can set other User Profile Options.
6. Run the HRMS security processes

Security for Reporting Users

Reporting users do not have online access to the database through Oracle HRMS forms. They use Oracle reporting tools to prepare reports on the information to which their security profiles grant access.

All secure users connect to the APPS ORACLE ID. This is created when the system is installed. However, for reporting users, you should create one or more new reporting user ORACLE IDs and associate each with a restricted security profile.

The first step in this procedure is the job of the ORACLE database administrator. The other steps are normally done by the system administrator.

To set up a new reporting user:

1. Create a new reporting user ORACLE ID.
2. Register the new ORACLE ID with Application Object Library.
3. Using a view–all responsibility, define a security profile in the Security Profile window for the new ORACLE ID.
4. Run the HRMS security processes
   See: Running the HRMS Security Processes: page 28 – 15
Defining Security Profiles

Using a view–all responsibility, you can define security profiles in the Security Profile window.

Prerequisites

- If you want to associate a reporting user with the new security profile, the ORACLE database administrator must create a new reporting user ORACLE ID. The system administrator must register the new ORACLE IDs with the Application Object Library.

To define a security profile:

1. Enter a name for the security profile and select a Business Group. This does not need to be the Business Group you are logged on to.

2. If you want reporting users to be able to use this security profile, select the Reporting User name for the ID set up by the database administrator.

3. Uncheck the View All Employees and View All Applicants check boxes if you want to restrict access to these person types by organizations, positions, or payrolls.

4. To restrict access by organization, uncheck the View All Organizations check box. Select an organization hierarchy, and a
top organization. Check the Include Top Organization check box if you want to allow access to this organization.

5. To restrict access by position, uncheck the View All Positions check box. Select a position hierarchy, and a top position. Check the Include Top Position check box if you want to allow access to this position.

6. In the Payroll Security alternative region:
   • To give access to many payrolls, check the View All Payrolls check box, and uncheck the Include check box. Select the payrolls you want to exclude.
   • To give access to a small number of payrolls, uncheck the View All Payrolls check box, and check the Include check box. Select the payrolls to include.

7. Save your work.
Running the HRMS Security Processes

There are three HRMS security processes:

- Run the Grant Permissions To Roles process when you install Oracle HRMS, or when you upgrade the system.
- Run the Generate Secure User process when you create a new security profile that references a reporting user.
- Run the Security List Maintenance process every night.

You run these processes using a system administrator responsibility from the Submit Requests window.

Grant Permissions To Roles Process (ROLEGEN)

All reporting users in Oracle HRMS share access to a set of synonyms for tables. The synonyms are created by the Autoinstall process. You must run the Grant Permissions To Roles process to create the public grants to make those synonyms usable.

Run this process when you install Oracle HRMS, or when you upgrade the system. You must run this process before you run the Generate Secure User Process for the first time.

The process grants SELECT permissions to the role "hr_reporting_user". Permissions are not granted on the secured tables, but only on the secure views of those tables. All permissions previously granted to the role are revoked.

Generate Secure User Process (SECGEN)

This process grants permissions to new reporting users. It grants the "hr_reporting_user" role to the REPORTING_ORACLE_USERNAME specified in the security profile.

Run this process when you have created a new security profile that references a reporting user. In the Submit Requests window, select the name of the new security profile. This is the only parameter to the process.

Security List Maintenance Process (LISTGEN)

This process maintains the lists of organizations, positions, payrolls, employees and applicants that security profile holders can access. You should schedule it to run every night to take account of changes made during the day. If a disruption, such as a power cut, occurs while the
process is running, you can manually restart it from the Submit Requests window.

There is one required parameter for this process: Effective Date, which should normally be set to SYSDATE. You can also enter a security profile name to generate list entries for that security profile only.

**Attention:** LISTGEN should normally run when there are no users logged on to Oracle HRMS. Users attached while LISTGEN is running may experience unexpected results; for example, additional employees may become visible or previously visible employees may disappear from view.
QuickCodes and User Tables

QuickCodes provide lists of valid values on certain fields throughout the system. For many types of code you can add your own values and change the values that are predefined. You can also set up your own types of QuickCode.

You can set up user tables to provide matrices of valid values that vary according to a factor such as age, or job, or number of years service. You can access these values from formulas, or your own forms or reports, using a supplied function.

This chapter explains how to set up QuickCode Types and how to add values to predefined QuickCodes. It lists the predefined QuickCodes to which you can add values. It also explains how to set up user tables and enter values for the rows and columns you define.
QuickCodes

Providing lists of valid values for certain items of information has two key advantages:

- It ensures that all users use the same terminology, which makes it easier to inquire and report on the information.
- It speeds up data entry because you can enter just enough to identify the value, and the system completes the entry.

In Oracle HRMS, a list of values is called a QuickCode Type. Each value comprises a code and a meaning. For example:

<table>
<thead>
<tr>
<th>QuickCode Type</th>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES_NO</td>
<td>Y</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>No</td>
</tr>
</tbody>
</table>

The codes are used internally; users do not see them. There is a maximum of 250 QuickCodes for each QuickCode Type.

Predefined QuickCode Types

A number of QuickCode Types are included in Oracle HRMS. Some contain codes as startup data. You can never delete these codes, but you can change their meaning. For some QuickCode Types, you can also disable the codes that are supplied. Your ability to disable codes and add new codes is determined by the access level of the QuickCode Type:

- **User**
  - You can add codes and you can disable supplied codes.

- **Extensible**
  - You can add new codes, but you cannot disable supplied codes because the system uses them.

- **System**
  - You can neither add codes nor disable supplied codes. You can only change the meaning or description of supplied codes.

Table 29 – 1 lists the predefined QuickCode Types with an access level of User or Extensible.

You can also create your own QuickCode Types in the QuickCode Type window. These all have an access level of User.
Adding QuickCode Values

To add, disable, or change the meaning of a QuickCode, use the QuickCodes window.

To add QuickCodes:
1. Query the QuickCode Type to which you want add a value.
   You cannot add values if the Access Level is System.
2. Enter a code and meaning. Optionally, enter a start and end date.
   If you do not enter a start date, the new QuickCode is valid immediately. If you do not enter an end date, the new QuickCode is valid indefinitely.

Removing QuickCode Values

You cannot delete QuickCodes after saving them, but you can stop them appearing in lists of values.

To remove a user defined QuickCode:
- In the QuickCodes window, do one of the following:
  • Disable the code by unchecking the Enabled check box if you want to prevent users selecting this value on any date.
  • Enter an end date if you want to prevent users selecting this value after a certain date.
• Change the meaning and description to create a replacement QuickCode.

If you disable the QuickCode or set an end date, users cannot select this value when they create new records. However, they can continue to see the value when they query records that contain it.

If you add, disable, or change the meaning of a QuickCode, users must log out and log back in again for your changes to take effect.
Defining QuickCode Types

You can create your own QuickCode Types to provide lists of values, for example to validate element entries.

Define the new type in the QuickCode Types window, then query it in the QuickCodes window to define the values that appear in lists.

To define a new QuickCode Type:

1. Enter the name and meaning of your new type.
2. Save your work.
3. Optionally, choose the Usages button and select other Oracle Applications in which you want to use this new QuickCode Type.
### User and Extensible QuickCodes

<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category (absence)</td>
<td>ABSENCE_CATEGORY</td>
</tr>
<tr>
<td>Reason (for absence)</td>
<td>ABSENCE_REASON</td>
</tr>
<tr>
<td>Account Type (for bank details)</td>
<td>ACC_TYPE</td>
</tr>
<tr>
<td>Address Type</td>
<td>ADDRESS_TYPE</td>
</tr>
<tr>
<td>Reason (for application assignment status)</td>
<td>APL.Assign.REASON</td>
</tr>
<tr>
<td>Type (event type for applicant)</td>
<td>APL_EVENT_TYPE</td>
</tr>
<tr>
<td>Type (interview type for applicant)</td>
<td>APL_INTERVIEW_TYPE</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>APL_SEC_ASSIGN_REASON</td>
</tr>
<tr>
<td>Appraisal and Assessment Status (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL.ASSESSMENT_STATUS</td>
</tr>
<tr>
<td>Appraisal and Assessment Type (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL.TYPE</td>
</tr>
<tr>
<td>State (Australian addresses)</td>
<td>AU_STATE</td>
</tr>
<tr>
<td>Blood Type</td>
<td>BLOOD_TYPE</td>
</tr>
<tr>
<td>Measurement Type (for budget)</td>
<td>BUDGET_MEASUREMENT_TYPE</td>
</tr>
<tr>
<td>Cash Analysis (for a cash payment)</td>
<td>CASH_ANALYSIS</td>
</tr>
<tr>
<td>Census Metropolitan Area (Canada)</td>
<td>CA_CMA</td>
</tr>
<tr>
<td>Province (Canadian addresses)</td>
<td>CA_PROVINCE</td>
</tr>
<tr>
<td>Method</td>
<td>CERTIFICATION_METHOD</td>
</tr>
<tr>
<td>User friendly names for cheque–ordering SQL statement</td>
<td>CHEQUE.PROCEDURE</td>
</tr>
<tr>
<td>User friendly names for cheque–writing SRW2 reports.</td>
<td>CHEQUE_REPORT</td>
</tr>
<tr>
<td>Primary Evaluation Method</td>
<td>COMPETENCE_EVAL_TYPE</td>
</tr>
<tr>
<td>Competence Type</td>
<td>COMPETENCE_TYPE</td>
</tr>
<tr>
<td>Type (relationship of one person to another)</td>
<td>CONTACT</td>
</tr>
<tr>
<td>Type (of MIX batch control total)</td>
<td>CONTROL_TYPE</td>
</tr>
</tbody>
</table>

*Table 29 – 1 User and Extensible QuickCodes*
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason (for element entry)</td>
<td>ELE_ENTRY_REASON</td>
</tr>
<tr>
<td>Reason (for employee assignment)</td>
<td>EMP_ASSIGN_REASON</td>
</tr>
<tr>
<td>Employment Category</td>
<td>EMP_CAT</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>EMP_SEC_ASSIGN_REASON</td>
</tr>
<tr>
<td>Ethnic Origin</td>
<td>ETH_TYPE</td>
</tr>
<tr>
<td>System (job or position evaluation system)</td>
<td>EVAL_SYSTEM</td>
</tr>
<tr>
<td>Measurement In (type for EVAL SYSTEM)</td>
<td>EVAL_SYSTEM_MEAS</td>
</tr>
<tr>
<td>Type (of formula)</td>
<td>FORMULA_TYPE</td>
</tr>
<tr>
<td>Authority (for PAYE details)</td>
<td>GB_AUTHORITY</td>
</tr>
<tr>
<td>Bank Name</td>
<td>GB_BANKS</td>
</tr>
<tr>
<td>Certificate (for element NI)</td>
<td>GB_CERTIFICATE</td>
</tr>
<tr>
<td>Cheque Style</td>
<td>GB_CHEQUE_REPORT</td>
</tr>
<tr>
<td>County (UK addresses)</td>
<td>GB_COUNTY</td>
</tr>
<tr>
<td>Pension</td>
<td>GB_PENSION</td>
</tr>
<tr>
<td>Sequence (for the BACS process)</td>
<td>GB_SORT_SEQUENCE</td>
</tr>
<tr>
<td>Reason (for leaving)</td>
<td>LEAV_REAS</td>
</tr>
<tr>
<td>Marital Status</td>
<td>MAR_STATUS</td>
</tr>
<tr>
<td>Nationality</td>
<td>NATIONALITY</td>
</tr>
<tr>
<td>Name (of organization classification)</td>
<td>ORG_CLASS</td>
</tr>
<tr>
<td>Organization Type</td>
<td>ORG_TYPE</td>
</tr>
<tr>
<td>Minimum Service</td>
<td>PER_LENGTHS_OF_SERVICE</td>
</tr>
</tbody>
</table>

Table 29 – 1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relocation</td>
<td>PER_RELOCATION_PREFERENCES</td>
</tr>
<tr>
<td>Status</td>
<td>PER_SUBJECT_STATUSES</td>
</tr>
<tr>
<td>Subject</td>
<td>PER_SUBJECTS</td>
</tr>
<tr>
<td>Work Duration</td>
<td>PER_TIME_SCALES</td>
</tr>
<tr>
<td>Tuition Method</td>
<td>PER_TUITION_METHODS</td>
</tr>
<tr>
<td>Work Hours</td>
<td>PER_WORK_HOURS</td>
</tr>
<tr>
<td>Work Schedule</td>
<td>PER_WORK_SCHEDULE</td>
</tr>
<tr>
<td>Rating</td>
<td>PERFORMANCE_RATING</td>
</tr>
<tr>
<td>Type</td>
<td>PHONE_TYPE</td>
</tr>
<tr>
<td>Reason (for grade step placement)</td>
<td>PLACEMENT_REASON</td>
</tr>
<tr>
<td>Status</td>
<td>POSITION_STATUS</td>
</tr>
<tr>
<td>Source of Proficiency Rating</td>
<td>PROFICIENCY_SOURCE</td>
</tr>
<tr>
<td>Reason (for salary proposal)</td>
<td>PROPOSAL_REASON</td>
</tr>
<tr>
<td>Units (qualifying units for probation period)</td>
<td>QUALIFYING_UNITS</td>
</tr>
<tr>
<td>Prefix</td>
<td>TITLE</td>
</tr>
<tr>
<td>Accrual Start</td>
<td>US_ACCRUAL_START_TYPE</td>
</tr>
<tr>
<td>Status of request for accommodation</td>
<td>US_ADA_STATUSES</td>
</tr>
<tr>
<td>Coverage Level (for medical, dental and vision</td>
<td>US_BENEFIT_COVERAGE</td>
</tr>
<tr>
<td>benefit plans)</td>
<td></td>
</tr>
<tr>
<td>Status (of continued coverage)</td>
<td>US_COBRA_STATUS</td>
</tr>
<tr>
<td>Reason (for COBRA Termination)</td>
<td>US_COBRA_TERM_REASON</td>
</tr>
<tr>
<td>Category (within Earnings classification)</td>
<td>US_EARNINGS</td>
</tr>
<tr>
<td>Category (within Imputed Earnings classification)</td>
<td>US_IMPUTED_EARNINGS</td>
</tr>
<tr>
<td>Category (within Information classification)</td>
<td>US_INFORMATION</td>
</tr>
<tr>
<td>Category (within Involuntary Deductions</td>
<td>US_IN Voluntary_DEDUCTIONS</td>
</tr>
<tr>
<td>classification)</td>
<td>US_JOB_GROUPS</td>
</tr>
</tbody>
</table>

Table 29 – 1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filing Status for local income tax</td>
<td>US_LIT_FILING_STATUS</td>
</tr>
<tr>
<td>Exemption Reason (for excluding employee from New Hire report)</td>
<td>US_NEW_HIRE_EXCEPTIONS</td>
</tr>
<tr>
<td>Category (within Nonpayroll Payments classification)</td>
<td>US_PAYMENT</td>
</tr>
<tr>
<td>Category (of accrual plan)</td>
<td>US_PTO_ACCRUAL</td>
</tr>
<tr>
<td>Filing Status for state income tax</td>
<td>US_SIT_FILING_STATUS</td>
</tr>
<tr>
<td>State (US addresses)</td>
<td>US_STATE</td>
</tr>
<tr>
<td>Category (within Supplemental Earnings classification)</td>
<td>US_SUPPLEMENTAL_EARNINGS</td>
</tr>
<tr>
<td>Row Type (for Payroll Tables)</td>
<td>US_TABLE_ROW_TYPES</td>
</tr>
<tr>
<td></td>
<td>US_TAX_REPORT</td>
</tr>
<tr>
<td>Category (within Voluntary Deductions classification)</td>
<td>US_VOLUNTARY_DEDUCTIONS</td>
</tr>
<tr>
<td>Position of WC surcharge (after experience modifications and after premium discount)</td>
<td>US_WC_SURCHARGE_POSITION</td>
</tr>
<tr>
<td>Status (of a vacancy)</td>
<td>VACANCY_STATUS</td>
</tr>
<tr>
<td>Availability Schedule</td>
<td>WORK_SCHEDULE</td>
</tr>
</tbody>
</table>

Table 29 – 1 User and Extensible QuickCodes
User–defined Tables

You may need to set up your own tables in your Oracle HRMS system, to hold data such as wage codes, shift differentials, or the amounts of certain deductions. You can set up all the tables you require using the Table Structure window. Using Oracle FastFormula, you can write simple formulas for validating entries made in table columns.

Your Oracle HRMS startup data includes some predefined user tables that are either ready to receive entries, or that already have some entries.

Attention: You do not use the Table Structure window to set up tables holding information on medical, dental or vision benefit plans (benefits with the benefits classification Medical, Dental or Vision).

The Oracle HRMS database includes a special table, the Benefits Table, already set up to hold information on benefit plans with coverage levels, and the employee and employer contributions at each level. To enter information into this table you use the Benefit Contributions window.


Notice that the Oracle HRMS user–defined tables are different from the database tables of the Oracle Relational Database Management System. When you set up a user table, you define the rows as well as the columns, like a matrix. For example, you could set up a table showing bonus amounts (the column) against years of service (the rows).

Entering and Accessing Table Values

To enter values in tables, you use the Table Values window. Table entries and rows are both datetracked, so you can delete existing entries or rows, and add new ones, as of an effective date.

Oracle HRMS provides the GET_TABLE_VALUE function to access table values. You can yourself write formulas that include calls to this function, perhaps for QuickPaint inquiries. Also, it is easy for MIS personnel to write PL/SQL statements that call this function, to include in the code for a form or report process, for example.

The formulas for the predefined earnings types Regular Wages, Overtime, Shift Pay and GTL Imputed Income all include calls to this function, as do the formulas the system generates for deductions with the amount rule Payroll Table.
Row Types for Payroll Tables

Tables set up to hold deduction amounts are called payroll tables. You need a payroll table when the amount of a deduction varies in accordance with a factor such as employee age, pay or job class.

To initiate a deduction with the amount rule Payroll Table, you must establish a row type. The formula for the deduction uses the row type to help determine which row of the table to go to for each employee’s deduction amount. Your startup data includes three predefined row types: Age Range, Salary Range and Job Class. You can set up any additional types you require.

See Also

Setting Up Row Types for Payroll Tables, Oracle Payroll User’s Guide
Functions, Oracle FastFormula User’s Guide

Predefined User Tables

Oracle HRMS supplies the following tables, already defined using the Table Structure window:

COMPANY WORK SCHEDULES Table

This table has several commonly-used work schedules already entered in it, and you can add more. A work schedule shows the hours employees normally work each day from Monday through Sunday. For example, employees with the schedule 10–10–10–0–0–0–0 work 10 hours each day Monday through Thursday, and have Friday, Saturday and Sunday off.

Each column in this table holds a separate schedule, with each row holding the hours worked each day of the week for the schedule. For convenience, each column header names the schedule held in the column. For example, the header for the column holding the first schedule is 1 Schedule: 8–8–8–8–8–0–0.

GTL PREMIUMS Table

For use in Oracle Payroll, this table holds the cost of Group Term Life insurance premiums per $1,000 of coverage by age range, as maintained in the IRS Uniform Premiums table. The table rows hold
age ranges, and its single column holds the premium for each $1,000 of coverage for each age range.

Oracle Corporation provides you with updates to the GTL Premiums table, which your system administrator applies.

The predefined imputed earnings GTL Imputed Income references this table in its processing.

**SHIFT DIFFERENTIALS Table**

This table has no data already in it, but is ready for your data entry. Its rows hold the shift designators Day, Eve, Night and Split, representing the normal shifts employees work, and its columns have the same headings, for entry of differentials. You can add to or change the shift designators as necessary.

To look at examples of differentials entries, suppose day shift employees receive one and one-half times their regular pay when temporarily working the evening shift, twice their regular pay for the night shift, and three times their regular pay for the split shift. You enter 1.5, 2.0 and 3.0 as the differentials for day shift workers.

**Example Shift Differentials Table**

<table>
<thead>
<tr>
<th></th>
<th>D</th>
<th>E</th>
<th>N</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td></td>
<td>1.5</td>
<td>2.0</td>
<td>3.0</td>
</tr>
</tbody>
</table>

The predefined earnings types Regular Wages and Shift Pay reference this table in their processing in Oracle Payroll.

**WAGE RATES Table**

This table has no data in it when you receive your system, but is ready for your data entry. Its rows hold rate codes, and its single column holds the rate matching each code. This example holds codes for rates associated with the operation of different types of equipment:

**Example Wage Rates Table**

<table>
<thead>
<tr>
<th>Rate Code</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL (forklift)</td>
<td>6.80</td>
</tr>
<tr>
<td>A3 (crane A3)</td>
<td>8.20</td>
</tr>
<tr>
<td>A7 (crane A7)</td>
<td>9.00</td>
</tr>
</tbody>
</table>

Oracle Payroll’s predefined earnings types Regular Wages, Overtime, and Shift Pay reference this table in their processing.
See Also

Setting Up User Tables: page 29 – 14
Setting Up User Tables

You set up user tables in the Table Structure window.

Prerequisites

- Plan what your table rows and columns will contain, and whether you will use formulas to validate table column entries.
- If you plan to use formulas to validate entries into the table columns, write these formulas and enter them in your database.
  

- If you are setting up a payroll table holding amounts of a deduction, check whether you need to set up a row type for the table.

  See: Setting Up Row Types for Payroll Tables: page 16–14

To set up the structure of a table:

1. Set your effective date to the date from which you want the table’s row labels to take effect.
2. Enter the table name.
3. For the table’s match type, select Match or Range. Select Match if each row is for one item, such as one job or one code. Select Range if each row is for a range of numeric values, such as an age range or a pay range.
4. If the match type is Match, select Date, Number or Text as the Key Units of Measure, depending on whether entries in the rows are dates (DD–MON–YYYY), numbers, or alphanumeric text.

   If the table’s match type is Range, the Key Units of Measure automatically becomes Number.
5. Enter the row label as the Row Title.
   For example, if the table rows refer to rate codes, an appropriate row title would be Rate Code. If the rows refer to age ranges, you might use the title Age Range.

6. Save your work, and choose the Columns button to go to the Columns window.

   ![Columns Window](image)

   **To enter column labels:**
   1. Enter labels for the table columns in the Name field. To add a new column to a table that already exists, place the cursor on the name of the column after which you want to enter the new column name, and choose Insert Record from the Edit menu to obtain a clear field.
   2. If you are using formula validation for a column’s entries, select the name of the validation formula for the column.
   3. Save your work and close the window. In the Table Structure window, choose the Rows button to go to the Rows window.
To enter row labels:

1. If the match type of the table is Match, enter the label for each table row in the fields under the heading Exact.
   
   If the match type of the table is Range, enter numbers representing the lower and upper boundary of each row’s range.
   
2. In the Sequence fields, you can optionally enter a number for each row label to determine the order in which it appears on a list in the Table Values window. Logical sequencing of row labels helps users enter table values rapidly and accurately.
   
3. When you are finished, save your work and close the window. Your table is now set up and ready to receive entries into its columns.
Entering Table Values

If you have set up user-defined tables, you can enter and maintain values in the Table Values window.

Note: The system administrator can create customized versions of the Table Values window so that you use each version for one user table only.

Prerequisite

Before you can enter values into a table’s columns, the table with its columns and rows must be completely set up.

To enter values into table columns:

1. Set your effective date to the date from which you want the entries to take effect.
2. Query the table name.
3. With the cursor in the Column Name field, use the up and down arrows to locate the name of the column in which you want to make entries.
4. In the Values region, select each row for which you want to make an entry. You select rows in the Exact field or the Lower Bound field, depending on the match type of the table.
5. For each row, make the appropriate entry in the Value field.
6. Save your work.
Integrating With Other Systems

Oracle Human Resources can be integrated with a number of Oracle and third party products. This chapter explains how to set up Oracle Human Resources to integrate with the following products.

- Oracle Payroll
- spreadsheets

It also explains how to attach text, images, OLE objects, and Web pages to individual records.
Using Oracle Human Resources with Oracle Payroll

Oracle Human Resources and Oracle Payroll are available for purchase together as the components of a closely integrated human resources management system. This system combines Oracle Human Resources and Oracle Payroll windows under a single menu structure, sharing windows and underlying tables wherever possible to eliminate redundant data entry, maintenance and storage.

For Oracle Human Resources or Oracle Payroll, you enter and maintain the same fundamental human resource information about your structure and operations, your employees and their assignments, and employee compensation and benefits. You then add the specialized information you need specifically for human resources or payroll management and administration.

Shared Information in Oracle HRMS

The common core of fundamental information used by both human resources and payroll managers and staff includes:

- **Your operational basics:**
  - payrolls with their calendars and pay periods
  - the currencies and methods of payment you use

- **Your organizational structure:**
  - internal organizations, such as companies, divisions, departments, work groups, or production team
  - external organizations of key importance to you, such as employment agencies, tax authorities, or union headquarters
  - organization location information, including addresses and telephone numbers
  - hierarchies showing the relationships between your organizations
  - any grade and grade scale structures you use

- **Your employees’ essential personal information,** such as:
  - name and address
  - marital status
  - birth date
  - nationality
- ethnic origin
- **Your employees’ current work statuses**, such as:
  - active assignment
  - on maternity leave
  - terminated
- **Your employees’ assignments to:**
  - internal organizations
  - grades, or grades and grade steps
  - groups having a compensation-related factor in common, such as membership in an insurance or pension plan or participation in an employee stock purchase plan
  - jobs, or jobs and positions
  - payrolls
- **Elements of your employees’ pay and benefits:**
  - *earnings* such as salary, wages, commissions, bonuses, allowances
  - *employer charges* such as employer contributions to legislatively-mandated or private insurance or pension plans
  - *deductions* such as contributions for union dues or employee stock purchase plans
  - *nonpayment benefits* such as vacation time or a company car

### Shared Windows in Oracle HRMS

While many of the windows in your system relate exclusively to the human resources or payroll function, some include information relevant to both functions. These latter windows are *shared* windows.

Shared windows can include some information fields relevant to both human resources and payroll users, and other fields for information specific to either human resources or payroll users but not both.

### Using Shared Windows

You can control the use of fields on shared windows by the value your system administrator gives to each user or responsibility for the HR:User Type profile option. The three valid values are:
• HR with Payroll User
• HR User
• Payroll User

Users with an *HR User* profile are restricted in their use of fields on certain windows. In particular:

• they do not see certain fields on the Element window, which are only required if you are processing elements
• they cannot assign employees to a payroll if both Oracle Payroll and Oracle Human Resources are installed
Using Oracle HRMS with Spreadsheets

Spreadsheets are commonly used in many enterprises to provide managers and other users with a powerful modelling and analysis tool. Often it is the ability to represent complex numeric data in a simple graphical format that makes them so popular.

You can use Oracle Application Data Export (ADE) to download information from the HRMS database to a spreadsheet for analysis and manipulation. For example, you can download data on current and proposed salaries for a group of employees. You can adjust the salary proposals in the spreadsheet, or enter new ones, and upload the revised data to the database. The ADE upload process reports any errors and ensures that only valid data is saved in the database.

To download information from a form to a spreadsheet using ADE, your system administrator needs to create a style in ADE. The style defines the form it is used for, the responsibilities that can use it, and the columns (or fields) to be downloaded. You determine which records are downloaded by running a query in the form before launching ADE.

A style for downloading salary proposals is predefined.

See Also

Application Data Export Online Help
Using Attachments

You can attach short comments, word processed documents, images, video, OLE objects, or Web pages to many records in Oracle HRMS. For example, you could attach a resume to an applicant record and a position description to a position record.

Each record can have one or more attachments, and you can copy attachments from one record to another. You can store the attachments in the database or in your file system.

You view or add new attachments by clicking the Attachments icon. By default, clicking the attachments icon displays a Comments window where you can enter text up to 2000 characters. This is the Comments facility available in earlier releases of Oracle HRMS. If you want to replace this facility with the ability to attach multiple items, ask your system administrator to set your user profile option HR:Use Standard Attachments to Yes.

The HRMS entities that support attachments are as follows:

- Absence
- Absence Type
- Address
- Application
- Assignment
- Balance (Oracle Payroll)
- Batch Header
- Benefit
- Booking
- Budgets
- Budget Version
- Calendar
- Career Path
- Cobra Coverage Status
- Cobra Enrollment
- Cobra Payment
- Consolidation Set (Oracle Payroll)
- Contact Relationship
• Customization
• Element
• Element Entry
• Element Link
• Element Set
• Event
• Grade
• Grade Rate
• Job
• Job Evaluation
• Job Requirement
• Letter Type
• Monetary Unit (Oracle Payroll)
• Organization
• Organization Payment Method
• Organization Hierarchy
• Pay Scale
• Payroll Process (Oracle Payroll)
• Period of Service
• Person
• Person Analysis/Special Information
• Personal Payment Method
• Position
• Position Hierarchy
• Recruitment Activity
• Requisition
• Salary Basis
• Salary Proposal
• Salary Proposal Component
• Secondary Assignment Status
• Special Information Type
• Status Processing Rules (Oracle Payroll)
• Vacancy
• Valid Grade
• WC Fund

See Also

Working With Attachments
Oracle Applications User’s Guide
Setting User Profile Options: page 25 – 4
Using Letters to Manage Recruitment and Enrollment

You can use standard letters to help you to manage your enterprise’s recruitment or enrollment activities. You do this by issuing standard letters to applicants (Oracle Human Resources) or to students (Oracle Training Administration), triggered by changes in assignment or enrollment status. For example, you can set up a standard enrollment confirmation letter that is triggered when a student’s enrollment status is set to Placed or you can set up a rejection letter that is triggered when an applicant’s assignment status is set to Rejected.

Here are a few examples of letters you can set up to help you to manage your enterprise’s recruitment or enrollment activities:

<table>
<thead>
<tr>
<th>Oracle Human Resources</th>
<th>Oracle Training Administration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgement letters (for all active applications)</td>
<td>Acknowledgement letters (for all requested enrollments)</td>
</tr>
<tr>
<td>Confirmation letters (for interviews)</td>
<td>Confirmation letters (for placed enrollments, including event joining instructions based on the date, venue, and trainers)</td>
</tr>
<tr>
<td>Reports for interviewers and schedules</td>
<td>Reports for trainers (listing the students to attend an event)</td>
</tr>
<tr>
<td>Offer and Rejection letters (for applicants)</td>
<td>Chase–up letters (for non–response or non–payment)</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement letters (for cancellations)</td>
</tr>
<tr>
<td></td>
<td>Certificates (of successful course completion)</td>
</tr>
</tbody>
</table>
Setting Up Standard Letters

Oracle HRMS provides you with two different methods to create standard letters:

- Concurrent Processing
- Online:
  - using Oracle Application Data Export (ADE)
  - using Object Linking and Embedding (OLE) to generate Microsoft Word letters only

Which Method Should You Use?

Use the online method, ADE or OLE, if you want to generate and review your letters immediately.

Alternatively, you can use the concurrent processing method to set up your standard letters. With concurrent processing, you can generate and review your letters without interfering with the other work you perform at your terminal. You can control when a concurrent process runs and schedule long-running processes to run at times when the system is lightly loaded. Another advantage of using concurrent processing is that you do not need Windows 95, Excel or Lotus 123 installed.

See: Concurrent Processing: page 30 – 12

Using ADE

You can use ADE to generate standard letters and reports. ADE retrieves data and exports it to a data file that is merged with a standard word processed document. The word processed document includes all the merge fields required to merge the data and the standard text for the letter. ADE is fully compatible with Microsoft Word 6.

You can use ADE to generate standard letters for recruitment or enrollment by performing a mail merge from the Request Letter window in your application.

If you want to use ADE to set up your standard letters instead of using the concurrent processing method, refer to the ADE documentation.

See: Application Data Export (ADE) Online Help

Using OLE

You can use Object Linking and Embedding (OLE) to generate Microsoft Word letters instead of using ADE, if required.
Attention: In future releases of Oracle HRMS, generating Microsoft Word letters using Object Linking and Embedding (OLE) will be replaced by ADE.

Concurrent Processing

There are two methods of using concurrent processing to set up your standard letters:

- Using word processors
- Using Oracle reports

Using Word Processors

You can use any word processor to produce standard letters from Oracle HRMS. If you use a word processor, you can submit a concurrent request in the Letter Request window to generate the mail merge file. When the concurrent request is complete, you can use your word processor’s mail merge facilities to create the merged letters.

See: Using a Word Processor: page 30 – 13

Using Oracle Reports

As an alternative to using a word processor to produce standard letters, you can use the Standard Letter and Label features of Oracle Reports. Use this method if you do not want to use word processors to print your letters (or if you do not have word processors).

See: Using Oracle Reports: page 30 – 27
Using a Word Processor

To create standard letters using a word processor, you need to extract the data you want to include in the letters from the Oracle HRMS database. To do this, you create a program, such as a SQL*Plus script, to extract the data, which is then stored in a Data file. You also write skeleton standard letters using your word processor.

Each time you run your SQL*Plus script, it extracts data to the Data file. You then use the mail merge features of your word processor to merge this data with the skeleton standard letters you previously prepared. This merging process creates the actual letters that you send out to students and applicants.

An overview of creating standard letters using a word processor is illustrated in Figure 30 – 1.
**Which Word Processor?**

Oracle HRMS supplies SQL*Plus script templates for use with MultiMate, WordPerfect and Microsoft Word. It also supplies two sample Microsoft Word documents containing merge codes for the SQL*Plus scripts. You can copy the SQL*Plus script templates (or Word documents) and modify them to create the standard letters you require.

If you use Microsoft Word as your word processor, not only can you use the concurrent processing method to produce your standard letters, but you can also generate letters online. You can generate Microsoft Word letters using OLE or Oracle Application Data Export (ADE). See: Setting Up Standard Letters: page 30 – 10.

If you are setting up standard letters using the concurrent processing method with MultiMate or WordPerfect (or if you are using the concurrent processing method with Microsoft Word), see Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect: page 30 – 14

If you are setting up standard letters to be generated online for Microsoft Word, see Flowchart for Setting Up Standard Letters Using Microsoft Word: page 30 – 22

---

**Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect**

Figure 30 – 2 illustrates the sequence in which you set up standard letters using the concurrent processing method with MultiMate or WordPerfect (or if you are using the concurrent processing method with Microsoft Word).
Planning

One of the first tasks you need to perform is to identify which data you want to extract from the database to include in your standard letters. You need to identify the select statements to use to provide you with the data as the content of your letters. Oracle HRMS supplies you with...
SQL*Plus scripts as templates to help you do this. You also need to identify the text that you want to include as the body of your letters.

The next decision you need to make is whether to associate your standard letters with student enrollment or applicant assignment statuses.

If you do want to link your standard letters to student enrollment or applicant assignment statuses, your next decision is to identify which student enrollment or applicant assignment statuses you want to trigger your standard letters. For example, do you want to link your standard enrollment confirmation letter to the status Placed so that the letter is triggered when you set a student’s enrollment status to Placed? Alternatively, do you want to link your standard rejection letter to the status Rejected so that it is triggered when an applicant’s assignment status is set to Rejected?

Writing a SQL*Plus Script for MultiMate or WordPerfect

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to write your program to extract the data from the database.

Oracle HRMS supplies you with SQL*Plus scripts as templates. You can copy the SQL*Plus script templates and modify them to create the standard letters you require. Copy the SQL*Plus scripts from the server side sql directory of the HR product tree (consult your installation guide for details). The following example applies to HR—Oracle Training Administration does not provide template scripts—but we provide an example of a Confirmation letter SQL mail merge file.

Once you have written your script, save the file with the name PERWP*** (or OTAWP*** for OTA). You must use this prefix for the system to recognise it as a type of letter. See your Oracle Applications installation server guides for details of where the concurrent manager places the files.

The template scripts Oracle HRMS provides are:

<table>
<thead>
<tr>
<th>Scripts</th>
<th>Purpose</th>
<th>Used By</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERWPMUK.sql</td>
<td>Example UK SQL*Plus script for MultiMate</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPMUS.sql</td>
<td>Example US SQL*Plus script for MultiMate</td>
<td>HR</td>
</tr>
</tbody>
</table>
To write a SQL*Plus script for MultiMate or WordPerfect:

1. Write a SQL*Plus script to select data from the database in a format your word processor can read and that is compatible with the standard letter.
2. Name the program PERWP*** (or OTAWP*** for OTA).
3. Save the program. (Consult your installation guide for details).

**Registering the SQL*Plus Script for MultiMate or WordPerfect**

You now need to register your SQL*Plus program with Oracle HRMS. You register your program so that you can run it as a concurrent program. Name the file PERWP*** (or OTAWP***). You must use this prefix for the system to recognise it as a type of letter.

You use the Concurrent Programs window to register your program (using a system administrator responsibility).

See: Concurrent Programs Window, Oracle Applications System Administrator's Guide

**Linking the SQL*Plus Script With a Letter for MultiMate or WordPerfect**

You need to link your SQL*Plus script with a letter and one or more statuses. In Oracle Human Resources, you can link one or more applicant assignment statuses with each recruitment letter. A request for the letter is then created automatically when an applicant is given an associated assignment status. For example, you can link your standard recruitment rejection letter to the status Rejected so that the letter is triggered when you set an applicant’s assignment status to Rejected.

In Oracle Training Administration, you can link one or more enrollment statuses with each enrollment letter. A request for the letter is then created automatically when an enrollment is given an associated status.
Define your standard letter types in the Letter window.

To define a standard letter type:

1. Enter a name for the letter in the Name field.
2. Select the Concurrent Program Name assigned by your System Administrator to the SQL*Plus script.

For Oracle Human Resources:

3. Select one or more applicant assignment statuses to create letter requests automatically for applicants, and check the Enabled box.
   When an applicant is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the applicant is added to the list of people to receive the letter when you submit the request.

For Oracle Training Administration:

4. Select one or more enrollment statuses to create letter requests automatically for enrollments, and check the Enabled box.
   When an enrollment is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the enrollment is added to the list of people to receive the letter when you submit the request.

Writing a Skeleton Letter

You now need to write a skeleton letter using your word processor. Include the appropriate merge codes from the data source for the word processor you are using.

The mail merge feature of any word processor enables you to merge text from the data file you create into a standard letter. Each line in the data file contains the text to merge into one standard letter for one recipient.

Within the program, you can format the data and include the characters that are recognized as separators by your word processor.

A standard letter comprises standard text with a number of embedded variables in it. When you print the letter, the variables are replaced with specific items of data, such as name and address details for different people.
Requesting Letters for MultiMate or WordPerfect

When you, or other users, set the status for an applicant or enrollment that triggers your standard letters, Oracle HRMS creates a letter request automatically, with the status of Pending. It also adds the applicant’s or student’s name to the request. You can view the pending request and names through the Request Letter window.

Then, when you change the letter request from Pending to Requested, Oracle HRMS runs the SQL*Plus script that you previously wrote and creates the data file for mail merge. (Consult your installation guide for details of the location Concurrent Manager places the output file).
You can add further names to the list manually, if required. For example, you might have a last minute acknowledgement letter to send.

You can also create manual letter requests. If you do, enter the status of Pending yourself, then enter all the recipients of the letter before changing the status of the letter to Requested.

▶ **To submit an automatic letter request:**
1. Query the letter you require in the Letter Name field.
2. Ensure that the method is Automatic.
3. Move to the Requested for block to query the applicants, events or students which have been entered automatically on this request, according to their status. You can add further names manually.
4. Update the status from Pending to Requested.
5. Save your changes.
   
   A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.
6. You can query the request ID in the Concurrent Requests window and monitor its progress.

   **Note:** Consult your installation guide for details of the location Concurrent Manager places the output file.

▶ **To create a manual letter request:**
1. Select the Letter Name for the letter type you want to request.
2. Ensure that the method is Manual.
3. Leave the status of the request as Pending.
4. Save the changes.

**Adding the Names**
5. Select the names to add:
   
   - Select employees or applicants (for Oracle Human Resources) to receive the letter in the Requested For region.
     
     The Assignment field displays the organization to which the person is assigned. You can view the other components of the assignment by choosing List of Values from the Edit menu.
   - Select events or students or both (for Oracle Training Administration) in the Requested For region.
6. Save the changes.

Changing the Status

7. Update the status from Pending to Requested.

8. Save the changes.

A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

9. You can query the request ID in the Concurrent Requests window and monitor its progress.

Note: Consult your installation guide for details of the location Concurrent Manager places the output file.

Merging the Data File With the Standard Letter MultiMate or WordPerfect

The last step is to merge the data in the Data File with your skeleton letters to create your standard letters. The merging of text and data files is normally carried out using the mail merge features of your word processor.

If you do not have access to the directory where the Data File resides (consult your installation guide for details of the location Concurrent Manager places the file), you need to transfer the mail merge files created by the concurrent process to your word processor before you can merge the data file with the skeleton letters.

Saving the Letters You Generate

If you are using a word processor to merge the data file, you need to save the merged letters you generate. If you do not save the merged letters, when you exit the word processor you lose the letters. You do not lose the data file or the skeleton letter, however.
Flowchart for Setting Up Standard Letters Using Microsoft Word

Figure 30 – 4 illustrates the sequence in which you set up standard letters using Microsoft Word.
If you use Microsoft Word as your word processor, not only can you use the concurrent processing method to produce your standard letters, but you can also generate letters online.

You can use either one of two methods:

- Generate Microsoft Word letters using Object Linking and Embedding (OLE)
- Application Data Export (ADE)

**Attention:** In future releases of Oracle HRMS, generating Microsoft Word letters using Object Linking and Embedding (OLE) will be replaced by ADE.

See: Application Data Export (ADE) Online Help

If you are setting up standard letters using the concurrent processing method, follow the same sequence as for MultiMate or WordPerfect. See: Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect: page 30 – 14

If you are generating Microsoft Word letters using Object Linking and Embedding (OLE), see Writing a SQL*Plus Script for Microsoft Word: page 30 – 23

---

**Writing a SQL*Plus Script for Microsoft Word**

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to identify which data you want to extract from the database.

Oracle HRMS supplies SQL*Plus script templates. It also supplies two sample Microsoft Word documents containing merge codes for the SQL*Plus scripts. You can copy the SQL*Plus scripts from the server side sql directory of the HR or product tree. (Consult your installation guide for details).

You can copy the word documents from the client–side directory \[APPL_TOP\]\PER76\LEGEN.

You can run the scripts on the server side and make them accessible to other users across the network, or you must copy them to a directory which is accessible from the PC, such as a network drive. You must also make the Microsoft Word documents accessible to other users across the network, or you must copy them to each PC.

---

**Templates Provided**

The template scripts and Microsoft Word documents Oracle HRMS provides are:
<table>
<thead>
<tr>
<th>Scripts and Documents</th>
<th>Purpose</th>
<th>Used By</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERWPOUS.sql</td>
<td>Example US Offer letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUK.sql</td>
<td>Example UK Offer letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUS.sql</td>
<td>Example US Interview letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUK.sql</td>
<td>Example UK Interview letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUS.doc</td>
<td>Example US Offer MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUK.doc</td>
<td>Example UK Offer MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUS.doc</td>
<td>Example US Interview MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUK.doc</td>
<td>Example UK Interview MS Word document</td>
<td>HR</td>
</tr>
</tbody>
</table>

- **To write a SQL*Plus script for Microsoft Word:**
  1. Write a SQL*Plus script to select data from the database in a format your word processor can read and is compatible with the standard letter.
  2. Name the program PERWP*** (or OTAWP***).
  3. Save the program. (Consult your installation guide for details).
Generating a Microsoft Word Letter

You can generate the Microsoft Word letter online using the Letter Generation window. This window uses Object Linking and Embedding (OLE) to display the Microsoft Word letter. When you start Microsoft Word from this window, your standard letter is automatically loaded and ready to be merged with the mail merge file.

To generate and merge a Microsoft Word document:

1. Select one of the following in the Letter region:
   - Request if you want to process a pending letter request that the system has created automatically for applicants, or that you have created manually in the Request Letter window. Select the name of the letter request.
   - Custom if you want to process a custom program that is not associated with a letter type.

2. Position the cursor in the Document field and choose the Browse button.

3. Select the Microsoft Word document that is your skeleton letter.

4. Position the cursor in the Merge field and choose the Browse button.

5. Select the extract program (such as a SQL script) that extracts data from the database to create the mail merge file.
   
   You can run the scripts on the server side (consult your installation guide for details). Make them accessible to other users across the network, or copy them to each PC. You must also make the Microsoft Word documents accessible to other users across the network, or you must copy them to each PC.

6. Check View Generated Merge File if you want to examine the generated mail merge file before activating the Microsoft Word document then choose the Generate button to create the mail merge file.

   If the View Generated Merge File check box is checked, the file displays in the Windows Notepad application.


   The document displays in the Document Preview and Activation block.
8. Merge the data with the document.
   If the Microsoft Word document already contains mail merge fields, the mail merge file you have generated is automatically loaded in Microsoft Word.

9. You must open the merge file as the Data Source and insert the merge fields in your document if the document does not yet contain mail merge fields.

10. Save the document using the filename of your mail merge file, with a .doc extension.

   **Note:** If you do not save the merged letters when you exit the word processor you lose them.
Using Oracle Reports

You can create a report for each letter using Oracle Reports, or another tool of your choice. The report contains the skeleton letter text and Select statements specifying the data to be extracted from the Oracle database.

Figure 30 – 5 illustrates the sequence in which you set up standard letters using Oracle Reports.

Planning the Content and Layout

One of the first tasks you need to perform is to identify which data you want to extract from the database to include in your standard letters. You need to identify the select statements to use to provide you with the data as the content of your letters. You also need to identify the text that you want to include as the body of your letters.
The next decision you need to make is whether you want to associate your standard letters with student enrollment or applicant assignment statuses.

If you do want to link your standard letters to student enrollment or applicant assignment statuses, your next decision is to identify which student enrollment or applicant assignment statuses you want to trigger your standard letters. For example, do you want to link your standard enrollment confirmation letter to the status Placed so that the letter is triggered when you set a student’s enrollment status to Placed? Alternatively, do you want to link your standard rejection letter to the status Rejected so that it is triggered when an applicant’s assignment status is set to Rejected?

Writing the Report

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to identify which data you want to extract from the database.

Write your skeleton letter text and Select statements specifying the data to be extracted from the Oracle database.

Registering the Report

You now need to register your report with Oracle HRMS. You register your report so that you can run it as a concurrent program. Name the file PERWP*** (or OTAWP*** for OTA). You must use this prefix for the system to recognise it.

You use the Concurrent Programs window to register your report (using a system administrator responsibility).

See: Concurrent Programs Window, Oracle Applications System Administrator’s Guide

Linking the Report With a Letter

You need to link your report with a letter and one or more statuses. In Oracle Human Resources, you can link one or more applicant assignment statuses with each recruitment letter. A request for the
letter is then created automatically when an applicant is given an associated assignment status. In Oracle Training Administration, you can link one or more enrollment statuses with each enrollment letter. A request for the letter is then created automatically when an enrollment is given an associated status.

For example, you can link your standard recruitment rejection letter to the status Rejected so that the letter is triggered when you set an applicant’s assignment status to Rejected.

Define your standard letter types in the Letter window.

► **To define a standard letter type:**

1. Enter a name for the letter in the Name field.
2. Select the Concurrent Program Name assigned by your System Administrator to the report.
3. Select one or more applicant assignment statuses to create letter requests automatically for applicants, and check the Enabled box.
   
   When an applicant is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the applicant is added to the list of people to receive the letter when you submit the request.

**Running the Report**

When you, or other users, set the status for an applicant or enrollment that triggers your standard letters. Oracle HRMS creates a letter request automatically, with the status of Pending. It also adds the applicant’s or student’s name to the request. You can view the pending request and names through the Request Letter window.

Then, when you change the letter request from Pending to Requested, Oracle HRMS runs the report that you created.

You can add further names to the list manually, if required. For example, you might have a last minute acknowledgement letter to send.

You can also create manual letter requests. If you do, enter the status of Pending yourself, then enter all the recipients of the letter before changing the status of the letter to Requested.

► **To submit an automatic letter request:**

1. Query the letter you require in the Letter Name field.
2. Ensure that the method is Automatic.
3. Move to the Requested for block to query the applicants, events or students which have been entered on this request automatically, according to their status. You can add further names manually.
4. Update the status from Pending to Requested.
5. Save your changes.
   A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.
6. You can query the request ID in the Concurrent Requests window and monitor its progress.
   Note: Oracle HRMS saves the data file (consult your installation guide for details).

To create a manual letter request:
1. Select the Letter Name for the letter type you want to request.
2. Ensure that the method is Manual.
3. Leave the status of the request as Pending.
4. Save the changes.

Adding the Names
5. Select the names to add:
   • Select employees or applicants (for Oracle Human Resources) to receive the letter in the Requested For region.
     The Assignment field displays the organization to which the person is assigned. You can view the other components of the assignment by choosing List of Values from the Edit menu.
   • Select events or students or both (For Oracle Training Administration) in the Requested For region.
6. Save the changes.

Changing the Status
7. Update the status from Pending to Requested.
8. Save the changes.
   A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.
9. You can query the request ID in the Concurrent Requests window and monitor its progress.

   **Note:** Oracle HRMS saves the data file, consult your installation guide for details.
This appendix shows you the default menu path for every window in Oracle Human Resources and Oracle Payroll. Refer to chapter 27 Customizing Windows and Menus for information about setting up your own menu structures.

The first two sections show the structure of the default menus for the default responsibilities. The third section is arranged alphabetically by window title and shows how to find each window.
### Default Navigation Menus for HR with Payroll Responsibility

<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>People</td>
<td>Enter personal and assignment information</td>
</tr>
<tr>
<td></td>
<td>Enter people, assignments, and applications</td>
</tr>
</tbody>
</table>

#### Enter and Maintain

<table>
<thead>
<tr>
<th>1 Person</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Address</td>
<td></td>
</tr>
<tr>
<td>2 Picture</td>
<td></td>
</tr>
<tr>
<td>2 Assignment</td>
<td>---</td>
</tr>
<tr>
<td>2 Special Info</td>
<td></td>
</tr>
<tr>
<td>2 Bookings</td>
<td></td>
</tr>
<tr>
<td>2 Absence</td>
<td></td>
</tr>
<tr>
<td>2 Contact</td>
<td>---</td>
</tr>
<tr>
<td>2 Application</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>2 Competence Profile</td>
<td></td>
</tr>
<tr>
<td>2 Qualifications</td>
<td></td>
</tr>
<tr>
<td>2 Work Choices</td>
<td></td>
</tr>
<tr>
<td>2 Schools and Colleges Attended</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>Events and Bookings</td>
<td>Enter events and bookings</td>
</tr>
<tr>
<td>Delete Personal Records</td>
<td>Remove all records for any person</td>
</tr>
<tr>
<td>Salary Management</td>
<td>Manage salary details</td>
</tr>
<tr>
<td>FastPath</td>
<td>Enter personal and assignment information quickly</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Address</td>
<td>Enter address details</td>
</tr>
<tr>
<td>US Address</td>
<td>Enter address details</td>
</tr>
<tr>
<td>Picture</td>
<td>Enter pictures for a person</td>
</tr>
<tr>
<td>Special Information</td>
<td>Enter special information</td>
</tr>
<tr>
<td>Contact Information</td>
<td>Enter contact information</td>
</tr>
<tr>
<td>Event for Person</td>
<td>Book a training event</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Enter phone numbers</td>
</tr>
<tr>
<td>Absence Information</td>
<td>Enter absence information</td>
</tr>
<tr>
<td>Application</td>
<td>Enter application details</td>
</tr>
<tr>
<td>End Application</td>
<td>End a person’s application</td>
</tr>
<tr>
<td>Assignment</td>
<td>Enter a person’s assignment details</td>
</tr>
<tr>
<td>Assignment Costing</td>
<td>Enter costing for an assignment</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Enter budget values for an assignment</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter grade step placement details</td>
</tr>
<tr>
<td>Secondary Status</td>
<td>Enter a person’s secondary status</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Enter a pay method</td>
</tr>
<tr>
<td>End Employment</td>
<td>End a person’s employment</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Perform an employee review</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Perform a Salary Review</td>
</tr>
<tr>
<td>Salary History</td>
<td>View a person’s salary history</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Enter compensation and benefits for employee assignment</td>
</tr>
<tr>
<td>Benefits</td>
<td>View benefits details</td>
</tr>
<tr>
<td>Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>US Tax</td>
<td>View tax history</td>
</tr>
<tr>
<td>US Statement of Earnings</td>
<td>View statement of earnings</td>
</tr>
<tr>
<td>Employee Balance</td>
<td>View employee balances</td>
</tr>
<tr>
<td>Adjust Balances</td>
<td>Adjust balances</td>
</tr>
<tr>
<td>Taxes</td>
<td>View taxes</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Run QuickPay</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reverse Payroll Run</td>
<td>Run a reverse payroll</td>
</tr>
<tr>
<td>External Manual Payments</td>
<td>Enter external or manual payments</td>
</tr>
<tr>
<td><strong>Recruitment</strong></td>
<td></td>
</tr>
<tr>
<td>Requisition and Vacancy</td>
<td>Enter a requisition and any vacancies</td>
</tr>
<tr>
<td>Recruitment Activity</td>
<td>Enter a recruitment activity</td>
</tr>
<tr>
<td>Applicant Quick Entry</td>
<td>Quick entry of personal and application information</td>
</tr>
<tr>
<td>Mass Update of Applicants</td>
<td>Mass Update of Applicants</td>
</tr>
<tr>
<td>Request Recruitment Letter</td>
<td>Request a mailmerge file or a standard letter</td>
</tr>
<tr>
<td><strong>Career Management</strong></td>
<td></td>
</tr>
<tr>
<td>Rating Scales</td>
<td>Career Management</td>
</tr>
<tr>
<td>Competencies</td>
<td>Define general methods of measuring competencies</td>
</tr>
<tr>
<td>Competence Types</td>
<td>Group competencies into types</td>
</tr>
<tr>
<td>Competence Requirements</td>
<td>Define requirements for enterprise, organizations, jobs and positions</td>
</tr>
<tr>
<td>Schools &amp; Colleges</td>
<td>Define name and location of training establishments</td>
</tr>
<tr>
<td>Qualification Types</td>
<td>Define, categorize and rank qualifications</td>
</tr>
<tr>
<td>Assessment Template</td>
<td>Select competencies and rating scale for an assessment</td>
</tr>
<tr>
<td>Appraisal Template</td>
<td>Select questionnaire and rating scale for an appraisal</td>
</tr>
<tr>
<td><strong>Work Structures</strong></td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>Enter work structures</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter locations</td>
</tr>
<tr>
<td>Description</td>
<td>Enter organizational information</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure organizations into hierarchies</td>
</tr>
<tr>
<td>Job</td>
<td>Enter job-related information</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Enter job names</td>
</tr>
<tr>
<td>Path Name</td>
<td>Enter names for job career paths</td>
</tr>
<tr>
<td>Career Path</td>
<td>Enter career paths for jobs</td>
</tr>
<tr>
<td>Workers Compensation Codes</td>
<td>Enter WC codes for jobs</td>
</tr>
<tr>
<td>Workers Compensation Rates</td>
<td>Enter rates for WC codes</td>
</tr>
<tr>
<td>Position</td>
<td>Enter position-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter position names</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure positions into hierarchies</td>
</tr>
<tr>
<td>Mass Move</td>
<td>Enter details of a mass move</td>
</tr>
<tr>
<td>Grade</td>
<td>Enter grade-related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter grade names</td>
</tr>
<tr>
<td>Grade Rate</td>
<td>Enter rates and values for grades</td>
</tr>
<tr>
<td>Pay Scale</td>
<td>Create a pay scale of fixed progression points</td>
</tr>
<tr>
<td>Point Values</td>
<td>Enter values for progression points</td>
</tr>
<tr>
<td>Grade Steps and Points</td>
<td>Enter grade steps and fixed point values for each step</td>
</tr>
<tr>
<td>Salary Basis</td>
<td>Enter available salary bases for salary administration</td>
</tr>
<tr>
<td>Budget Calendar</td>
<td>Define calendars for headcount and position budgets</td>
</tr>
<tr>
<td>Budget</td>
<td>Enter headcount and position budgets</td>
</tr>
<tr>
<td>Status</td>
<td>Define employee and applicant assignment statuses</td>
</tr>
<tr>
<td>Recruitment Letter Type</td>
<td>Associate letter types with applicant statuses</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter information for payrolls</td>
</tr>
<tr>
<td>Description</td>
<td>Enter payroll groups</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Define consolidation sets for payroll run results</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Payment Methods</td>
<td>Define available payment methods</td>
</tr>
<tr>
<td>GL Flexfield Map</td>
<td>Map payroll costing to Oracle GL flexfield segments</td>
</tr>
<tr>
<td>Update Payroll Run</td>
<td>Update consolidation set or pay advice date</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Define employee assignment sets</td>
</tr>
<tr>
<td>Element Set</td>
<td>Define element and distribution sets</td>
</tr>
<tr>
<td>RetroPay Set</td>
<td>Define retropay sets using balances and elements</td>
</tr>
<tr>
<td>Exchange Rates</td>
<td>Enter exchange rates for your base currency</td>
</tr>
<tr>
<td>Monetary Units</td>
<td>Enter monetary units for cash analysis and distribution</td>
</tr>
<tr>
<td>Compensation and Benefits</td>
<td>Enter information on compensation and benefits</td>
</tr>
<tr>
<td>Earnings</td>
<td>Activate and review earnings types</td>
</tr>
<tr>
<td>Tax Withholding Rules</td>
<td>Enter withholding rules for earnings</td>
</tr>
<tr>
<td>Deductions</td>
<td>Activate and review deductions</td>
</tr>
<tr>
<td>Element Description</td>
<td>Enter compensation and benefit information</td>
</tr>
<tr>
<td>Link</td>
<td>Enter eligibility rules for compensations and benefits</td>
</tr>
<tr>
<td>Benefit Contributions</td>
<td>Enter benefit contribution levels and values</td>
</tr>
<tr>
<td>Absence Types</td>
<td>Define absence types</td>
</tr>
<tr>
<td>Accrual Plans</td>
<td>Enter accrual plans</td>
</tr>
<tr>
<td>Write Formulas</td>
<td>Enter and modify formulas</td>
</tr>
<tr>
<td>Formula Results</td>
<td>Define what happens to formula results</td>
</tr>
<tr>
<td>Global Values</td>
<td>Enter global values for use in formulas</td>
</tr>
<tr>
<td>Balance</td>
<td>Enter balances with feeds and dimensions</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>Classification</td>
<td>Define additional element classifications</td>
</tr>
<tr>
<td>Wage Attachment Earnings Rules</td>
<td>Define Wage Attachments Earnings rules</td>
</tr>
<tr>
<td>View</td>
<td>View HRMS information</td>
</tr>
<tr>
<td>Histories</td>
<td></td>
</tr>
<tr>
<td>Employee Assignment</td>
<td>Employee assignment history</td>
</tr>
<tr>
<td>Absence</td>
<td>Employee absence history folder</td>
</tr>
<tr>
<td>Run Results</td>
<td>Employee run result history</td>
</tr>
<tr>
<td>Salary</td>
<td>Salary history for an employee assignment</td>
</tr>
<tr>
<td>Salary</td>
<td></td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Salary History</td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Entry History</td>
</tr>
<tr>
<td>Entries</td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>People folder</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Assignment folder</td>
</tr>
<tr>
<td>People by Assignment</td>
<td>List people by assignment folder</td>
</tr>
<tr>
<td>Assignments</td>
<td>List assignments folder</td>
</tr>
<tr>
<td>Employees by Organization</td>
<td>List employees by organization folder</td>
</tr>
<tr>
<td>Employees by Position</td>
<td>List employees by position folder</td>
</tr>
<tr>
<td>Emps by Position Hierarchy</td>
<td>List employees by position hierarchy folder</td>
</tr>
<tr>
<td>Employees by Element</td>
<td>List employees by element</td>
</tr>
<tr>
<td>Employees by Absence Type</td>
<td>List employees by absence type folder</td>
</tr>
<tr>
<td>People by Special Information</td>
<td>List people by special information folder</td>
</tr>
<tr>
<td>Vacancies</td>
<td>View vacancies folder</td>
</tr>
<tr>
<td>Organization Budgets</td>
<td>View organization budget variance folder</td>
</tr>
<tr>
<td>Position Budgets</td>
<td>View position budget variance folder</td>
</tr>
</tbody>
</table>

Default Menus   A – 7
<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grade Comparatio</td>
<td>View employee grade comparatio folder</td>
</tr>
<tr>
<td>Employee Benefits</td>
<td>View benefits for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder —&gt; 2 Benefits</td>
<td></td>
</tr>
<tr>
<td>Employee Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>1 Assignment Folder —&gt; 2 Accruals</td>
<td></td>
</tr>
<tr>
<td>Employee Balances</td>
<td>View employee balances for earnings and deductions</td>
</tr>
<tr>
<td>1 Assignment Folder —&gt; 2 Balances</td>
<td></td>
</tr>
<tr>
<td>Tax Information</td>
<td>View Employee Tax Balances</td>
</tr>
<tr>
<td>Tax Balances</td>
<td>View Form 941 Information</td>
</tr>
<tr>
<td>1 Assignment Folder —&gt; 2 Tax Balances</td>
<td></td>
</tr>
<tr>
<td>Payroll Process Results</td>
<td>View process results for a payroll</td>
</tr>
<tr>
<td>Assignment Process Results</td>
<td>View process results for an employee assignment</td>
</tr>
<tr>
<td>System Messages</td>
<td>View system level messages</td>
</tr>
<tr>
<td>Wage Attachment</td>
<td>View Wage Attachment</td>
</tr>
<tr>
<td>Exemption Rules</td>
<td>Define Wage Attachments</td>
</tr>
<tr>
<td>Limit Rules</td>
<td>Define Wage Attachments</td>
</tr>
<tr>
<td>Processes and Reports</td>
<td>Submit processes or run standard reports</td>
</tr>
<tr>
<td>Submit Processes and Reports</td>
<td></td>
</tr>
<tr>
<td>View Requests</td>
<td>View any requests submitted for processing</td>
</tr>
<tr>
<td>View Reports</td>
<td>View reports online</td>
</tr>
<tr>
<td>Workflow Notifications</td>
<td>Workflow Notifications</td>
</tr>
<tr>
<td>Define a QuickPaint Report</td>
<td>Set up the report layout</td>
</tr>
<tr>
<td>Run a QuickPaint Report</td>
<td>View or print the report for a set of people</td>
</tr>
<tr>
<td>Generate MS Word Letter</td>
<td>Generate MS Word Letter</td>
</tr>
<tr>
<td>Submit Custom Reports</td>
<td>Submit custom reports</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------</td>
</tr>
<tr>
<td>Mass Information eXchange: MIX</td>
<td>Enter timecard and other information batches</td>
</tr>
<tr>
<td>Batch Element Entry</td>
<td>Enter, validate, and transfer element entry batches.</td>
</tr>
<tr>
<td>PayMIX Entry</td>
<td>PayMIX batch entry</td>
</tr>
<tr>
<td>PayMIX Summary</td>
<td>PayMIX batch summary</td>
</tr>
<tr>
<td>Other Definitions</td>
<td>Other Definitions</td>
</tr>
<tr>
<td>Person Types</td>
<td>Enter names for types of employees, applicants and other people</td>
</tr>
<tr>
<td>QuickCode Values</td>
<td>Enter values and meanings for QuickCode types</td>
</tr>
<tr>
<td>QuickCode Types</td>
<td>Define your own QuickCode types</td>
</tr>
<tr>
<td>Special Information Types</td>
<td>Join special information types to the current business group</td>
</tr>
<tr>
<td>Table Structure</td>
<td>Set up tables you require</td>
</tr>
<tr>
<td>Table Values</td>
<td>Enter table values</td>
</tr>
<tr>
<td>Time Periods</td>
<td>Define time period types for use in budget calendars</td>
</tr>
<tr>
<td>User Profile Options</td>
<td>Review your personal profile options</td>
</tr>
<tr>
<td>Formula Functions</td>
<td>Register your user defined functions</td>
</tr>
<tr>
<td>Security</td>
<td>Define security restrictions</td>
</tr>
<tr>
<td>Profile</td>
<td>Define security profiles to restrict record access</td>
</tr>
<tr>
<td>CustomForm</td>
<td>Define customizations to restrict information access in windows</td>
</tr>
<tr>
<td>Report Sets</td>
<td>Define sets to restrict report and process access</td>
</tr>
<tr>
<td>Task Flow Nodes</td>
<td>Define task flow nodes and customizations</td>
</tr>
<tr>
<td>Task Flow Definitions</td>
<td>Define task flows</td>
</tr>
</tbody>
</table>
Default Navigation Menus for Payroll Responsibility

<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>People</td>
<td>Enter personal and assignment information</td>
</tr>
<tr>
<td>Enter and Maintain</td>
<td>Enter people, assignments, and applications</td>
</tr>
<tr>
<td>1 Person</td>
<td></td>
</tr>
<tr>
<td>2 Address</td>
<td></td>
</tr>
<tr>
<td>2 Picture</td>
<td></td>
</tr>
<tr>
<td>2 Assignment</td>
<td>3 Salary</td>
</tr>
<tr>
<td>2 Absence</td>
<td>3 Entries</td>
</tr>
<tr>
<td>2 Contact</td>
<td>3 Tax Information</td>
</tr>
<tr>
<td>2 End Employment</td>
<td>3 Pay Method</td>
</tr>
<tr>
<td></td>
<td>3 Costing</td>
</tr>
<tr>
<td></td>
<td>3 Grade Step</td>
</tr>
<tr>
<td></td>
<td>3 Secondary Status</td>
</tr>
<tr>
<td></td>
<td>3 Salary History</td>
</tr>
<tr>
<td></td>
<td>3 Entry History</td>
</tr>
<tr>
<td></td>
<td>3 Reviews</td>
</tr>
<tr>
<td></td>
<td>3 QuickPay</td>
</tr>
<tr>
<td></td>
<td>3 Statement of Earnings</td>
</tr>
<tr>
<td></td>
<td>3 External/Manual Payment</td>
</tr>
<tr>
<td></td>
<td>3 Reverse Run</td>
</tr>
<tr>
<td></td>
<td>3 Adjust Balance</td>
</tr>
<tr>
<td></td>
<td>3 Adjust Tax Balances</td>
</tr>
<tr>
<td>Delete Personal Records</td>
<td>Remove all records for any person</td>
</tr>
<tr>
<td>Work Structures</td>
<td>Enter work structures</td>
</tr>
<tr>
<td>Location</td>
<td>Enter locations</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter organizational information</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>Enter information for an organization</td>
</tr>
<tr>
<td></td>
<td>Hierarchy</td>
</tr>
<tr>
<td></td>
<td>Structure organizations into hierarchies</td>
</tr>
<tr>
<td>Job</td>
<td>Enter job–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter job names</td>
</tr>
<tr>
<td>Workers Compensation Codes</td>
<td>Enter WC codes for jobs</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Workers Compensation Rates</td>
<td>Enter rates for WC codes</td>
</tr>
<tr>
<td>Position</td>
<td>Enter position–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter position names</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure positions into hierarchies</td>
</tr>
<tr>
<td>Grade</td>
<td>Enter grade–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter grade names</td>
</tr>
<tr>
<td>Grade Rate</td>
<td>Enter rates and values for grades</td>
</tr>
<tr>
<td>Pay Scale</td>
<td>Create a pay scale of fixed progression points</td>
</tr>
<tr>
<td>Point Values</td>
<td>Enter values for progression points</td>
</tr>
<tr>
<td>Grade Steps and Points</td>
<td>Enter grade steps and fixed point values for each step</td>
</tr>
<tr>
<td>Salary Basis</td>
<td>Enter available salary bases for salary administration</td>
</tr>
<tr>
<td>Status</td>
<td>Define employee and applicant assignment statuses</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter information for payrolls</td>
</tr>
<tr>
<td>Description</td>
<td>Enter payroll groups</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Define consolidation sets for payroll run results</td>
</tr>
<tr>
<td>Payment Methods</td>
<td>Define available payment methods</td>
</tr>
<tr>
<td>GL Flexfield Map</td>
<td>Map payroll costing to Oracle GL flexfield segments</td>
</tr>
<tr>
<td>Update Payroll Run</td>
<td>Update consolidation set or pay advice date</td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Define employee assignment sets</td>
</tr>
<tr>
<td>Element Set</td>
<td>Define element and distribution sets</td>
</tr>
<tr>
<td>RetroPay Set</td>
<td>Define retropay sets using balances and elements</td>
</tr>
<tr>
<td>Exchange Rates</td>
<td>Enter exchange rates for your base currency</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Monetary Units</td>
<td>Enter monetary units for cash analysis and distribution</td>
</tr>
<tr>
<td>Compensation and Benefits</td>
<td>Enter information on compensation and benefits</td>
</tr>
<tr>
<td>Earnings</td>
<td>Activate and review earnings types</td>
</tr>
<tr>
<td>Tax Withholding Rules</td>
<td>Enter withholding rules for earnings</td>
</tr>
<tr>
<td>Deductions</td>
<td>Activate and review deductions</td>
</tr>
<tr>
<td>Element Description</td>
<td>Enter compensation and benefit information</td>
</tr>
<tr>
<td>Link</td>
<td>Enter eligibility rules for compensations and benefits</td>
</tr>
<tr>
<td>Benefit Contributions</td>
<td>Enter benefit contribution levels and values</td>
</tr>
<tr>
<td>Absence Types</td>
<td>Define absence types</td>
</tr>
<tr>
<td>Accrual Plans</td>
<td>Enter accrual plans</td>
</tr>
<tr>
<td>Write Formulas</td>
<td>Enter and modify formulas</td>
</tr>
<tr>
<td>Formula Results</td>
<td>Define what happens to formula results</td>
</tr>
<tr>
<td>Global Values</td>
<td>Enter global values for use in formulas</td>
</tr>
<tr>
<td>Balance</td>
<td>Enter balances with feeds and dimensions</td>
</tr>
<tr>
<td>Classification</td>
<td>Define additional element classifications</td>
</tr>
<tr>
<td>View</td>
<td>View HRMS information</td>
</tr>
<tr>
<td>Histories</td>
<td></td>
</tr>
<tr>
<td>Employee Assignment</td>
<td>Employee assignment history</td>
</tr>
<tr>
<td>Absence</td>
<td>Employee absence history folder</td>
</tr>
<tr>
<td>Run Results</td>
<td>Employee run result history</td>
</tr>
<tr>
<td>Salary</td>
<td>Salary history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Salary History</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Entries</td>
<td></td>
</tr>
<tr>
<td>1 Assignment Folder ——&gt; 2 Entry History</td>
<td>Entry history for an employee assignment</td>
</tr>
<tr>
<td>Lists</td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>People folder</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Assignment folder</td>
</tr>
<tr>
<td>People by Assignment</td>
<td>List people by assignment folder</td>
</tr>
<tr>
<td>Assignments</td>
<td>List assignments folder</td>
</tr>
<tr>
<td>Employees by Organization</td>
<td>List employees by organization folder</td>
</tr>
<tr>
<td>Employees by Position</td>
<td>List employees by position folder</td>
</tr>
<tr>
<td>Emps by Position Hierarchy</td>
<td>List employees by position hierarchy folder</td>
</tr>
<tr>
<td>Employees by Element</td>
<td>List employees by element</td>
</tr>
<tr>
<td>Employees by Absence Type</td>
<td>List employees by absence type folder</td>
</tr>
<tr>
<td>Grade Comparatio</td>
<td>View employee grade comparatio folder</td>
</tr>
<tr>
<td>Employee Benefits</td>
<td>View benefits for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder ——&gt; 2 Benefits</td>
<td></td>
</tr>
<tr>
<td>Employee Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>1 Assignment Folder ——&gt; 2 Accruals</td>
<td></td>
</tr>
<tr>
<td>Employee Balances</td>
<td>View employee balances for earnings and deductions</td>
</tr>
<tr>
<td>1 Assignment Folder ——&gt; 2 Balances</td>
<td></td>
</tr>
<tr>
<td>Tax Information</td>
<td></td>
</tr>
<tr>
<td>Tax Balances</td>
<td>View Employee Tax Balances</td>
</tr>
<tr>
<td>1 Assignment Folder ——&gt; 2 Tax Balances</td>
<td></td>
</tr>
<tr>
<td>Form 941 Information</td>
<td>View Form 941 Information</td>
</tr>
<tr>
<td>Payroll Process Results</td>
<td>View process results for a payroll</td>
</tr>
<tr>
<td>Assignment Process Results</td>
<td>View process results for an employee assignment</td>
</tr>
<tr>
<td>System Messages</td>
<td>View system level messages</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Processes and Reports</strong></td>
<td></td>
</tr>
<tr>
<td>Submit Processes and Reports</td>
<td>Submit processes or run standard reports</td>
</tr>
<tr>
<td>View Requests</td>
<td>View any requests submitted for processing</td>
</tr>
<tr>
<td>View Reports</td>
<td>View reports online</td>
</tr>
<tr>
<td>Generate MS Word Letter</td>
<td>Generate MS Word Letter</td>
</tr>
<tr>
<td>Submit Custom Reports</td>
<td>Submit custom reports</td>
</tr>
<tr>
<td><strong>Mass Information eXchange: MIX</strong></td>
<td></td>
</tr>
<tr>
<td>Batch Element Entry</td>
<td>Enter, validate, and transfer element entry batches.</td>
</tr>
<tr>
<td>PayMIX Entry</td>
<td>PayMIX batch entry</td>
</tr>
<tr>
<td>PayMIX Summary</td>
<td>PayMix batch summary</td>
</tr>
<tr>
<td><strong>Other Definitions</strong></td>
<td></td>
</tr>
<tr>
<td>Person Types</td>
<td>Enter names for types of employees, applicants and other people</td>
</tr>
<tr>
<td>QuickCode Values</td>
<td>Enter values and meanings for QuickCode types</td>
</tr>
<tr>
<td>QuickCode Types</td>
<td>Define your own QuickCode types</td>
</tr>
<tr>
<td>Table Structure</td>
<td>Set up tables you require</td>
</tr>
<tr>
<td>Table Values</td>
<td>Enter table values</td>
</tr>
<tr>
<td>User Profile Options</td>
<td>Review your personal profile options</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td>Define security profiles to restrict record access</td>
</tr>
<tr>
<td>CustomForm</td>
<td>Define customizations to restrict information access in windows</td>
</tr>
<tr>
<td>Report Sets</td>
<td>Define sets to restrict report and process access</td>
</tr>
<tr>
<td>Task Flow Nodes</td>
<td>Define task flow nodes and customizations</td>
</tr>
<tr>
<td>Task Flow Definitions</td>
<td>Define task flows</td>
</tr>
</tbody>
</table>
Windows and their Navigation Paths

This topic shows the default navigation paths for all the windows in Oracle HRMS, as they are supplied. You can use taskflow windows directly from the menu, or from the People and Assignment windows.

The responsibility that you use determines which of these windows you can use and how you access them. Your system administrator sets up navigation menus and task flows for your responsibility. They may also create customized versions of some of these windows using different window titles.

AAP Organization
2. Enter or query an AAP Organization.
3. Choose the Others button and select AAP Organization.

Absence Detail
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Choose the Others button and select Absence.
Or:
1. Choose People –> Fastpath –> Absence in the Navigator.
2. In the resulting Find window, query the person.

Absence Attendance Type
- Choose Compensation and Benefits –> Absence Types in the Navigator.

Accrual Bands
2. Enter or query an accrual plan name.
3. Choose the Accrual Bands button.

Accrual Plans
- Choose Compensation and Benefits –> Accrual Plans in the Navigator.
Accruals

Do one of the following:
1. Choose View → Employee Accruals in the Navigator.
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Accruals button.

Or:
1. Choose People → Fastpath → Accruals in the Navigator.
2. In the resulting Find window, query the person.

Address

Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Address button.

Or:
1. Choose People → Fastpath → Address in the Navigator.
2. In the resulting Find window, query the person.

Adjust Balance (Oracle Payroll only)

Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Adjust Balance.

Or:
1. Choose People → Fastpath → Adjust Balances in the Navigator.
2. In the resulting Find window, query the person.

Adjust Tax Balances (Oracle Payroll only)

1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Adjust Tax Balances.

**Alter Effective Date**
- Choose the Alter Effective Date icon from the toolbar.

**Applicant Entry**
- Choose Recruitment -> Applicant Quick Entry in the Navigator.

**Applicant Interview**
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.
4. Choose the Interview button.

**Application**
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.
Or:
1. Choose People -> Fastpath -> Application in the Navigator.
2. In the resulting Find window, query the person.

**Appraisal Template**
- Choose Career Management -> Appraisal Template in the Navigator.

**Assessment Template**
- Choose Career Management -> Assessment Template in the Navigator.

**Assignment**
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
Or:
1. Choose People -> Fastpath -> Assignment in the Navigator.
2. In the resulting Find window, query the person.

**Assignment Budget Values**

Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant or an employee.
3. Do one of the following:
   - For an applicant:
     - Choose the Others button and select Application.
     - Choose the Budgets button.
   - For an employee:
     - Choose the Assignment button.
     - Choose the Others button and select Budgets.

Or:
1. Choose People -> Fastpath -> Assignment Budget Values in the Navigator.
2. In the resulting Find window, query the person.

**Assignment Criteria**

1. Choose Payroll -> Assignment Set in the Navigator.
2. Enter or query an assignment set.
3. Choose the Criteria button.

**Assignment History**

- Choose View -> Histories -> Employee Assignment in the Navigator.

**Assignment Processes**

1. Choose View -> Payroll Process Results in the Navigator.
2. Enter or query a payroll process.
3. Choose the Assignment Process button.
Assignment Set
- Choose Payroll -> Assignment Set in the Navigator.

Assignment Statuses
- Choose Work Structures -> Status in the Navigator.

Assignments Folder
- Choose View -> Lists -> Assignments Folder in the Navigator.

Balance (Oracle Payroll only)
- Choose Compensation and Benefits -> Balance in the Navigator.

Balance Classifications (Oracle Payroll only)
2. Enter or query a balance.
3. Choose the Classifications button.

Balance Dimensions (Oracle Payroll only)
2. Enter or query a balance.
3. Choose the Dimensions button.

Balance Feed Control (Oracle Payroll only)
1. Choose Compensation and Benefits -> Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Balance Feed Control button.

Balance Feeds (Oracle Payroll only)
- Note: This instance of the Balance Feeds window lets you select more than one element to feed the balance.
2. Enter or query a balance.
3. Choose the Feeds button.
Balance Feeds (Oracle Payroll only)

Note: This instance of the Balance Feeds window lets you select more than one balance for the element to feed.

1. Choose Compensation and Benefits -> Element in the Navigator.
2. Enter or query an element.
3. Choose the Feeds button.

Batch Entry Default Values (Oracle Payroll only)

2. Choose the Defaults button.

Batch Header

- Choose Mass Information eXchange: MIX -> Batch Element Entry in the Navigator.

Batch Lines

2. Choose the Lines button.

Beneficiaries

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
4. Choose the Entries button.
5. Select the element representing the benefit for which you are entering a beneficiary.
6. Choose the Others button and select Beneficiary.

Benefit Contributions

- Choose Compensation and Benefits -> Benefit Contributions in the Navigator.

Book Events

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Bookings.

**Budget**
- Choose Work Structures –> Budget in the Navigator.

**Budget Value Defaults**
2. Enter or query a Business Group.
3. Choose the Others button and select Budget Value Defaults.

**Budgetary Calendar**
- Choose Work Structures –> Budget Calendar in the Navigator.

**Business Group Information**
2. Enter or query a Business Group.
3. Choose the Others button and select Business Group Information.

**Career Path Names**
- Choose Work Structures –> Job –> Path Name in the Navigator.

**Cities**
- Choose Other Definitions –> Cities in the Navigator.

**City Tax Rules <Employee>**
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Tax Information button.
5. Choose the Tax information button from the State Tax Rules <Employee> window.
6. Choose the Tax information button from the County Tax Rules <Employee> window.
COBRA Benefits
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.
5. Enter or query a qualifying event.
6. Choose the Benefits button.

COBRA Coverage
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.

COBRA Payments
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.
5. Enter or query a qualifying event.
6. Choose the Payments button.

COBRA Statuses
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.
5. Enter or query a qualifying event.
6. Choose the Statuses button.

Columns
1. Choose Other Definitions –> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Columns button.

**Competence Profile**
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Competence Profile.

**Competence Requirements**
- Choose Career Management → Competence Requirements in the Navigator.

**Competence Types**
- Choose Career Management → Competence Types in the Navigator.

**Competencies**
- Choose Career Management → Competencies in the Navigator.

**Concurrent Requests**
- Choose Processes and Reports → View Requests in the Navigator.

**Consolidation Sets** (Oracle Payroll only)
- Choose Payroll → Consolidation in the Navigator.

**Contact**
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
Or:
1. Choose People → Fastpath → Contact in the Navigator.
2. In the resulting Find window, query the person.

**Control Totals**
2. Choose the Totals button.
Costing
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Costing.
Or:
1. Choose People -> Fastpath -> Costing in the Navigator.
2. In the resulting Find window, query the person.

Costing Information
2. Enter or query an organization.
3. Choose the Others button and select Costing Information.

County Tax Rules <Employee>
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Tax Information button.
5. Choose the Tax information button from the State Tax Rules <Employee> window.

Covered Dependents
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
4. Choose the Entries button.
5. Select the element representing the benefit for which you are entering a dependent.
6. Choose the Others button and select Dependents.
Custom Reports
- Choose Processes and Reports → Submit Custom Reports in the Navigator.

Database Items
1. Choose Compensation and Benefits → Write Formulas in the Navigator.
2. Enter or query a formula.
3. Choose the Show Items button.

DateTrack History Change Field Summary
- Choose the DateTrack History icon from the toolbar.

Deduction (Oracle Payroll only)
- Choose Compensation and Benefits → Deductions in the Navigator.

Define Function
- Choose Other Definitions → Formula Functions in the Navigator.

Define QuickPaint Report
- Choose Processes and Reports → Define a QuickPaint Report in the Navigator.

Define Task Flow

Define Task Flow Nodes
- Choose Security → Task Flow Nodes in the Navigator.

Delete Person
- Choose People → Delete Personal Records in the Navigator.

Earnings (Oracle Payroll only)
- Choose Compensation and Benefits → Earnings in the Navigator.

Earnings Entry (Oracle Payroll only)
2. Enter or query batch totals.
3. Choose the Details button.

**Edit Formula**
1. Choose Compensation and Benefits \( \rightarrow \) Write Formulas in the Navigator.
2. Enter or query a formula.
3. Choose the Edit button.

**EEO–1 Filing**
1. Choose Work Structures \( \rightarrow \) Organization \( \rightarrow \) Description in the Navigator.
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select EEO–1 Filing.

**Element**
- Choose Compensation and Benefits \( \rightarrow \) Element Description in the Navigator.

**Element and Distribution Set**
- Choose Payroll \( \rightarrow \) Element Set in the Navigator.

**Element Classifications**  (Oracle Payroll only)
- Choose Compensation and Benefits \( \rightarrow \) Classification in the Navigator.

**Element Entries**
Do one of the following:
1. Choose People \( \rightarrow \) Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Entries button.

Or:
1. Choose People \( \rightarrow \) Fastpath \( \rightarrow \) Element Entries in the Navigator.
2. In the resulting Find window, query the person.

**Element Link**
- Choose Compensation and Benefits \( \rightarrow \) Link in the Navigator.
**Employee Assignment Processes** (Oracle Payroll only)
- Choose View -> Assignment Process Results in the Navigator.

**Employee Review**
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reviews.
Or:
1. Choose People -> Fastpath -> Employee Review in the Navigator.
2. In the resulting Find window, query the person.

**Employee Run Result History** (Oracle Payroll only)
- Choose View -> Histories -> Run Results in the Navigator.

**Employer Identification**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Employer Identification

**Entry Values**
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Entries button.
5. Select an entry and choose the Entry Values button.

**Establishment EEO–1 Filing**
2. Enter or query a Reporting Establishment.
3. Choose the Others button and select Establishment EEO–1 Filing.
Establishment VETS–100 Filing
2. Enter or query a Reporting Establishment.
3. Choose the Others button and select Establishment VETS–100 Filing.

Event Bookings
Do one of the following:
- Choose People –> Events and Bookings in the Navigator.
Or:
2. In the resulting Find window, query the person.

Exchange Rates (Oracle Payroll only)
- Choose Payroll –> Exchange Rates in the Navigator.

Exemption Rules
- Choose View –> Wage Attachments –> Exemption Rules

External/Manual Payments (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select External Pay.
Or:
2. In the resulting Find window, query the person.

Federal Tax Rules
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Federal Tax Rules
Federal Tax Rules <Employee>
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Tax Information button.

Form 941 Information
- Choose View –> Tax Information –> Form 941 Information in the Navigator.

Form Customization
- Choose Security –> CustomForm in the Navigator.

Formula
- Choose Compensation and Benefits –> Write Formulas in the Navigator.

Formula Result Rules (Oracle Payroll only)
- Choose Compensation and Benefits –> Formula Results in the Navigator.

Frequency Rules
2. Enter or query a deduction.
3. Choose the Frequency Rules button.

GL Map (Oracle Payroll only)
- Choose Payroll –> GL Flexfield Map in the Navigator.

Globals
- Choose Compensation and Benefits –> Global Values in the Navigator.

Grade Rate
- Choose Work Structures –> Grade –> Grade Rate in the Navigator.

Grade Scale
- Choose Work Structures –> Grade –> Grade Steps and Points in the Navigator.
Grade Step Placement

Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Grade Step.

Or:
1. Choose People –> Fastpath –> Grade Step Placement in the Navigator.
2. In the resulting Find window, query the person.

Grades

Choose Work Structures –> Grade –> Description in the Navigator.

Input Values

1. Choose Compensation and Benefits –> Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.

Job

Choose Work Structures –> Job –> Description in the Navigator.

Job Evaluation

2. Enter or query a job.
3. Choose the Evaluation button.

Job Requirements

2. Enter or query a job.
3. Choose the Requirements button.

Letter

Choose Work Structures –> Recruitment Letter Type in the Navigator.
Limit Rules
- View –> Wage Attachments –> Limit Rules

Link Input Values
1. Choose Compensation and Benefits –> Link in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.

List Assignments
- Choose View –> Lists –> Assignments in the Navigator.

List Budget Variance by Organization
- Choose View –> Organization Budgets in the Navigator.

List Employees by Absence Type
- Choose View –> Lists –> Employees by Absence Type in the Navigator.

List Employees by Element
- Choose View –> Lists –> Employees by Element in the Navigator.

List Employees by Organization
- Choose View –> Lists –> Employees by Organization in the Navigator.

List Employees by Position
- Choose View –> Lists –> Employees by Position in the Navigator.

List Employees by Position Hierarchy
- Choose View –> Lists –> Emps by Position Hierarchy in the Navigator.

List People by Assignment
- Choose View –> Lists –> People by Assignment in the Navigator.

List People by Special Information
- Choose View –> Lists –> People by Special Information in the Navigator.
**List Position Budget Variance**
- Choose View -> Position Budgets in the Navigator.

**Local Tax Rules**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Local Tax Rules.

**Location**
- Choose Work Structures -> Location in the Navigator.

**Map Career Path**
- Choose Work Structures -> Job -> Career Path in the Navigator.

**Mass Move**
- Choose Work Structures -> Mass Update in the Navigator.

**Mass Move – Assignments**
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Assignments button.

**Mass Move – Messages**
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window and choose the Find button.
5. Complete the Mass Move – Positions window and choose the Assignments button.
6. Complete the Mass Move – Assignments window and close it.
7. From the Mass Move – Positions window, choose the Valid Grades button.
8. Complete the Valid Grades window and close it.
10. From the Mass Move window, choose the Execute button.
11. If the Status field shows In Error or Complete with Warnings, a Message button appears.
12. If the Message button appears, choose it to view messages in the Mass Move – Messages window.
   **Note:** Alternatively, you can view messages for saved (but not yet successfully executed) mass moves as follows:
   2. Enter the name of the saved mass move in the Description field.
   3. When the Mass Move window is populated with data and the Message button appears, choose the Message button.

**Mass Move – Positions**
2. Complete the Mass Move window.
3. Save your work.
4. Choose the Positions button.
5. In the resulting Find Positions window, select or enter a Source Job and Source Position.
6. Choose the Find button.

**Mass Move – Valid Grades**
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Valid Grades button.
**Mass Update of Applicants**

- Choose Recruitment -> Mass Update of Applicants in the Navigator.

**Messages**

2. Choose the Messages button.

**MIX Batch Entry Default Values (Oracle Payroll only)**

2. Choose the Defaults button.

**MIX Batch Header**

- Choose Mass Information eXchange: MIX -> Batch Element Entry in the Navigator.

**MIX Batch Lines**

2. Choose the Lines button.

**Multiple Worksite Reporting**

2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Multiple Worksite Reporting

**NACHA Rules**

2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select NACHA Rules

**Net Calculation Rules**

2. Enter or query an accrual plan name.
3. Choose the Net Calculation Rules button.

**New Hire Reporting**
2. Enter or query a GRE.
3. Choose the Others button.
4. Select New Hire Reporting
5. Click in the Additional Organization Information field.

**Organization**
- Choose Work Structures -> Organization -> Description in the Navigator.

**Organization Hierarchy**
- Choose Work Structures -> Organization -> Hierarchy in the Navigator.

**Organizational Payment Method**
- Choose Payroll -> Payment Methods in the Navigator.

**Parent Organization**
2. Enter or query an organization.
3. Choose the Others button and select Parent Organization.

**Pay Scale**
- Choose Work Structures -> Grade -> Pay Scale in the Navigator.

**PayMIX Batch Information** (Oracle Payroll only)
- Choose Mass Information eXchange: MIX -> PayMIX Entry in the Navigator.

**PayMIX Batch Summary** (Oracle Payroll only)
- Choose Mass Information eXchange: MIX -> PayMIX Summary in the Navigator.
PayMIX Information (Oracle Payroll only)
2. Enter or query a Business Group.
3. Choose the Others button and select PayMIX Information.

Payroll
- Choose Payroll -> Description in the Navigator.

Payroll Processes (Oracle Payroll only)
- Choose View -> Payroll Process Results in the Navigator.

People
- Choose People -> Enter and Maintain in the Navigator.

People Folder
- Choose View -> Lists -> People Folder in the Navigator.

Percentage
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee, and choose the Assignment button.
3. Choose the Tax Information button.
4. Choose the Percentage button.

Performance
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee, and choose the Assignment button.
3. Choose the Salary button.
4. Choose the Performance button.

Period Dates
1. Choose Payroll -> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Period Dates button.
Period Types
- Choose Other Definitions –> Time Periods in the Navigator.

Person Types
- Choose Other Definitions –> Person Types in the Navigator.

Personal Payment Method
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Pay Method button, or choose the Others button and select Pay Method.

Or:
2. In the resulting Find window, query the person.

Personal Profile Values
- Choose Other Definitions –> User Profile Options in the Navigator.

Phone Numbers
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose Phones.

Or:
1. Choose People –> Fastpath –> Phone Numbers in the Navigator.
2. In the resulting Find window, query the person.

Picture
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator
2. Enter or query a person.
3. Choose the Picture button.

Or:
2. In the resulting Find window, query the person.

**Position**
- Choose Work Structures –> Position –> Description in the Navigator.

**Position Evaluation**
2. Enter or query a position.
3. Choose the Evaluation button.

**Position Hierarchy**

**Position Occupancy Folder**
2. Query a position.
3. Choose the Occupancy button.

**Position Reporting To**
2. Enter or query a position.
3. Choose the Reporting To button.

**Position Requirements**
2. Enter or query a position.
3. Choose the Requirements button.
Qualifications
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Qualifications.

Qualification Types
- Choose Career Management -> Qualification Types in the Navigator.

QuickCode Type Usages
1. Choose Other Definitions -> QuickCode Types in the Navigator.
2. Enter or query a user-defined Type.
3. Choose the Usages button.

QuickCode Types
- Choose Other Definitions -> QuickCode Types in the Navigator.

QuickCodes
- Choose Other Definitions -> QuickCode Values in the Navigator.

QuickPaint Inquiry
2. Query a report that has been run.
3. Choose the View Report button.

QuickPay (Oracle Payroll only)
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select QuickPay.
Or:
1. Choose People -> Fastpath -> QuickPay in the Navigator.
2. In the resulting Find window, query the person.
Rating Scales
- Choose Career Management -> Rating Scales in the Navigator.

Recruiting For
2. Enter or query a recruitment activity.
3. Choose the Recruiting For button.

Recruitment Activity
- Choose Recruitment -> Recruitment Activity in the Navigator.

Reporting Categories
2. Enter or query a Business Group.
3. Choose the Others button and select Reporting Categories.

Reporting Statuses
2. Enter or query a Business Group.
3. Choose the Others button and select Reporting Statuses.

Request Letter
- Choose Recruitment -> Request Recruitment Letter in the Navigator.

Request Set

Requisition and Vacancy
- Choose Recruitment -> Requisition and Vacancy in the Navigator.

RetroPay Set (Oracle Payroll only)
- Choose Payroll -> RetroPay Set in the Navigator.

Reverse Payroll Run (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reverse Run.
   Or:
2. In the resulting Find window, query the person.

**Rows**
1. Choose Other Definitions –> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Rows button.

**Run QuickPaint Report**
- Choose Processes and Reports –> Run a QuickPaint Report in the Navigator.

**Salary Administration**
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Salary button.
   Or:
2. In the resulting Find window, query the person.

**Salary Basis**
- Choose Work Structures –> Salary Basis in the Navigator.

**Salary History**
Do one of the following:
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Salary History button.

Or:
2. In the resulting Find window, query the person.

Salary Management Folder
- Choose People –> Salary Management in the Navigator.

Scale Rate
- Choose Work Structures –> Grade –> Point Values in the Navigator.

Schools and Colleges
- Choose Career Management –> Schools and Colleges in the Navigator.

Schools and Colleges (Attended)
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Schools/Colleges.

Secondary Statuses
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an applicant or employee.
3. Do one of the following:
   - For an applicant:
     - Choose the Others button and select Application.
     - Choose the Secondary Status button.
   - For an employee:
     - Choose the Assignment button.
     - Choose the Others button and select Secondary Status.

Or:
2. In the resulting Find window, query the person.

Security Profile

Choose Security –> Profile in the Navigator.

Special Information

Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Special Info button.
Or:
1. Choose People –> Fastpath –> Special Information in the Navigator.
2. In the resulting Find window, query the person.

Special Information Types

Choose Other Definitions –> Special Information Types in the Navigator.

SQWL Employer Rules (1) (Oracle Payroll only)
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL Employer Rules (1)

SQWL Employer Rules (2) (Oracle Payroll only)
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL Employer Rules (2)

SQWL Generic Transmitter Rules (Oracle Payroll only)
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL Generic Transmitter Rules

**SQWL State-Specific Transmitter Rules** (Oracle Payroll only)
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL State Transmitter Rules

**State Tax Rules**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select State Tax Rules.

**State Tax Rules <Employee>**
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Tax Information button.

**Statement of Earnings** (Oracle Payroll Only)
Do one of the following:
1. Choose View → Assignment Process Results
2. Choose the SOE Report button.
   Or:
   1. Choose People → Enter and Maintain in the Navigator.
   2. Enter or query an employee.
   3. Choose the Assignment button.
   4. Choose the Others button and select Statement of Earnings.
   Or:
   1. Choose People → Fastpath → Statement of Earnings in the Navigator.
   2. In the resulting Find window, query the person.
Submit a New Request
1. Choose Processes and Reports -> Submit Processes and Reports in the Navigator.
2. Select Single Request or a Request Set.

Table Structure
- Choose Other Definitions -> Table Structure in the Navigator.

Table Values
- Choose Other Definitions -> Table Values in the Navigator.

Taxability Rules (Oracle Payroll only)
- Choose Compensation and Benefits -> Tax Withholding Rules in the Navigator.

Tax Balances (Oracle Payroll only)
1. Choose View -> Tax Information in the Navigator.
2. Choose the Tax Balances button.

Tax Rules
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
4. Choose the Tax Information button.

Terminate
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Employment.
Or:
1. Choose People -> Fastpath -> End Employment in the Navigator.
2. In the resulting Find window, query the person.

Terminate Applicant
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Application.

**Update Payroll Run** (Oracle Payroll only)
- Choose Payroll -> Update Payroll Run in the Navigator.

**Valid Grades**
2. Choose either Job -> Description or Position -> Description.
3. Enter or query a job or position.
4. Choose the Valid Grades button.

**Valid Payment Methods**
1. Choose Payroll -> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Valid Payment Methods button.

**VETS–100 Filing**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select VETS–100 Filing.

**View Absence History**
- Choose View -> Histories -> Absence in the Navigator.

**View Earnings and Deductions Balances**
Do one of the following:
1. Choose View -> Employee Balances in the Navigator.
2. Select an employee assignment and choose the Balances button.

Or:
1. Choose People -> Fastpath -> Employee Balances in the Navigator.
2. In the resulting Find window, query the person.

**View Element Entry History for Employee**
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Entry History button.

**View Employee Dental, Medical and Vision Benefits**
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the View Benefits button.

**View Employee Grade Comparatio**
- Choose View –> Grade Comparatio in the Navigator.

**View Run Messages** (Oracle Payroll only)
- Choose View –> System Messages in the Navigator.

**View Tax Balances**
Do one of the following:
2. Select an employee assignment and choose the Balances button.
   Or:
   2. In the resulting Find window, query the person.

**View Vacancies**
- Choose View –> Vacancies in the Navigator.

**W2 Reporting Rules**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select W2 Reporting Rules.

**W941** (Oracle Payroll only)
- Choose View –> Tax Information –> Form 941 Information in the Navigator.
WC Codes and Rates
- Choose Work Structures -> Job -> Workers Compensation Rates in the Navigator

Wage Attachment Earnings Rules
- Choose Compensation and Benefits -> Wage Attachments Earnings Rules in the Navigator.

Work Choices (Job or Position)
1. Choose Organization -> Job or Position -> Description in the Navigator.
2. Enter or query a job or position.
3. Choose the Work Choices button.

Work Choices (Person)
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Work Choices.

Work Day Information
2. Enter or query an organization.
3. Choose the Others button and select Work Day Information.

Work Schedule
2. Enter or query an organization.
3. Choose the Others button and select Work Schedule.

Work Site Filing
2. Enter or query a Reporting Establishment.
3. Choose the Others button and select Work Site Filing.
Worker’s Compensation

- Choose Work Structures –> Job –> Workers Compensation Codes in the Navigator
Key and Descriptive Flexfields

A flexfield is a flexible field that allows you to customize and extend Oracle Applications. Each flexfield has the characteristics of separate fields known as segments. There are two types of flexfield:

- Descriptive flexfields allow you to define additional information you want to record in the windows.
- Key flexfields are the mechanism by which you customize some important parts of the system.

Both types of flexfield have also been used by localization teams to customize Oracle HRMS for your legislation.

This chapter lists the flexfields in Oracle HRMS and summarizes what you need to set up.
User Definable Key Flexfields

In Oracle HRMS there are six user definable key flexfields, for each of which you can define up to 30 segments:

- Job
- Position
- Grade
- People Group
- Personal Analysis
- Cost Allocation

The Personal Analysis key flexfield is different from the others. You can set up an unlimited number of structures for this flexfield. Each separate structure can have up to 30 segments.

How the Key Flexfields Are Used

Oracle HRMS uses key flexfields in a number of distinct ways:

**Unique Identifiers**

The Job, Position, and Grade Name flexfields let you create a unique name, which is a combination of separate components or segments. You use these flexfields when you are defining the work structures that exist in your enterprise.

**Suggestion:** When you are defining your requirements for these key flexfields you should consider the following points.

The task of defining the segment combinations is normally restricted to one or two users only. Therefore, you may not need to use value sets, or cross validation rule options to control the values that can be entered.

The names that users see are made up of a combination of segment values. The segment values are displayed, not the meanings.

Avoid segments containing information that may change regularly. There is no history of changes to the combinations you create. For example, do not define minimum and maximum values for grades as segments of the Grade flexfield.
Analysis Information

The People Group and Personal Analysis flexfields let you add key information to records of employee assignments and people. You can use the individual segments of these flexfields to identify or report on specific groups of people.

Payroll Costing

The Cost Allocation key flexfield is used to collect and to accumulate costs associated with running a payroll.

What You Must Set Up

The key flexfields are central to Oracle HRMS, therefore you must create certain definitions before you can set up your Business Group.

Job, Position, And Grade Key Flexfields

- You can only define one structure per Business Group for each of these flexfields.
- You can define up to 30 segments within the structure.
- Use of these flexfields is optional, but almost all Oracle HRMS installations use job and grade. Positions are used most often in large, highly structured enterprises, such as those in the areas of government, education, and health care.
- You must define a structure name for these three flexfields before you can define a Business Group.
- You associate these structures with a Business Group in the Business Group Information window, which opens from the Organization window.

People Group Key Flexfield

- You can only define one structure per Business Group for this flexfield.
- You can define up to 30 segments within the structure.
- You do not create separate combinations of segments for the People Group flexfield. You enter values for each employee as part of the employee assignment.
- You must define a structure name for this flexfield before you can define a Business Group.
• You must define at least one segment for the People Group flexfield in order to be able to use the Assignment window.

**Personal Analysis Key Flexfield**

• You can create any number of structures per Business Group for this flexfield. Each one represents a Special Information Type.

• You can define up to 30 segments within each structure.

• You do not need to define any structures for the Personal Analysis flexfield before you can use Oracle HRMS.

• You link each structure to a Business Group in the Special Information Types window while you are logged on to that Business Group.

• You can customize windows to restrict access to specific Information Types, such as medical or disciplinary information.

**Cost Allocation Key Flexfield**

• You can only define one structure per Business Group for this flexfield.

• You can define up to 30 segments within the structure.

• You can control the levels at which users can enter cost information by using the flexfield qualifiers.

• You must define a structure name for this flexfield before you can define a Business Group.

• A number of windows in Oracle HRMS check for the existence of a valid flexfield structure for Cost Allocation. You must define at least one segment for your Cost Allocation flexfield.

**Creating Key Flexfield Database Items**

The *Create Key Flexfield DB Items* process turns data in key flexfields into database items that Oracle FastFormula can access. It is essential to run this process whenever you create or change the Grade, Job, Position, or People Group key flexfield definitions. Submit the process from the Submit Requests window.

**See Also**

*Oracle Applications Flexfields Guide*
User Definable Descriptive Flexfields

All window blocks in which you can enter information contain a user definable descriptive flexfield. You decide in which blocks you want to record additional information. Each user definable descriptive flexfield has 20 segments that you can define. After you define a descriptive flexfield, Oracle HRMS treats the segments as part of the window.

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the window.
- Context sensitive segments, that appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same block.

For example, a segment to hold information about an employee’s disability might appear only when the Disabled field is checked.

**Attention:** Some descriptive flexfields appear in more than one window. For example, the Additional Evaluation Details flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

Refer to Table B – 1 for a full list of descriptive flexfields in Oracle HRMS.
Creating Descriptive Flexfield Database Items

You can use descriptive flexfield segments in QuickPaint reports and formulas if there are database items for these segments. Table B – 1 marks the descriptive flexfields for which you can create database items. To do this you run the Create Descriptive Flexfield DB Items process. It is essential to run this process from the Submit Requests window whenever you create or change these descriptive flexfield definitions.

**Note:** The process can only create database items for global segments. It does not create database items for context-sensitive segments.

List of Descriptive Flexfields

The following table lists all the descriptive flexfields in Oracle HRMS.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Absence Details</td>
<td>Absence Detail, View Absence History</td>
<td>ABSENCES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Absence Type Details</td>
<td>Absence Attendance Type</td>
<td>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Address Details</td>
<td>Address, Applicant Entry, Contact</td>
<td>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Application Details</td>
<td>Applicant Entry, Application, Terminate Applicant</td>
<td>APPLICATIONS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Details</td>
<td>Applicant Entry, Application, Assignment, Assignment History</td>
<td>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Status Details</td>
<td>Secondary Statuses</td>
<td></td>
</tr>
<tr>
<td>Additional Balance Type Information</td>
<td>Balance (Oracle Payroll only)</td>
<td></td>
</tr>
<tr>
<td>Additional Benefit Contribution Details</td>
<td>Benefit Contributions (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Booking Details</td>
<td>Applicant Interview, Book Events, Employee Review, Event Bookings</td>
<td></td>
</tr>
</tbody>
</table>

Table B – 1  User Definable Descriptive Flexfields
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Budget Details</td>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>Additional Budget Version Details</td>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>Additional Calendar Information</td>
<td>Budgetary Calendar</td>
<td></td>
</tr>
<tr>
<td>Additional Career Path Details</td>
<td>Career Path Names</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Benefit Details</td>
<td>COBRA Benefits (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Coverage Details</td>
<td>COBRA Coverage (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Payment Details</td>
<td>COBRA Payment (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Status Details</td>
<td>COBRA Status (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Contact Relationship Details</td>
<td>Contact</td>
<td>CONTACTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Element Entry Information</td>
<td>Adjust Balance (Oracle Payroll only), Element Entries, View Element Entry History for Employee</td>
<td></td>
</tr>
<tr>
<td>Additional Element Link Information</td>
<td>Element Link</td>
<td></td>
</tr>
<tr>
<td>Additional Element Type Details</td>
<td>Element</td>
<td></td>
</tr>
<tr>
<td>Additional Evaluation Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Event Details</td>
<td>Applicant Interview, Employee Review, Event Bookings</td>
<td></td>
</tr>
<tr>
<td>Additional Event Details</td>
<td>EVENTS_&lt;SEGMENT_NAME&gt;</td>
<td></td>
</tr>
<tr>
<td>Additional Grade Details</td>
<td>Grade</td>
<td>GRADES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Job Details</td>
<td>Job</td>
<td>JOBS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Letter Details</td>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td>Additional Location Details</td>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Information</td>
<td>Organization</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Payment Method Details</td>
<td>Organizational Payment Method</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Structure Detail</td>
<td>Organization Hierarchy</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Unit Details</td>
<td>Organization</td>
<td>ORGANIZATION_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Pay Scale Information</td>
<td>Pay Scale</td>
<td></td>
</tr>
</tbody>
</table>

**Table B – 1  User Definable Descriptive Flexfields**
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Pay Rate Details</td>
<td>Grade Rate, Scale Rate</td>
<td></td>
</tr>
<tr>
<td>Additional Payroll Details</td>
<td>Payroll</td>
<td>PAYROLLS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Period Information</td>
<td>Budgetary Calendar, Period Dates (Payroll form)</td>
<td></td>
</tr>
<tr>
<td>Additional Period of Service Details</td>
<td>Terminate</td>
<td>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Period Type Information</td>
<td>Period Types</td>
<td></td>
</tr>
<tr>
<td>Additional Person Analysis Details</td>
<td>Special Information, List People By Special Information</td>
<td></td>
</tr>
<tr>
<td>Additional Personal Details</td>
<td>Applicant Entry, Contact, People, People Folder</td>
<td>PEOPLE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Personal Payment Method Details</td>
<td>Personal Payment Method</td>
<td></td>
</tr>
<tr>
<td>Additional Position Details</td>
<td>Position, Find Positions (Mass Move form)</td>
<td>POSITION_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Position Structure Details</td>
<td>Position Hierarchy</td>
<td></td>
</tr>
<tr>
<td>Additional Recruitment Activity Details</td>
<td>Recruitment Activity</td>
<td>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Requirement Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Requisition Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Administration Details</td>
<td>Salary Administration</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Basis Information</td>
<td>Salary Basis</td>
<td></td>
</tr>
<tr>
<td>Additional Telephone Number Details</td>
<td>Phone Numbers</td>
<td></td>
</tr>
<tr>
<td>Additional Vacancy Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Valid Grade Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Year Information</td>
<td>Budgetary Calendar</td>
<td></td>
</tr>
</tbody>
</table>

Table B – 1 User Definable Descriptive Flexfields
Descriptive Flexfields with Startup Data

Oracle HRMS supplies two predefined descriptive flexfields to hold address information in different styles for different countries. These are the Personal Address Information descriptive flexfield and the Location Address descriptive flexfield.

You can use these descriptive flexfields to add new address styles or to change the styles included in Oracle HRMS.

**Attention:** If you change the predefined styles, your changes will be overwritten when you upgrade Oracle HRMS. If you add new styles, your changes may be overwritten if new startup data contains address styles for these countries.

Changing Address Styles

Address styles vary between countries, so Oracle HRMS provides two descriptive flexfields that use context sensitive segments to hold each line of an address.

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Address Information</td>
<td>PER_ADDRESSES</td>
<td>Address, Applicant Entry</td>
</tr>
<tr>
<td>Location Address</td>
<td>HR_LOCATIONS</td>
<td>Location, Organization</td>
</tr>
</tbody>
</table>

Table B – 2  Address Styles in Oracle HRMS

The available address styles are defined as the contexts for these flexfields. The values used are the territory codes. These codes can be found in the FND_TERRITORIES table. You can have only one Address Style for each Territory in the FND_TERRITORIES table.

Address styles are provided as startup data in these flexfields. If you require additional address styles, you need to define a new context and segments.

To change the address style for any country, disable those segments you do not want to use. Then define new segments to record your own information. However, these changes will be overwritten when you upgrade Oracle HRMS.
Protected Flexfields

Oracle HRMS supplies two key flexfields and six descriptive flexfields that are predefined and protected. Your localization team defines these flexfields to meet the specific legislative and reporting needs of your country.

The protected key flexfields are the Soft Coded Legislation key flexfield and the Bank Details key flexfield.

Table B – 3 lists the protected descriptive flexfields.

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Further Element Information</td>
<td>PAY_ELEMENT_TYPES_F</td>
<td>Element</td>
</tr>
<tr>
<td>Further Assignment Information</td>
<td>PER_ASSIGNMENT_EXTRA_INFO</td>
<td>Assignment</td>
</tr>
<tr>
<td>Further Payment Method Information</td>
<td>PAY_ORG_PAYMENT_METHODS_F</td>
<td>Organizational Payment Method</td>
</tr>
<tr>
<td>Further Person Information</td>
<td>PER_PEOPLE_F</td>
<td>People, Applicant Entry</td>
</tr>
<tr>
<td>Further Person Information</td>
<td>PER_PEOPLE_EXTRA_INFO</td>
<td>People</td>
</tr>
<tr>
<td>Further Job Information</td>
<td>PER_JOB_EXTRA_INFO</td>
<td>Job</td>
</tr>
<tr>
<td>Further Position Information</td>
<td>PER_POSITION_EXTRA_INFO</td>
<td>Position</td>
</tr>
<tr>
<td>Further Organization Information</td>
<td>HR_ORGANIZATION_INFORMATION</td>
<td>Organization</td>
</tr>
<tr>
<td>Further Location Information</td>
<td>HR_LOCATION_EXTRA_INFO</td>
<td>Location</td>
</tr>
</tbody>
</table>

Table B – 3 Protected Descriptive Flexfields in Oracle HRMS

Your localization team determines which of these flexfields are required for your legislation, and what segments they should contain. Ensure that you select the appropriate legislation code when you define your Business Group so that you can see these flexfields.

⚠️ **Warning:** Do not attempt to alter the definitions of these protected flexfields. These definitions are a fundamental part of Oracle HRMS. Any change to them may lead to errors in the operating of the system.

It is possible that Oracle HRMS will use other segments of these flexfields in the future. Therefore, do not add segments to any protected flexfield. This can affect your ability to upgrade your system in the future.
Soft Coded Legislation Key Flexfield

This key flexfield holds legislation–specific information. The legislation of your Business Group determines the flexfield structure that you see.

Each localization team defines a flexfield structure and uses qualifiers to define the level at which each segment is visible. Therefore, you may be able to enter information specific to your legislation at one or more of the following levels:

- Business Group – Organization window
- Payroll – Payroll window
- Employee Assignment – Assignment window

Bank Details Key Flexfield

This flexfield holds legislation–specific bank account information. The legislation of your Business Group determines the flexfield structure that you see. Each localization team defines a flexfield structure that allows you to record the bank account information relevant to your legislation. You enter this information in the Organizational Payment Method window and Personal Payment Method window.
This appendix lists the database items available to you in Oracle Payroll for writing formulas and defining QuickPaint reports. The database items are grouped into two listings:

- Static Database Items
- Dynamic Database Items

Static database items are shipped with the system and you cannot modify them. Dynamic database items are created by Oracle Payroll processes whenever you define new elements or other related entities.
Static Database Items

Static database items are shipped with the system and you cannot modify them.

Applicant Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APL_DATE_END</td>
<td>The date the application ended</td>
</tr>
<tr>
<td>APL_DATE_RECEIVED</td>
<td>The date the application was received</td>
</tr>
</tbody>
</table>

Table C – 1

Employee Assignment Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_ASSIGNMENT_SEQUENCE</td>
<td>This is used as a default for assignment number</td>
</tr>
<tr>
<td>ASG_DATE_FROM</td>
<td>The date from which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_DATE_TO</td>
<td>The date to which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_EMPLOYMENT_CATEGORY</td>
<td>The employment category for the assignment</td>
</tr>
<tr>
<td>ASG_END_TIME</td>
<td>The standard end time for the assignment</td>
</tr>
<tr>
<td>ASG_FREQ</td>
<td>The frequency for which the assignment working hours are measured</td>
</tr>
<tr>
<td>ASG_GRADE</td>
<td>The employee’s grade</td>
</tr>
<tr>
<td>ASG_GRADE_DATE_FROM</td>
<td>The date from which this assignment grade information is effective</td>
</tr>
<tr>
<td>ASG_GRADE_DATE_TO</td>
<td>The date to which this assignment grade information is effective</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_GROUP</td>
<td>The employee’s group</td>
</tr>
<tr>
<td>ASG_HOURS</td>
<td>The standard number of working hours for the assignment</td>
</tr>
<tr>
<td>ASG_INT_ADDR_LINE</td>
<td>The internal address of the assignment</td>
</tr>
<tr>
<td>ASG_JOB</td>
<td>The employee’s job</td>
</tr>
<tr>
<td>ASG_JOB_DATE_FROM</td>
<td>The date from which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_JOB_DATE_TO</td>
<td>The date to which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_LAST_CHANGE_REASON</td>
<td>The reason the salary was changed</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_DATE</td>
<td>Last performance review date</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_LOCATION</td>
<td>Last performance review location</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_RATING</td>
<td>Last performance review rating</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_TYPE</td>
<td>Last performance review type</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PAYROLL_NAME</td>
<td>The payroll name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_ID</td>
<td>The time period ID the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NAME</td>
<td>The period name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NUMBER</td>
<td>The period number the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_CHANGE</td>
<td>The proposed salary change</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_PERCENT</td>
<td>The proposed salary change as a percentage</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_CHANGE_APPROVED</td>
<td>Whether the last proposed salary change has been approved</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_DATE</td>
<td>The last salary change date</td>
</tr>
<tr>
<td>ASG_LOCATION</td>
<td>The employee’s location</td>
</tr>
<tr>
<td>ASG_LOC_INACTIVE_DATE</td>
<td>The date to which the location information is effective</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_NEXT_PERFORMANCE_DATE</td>
<td>Next performance review date</td>
</tr>
<tr>
<td>ASG_NEXT_SALARY_DATE</td>
<td>The date of the next salary change</td>
</tr>
<tr>
<td>ASG_NUMBER</td>
<td>The assignment number</td>
</tr>
<tr>
<td>ASG_ORG</td>
<td>The employee's organization</td>
</tr>
<tr>
<td>ASG_ORG_DATE_FROM</td>
<td>The date from which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_ORG_DATE_TO</td>
<td>The date to which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_PAYROLL</td>
<td>The employee's payroll</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_FREQUENCY</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_PERIOD</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PER_STATUS_DP</td>
<td>Personal status for the assignment (as of Date Paid)</td>
</tr>
<tr>
<td>ASG_POSITION</td>
<td>The employee's position</td>
</tr>
<tr>
<td>ASG_POS_DATE_FROM</td>
<td>The date from which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_DATE_TO</td>
<td>The date to which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_END_TIME</td>
<td>The standard end time for the assignment position</td>
</tr>
<tr>
<td>ASG_POS_FREQ</td>
<td>The frequency for which the assignment position's hours is measured</td>
</tr>
<tr>
<td>ASG_POS_HOURS</td>
<td>The standard number of working hours for the position</td>
</tr>
<tr>
<td>ASG_POS_PROB_PERIOD</td>
<td>The probation period for the assignment position</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_POS_START_TIME</td>
<td>The standard start time for the assignment position</td>
</tr>
<tr>
<td>ASG_PRIMARY</td>
<td>Whether this is the employee’s primary assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_PROB_END_DATE</td>
<td>The probation period end date</td>
</tr>
<tr>
<td>ASG_PROB_PERIOD</td>
<td>The assignment’s probation period</td>
</tr>
<tr>
<td>ASG_PROB_UNITS</td>
<td>The units of the assignment’s probation period</td>
</tr>
<tr>
<td>ASG_REC_FULL_NAME</td>
<td>The full name for the recruiter</td>
</tr>
<tr>
<td>ASG_RELIEF</td>
<td>The relief position if the current position holder is absent</td>
</tr>
<tr>
<td>ASG_SALARY</td>
<td>The current salary for an employee</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS</td>
<td>The payment basis (i.e. frequency) for the assignment, e.g. monthly</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_CODE</td>
<td>The payment basis lookup code for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_NAME</td>
<td>The salary basis name for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT</td>
<td>The display element name</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT_VALUE_NAME</td>
<td>The display input value name</td>
</tr>
<tr>
<td>ASG_SALARY_GRADE_RATE</td>
<td>The display rate name</td>
</tr>
<tr>
<td>ASG_SALARY_RATE_BASIS</td>
<td>The salary rate basis</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_FREQUENCY</td>
<td>The salary review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_PERIOD</td>
<td>The salary review period for the assignment</td>
</tr>
<tr>
<td>ASG_START_DATE</td>
<td>The start date of the assignment</td>
</tr>
<tr>
<td>ASG_START_TIME</td>
<td>The standard start time for the assignment</td>
</tr>
<tr>
<td>ASG_STATUS</td>
<td>The primary status for the assignment</td>
</tr>
<tr>
<td>ASG_SUCCESSOR</td>
<td>The position name that will succeed into this position</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_SUP_FULL_NAME</td>
<td>The full name for the supervisor</td>
</tr>
<tr>
<td>ASG_TYPE</td>
<td>Whether this is an employee or applicant assignment</td>
</tr>
<tr>
<td>ASG_VACANCY</td>
<td>The name of the vacancy applied for</td>
</tr>
</tbody>
</table>

Table C ~ 2
# Contact Addresses

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_ADR_CITY</td>
<td>The name of the contact’s town or city</td>
</tr>
<tr>
<td>CON_ADR_COUNTRY</td>
<td>The name of the contact’s country</td>
</tr>
<tr>
<td>CON_ADR_DATE_FROM</td>
<td>The first date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_DATE_TO</td>
<td>The last date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_LINE_1</td>
<td>The first line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_2</td>
<td>The second line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_3</td>
<td>The third line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_PHONE_1</td>
<td>The contact’s first telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_2</td>
<td>The contact’s second telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_3</td>
<td>The contact’s third telephone number</td>
</tr>
<tr>
<td>CON_ADR_POSTAL_CODE</td>
<td>The contact’s postal code</td>
</tr>
<tr>
<td>CON_ADR_REGION_1</td>
<td>The first line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_2</td>
<td>The second line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_3</td>
<td>The third line of the contact’s region</td>
</tr>
</tbody>
</table>

Table C – 3
Contact Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_AGE</td>
<td>The contact’s age</td>
</tr>
<tr>
<td>CON_APP_NUMBER</td>
<td>The contact’s applicant number</td>
</tr>
<tr>
<td>CON_CURRENT_APP</td>
<td>Whether the contact is a current applicant (yes/no)</td>
</tr>
<tr>
<td>CON_CURRENT_EMP</td>
<td>Whether the contact is a current employee (yes/no)</td>
</tr>
<tr>
<td>CON_DATE_OF_BIRTH</td>
<td>The contact’s date of birth</td>
</tr>
<tr>
<td>CON_DISABLED</td>
<td>Whether the contact is disabled (yes/no)</td>
</tr>
<tr>
<td>CON_EMP_NUMBER</td>
<td>The contact’s employee number</td>
</tr>
<tr>
<td>CON_END_DATE</td>
<td>The date to which this contact information is effective</td>
</tr>
<tr>
<td>CON_FIRST_NAME</td>
<td>The contact’s first name</td>
</tr>
<tr>
<td>CON_FULL_NAME</td>
<td>The contact’s full name</td>
</tr>
<tr>
<td>CON_KNOWN_AS</td>
<td>The contact’s preferred name</td>
</tr>
<tr>
<td>CON_LAST_NAME</td>
<td>The contact’s last name</td>
</tr>
<tr>
<td>CON_MARITAL_STATUS</td>
<td>The contact’s marital status</td>
</tr>
<tr>
<td>CON_MIDDLE_NAMES</td>
<td>The contact’s middle names</td>
</tr>
<tr>
<td>CON_NATIONALITY</td>
<td>The contact’s nationality</td>
</tr>
<tr>
<td>CON_PERSON_TYPE</td>
<td>The contact’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>CON_RELATIONSHIP</td>
<td>The relationship of the contact to the employee</td>
</tr>
<tr>
<td>CON_SEX</td>
<td>The contact’s sex</td>
</tr>
<tr>
<td>CON_START_DATE</td>
<td>The date from which this contact information is effective</td>
</tr>
</tbody>
</table>

Table C – 4
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_TITLE</td>
<td>The contact’s title</td>
</tr>
<tr>
<td>CON_WORK_PHONE</td>
<td>The contact’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 4
### Employee Hire Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMP_HIRE_DATE</td>
<td>The employee’s hire date</td>
</tr>
<tr>
<td>EMP_LAST_PROCESS_DATE</td>
<td>The date the employee was last processed</td>
</tr>
<tr>
<td>EMP_LEAVING_REASON</td>
<td>The reason the employee left</td>
</tr>
<tr>
<td>EMP_TERM_ACCEPTED_BY</td>
<td>The person who accepted the employee’s notice</td>
</tr>
<tr>
<td>EMP_TERM_DATE</td>
<td>The employee’s termination date</td>
</tr>
</tbody>
</table>

Table C – 5

### Location Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_LINE_1</td>
<td>The first line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_2</td>
<td>The second line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_3</td>
<td>The third line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_POSTAL_CODE</td>
<td>The postal code for the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_REGION_1</td>
<td>The first line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_2</td>
<td>The second line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_3</td>
<td>The third line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_1</td>
<td>The assignment’s first work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_2</td>
<td>The assignment’s second work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_3</td>
<td>The assignment’s third work telephone number</td>
</tr>
</tbody>
</table>

Table C – 6
**Database Items**

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_CITY</td>
<td>The town or city where the assignment works</td>
</tr>
<tr>
<td>LOC_ADR_COUNTRY</td>
<td>The country where the assignment works</td>
</tr>
</tbody>
</table>

Table C – 6

**Work Address Details (US only)**

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_US_COUNTY</td>
<td>The assignment’s work county (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE</td>
<td>The assignment’s work state (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE_CODE</td>
<td>The assignment’s work state code (US only)</td>
</tr>
</tbody>
</table>

Table C – 7

**Work Address Details (UK only)**

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_UK_COUNTY</td>
<td>The assignment’s work county (UK only)</td>
</tr>
</tbody>
</table>

Table C – 8
## Payroll Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAY_PERIODS_PER_YEAR</td>
<td>The number of pay periods in the year</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_CUT_OFF_DATE</td>
<td>The cut off date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_DATE_PAID</td>
<td>The date the payroll was paid</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_DIRECT_DEPOSIT_DATE</td>
<td>The direct deposit date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_END_DATE</td>
<td>The end date of the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_ID</td>
<td>The ID of the time period for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_NAME</td>
<td>The period name for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_NUMBER</td>
<td>The current period number for the payroll</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_PAY_ADVICE_DATE</td>
<td>The pay advice date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC_PERIOD_START_DATE</td>
<td>The start date of the payroll period</td>
</tr>
</tbody>
</table>

Table C – 9
### People Addresses

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_CITY</td>
<td>The name of the person's town or city</td>
</tr>
<tr>
<td>PER_ADR_COUNTRY</td>
<td>The name of the person’s country</td>
</tr>
<tr>
<td>PER_ADR_DATE_FROM</td>
<td>The first date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_DATE_TO</td>
<td>The last date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_LINE_1</td>
<td>The first line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_LINE_2</td>
<td>The second line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_LINE_3</td>
<td>The third line of the person’s address</td>
</tr>
<tr>
<td>PER_ADR_PHONE_1</td>
<td>The person’s first contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_2</td>
<td>The person’s second contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_3</td>
<td>The person’s third contact number</td>
</tr>
<tr>
<td>PER_ADR_POSTAL_CODE</td>
<td>The person’s postal code</td>
</tr>
<tr>
<td>PER_ADR_REGION_1</td>
<td>The first line of the person’s region</td>
</tr>
<tr>
<td>PER_ADR_REGION_2</td>
<td>The second line of the person’s region</td>
</tr>
<tr>
<td>PER_ADR_REGION_3</td>
<td>The third line of the person’s region</td>
</tr>
</tbody>
</table>

Table C – 10

### Home Address Details (US only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_US_COUNTY</td>
<td>The person’s county (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE</td>
<td>The person’s state (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE_CODE</td>
<td>The person’s state code (US only)</td>
</tr>
</tbody>
</table>

Table C – 11
### Home Address Details (UK only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_UK_COUNTY</td>
<td>The person's home county (UK only)</td>
</tr>
</tbody>
</table>

Table C – 12
## People Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_AGE</td>
<td>The person’s age</td>
</tr>
<tr>
<td>PER_APPLICANT_NUMBER</td>
<td>The person’s applicant number</td>
</tr>
<tr>
<td>PER_CURRENT_APP</td>
<td>Whether the person is a current applicant (yes/no)</td>
</tr>
<tr>
<td>PER_CURRENT_EMP</td>
<td>Whether the person is a current employee (yes/no)</td>
</tr>
<tr>
<td>PER_DATE_OF_BIRTH</td>
<td>The person’s date of birth</td>
</tr>
<tr>
<td>PER_DATE_VERIFIED</td>
<td>The date the employee last verified his or her personal data</td>
</tr>
<tr>
<td>PER_DISABLED</td>
<td>Whether the person is disabled (yes/no)</td>
</tr>
<tr>
<td>PER_EMP_NUMBER</td>
<td>The person’s employee number</td>
</tr>
<tr>
<td>PER_FIRST_NAME</td>
<td>The person’s first name</td>
</tr>
<tr>
<td>PER_FULL_NAME</td>
<td>The person’s full name</td>
</tr>
<tr>
<td>PER_KNOWN_AS</td>
<td>The person’s preferred name</td>
</tr>
<tr>
<td>PER_LAST_NAME</td>
<td>The person’s last name</td>
</tr>
<tr>
<td>PER_MAIL_DESTINATION</td>
<td>The person’s mail destination</td>
</tr>
<tr>
<td>PER_MARITAL_STATUS</td>
<td>The person’s marital status</td>
</tr>
<tr>
<td>PER_MIDDLE_NAMES</td>
<td>The person’s middle names</td>
</tr>
<tr>
<td>PER_NATIONALITY</td>
<td>The person’s nationality</td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIER</td>
<td>The person’s national identifier</td>
</tr>
<tr>
<td>PER_PERSON_TYPE</td>
<td>Type of person – employee or applicant, for example</td>
</tr>
<tr>
<td>PER_PREV_LAST_NAME</td>
<td>The person’s previous last name</td>
</tr>
<tr>
<td>PER_SEND_EXPENSES</td>
<td>Where to send the person’s expenses (home/office)</td>
</tr>
<tr>
<td>PER_SEX</td>
<td>The person’s sex</td>
</tr>
</tbody>
</table>

Table C – 13
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_TITLE</td>
<td>The person’s title</td>
</tr>
<tr>
<td>PER_WORK_PHONE</td>
<td>The person’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 13
### Recruiter Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC_CURRENT_APP</td>
<td>Whether the recruiter is a current applicant (yes/no)</td>
</tr>
<tr>
<td>REC_CURRENT_EMP</td>
<td>Whether the recruiter is a current employee (yes/no)</td>
</tr>
<tr>
<td>REC_EMP_NUMBER</td>
<td>The recruiter’s employee number</td>
</tr>
<tr>
<td>REC_GRADE</td>
<td>The recruiter’s grade</td>
</tr>
<tr>
<td>REC_INT_ADDR_LINE</td>
<td>The recruiter’s internal address</td>
</tr>
<tr>
<td>REC_JOB</td>
<td>The recruiter’s job</td>
</tr>
<tr>
<td>REC_LOCATION</td>
<td>The recruiter’s work location</td>
</tr>
<tr>
<td>REC_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>REC_ORG</td>
<td>The name of the recruiter’s organization</td>
</tr>
<tr>
<td>REC_PERSON_TYPE</td>
<td>The recruiter’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>REC_POSITION</td>
<td>The recruiter’s position</td>
</tr>
<tr>
<td>REC_WORK_PHONE</td>
<td>The recruiter’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 14
## Supervisor Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUP_CURRENT_EMP</td>
<td>Whether the supervisor is a current employee (yes/no)</td>
</tr>
<tr>
<td>SUP_DATE_FROM</td>
<td>The date from which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_DATE_TO</td>
<td>The date to which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_EMP_NUMBER</td>
<td>The supervisor’s employee number</td>
</tr>
<tr>
<td>SUP_GRADE</td>
<td>The supervisor’s grade</td>
</tr>
<tr>
<td>SUP_INT_ADDR_LINE</td>
<td>The supervisor’s internal address</td>
</tr>
<tr>
<td>SUP_JOB</td>
<td>The supervisor’s job</td>
</tr>
<tr>
<td>SUP_LOCATION</td>
<td>The supervisor’s work location</td>
</tr>
<tr>
<td>SUP_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>SUP_ORG</td>
<td>The supervisor’s organization</td>
</tr>
<tr>
<td>SUP_PERSON_TYPE</td>
<td>The supervisor’s person type</td>
</tr>
<tr>
<td>SUP_POSITION</td>
<td>The supervisor’s position</td>
</tr>
<tr>
<td>SUP_WORK_PHONE</td>
<td>The supervisor’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 15

## Date Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SESSION_DATE</td>
<td>The effective date from FND_SESSIONS</td>
</tr>
<tr>
<td>SYSDATE</td>
<td>The system date</td>
</tr>
</tbody>
</table>

Table C – 16
Dynamic Database Items

Dynamic database items are created by Oracle Payroll processes whenever you define new elements or other related entities.

Element Database Items

When you define a new element, Oracle Payroll runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the element name <ENAME> to each one. It also creates further database items for each pay and input value you use <INAME>.

Here is a list of database items created each time you define an element using the Element window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ENAME&gt;_BEN_CLASS</td>
<td>The element’s benefit classification</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_CLASSIFICATION</td>
<td>The element’s classification</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_CLOSED_FOR_ENTRY</td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_CLOSED_FOR_ENTRY_CODE</td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_COSTABLE_TYPE</td>
<td>The element’s costable type (from lookup table)</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_COSTABLE_TYPE_CODE</td>
<td>The element’s costable type (code values)</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_COUNT</td>
<td>The element entry count</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_END_DATE</td>
<td>The date to which this element is effective</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_INPUT_CURRENCY_CODE</td>
<td>The element’s input currency code</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_LENGTH_OF_SERVICE</td>
<td>The element’s qualifying length of service</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_OUTPUT_CURRENCY_CODE</td>
<td>The element’s output currency code</td>
</tr>
</tbody>
</table>

Table C – 17
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_PROCESSING_PRIORITY</code></td>
<td>The element’s processing priority</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_AGE</code></td>
<td>The element’s qualifying age</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS_CODE</code></td>
<td>The qualifying length of service units (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS</code></td>
<td>The qualifying length of service units (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_REPORTING_NAME</code></td>
<td>The element’s reporting name</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK_CODE</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE</code></td>
<td>The element’s unit of measure (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE_CODE</code></td>
<td>The element’s unit of measure (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_DEFAULT</code></td>
<td>The element’s default input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MIN</code></td>
<td>The element’s minimum input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MAX</code></td>
<td>The element’s maximum input value</td>
</tr>
</tbody>
</table>

Table C – 17

In addition to the items above, Oracle Payroll creates the following four items for elements defined with multiple entries not allowed:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_ENTRY_VALUE</code></td>
<td>The element value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_USER_ENTERED_CODE</code></td>
<td>Whether a value exists at the element entry level (yes/no)</td>
</tr>
</tbody>
</table>

Table C – 18
In addition to the common list above, Oracle Payroll creates the following item for elements defined with multiple entries allowed whose input values are numeric (that is, hours, integer, money or number).

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_START_DATE</code></td>
<td>The start date of element</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_END_DATE</code></td>
<td>The end date of element</td>
</tr>
</tbody>
</table>

Table C – 18

The units for `<ENAME> <INAME> ENTRY VALUE` are generated for both recurring and nonrecurring elements and are user-definable. Oracle Payroll modifies the definition text to retrieve the entry value in the unit of measure as specified in the `pay_input_values_f` table.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_ENTRY_VALUE</code></td>
<td>The summed element values for the multiple entries</td>
</tr>
</tbody>
</table>

Table C – 19
Grade Rate Database Items

When you define a grade rate, Oracle Payroll runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the grade rate name <NAME> to each one.

Here is a list of database items created each time you define a grade rate using the Grade Rate window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_&lt;NAME&gt;_VALUE</td>
<td>The grade rate’s value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MINIMUM</td>
<td>The grade rate’s minimum value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MAXIMUM</td>
<td>The grade rate’s maximum value</td>
</tr>
</tbody>
</table>

Table C – 20

Pay Scale Rate Database Items

When you define a pay scale rate, Oracle Payroll runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the rate name <NAME> to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPINE_&lt;NAME&gt;_VALUE</td>
<td>The pay scale rates value</td>
</tr>
</tbody>
</table>

Table C – 21
Descriptive Flexfield Database Items

When you define descriptive flexfield segments you make them available for use in QuickPaint by running the Create Descriptive Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the descriptive flexfields listed below.

To ensure easy recognition of these items, the process adds the descriptive flexfield segment name `<SEGMENT_NAME>` to each one.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>PEOPLE_&lt;SEGMENT_NAME&gt;</code></td>
<td>People descriptive flexfield database items</td>
</tr>
<tr>
<td><code>PAYROLLS_&lt;SEGMENT_NAME&gt;</code></td>
<td>Payroll descriptive flexfield database items</td>
</tr>
<tr>
<td><code>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</code></td>
<td>Assignment descriptive flexfield database items</td>
</tr>
<tr>
<td><code>GRADES_&lt;SEGMENT_NAME&gt;</code></td>
<td>Grade descriptive flexfield database items</td>
</tr>
<tr>
<td><code>ABSENCES_&lt;SEGMENT_NAME&gt;</code></td>
<td>Absence descriptive flexfield database items</td>
</tr>
<tr>
<td><code>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</code></td>
<td>Absence type descriptive flexfield database items</td>
</tr>
<tr>
<td><code>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</code></td>
<td>Person Address descriptive flexfield database items</td>
</tr>
<tr>
<td><code>EVENTS_&lt;SEGMENT_NAME&gt;</code></td>
<td>Events descriptive flexfield database items</td>
</tr>
<tr>
<td><code>JOBS_&lt;SEGMENT_NAME&gt;</code></td>
<td>Jobs descriptive flexfield database items</td>
</tr>
<tr>
<td><code>CONTACTS_&lt;SEGMENT_NAME&gt;</code></td>
<td>Contacts descriptive flexfield database items</td>
</tr>
<tr>
<td><code>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</code></td>
<td>Periods of Service descriptive flexfield database items</td>
</tr>
<tr>
<td><code>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</code></td>
<td>Recruitment Activities descriptive flexfield database items</td>
</tr>
<tr>
<td><code>POSITION_&lt;SEGMENT_NAME&gt;</code></td>
<td>Position descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLICATIONS_&lt;SEGMENT_NAME&gt;</td>
<td>Applications descriptive flexfield database items</td>
</tr>
<tr>
<td>ORGANIZATION_&lt;SEGMENT_NAME&gt;</td>
<td>Organization descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
Key Flexfield Database Items

When you define key flexfield segments you make them available for use in QuickPaint by running the Create Key Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the key flexfields listed below.

To ensure easy recognition of these items, the process adds the key flexfield segment name `<SEGMENT_NAME>` to each one.

Run this process for each of your Business Groups. If you define context–dependent key flexfield structures using BUSINESS_GROUP_ID as the reference field, the process creates database items for those flexfield segments as well. BUSINESS_GROUP_ID is the only reference field that the Create Key Flexfield DB Items process supports.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Grade key flexfield database items</td>
</tr>
<tr>
<td>JOB_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Job key flexfield database items</td>
</tr>
<tr>
<td>POS_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Position key flexfield database items</td>
</tr>
<tr>
<td>GROUP_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Group key flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 23
Absence Database Items

When you define an absence type, Oracle Payroll runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the absence type name $<\text{ABSENCE\_NAME}>$ to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$&lt;\text{ABSENCE_NAME}&gt;_CUM_BALANCE$</td>
<td>The cumulative balance for an absence type</td>
</tr>
</tbody>
</table>

Table C – 24
This appendix provides template SQL*Plus scripts to extract data to include in standard letters.
Template SQL*Plus PERWPOUK

<table>
<thead>
<tr>
<th>PERWPOUK.sql</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHENEVER SQLERROR EXIT FAILURE ROLLBACK</td>
<td>This section defines the required SQL*Plus environment settings. You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>REM Define the MS Word mail merge record separator</td>
<td></td>
</tr>
<tr>
<td>DEFINE ch='%'</td>
<td></td>
</tr>
<tr>
<td>REM Define the column width for returning query results</td>
<td></td>
</tr>
<tr>
<td>COLUMN L1 FORMAT A2000</td>
<td></td>
</tr>
<tr>
<td>SET PAUSE OFF</td>
<td></td>
</tr>
<tr>
<td>SET FEEDBACK OFF</td>
<td></td>
</tr>
<tr>
<td>SET RECSEP OFF</td>
<td></td>
</tr>
<tr>
<td>SET HEADING OFF</td>
<td></td>
</tr>
<tr>
<td>SET VERIFY OFF</td>
<td></td>
</tr>
<tr>
<td>SET TERMOUT OFF</td>
<td></td>
</tr>
<tr>
<td>SET PAGESIZE 0</td>
<td></td>
</tr>
<tr>
<td>REM Insert session row</td>
<td></td>
</tr>
<tr>
<td>insert into fnd_sessions(session_id, effective_date)</td>
<td>This section creates a row in the Application Object Library table (AOL) FND_SESSIONS. This enables the datetrack security views to be accessed for the session. The &amp;2 argument contains the current SQL*Forms session date. You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>select userenv('SESSIONID'),</td>
<td></td>
</tr>
<tr>
<td>to_date('&amp;2','DD-MON-YYYY')</td>
<td></td>
</tr>
<tr>
<td>from sys.dual</td>
<td></td>
</tr>
</tbody>
</table>
This section has two functions:
1) To set the mail merge header linesize. This is dependant on the character length of all the mail merge items you want to use. In the example, the header linesize equates approximately to 220 characters.
2) To enable the spooling of the SQL results. You must remove the REM keyword from the line that spools output to a file for the Microsoft Mailmerge. If you use concurrent processing to generate the data source file, Concurrent Manager creates the output file.

This section defines the mail merge header information. These are the mail merge fields you integrate with your word processed letter. Each mail merge field is delimited by the pre-defined &ch character. Ensure that the field size does not exceed 40 characters and that the field name does not include white spaces. Do not forget that the length in characters of this selected row from sys.dual is the LINESIZE value you specified above.

After selecting your mail merge header information, you must re-set the LINESIZE to the maximum to VARCHAR2 size which is 2000.
REM Mail merge interview query

```sql
select rpad(
    nvl(pa.address_line1,'') || &ch |
    nvl(pa.address_line2,'') || &ch |
    nvl(pa.address_line3,'') || &ch |
    nvl(pa.town_or_city,'') || &ch |
    nvl(ft.territory_short_name, ' ') || &ch |
    nvl(pa.postal_code,'') || &ch |
    nvl(hl1.meaning, ' ') || &ch |
    nvl(pp1.last_name, ' ') || &ch |
    nvl(pos.name, ' ') || &ch |
    pou.name  || &ch |
    nvl(pg.name, ' ') || &ch |
    nvl(to_char(pappl.projected_hire_date, 'fmDay fmddth
"of" fmMonth YYYY'), ' ') || &ch |
    nvl(hl2.meaning, ' ') || &ch |
    nvl(pp2.last_name, ' ') || &ch, 2000, '#') L1
```

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter.

The RPAD function pads out the row of information with # for all white spaces. Without this function, mail merge cannot distinguish when a row/record has ended.

The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

```sql
from per_addresses pa,
     fnd_territories ft,
     hr_lookups hl1,
     hr_lookups hl2,
     hr_all_organization_units pou,
     per_positions pos,
     per_grades pg,
     per_applications pappl,
     per_all_people ppl,
     per_all_people pp1,
     per_all_people pp2,
     per_all_assignments pasg1,
     per_letter_request_lines plr
```
where plr.letter_request_id = &1
and plr.person_id = ppl.person_id
and pa.primary_flag = 'Y'
and ppl.person_id = pp1.person_id
and ft.territory_code = pa.country
and h1.lookup_code = ppl.title
and h1.lookup_type = 'TITLE'
and pasg1.assignment_id = plr.assignment_id
and pos.position_id = pasg1.position_id
and pou.organization_id = pasg1.organization_id
and pasg1.organization_id = papp1.application_id
and pg.grade_id = pasg1.grade_id
and h2.lookup_code = pp2.title
and h2.lookup_type = 'TITLE'
/
REM Note: SPOOL command commented out for concurrent manager.
REM PC based solution required the SPOOL command.
REM spool off
REM update the letter request_status from PENDING to COMPLETE
update per_letter_requests plr
set plr.request_status = 'COMPLETE'
where plr.letter_request_id = &1
and plr.request_status = 'PENDING'
REM delete the session row created
delete from fnd_sessions fs
where fs.session_id = userenv('sessionid')
and fs.effective_date = to_date('&2','DD–MON–YYYY')
REM commit the changes
commit
exit

This section updates the letter request from Pending to Complete (as the example is for letter requests).

This section deletes the row inserted into FND_SESSIONS.

This section commits the changes and exits the SQL*Plus session.
**Template SQL*Plus Script PERWPWUK**

<table>
<thead>
<tr>
<th>PERWPWUK.sql</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>REM &lt;br&gt;DEFINE line_size=80 &lt;br&gt;DEFINE field_size= &amp;line_size−1 &lt;br&gt;DEFINE ch=&quot;’’” &lt;br&gt;SET PAGESIZE 0 &lt;br&gt;SET LINESIZE &amp;line_size &lt;br&gt;BREAK ON L1 SKIP PAGE &lt;br&gt;COLUMN L1 FORMAT A&amp;line_size &lt;br&gt;COLUMN L2 FORMAT A&amp;line_size &lt;br&gt;COLUMN L3 FORMAT A&amp;line_size &lt;br&gt;COLUMN L4 FORMAT A&amp;line_size &lt;br&gt;COLUMN L5 FORMAT A&amp;line_size &lt;br&gt;COLUMN L6 FORMAT A&amp;line_size &lt;br&gt;COLUMN L7 FORMAT A&amp;line_size &lt;br&gt;COLUMN L8 FORMAT A&amp;line_size &lt;br&gt;COLUMN L9 FORMAT A&amp;line_size &lt;br&gt;SET FEEDBACK OFF &lt;br&gt;SET RECSEP OFF &lt;br&gt;SET HEADING OFF &lt;br&gt;SET VERIFY OFF &lt;br&gt;SET TERMOUT OFF</td>
<td>This section defines the required SQL*Plus environment settings. You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>INSERT INTO fnd_sessions &lt;br&gt;(session_id ,effective_date) &lt;br&gt;SELECT userenv(’SESSIONID’) , to_date(’&amp;2’,’DD–MON–YYYY’) &lt;br&gt;FROM sys.dual</td>
<td>This section creates a row in the Application Object Library table (AOL) FND_SESSIONS. The &amp;2 argument contains the current SQL*Forms session date. You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>REM re–initialise the linesize to the maximum 2000 varchar2 length &lt;br&gt;SET LINESIZE 2000</td>
<td>After selecting your mail merge header information, you must re-set the LINESIZE to the maximum to VARCHAR2 size which is 2000.</td>
</tr>
</tbody>
</table>
```
select nvl(t.meaning||' '||p.first_name,' ')||&ch||
nvl(a.address_line1,' ') ||&ch||
nvl(a.address_line2,' ') ||&ch||
nvl(a.address_line3,' ') ||&ch||
nvl(a.town_or_city,' ') ||&ch||
nvl(a.region_1, ' ') ||&ch||
nvl(a.postal_code,' ') ||&ch||
nvl(t.meaning)||' '||p.last_name,' '
from per_addresses a,
    per_people p,
    per_letter_request_lines s,
    hr_lookups t
where a.person_id (+) = p.person_id
    and p.person_id = s.person_id
    and p.title = t.lookup_code (+)
    and t.lookup_type (+) = 'TITLE'
    and s.letter_request_id = &1
/

update per_letter_requests r
set r.letter_request_id = &1
where r.letter_request_id = &1
/update per_letter_request_lines rl
set rl.letter_request_id = &1
where rl.letter_request_id = &1

/commit
/exit
/
```

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter.

The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

This section updates the letter request from Pending to Complete (as the example is for letter requests).

This section commits the changes and exits the SQL*Plus session.
### OTA SQL*Plus Script to Produce Confirmation Letters

**Purpose**

<table>
<thead>
<tr>
<th>OTA.sql</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHENEVER SQLERROR EXIT FAILURE ROLLBACK REM</td>
<td>This section defines the required SQL*Plus environment settings. You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>Define the MS Word mail merge record separator</td>
<td></td>
</tr>
<tr>
<td>DEFINE ch='&quot;'&quot;REM Define the column width for returning query results</td>
<td></td>
</tr>
<tr>
<td>COLUMN L1 FORMAT A2000 SET PAUSE OFF</td>
<td></td>
</tr>
<tr>
<td>SET FEEDBACK OFF</td>
<td></td>
</tr>
<tr>
<td>SET RECSEP OFF</td>
<td></td>
</tr>
<tr>
<td>SET HEADING OFF</td>
<td></td>
</tr>
<tr>
<td>SET VERIFY OFF</td>
<td></td>
</tr>
<tr>
<td>SET TERMOUT OFF</td>
<td></td>
</tr>
<tr>
<td>SET PAGESIZE 0</td>
<td></td>
</tr>
<tr>
<td>REM Insert session row</td>
<td></td>
</tr>
<tr>
<td>insert into fnd_sessions(session_id, effective_date)</td>
<td>This section creates a row in the Application Object Library table (AOL) FND_SESSIONS. This enables the datetrack security views to be accessed for the session.</td>
</tr>
<tr>
<td>select userenv(‘SESSIONID’),</td>
<td></td>
</tr>
<tr>
<td>to_date(&amp;2,’DD–MON–YYYY’)</td>
<td></td>
</tr>
<tr>
<td>from sys.dual</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
</tr>
</tbody>
</table>
REM Set length of the header
SET LINESIZE 200
REM Create the mail merge 'header' record for MS Word
REM Note: SPOOL command commented out for concurrent manager.
REM PC based solution required the SPOOL command.spool xxxxx.txt

This section has two functions:
1) To set the mail merge header linesize. This is dependant on the character length of all the mail merge items you want to use. In the example, the header linesize equates approximately to 220 characters.
2) To enable the spooling of the SQL results. The spool file should match the name of the SQL file you are writing, but with a text file extension.

select 'student_title'
   ||&ch||
   'student_first_name' ||&ch||
   'student_last_name'
   ||&ch||
   'event_name' ||&ch||
   'event_code'
   ||&ch||
   'event_end_date'
||&ch
from sys.dual /

This section defines the mail merge header information. These are the mail merge fields you integrate with your word processed letter. Each mail merge field is delimited by the pre-defined &ch character. Ensure that the field size does not exceed 40 characters and that the field name does not include white spaces. Do not forget that the length in characters of this selected row from sys.dual is the LINESIZE value you specified above.
REM re-initialise the linesize to the maximum 2000 varchar2 length
SET LINESIZE 2000

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter. The RPAD function pads out the row of information with # for all white spaces. Without this function, mail merge cannot distinguish when a row/record has ended.

The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

REM Note: SPOOL command commented out for concurrent manager.
REM       PC based solution required the SPOOL command.
spool off
REM Update the letter request status from PENDING to COMPLETE
update per_letter_requests
plr
set plr.request_status = 'COMPLETE'
where plr.letter_request_id = &1
and plr.request_status = 'PENDING'
/

This section updates the letter request status from PENDING to COMPLETE (as the example is for letter requests).

REM delete the session row created
delete from fnd_sessions
fs
where fs.session_id = userenv('sessionid')
and fs.effective_date = to_date('&2','DD–MON–YYYY')
/

This section deletes the row inserted into FND_SESSIONS.

REM commit the changes
commit
/
exit
/

This section commits the changes and exits the SQL*Plus session.
Glossary

A

Absence Types  Categories of absence, such as medical leave or vacation leave, that you define for use in absence windows.

Alternative Regions  Parts of a window that appear in a stack so that only one is visible at any time. You click on the name of the region to pop up a list of the other regions in the stack. Select the name of a region to bring it to the top of the stack.

Applicant  A candidate for employment in a Business Group.

Appraisal  A ‘superset’ of recording opinions and setting and achieving objectives, plans and so on. See also: Assessment.

Assessment  An information gathering exercise, from one or many sources, to evaluate a person’s ability to do a job. See also: Appraisal.

Assignment  An employee’s assignment identifies his or her role and payroll within a Business Group. The assignment is made up of a number of assignment components. Of these, organization is mandatory, and payroll is a required component for payment purposes.

Assignment Number  A number that uniquely identifies an employee’s assignment. An employee with multiple assignments has multiple assignment numbers.

Assignment Set  A grouping of employees and/or applicants that you define for running QuickPaint reports and processing payrolls. See also: QuickPaint Report.

Assignment Status  For employees, used to track their permanent or temporary departures from your enterprise, and to control the remuneration they receive. For applicants, used to track the progress of their applications.

Base Currency  The currency in which Oracle Payroll performs all payroll calculations for your Business Group. If you pay employees in different currencies to this, Oracle Payroll calculates the amounts based on exchange rates defined on the system.

Behavioral Indicators  Characteristics that identify how a competence is exhibited in the work context. See also: Proficiency Level.
Benefit  Any part of an employee’s remuneration package that is not pay. Vacation time, employer–paid medical insurance and stock options are all examples of benefits. See also: Elements

Block  The largest subordinate unit of a window, containing information for a specific business function or entity. Every window consists of at least one block. Blocks contain fields and, optionally, regions. They are delineated by a bevelled edge. You must save your entries in one block before navigating to the next. See also: Region, Field

Budget Value  In Oracle Human Resources you can enter staffing budget values and actual values for each assignment to measure variances between actual and planned staffing levels in an organization or hierarchy.

Business Group  The highest level organization in the Oracle HRMS system. A Business Group may correspond to the whole of your enterprise or to a major grouping such as a subsidiary or operating division. Each Business Group must correspond to a separate implementation of Oracle HRMS.

Cash Analysis  A specification of the different currency denominations required for paying your employees in cash. Union contracts may require you to follow certain cash analysis rules.

Compensation  The pay you give to employees, including wages or salary, and bonuses. See also: Elements

Competence  Any measurable behavior required by an organization, job or position that a person may demonstrate in the work context. A competence can be a piece of knowledge, a skill, an attitude or an attribute.

Competence Profile  Where you record applicant and employee accomplishments, for example, proficiency in a competence.

Competence Requirements  Competencies required by an organization, job or position. See also: Competence, Core Competencies

Competence Type  A group of related competencies

Consolidation Set  A grouping of payroll runs within the same time period for which you can schedule reporting, costing, and post–run processing.

Contact  A person who has a relationship to an employee that you want to record. Contacts can be dependents, relatives, partners or persons to contact in an emergency.

Core Competencies  Competencies required by every person to enable the enterprise to meet its goals. See also: Competence

C

Calendars  In Oracle Human Resources you define calendars that determine the start and end dates for budgetary years, quarters and periods. For each calendar you select a basic period type.

Career Map  A plan showing the expected routes by which employees can progress from one job to another within the Business Group.
Costable Type A feature that determines the processing an element receives for accounting and costing purposes. There are four costable types in Oracle HRMS: costed, distributed costing, fixed costing, and not costed.

Costing Recording the costs of an assignment for accounting or reporting purposes. Using Oracle Payroll, you can calculate and transfer costing information to your general ledger and into systems for project management or labor distribution.

Customizable Forms Forms that your system administrator can modify for ease of use or security purposes by means of Custom Form restrictions. The Form Customization window lists the forms and their methods of customization.

D

Database Item An item of information in Oracle HRMS that has special programming attached, enabling Oracle FastFormula to locate and retrieve it for use in formulas.

Date To and Date From These fields are used in windows not subject to DateTrack. The period you enter in these fields remains fixed until you change the values in either field. See also: DateTrack, Effective Date

DateTrack When you change your effective date (either to past or future), DateTrack enables you to enter information that takes effect on your new effective date, and to review information as of the new date. See also: Effective Date

Deployment Factors See: Work Choices

Descriptive Flexfield A field that your organization can customize to capture additional information required by your business but not otherwise tracked by Oracle Applications. See also: Key Flexfield

E

Effective Date The date for which you are entering and viewing information. You set your effective date in the Alter Effective Date window. See also: DateTrack

Elements Components in the calculation of employee pay. Each element represents a compensation or benefit type, such as salary, wages, stock purchase plans, and pension contributions.

Element Classifications These control the order in which elements are processed and the balances they feed. Primary element classifications and some secondary classifications are predefined by Oracle Payroll. Other secondary classifications can be created by users.

Element Entry The record controlling an employee’s receipt of an element, including the period of time for which the employee receives the element and its value. See also: Recurring Elements, Nonrecurring Elements

Element Link The association of an element to one or more components of an employee assignment. The link establishes employee eligibility for that element. Employees whose assignment components match the components of the link are eligible for the element. See also: Standard Link
**Element Set**  A group of elements that you define to process in a payroll run, or to control access to compensation information from a customized form, or for distributing costs.


**Event**  An activity such as a training day, review, or meeting, for employees or applicants.

**Field**  A view or entry area in a window where you enter, view, update, or delete information. See also: **Block**, **Region**

**Form**  A predefined grouping of functions, called from a menu and displayed, if necessary, on several windows. Forms have blocks, regions and fields as their components. See also: **Block**, **Region**, **Field**

**Grade**  A component of an employee’s assignment that defines their level and can be used to control the value of their salary and other compensation elements.

**Grade Comparatio**  A comparison of the amount of compensation an employee receives with the mid-point of the valid values defined for his or her grade.

**Grade Rate**  A value or range of values defined as valid for a given grade. Used for validating employee compensation entries.

**Grade Scale**  A sequence of steps valid for a grade, where each step corresponds to one point on a pay scale. You can place each employee on a point of their grade scale and automatically increment all placements each year, or as required. See also: **Pay Scale**

**Grade Step**  An increment on a grade scale. Each grade step corresponds to one point on a pay scale. See also: **Grade Scale**

**Group**  A component that you define, using the People Group key flexfield, to assign employees to special groups such as pension plans or unions. You can use groups to determine employees’ eligibility for certain elements, and to regulate access to payrolls.

**Hierarchy**  An organization or position structure showing reporting lines or other relationships. You can use hierarchies for reporting and for controlling access to Oracle HRMS information.

**Input Values**  Values you define to hold information about elements. In Oracle Payroll, input values are processed by formulas to calculate the element’s run result. You can define up to fifteen input values for an element.
Key Flexfield  A flexible data field made up of segments. Each segment has a name you define and a set of valid values you specify. Used as the key to uniquely identify an entity, such as jobs, positions, grades, cost codes, and employee groups. See also: Descriptive Flexfield

Leaver’s Statement  Records details of Statutory Sick Pay (SSP) paid during a previous employment (issued as form SSP1L) which is used to calculate a new employee’s entitlement to SSP. If a new employee falls sick, and the last date that SSP was paid for under the previous employment is less than eight calendar weeks before the first day of the PIW for the current sickness, the maximum liability for SSP is reduced by the number of weeks of SSP shown on the statement.

Menus  You set up your own navigation menus, to suit the needs of different users.

NACHA  National Automated Clearing House Association. This is the US system for making direct deposit payments to employees.

Nonrecurring Elements  Elements that process for one payroll period only unless you make a new entry for an employee. See also: Recurring Elements

Oracle FastFormula  An Oracle tool that allows you to write Oracle HRMS formulas without using a programming language.

Organization  A required component of employee assignments. You can define as many organizations as you want within your Business Group. Organizations can be internal, such as departments, or external, such as recruitment agencies. You can structure your organizations into organizational hierarchies for reporting purposes and for system access control.

Pay Scale  A set of progression points, which can be related to one or more rates of pay. Employee’s are placed on a particular point on the scale according to their grade and, usually, work experience. See also: Grade Scale

Payment Type  There are three standard payment types for paying employees: check, cash and direct deposit. You can define your own payment methods corresponding to these types.

Payroll  A group of employees that Oracle Payroll processes together with the same processing frequency, for example, weekly, monthly or bimonthly. Within a Business Group, you can set up as many payrolls as you need.

Performance (within Assessment)  An expectation of “normal” performance of a competence over a given period. For example, a person may exceed performance expectation in the communication competence. See also: Proficiency (within Assessment), Competence, Assessment
**Period Type**  A time division in a budgetary calendar, such as week, month, or quarter.

**Person Type**  There are eight system person types in Oracle HRMS. Seven of these are combinations of employees, ex–employees, applicants, and ex–applicants. The eighth category is ‘External’. You can create your own user person types based on the eight system types.

**Position**  A specific role within the Business Group derived from an organization and a job. For example, you may have a position of Shipping Clerk associated with the organization Shipping and the job Clerk.

**Proficiency (within Assessment)**  The perceived level of expertise of a person in a competence, in the opinion of the assessor, over a given period. For example, a person may demonstrate the communication competence at Expert level. See also: Performance (within Assessment), Competence, Assessment

**Proficiency Level**  A system for expressing and measuring how a competence is exhibited in the work context. See also: Behavioral Indicators.

**Progression Point**  A pay scale is calibrated in progression points, which form a sequence for the progression of employees up the pay scale. See also: Pay Scale
Qualification Type  An identified qualification method of achieving proficiency in a competence, such as an award, educational qualification, a license or a test. See: Competence

QuickCode Types  Categories of information, such as nationality, address type and tax type, that have a limited list of valid values. You can define your own QuickCode Types, and you can add values to some predefined QuickCode Types.

QuickPaint Report  A method of reporting on employee and applicant assignment information. You can select items of information, paint them on a report layout, add explanatory text, and save the report definition to run whenever you want. See also: Assignment Set

Recurring Elements  Elements that process regularly at a predefined frequency. Recurring element entries exist from the time you create them until you delete them, or the employee ceases to be eligible for the element. Recurring elements can have standard links. See also: Nonrecurring Elements, Standard Link

Region  A collection of logically related fields in a window, set apart from other fields by a rectangular box or a horizontal line across the window. See also: Block, Field

Report Parameters  Inputs you make when submitting a report to control the sorting, formatting, selection, and summarizing of information in the report.

Report Security Group  A list of reports and processes that can be submitted by holders of a particular responsibility. See also: Responsibility

Report Set  A group of reports and concurrent processes that you specify to run together.

Requisition  The statement of a requirement for a vacancy or group of vacancies.

Responsibility  A level of authority in an application. Each responsibility lets you access a specific set of Oracle Applications forms, menus, reports, and data to fulfill your business role. Several users can share a responsibility, and a single user can have multiple responsibilities. See also: Security Profile, User Profile Options, Report Security Group

Qualification Type  An identified qualification method of achieving proficiency in a competence, such as an award, educational qualification, a license or a test. See: Competence

QuickCode Types  Categories of information, such as nationality, address type and tax type, that have a limited list of valid values. You can define your own QuickCode Types, and you can add values to some predefined QuickCode Types.

QuickPaint Report  A method of reporting on employee and applicant assignment information. You can select items of information, paint them on a report layout, add explanatory text, and save the report definition to run whenever you want. See also: Assignment Set

Recurring Elements  Elements that process regularly at a predefined frequency. Recurring element entries exist from the time you create them until you delete them, or the employee ceases to be eligible for the element. Recurring elements can have standard links. See also: Nonrecurring Elements, Standard Link

Region  A collection of logically related fields in a window, set apart from other fields by a rectangular box or a horizontal line across the window. See also: Block, Field

Report Parameters  Inputs you make when submitting a report to control the sorting, formatting, selection, and summarizing of information in the report.

Report Security Group  A list of reports and processes that can be submitted by holders of a particular responsibility. See also: Responsibility

Report Set  A group of reports and concurrent processes that you specify to run together.

Requisition  The statement of a requirement for a vacancy or group of vacancies.

Responsibility  A level of authority in an application. Each responsibility lets you access a specific set of Oracle Applications forms, menus, reports, and data to fulfill your business role. Several users can share a responsibility, and a single user can have multiple responsibilities. See also: Security Profile, User Profile Options, Report Security Group
Retry  Method of correcting a payroll run or other process before any post-run processing takes place. The original run results are deleted and the process is run again.

Reversal  Method of correcting payroll runs or QuickPay runs after post-run processing has taken place. The system replaces positive run result values with negative ones, and negative run result values with positive ones. Both old and new values remain on the database.

Rollback  Method of removing a payroll run or other process before any post-run processing takes place. All assignments and run results are deleted.

Salary Basis  The period of time for which an employee’s salary is quoted, such as hourly or annually. Defines a group of employees assigned to the same salary basis and receiving the same salary element.

Security Profile  Security profiles control access to organizations, positions and employee and applicant records within the Business Group. System administrators use them in defining users’ responsibilities. See also: Responsibility, User Profile Options

Special Information Types  Categories of personal information, such as skills, that you define in the Personal Analysis key flexfield.

Standard Link  Recurring elements with standard links have their element entries automatically created for all employees whose assignment components match the link. See also: Element Link, Recurring Elements

Task Flows  A sequence of windows linked by buttons to take you through the steps required to complete a task, such as hiring a new recruit. System administrators can create task flows to meet the needs of groups of users.

Terminating Employees  You terminate an employee when he or she leaves your organization. Information about the employee remains on the system but all current assignments are ended.

Termination Rule  Specifies when entries of an element should close down for an employee who leaves your enterprise. You can define that entries end on the employee’s actual termination date or remain open until a final processing date.

User Profile Options  Features that allow system administrators and users to tailor Oracle HRMS to their exact requirements. See also: Responsibility, Security Profile

Work Choices  Also known as Deployment or Work Factors. These can affect a person’s capacity to be deployed within an enterprise, such willingness to travel or relocate. You can hold work choices at both job and position, or at person level.

Work Structures  The fundamental definitions of organizations, jobs, positions, grades, payrolls and other employee groups within your enterprise that provide the framework for defining the work assignments of your employees.
Index

A

A and B Records
Illinois, 19–21
Missouri, 19–21
New Jersey, 19–21
Pennsylvania, 19–21
State Quarterly Wage Listings, GRE Transmitters, 19–20
Texas, 19–21

Absence categories, for absence types, 10–2 to 10–4
Absence elements
balances for, 10–5 to 10–7
definition and linking of, 10–8 to 10–10
Absence types
database items, C–26
definition of, 10–10 to 10–15
listing by, 10–16
ABSENCE CATEGORY, 10–8, 10–11
ABSENCE_REASON, 10–8, 10–11
Absences
authorization of and replacements for, 10–7
batch entry of, 10–7, 10–29
defining and linking elements for, 10–8
defining types of, 10–10 to 10–15
elements for, 10–4 to 10–7
employee’s history of, 10–15
initializing balances for, 10–6
recording of, 10–7, 10–13 to 10–14
referencing in payroll runs, 10–6
relief position, 3–12
reporting for, 10–17
reviewing, 10–15 to 10–17
setup for recording, 10–8 to 10–12
types, categories and reasons, 10–2 to 10–4
Accrual plans. See PTO accrual plans
Active assignment status, 24–5
ADA reporting
information for, 8–26
registering employees with disabilities, 8–6
Address styles, B–9
ADDRESS TYPE, 8–11, 8–13
Addresses
floor or office numbers, 9–12
for work sites, 2–2 to 2–3
generic, for people, 8–11
validated, for people, 8–12
Administration, Wage Attachment Fee Rules, 17–14
Alaska, S Record Data, 19–27
Alimony
Wage Attachment, 17–2
Wage Attachment Fee Category, 17–14
Applicant assignment statuses
reporting on, 9–32
user statuses for, 24–7
Applicant Details Report, 8–31
Applicant information, 8–8
Applicant number, 8–5
Applicants, listing, 8–3
Application Data Export, 30–5
Archive Differences Report, Magnetic Media
Wage Reporting Utilities, 19–39
Archive Magnetic Report, Magnetic Media
Wage Reporting Utilities, 19–39

Arrears balances
adjustment using special input, 21–5
creation and maintenance of, 16–13 to 16–14
for deductions, 14–11

Assignment
Retiree, 6–7
Retirement, 6–9

Assignment components
and element eligibility rules, 12–25
and element links, 12–6
and pay processing requirements, 9–5, 21–7

Assignment Details Report, 8–31
Assignment reporting
Assignment Status Report, 9–32
Assignments Folder, 9–25
Assignment sets, 23–14
for payroll processing, 21–3 to 21–4
Assignment Status, Retirement, 6–4

Assignments
See also Employee assignments
for employees, 9–4
verifying for a mass move, 3–31

Attachments, 30–6
Audit groups, 26–2
AuditTrail, 26–2
setting up audit groups, 26–2

Automatic element entry
HR example of, 12–28
payroll example of, 12–28
standard links for, 12–27

defining user, 14–22 to 14–24
dimensions and levels of, 14–4
direct adjustments to, 22–10
fees for, 14–3 to 14–5, 14–7, 14–20
fees for arrears balances, 16–13 to 16–15
fiscal year, 2–27
for foreign currencies, 14–15, 21–13
for taxes, 18–5
review of, 14–8 to 14–11
Toward Bond, 14–11
viewing, for deductions, 14–10 to 14–14
viewing, for earnings, 14–8 to 14–10
viewing, for taxes, 18–44 to 18–46
Bank account information, B–11
Bank information, for employees, 9–22
Bankruptcy Order, Wage Attachment Fee Category, 17–14
Bankruptcy orders, Wage Attachment, 17–2
Base currency, 25–7

Batch element entry
BEE facility for, 13–51 to 13–59
PayMIX facility for, 13–60 to 13–61
Batch processing, generating letters, 30–13 to 30–16
BEE
for batch element entry, 13–50, 13–51 to 13–59
procedures for, 13–52
Beneficiaries
entering organizations as, 2–23
every of, 8–16 to 8–20
Benefit plans for health care coverage
and the Benefit Tables amount rule, 16–17
Oracle Payroll setup for, 16–17 to 16–18
Benefits
defining carriers of, 2–23, 14–17
setting deduction frequency for, 14–17
Benefits classifications, for elements representing benefits, 12–3

Benefits Table amount rule
and benefit plan setup, 16–13, 16–17 to 16–18
selection of, 16–12

Blocking Factor, State Quarterly Wage Listings,
E Records, 19–22

B
Background check information, 8–8

Balances
Able, 14–11
Accrued, 14–10
adjustment procedure, 22–10 to 22–12
adjustments to tax, 18–39
Arrears, 14–11
creation of, 14–4
Blood type, entry of, 8 – 9
Budget value defaults, 2 – 27
BUDGET_MEASUREMENT_TYPE, 2 – 28
Budgets
  in project based enterprises, 7 – 5
  in rule based enterprises, 7 – 8
Business Groups
  additional information for, 2 – 24
  defaults for, 2 – 27 to 2 – 28
  defining, 2 – 20 to 2 – 24
  key flexfields for, 2 – 4 to 2 – 6
  representing companies in, 2 – 15 to 2 – 17
startup data, 2 – 7

C
Calendars
  for employee absences, 10 – 7
  for payrolls, 5 – 8
  for PTO accrual plans, 10 – 18
California, S Record Data, 19 – 27
Categories, Wage Attachment, 17 – 14
Categories of elements, 12 – 3
  adding new, for deductions, 17 – 8
  adding new, for earnings, 15 – 27
  adding new, for imputed earnings, 18 – 33, 18 – 34
  adding new, for non-payroll payments, 15 – 27
  adding new, for supplemental earnings, 18 – 33, 18 – 34
  listing of, 12 – 8 to 12 – 15
  taxability rules for, 18 – 36
Chained start rule
  input value for, 16 – 8
  selection of, 16 – 7
Chained To input value. See Chained start rule
Check Writer, 21 – 6
  for paychecks, 21 – 16
  for wage attachments, 17 – 12
Child Support Order, Wage Attachment Fee Category, 17 – 14
Child support orders, Wage Attachment Category, 17 – 2
City Taxability Rules
  Creating, 18 – 35
  Ending, 18 – 36
  Updating, 18 – 36
Classifications of elements
  See also Element classifications
    primary, 12 – 8
    primary and benefits, 12 – 3
Classifying organizations. See Organizations, classifications for
  College attendances, 8 – 19
  Comments, 30 – 6
Common paymaster, 2 – 21
Company Car, earnings type for, 15 – 17
Comparatio values for grades, 4 – 10
Compensation and benefits
  relating grades to, 4 – 3, 4 – 6
  using elements to represent, 12 – 2 to 12 – 4
Competence profile, copying competencies, 8 – 19
Competence profiles, 8 – 19
Competencies, copying, competence profile, 8 – 19
Concurrent managers, 23 – 5
Consolidation sets
  defining and deleting, 21 – 10
  temporary change of, 21 – 11 to 21 – 13
CONTACT, 8 – 16
Contacts, 24 – 2
  entry of, 8 – 16 to 8 – 20
Contract staff, 7 – 12
CONTROL_TYPE, 13 – 52
Copying competencies, competence profile, 8 – 19
Corporate Headquarters
  See also Reporting Organizations
    defining, 2 – 23
Cost Allocation key flexfield, 2 – 6, B – 4
  cost centers in, 11 – 2 to 11 – 6
  customizing segment names of, 2 – 8
  entry overrides, 11 – 6
  examples of, 11 – 2 to 11 – 6
  qualifiers for, 11 – 11 to 11 – 13
setup of, 11 – 11 to 11 – 13
use of, 11 – 5 to 11 – 6
Cost centers
defining organizations as, 11 – 9
element of cost allocation to, 11 – 18 to 11 – 19
for organizations, 2 – 16
in the Cost Allocation flexfield, 11 – 2 to 11 – 6
Costable types
and entries of indirect results, 14 – 27
for costing information, 11 – 7
for element links, 12 – 39
Costing
for organizations, 2 – 30
for payrolls, 5 – 8
Costing information
examples of, 11 – 18 to 11 – 21
for assignments, 11 – 9 to 11 – 10
for element entries, 11 – 10 to 11 – 12
for element links, 11 – 7 to 11 – 9, 14 – 27
for GL debits and credits, 11 – 8
for organizations and assignments, 11 – 9 to 11 – 11
for payrolls, 11 – 6
for projects, 7 – 4
for taxes, 11 – 14 to 11 – 16
PayMIX entry for, 13 – 62, 13 – 65
process for accumulating, 11 – 17 to 11 – 19
transfer to Oracle GL, 11 – 24 to 11 – 26
Country–specific features
address styles, B – 9
in key flexfields, B – 10
County Taxability Rules
Creating, 18 – 35
Ending, 18 – 36
Updating, 18 – 36
Coverage input value. See Benefits Table
Credit Debt, Wage Attachment Fee Category, 17 – 14
Credit debt, Wage Attachment, 17 – 2
Cumulative withholding, 18 – 4
Currencies
enabling, 25 – 7
exchange rates for, 21 – 13 to 21 – 21
foreign, specification of, 14 – 15
Current andProjected Progression Point Values Report, 4 – 18
Customizing
List People by Special Information window, 8 – 28
menu structures, 27 – 17 to 27 – 19
People Folder window, 8 – 3
People window, 8 – 4
QuickPaint Report window, 23 – 13
Special Information window, 8 – 26
Table Values window, 29 – 17
windows, 27 – 2, 27 – 3 to 27 – 8
D
Database items
and payroll formula inputs, 12 – 21
in QuickPaint reports, 23 – 10
list of dynamic items, C – 10
list of static items, C – 2
Date earned
for PayMIX entries of PTO taken, 10 – 10
for work in prior periods, 15 – 19
input value for, 15 – 19
of PayMIX entries, 13 – 63, 13 – 66 to 13 – 71
DateTrack, 1 – 9, 1 – 10 to 1 – 19
changing datetracked information, 1 – 14 to 1 – 15
Date Security user profile option, 1 – 11
deleting datetracked information, 1 – 15
Reminder user profile option, 1 – 12
DateTrack History, 1 – 13
DateTrack:Date Security, 25 – 6
DateTrack:Reminder, 25 – 6
Deduction Processing input value. See Deductions taken against a particular earnings
Deduction start and stop rules
Chained start rule, 16 – 8
Earnings Threshold start rule, 16 – 9
Total Reached stop rule, 16 – 9 to 16 – 10
Deductions
See also Garnishment deductions
arrears management for, 16 – 13
batch entry for, 13 – 64 to 13 – 65, 16 – 6
changing partial amount rule for, 14–18
changing run types for, 14–18
classifications for, 12–11
components generated for, 16–2
for garnishments, 17–6 to 17–13
for Series EE Bond purchase, 16–11
for wage attachments, 17–2 to 17–4
frequency rules for, 12–23 to 12–25, 16–9, 16–10
included in Oracle Payroll, 14–2
online review of, 14–6
reporting for, 21–39 to 21–41
restarting after run reversals, 22–8
start and stop rules for, 16–8 to 16–18
structures for, 16–2 to 16–18
user–initiated and system–generated, 14–2
viewing balances for, 14–10 to 14–14

Deductions taken against a particular earnings control of, 15–30
PayMIX entry to control, 13–62, 13–65
tax and pre–tax only, 15–23
tax only, 15–23

Deductions, pre–tax. See Pre–tax deductions
Deductions, tax. See Tax deductions

Define Rate form, modes, 27–20

Defined Benefits Plan, Retirement Processing, 6–2

Defining an element to hold information
input value validation, 12–32
processing rules, 12–33 to 12–35
termination rule selection, 12–34

Dependents, entry of, 8–16 to 8–20
Deposit Advice, 21–6

Descriptive flexfields
creating database items, B–6
defining segments of, 27–2 to 27–4
explained, 27–2, B–5
for address styles, B–9
list of user definable, B–6 to B–9
protected, B–10

Disability leave, 24–7

Distributed costing
element of, 11–19 to 11–26
for employer charges, as overhead, 11–8 to 11–10
Distribution set, for distributed costing, 11–8

Distribution sets, 27–5

E

E and T Records
Entering State Data, State Quarterly Wage Listings, 19–23
Illinois, 19–23
Kentucky, 19–23
Missouri, 19–23
Montana, 19–23

E Records
Blocking Factor, State Quarterly Wage Listings, 19–22
Kentucky, 19–24
New Hampshire, 19–25
New York, 19–25
North Carolina, 19–25
Ohio, 19–25
Pennsylvania, 19–26
Texas, 19–26

Earned Income, Retirement, 6–10
Earnings and deductions
initiation and generation of, 12–5, 14–2 to 14–4
review of, 14–6 to 14–7

Earnings elements
See also Earnings types
Labor Recording, 15–4

Regular Hours Worked, 15–4
Time Entry Wages, 15–2 to 15–5
Vacation Pay and Sick Pay, 15–5 to 15–7

Earnings or payment amounts
 calculation rules for, 15–24 to 15–26
Flat Amount rule for, 15–24
Hours x Rate rules for, 15–24 to 15–25
Percentage of Earnings rule for, 15–26

Earnings Threshold start rule
input value and balance for, 16–9
selection of, 16–7

Earnings Type, Local Taxability Rules
creating, 18–35
Ending, 18–36
updating, 18–36

Earnings types
batch entry for, 13–64 to 13–65, 15–29
classifications and categories for, 12 – 10
Company Car, 15 – 17
components generated for, 15 – 18
dates earned for, 15 – 19
deduction processing against, 15 – 23
from outside sources, 18 – 39
GTL Imputed Income, 15 – 15 to 15 – 28
included in Oracle Payroll, 14 – 2
jurisdictions for, 15 – 19
online review of, 14 – 6
Overtime, 15 – 10 to 15 – 28
Regular Salary, 15 – 2 to 15 – 7
Regular Wages, 15 – 2
restarting after run reversals, 22 – 8
separate checks for, 15 – 22
Shift Pay, 15 – 13 to 15 – 28
structures for, 15 – 18
tax withholding methods for, 15 – 20 to 15 – 28
taxability rules for, 18 – 2
user–initiated and system–generated, 14 – 2
viewing balances for, 14 – 8
Education leave, 24 – 7
Educational Loan
Wage Attachment, 17 – 2
Wage Attachment Fee Category, 17 – 14
Effective dates, 1 – 9, 1 – 11
Element categories. See Categories of elements
Element classifications. See Element generation
Element entries
automatic, using standard links, 12 – 27
batch entry using BEE or PayMIX, 12 – 29 to 12 – 31
by indirect formula results, 14 – 27
for eligible employees, 12 – 27
indirect formula results for, 12 – 29
manual, for individual employees, 12 – 27, 12 – 42 to 12 – 44
qualifying conditions for, 14 – 15
reviewing, 12 – 45
standard links for automatic, 12 – 27
supplying end dates for, 12 – 27
using salary administration, 12 – 27
viewing a history of, 12 – 45
viewing list of employees with, 12 – 46
Element generation by Oracle Payroll
for earnings and non–payroll payments, 15 – 18
for non–tax deductions, 16 – 2
for payroll processing, 14 – 2 to 14 – 4
initiation of, 12 – 5
Element processing priority
changing the default for, 14 – 15, 15 – 29, 16 – 7
default values for, 12 – 14
Element sets, 27 – 5
for payroll processing, 21 – 3 to 21 – 4
Elements. See also Element links, element entries
and balance feeds, 14 – 20
batch entry of, 13 – 50
classifications and categories of, 12 – 3, 12 – 8 to 12 – 15
costing information for, 11 – 7 to 11 – 8
defining, 12 – 38 to 12 – 41
report for reviewing, 12 – 40 to 12 – 41
standard, for automatic entry, 14 – 16
Element processing priority
changing the default for, 14 – 15, 15 – 29, 16 – 7
default values for, 12 – 14
Element sets, 27 – 5
for payroll processing, 21 – 3 to 21 – 4
Elements. See also Element links, element entries
and balance feeds, 14 – 20
batch entry of, 13 – 50
classifications and categories of, 12 – 3, 12 – 8 to 12 – 15
costing information for, 11 – 7 to 11 – 9
defining, 12 – 4
defining, for absence types, 10 – 8 to 10 – 10
defining, to hold information, 12 – 32 to 12 – 36
eligibility rules for, 12 – 25 to 12 – 27
entry of, 12 – 7
for wage attachments, 17 – 5
formulas for, 12 – 4, 12 – 21 to 12 – 23
generated, for PTO accrual plans, 10 – 18 to 10 – 19
included in Oracle HRMS, 12 – 5
input values of, 12 – 3, 12 – 16 to 12 – 20
linking of, 12 – 6, 12 – 38 to 12 – 41
manual entry of, 12 – 42 to 12 – 44
modification of system–generated, 14 – 3, 14 – 12 to 14 – 21
nonrecurring, 5 – 2
Oracle HR uses for, 12 – 2
Oracle Payroll uses for, 12 – 2 to 12 – 4
processing types of, 12 – 4, 12 – 23 to 12 – 25
special inputs, 21 – 4 to 21 – 5
system generation of, 14 – 2
Eligibility rules
  and element links, 12 – 6
  criteria used in, 12 – 25 to 12 – 27
Email ID information, entry of, 8 – 6
EMP_ASSIGN_REASON, 9 – 12
Employee assignment number, 9 – 10
Employee assignment statuses, 24 – 5 to 24 – 6
  and formula processing rules, 14 – 25
  and payroll processing, 24 – 5
  element entries valid for, 24 – 5
  reporting on, 9 – 32
  secondary statuses, 24 – 6
Employee assignments
  allocation of costs for, 9 – 6
  and work structures, 9 – 4 to 9 – 19
  changes to, and DateTrack, 9 – 14
  components of, 9 – 5
  defining as primary, 9 – 12
  definition, 9 – 4
  ending all, 9 – 17 to 9 – 18
  ending one of multiple, 9 – 16
  entering, 9 – 9 to 9 – 13
  history, 9 – 35
  inquiring and reporting on, 9 – 25 to 9 – 35
  manager–level, 9 – 12
  numbers for, 9 – 7
  payment methods for, 9 – 21 to 9 – 23
  placing in GREs, 9 – 10
  position based, 7 – 6
  primary assignments, 9 – 6
  project based, 7 – 2 to 7 – 6
  tax information for, 18 – 13
  using multiple assignments, 9 – 6
Employee Contribution input value. See Benefits Table amount rule
Employee groups, 5 – 10
  People Group flexfield for, 2 – 5
Employee Increment Results Report, 4 – 19
Employee lists
  by absence type, 10 – 16
  by assignment components, 9 – 25
  by assignment statuses, 9 – 32
  by organization, 9 – 28
  by personal information, 8 – 3
  by position, 9 – 30
  by position hierarchy, 9 – 31
  by special information type, 8 – 28
Employee numbers, 8 – 5, 9 – 7
Employee Organization Movements Report, 9 – 33
Employee Payroll Movements Report, 9 – 33
Employee Requested, Wage Attachment Fee Category, 17 – 14
Employee Retirement Processing, 6 – 6
Employee statuses
  formula processing rules for, 14 – 25
  formulas for different, 12 – 22
Employee Summary Report, 9 – 33
Employee–Requested Payment, Wage Attachment, 17 – 2
Employer
  charges, distribution of, 11 – 8
  liabilities, classification for, 12 – 12
  taxes, classification for, 12 – 12
Employer Contribution input value. See Benefits Table amount rule
Employment
  hiring, 8 – 10
  history, 9 – 35
Employment categories
  adding new, 9 – 5
  assigning employees to, 9 – 10
  full time and part time, 9 – 5
  in startup data, 9 – 5
Employment information
  making changes to, 9 – 3
  table of, 9 – 2
End assignment status, 9 – 16, 24 – 5
End Dates, removing, 1 – 16
Entering State Data, E and T Records, State Quarterly Wage Listings, 19 – 23
Entries. See Element entries
Error status, of payroll processes, 21 – 20, 21 – 28, 21 – 31
Ethnic origin, entry of, 8 – 6
EVAL_SYSTEM, 3 – 14
EVAL_SYSTEM_MEAS, 3 – 14
Evaluation systems, 3 – 14
Exchange rates
  currencies for element entries, 14 – 15
  for payroll runs, 21 – 13 to 21 – 21
External organizations, 2 – 14, 2 – 17
  classifications for, 2 – 23
  defining, 2 – 20

F
Federal tax rules, entry of, for employees, 18 – 25 to 18 – 27
Federal taxes. See Taxes
Fiscal year, balances for, 2 – 27
Flat Amount rule
  input value for, 15 – 24
  selection of, 15 – 30, 16 – 12
FLSA
  See also Overtime
    changing indicators for, 14 – 17
    hours, 15 – 11
    overtime base rate, 15 – 10
Folders, 23 – 3 to 23 – 8
FORM_MODE, 27 – 21
Formula result rules, 14 – 25
  modification of system–generated, 14 – 3
  system generation of, 14 – 2, 15 – 18, 16 – 2
Formulas
  and employee statuses, 12 – 22
  and Oracle FastFormula, 12 – 21
  conditional logic in, 12 – 21 to 12 – 23
  for element processing, 12 – 21 to 12 – 23
  for payroll calculations, 12 – 21
  for tax calculations, 12 – 22
  for validation, 24 – 4
  for wage attachments, 17 – 5
  in payroll startup data, 12 – 22
  indirect results and element entry, 12 – 29
  modification of system–generated, 14 – 3
  processing and result rules for, 14 – 25 to 14 – 29
  processing rules for, 12 – 22, 14 – 25, 14 – 26
  result rules for, 12 – 22, 14 – 7, 14 – 25 to 14 – 26, 14 – 27
    review of, 14 – 7
    system generation of, 14 – 2, 15 – 18, 16 – 2
  FREQUENCY, 2 – 29
  Frequency rules
    for recurring deductions, 12 – 23, 16 – 9, 16 – 10
    setup of, 16 – 10
  Full Personal Details Report Set, 8 – 31
  Further name information, 8 – 9

G
Garnishment, Wage Attachment Fee Category, 17 – 14
Garnishments
  See also Wage Attachment Fee Rules; Wage attachments
deductions for, 17 – 6
Gender information, entry of, 8 – 5
General ledger. See GL codes
Generate Secure User process, 28 – 15
Generated elements
  for payroll processing, 14 – 2, 15 – 18, 16 – 3, 17 – 7
  modification of, 14 – 3, 14 – 12 to 14 – 21
  pay values of, 12 – 19 to 12 – 21
Generated formulas, modification of, 14 – 3
Generating letters, batch processing, 30 – 13 to 30 – 16
GL codes
  costs transfer to Oracle GL, 11 – 24 to 11 – 26
  example of cost allocation to, 11 – 18 to 11 – 19
for federal taxes, 11–15
for state and local taxes, 11–15 to 11–17
in the Cost Allocation flexfield, 11–2 to 11–6

Government Reporting Entities. See GREs
Grade Name key flexfield, 2–4, 4–2, B–3
Grade rates, 4–8 to 4–10
Grade scales, 4–12
Grade steps, 4–15
  incrementing placements, 4–18
  placing employees on, 4–16
Grades, 4–2 to 4–5
  assigning an employee to, 9–10
  comparatio values, 4–10
  defining, 4–4 to 4–6
  relating to progression points, 4–15
  valid grades for jobs and positions, 3–16, 4–3

Grant Permissions To Roles process, 28–15

Graphics, 8–16

GRE Transmitters
  State Quarterly Wage Listings, A and B Record Data, 19–20
  State quarterly wage listings, about, 19–18
GREs
  additional information for, 2–25
  and common paymasters, 2–9
  and Legal Entities, 2–9
  and tax groups, 2–12
  defining, 2–20, 2–23
  federal tax rules for, 18–9 to 18–10
  functions of, 2–9
  identification number for, 2–9, 2–30
  local tax rules for, 18–12
  NACHA information for, 5–5
  placing employee assignments in, 9–10
  state tax rules for, 18–10 to 18–12
  W–2 reporting rules for, 19–8 to 19–10

Group Term Life premiums
  See also GTL Imputed Income
  predefined table for, 29–11
GTL imputed income
  earnings type for, 15–15 to 15–28
  predefined table for, 15–15

H
  Handpay. See Payments
  Health and safety requirements, for jobs or positions, 3–6
  Hiring people, 8–10
    New Hire reports, 8–32 to 8–36
  History, of assignments, 9–35
  Honors, entry of, 8–9
  Hot defaults
    consequences of overriding, 12–35, 12–44, 14–20
    for automatic updating, 12–35, 14–20
  Hours of work, 9–12
    entering defaults for, 2–8, 2–29
    work schedules for, 2–31 to 2–33
  Hours x Rate rules
    for earnings types, 15–24 to 15–25
    input values for, 15–25
    selection of, 15–30
    Wage Rates tables for, 15–24 to 15–26
  HR Organizations
    additional information for, 2–25
    classification for, 2–20
  HR User Type, 30–3
  HR:Business Group, 25–5
  HR:Query Only Mode, 25–5
  HR:Security Profile, 25–5
  HR:Use Standard Attachments, 25–5
  HR:User Type, 25–5
  HR_CUSTOMIZATION, 27–20

Human resource management
  cycle of functions, 1–4
  evaluating jobs and positions, 3–14 to 3–17
  integrating with payroll management, 1–3

I
  I–9 information, 8–7
    entry of, 8–7
  Illinois
    A and B Records, 19–21
E and T Records, 19–23
Implementation of HRMS
- in hybrid enterprise structures, 7–10 to 7–12
- in project based enterprises, 7–2 to 7–6
- in rule based enterprises, 7–6 to 7–13
Increment Progression Points process, 4–18
Indirect results
- costing elements with entries of, 11–7 to 11–9
- formula result rules for, 14–25 to 14–27
Initiated Deductions, Retirement Tax Withholding Rules, 6–4
Initiation
- of deductions, 16–3 to 16–18, 17–7 to 17–13
- of earnings or payments, 15–27 to 15–31
Input value entries
- currencies for, 14–15
- element level defaults for, 12–17, 14–19
- hot defaults for, 12–35, 12–44, 14–20
- link level defaults for, 12–18, 12–26
- units of measure for, 12–16
- validation for, 12–16 to 12–18
Input values
- Additional Amount, 21–4 to 21–5
- Adjust Arrears, 21–5
- and formula inputs, 12–21
- default entries for, 12–17 to 12–19
- establishing, for Information elements, 12–35
- for special inputs elements, 21–4 to 21–5
- Replacement Amount, 21–4 to 21–5
- setting up, 14–19
Inquiry windows, list of, 23–3
Insurance carriers
- defining, 2–22
- for Workers Compensation, 20–2
International relocation, employee preferences, 8–21
Involuntary Deduction. See Wage Attachment

J
Job codes, 3–5
- for Workers Compensation, 20–4 to 20–5, 20–13 to 20–14
Job Name key flexfield, 2–4, 3–5, B–3
Jobs
- assigning an employee to, 9–10
- contrasted with positions, 3–2
- defining, 3–8
- entering valid grades, 3–16
- evaluating, 3–14
- in project based enterprises, 7–4
- representing jobs and positions, 3–2 to 3–7
- skill requirements of, 3–17
- work choices, 3–18
- Workers Compensation codes for, 20–4 to 20–5

Jurisdiction
- and PayMIX entry of location, 13–62 to 13–64, 13–65
- entering for localities, 18–12
- for a secondary work location, 15–19
- input value for, 15–19 to 15–28

K
Kentucky
- E and T Records, 19–23
- E Records, 19–24
Key flexfields, 1–17
- Bank Details, B–11
- Cost Allocation, 11–2 to 11–10
- creating database items, B–4
- for country-specific information, B–10 to B–12
- Grade Name, 4–2
- in Oracle HRMS, 2–4 to 2–6
- Job Name, 3–5
- People Group, 5–10
- Personal Analysis, 2–5 to 2–6, 24–10
- Position Name, 3–5
- protected, B–10
- setting up, B–3
Soft Coded Legislation, B – 11
uses of, B – 2

L
Labor costs
See also Costing information
and the Cost Allocation flexfield, 11 – 2
example allocation of, 11 – 18 to 11 – 19
Labor Recording element, 15 – 4
Legal entities. See GREs
Legislation Code, 2 – 27
Length of service bands
for PTO accrual plans, 10 – 20
setup of, 10 – 25 to 10 – 26
Letter generation, 30 – 10 to 30 – 14
Letters
generating, batch processing, 30 – 13 to 30 – 16
setting up, 30 – 11
Link definition, 12 – 38 to 12 – 41
entering costing information, 12 – 39
entering qualifying conditions, 12 – 40
link level input value changes, 12 – 40
Links
See also Element links
components of, 12 – 25
for employee eligibility rules, 12 – 25
for tax deductions, 12 – 25
for Vacation Pay and Sick Pay elements, 15 – 5
for Workers Compensation elements, 20 – 8
reviewing, for an element, 12 – 40 to 12 – 41
rule for building, 12 – 25
standard, for automatic entry, 12 – 27, 14 – 16
LISTGEN, 28 – 15
Local Taxability Rules
Creating, 18 – 35
Ending, 18 – 36
Updating, 18 – 36
Local taxes. See Taxes
Location, entering for an office, 8 – 9
Locations, 2 – 2 to 2 – 3
See also Jurisdiction
assigning an employee to, 9 – 9

Lookups, 29 – 2

M
Magnetic Media Wage Reporting, Utilities, 19 – 38
Magnetic tape processes
for reports, 19 – 2, 19 – 35
rollbacks of, 19 – 37
Mail location information, entry of, 8 – 6
Mail merge, 30 – 10 to 30 – 14, 30 – 22
Mailstop, entry of, 8 – 8, 8 – 9
Manager–level assignments, 9 – 28
Managing change, 1 – 9
Manual element entries, completion of, 12 – 42
12 – 44
Marital Status information, entry of, 8 – 6
Mass Move, 3 – 25
deleting, 3 – 35
describing, 3 – 28
executing, 3 – 33
making decisions for, 3 – 26
managing your collection of, 3 – 35
preparing for, 3 – 26 to 3 – 28
prerequisites for, 3 – 26 to 3 – 28
reexecuting, 3 – 34
reviewing the results of, 3 – 34
status of, 3 – 34
summary of tasks, 3 – 28
Maternity leave, 24 – 7
Matrix management, hierarchies for, 2 – 35
Medical information, 8 – 9, 8 – 26, 24 – 10
Menu Structures Report, 27 – 18
Menus
default menu paths, A – 1
defining, 27 – 17 to 27 – 22
for security, 28 – 2, 28 – 8
query–only access, 27 – 19
Messages
formula result rules for, 14 – 25 to 14 – 26
from pay processing, 21 – 26 to 21 – 27
Microsoft Word, 30 – 10 to 30 – 14
Military leave, 24 – 7
Missouri
A and B Records, 19–21
E and T Records, 19–23
S Record Data, 19–27
T Records, 19–24
MIX facilities, for batch element entry, 13–50
Modifications, of system–generated elements, 14–12 to 14–13
Montana
E and T Records, 19–23
T Records, 19–24
Multiple Worksite reporting
filing information for, 2–26
GRE transmitter for, 2–25

N
NACHA
personal payment methods using, 9–21 to 9–23
prenote information for, 9–22
reporting for, 21–40
Name, entry of additional name information for an employee, 8–9
Negative pay. See Payments
Net Accrual Calculation, 10–26 to 10–27
New Hampshire
E and T Records, 19–25
E Records, 19–25
New hire reporting, 8–32
employee information for, 8–34 to 8–35
GRE contact for, 8–33 to 8–34
obtaining, 8–35 to 8–37
setup steps for, 8–33
New Jersey, A and B Records, 19–21
New York
E and T Records, 19–25
E Records, 19–25
Non–payroll payments
deduction processing against, 15–23
PayMIX entry for, 15–29
review of, 14–6
separate checks for, 15–22
user–initiated and system–generated, 14–2
Non–Periodic Payments, after retirement, 6–10
Nonrecurring elements, 5–2
See also Processing type
PayMIX for entries to, 13–64
North Carolina
E and T Records, 19–25
E Records, 19–25
O
Office location, entry of, 8–8
Office number, entry of, 8–8, 8–9
Ohio
E and T Records, 19–25
E Records, 19–25
Oracle FastFormula. See Formulas
Oracle Human Resources
using with Oracle Payroll, 30–2 to 30–5
using with spreadsheets, 30–5
ORACLE IDs, 28–11
Oracle Payroll, 30–2
ORG>Type, 2–14
Organization hierarchies, 2–34 to 2–41
adding to, 2–31
creating, 2–37 to 2–41
for matrix management, 2–35
in security profiles, 28–5
versions of, 2–36
Organization Hierarchy Report, 2–39
Organizations, 2–14 to 2–17
adding to hierarchies, 2–25, 2–26, 2–31
additional information for, 2–24
assigning an employee to, 9–9
classifications for, 2–20, 2–23
cost centers for, 2–16
defining, 2–20 to 2–24
deleting, 2–33
entering site addresses for, 2–2
external, 2–17, 2–20
in project based enterprises, 7–3
levels of internal, 2–14 to 2–16
listing employees assigned to, 9–28
used with position control, 3–4
OSHA reporting, information for, 8 – 26
OTA, SQL*Plus script, D – 8 to D – 11
Other information, entering for an employee, 8 – 9
Overhead labor costs, distribution of, 11 – 19 to 11 – 25
Overtime
  base rate calculation, 15 – 11
  base rate, including earnings in, 15 – 29
  earnings type for, 15 – 10 to 15 – 28

P
Parent organizations, 2 – 31
Part time employment category, 9 – 6
Paternity leave, 24 – 7
Pay periods, selecting, 5 – 7
Pay scales, 4 – 12
  defining, 4 – 13
  defining rates for, 4 – 14
Pay values
  and generated elements, 12 – 20
  enterable and non-enterable, 12 – 19 to 12 – 21
  purpose of, 12 – 19
  setup of, 12 – 35, 14 – 19
  to hold run results, 12 – 19
Payee organization, defining, 2 – 23
Payment methods
  for a payroll, 5 – 8
  for employee assignments, 9 – 21 to 9 – 23
  for the enterprise, 5 – 3
Payments
  manual, 18 – 39, 21 – 24
  reporting for, 21 – 36
  running processes for, 21 – 15
  viewing information about, 21 – 33
  zero or negative, 21 – 2
PayMIX
  and special inputs element entry, 21 – 4 to 21 – 5
  batch line dates, 13 – 66 to 13 – 67
  customizing segment names for, 2 – 8
  enabling entries using, 14 – 16
  for batch element entry, 13 – 50
  for earnings and deductions entries, 13 – 64 to 13 – 65
  for entry of accrued time taken, 10 – 30
  for payroll batch entry, 13 – 60 to 13 – 61
  for pre–run changes, 21 – 12 to 21 – 13
  marking deductions for, 16 – 6
  marking earnings for, 15 – 29
  procedures for, 13 – 69 to 13 – 76
  process for validation and transfer, 13 – 75 to 13 – 78
  process review and correction, 13 – 77
  routing to input values, 13 – 64 to 13 – 66
  statuses for, 13 – 67
Payroll code number, 9 – 7
Payroll costs. See Costing information
Payroll exposure
  entering rules for, 20 – 14 to 20 – 15
  for Workers Compensation premiums, 20 – 3, 20 – 6
Payroll formulas
  See also Formulas
    for element processing, 12 – 21 to 12 – 22
    modification of, 15 – 25
Payroll management, 1 – 3
  cycle of functions, 1 – 4
Payroll run types
  default withholding methods for, 15 – 20, 18 – 4
  Regular and Supplemental, 15 – 20, 21 – 2
Payroll runs
  and balance adjustments, 22 – 10
  and retroactive processing, 22 – 12 to 22 – 15
  assignment–level results, 21 – 30 to 21 – 34
  correcting run results, 22 – 2 to 22 – 3
  defining exchange rates for, 21 – 13 to 21 – 21
  employee setup for, 9 – 5, 21 – 7
  initiating QuickPay, 21 – 19 to 21 – 23
  initiating standard, 21 – 9 to 21 – 14
  making pre–run changes, 21 – 12 to 21 – 13
  messages issued from, 21 – 26 to 21 – 27
  process–level results, 21 – 27 to 21 – 30
  Regular and Supplemental, 21 – 2 to 21 – 3
  reporting on, 21 – 36 to 21 – 41
  retries of, 22 – 5
  reversals of, 22 – 8
  reviewing results of, 21 – 26
  rollbacks of, 22 – 3
standard and QuickPay, 21–2 to 21–4
tax withholding in, 18–4 to 18–5
viewing run result histories, 21–34
Payroll Table amount rule, selection of, 16–12
Payroll tables
  row type setup, 16–14 to 16–16
  row types for, 29–11
Payrolls
  assigning employees to, 9–9
  check date, 5–7
  cut off date, 5–7
  defining, 5–6 to 5–11
  deleting, 5–9
  in security profiles, 28–7
  scheduled run date, 5–7
  using in HRMS, 5–2
Pennsylvania
  A and B Records, 19–21
  E and T Records, 19–25
  E Records, 19–26
Pension Elements, 6–3
Pension groups, 5–10
People folders, 8–3
People Group key flexfield, 2–5, B–3
  setting up, 5–10
  to represent companies, 2–15 to 2–17
People groups, assigning employees to, 9–10
Percentage of Earnings rule
  input value for earnings types, 15–26 to 15–28
  selection of, 15–30, 16–12
Period of service, 9–35
Person Details Report, 8–31
Person types, 24–2 to 24–4
Personal Analysis key flexfield, 2–5, 24–10, B–4
Personal information
  deleting, 8–37
  entering, 8–4
  entering special information, 8–26
  I–9, veteran, ethnic origin, 8–6
  inquiring and reporting on, 8–3, 8–31
  office location, mailstop, 8–8
  tracking roles and activities, 8–30
Personal payment methods, NACHA or paycheck, 9–21
PERWPOUK, SQL*Plus script, D–2 to D–5
PERWPWUk, SQL*Plus script, D–6 to D–9
Physician’s name, entry of, 8–9
Pictures, 8–16
PLACEMENT_REAson, 4–17
Position hierarchies, 3–3
  adding a new position, 3–12
  creating, 3–21 to 3–36
  creating new versions, 3–22
  in security profiles, 28–6
Position Hierarchy Report, 3–24
Position Name key flexfield, 2–4, 3–5, B–3
Positions
  assigning an employee to, 9–10
  contrasted with jobs, 3–2
  defining, 3–11 to 3–14
  entering valid grades, 3–16
  evaluating, 3–14
  in rule based enterprises, 7–6
  listing employees assigned to, 9–30
  representing jobs and positions, 3–2 to 3–7
  skill requirements of, 3–17
  source, 3–29
  target, 3–30
  viewing occupancy, 3–20
  work choices, 3–18
Post–run processes, Deposit Advice, 21–6
Pre–payments processing, 21–5
  for QuickPay runs, 21–22 to 21–26
  initiation of, 21–15
Pre–Tax Deduction, Local Taxability Rules
  creating, 18–35
  Ending, 18–36
  updating, 18–36
Pre–tax deductions
  balance for, 14–11
  classification and categories for, 12–11
  taxability rules for, 18–2, 18–37 to 18–41
Predefined user tables, 29–11
  Company Work Schedules, 29–11
  GTL Premiums, 29–11
  Shift Differentials, 29–12
Wage Rates, 29 – 12
Prefix information, entry of, 8 – 5
Prenote information, for NACHA payments, 9 – 22
Primary assignment statuses, for employees, 9 – 6 to 9 – 7, 24 – 5
Primary element classifications, 12 – 8 to 12 – 15
Primary reporting hierarchy, 2 – 34
Prior period pay
dated earned for, 15 – 19
employee information for, 15 – 19
Probation period, 3 – 11, 3 – 12
entering on assignments, 9 – 12
Processes
Check Writer, 17 – 12, 21 – 6, 21 – 16
Costing, 11 – 22 to 11 – 24, 21 – 6
Create Descriptive Flexfield DB Items, B – 6, C – 23
Create Key Flexfield DB Items, B – 4, C – 25
Deposit Advice, 21 – 17
Federal W-2, 19 – 35
Generate Secure User, 28 – 15
Grant Permissions To Roles, 28 – 15
NACHA, 21 – 6, 21 – 17
pay–related, 21 – 7
PayMIX Batch, 13 – 75
post–run, 21 – 5 to 21 – 7
Pre–Payments, 21 – 5, 21 – 15
PTO Carry Over, 10 – 21, 10 – 30
QuickPay runs, 21 – 19 to 21 – 23
RetroPay, 22 – 12, 22 – 15
Rollback Magnetic Report, 19 – 37
Security List Maintenance, 28 – 15
security of, 28 – 9
standard payroll runs, 21 – 9 to 21 – 14
State Quarterly Wage Listing, 19 – 36
Transfer to GL, 11 – 24 to 11 – 26, 21 – 6
Processing rules, modification of, 14 – 14 to 14 – 16
Processing type
of elements, 12 – 4
recurring and nonrecurring, 12 – 4, 12 – 23
Progression points
defining, 4 – 13
entering special ceiling for, 9 – 12
relating to grades, 4 – 15
Project based enterprises, 7 – 2 to 7 – 6
Promotions, recording information about, 9 – 4 to 9 – 6, 9 – 14
Proration of pay, work schedules for, 9 – 11
PTO (paid time off)
calculation of net accrued, 10 – 27
carry over process for, 10 – 30 to 10 – 34
manual or batch entry of time taken, 10 – 29 to 10 – 30
residual and carried over, 10 – 21
review of net time accrued, 10 – 32 to 10 – 34
sale or purchase of, 10 – 22, 10 – 30
PTO accrual plans
elements for, 10 – 18 to 10 – 19
enrollment in, 10 – 29
length of service factors, 10 – 20 to 10 – 23
maintenance of, 10 – 29
operation and structure of, 10 – 18 to 10 – 22
period of ineligibility under, 10 – 19
setup steps for, 10 – 23 to 10 – 28
start rule options for, 10 – 19 to 10 – 20
Public sector, implementation in, 7 – 6 to 7 – 13
Purchase Price input value. See Series EE Bond purchase
Purge, 1 – 15

Q
Qualifications, 8 – 19
Qualifiers, for the Cost Allocation key flexfield, 11 – 11 to 11 – 13
Qualifying conditions
establishing, for element entry, 14 – 15
failure to meet, 12 – 43
QUALIFYING_UNITS, 3 – 11
Query–only access to windows, 27 – 19
QuickCodes
access levels, 29 – 2
creating QuickCode values, 29 – 3
defining QuickCode types, 29 – 5
list of predefined types, 29 – 6 to 29 – 8
removing QuickCode values, 29 – 3

Index – 15
QuickPaint reports, 23 – 8
customizing, 23 – 13
defining, 23 – 9 to 23 – 11
running, 23 – 12 to 23 – 13
QuickPay runs, 21 – 2
manual payments for, 21 – 24 to 21 – 26
pre–payments processing for, 21 – 22
procedure for, 21 – 19 to 21 – 23
retry of, 21 – 22
reviewing results of, 21 – 21
rollback of, 21 – 22

R
Rate codes
and wage rate tables, 15 – 24
PayMIX entries for, 13 – 62 to 13 – 64
Rates
See also Regular Wages, Time Entry Wages
Overtime, Shift Pay
for earnings calculations, 15 – 24
for grades, 4 – 8
for pay scales, 4 – 14
PayMIX entries for, 13 – 62
Re–hiring an employee, 8 – 10
Recurring elements
See also Processing type
PayMIX for changes to, 13 – 64 to 13 – 67
pre–run changes to, 21 – 4 to 21 – 5
Reference information, for a rehire applicant, 8 – 8
Regular
earnings, 12 – 10, 15 – 20
payroll runs, 21 – 2 to 21 – 3
runs, 15 – 20
salary, 15 – 2 to 15 – 6
wages, 15 – 2 to 15 – 6
withholding, 18 – 4, 21 – 3
Regular Hours Worked element, 15 – 4
Regular runs
See also Payroll run types
scheduled date of, 5 – 7
Regular Salary and Regular Wages
earnings type for, 15 – 2 to 15 – 7
elements associated with, 15 – 2 to 15 – 5
formula processing for, 15 – 5
Regular Wages, Retirement, 6 – 11
Rehire information, 8 – 8
Reimbursements, classification for, 12 – 11
Relief position, to cover absence, 3 – 12
Relocation, employee preferences, 8 – 19
Reorganizing, positions and assignments, 3 – 25
Reporting Categories and Statuses, registering,
2 – 8, 2 – 24
Reporting Establishments, additional information for, 2 – 26 to 2 – 33
Reporting lines, 2 – 35, 3 – 3, 3 – 21
Reporting organizations
additional information for, 2 – 26 to 2 – 28
defining, 2 – 23
Reporting Rules, 1099R, 19 – 41
Reporting users, 28 – 8
Reports
Absences, 10 – 17
Archive Differences Report, 19 – 39
Archive Magnetic Report, 19 – 39
Assignment Status, 9 – 32
Cost Breakdown Summary, 11 – 22, 11 – 23
Current and Projected Progression Point Values, 4 – 18
defining, 23 – 6
Earnings Audit, 21 – 38
Element Link Details, 12 – 40
Employee Deductions Not Taken, 21 – 39
Employee Deductions Taken, 21 – 39
Employee Increment Results, 4 – 19
Employee Organization Movements, 9 – 33
Employee Payroll Movements, 9 – 33
Employee Summary, 9 – 33
Form 1099R, 19 – 41
Form 941, 19 – 33
Form W–2 for employees, 19 – 29
Form W–2 on magnetic tape, 19 – 35
Full Personal Details, 8 – 31
Gross to Net Summary, 21 – 38
list of, 23 – 5 to 23 – 7
Magnetic Media Wage Reporting Utilities, 19 – 38 to 19 – 41
Menu Structure, 27 – 18
NACHA, 21 – 40
New Hire, 8 – 32 to 8 – 36
Organization Hierarchy, 2–39
Payments Register, 21–36
Position Hierarchy, 3–24
QuickPaint, 23–9 to 23–17
Resubmit Magnetic Media Reports, 19–38
security of, 28–9
State Quarterly Wage Listings, 19–18 to 19–27, 19–36
Statement of Earnings, 21–16
Tax Summary, 19–28 to 19–38
Terminations, 9–19
Responsibilities, 27–17, 28–2
defining, 28–11
Restricting access to records
by menu structures, 27–17, 28–8
by organization hierarchy, 28–5
by payroll, 28–7
by position hierarchy, 28–6
by Responsibilities, 28–2 to 28–4
by security profiles, 28–4
from other tools, 28–8
Resubmit Magnetic Report, Magnetic Media
Wage Reporting Utilities, 19–38
Resumes, entry of status information on, 8–8
Retirement GRE, 6–3
Retirement Leaving Reason, 6–3
Retirement Payroll, 6–3
Retirement Processing
Assignment, 6–7
Defined Benefits Plan, 6–2
Earned Income, 6–10
Employees, 6–6
Establishing Retirement Structures, 6–3
Final Pay, 6–7
Pension Elements, 6–3
Primary Assignment, 6–9
Regular Wages, 6–11
Retirement GRE, 6–3
Retirement Leaving Reason, 6–3
Retirement Payroll, 6–3
Retirement Status, 6–4
Retiring the Employee, 6–6
Salary Basis, 6–4
Tax Withholding Rules, 6–4, 6–8
Wages after Retirement, 6–10
Retirement Salary Basis, 6–4
Retirement Status, 6–4
Retries
marking runs for retry, 22–5
of pay processes, 22–5
Retroactive pay, 22–2, 22–12
RetroPay set creation, 22–14
running RetroPay, 22–15
setup steps for, 22–12 to 22–16
the RetroPay process, 22–12 to 22–16
Retrys, procedures for, 22–5 to 22–8
Reversals
of payroll processing, 22–8
procedure for, 22–8
Reviews
of employee performance, 9–12
of salaries, 9–12
ROLEGEN, 28–15
Rollbacks
of magnetic tape report processes, 19–37
of pay processes, 22–3
procedures for, 22–3 to 22–5
Row Name input value. See Payroll Table
amount rule
Rule based enterprises, 7–6 to 7–13
Rules, Wage Attachment Fee
Concluding, 17–17
Creating, 17–15
Updating, 17–16
Run results
See also Pay values
and Oracle FastFormula, 12–21 to 12–27
correction of, 22–2
Run sets. See Element sets

S

S Records
Alaska, 19–27
California, 19–27
Missouri, 19–27
State Quarterly Wage Listings, 19–26
Salary
See also Regular Salary
relating to grades, 4–3
Salary administration, for element entry, 12–27
Salary Basis, Retirement, 6 – 4
Salary basis, assigning an employee to, 9 – 12
Scale rates, 4 – 14
School attendances, 8 – 19
School District Taxability Rules, Creating, 18 – 35
School loans, Wage Attachment. See Educational Loans
SECGEN, 28 – 15
Secondary assignment statuses, 24 – 6
adding reasons for, 24 – 6
Secondary statuses
defining, 24 – 7, 24 – 8
entering for employees or applicants, 9 – 23
Security, 28 – 2 to 28 – 9
creating Oracle IDs, 28 – 11
enabling currencies, 25 – 7
list of user profile options, 25 – 5 to 25 – 8
of reports and processes, 28 – 3, 28 – 9
restrictions by HR User Type, 30 – 4
setting up, 28 – 10 to 28 – 12
setting user profile options, 25 – 4
Security groups, 28 – 3, 28 – 9
Security List Maintenance process, 28 – 15
Security profiles, 28 – 2, 28 – 4 to 28 – 7
defining, 28 – 13 to 28 – 15
Separate check payments
input value for, 15 – 22
PayMIX entry for, 13 – 62 to 13 – 64, 13 – 65
to 13 – 71
setup of, 15 – 30
Series EE Bond purchase
balance for, 14 – 11
deduction for, 16 – 11
Purchase Price input value, 16 – 11
setup for, 16 – 7
Setting up, standard letters, 30 – 11
Shift differentials
PayMIX entry for, 13 – 62 to 13 – 64
predefined table for, 15 – 13 to 15 – 14, 29 – 12
Shift Pay, earnings type for, 15 – 13 to 15 – 28
Shift worked, entry of regular, 9 – 11
Skills information, 8 – 26
Skip rules
adding to generated, 14 – 14
selection of, 14 – 15
Social security number, as employee number, 9 – 7
Soft coded legislation, B – 11
Source positions, identifying, 3 – 29
Special ceiling points, 9 – 12
Special information types
enabling, 24 – 11
entering, 8 – 26
for ADA and OSHA reporting, 8 – 26
setting up, 24 – 10 to 24 – 12
Special inputs elements
for pre–run changes, 21 – 4 to 21 – 5
making entries to, 21 – 12 to 21 – 13
PayMIX entries for, 13 – 64 to 13 – 71
viewing, 14 – 6
Spousal Support Order, Wage Attachment Fee Category, 17 – 14
Spousal support orders, Wage Attachment, 17 – 2
Spreadsheets, 30 – 5
SQL*Plus script
OTA – for confirmation letters, D – 8 to D – 11
PERWPOUK, D – 2 to D – 5
PERWPWUK, D – 6 to D – 9
SQWL, about, 19 – 2
Standard element links
See also Automatic element entry
elements of, 12 – 28 to 12 – 30
setup of, 14 – 16
Standard letters, 30 – 10
Standard work day, 9 – 12
State Quarterly Wage Listings, 19 – 18 to 19 – 27
A and B Records
Illinois, 19 – 21
Missouri, 19 – 21
New Jersey, 19 – 21
Pennsylvania, 19 – 21
Texas, 19 – 21
Blocking Factor, E Records, 19 – 22
E and T Records, 19–23
Illinois, 19–23
E Records
Kentucky, 19–24
New Hampshire, 19–25
New York, 19–25
North Carolina, 19–25
Ohio, 19–25
Pennsylvania, 19–26
Texas, 19–26
Entering State Data, E and T records, 19–23
GRE Transmitters
A and B Record Data, 19–20
about, 19–18
S Records, 19–26
Alaska, 19–27
California, 19–27
Missouri, 19–27
T Records
Missouri, 19–24
Montana, 19–24
State taxes. See Taxes
Statement of Earnings, production of, 21–16
to 21–18
Statement of earnings, 21–20, 21–32
online display of, 21–21
processes for, 21–16 to 21–17
States
and Workers Compensation, 20–2
employee tax rules for, 18–26 to 18–28
quarterly wage listings for, 19–18, 19–36
Status, of assignments, 24–5
Statuses, for letter generation, 30–10
Subsidiaries, as Business Groups, 2–7
Succession planning, 3–12
Suffix information, entry of, 8–5
Supervisor, entering on assignments, 9–11
Supplemental
earnings, 12–10
payroll runs, 21–2 to 21–3
withholding, 15–20, 18–4, 21–3
Supplemental runs. See Payroll run types
Supplemental withholding
for tax calculations, 18–2
input value for, 15–20 to 15–28
selecting a GRE’s method for, 18–10
Surcharges, for Workers Compensation, 20–5,
20–14 to 20–15
Suspended assignment status, 24–5
Suspense account, 11–6 to 11–7
System administrator, role of in OHR, 25–2

T
T Records
Missouri, 19–24
Montana, 19–24
Table Column input value. See Payroll Table
amount rule
Tables, user–defined, 29–30
accessing values in, 29–10
entering values into, 29–17
payroll tables for deduction amounts, 29–11
setting up, 29–14 to 29–16
Target positions, identifying, 3–30 to 3–32
Task flows, 27–9 to 27–16
adding to a menu, 27–20
defining nodes, 27–12
Tax and Wage Reporting, State Quarterly Wage
Listings, about, 19–2
Tax balances
adjustments to, 18–39 to 18–43
and Vertex Inc. routines, 18–7 to 18–13
created in payroll runs, 18–5 to 18–9
entering adjustments to, 18–40 to 18–46
for upper earnings limits, 18–7
viewing, 18–44 to 18–46
Tax deductions
and Vertex Inc., 12–12, 14–2, 18–5, 18–7
classifications and categories for, 12–12 to
12–14
links and entries for, 12–25, 14–2
withholding methods for, 18–4 to 18–5
Tax groups, defining, 18–10
Tax information
entering for employees, 18–13 to 18–14
for earnings and deductions categories, 18
–33 to 18–38
for GREs, 18–9
for new hires, 18–13
maintenance of, 18–2 to 18–3
The text in the image contains various sections from a user's guide, discussing topics such as tax jurisdictions, tax levies, wage attachment, tax withholding rules, taxability rules, and payroll-related processes. Here is the index entry in plain text:

- Tax jurisdictions. See Jurisdiction
- Tax levies, Wage Attachment, 17–2
- Tax Levy, Wage Attachment Fee Category, 17–14
- Tax Separately. See Tax withholding methods
- Tax withholding methods, 18–4
  and Tax Separately input value, 15–20
  for Regular and Supplemental runs, 15–20
  for supplemental earnings in regular runs, 15–20
- Tax Withholding Rules
  Retirement, 6–4
  Retirement Processing, 6–8
- Taxability Rules
  City
    Creating, 18–35
    Ending, 18–36
    Updating, 18–36
  County
    Creating, 18–35
    Ending, 18–36
    Updating, 18–36
  School District, Creating, 18–35
- Taxability rules, 18–2
  for earnings types, 18–36 to 18–37
  for pre-tax deductions, 18–37
- Taxes
  balances for, 18–5, 18–44 to 18–46
  costing, by jurisdiction, 11–15
  costing, by tax type, 11–15
  element classifications for, 12–12
  federal tax rules, 18–9 to 18–10
  federal, state and local, 12–12, 18–5
  local tax rules, 18–12 to 18–25
  maintaining information for, 2–9, 2–25, 18–2
  payroll run calculations of, 18–5
  reports for, 19–28
  state tax rules, 18–10 to 18–12
  W–2 reporting for GRES, 19–8 to 19–10
  with upper earnings limits, 18–7
- Template
  PERWPOUK, D–2 to D–5
  PERWPWUK, D–6 to D–9

Temporary cover, 3–12
Terminated assignment status, 9–16, 24–5
Terminating employees
  adding to reasons for, 9–17
  cancelling a termination, 9–18
  procedure for, 9–17 to 9–18
  processing pay after, 24–8
  reporting on, 9–19 to 9–20
  retirement processing, 6–6
Termination, of employees, 9–17 to 9–18
Termination dates, 9–18
Termination rules, modification of, 14–14
Terminations Report, 9–19
Texas
  A and B Records, 19–21
  E and T Records, 19–25
  E Records, 19–26
Third party payments
  See also Payments
  defining a personal payment method, 9–23
  for wage attachments, 17–10 to 17–12
  payee organizations for, 2–23
Threshold Amount input value. See Earnings
  Threshold start rule
Time Entry Wages element, 15–2
  for PayMIX timecard entry, 13–62
Timecard, entry of requirement for, 9–11
Timecards, using PayMIX to enter, 13–62 to 13–63
Title information, entry of, 8–26
Total Owed input value. See Total Reached
  stop rule
Total Reached stop rule
  Accrued balance for, 14–10 to 14–12
  input value for, 16–9
  selection of, 16–8
Training information, 8–26
Transfers or relocations
  recording information on, 9–4 to 9–6, 9–14
  W–4 information for, 18–13
Turnover, reporting on, 9–33 to 9–34
U
Union membership, 5 – 10
Union pay scales, 4 – 12
University attendances, 8 – 19
User profile options, 28 – 3, 28 – 11, 30 – 4
User statuses
  defining, 24 – 7
  for employee assignments, 24 – 7
  renaming, 24 – 7
User tables, 29 – 10 to 29 – 11
  See also Payroll tables; Predefined user tables
User–initiated deductions
  See also Deductions
  components generated for, 14 –2
  modifying generated components of, 14 –3
User–initiated earnings types
  See also Earnings types
  components generated for, 14 –2, 15 –18
  features of, 15 –18
  modifying generated components of, 14 –3
User–initiated non–payroll payments
  See also Non–payroll payments
  components generated for, 14 –2, 15 –18
  features of, 15 –18
  modifying generated components of, 14 –3
Users, creating, 28 – 11
Utilities
  Archive Differences Report, 19 –39
  Archive Magnetic Report, 19 –39
  Magnetic Media Wage Reporting, 19 –38
  Resubmit Magnetic Report, 19 –38

V
Valid grades, 3 – 16
Vertex Inc.
  Oracle Corporation agreement with, 14 –2
tax calculations from, 12 – 12, 18 –5
Vertex, Inc., link for Vertex element, 18 –24
Veteran status, entry of, 8 – 7
VETS–100 reporting, identifying employees for, 8 – 7
Views, list of, 23 – 3
Visa information, entry of, 8 – 7

W
W–2
  for employees, 19 –29
  GRE reporting rules for, 19 –8
  on magnetic tape, 19 –35
  Wage and Tax Statement, 19 –29
W–4 information
  allowances claims, 18 –27
  entry of, 18 –13
  for new hires, 18 –13
  for tax calculations, 18 –2 to 18 –5
  for transferring employees, 18 –13
Wage Attachment Fee Rules
  Administration, 17 –14
  Categories, 17 –14
  Concluding, 17 –17
  Creating, 17 –15
  Rules
    Amount, 17 –14
    Amount or percent, 17 –14
    Amount to maximum per month, 17 –15
    Amount to maximum per period, 17 –15
    Amount to maximum per run, 17 –15
    Initial and subsequent amounts, 17 –15
    Initial and subsequent amounts to maximum per month, 17 –15
    Initial and subsequent amounts to maximum per period, 17 –15
    Initial and subsequent amounts to maximum per run, 17 –15
    Updating, 17 –16
Wage Reporting Utilities, 19 –38 to 19 –41
Wages. See Regular Wages
Windows
  Absence Attendance Type, 10 – 10
  Absence Detail, 10 – 13
  Accrual Bands, 10 – 25

Accrual Plan, 10 – 23
Accruals, 10 – 32 to 10 – 34
Address (for Oracle Payroll), 8 – 13
Address (generic), 8 – 11
Adjust Balance, 22 –10
Adjust Tax and Subject Wage Balances, 18 –39, 18 –40
Alter Effective Date, 1 – 11
Assignment, 9 – 9
Assignment Criteria, 23 – 15
Assignment History, 9 – 35
Assignment Process Information, 21 –29
Assignment Processes, 21 –29
Assignment Set, 23 – 14
Assignment Statuses, 24 – 7
Assignments Folder, 9 – 25
Balance, 14 –22
Batch Entry Default Values, 13 –71
Batch Header, 13 – 52
Batch Lines, 13 – 52
Benefit Contributions, 16 –17
Columns, 29 – 15
Competence Profile, 8 – 20
Consolidation Sets, 21 –10
Costing, 11 – 22
Costing Breakdown, 11 – 22
Date Track History Change Field Summary, 1 – 13
Deduction, 16 –3, 17 –7
Deductions Entry, 13 – 74
default navigation paths, A – 15
Define Task Flow, 27 – 14
Define Task Flow Nodes, 27 – 12
Delete Person, 8 – 37
Earnings, 15 –27
Earnings Entry, 13 – 73
Element, 12 – 32, 14 –13
Element and Distribution Set, 27 – 5
Element Entries, 12 –43, 16 –4
Element Link, 12 – 38
Employee Assignment Processes, 21 –30
Employee Run Result History, 21 –34
Entry Values, 12 – 43
Exchange Rates, 21 –13
External/Manual Payments, 21 –24
Federal Tax Rules, 18 –9
Find Person, 8 – 2
Find Positions, 3 – 29
Form Customization, 27 – 7
Formula Result Rules, 14 –26
Frequency Rules, 16 –10
Further Element Information, 14 –16, 16 –18
Grade Rate, 4 – 9, 27 – 20
Grade Scale, 4 – 15
Grade Step Placement, 4 – 16
Grades, 4 – 4
GREs and Other Data, 19 –26
Job, 3 – 8
Job Evaluation, 3 – 15
Job Requirements, 3 – 17
Letter, 30 – 18
List Assignments, 9 – 26
List Employees by Absence Type, 10 – 16
List Employees by Element, 12 – 46
List Employees by Organization, 9 – 28
List Employees by Position, 9 – 30
List Employees by Position Hierarchy, 9 – 31
List People by Assignment, 9 – 27
List People by Special Information, 8 – 28
Local Tax Rules, 18 –12
Location, 2 – 3
Mass Move, 3 – 28
Mass Move – Assignments, 3 – 31
Mass Move – Positions, 3 – 30
Mass Move – Valid Grades, 3 – 33
Menu, 27 – 18
Net Calculation Rules, 10 – 26
Organization, 2 – 20
Organization Hierarchy, 2 – 37
Organizational Payment Method, 5 – 3
Parent Organization, 2 – 31
Pay Scale, 4 – 13
Payments, 21 –33
PayMIX Batch Information, 13 – 69
PayMIX Batch Summary, 13 – 77
Payroll, 5 – 7
Payroll Processes, 21 –27 to 21 –29
People, 8 – 5
People Folder, 8 – 3
Period Dates, 5 – 8
Person Types, 24 – 3
Personal Payment Method, 9 – 21
Picture, 8 – 16
Position, 3 – 11
Position Evaluation, 3 – 15
Position Hierarchy, 3 – 21
Position Occupancy, 3 – 20
Position Requirements, 3 – 17
Qualifications, 8 – 23
QuickCode Types, 29 – 5
QuickCodes, 29 – 3
QuickPaint Inquiry, 23 – 12
QuickPaint Report, 23 – 9
QuickPay, 21 – 19
Request Letter, 30 – 20
Requests, 21 – 30
RetroPay Set, 22 – 14
Reverse Payroll Run, 22 – 8
Rows, 29 – 15
Scale Rate, 4 – 14, 27 – 20
Schools and Colleges Attended, 8 – 24
Secondary Statuses, 9 – 23
Security Profile, 28 – 13
Special Information, 8 – 26
Special Information Types, 24 – 11
SQWL Generic Transmitter Rules, 19 – 19
SQWL State Transmitter Rules, 19 – 20, 19 – 21
State Tax Rules, 18 – 10
Submit Requests, 23 – 5
Table Structure, 29 – 14
Table Values, 29 – 17
Tax Rules, 18 – 24
Taxability Rules, 18 – 33 to 18 – 35
Terminate, 9 – 17
Time Entry, 13 – 72
Update Payroll Run, 21 – 11
Valid Grades, 3 – 16
Valid Payment Methods, 5 – 8
View Absence History, 10 – 15
View Earnings and Deductions Balances, 14 – 8
View Element Entry History, 12 – 45
View Employee Grade Comparatio, 4 – 10
View Requests, 23 – 5
View Run Messages, 21 – 26
View Tax Balances, 18 – 44
W2 Reporting, 19 – 8
WC Codes and Rates, 20 – 13
Work Choices (Job or Position), 3 – 18
Work Choices (Person), 8 – 21
Work Day Information, 2 – 29
Work Schedule, 2 – 31
Workers Compensation, 20 – 14
Word processors, 30 – 13
Work choices, 8 – 19
employee preferences, 8 – 21
jobs and positions, 3 – 18
Work day information, 2 – 29, 9 – 12
Work Details Report, 8 – 31
Work locations, and tax jurisdictions, 15 – 19
Work schedules, 2 – 31
employee preferences, 8 – 19
entry for employee assignments, 9 – 11
predefined table for, 29 – 11
selecting for an employee, 8 – 9
Work structures, 1 – 7
and key flexfields, 1 – 17
dates, 1 – 9, 1 – 10
setup examples, 7 – 1 to 7 – 14
Workers Compensation
data setup for, 20 – 12 to 20 – 17
elements and formula for, 20 – 8 to 20 – 10
insurance carriers for, 2 – 23, 20 – 2
job codes and rates for, 20 – 4 to 20 – 5, 20 – 13 to 20 – 17
links for WC elements, 18 – 24, 20 – 8
override code for, 9 – 11, 20 – 7, 20 – 15
premium calculation, 20 – 3, 20 – 9
premium modifiers, 20 – 5
WORKFLOW_NAME, 27 – 20

Z

Zero pay. See Payments
Reader’s Comment Form

Oracle Payroll US User’s Guide
A58333–01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information we use for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual? What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter, and page number below:

_____________________________________________________________________________
_____________________________________________________________________________
_____________________________________________________________________________
_____________________________________________________________________________
_____________________________________________________________________________

Please send your comments to:
Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
Phone: (415) 506–7000  Fax: (415) 506–7200

If you would like a reply, please give your name, address, and telephone number below:

_____________________________________________________________________________
_____________________________________________________________________________
_____________________________________________________________________________

Thank you for helping us improve our documentation.
Vertex Inc. Contact for Vertex’s PayrollTax™ Calculation System

United States federal, state and local tax data for use with Oracle Payroll™ is provided by Vertex Inc. Vertex related software is provided by Oracle in Oracle Payroll. Such tax data and software are licensed under a separate license between you and Vertex. Such software is warranted by Vertex, not Oracle.

Note: Oracle Payroll is delivered with sample Vertex tax data. The sample Vertex tax data is not current and is provided for demonstration purposes only.

To initiate delivery of current tax data and monthly updates directly to you from Vertex, either complete the form below and fax it to 415–696–3167, ATTN: Donna Palmquist, or mail it to

Vertex Corporation
ATTN: Donna Palmquist
100 South Ellsworth Ave., 4th Floor
San Mateo, CA 94401

Donna Palmquist may be telephoned at 415–696–3166

Company Name: ____________________________
Your Name: ________________________________
Your Signature: ____________________________
Your Title: _________________________________

Contact Name: ______________________________
Address: ___________________________________
________________________________________

Phone Number: _____________________________